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Chapter 1 Software Installation & Hardware Setting

1.1 Installing the Win-GRAF Workbench

Before installing the Win-GRAF Workbench, check the installation environment on your PC.

System requirements:
® O0.S.: Windows XP, Windows Vista, Windows 7, Windows 8 (32-bits or 64-bits)
® Microsoft .Net Framework 3.5 (Download it on the Microsoft web site:
http://www.microsoft.com/zh-tw/download/details.aspx?id=22)
® RAM: 1 GB minimum (Recommended: 2 GB or more)
® Available hard-disk space: 200 MB minimum

Installation Steps:
1. Double-click the “Win-GRAF-setup-ver-x.xx.exe” file in the Win-GRAF installation CD.
(or download the Win-GRAF Workbench on the website:
https://www.icpdas.com/en/download/show.php?num=711)

Win-GRAF-swtp-ver-1.01 exe
s | Win-GEAF Setup
IR 1Cr DAz co, LTD.

2. Click “Next” to continue and then select “l accept the agreement”, then click “Next” to continue.

Setup - Win-GRAF

Welcome to the Win-GRAF Setup
Wizard

This will install Wwin-GRAF version 1.01 on wour computer,

It is recommended that vou close all other applications before
conkinuing.

Click Mext ko continue, or Cancel to exit Setup.
Setup - Win-GRAF
License Agreement

Please read the Following impartant information before continuing,

Please read the Following License Agreement. You must accept the terms of this
agreemant before continuing with the installation,

welcome to the Win-GRAF setup program, ~

controllers) produced by ICP DAS.,

The win-GRAF is 4 ICP DAS software, Ik supports only hardwares (PAC, PLC, [ Met > * [ Cancel
N\

W ARMING: This software is pratectked by copyright law and international treaties,

IUnautharized reproduction or distribution of this software, or any portion of i,
may result in severe civil and criminal penalties and will be prosecuted ko the
maximum exkent possible under law,

4 I do not accepl Ehe agreement

[ <Back [ mext> *[ Cancel |
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3. Recommend to use the default installation path (i.e., “C:\Win-GRAF”) and then click “Next” to

continue.

Setup - Win-GRAF

Select Destination Location
Where should Win-GRAF be installed?

.—.J Setup will install Win-GRAF into the Following folder,

To continue, click Mext, IF vou would like ko select a different Folder, click Browse,

| i GRAF

| [ Browse,..

AL least 77,4 MB of Free disk space is required,

| <Back || uext:»ﬂ[ Cancel |

4. Click “Next” to add a “Win-GRAF” folder shortcut in the “Start” menu, and then select “Create a
desktop icon” to add a desktop shortcut, then click “Next” to continue.

Setup - Win-GRAF

Select Additional Tasks
Wwhich additional tasks should be performedy

then click Mext,

Additional icons:

[

Select the additional basks wou would like Setup to perform while installing Win-GRAF,

Setnp - Win-GRAF

Select Start Menu Folder
Where should Setup place the program's shortcuks?

- Setup will create the program's shortouts in the Following Start Menu folder,

To continug, click Next, IF vou would like to select a different Folder, click Browse,

Win-GRAF | [ Browse. .,

< Back. ” Mext = *[ Zancel
N\

< Back “ Tk = k[ Zancel

N\
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5. Click “Install” to begin installing the Win-GRAF Workbench.

Setup - Win-GRAF

Ready to Install
Setup is now ready to begin installing Win-GRAF on vour computer,

Click Install ko continue with the installation, or click Back. if you want Eo review or
change any settings,

Destination locakion:
CiWin-GRAF

Start Menu Folder:
‘Win-GRAF

Additional tasks:
Additional icons:
Create a deskkop icon

[ < Back ]| Install K[ Cancel ]

N

6. Before the end of the installation, you will see a pop up window and it displays:

a. The legal Win-GRAF Workbench is delivered with a legal Win-GRAF Dongle distributed by ICP DAS.

Please always plug the Win-GRAF Dongle in your PC while running it.
b. To run the Win-GRAF, require Microsoft “.Net FrameWork 3.5” installed in your PC.

Setnp - Win-GRAF

Installing

Extracting files. ..
C:Win-GRAFKSHelpGR . chim

Please wait while Setup installs Wwin-GRAF on wour computer, 'rh

i) Setup - Win-GRAF

Information
Please read the Following important information before continuing.

\When waou are ready to continue with Setup, click Mexk,

Thank vou Far installing the Win-GRAF software,

The leqal Win-GRAF saftware is delivered with a legal Win-GRAF-Dangle distributed
by ICP DAS. Please abways plug the Win-GRAF-Dongle in your PC while running it.

T run the Win-GRAF, require MicraSaft ket Framewark 3.5" installed in voor PC,

Far technical suppart and sales service, contact service@icpdas.com |

[CP DAS CO,, LTD

v icpdas, com
service@icpdas, com

Win-GRAF User Manual, V2.0, Aug. 2020 by ICP DAS 1-11




7. By now, you have completed the Win-GRAF installation, then click “Finish” to exit this window.
(Select “Launch Win-GRAF” to auto-run the Win-GRAF after completing the setup. If there is no
Win-GRAF Dongle in your PC, the Win-GRAF Workbench will run in Demo mode.)

Setup - Win-GRAF 9= ]

Completing the Win-GRAF Setup
Wizard

Setup has finished installing Win-GRAF on vour computer, The
application may be launched by selecting the installed icons.

Click Finish ko exit Setup,

Launch W

< Back ” Einish Q

N

1.2 Run the Win-GRAF Workbench

Before running the Win-GRAF Workbench, make sure the Win-GRAF Dongle is plugged into your PC.
Without using a Win-GRAF Dongle, the Win-GRAF Workbench will run in Demo Mode. Open the
Windows Start menu, click on “Win-GRAF” folder and “Win-GRAF” to open this software.

/= N G Vi GRAF ) Librories  »
‘ ) Google Chrome vl & Handbook
/) ICPDAS v
ﬁj Ctlook Express

@ Mozilla Firefox

ARl ) Opers 16 Win-GRAF &

Description of the “Win-GRAF” folder:
Libraries: For users to create their own function or modify an exist function.
Handbook: The manual details the software interface, programming environment, programming
languages, and so on, provided by COPALP.
(Or click the [Help] > [Topics] from the Win-GRAF menu bar)
History:  The modification history and features added of the Win-GRAF Workbench.
Manual:  The Win-GRAF manual provided by ICP DAS.
(Or click the [Help] > [Tutorials] from the Win-GRAF menu bar, ? e—
®

the manual is located in the path “C:\Win-GRAF\Tutorials”)
ReadMe: The notice for the Win-GRAF Workbench.
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1.2.1 Win-GRAF Operating Mode
The Win-GRAF Workbench provides two operating modes:

“Demo Mode”: Without using a Win-GRAF Dongle. The compiled Win-GRAF project can run for 15
minutes on the PAC. Once the time limit has expired, users must Stop/Start this
project again and it only supports up to 40 I/0 tags.

“Large Mode”: Using a Win-GRAF Dongle. The project can run on the PAC without the time limit.

Demo Mode - Without using a Win-GRAF Dongle.
The start screen will show as below after running the Win-GRAF Workbench.

Win-GRAF Starter EER

No Win-GRAF-Dongle found. Demo mode !l i No Win-GRAF Dongle found. Demo mode!

Win-GRAF

Win-GEAF ¥Yersion 1.01 {(MAE 18,2014}

Coparright by ICP DAR CO, LTI since 2014,

Fhepbroeek [Demo mode] FEEEEEOO0

For [Large mode], pleass plug o the "Win-GRAF-Dongle' while mdng it.
For technical support and sales service, contact service @4icpd az oo

It describes the limitations in [ Limitations in demo mode:
- Applications are limited to 40 T0s
demo mode, you can also - The code generated b the compiler stops after 15 minutes

click the main menu [Help] > = i) AR T e o5 L i

H H Limitaticns of controller type:
[About] to view this content. i Wi GIRAE st summeis oy Fadrarss (P00, FLC, eomtllbrs s byl o D08

Note: If you install the Win-GRAF Dongle in the Demo Mode, you must close Win-GRAF Workbench and
then start it again to make it become Large Mode.

Large Mode - Using a Win-GRAF Dongle.
The start screen will show as below after running the Win-GRAF Workbench.

Win-GRAF Starter

Win-GRAF
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1.2.2  Win-GRAF Operating Environment
Run the Win-GRAF and then the main screen will show as below:

Win-GRAF
(Fil: View [Lools Window Help .
e 1= = e >< i -

Work=space

Menu / Tool bar

X RO Alt+F4

-
ShowHide menu Pro gram Area

Workspace
3 >
Message Area
m Build‘ Cross references ] RunlimeJ Ca-ll stack ,l Breakpaints ,] Digital sampling trace ,l Prom-nt,l HEdAl
Ready Mo project 4 0,0 0x0 0,0 100% | B4

v

Note: Mouse right-click on the top of the Window to Show/Hide the menu bar.

A. The Workspace: It allows users to create project lists, and add/open the Win-GRAF program as
well as the related settings. Moreover, the new project can be created by using a
project template.

B. The Program Area: It used to show/edit the program and can be divided into more function area.
(Refer to Section 2.2.1)

C. The Message Area: It used to show compiler messages and provides more diagnostic tools.

Tips:
1. To resize a window, click and drag the side or corner of the window to change its size.

2. Press the “F1” key to open the user manual (i.e., HTML Help).

Hind or Show the window
If you carelessly closed the Variables pane or the Message Area during the programming, you can click

the menu bar "View" and select the following options to open this window again.

a'; L Local Defines

Cntpt Ctit A0
Tnfos Tabl
Tnfos Tab2

Output: It means the Message Area.
Infos Tab1: It means the Program Area — Variables pane (Refer to Section 2.2.1).
Infos Tab2: It means the Program Area - Function Blocks pane (Refer to Section 2.2.1).
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Switching the language

1. To switch the Ul language of the Win-GRAF, click “Help” and “Language” on the toolbar and then
choose a language in the “Select Language” dialog box, and click “OK”.

(Selectlonguage (o]

File View Tool Window [Help. u Frarfiis -
—— : C_Jre
i o RE ARSI R ] |M
| Workspace &, | Search... S EspaiEl
' Tutorials * <& Forean =
® | About.. Traditional Chinese
Simplified Chinese
| La_r‘gguagge....k |

N [ m%[mv

2. The Ul language will be changed after restarting the Win-GRAF automatically.

File VWisualizza Strumenti Finestra Guida

Sl bl nx gl a el E Ll E % e Qe A
'ﬂnm Nessuna selezione!

[4]¥] compita;” Ustinciooats | Runtime.|  CallStack | Breskpont.| — DigiaiGamping Trace | Frompt| HMI | Gode Cheker
Pronto | | | Messun progetto | | 0,0 | 0x0 | 0,0
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1.2.3  Win-GRAF Library Manager

Win-GRAF Workbench provides a Library Manager that can be used to look up all descriptions for
Functions, Function Blocks and I/O Boards. Refer to Section 11.1 to upgrade the Win-GRAF Lib.

1. To begin this, click the Start button and click "All Programs" > "Win-GRAF" > "Libraries" > “OEM”.

@ Win-GRAF ; "8 OEM
@ Google Chrome > :
(™) ICPDAS >
[4) Outlook Express
@ Mozilla Firefox
g € ) Operais

HEEA® b

Wi Win-GRAF

2. Inthe “Library Manager” window, click the menu bar “File” > “Open Library” and select “ICP DAS —
XP-WP-VP” then click “OK”.
3. Select any title in the “Function and FBs” tab and click the “Description” to view the usage of this

Function or Function Block; Select any title in the “I/Os” tab and click the “Description” to view the
usage of this I/O Boards.

Library Manager - zer

IZ1EN Wizard Help

- Open Library b4
M i
Exit (ICP DAS - XP-WPP _

[ oKy
Embedded HMI -
Ethemet Powerlink ==
Files

A

{FAPAP

£l

ICP D&S
Maths
Miscellaneous
FID

Plus!

PRP

{8 Library Manager - ICP DAS - XP-WP-YP
File Wizard Help

@ Time_Get (* Function Block: Get date and time of the PAC %) =

v
—T . Yok Sk ety TV el i o ioeii Jode wied Aleeo do 2L VA, WA A

Parameters( Description

Retain ¥ar : Retain a variable . el

*#*% The "Retain Var()™ can work only in the lst PAC cycle or
in the cycle when on line change.
Call this function in other cycles will return FALSE .
\

L~
i
|
.
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1.3 Setting the Win-GRAF PAC’s IP Address

For connecting with the PAC, the Win-GRAF Workbench needs to know the PAC IP. The following will
show you how to set up the PAC IP. Using the XPAC (XP-8xx8-CE6) and the WinPAC (WP-5xx8-CE7,
WP-8x48, WP-8x28-CE7) as the example:

Hardware Wiring Diagram

Power Supply

Monitor
DP-665
PC/Win-GRAF GND ; i
N~ .
I S = = +V p
IP 192.168.1.20 -‘ usp =

Mask: 255.255.255.0 R5-408

LAN1: 192.168.1.10 Win-GRAF PAC
Mask: 255.255.255.0

Notice:
For connecting properly, the PC/Win-GRAF IP and the PAC IP must on the same network segment.
For example,

The PC’s IP:  “192.168.1.20” (Mask: 255.255.255.0)

The PAC's IP: “192.168.1.10” (Mask: 255.255.255.0)

PAC Side

Run PAC_Utility on desktop, click "Assign IP address" and enter the IP address for LAN1 (or LAN2) in the
"IP Config" screen. Next, click the "Apply" button and click "Save and Reboot" on the File menu to apply
the IP settings.

M 3

Save

Save and Reboot

pnfig | Metwork IDevice Inforrmation I Autn Execution IRDtar\,f Exe_{ I 4

Reboot

Restore Utility Default Settings

Eut LAN 2:
MAC Address: 00-10-F3-31-B5-F5 MAC Address: 00-10-F3-31-B3-ES
{ ) Use DHCP to get IP address @ () Use DHCP to get IP address
%ﬁss' TP address = @ assign 1P address
IP aNdress:  [192.166.1.26 | IP Address:  [160.254.165.121 |
Mask: |255.255.0.0 | Mask: |255.255.00 |
Gateway: |192.16E|.1.1 | Gateway: | |
DNS Server: |139,1?5,1,244 | DS Server: |1|:|,|:|,D,3 |

\
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Chapter 2 A Simple Win-GRAF Program

2.1 Creating a New Win-GRAF Project

The following sections will introduce you to a simple template project that used to get/set (read/write)
the Win-GRAF PAC'’s system time. Follow the steps below to complete this demo program.

2.1.1 Creating a Template Project (Demo01)
1. Run the Win-GRAF Workbench (refer to Section 1.2), and click "File / Add New Project..." from the
menu bar.

I Win-GRAF

IZIEN View Tool: Window Help
Hml Mew Project Lizt...
Cpen Project List

_IJ Add Mew Froject... \
Add Emisting Project

2. Click “From template” to create a project from a template, enter a project name (e.g., "Demo01") in
the Name field and add a simple note in the Comment field, then click "Next". By default, it will
show a "ICPDAS_template" option provided by Win-GRAF Workbench, just click "Next" to continue.

B Project wizard [Z'
@ Project

ML Import
Q Library

'ﬁ: Autamation zcript

Creates a new project using a template

Recommend to use the default folder.

Mew project
Deztination folder ; | C:WwWin-GRAF\Projects w | Browse. ..
Marme: | Demaoll |
Comment: | Test Demo |

| Newt ‘{[ Cancel || Hep |

Template: ICPDAS_template 4 |

[ Previouz ] [ Ne:-:tkl [ Help ]
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3. Now, you have created the “Demo01” template project.

Win-GRAF - Demo01

File Edit View Inmrt Project Tools Window Help

ﬁ Exception programs

- [J Programs

; |_%'] PAC_Time [*Get / Set PAC Time®)
E| [ Watch [for debugging)

; - Soft Scope

-4 Initial values

g Binding Configuration

-3 Global defines

fal Wariables

Lo BB Types

Build

Ready

Sl g s AX R o 9 o LGN E GRS A
Workspace Ho selection!
- Ei Demo1

Build/ CrossrefelencesJ Runtime,l Callslack/I BreakDoinlsJ

Digital sampling trace /I Frampt

Hhdl

OFfLine 192,168,255,1:502 0,0

0x0

0,0 100% @&

Note: Inthe demo01, we use a “From template” way to create this project. If you select "Project" in the

step2, click the "Release" in the “Compiling options" setting. The others setting can be done in
the following sections, just click "Next" and then "OK" button to end the settings.

“PAC IP:502”,

N

Refer to Section 2.3.5

Settings
Programs
Language: | LD: Ladder Diagram
Compiling options
() Debug
Communication options
|
Settings: 1192.168.71.19:502 l'Y
Protocol: [ T5 Runtime
Other
Edit nitial valves with the Recipe editor

X

i3

SERL

|

%0 | =] (

Luste)

]
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2.1.2 Important Project Settings
There are two important settings must be done after creating the project.

1. In the "Workspace", mouse right-click the project name (e.g., "Demo01") and then uncheck the
"Alphanumeric Sorting" option (the last one). If unchecked, means the programs are in execution
order ; If checked, means the programs are in alphanumeric order (e.g., FBD1, LD1, ST1).

Work=space

= | M Cucle...
L Communication Parameters. . Conbigaraton...
-G | #B1) On Line Libraries...
: e E Eumulate o . -
e 75 Buid Project
L~ Clean Froject
settings. .
Alphanumeric Sorting < v | Alphanumeric Sorting \

Workspace Workspace

5] FED1
Unchecked, Checked,
In execution order In alphanumeric order

Change the execution order of programs:

Note: If you want to change the execution order of programs, mouse right-click the project name
(e.g., "Demo01") and click "Cycle" (as the screenshot above) to open the settings window,
then click the "Move Up" or "Move Down" button to change the order.

| Enabled | Period | Phase |
1 0
1 0
1

2. If using the "Project" way to create a new project (in this example, we use the “From template” way,
refer to Section 2.1.1 - Step 2), click the"Project" > "Settings..." from the menu bar to open the
"Project settings" window. Click the "General" option and set the "Complex variables in a separate
segment" to "Yes" to allow the using of complex data structures, such as arrays. Finally, click "OK" to

exit the window.
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FEes Tool: Window Help
Enild 411 Projects Fi
Clean A1 Frojects

¥ LDownload All Projects...

Sethings...

(& 21 [ F

CWin-GRAFProjectsiDemo0 1

| M ame | Walue
Runtime # Commurication parameters 192.188.255.1:502
Compiler

Dehugging i E_I,II:|E t"TIE ]
Advanced [ Code Generation
(Al [H™ Comples variables in a separa

= 0On Line Change Disabled

EIE Yersion WE - 201402425 1217
o) Libraries Edit...

S Use external objects Edi...

Enables complex data such as arrays of struckures, This option is

Lirne consuming.
Zancel

(Note: The "Code Generation" must be set to "Release".)
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2.2 Introduction of the Project

2.2.1 DemoO1-LD Program
This program is used to read/write the Win-GRAF PAC's system time. In the Workspace, double-click the

LD program name (i.e., “PAC_Time") to open all relevant windows. As the screenshot below, the
Program Area has three main parts:

File Edit WView Insert Project Tools Window Help

Program Area

AN BE AN RN SE-Rh= T wHOI At € AR g Al
2l DemoD1 I : ! A °F Mame | Type | Dir
[ E=ception programs R cetour.. e TE S L _] PAC Time (*Get f Set PAC Time #
e I - A = - ~ Inst_TIME_GET Time_Get
3| AL Time [“Get / Get PAC Time?) vaar|Pac vesr N Inst_TIME_SET Time_Set
o (SR e e il y B N 5 ¢ Global variables
W Soft Scope Marth | PAC_Morth Bl
= Iritial values I - FAC_Month DINT
%3 Binding Canfiguration 4| | Dy | PAC_Day PAC Day MINT b
jg Global defines b .
{2} Waiables | whiay | PAC_visekDay ] B. Variables
B Tupes [ [Used) Area
2 | Hour |-PAC_Hour 3 [Project)
-H 1 Advanced
| Minute | PAC_hirute 3 Aiithmetic
HeS w [ Araps
o) [ A. Program Editor | ¢+ meas s C. Function
Note: , means the Build Area (LD) BBl Area
program is locked and
cannot be deleted. ] : _ ——
4 ¥ | Build Cross references Runtirme Call stack EBreakpoints Digital sampling trace Frompt HbAl
Ready OffLine 192.168.255.1:502 £ 0,54 261 x 18 0,0 100% | gy

Tips: Mouse click the Program Editor Area, and press the "+“ or “-” key to zoom in or zoom out the

content.
Inst_TIME_GET R1: Gete.. HTIME_SET I

R1: et current .. fEn TIME_GET E... |

Current tim...
Year-PAC_rear

Current time of th...
Year |-PAC Y gar Mo, | FAC_Month

PAC Month Cray|-FAC_Day
Mertn| PAC Mo | (E.g., press "-” key twice to

] FAC_Wieek...
zoom out the content.) R M

PAC_Da
iy —DaY Hourf- FAC_Hour

wyDiay PAC \WeekDay q Mi.. .} FAC_Minute

Se. PAC_Second

Haour |-PAC_Hour Set_nem ti..
TIME_SET |

new time ...
new fear rear

Minute | PAC_Minute

A. Program Editor Area (LD):
This area allows to edit or display this LD program, you can click the object button (on the left of
Program Area) to add a program, and then drag-and-drop variables (in the Variables Area) onto the
function block one-by-one.
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R1: Get current time of the PAC

Inst_TIME_ET
En TME_ET Eno

Year | PAC Year

Morth |-PAC_hdorth

Dy |-PAC_Day

Dy |-PAC_wWeekDay

Howr |-PAC_Haur

Minute |-PAC_Minute

Second|-PAC_Second

R3: Reset it to “False”

B. Variables Area:

Current time of th...

R2: Set “Set_new_time” to “True” to set the new time

Set_new_fime Inst_TIME_ZET
| Set TME_SET & |

niesey time far the P
newy_ear vear

nesy _hdanth Jkdarth

nenw_Dary | Day

nesy_Hour JHour

new_Minute inute

newy _Zecand 4 Secand

Note: You can press the SPACE bar
| | tochangeitstype (/, S, R), and
'\ press the F1 key for more details.

Set_new_time
R

This area shows the function blocks and variables that used in this program. Mouse double-click the

“Name” or “Type” item to modify its name or data type, then click “Enter” to complete the setting.
(Refer to Section 2.3.1 for the details about variable declaration.)

M ame | Type

Dim. |

Attrib. Note: For the function block can work correctly, the

| FAL_Time ["bel 5 oel FAL

Inst_TIME_GET  Time_Get
Inst TIME_SET  Time_3Set
fat Global variables

PAC Year Dl
PAC _Muonth O | BOOL
PAC Day D |BrTE
PAC WeekDay D

PAC Hour b I[:;fDHD

PAC_Minute Ol unr
PAC_Second D LrEAL
£ L'wORD

C. Function Blocks Area:

Time™)

“*  “Inst_xxx..” FB instance variable will be automatically

added when using one function block. For the safety

reasons, this FB instance variable will not be automatically
= deleted even if the function block has been removed in the
editor area. So, users can right-click the unwanted variable
and select “Clear” to manually remove it.

Inst_TIME_: - .
&4 Glohal FB instance variable

LED L
o e & Cut

£

"u . Copy
TIME, =

TIME_

Cd Maths | % Clesr\

In the “Blocks” tab, it provides many types of the function block for users to drag and drop them to

the editor area.

A En DAY _TWE Enc

5

SEL

S T3 BAChet
~
N1 Booleans
| =3 GaMbus
Ca Eﬁ.ﬁqeen

i 4 Clock

Tips: Sl DAY TIME [*Get cunent day and time
After selecting the function DTAT [Pulss at a datetime]
b|OCk, press “F1” key to open " T} DTCURDATE [*Get curent date stamg

BN CURDATETIME [FGet curent date
the HTML Help 4 ’ Sow list [efine EM LI
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2.2.2

Demo01 - Variables

In the workspace, mouse double-click the “Variables” item to open the Variables window. The following
screenshot shows all the needed and defined variables in this “Demo01” project.

= H= 3 x — O & N e AR G & EA
2 DemoD1 l S Mame | Type | Dim. | Attrib. | Syb. | Init value | User Group | Tag | Description
[J Ewception programs PAC Year \ DIWT ] Current tirme of the PAC -
3 Pragrams PAC_ Maonth DIMT ]
“He] PAC_Time [*Get / 5... PAC Day . .
[ “watch [for debugging) PAC WeekDay Click it to sort by name.
& Scoft Scope PAC_Hour
= Initial values PAC_Minute DIMNT ]
%4 Binding Configuration PAC Second DIMT i
s g Global define new_Year DIMT ] new time for the PAC
Wariables fesws_Manth DINT [
new_Day DIMT [
new_Hour DIMT [
new_Minute DIMT ]
new_Second DIMT ]
Set_new _time BOOL | Set TRUE to set new time

=l RETAIN variables
_] PAC Time (*Get / Set PAC Time®)

L R e = P P Py

< ¥
4 ¥ | PAC 'I'|m

Tips: In the Variables window, users can click any title field (e.g., “Name”) for sorting.

If you want to go back to the original sort order, mouse right-click anywhere and select the

“Cancel Sorting” option.

Cancel Sorting \
Al Epshle Changes Space

Swap Flobal <= Eetain

Field description: (Press the “F1” key to look up the details)

Mouse double-click any field item to set or modify the data.

Name:

Type:
Dim.:

Attrib.:

Syb.:
Init value:

User Group:

Tag:

Description:

A valid variable name starts with a letter (e.g., "A to Z" or "a to z") followed by any
number of letters, numbers (e.g., "0 to 9"), or an underscore (i.e., “_").

Data type. (Refer to Appendix A for the value range)

To specify the range of an array.

(E.g., enter “10”, means the use of the Counter [0] to [9]).

Double-click this field item to set it to “Read Only” that means users can only read this
variable but cannot modify it.

If checked, the variable name will also be downloaded into the PAC.

To set the initial value of the variable.

All the variables can be divided into some groups (e.g., “Groupl”, “Group2”) and it is
convenient for users to look up or search these variables.

To enter a nickname for the variable.

To enter a simple note for the variable.
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2.3 GiveitaTry

As mentioned before, we have described the LD program (Section 2.2.1) and variables (Section 2.2.2) in
the "Demo01” project. The following sections will show you how to declare variables and add an LD

program with the blinking function in this project.
Note: “ULINT” and “LWORD” are not supported for Win-GRAF PAC.

2.3.1

Declaring the Win-GRAF Project Variables

First, we will declare two boolean variables (i.e., "LED1" and "LED2") that used in the program.

1. In the “Variables” window, mouse right-click any item in the “Name” field and select “Add Variable”

(or press the "Ins"

Variables

M & Y € & B g

key or click the =

tool button) to add a variable.

5 " Al

I Mame | Type | Cim. | atib. | Spb. | Initvalue | UserGroup | Tag | Description
fal Global variahles =
PALC Year &) | Undo Current time of the PAC
PAC Month
PAC Day
PAC WeekDay | ® =
PAC_ Hour 23 Comy
PAC_ Minute
PAC Second % | Clear
hew Y ear 3 Edi new time for the PAC
neswy_Month -
new Day Cancel Sorting
new_Hour A Enable Changes Space
new_Minute -
new Second Swap Global <= Eetadn

i
=l AN var

Add Variable \ Inz
Add Multi Variabled..

Set TRUE to set new time

2. Double-click the new “NewVar” item and change its name to “LED1”, then click “Enter” to finish the

setting. In this case, the data type is "BOOL".

oet _new time
hlﬁ'..\..'l‘l l'l-"hl"

LED

BOOL

Bl

L] Set TRUE to set new time
L]

Note: The settings will be done only after clicking the “Enter” key.

3. Follow the previous steps to add the “LED2” boolean variable.

Set new time

BOOL

LED1
LEDZ

BOOL
BOOL

lml RETAIN variables

] Set TRUE to set new time
]
]

Tips: To set up multiple ordinal variables, enter the name “LED” (as the step2) and then press “Ctrl+C”

and “Ctrl+V” twice to create “LED1” and “LED2” (auto sequential numbering), finally, delete the
first variable (i.e., “LED").
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Tip #2:
1. If you need to add multiple variables (e.g., “Boo_01 to Boo_16"), simply right-click the “Global

variables” and select the “Add Multi Variables”.

Workspace I variables

= »;] Test_01 P Name [Toped | = | Undo nit value

i}~ [3 Exception programs ﬁm
£ Programs il RETAIN variables |

WL _] Main Mouse right-click

=) [d Watch (for debuggi... ? 2 pOnBadindex ‘

- ¥ Soft Scope ? 2 nOnDivZero | (| Paste

- =4 Initial values _] pShutDown \ % | Cloas

%% Binding Configuration _] pStartup liess] s

30 Global defines | =

; Y2y Variables ‘ Cancel Sorting

i e :J.TL']‘ Enable Changes Space
+ Add Variable Ins

b ‘ Add Multi Variables... :\ ?
] [ 4 "% | 10 Drivers | Variables /, Edit Variables as Text... \ B

2. Follow the settings like the figure below (Name: “Bool_%%"; Type: “BOOL”; From: 1; To: 16) to
create Boolean variables (i.e., “Bool_01" to “Boo_16") and then click “Create all” button to complete

the settings.

Name |Bool %% |
N
Type BOOL viu I Cancel l

Group Global variables v I [ Help ]

[C]Read only Dimn. o []

[From 1 To |16 \]

Overview

Creation of 16 variables :

From variable Bool_01 to variable Bool_16

I Mame | Type | Dim. | Attrib. | Syb | Initwalue | User.. | Tag | Drescription

52 Global variables ~
Bool_01 BOOL O
Bool_02 BOOL O
Bool_03 BOOL O
Bool_04 BOOL O
Bool_05 BOOL O
Bool 06 BOOL O
Bool 07 BOOL O
Bool_08 BOOL O
Bool_09 BOOL O
Bool_10 BOOL O
Bool_11 BOOL O D
Bool_12 BOOL O
Bool_13 BOOL O
Bool_14 BOOL O
Bool_15 BOOL O
Bool_16 BOOL [l v

4 | )

m Wariables
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2.3.2 Declaring the 1/0 Variables

In this example, the [-8055W module that used to show the blinking feature must be plugged in the

PAC's slotl. So, we need to add an I/O link to correspond to the real I/O module.

1. Click the "Open I/0s" tool button to add an 1/0 link.

File Edit View Insit FPooject Tool: Window Help

Sl 3 42X o 9c =2lghne dm s Ba

2. Mouse double-click on "Slot 1” and then double-click the "i_8055" to select this I/O board.

N

EEEE 140 Boands

Librany: Device:

i_B046_DI (*I-8046W (16-ch D) *

[ETI i 8046 _
ICP DAS - %PwP-H| |i_8050 (* [-8050% (16-ch configurable DIO) *)

Srandad 78051 _DI (*1-8051 W (16-ch D) %)
anear 78052 DI (*1-8052W (8-ch D/T) %)

i_8053_DI (*I-8053W (16-ch D) *

8054 (% 16054

ch DVT 4+ 8-ch Ditn %)

i 8056_DO (*1-8056 W (16-ch DAJ)

i_B057_DO (* 8057 W (16-ch D) *)

i_B058_DI (*I-8058W (5-ch D) *)

i_8060_D0O (*I-3060%W {B-ch Relaor outputs) *

[

I1E

[-B055w

8-Ch Digital Inputs + 8-Ch Digital Outputs

o 01,2013
ICP DAS | Taiwan

3. Click the “Close” button to exit the “I/O Boards” window.

Note: Click the “Virtual/Real” button to change to the Virtual I/O (for testing) or the Real I/O.

(The Real I/0 is used in this example).

EEEE /D Boards

Select

Fename

[

Properties

1 (i 8085 DO

Yirtual/Real
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After linking the “i_8055” 1/0 board, it will automatically add 8 input & output variables in the
“Variables” window.

T Mame | Type | Dir | Atk | Syb. | Initvalue | UserGroup | Tag | Description
LED1 BOOL O] »
LEDZ2 BOOL [l

[l RETAIN variables
B %0¢1.0-i 8055 D

Telr1.0.0 BOOL Input O]
%lx1.0.1 BOOL Input O]
%l¥1.0.2 BOOL Input O]
%1¥1.0.3 BOOL Input O]
%lx1.0.4 BOOL Input O]
%l1.0.5 BOOL Input O]
%lx1.0.6 BOOL Input ]
%lx1.0.7 BOOL Input L]
B %0x1.1-i 8085 DO
TCIA] 1.0 BOOL QOutput [
% K111 BOOL QOutput [
%0112 BOOL Output [
%113 BOOL Cutput [ |
%0114 BOOL Output [
%K1 1.5 BOOL Output [
%K1 16 BOOL Cutput [
%CIK1.1.7 BOOL Qutput [ v
< »
4 ¥ | PAD Tlm
%1X1.0 —i_8055_DI %QX1.1-i_8055 DO
“I” means “Input” “Q” means “Output”
“X” means “Boolean” “X” means “Boolean”
“1” means “Slot 1” “1” means “Slot 1”

%ID or %QD

“D” means “Integer/Real”

There are three output variables are used in this example, and you can modify the name for easy use.
Mouse double-click the item and fill in a name, then press “Enter” key to finish the setting.

B %011 - 8055 _DO B %011 - i 8055 DO

241 10 Slalal Output %@t 1.0400tputt |BOOL Output
Outputl \ Output |:> % 01,1, 19 0utput? |BOOL Output
11,2 BOOL Qutput %@t 1.2400tputd |BOOL Qutput
%QK1.1.3 BOOL Output %1 1.3 BOOL Output

Win-GRAF User Manual, V2.0, Aug. 2020 by ICP DAS 2-11



2.3.3  Creating an LD Program
In the “Demo01” project, we want to create a “LD1” program to show the blinking. To begin, follow
these steps:

1. Inthe workspace, mouse right-click the “Programs” folder and select “Insert New Program...”.

Workspace PAC _Time

B .1_|.| Demoll
l ----- [[3 Exception programs

D ij Eename... F2

e EE] PALC
5[ Watch [fo [ Dnzert New Folder

o ot 0 IgsertHewPngIﬂm..\
3

------- =4 Initial vl Shortouts
"""" % Binding Ci Tt Mew Ttem...
....... g Global del

2. Fillin a program name in the “Name” field and enter a simple note in the “Description” field, and
then select the “LD — Ladder Diagram” as the programming language and click the “OK” button.

New program [‘5—<|

Properties |Advamed | Descrintion |
Program
Name: LDI |

Description; |El]jnl<jng |

Programiming language

BFC - Sequential Function Chart - Grid edior

SFC - Bequential Function Chart - Free form editor
a.2073

aT - Sh'w:tu.red Text
IL - Instrocton List
PACEML - PACEML State Machine

Execution stle

(®) Main program
() Bub-program
() UDFE (User Defined Function Block)
Child 3FC program
Child of: | v |

ek~ | O | W

3. Double-click the “LD1” program to open the editor window.
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4. Click the “Insert FB..” button on the left of the “LD1” window to add a function block.

File Edit ¥iew Inset Project Tools Window Help
S HE S B X o e AR g 5 A

Workspace
= .|_|l Demol1 T A °F Mame | Type | Dim
----- [_d Exception programs L. = 1 LD (*Blinking™) ]
£ [ Programs
) PAC_Time [Get / Set PAC Time®] || & Tips: |
5] LD [*Blinking?) il y
- Watch (for debugging) | You can also drag and drop
am Soft Scope the “BLINK” function block v
------- o Initial walues 4 . « ” . |
------- !!é Binding Canfiguration Into the LDl WlndOW. [~ ~
------- g Global defines ey =
------- Ty wariables ‘“ e e B
....... B Types » | ~ ~ [ (Project]
o R ~
W1 [ Text buffers

L | = [ Timers |

<> t PAll: Time \f‘afiab'e BLIME [*Blink zignal ge...
BLIMNKA [*&symetric blin...

PLS [*Pulze signal gene...
SIG_GEM [*Signal gene...

click the “OK” button. e e - b
< Spulist | Define | ENUM

| %

5. Double-click this function block and select the “BLINK”, then

* | R ] S| =

!
[ K

- AN

AVERAGEL [*Running average [LREALT *

9 | | TF BACHMETFMTDTYPES [*Set BAChet device types fomatting”]

i I} BACNETFMTMHAMES [*Set BACnet objects name formatting®)

I 1} BACHETMASMASTER [*Read/wfite Mas aster parameter®) 3
3 I BACMETOWERRIDE [*Set BAChet OVERRIDE flatl
3 B 1} BACHETSETFLAGS [*Set BAChet flags [obsolets M

| BACMETSLAVE [*Controls the BAChet MS_TF' Sl You can press the “BL” key

HiCH BACMETSTATE [*Current BAChet taken ring ztah i !
b {1} BCD_TO_BIN [BCD to binary canversion’] to quickly find out the name.

P | IF BIN_TO_BCD [*hinary ta BCD conversion®)
4 % | FAC Time | ‘ariables | LD [

BLIMKEA [“Asypmetric blink signal]
CANRCWMSE [*Recee CANbus meszage®)
IF CANSHNDMSEG [*Send CAMbuz message?]
TTF CHAR [*Build characker)

CHP [*3 output comparizon®)

ti CONCAT [*Concatenate strings™)

S S T EMITE O O O e leiLT L L L

Mb Inpuks: I:I [ o] 4 % Cancel

3 -
R1 |

o FIIECE \
JU1

CYCLE Tips: (Refer to Section 2.2.1 - B)

Click the upper area, to change a FB instance variable.

Click the lower area, to change a function block.

y
.
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& Important Notice:

When programming, users may copy & paste an existing function block to create a new one. But,
this way will cause a function exception due to the same function instances. Therefore, users must

create a new name for the function instance.

1. Mouse double-click the function block and enter a new name (e.g., “Inst_BLINK1”), then click the

" button to complete the setting.

m

‘E*’ BLIN | iblame | Tyee
Inst pILe =] -
- g | ~
| +38] | R R.BLNK of—O—o] —|| = Ebest O E
l . Inst_BLINK blink —
| 2
[ : = {2} Global variables v
E; L i &
| Gl R2 R )| ~
, E F o [4 [Used) T
‘ T4 | x || B [ (Project] &
' it £ | #3 Varisbles: [all] ~ ]i-i;jj,r__l!l_q_ql_:ms ';V _S_DV"S' Vv'__ A__De_?'ﬁe",E_N_U_hj
-1 Inst_BLINE —
=0
_Q LED ~
Wariables: (all] v
[] Local varables only
[ Hide FB instances

2. In the “Inst_BLINK1” window, click “Yes” to create this function instance.

Inst BLINK1

This symbol does not exist. Do you want to:

Fename the vanable

(3) Declare a new variable

Type: | EETS—
° Where: i LD1 v I
Yes [ No ] [ Cancel ]

You can also use the same way to
double-click on the right-side of the
“Coil” to create or assign a variable.
(Refer to Step7)

3. Now, there is an “Inst_BLINK1” function instance added in the Variables Area.

A7 Name [

* Inst_BLINK =l | Type
) 15T _| N — A
% | R1 R..BLNK Q) ] '*; dLDteSt ——
i N
b :
4| Jeve. | ° blink
= Inst_BLINK1 § | 5! ) ol
i o2 RS ERET ~
4 [Used) =
o {eve. =8
i m # (Gl Pojectt ™
ha' (I > - 3| Blocks (" Soulist | Define | ENUM
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6. Click the “Coil” on the right of the “BLINK” function block, and continuously click the “Insert Coil”
button to add four “Coil”.

k3 J_\

I In=t_BLIMK =l

| R RUM BLINK [=] &

lge! il
- | Jovele

'»
L Tips: Press the “+” key to zoom in the content.

a Press the SPACE bar to change the Coil type (/, S, R).
ol | ;
> | | inst_BLINK~ §

R RUM BLINK. - Qf s
I “ﬂ
JoveLE

7. Mouse double-click the first “Coil” and double-click “LED1” to assign it. Follow the same way to
assign the “LED2” variable to the second “Coil”.

L ————————

I #| “F Mame
1 R1 RUN ELINK - @ _|LEDT | v x
4 Tt \ | #2 Variables: (2l ~
— | I [ Inst_BLINE.
| | & 5
4 B LEDZ
I m By new Day
By new Hour
j u B new_Minute
gl By new_Month
B new Second ¥
= —— )=
i Wariables: (all v
-
[] Local warisbles anly
HICH — []Hide FB instances

8. As the screenshot below, mouse drag-and-drop the “Outputl”, “Output2” and “Output3” variables
to the 3th, 4th and 5th “Coil”.

T ———————————————— —— e 2 X

I A °F Mame | Twpe | Dir
b - ~| LEDI BOOL &
=il RUM  BLMK @ LEDZ ~BooL
=l RETAIM variables

3 i LED2 B %[¢1.0-i 5055 DI

e L dovLE =T T T s |E %01 - 8085 DO

e 1.0=0utput! BOOL

i1 %11 1=0utput? BOOL

0 S QR1.1.2=0utputs BOOL -
: i e
s I Sl b
3 3 (a0 A

1 3 (Uszed)

HiH ] . [ [Project]
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9. Mouse double-click on the left of the “CYCLE” and enter “T#2S” (to blink every two seconds), and
then click " to finish the setting.

= m LEDZ2
| \CYCLE |
%EH1.1 10
! |T1¢25 v Ottt
I
0 | #h Vaiiables: [al) A '
= w0 Inst_BLINK = %O@;; o
By LED1 I
e By LEDZ2 U
D FiRIsl nFIII : %G}{1 1 2
o CutpLt3
| Wariables: (] v I
HKH | ; !
[] Local variables only
= []Hide FB instances
—
1" L

4 |
4 FAC Time “wariables LD1

| W

10. Finally, click the “Save” button to save the “LD1” program.

[/} Win-GRAF - Demo0l Q

File Edit ¥View Insert Project Tools Window Help

[eRe @ & 52X o 90 = MaBede; &R
WorkspaceN\ E_ﬁ
| 7 Name | Type | Dim.

E|..;I Demoll I
----- 3 Exception pragrams . ey = LEDZ2 BOOL ”~
203 Programs ST T T [l RETAIN variables
: @ PAC_ Time ["Get / Set.. L. L ———— AR i_BDSS_DI
] LD (Blinking®) a i LEDZ B %0X1.1 - i_8055_DO
£1- [ Watch (for debugging] TH2S CYCLE — %EX1.1.0=0utput] BOOL
38 Soft Scope %K1 10 % GX1.1 1=0u0tput2 BOOL B
<o B8] Iritial values ki Outtput1 %0H1.1.2=0utput3 BOOL “
Wi Binding Corfiguration - < | 3
;}g Global defines ! %5;1L":2'1 T_j (Al - ~
f‘a& Wariables 2 3 Used) :
s U= 1 EH1 12 L3 [Project]
R Outputs 1 Advanced
HioH [ Arithmetic
b [0 Arrays w
- i | l 4 *| Blocks Sov list Drafire EM LKA -~
4 » FAC Time \-"ariahles
Build ®
4 ¥ | Build Cross references Runtirme Call stack EBreakpoints Ligitzl zampling brace Frompt HbAl
Ready OffLine 192,168,255, 1:502 A 1,1 1x1 1,1

Note: “2” means this program is opened (locked, cannot be deleted). Click the “X” in upper-right

corner of window to close this program (un-locked, “ sl ”).
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If you want to add a program to the first line after completing the programming, follow these steps:

1. Click the upper-left corner of the Program Editor Area, and you will see the selectable items on the
Object bar. Select an object (4 to 7, as the screenshot below) to add a program to the first line.
Note: You can also select an object (1 to 3) to add it on the left of the current program.

3 ~
LEDH =
\\ R RUM  BLIMK i | |
= || Add a object on the left of the current program: LECZ
—{ | 1. Insert contact before (shift + F4) I
2. Insert horizontal line (shift + space) e
o . Outputt
— | 3. Insert FB before (shift + F8) I
| F@H1 11
i N Output2
55 || Add a object on the top of the program: |
a 4. Insert jump (shift + F9) FlR1.1.2
5. Insert Coil (F9) OutpLt3 I
u |}
HISS 6. Insert new rung
- 7. Insert commecnt line v
LS 2

4k FALC Time ‘JWariables LD 1

2. Inthis case, click “Insert new rung” to add it to the first line.

JE —
I _—
R1
bl —
= LED1
ol R2 RUM  BILINK Q@ |
o I LED2
4 T#2S |CWCLE |
@K1 1.0
! Outputd
l
% !
W@ 1.1
- Output2
l
HHCH '
W@ 1.2
B AN OutpLt3 v
(i) 2.

4k FAC Time ‘JWariables LD1
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2.3.4 Compiling the Program
In the previous section, we have added and saved the LD program. For the Win-GRAF project can
function properly on the PAC, we need to compile the programs. To begin, follow these steps:

1. Onthe menu bar, click “Project > Build All Projects” to compile all programs.

™ Win-GRAF - Demo01

File Edit View Insert B&ma® Tool: Window Help

TR = NE REE RS Euild 411 Projects F7
Workspace Clean A1l Prc:jects\

Diowndoad A1 Projects.

Settings. .

2. If a “No error detected” message is appear that means the project was successfully compiled.
Note: If you modify and save the program after compiling it, click the “Clean All Projects” to clean
the previous results and then do the step1 again.

[ Win-GRAF - Demo01 =13
File Edit View Insert Project Tool: Window Help
San " N BR= R WENE o s WRE &Ry B A
Workspace PAC_Time L
=3 Demo0l I AT Mame | Type
----- [ Exception programs In=t TIME GET = E ] PAC Time (*Get / Set F~
5 Programs _|R1: et currentt f|En TivE_GET Eno | Inst_TIME_GET Time
b B PAC_Time [Giet # Set... Inst_TIME_SET Time
‘o 3] LD ["Blinking®] - Current time of th... = {2 Global variables
. “ear | PAC_Year
(=) [ Watch [far debugging) - PAC Year DINT
i 8 Soft Scope PAC Manth DINT 2
o [ Initial values i | Worth |-PAC_Manth {'_' = "l ™ .-....;— —
!Fé Binding Configuration — —
sg Global defines L3 (i -
ety Variables | Day | PAC_Day [ ] [Use_d] =
BB Types 5 [ [Project]
a [ Advanced
| | wDay | PAC WizekDay £ Aithmetic
i [ Amraps
. Hour | PAC_Hour v 4 AS-interface A
50 > 4% Blocks  Soviist | Define | ENUM
Build X
Felocating code.... ~
< Code CRC=d1bdae33 - File CRC=cBebeatf - Size=2384> | Check to see if there is any
error message here. 3
4 ( Build >Cmss reMyrences Runtime Call stack -~
Ready CffLine 192,168,255, 1:502 é 0,0 1x1 0,0

Build in progres=... Pleaze \Wait...
C:wwiin-GRAFProjects\Demaoll

Compiler ¥14.3.31.0

»» Complex varables stored in a separate segment

If the Win-GRAF is running in Demo
Loading application symbals... L~ M9de' this me§sage means the

— Vi Win-GRAF project can run for up to
15 minutes on the PAC.

Demo Maode: rn time execution limited to 15 minutes!

4 ¥ Euild Cross references Funtime Call stack
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2.3.5 Download the Program to PAC

Before downloading the program, you need to set up the communication parameters. (By now, it only
supports the Ethernet TCP/IP).

1. Mouse right-click the project name (i.e., "Demo01") and select “Communication Parameters...” to
open the settings window.

File Edit View Insit Project Tools  Window
S R S % Gy X o

Workspace PAC_Tim

= .,_|l Demoll I —|—
..... CH ¢
B I‘jj Comrmnnication Parame ters.
........ #| Cn Line \

2. Enter the “PACIP:502"” (e.g., “192.168.255.1:502") to add an IP address and then click “OK”.

It can also click the D button to add/modify the IP address.
(Note: the default PAC IP is “192.168.255.1” and the fixed port number of Win-GRAF PAC is “502”)

Communication Sethngs &|

Tips: All the configured IP will be listed here. You
can select the unwanted IP and press “Del” key to
delete it (e.g., “192.168.78.8: 502").

Communication Setlings

|T5 Runtime Vl

How to Extend the Timeout ?

If typing “PAC IP:502", the

default timeout is 3 seconds, and

the user can type "PAC IP:502(n)"

to set the timeout as n seconds.

(E.g., "192.168.255.1:502(10)"
means the timeout is set to 10
seconds.)

|'IE!2.1 E2.255.1:502

|1E|2.1EE.?E=.E:5EIE

132.168.255.1:502
192.168.71.19:502

132168 78.58:502

(%) Ethernet TCPAP
A) |P adress: |192.1 £ 255 1 |

Part number: a0

) Serial link
PC port;

Baudrate:
Pariby:

Stop bits:

3. Before establishing a connection, make sure the PAC and the network are working properly.
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4. Click the menu bar “Project” and select “On Line”, or click the Al tool button to establish a

01

connection.
] Win-GRAF - Demo
File Edit View Insert
e, N
Work=space
= _|l Demoll

: Tool: Window Help
Build AQ Projects

Clean A1l Projects

Settings.

O Line

aimulate

Diowndoad A1 Projects.

\

Chl+FS
EX

5. Asthe screenshot, if it shows “App: TEST”, different to the current project name (i.e., “Demo01”),
that means there is a project (name: “TEST”) running on the PAC. Click “Stop application” tool button

to stop the “TEST” project.

[ Win-GRAF - DemoOl
Filz Edit Wiew Insert Project
S H = S

£ Ba 8 X Skl

Tools Window Help

L
1

H & % € (& B g

&D iz | f|| App: TERT

6. Click the “Download” tool button to download the “Demo01” project.

#2| o application

¥

=t

Stop application

Contme 7

Contime 7

[ RowR|[_Fw |
N

[ %rﬁ‘{[ T |

7.

Pl |

Workspace

Oooo [PAC_Time]

i Y e d R

_ MEEpNon programs
[—:||_] Programs

V”iﬂ PAC_ Time [*Get # Set..
=] LD1 [*Blinking]
[ ‘Watch [far debuagaing) B

o R Sl Scope
o B Iritial values
%é Binding Configuration

R1: Get current t...

g Global defines
‘ﬁﬁ Warniables ]
e [y Types

Inst_TIME_ET
En TIME_GET Eno

If RUN is displayed, it means that the "Demo 01" project has been successfully executed on the PAC.

f

ot

D

whia

Ha

hinwst

Current time of th...
LPAC MYear = 2014

|-PAC_Month = 4

LPAC Day =7

LPAC WieekDay =1

L PAC Hour =13

|-PAC_Minute = 55

2
4 ¥ PAC Time

“ariables

SEcan kPAC_Second =23
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(%5 " A RUN PAES R @
A °F Hame | % alue |
= ] PAC Time ("Get / Set Fa
| Inst_TIME_GET
Inst TIME SET
B fat Global variables
PAC Year 2014
FPAC Month 4 [
PAC Day 7
PAC WeekDay 1
PAC Hour 13
PAC Minute 25
PAC Second 23 e
The current time on 2 ~
the PAC is displayed. E|
1 Adwvanced
[ Avithmetic
[0 &rrays
[ AS-interface
bt [J BAChet v
z 4 *| Blocks; Sovlist Define ENUE




Note:

the solution.

Cycle time

When on-line with the PAC, move your mouse over the “RUN” position on the toolbar to view the

If there is any error message show up during the download process, refer to Appendix B to get

current cycle time of the program on the PAC. You can also view the cycle time in the bottom-right
corner of the message area.

Win-GRAF - Demo01

& % e AR e (5

A RUN

File Edit View Inmit Project Toole Window Help
o 4 A —::‘nl [h . _k +":|
Workspace o000 [PAC_Ti
[* Demo01 [RUN
i,
L3 Exception programs R1: Getc.. [|TIME _GET
[_J Programsz B
“HE) PAC_Time [*Get ... | Year
“Ee] LD [*Elinking®)
[ 3 ‘watch [for debugging) | | ha...
&R Soft Scope
=4 Initial values — bay
'ﬂé Binding Configuration Day
«2q Global defines B
ta} Wariables M
B Types |
| Mi...
| | Se. ..
<
4 ¥ | PAC Time ~ “ariables

Demol1 - 192.165.71.19:502
# | Time

Current tim...
FAC_ear...

FAC_hont...
FAC_Day=1
PAC_Maak...
FAC_Hour ...
PAC_Minut...

FAC_Seco..

Inst_TIME...

LD

| Event description

A5 Mam

= Madmuom = 36
Ins{ Owerlow =0
Ing o
Local application:

pa| CRC=16#:££d8172
P Target application:

A
pa| CRC=16#ctda172
B4l =75216 btes
< Elapzed: 15ml3s

4 ¥21 - 05042014 - 02:57.05

V31 - 090442014 - 085705 [

3 A

[ [Uzed]
1 [Project]
1 Advanced
1 Anthmetic
[ Amays

T ACmbarfamas

4 *| Blocks. Sowlist Drefine

ENLUIRA

LN

1 20000407 00:15:21.000
2 2000401401 00:15:29.000
3 2000401401 00:15:37.000

Board errar in the slot Mo, 11
Board errar in the slot Mo, 11
Board error in the slot Mo, 11

Cycle time (ms):
Last=2
Allowed =0
Maximum = 36
Overflowe =0

Local application:
4 ¥ Build Crasz reference @ all stack Breakpaints Diqital sampling trace Frompt HhAl

When doing the “On Line” ( Al ) operation, it will automatically switch to the “Runtime” tab and you
can see if there is any error message for the downloaded program. (E.g., in this example, we need to
plug the I-8055W module in the Slot1 of the PAC, and the message “Board error in the slot No. 1 !”

means there is no I/0 module in the Slot1 or an /O exception.)

Shutting down the PAC, and plug one I-8055W module in the PAC’s Slot1 then reboots. Then, click

“On Line” ( Al ) button to connect to the PAC.

Demo1 - 192.168.71.19:502

# | Tirne

| Event description

4 F | Build Cross references Call stack Breakpoint=

Digital zampling trace

RN

Crycle time (ms):
Last=2
Allowed =0
Maximum = 36
Orverflove = 0

Local application:
Frampt Hidl
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2.3.6 Testing the Program
In the previous section, you have successfully downloaded the “Demo01” project and the following will
describe how to test the program.

The “PAC_Time” Program:
1. Mouse double-click the variable name (e.g., “new_Year”) in the “TIME_SET” function block (or the

Variables Area) one-by-one to change the PAC’s system time (e.g., to change it as January 1, 2015
12:30:35).

oogoo [PAC_Time]

A F Mame | Walue |

PALZ_Manth 4 ~
| |R2: Set TRUEtD ... Set T T @ PALC_Day 7

PAC WeekDay 1

newy time for the ... PAC Hour 14
. new_ygar = 0| vear PAC_Minute 16
new_Yes PAC Second 41
new_Year 0
] |2':I14 | new_konth
new Day
g [ Force | new_Haur
new hinute
. |

[ (Al

[ [Used)
15 a7 0§34 [Praject] B
OOOOOEEE  EFROFEEFFD ey Advanced

1 24 33 15 |3 Arithmetic

setTRUEW s=tn.| OOO00000 OOOOO0O00 |23 A
[ AS-interface

| | R3 R B [ BAChet w

z 4 *| Blocks Sow list Crefine EMLIk4
4 @ ariablas

2. Set the “Set_new_time” variable to “TRUE” to write the new system time.

Set TRUEto =etn..

| W

3

oooO [PAC_Time]

#||"F Mame | Walue |

Set TRUEto =et n...

Inst_TIME _SET PAC WeekDay 1 -
_|RZ: Set TRUEto ... Zet TIME_SET  Qf— FAC_Hour 14
FPAC_Minute 30
newy time for the ... PAC Second 7
| | nevw _Year = 2015 vear new _Year 015
nea_hlanth 1
| nesw_Month = 1 karth nesw_Day 1
newy Hour 12
nesy_Minute 30
| nesw_Day =1 Day E new Secand 35
Set_new_time FALSE |«
| new_Hour =12 JHaur —‘ | »
Set_new_time X

|3

new_Minute = 30 Minute [ TRLUE ‘\ i1y =

[ FalsE (o))

newy_Second = 35| Second
Set TRUEto set ...

| R3 R —Kl ol
£ | EMUIbA

4 *»| PAC Time  ‘fariables
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3. Then, the new system time will show on the “TIME_GET” function block (or the Variables Area),
and the “Set_new_time” variable will be reset to “FALSE” automatically.

oogoo [PAC_Time]

# | ["F_Mame | Walue |
nesw_Year 2015 ~
nea_hlanth 1

nesw_Day 1
Current time of th... new_Hour 12

LPAC Y =2015 i
| Year _vear nesy_Minute 30

nesy Second 30

e .
Month |-PAC_hartth = 1 q_Set new time
LED1

\ LED2
Day |- PAC_Day =1 LLoeT Al variables

The new system time. |1.0-i_8055_D v
whay |-PAC_WeekDay = 4 — >
[ (&) J_\
[ [Used)

[ [Froject] B
1 Advanced

[ Arithmetic

[ Arrays

1 AS-interface

[ BAChet w
* | Blocks. Soviist [refine ENU;

R Get current t... FER no

Hour |-P&C_Hour =12

Minute |-PAC_Minute = 30

Second |-PAC_Second = 35

4l
4 ¥ | PAC Time  ‘fariablas

£
AEHEEREEHEERE

| %

The “LD1” program:
4. When the “Demo01” project is running, you can check to see if the DO0O, DO1 and DO2 tags of the

[-8055W 1/0 module that plugged in the slotl of the PAC is blinking every two seconds (like the
value "T#2S” we set before). You can also assign a “TIME” variable on the left side of the “CYCLE”
for easy to change the time setting. Refer to Section 2.3.1 for the setting way.

5. If the “%QX1.1.3” variable is set to “TURE” in the Variable Area, the LED4 (i.e., “DO3”, at the top of
the 1-8055W 1/0 module) will light up.

AN WEY RRET R W, - L & Y € G B e (5 " A RUN AR S n i &
= | DemoD1 [RUN] AT Mame | Walue | Tope
----- | Ewception prograns LED1 = TRUE B8 %01.0- I_BDEE_DI ﬁ
&1 [ Programs RUM. - BLINE B8 %0x1.1 -0 8055 DO
....... “HE] PAC_Time [*Get ... %=1.1.0=0utput! TRUE BOC
3] LD [*Blinking®) m LED?Z = TRLE Y11 1=0utput2  TRELE Bt
[=] 1 W atch [for debugging) | CYCLE 4
- Soft Scope G110
o ] Initial walues Output = TRUE
!!é Binding Configuration H
- 3q Global defines ZETH 0
]ﬁ Wariables OutputZ = TRUE
Lo s Sl 1 2
Outputs = TRUE

K4
| £

< |
4 b FAC Time “ariables L1

| »

6. Click the Al tool button again to cancel the PAC connection.
Note: Do NOT click the “Stop Application” button; it will stop the running project on the PAC.
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Chapter 3 Modbus Slave: Allow the SCADA/HMI Software to
Access Win-GRAF Variables

The chapter describes how to allow the SCADA/HMI software (e.g., “InduSoft”) to access Win-GRAF
variables that defined in the "Demo01" project. Win-GRAF provides two communication ways to open
variable data, one way is to enable the Modbus TCP Slave function and the second way is to enable the
Modbus RTU Slave function (you must first complete all the Modbus Slave settings in Section 3.1, and
then refer to Section 3.2). To begin, follow these steps:

3.1 To Enable the Win-GRAF PAC as a Modbus TCP Slave

1. Click the “Open Fieldbus Configuration” tool button to open the “lO Drivers” window.

[ Win-GRAF - DemoO1
File Edit ¥iew Insert Project Tools  Window  Help

FEIE R R O LT

Workspace 10 Drivers *

B _|l Demoll E Mame | walue T Mame | Type
1 Exceplion prog... || 5 = {2} Global variablas
-3 Programs PAC Year DINT —

*ﬁj PAC Time... B PAC Month  DINT

%) LD [*Blirk.. || = PAC Day DINT
El'_j Watch [fD[ de E {l‘l.i\ll’“ RN [T [ Iy —

iR Soft Scope Q = =
e 2 Invitial values blans | Value
M3 Binding Corfig... || &%

- 30 Global dfines
a3} Wariables o

e Y Types
< | »
4 FALC Time “fariables LD1

Build 74
Cawin-GRAFYProjectzhDemol
Mo emor detected

4 ¥ | Build Crozs references Funtime Call stack Breakpoint=s Digital sampling trace Frompt | Hbdl

fready OffLine 192,168,255, 1:502 A 0,0 00 0,0

2. Click the “Insert Configuration” button on the left side of the “IO Drivers” window and then select the
“MODBUS Slave” and click “OK” to enable a Modbus TCP Slave.

10 Drivers *

= | e | Yalue

‘ Add Configuration X

5 Choose a configuratian
A (Al ]

E ; LfIEI]DBLIS

- MODBUS Master
O | {ODE S Slave

4 FAC Time ‘“Wariables L1 | 1D Drivers
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3. Click the “Insert Master/Port” button on the left side to set the “Slave number” (In this case, the
value is “1”), and click the “OK” button.

10 Drivers *
S MODELS Slave

M arme | Walue

MODEDSE Slave Protocol

q
Slave number;
g

Bt

Slave numnber | Server D

4 * FALC Time “Wwariables L1 10 Drivers

4. Click the “Insert Slave/Data Block” button on the left side to open the “MODBUS Slave Request”
window.

0 Drive
B =-Mg MODEBUS Slave Marme | Walue
2 | o Slave number 1

K Server D \

1. Press the “F1” key to open the Help on this subject.
2. If you add two or more “Server - ...” settings, type a
“Server ID” for easier use (a string, e.g., 'SVR1’)

mmﬁ

B

Request | &ddress | Mb Item | Description |

4 PAC Time ‘Jariables LE1 | 1D Drivers

5. Enter a simple note in the “Description”  R.lunzliESd EUER L2 E T2 E

field and then click the "Input Registers” Request
morcz
Description: Read_Yalue | -
LN

option.

For Modbus Master to Read data:

Diata read by the master ]
Options Data types Enter a simple note.
- ) Input Bits
Input-bits BOOL o et
Input Registers BYTE, INT, DINT, 6% o
REAL, etc. Diata read or Forced by the master
For Modbus Master to Write data: O Cail Bits
o () Holding Registers

OP:'?:S 2ELE) 5 Recommend to set

Coi ‘- its BOOL Diata block, ”Base addressn to nln

HOI(.:Img BYTE' INT' DINT' Base address: and set the value of

Registers REAL, etc. “Nb items” is greater
(Refer to Appendix A to view more data type) Mb items: than “200”.

Win-GRAF User Manual, V2.0, Aug. 2020 by ICP DAS 3-2



6. As the screenshot above, it’s recommended to set the “Base address” to “1” and the “Nb items”
refers to how much variable data can be provided by one “data block”. If the data address requested
from the Modbus Master (e.g., the SCADA software) is greater than this value (in this example, the
value is “2000”), the Modbus Slave (i.e., Win-GRAF PAC) will not respond.

7. Mouse drags all the needed variables (e.g., “PAC_xxx", data type: “DINT”) one-by-one from the
Variables area and then drop it to the “Symbol” field.

IO Drivers *
=M@ MODBUS Slave Mame | Walle “F Mame | Type | Drimn.
El-ﬂ-; Server - Slave nurmber = 1 Fequest  Input Registers PAC Month DIMT ~
I ---“E Input Registers [1..2000] - Fead V4| Address 1 PAC Day DINT
B Nbltem 2000 PAC WeekDay DINT 1
ik Dezcripti... Read Value I—‘AL_Huﬂr LI
E L FAC Minute DINT
_ Symhbal | Offzet | hd azk, | Storage | f PAC Shcond DINT “
PAC_Year 0 FFFF Diefault | s
&5 PAC_Manth 1] FFFF Default Name/l | Value |
PAC_Day 1 FFFF Default P ”
B4 PAC Hour 0 FFFF Diefaul Plig
PAC_Minute n FFFF Default - -
PAC_Second 1] FFFF Dttt ~ -

-
-

N -
- -
-——
—

*" 4_ _——— -
£ [
4 ¥ FAC Time “Wariables L1 10 Drivers

| "

8. Mouse double-click the “Offset” field and fill in a value, then press “Enter” key to finish the setting.
Note: (1) The “Offset” value starts at “0” and the Modbus address of variable is equal to this value
plus 1 (Base address).
(2) If using a 32-bits (or more than 32-bits) data type (e.g., “DINT”, refer to Appendix A),
it requires two Modbus addresses, as the table below, the “Offset” values are 0, 2, 4, 6, etc.

Suernbol | Oiffset | Mask | Storage
PAC ear 0 FFFF Drefault
PALC_Manth 2 FFFF Drefault
FAC_Day 4 FFFF Default
PAC_Hour 5 FFFF Drefault
PAC_Minute EI FFFF Drefault
PAC_Second 0 FFFF Drefault
PAC ‘wWeekDay 0| Enter FFFF Defauilt

Tips:
Mouse click the “Offset” field and press the keyboard “Ctrl+A” to select all items, and then click the
“Iterate Property” button at the left-side to open the settings window.

5 Symbol | Drfset 4| Mask | Storage
] PAC_vear Drefault
&2 PAC_Marth Drefault
B+ PAC Dayp Default

PAC_Haour Drefault

PAC_kinute Ctri+A Drefault
C_Second I} Drefault

Drefault

PAC WeekDay
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Keep the “Name” setting, enter “0” into “From” field and enter “2” into “By” field, then click “OK”.

(If the “Name” is set to “%%”, it will show “00, 22,

44, 66, 88, 1010, 1212” in this example. The user
iz * | can modify it depends on the needed settings and
Frorm B 2 2 then check the value in the “Results” area.)

Fiesults 1

Surnbial | Oiffget 4| Mask | Storage
PALC ear 1] FFFF Drefault
FALC_Month 2 FFFF Drefault
PAC_Day 4 FFFF Drefault
PAC_Haur G FFFF Drefault
PAC_Minute a FFFF Drefault
PAC_Second 10 FFFF Drefault

[ ok W[ ca PAC_ weskDay |12 FFFF Drefault

AN

% >

FAC Time ‘JWariables LC1 | 10 Drivers

9. Click “Storage” to select entire columns and then press “Enter” key to display a drop-down menu.
Then, select “DWORD (Low — High)” and press “Enter” key to complete the setting. (If using a 16-bits
or below, it’s no need to set the “Storage” item.)

Symbiol | Difset | Mask | Starage 4| Range [Low]
PAC “ear ] FFFF Default \

PAC_Maonth 2 FFFF Drefault

PAC_Dap 4 FFFF Drefault

PAC_Hour 5 FFFF Defaul

PAC_Minute 3 FFFF Defaul

PAC_Second 10 FFFF b=k

PAC weekDay 12 FFFF 0 | Default A

CwORD [High - Low
CwORD [Low - High)
STRINGIE]
STRINGIE]

FAC Time | “arizbles | LD | 1O Drivers STRIMG[10]

To expand this “Data Block” and you can see the Modbus addresses of all variables. It equals to the
“Offset” value plus 1 (Base address).

10 Drivers *

E 1 MName | Walue
2 \ = +0..1: PAC_Year A equest [nput Reqisters
I = +2..3 PAC_Month Address 1
E 2| +4.5: PAC_Day Mb Item 2000
= 3| +6..7: PAC_Hour Deszcrption  Fead_Walue
E =3 +3..9 PAC_Minute
Q = +10.17: PAC_Second W
. 2| +12.1:3% PAC “WeekDa ot
28 Syumbal | Dfset | Mazk | Storage | Range (Lo
g PALC “Wear 1] FFFF Liw/ORD [Low - High)
PaC_konth 2 FFFF LwfORD [Low - High)
PaC_Day 4 FFFF LwORD [Low - High)
PAC_Haour B FFFF LwORD [Low - High)
PAC_Minute a FFFF Liw/ORD [Low - High)
PaC_Second 10 FFFF LwORD [Low - High)
PaC_weekDay 12 FFFF LwORD [Low - High)
£ [ ¥
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10. Then, we need to add the second “Data Block” for the Modbus Master to read the Boolean data.
This configure way is similar to the step 4 to 8:
(1) Click the “Server - ..."” item and click the “Insert Slave/Data Block” button at the left side to open
the settings window.
(2) In the “MODBUS Slave Request” window, enter a simple note and select the “Input-bits” option,
then set “Base address” to “1” and set “Nb items” to “2000”.

10 Drivers *

E M@ MODBLS Slave
Egx e punmber = 1

5 :
@ -8 InpFegisters [1..2000] - Read_Walue

x

MODBUS Slave Request |

N |

Request

1= ¥

Description: |Read_E!cu3Iean ‘

Data read by the maske)

Enter a simple note

{*) Input. Bits
i) Input Reqgisters

For the Modbus Master to Read data:

[rata read or Forced by the master

Option Data Type
. () Coil Bits
Input Bits BOOL O oding Regist
Input Registers BYTE, INT, DWORD, e
put Reg REAL, LINT, etc. Data black
(Refer to Appendix A to view more data type) B it

Mb items: 2000

(3) Mouse drags the Boolean variables (i.e., “LED1”, “LED2”; data type: BOOL) one-by-one and drop
them to the “Symbol” area, and then set the “Offset” to “0” and to “1”.

10 Drivers *
I Elﬂ-; Server - Slave number = 1 A || Name | Walue “F_Mame | Tupe
i Fequest  Input Bits LED BOOL |~
Address 1 0z BOOL | -
Mbltem 2000 /= RETAIN variables 3
Descrption  Fead Boolean ,(/ il ¥
7
| Storage | Rang M ame | Walue
Default P -
Default’ _-" -
-T S Ik

4k FAC Time ‘Wariables LC1 . 10 Drivers

You have completed the settings for the Modbus Slave. Finally, follow the way below to re-compile
the program and download it to the Win-GRAF PAC.
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11. Click “Project” > “Build All Projects” from the menu bar to compile this program again (refer to
Section 2.3.4). If a message informs you “No error detected” that means this process is successful.

Build 3
n Line Chanhge iz dizabled ~
[ [MODEBUS-5): [4): PAC Year "Waming: 32 bit word ardenng not supported by ntime 7.4 and older ]
< CT Segment = 55 byte(z] »
<161/0z > . L . .
_ This version information can be ignored.
Relocating code...

< Code CRC=3237937fc - File CAC=eb3d0c1E - Size=3672 »

CrozE references Runtime Call stack Breakpoint=s Diigital sampling trace

12. Mouse right-click the project name (i.e., “Demo01”) and select the “Communication Parameters...”
to set the PACIP (e.g., “192.168.71.19:502”) and then click the menu bar “Project” > “On Line” (or

Al ) to establish a connection and download this project to the Win-GRAF PAC. (Refer to Section
2.3.5).

File Edit ¥iew Insert Project Tool: Window
AN B2 AN R TRECEECN

Worksnare
fin-GEAF - Demo01

Edit Wiew Insert B3 i Tool: Window Help

= E]j QummunicaﬁnnPaxs.mﬂters..\ e A ,,l Build &1 Projects | E?

"""" j' || On Line k?pace Clean A1 Frojects

e E‘m Diowndoad A1 Projects.
#-- wCephion pro Settings
£ Programs -
% PaC_Tin| @) Onlins wp | Ctil+F5
o 2] LDV EBI b Simmlste N o7
SCADA / HMI Win-GRAF PAC

= 1 IP:192.168.71.19

-~ =
LC} InduSoft '-'j Port: 502
< T
-

InduSoft
Slave number =1 piian
IP: 192.168.71.xxx WP-5xx8-CE7 WP-9x28-CE7
Mask: 255.255.255.0
Modbus TCP Master Modbus TCP Slave

(Check P1-1 to view all PAC models)

After completing all the steps, the HMI/SCADA software can access to all the Win-GRAF variables listed
above via Modbus TCP protocol.
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3.2 To Enable the Win-GRAF PAC as a Modbus RTU Slave

Before doing this, you must complete all the content that described in Section 3.1 to open the Modbus
Slave data. The way to enable the Win-GRAF PAC as the Modbus RTU Slave is to add the “MBSLAVERTU”
or the “MBSLAVERTUEX” function block in the program. To begin, follow these steps:

Add the “MBSLAVERTU” function block
1. Inthe “LD1” window, mouse click the place where you want to add this function block and then click

the “Insert FB..” button on the left side of the window.

1F /_\
3 LEDM -
R
m il |
- I LEDZ
| T#25 | CYCLE |
%EH1 1 0
Outputt
= |
a1 11
! Outputz
> I
el 1 2
= OutpLta

W

4 b PALC Time ‘u‘ariableﬂ Crrineers :

2. Double-click on this function block and select the name “MBSLAVERTU”, then click “OK”.

R2 M & Q |
] I K TF LML [*Matural logarithm [LREALJY) ~
N TTF LOADSTRIMG [*Get a sting from a table®)

TF LOBYTE ["Low part of a word®]

It LOG (*Logarithm [base 10)7)

LOGFILECSY [*Generate log file in C5W formnat®]

IF LOGL {*Logarithm [base 10 - LREALF)

T LOGMESSAGE [*zend a LOG message”)

T+ LOWWORD (*Low part of a double word®)

I+ MAKEDWORD [(*Pack words to double waord®) =
TT MAKEWORD [Pack bytes to ward)

TiES: T MAX (<M aximum*)
“ ” . MEMASTERRTU (MODBUS Master RTUY
Press “MBSL” key to quickly MBMASTERTCP (MODBUS Master TCP)
find out the function name. T} MBSHIFT [*Multibpte skift/rotate?]
11 hiPc] A EINE L =0 = b P

Nb Inputs: I:l I Ok, Q l Cancel
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3. Inthe “MBSLAVERTU” function block, mouse double-click the left side of the “PORT” and enter a
string 'COM2:9600,N,8,1' (it means using the Win-GRAF PAC’'s COM2 to communication with the

Modbus Master) and then click

Rz

“ to complete the settings.

Inst_MWBSLAWERTL
: I MESLAWERTU I
\ Tips:
> Press the “F1” key on this
'COMZ:9600.8.2.1" v | x function block to show up
ﬁ UariablES: [EI"] e - the related Help.
#--[ Inst_BLINE
a7 Inst_MBSLAVERTL
Oy LEDT
G I FO7 b
W ariables: [all] W
[]Local variables anly
[ ]Hide FE instances

4. Double-click the left side of the “SLV” and then enter “1” (the value set in the Section 3.1 - Step 3),

then click " to finish the setting.

F2

In=t_MBESLANVERTL

'COM2:9500,H 5 1"

Ik WMESLAVERTU & I

R2

'COMZ:9600M 5,1°

PORT
1 Ll 4
#3 Yariables: [all) -~
Lo 4 [ Inst_BLINE
a0 Inst MBSLAVERTU
B, LED1
B FOo ¥
Yariables: [all] w
| N RPN [N N I (R 1t
Inst_MBSLAWERTL I

Ik MBESLAVERTU 2 I

PORT

Now, you have completed the setting of the “MBSLAVERTU” function block, and then re-compile the
program and download it to the Win-GRAF PAC. (Refer to Section 2.3.4, Section 2.3.5)

Note: Users can enable multiple Modbus RTU Slave ports for each PAC (recommend not over 16 Ports),
the way is to add multiple “MBSLAVERTU” function blocks and set the different “Port” value.

Win-GRAF User
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SCADA / HMI
COM2: RS-232

InduSoft - 9600 N 8 1
InduSoft ”‘-—j < >

Slave number =

WP-5xx8-CE7

Win-GRAF PAC

WP-8xx8

Modbus RTU Master

Modbus RTU Slave

Add the “MBSLAVERTUEX” function block
When using several “Server - ...”

(Check P1-1 to view all PAC models)

settings (recommend to set one) in the “l10 Drivers” window, the user
needs to use the “MBSLAVERTUEX” function block.

10 Drivers *

Mare | Walue

Slave number 1
Server 1D Syl

wer - Slave number = 1
[nput Reqisters [1..2000] - Read_Walue

e |

E ----“E [nput Bitz [1..2000] - Read_Boolean
1__'- L
Request | Address | Mb Iterm | Description
E Input Registers 1 2000 Read_' alue
Input Bits 1 2000 Fiead_Boolean

=138
4 FAC Time “Wariables LD

1. Follow steps 1 to 4 above to add the “MBSLAVERTUEX" function block. If you want to change the
usage for existing function block, mouse double-click the “MBSLAVERTU” and change it to the
“MBSLAVERTUEX”, and then click the “OK” button.

F2

IrJ MEISLA"-.-"EHTLI ]

COMZ2:3600 M5 1 JPORT

1
ﬁ
It LOADSTRIMNG [*Get a sting from a table®)

TF LOBEYTE [Low part of a ward”)

\ I} LOG [“Logarithm (base 10]%)
LOGFILECSY [*Generate lag file in CSY format)

I} LOGL ["Logarithm [base 10 - LREALF)

T LOGMESSAGE [*zend a LOG meszage”]
I} LOWORD [*Low part of a double word®)

| >

1450y

Function

=R MAKEDWORD [*Pack words to double word®)
@ AkEWORD [*Pack bytes to ward”] —
[T MAX [*Maximum™]

MBMASTERRTU [*MODEBUS Master RTU")

MBMASTERTCF ["MODEUS Mazter TCP¥)

TF MBSHIFT [*Multibpte shift/rotate®]

I+ MBSLAVEIDEMT [*Set MODBUS Slave Device |dentification®]

FE WMBSLAVERTU FMODRIS Slave BT [seral]
Function Block BSLAVERTUER [*MODBUS Slave RTU [zeriall?]

LG g v o iy e gy ) ) ) e ) |

B oo ST Y1 I TR N _WHUT_1 XTI L Lire

e [

Nb Inputs:

Ok ‘ ] [ Cancel
AN
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2. The “MBSLAVERTUEX” has a “SrvID” setting. Double click the left side of the “SrvID” and enter a
needed “Server ID” (using a string format, e.g., ‘Svrl’).
Note:
Using the “MBSLAVERTU” function block means the first Modbus Slave setting will be enabled.

Using the “MBSLAVERTUEX” function block means to enable the Modbus Slave setting depends on
the “Server ID”.

Inst_MP=1 8WERTL

Rz | MBSLAVERTUEX 2 I
I ——

'COMZ:9800,M 51" JpoRT Tips:

Press the “F1” on this
function block to show
up the related Help.

1450

Inzt_MBESLANVERTL
F2 | MBESLAWERTUER 2 I

CORZ2 9800 M G 1 PORT

1450

~—_

Now, you have finished the settings for the “MBSLAVERTUEX” function block, and then re-compile
the program and download it to the Win-GRAF PAC. (Refer to Section 2.3.4, Section 2.3.5)
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Chapter 4 Linking “I/O Boards”

This section lists the usage of the “I/O Boards” function in the Win-GRAF Workbench to link the Real I/0
modules or to enable other I/O functions. First, you need to know the slot numbering and supported 1/0
modules for each PAC:

Slot No. (from the
PAC Model left to the right) The supported PAC I/0 modules
Supported:
WP-9x28-CE7 Oto7
X I-9K and I-97K series 1/0 modules.
WP-8xx8 Oto7 Supported:
WP-8x28-CE7 Oto7 I-8K and I-87K series (High Profile) /O modules.
XP-8x38-CE6 (*) 0to 7 (E.g., I-8017HW and 1-87055W)
Not Supported:
XP-8x48-CE6 (*) 1to7 I-8K and 1-87K series (Low Profile) /0 modules.
VP-x2x8-CE7 (*) Oto?2 (E.g., [-8017H and |-87055)
The Palm-size PAC which can support one XV board.
(E.g., XV107, XV116, XV308, etc.)
WP-5238-CE7 The XV board is a kind of the Modbus slave I/0 board.
Refer to Section 5.1.6 to 5.1.12 for using XV-boards.

(*) : The XP-8038-CE6, XP-8048-CE6, VP-x208, WP-5xx8-CE7 are the 0-slot PAC.
(Check P1-1 for all PAC models)

Add the “1/0 board”
“I/0 board” refers to the 1/0 functionality in the Win-GRAF (e.g., “i_8037_D0O") and
“I/0 module” refers to the hardware device (e.g., “I-8037W*).

Notice:
Besides the software setting for the 1/0 board, there are some kinds of I/0 modules need to set the

hardware Jumper (e.g., Single-ended and Differential Jumper). So, go to the website to look up the
product information, or the description printed on the module cover, or the attached shipment
document.

I-8K and I-87K series product website:

http://www.icpdas.com/en/product/guide+Remote__ | O Module__and__ Unit+PAC__ %EF%BC%86a
mp;__Local__| O Modules+I-8K_I-87K__Series__(High__Profile)

1. In the Win-GRAF, click the "Open 1/0s" button from the toolbar to open the “I/O Boards” window.

File Edit View Insert Project Tools Window Help

Sld Gl m X aloln a;;@mmﬁsgg&?'@w

2. Asthe figure below, mouse double click the slot number that corresponds to the real I/O module
and then select the proper I/O board (e.g., i_8037_DO).
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http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+PAC__%EF%BC%86amp;__Local__I_O__Modules+I-8K_I-87K__Series__(High__Profile)
http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+PAC__%EF%BC%86amp;__Local__I_O__Modules+I-8K_I-87K__Series__(High__Profile)

Note: The Slot 0 to Slot 7 are reserved for real I/0 modules that plugged into the PAC, and the slot

8 or above are for other usage.

i Library: \_Devic

5 [all} | IDCON (* Enable one serial port to connect DCON [#0s %) ~
c ICP DAS - XP-wP- |i_8017_08ch (*8-ch A/l , differential (for I-8017HW, I-8017HCW & | —
c CFandard li_8017_16¢h (* 16-ch A/l , single-ended (for I-8017HW, I-8017HCW
g

q

10

112 Select it and to view

13 the setting description.

14 —
15 1-8037w

15

16-Ch Digital Outputs

Nov.05,2013
ICP DAS |, Taiwan

Buttons Description: (Click the following buttons to modify the settings)

iiif 170 Boards “Close”:

( \ d his wind
a & ose this window.
i_E”:':E:—-‘T__D |:| Y ‘
2 1 __S elect “Select”:
- Open the I/0 selecting window.
4 | Delete |
5 ( Hot Key - “Enter”: to open ;
g m] Hot Key - “ESC” : to exit)
8 Properties
9 ;] “Delete”:
10 [ Viual/Res || pelete this 1/0 board.
13 ename”:
}g Rename this I/0 board.
16 | Help |
17
“Properties”: Look up the usage of this I/O board.
“Virtual/Real”: Change the I/0O board to a Virtual I/O (for testing) or a Real I/0. (Hot Key —
”Space")
“Move Up”: Move up this I/0 board.
“Move Down”:  Move down this I/O board.
“Help”: To view the description of “I/O devices”.
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4.1 DI/DO Boards

Here use the "I-8055W" as an example, users can refer to Chapter 4 (P4-1) to add this I/O board.

1. Double-click the “i_8055_DI” (or the “i_8055_DQ”) to open the “Properties” window.
Note: A mouse-over showing the details on the “i_8055_DI” (or the “i_8055_DO”).

£EEE 170 Boards

Key=6

Ref=16#80554
Resrved0=0

Reserved 1=

Reserved 2=

Reserved 3=

i 1_8055 - Pmpel:ﬁes

Reyz
Ref = 16#80554

Reserved0 =0
Reservedl =0
Reserved2 =0
Reserved3 =0

1-8055w/

Setting Description

8-Ch Digital Inputs + 8-Ch Digital Outputs

Now.01,2013
ICP DAS |, Taiwan

2. After linking the “i_8055” I/O board, it will auto add 8 Input and 8 output variables in the
“Variables” window that can be used in the program.

Variables BEX
“F MHame | Type | Dim. | &b | Spb. | Initvalue | User Group | Tag | Description
LED1 BOOL ] ~
LED2 BOOL ]
H_QET,MM e pimlle
oW %0 D +ﬁ> %IX1.0 —i_8055_DlI
ali.0. npu .
%161 0.1 BOOL pat [ %QX1.1-i_8055_DO
delbs) 0.2 o0l Ll “I” means “Input” “Q” means “Output”
%0¢1.0.3 BOOL
%0104 BOOL O “X” means “Boolean” “1” means “Slot 1”
%lx1.0.5 BOOL O
%IX1.0.6 BOOL O Note:
K Note:
= 21;;><1_1 - i_BDESBSI = Double-click this item to modify the variable
T T =TaI8] N Output [ name and click “Enter” to accept the setting.
SK1.1.1 BOOL Qutput [
Y1 1.2 BOOL Output [ B %0K1.1 -0 8055 DO
%0113 BOOL Output [ : =Talal Output
%0114 BOOL Cutput [ ( |Dutput1‘) || Olutput
20115 BOOL Output [ . <
%QX1.1.6 BOOL Output  [J Allal 1.2 BOOL Output
%QX1.1.7 BOOL Output [ Hllx1.1.3 BOOL Cutput
4 —
4 » FALC Time Wariables
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4.2 i_scale (Conversion Table)

The “i_scale” function can set up to 29 scaling functions to convert values for the Al or AO module that
plugged in the slot 0 to slot 7. Refer to Chapter4 (P4-1) to add this I/O board.

1. Mouse double click the "i_scale_0" (or "i_scale_1" or "i_scale_2") to open the “Properties” window,
and then to view the setting description.

Note: Using the slot 8 or above No. because the slot 0 to slot 7 are reserved for the real /O module.

i£6£ 1/0 Boards
A

|Key=6 '
Ref = 16#24

ChO0_X0_reserved =00
Ch00_X1_reserved =0.0
ChOO_YO0_reserved = 22

QO = [0 O (L0 (D | — O

ChO1_YO0_Engineering ¥al For X0=00 0.0
Ch01_¥Y1_Engineering Yal For X1=00
TCho2— X0 Win_Physical_Yal =00
Ch02_X1 Max_Physical Yal=00
Ch02_YO0_Engineering ¥al For X0=00
Ch02_Y1_Engineering Yal For X1=00

12 Ch03_X0_Min_Physical ¥al=00
|Ch03_X1_Max_ Physical ¥al=00 . - Ml
13 e e Setting Description ==
14 2%
e scaling function No. 01 to 29 for scaling | /0 variables .
ting both value of Ch_X0 and Ch_X1 to 0.0, it means the relative scaling function No. is disabled.
_X0is greater than or equal to Ch_X1, the setting is wrong. ¥
< B2

Parameters: (“Ch” means the Ch01 to Ch29, "Ch00” is a reserved item)
Ch_X0_Min_Physical_Val: The min. value of Al (or AO) boards (X0).
Ch_X1_Max_Physical_Val: The max. value of Al (or AO) boards (X1).
Ch_YO_Engineering_Val_For_X0: The engineering value after scaling X0.
Ch_Y1_Engineering_Val_For_X1: The engineering value after scaling X1.

2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.
Notice:
1. If set both Ch_X0 and Ch_X1 values to "0.0", it means the relative scaling function No. is disabled.
2. If Ch_XO0 is greater than or equal to Ch_X1, the setting is wrong.
3. If Ch_YO is equal to Ch_Y1, the setting is wrong.

For example, if the Al board's value is 4 to 20 mA and wish to scale as 0 to 10000, then set Ch_XO as
"4.0", Ch_X1 as "20.0", Ch_Y0 as "0.0", Ch_Y1 as "10000.0".
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For example, if the AO board's value is -10 to +10 V and their respective engineering value is
-50 to 1200, then set Ch_X0 as "-10.0", Ch_X1 as "+10.0", Ch_YO0 as "-50.0", Ch_Y1 as

"+1200.0".
0.0: i_scale - Properties £
Key=0 -
Ref = 10#24 =

ChoD_X0_rxeserved =0.0

ChO0_X1 reserved =00

ChOD_Y0_reserved = gg

UChOO Y1 reserved =
Chil_X0_Min_FPhyzical ¥al=-100

Cho1 X1 Hax ' Physical_¥al=+10.0

Ch01_¥0 Engineering ¥al For X0=-500

Chil ?1 Enmeerm 1|i"al For X1 =+1.20010

111 B
Ch02 Il Hax Ph]rs;u:a.l "i"al on
Ch02_Y0 Engineering ¥al For Z0=00
Ch02_¥1 Engineering ¥al For X1=00
Ch03_X0_Min Physical ¥al=00
Ch03 X1 Max Physical ¥al=00 bl

3. After linking the “i_scale” in the “I/O Boards” window, it will auto add 30 Boolean variables in the
“Variables” window. When the Win-GRAF connects the PAC, it will display the state of each scaling
function.

True: scaling function is ok.
FALSE: scaling function is not enabled or setting error.

T Name | Type | Dir. | Attrib. | Syb. | Initvalue | User... | Tag | Description
= B %IX9.0 -1 scale D A
%0000  [Eelel Input O
%I1%9.0.1 BOOL Input O
%I¥3.0.2 BOOL Input O
%I¥9.0.3 BOOL Input O
%I%9.0.4 BOOL Input O
%I¥9.0.5 BOOL Input O
%I¥3.0.6 BOOL Input O
%I%9.0.7 BOOL Input O
%I%9.0.8 BOOL Input O
%I1%3.0.9 BOOL Input O
= B8 %IX8.1 - i _scale_1
%I%9.1.0 BOOL Input ]
%I%9.1.1 BOOL Input O
%I¥9.1.2 BOOL Input O
%I¥3.1.3 BOOL Input O
%I%9.1.4 BOOL Input O L
%I%9.1.5 BOOL Input O
%I¥9.1.6 BOOL Input O
%I%3.1.7 BOOL Input O
%I¥3.1.8 BOOL Input O
%I%9.1.9 BOOL Input O
C B %IX9.2 -0 scale 2
%I¥3.2.0 BOOL Input O
%I%9.2.1 BOOL Input O
(ofawcl 3:9 [=TaTal Innit :I'W . >
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4.3 i_8017HW (8/16 channels Al)

The I-8017HW can be an 8-channel differential or a 16-channel single-ended analog input module (Data

type: "REAL"). The following will describe a 16-channel module, you can refer to Chapter4 (P4-1) to add

this 1/0 board.

Note: Before using the I-8017HW 1/O module, it requires to set the Differential or Single-ended
Jumper in the hardware.

1. Mouse double click the "i_8017_16ch" to open the “Properties” window, and then to view the
setting description.

£EEE 170 Boards

1]
: w — A
i AN 1:i 8017_16¢ch - Properties
5 Key=6 ]
6 Ref = 16#801716
ChO_type = 16808
7 Chl_type = 16#08
8 Ch2_type = 16808
q Ch3_type = 16#08
10 Ch4_type = 16#08
Ch5_type = 16#08
11 Chb_type = 16#08
12 Ch7_type = 16#08
13 Ch8_type = 16808
14 Ch9_type = 16#08
Chl10_type = 16808
15 Chll_type = 16#08
16 Chl12_type = 16808
17 Chl3_type = 16#08 Setting D . ¥
AT ettin escription
-8017Hw 1801 7HCW , 1-80170W & P ~
16-Ch Analog lutputs [Value type is REAL), single-ended input.
Parameters :
Ch_type : 16HSSRR
S5 - Scaling function is defined by the virtual board "'i_scale"' ----
00 means "Mo scaling"
01 to 29 means "“Appling a scaling function No. [01 to 23] ¥
Parameters:

Ch_type: 16#SSRR
SS : Scaling function is defined by the "i_scale" I/O board (refer to Section 4.2).
00 means "No scaling".
01 to 29 means "Appling a scaling function No. (01 to 29)".
Setting “SS” as other value will use the default value 00.
RR : Range definition of signals.
05 means "physical input signal is -2.5 to +2.5 Volt".
06 means "physical input signal is -20 to +20 mA".
07 means "physical input signal is -1.25 to +1.25 Volt".
08 means "physical input signal is -10 to +10 Volt".
09 means "physical input signal is -5 to +5 Volt".
Setting “RR” as other value will use the default value 08.
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2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.

For example, 16#08 means the physical input signal is -10 to +10 V.
Channel value 5.67 means the input signal is 5.67 V.

For example, 16#209 means the physical input signal is -5 to +5 V with the scaling function 2.
Signal 5.67 V will be scaled to an engineering value by the scaling function 2.

For example, 16#1709 means the physical input signal is -5 to +5 V with the scaling function 17.
Signal 5.67 V will be scaled to an engineering value by the scaling function 17.

Key=6

{Ref = 168801716
IChD _type = 1681709
{Chl_type = 16#08
Ch2 type = 16408
Ch3_type = 16402
Chdtype = 16408
Ch5_type = 16402

Noise_Filter_Max: The max. of the physical value to be considered as noise.
The filter will filter out the signal value beyond it, default setting is "9999.9".
For example, set as “7.9”, signal larger than 7.9 V (or 7.9 mA) will be filtered out.

Noise_Filter_Min: The min. of the physical value to be considered as noise.
The filter will filter out the signal value beyond it, default setting is "-9999.9".
For example, set as “1.5”, signal smaller than 1.5 V (or 1.5 mA) will be filtered out.
Note:
If setting Noise_Filter_Min >= Noise_Filter_Max, filter is disabled.
If setting Noise_Filter_Min < -1000 and Noise_Filter_Max > 1000, the filter is disabled.

Sample_Number: The number of sampled data to be averaged as one data.
Default is “1” (range: 1 to 500). Set a bigger value will reduce the sampling rate,
however the signal curve is smoother than setting a small value.

3. After linking the “i_8017_16ch” in the “I/O Boards” window, it will auto add 16 "REAL” input
variables in the “Variables” window. These variables can be used in the program.

T Name | Type | Dim. | Attrib, | Syb. | Initvalue | User... | Tag | Description
= B %ID1-i 8017 _16ch A
%ID1.0 g BEAL Input |
%ID1.1 REAL Input L1 | You can change the variable
:”"'01'2 REAL gt L & name by double clicking it.
%ID1.3 REAL Input O .
%ID1.4 REAL Input ] | (Referto the Section 4.1)
%ID1.5 REAL Input O
%ID1.6 REAL Input O
%ID1.7 REAL Input O
%ID1.8 REAL Input O
%ID1.9 REAL Input O
%ID1.10 REAL Input O
%ID1.11 REAL Input O
%ID1.12 REAL Input O
%ID1.13 REAL Input O
%ID1.14 REAL Input O
%ID1.15 REAL Input O v
< : >
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4.4

i_8024 (4-channel AO)

The 1-8024W is a 4-channel analog output module (Data type: "REAL") that can be used to output +/- 10

V or 0 to +20 mA signal. Refer to Chapter4 (P4-1) to add this I/O board.

1. Mouse double-click the "i_8024_AQ" to open the “Properties” window and then to view the setting
description.

£EEE 170 Boards

e

1

i 8024 A0

A oo ]

1: 1 8024 AO - Properties R

Key=0

Ref = 16#5024

ChO_type = 16§33

Chl_type = 16§33
Ch2_type = 16§33

Ch3_type = 16#33

Reserved0 =0

Reservedl =

0
Reserved2 = g

Reserved3 =

Setting Description

TOmmElniSiaiooooewin

Parameters:

[ 1-8024w/

4-Ch Analog Dutputs [Value type is REAL)

Parameters :
Ch_type: 16H5SRR
S5 : - Scaling function is defined by the virtual board "i_scale" ----
00 means "Mo scaling"
01 to 29 means "Appling a scaling function No. [01 ta 29]"

Ch_type: 16#SSRR
SS: Scaling function is defined by the "i_scale" I/O board (refer to Section 4.2).

2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.

00

means "No scaling".

01 to 29 means "Appling a scaling function No. (01 to 29)".
Setting “SS” as other value will use the default value 00.

RR: Range definition of signals

30
33

means "physical output signal is 0 to 20 mA"
means "physical output signal is -10 to +10 Volt"

Setting “RR” as other value will use the default value 33.

For example, 16#33 means the physical output signal is -10 to +10 V.

For example, 16#133 means the physical output signal is -10 to +10 V with the scaling function 1.
Channel value is a user-defined engineering value will be converted first by the scaling

Channel value 5.67 is to output 5.67 V ; value -3.752 is to output -3.752 V.

function 1 (i.e., "Ch01") before output it as -10 to +10 V.
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3.

For example, 16#30 means the physical output signal is 0 to 20 mA.
Channel value 12.5 is to output 12.5 mA ; value 6.27 is to output 6.27 mA.

For example, 16#1730 means the physical output signal is 0 to 20 mA with the scaling function 17.
Channel value is a user-defined engineering value will be converted first by the scaling
function 17 (i.e., "Ch17") before output it as 0 to 20 mA.

Key=6
Ref = 16#5024
Chi b= 103
_type = -
Ch2 type = 16#33
Ch3_type = 16§33
Reserved0 =0
Reservedl =0
Reserved2 =0
Reserved3 =0

After linking the “i_8024_AQ” in the “I/O Boards” window, it will auto add 4 "REAL” Output variables
in the “Variables” window. These variables can be used in the program.

¥ Name | Type | Dim. | Attrib. | Syb. | Initvalue | User... | Tag | Description
= H %QD1-i 8024 AO Al
0,
;:gg}? N ;E:t 83;23: You can change thfa v.aria.ble ;:i
%QD1 2 REAL Ouipt 9 name by double c.Ilcklng it.
%001 3 REAL Output (Refer to the Section 4.1) el
< 111 [ >
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4.5 i_87018W (8-channel Al)

The I-87018W is an 8-channel analog input module (Data type: "REAL") that provides thermocouple
input, current input (-20 mA to +20 mA) and voltage input (+/- 15 mV, +/- 50 mV, +/- 100 mV, +/- 500
mV, +/- 1V, +/- 2.5 V). Refer to Chapter4 (P4-1) to add this I/O board.

Important Notice:
® |-87018ZW is better than I-87018W / I-87018RW / I-87018PW because

(A) Each channel can use different range type setting.

(B) Accuracy is better and total 10-Channels.

(C) Temperature input with sensor-broken-line detection.

Please visit http://www.icpdas.com/en/product/I-87018ZW-G_S
® |-87018W does not support sensor-broken line function.

1. Mouse double-click the "i_8018_08ch" to open the “Properties” window, and then to view the
setting description.

£EEE 1/0 Boards

e

2 _87018_08ch - Properties
3 Key = ’
4 Ref = 16#57018
5 Tmp_F = 16801
[ ChO_7_type = 16#05
ChO_scale = 1680
7 Ch1 scale = 16#0
8 Ch2_scale = 1680
9 Ch3_scale = 1680
10 Ch4_scale = 1640
1 Ch5_scale = 1680
Ch6_scale = 1680
12 Ch7_scale = 1680
13 Reserved =0
14 Reserved =0
15 Reserved =0
16 .Remved i Setting Description

17 i-57018w / -87018RW / 16701 8P\ A
8-Ch Analog inputs [Value type is REAL) =5

Important:
1. 1-87018z is better than i-87018 / -87018RW / i-87018PW because

[&] Each channel can use different range type setting.

(B] Accuracy is better & total 10-Channels

[C) Temperature input with sensor-broken-line detection Vv
< * ?

—

Parameters:
Tmp_F: 164#FF
FF: Temperature format, It only apply to the channel type is Thermocouple.
01 means the unit of the input value is Degree Celsius
02 means the unit of the input value is Degree Fahrenheit

ChO_7_type: 16#RR
RR: Range definition of signals.
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Normal Range: (For mA or Volt)

Thermocouple Range: (For temperature)

Type Code | Physical Input Signal Type Code Type | Physical Input Signal
00 -0.015to0 +0.015V OE J -210to +760 °C
01 -0.05to +0.05 V OF K -270to +1372 °C
02 0.1t0+0.1V 10 T -270 to +400 °C
03 -05t0+0.5V 11 E -270 to +1000 °C
04 -1to+lV 12 R 0to+1768 °C
05 '25 tO +25 V 13 S 0 tO +1768 oC
06 20 to +20 mA 14 B 0 to +1820 °C
When 1-87018 and I-87018R are connected 15 N 0to +2320 °C
to a current source and set to “06” type "
code, an optional external 125 Ohm resistor 17 - -200 to +800 OC
is required. 18 M -200 to +100 °C
19 Loinas710 -200 to +900 °C

Setting RR as other value will use the default value “05”

2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.

For example, 16#05 means the physical input signal is -2.5 to +2.5 V.

Channel value 1.28 means the input signal is 1.28 V.
Channel value -0.752 means the input signal is -0.752 V.

For example, If "ChO_7_type" set as 16#0F and "Tmp_F" set as 16#01 means the physical input

signal is -270 to +1372 degree Celsius.
Channel value 25.75 means 25.75 degree Celsius.

For example, If "ChO_7_type" set as 16#10 and "Tmp_F" set as 16#01 means the physical input

signal is -454 to +752 degree Fahrenheit.
Channel value 25.75 means 25.75 degree Fahrenheit.

! ' ."‘-', -}J\?Al’;:’L [ODer :,1 : 'fﬂ——g:!
Key=6 '
ef = 16#87018

mp
ChO_7 type = 16#1
ChO_scale = 16#0
Ch1 scale = 16#0

Ch5 _scale = 1640

Note: If using a temperature module with a broken-line detection function (e.g., -87018ZW), and the
temperature value is greater than "9000.0", it means,

1. The temperature sensor may be broken-line.

2. The temperature sensor may be crashed.

3. The DCON module is not configured well to fit the connected temperature sensors.

4. The ohm measured by the connected sensor is not correct.
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ChO_scale to Ch7_scale: 16#SS
SS: Scaling function is defined by the "i_scale" I/O board (refer to Section 4.2).

00

means "No scaling".

01to 29 means "Appling a scaling function No. (01 to 29)"

Setting SS as other value will use the default value 00.

For example, 16#17 means the physical input signal is converted with the scaling function 17.

3. After linking the “i_87018_08ch” in the “I/O Boards” window, it will auto add 8 "REAL” input
variables in the “Variables” window that are available for programming.

Variables WX
¥ Name | Type | Dim. | Attrb. | Syb. | Initvalue | User... | Tag | Description
= B8 %ID1-i 87018 _08ch !
%ID1.0 4—REA Input You can change the variable
i, | BEAL Inpat @ name by double clicking it
%ID1.2 REAL Tmpot Y 1cxing 1t
%101 3 REAL it (Refer to the Section 4.1)
%ID1.4 REAL Input L] 3
%ID1.5 REAL Input O
%ID1.6 REAL Input O]
%ID1.7 REAL Input [ v
< i >
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4.6 i_exist (Test if the I/0 module exists?)

The “i_exist” is used to check if the I-8K and 1-87K series I/O modules exist in the PAC’s slot 0 to 7.
Refer to Chapter4 (P4-1) to add this I/O board.

1. Mouse double-click the "i_exist" to open the “Properties” window, and then to view the setting
description.
Note: Using the Slot 8 or above No. because the slot 0 to slot 7 are reserved for the real I/0O module.

iEEE 170 Boards
B

9: i_exist - Properties

QO =N (0P | =D

Setting Description
i_exist ~

Test if |-Bxxi and |-87xxs i0 boards in the slot 0 thru. 7 exist or nat.

8-ch boolean inputs represent the board state in the slot 0 thru. 7
True : exists
FALSE : board not found

<

2. After linking the “i_exist” in the “I/O Boards” window, it will auto add 8 "BOOL” input variables in
the “Variables” window and display the state of the I/O module from slot 0 to slot 7 when
connecting the Win-GRAF PAC.

"TRUE" means the I/O module exists.
"FALSE" means cannot find this /0O module.

¥ _Name | Type | Dim. | Atrib, | Syb. | Initvalue | User.. | Tag | Description

= B %09 - i_exist A
o,
;z:g? < ;88;_ ::ESI You can change the variable
%I[%3.2 BOOL Tput 9 name by double clicking it.
%I%9.3 BOOL Input (Refer to the Section 4.1)
%olX3.4 BOOL Input - &
%l¥9.5 BOOL Input O
%Ix9.6 BOOL Input il

O] v

%lX3.7 BOOL Input

N
v
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4.7

i_8084 (Frequency, UP/Down Counter, UP Counter)

The 1-8084W is a 4/8-channel high speed Frequency/Counter (Data type: “DINT”) that can be used to
measure frequency or as a UP/Down Counter or as a UP Counter. The following will describe these three

modes. Refer to Chapter4 (P4-1) to add this I/O board.

4.7.1 i_8084 freq (8-channel Frequency)

1. Mouse double-click the "i_8084_freq" to open the “Properties” window, and then to view the

setting description.

£EEE 170 Boards

o

Wi 5084 freq

1: i 8084 freq - Properties

N keyze

ef = 16#8084F

ChO0_1_Filter=0
ChO_1_Freq_timeout = 1500
Ch0_1_Low_High Auto=2
Ch2_3_Filter=0
Ch2_3_Freq_timeout= 1800
Ch2_3 Low_High Auto=2
Ch4_5_Filter=10
Ch4_5_Freq_timeout = 1500
Ch4_5_ Low_High Auto=2
Ch6_7_Filter=0
Ch6_7_Freq_timeout = 1800
Ch6_7_Low_High_ Auto=2
Min_Update_Interval =0

Signal Inverted =0
18084 :

b b=l =t bl e e fomred = £S5 1 L= SR RN PR B PRR K

Setting Description

|3

8-Ch Frequency Inputs [Value type is DINT]
Parameters :

Ch_Filter : unit is 0.000001 second , can be 0~ 200 .
The default setting is 0 [without filter].

The "Ch_Filter" is for filtering out some hoise sighals with samll signal width. o

Parameters:

Ch_Filter: The unit is 0.000001 second (us), the value can be 0 to 200.

The default setting is 0 (without filter). The "Ch_Filter" is for filtering out some noise
signals with smaller signal width. (Recommend O: if there is no noise consideration or

need a real-time measurement.) The following setting is recommended:

Max Input Signal (Hz) Recommend Filter Value

1K 200
2K 100
5K 40

10K 20

20K 10

100K 2

450K 1

450K 0 (without filter)
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Ch_Freq_Timeout:
The unit is 0.001 second (ms), the value can be 20 to 1800. Set as other value will use the

default value 1800. If there is no signal wave input to the I-8084W in the "Ch_Freq_Timeout"
interval, the frequency value of the related channel will be assigned as 0.

For example, if set it as 100 ms and the input is 500 Hz (that means, one signal wave takes
about 2 ms to happen), the frequency is updated normally. When the input frequency drop to 9
Hz (that means, one signal wave take about 111 ms to happen), this "111" exceeds the setting
"100" ms (Freq_Timeout). So the frequency value will be assigned as 0 because there is no
signal wave coming in this 100 ms interval.

When setting as 20 ms, the frequency value below 50 Hz is not detectable (become 0).
When setting as 100 ms, the frequency value below 10 Hz is not detectable (become 0).
When setting as 1800 ms, the frequency value of 0 Hz , 1 Hz to 450 KHz is detectable.

Ch_Low_High_Auto: (recommend setting as “2: Auto”.)
0 means a Low frequency mode.

1 means a High frequency mode.
2 means Auto switching between Low and High frequency mode.
Set as other value will use the default value “2: Auto”.

Mode 2 will auto change the frequency mode. It will auto change to High mode when the input
frequency is larger than 3500 Hz, while auto change to Low mode if input frequency is less than
1000 Hz.

DO NOT set as 1 (High frequency mode) if the input signal is normally less than 1000 Hz, or the
frequency value will be incorrect frequently. Recommended don't set as O (Low frequency
mode) if the input signal is normally larger than 3500 Hz.

Min_Update_Interval:
The unit is 0.001 second (ms), the value can be 0, or 20 to 1000.

Default value 0 means "Update frequency every PAC cycle".

Other means "Update frequency when each Interval time reached".

The frequency update time also depends on the Win-GRAF PAC cycle time. If the PAC cycle time
is big, for example 200 ms, then the real frequency update time will become 200 ms when
setting the "Min_Update_Interval" less than 200. Setting bigger "Min_Update_Interval" will get
smooth frequency curve value, however the frequency value is updated slowly.

Signal_Inverted:
0: input signal is normal (no inverted).

1: inputsignalis inverted (means voltage HIGH will be processed as LOW, and voltage LOW
will be processed as HIGH).
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2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.

& §;8@84~fm41;-’: Properties:
Key=6

Ref = 16#8084F =
ChO_1 Filter=0

ChO_1 Freq timeout=100
ChD_1_Low_High Auto=
Ch2_3_Filter=0
Ch2_3_Freq_timeout= 1800
Ch2_3 Low_High_Auto=2
Ch4_5_Filter=0
Ch4_5_Freq_timeout = 1800
Ch4_5 Low_High Auto=2
Ch6_7_Filter=0
Ch6_7_Freq_timeout = 1800
Ch6_7 Low_High_Auto=2
Min_Update Interval =200

‘ ChU_l_Freq_timeout

Signal Inverted =0

%

3. After linking the “i_8084_freq” in the “l/O Boards” window, it will auto add 8 “DINT” input variables
in the “Variables” window. When the Win-GRAF connects the PAC, it will display the frequency value
for each channel.

T Name | Type | Dim. | Attrib. | Syb. | Initvalue | User... | Tag | Description
= @ %ID1 - i_8084_freq Al
3:’::3:? < g:;:; ::Pz: You can change the variable
%ID1.2 DINT I ] ¢ name by double clicking it.
olD1. nput .
o%ID1.3 DINT Input (Refer to the Section 4.1)
%ID1.4 DINT Input ] L2
%ID1.5 DINT Input O
%ID1.6 DINT Input Ol
%ID1.7 DINT Input O bl
< il | >
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4.7.2 i_8084 cnt_ch04 (4-channel UP/Down Counter)
Note: Using the "COUNTER_START", "COUNTER_STOP", "COUNTER _GET", "COUNTER_STATE" and
"COUNTER_RESET" functions in the Win-GRAF Workbench to operate counter channels in an

[-8084W.

1. Mouse double-click the "i_8084 cnt_ch04" to open the “Properties” window, and then to view the

setting description.

§EEE 170 Boards

: :
2 8084 e¢nt 04 Properties (%]
4 Ref = 16#8084C4
5 Ch0_Mode =0
6 ChO_Filter=0
Chl_Mode =0
Fi Chl_Filter=0
8 Ch2_Mode =0
q Ch2_Filter=0
10 Ch3_Mode =0
Ch4_Filter=0
11 Signal Inverted =0
12 Reserved0 =0
13 Reservedl =0
14 Reserved2 =0
1 Reserved3 =0
16 Setting Description
17 |-8084' : Setup 4-Ch Counter Inputs
Mote: Please use the i 8084 Start" , "i_8084_Stop" , "i_B084_Get",
"i_8084_State" and "i_8084_Reset" functions to operate
counter channles in an [-8084'w .
Parameters :
Parameters: -

Ch_Mode: Input mode, can be 0, 1 and 4. Set other value will use 0.

0: Pulse/DIR mode.
1: UP/DOWN mode.
4: A/B phase (Quard.) mode.

Ch_Filter: The unit is 0.000001 second (us), the value can be 0 to 200.
The default setting is O (without filter). The "Ch_Filter" is for filtering out some noise

signals with smaller signal width. (Recommend O: if there is no noise consideration or

need a real-time measurement.) The following setting is recommended:

Max Input Signal (Hz) Recommend Filter Value

1K 200
2K 100
5K 40

10K 20

20K 10

100K 2

450K 1

450K 0 (without filter)
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Signal_Inverted:
0: Input signal is normal (no inverted).
1: Input signal is inverted (means voltage HIGH will be processed as LOW, and voltage LOW

will be processed as HIGH).

For example:
If setting "Signal_Inverted" as 0 (no inverted) and Ch_Mode is O (Pulse/DIR),

the counter value will count up if "DIR" signal is High.
If setting "Signal_Inverted" as 1 (inverted) and Ch_Mode is 0 (Pulse/DIR),

the counter value will count down if "DIR" signal is High.

Double click the item and fill in a value, then press the “Enter” key to complete the setting.

Key =06
Ref = 16#8084C4

ChO_Mode =0
ChO_Filter =0
Chl_Mode =0
Chl_Filter=0

Ch2_Filter =0
Ch3_Mode =0

‘ Signal Inverted
1

Reserved3 =

After linking the “i_8084 _cnt_ch04” in the “I/O Boards” window, it will auto add one “BOOL” Input
variable (no meaning, always “FALSE”) in the “Variables” window.

Variables B X
T Name | Type | Dim. | Attrib. | Syb. | Initvalue | User... | Tag | Description
= B %IX1 - i B0B4_cnt_Ddch A
%lX1.0 BOOL Input O] v
< I | >

After linking the “I/O board”, refer to Section 4.9 to use "COUNTER_START", "COUNTER_STOP",
"COUNTER _GET", "COUNTER_STATE" and “COUNTER_RESET” functions in the LD or ST program to

operate the Counter channel of the I1-8084W.
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4.7.3 i_8084 cnt_ch08 (8-channel UP Counter)
Note: Using the "COUNTER_START", "COUNTER_STOP", "COUNTER _GET", "COUNTER_STATE" and
"COUNTER_RESET" functions in the Win-GRAF Workbench to operate counter channels in an

[-8084W.

1. Mouse double-click the "i_8084 cnt_ch08" to open the “Properties” window, and then to view the

setting description.

£EEE 170 Boards

Bl 2084 cnt_08ch = e e —

2 -1 8084 ent 08ch - Properties V
3 N\ e o L e e e e e
4 Ref = 16#8084C8
5 ChO_1_Filter=0
6 Ch2_3_Filter=0

Ch4_5_Filter=0
7 Ch6_7_Filter=0
g Signal Inverted =0
q Reserved0 =0
10 Reservedl =0

Reserved2 =0
11 Reserved3 =0
12
13
14
15 . .
16 e Setting Description |
17 |-8084' : Setup 8-Ch Counter Inputs »

Mote: Please use the i 8084 Start" , "i_8084_Stop" , "i_B084_Get",

"i_8084_State" and "i_8084_Reset" functions to operate
counter channles in an [-8084'w .
Parameters :
b

Parameters:
Ch_Filter: The unit is 0.000001 second (us), the value can be 0 to 200.

The default setting is O (without filter). The "Ch_Filter" is for filtering out some noise
signals with smaller signal width. (Recommend O: if there is no noise consideration or
need a real-time measurement.) The following setting is recommended:

Max Input Signal (Hz) | Recommend Filter Value

1K 200
2K 100
5K 40

10K 20

20K 10

100K 2

450K 1

450K 0 (without filter)

Signal_Inverted:
0: Input signal is normal (no inverted)
1: Input signal is inverted (means voltage HIGH will be processed as LOW, and voltage LOW will

be processed as HIGH).
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2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.

1:1 8084 cnt_08ch - Froperties

Key=0

Eef = 10#3054C3
ChO_1_Filter=0
Ch2_3_Filter=0
Ch4_5_ Filter=10
Cho_7 Filter=10
S1znal Inverted =10
Reservedd =0
Reservedl =0
Reserved? =0
Reserved3 =0 N

Signal Inverted

3. After linking the “i_8084_cnt_ch08” in the “I/O Boards” window, it will auto add one “BOOL” Input
variable (no meaning, always “FALSE”) in the “Variables” window.

Variables BV X
T Name 4| Type | Dim. | Attrib. | Syb. | Initvalue | User.. | Tag | Description
= @ %IX1 - i B084_cnt_08ch Al
%IX1.0 BOOL Input O v

£ T | x|

[T)T_IO Drivers‘__! Variables -

4. After linking the “I/O board”, refer to Section 4.9 to use "COUNTER_START", "COUNTER_STOP",
"COUNTER _GET", "COUNTER_STATE" and “COUNTER_RESET” functions in the LD or ST program to
operate the Counter channel of the 1-8084W.

Win-GRAF User Manual, V2.0, Aug. 2020 by ICP DAS 4-20



4.8 i_8093 (3-axis High Speed Encoder Module)

The 1-8093W is a 3-axis high speed encoder module that can be independently configured as one of the
Quadrant, Pulse/Direction or CW/CCW input mode for each channel. If not familiar with the way to add
the this I/0O board, refer to Chapter4 (P4-1).

1. Mouse double-click the "i_8093" to open the “Properties” window, and then to view the setting
description.

5 170 Boards

2 1: i_80§3 -.-l;mperti'es
3 \ DT e e e e O T OO '"'7"‘1
4 Key=0
ef = 1688093
5 X Mode=1
B Y _Mode=1
7 Z Mode =1
8 Signal_Inverted =0
ReservedD =0
3 Reservedl =0
10 Reserved2 =0
11 Reserved3 =0
12
13
14
15
16 — - Setting Description ==
17 1-8093w : Setup 3-Ch Encoder module -~
Mote: Please use the "'i_8093_Start" , "i_8093_Stop'" . "i_B093_Get", =
80393 State" and "i_B033_Reset" functions to operate
encoder channles in an 1-8033w/ .
Parameters :
v
Parameters:

X_Mode, Y_Mode, Z_Mode:

The input mode of X, Y, Z axis, can be 1, 2 and 3. Set other value will use 1.
1: CW/CCW counting mode.
2: Pulse/Direction counting mode.
3: A/B phase (quadrant) counting mode.

Signal_Inverted:
0: Input signal is normal (no inverted)
1: Input signal is inverted (means voltage HIGH will be processed as LOW, and voltage LOW will
be processed as HIGH).

For example:
If setting "Signal_Inverted" as O (no inverted) and X_Mode is 2 (Pulse/Direction),
the encoder value will increase if "Direction" signal is High.
If setting "Signal_Inverted" as 1 (inverted) and X_Mode is 2 (Pulse/Direction),
the encoder value will decrease if "Direction" signal is High.

Win-GRAF User Manual, V2.0, Aug. 2020 by ICP DAS 4-21



2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.

Signal Inverted =0
Reserved0 =0
Reservedl =0
Reserved2 =0
Reserved3 =1

3. After linking the “i_8093” in the “I/O Boards” window, it will auto add 3 “BOOL” input variables in
the “Variables” window that are available for programming.
Ch0: Z-index of X axis.
Ch1: Z-index of Y axis.
Ch2: Z-index of Z axis.

Variables BV X
T Name | Type | Dim. | Attrib. | Syb. | Initvalue | User... | Tag | Description
C B %IX1 - i 8093 s
%I%1.0 BOOL Input O
%111 BOOL Input O 3
%I1.2 BOOL Input Ol v
< I | >

4. After linking the “I/O Boards”, refer to Section 4.9 to use "COUNTER_START", "COUNTER_STOP",
"COUNTER _GET", "COUNTER_STATE" and “COUNTER_RESET” functions in the LD or ST program to
operate the Encoder channel of the I-8093W.
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4.9 Using the Count Function for 1-8084W, 1-8093W, 1-87082W, 1-87084W,
I-7083 and 1-7080 Modules

This section lists the way to use the "COUNTER_START", "COUNTER_STOP", "COUNTER _GET",
"COUNTER_STATE" and “COUNTER_RESET” functions in the LD or ST program to operate the Counter
and Encoder modules. If not familiar with the way to create a program or a function block, refer to
Section 2.3.3.

Note:

1. In the following content, we use I1-8084W and 1-8093W modaules as examples.

2. Before using these function blocks, first go to Section 4.7.2 (UP/Down Counter), Section 4.7.3
(UP Counter) and Section 4.8 (Encoder) to link 1/0 Boards.

49.1 COUNTER_START
For example: Using the I-8084W module in the PAC’s slot2 and start counting the channel 5.

ST program:

IF Startl =TRUE THEN

Startl := FALSE; Note: .
First, add two BOOL variables
TMP_BOOL := Counter_Start (0, 2, 8084, 5) ; ("Start1", "TMP_BOOL") in the

END_IF; Variables Area.

LD program:
(“Startl”: boolean, set it to “TRUE” to start counting and then reset “Start1” to “FALSE”.)

Start1
R1 E COUMTER_START I

*

Set it to “TRUE” to start counting | °|Fart Tips:
Press the [F1] key for
the details on settings.

ﬁ/!l{*#
]

2 Al

%1 Click to set
I:D.-I ”COil” tO IIRII.

O 5034
] : I2_rame
Reset it to “FALSE”
-H
* S Channel
HEZH
= Start?
= | O F:2 R |
-
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Port: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as “0”. For a DCON module connected to a serial
COM port, can be “1 to 37” (depends on PAC, means COM1 to COM37).

Addr: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as the slot number (0 to 7).
For a module connected to a serial COM port, set it as the Net-ID address of the module (1 to 255).

I0_Name: (Data type: “DINT”)
The name of relative Counter/Encoder module, it can be set to "8084”, "8093", "87084", "87082",
"7083" and "7080".

Channel: (Data type: “DINT”)

The channel No. of the Counter/Encoder module, it can be set to "0", "1", and so on, depends on the
module. For example, when using the I-8093W module, "0" means the X-axis, "1" means the Y-axis
and "2" means the Z-axis.

Q: (Data type: “BOOL")
“TRUE”: OK ; “FALSE”: Error.
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4.9.2 COUNTER_STOP
For example: Using the I-8093W module in the PAC’s slot1 and stop counting the X-axis.

ST program:
IF Stopl=TRUE THEN
Note:
Stopl := FALSE; First, add two BOOL variables
TMP_BOOL := Counter_Stop (0, 1, 8093, 0) ; ("Stop1", "TMP_BOOL") in the
Variables Area.
END_IF;
LD program:

(“Stop1”: Boolean, set it to “TRUE” to start counting and then reset “Stop1” to “FALSE”.)

s

£l
ik Stopt
Gl R1 En COUNTER_STOP @ |
. Set it to “TRUE” to stop counting 0-{port Tips:
K Press the [F1] key for
4 1 Lo the details on settings.
Il
LN G095 I _Mame
< Reset it to “FALSE”
04 Channel
HKH | +
— Stop
= Rz R |

Port: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as “0”. For a DCON module connected to a serial
COM port, can be “1 to 37” (depends on PAC, means COM1 to COM37).

Addr: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as the slot number (0 to 7).
For a module connected to a serial COM port, set it as the Net-ID address of the module (1 to 255).

I0_Name: (Data type: “DINT”)

The name of relative Counter/Encoder module, it can be set to "8084”, "8093", "87084", "87082",
"7083" and "7080".

Channel: (Data type: “DINT”)

The channel No. of the Counter/Encoder module, it can be set to "0", "1", and so on, depends on the
module. For example, when using the I-8093W module, "0" means the X-axis, "1" means the Y-axis
and "2" means the Z-axis.

Q: (Data type: “BOOL")
“TRUE”: OK ; “FALSE”: Error.
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49.3 COUNTER_GET
For example: Using the I-8093W module in the PAC’s slot1 and get the Encoder value of the Z-axis.

ST program: Note: First, add variables in the
Variables Area (refer to Section
TMP_BOOL := Counter_Get (0, 1, 8093, 2, Encoder_1) ; 2.2.1).

"TMP_BOOL" (BOOL).
“Encoder_1" (DINT).

LD program:
(3
1E
bl R1 En COUNTER_GET @ |
| | 0-Part
Tips:
3 L Press the [F1] key for
i the details on settings.
I
5093
r i I2_PMame
-ZH
24 Channel
HHZH
o | Ecoder_1 @t alue
—=

Port: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as “0”. For a DCON module connected to a serial
COM port, can be “1 to 37” (depends on PAC, means COM1 to COM37).

Addr: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as the slot number (0 to 7).
For a module connected to a serial COM port, set it as the Net-ID address of the module (1 to 255).

I0_Name: (Data type: “DINT”)

The name of relative Counter/Encoder module, it can be set to "8084”, "8093", "87084", "87082",
"7083" and "7080".

Channel: (Data type: “DINT”)

The channel No. of the Counter/Encoder module, it can be set to "0", "1", and so on, depends on the
module. For example, when using the I-8093W module, "0" means the X-axis, "1" means the Y-axis
and "2" means the Z-axis.

@Value: (The data type can be “DINT”, “UDINT”, “DWORD” and “LINT")
It returns the current counter or encoder value. (Refer to Appendix A for the range of values)

Q: (Data type: “BOOL")
Counting state. “TRUE”: Counting ; “FALSE”: Stopped.
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49.4 COUNTER_STATE
For example: Using the I-8084W module in the PAC’s slot2 and to get the counting status of the
channel 5.

ST program:

Note: First, adda "TMP_BOOL"

TMP_BOOL := Counter_State (0, 2, 8084, 5) ; . ) .
BOOL variable in the Variable Area.

LD program:

*

%

=il R EnCOUNTER_STATE G |

| | O4Part
Tips:

3 o L Press the [F1] key for

'l the details on settings.
!

a054
- 2 _Mame
o
S Channel

HIH —

Port: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as “0”. For a DCON module connected to a serial
COM port, can be “1 to 37” (depends on PAC, means COM1 to COM37).

Addr: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as the slot number (0 to 7).
For a module connected to a serial COM port, set it as the Net-ID address of the module (1 to 255).

10_Name: (Data type: “DINT”)
The name of relative Counter/Encoder module, it can be set to "8084”, "8093", "87084", "87082",
"7083" and "7080".

Channel: (Data type: “DINT”)

The channel No. of the Counter/Encoder module, it can be set to "0", "1", and so on, depends on the
module. For example, when using the I-8093W module, "0" means the X-axis, "1" means the Y-axis
and "2" means the Z-axis.

Q: (Data type: “BOOL")
“TRUE”: OK ; “FALSE”: Error.
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4.9.5 COUNTER_RESET
For example: Using the I-8093W module in the PAC’s slot5 and reset the Encoder value of the Y-axis
as IIOII.

STProgram: | | pesetl=TRUE THEN Note:

Resetl := FALSE ; First, add two BOOL variables

("Resetl", "TMP_BOOL") in the

END_IF;
LD program:
k3
I Resetl
b R1 EnCOUNTER_RESET G |
“ ” . 0{Part
B Reset1”: BOOL, set it to Tips:
o “TRUE” to reset the value. Press the [F1] key for
0 o [l the details on settings.
gl
i 09310 _Mame
-ZH
14 Channel
HHZH |
= Reset it to “FALSE”
—a + 0q%alue
—a
Resetl
| R2 R |

Port: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as “0”. For a DCON module connected to a serial
COM port, can be “1 to 37” (depends on PAC, means COM1 to COM37).

Addr: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as the slot number (0 to 7).
For a module connected to a serial COM port, set it as the Net-ID address of the module (1 to 255).

I0_Name: (Data type: “DINT”)
The name of relative Counter/Encoder module, it can be set to "8084”, "8093", "87084", "87082",
"7083" and "7080".

Channel: (Data type: “DINT”)
The channel No. of the Counter/Encoder module, it can be set to "0", "1", and so on, depends on the
module. For example, when using the I-8093W module, "0" means the X-axis, "1" means the Y-axis
and "2" means the Z-axis.

Value: (The data type can be “DINT”, “UDINT”, “DWORD”, and “LINT")
The new Counter or Encoder value wish to set.

Q: (Data type: “BOOL”) “TRUE”: OK ; “FALSE”: Error.
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4.10 Ping_ip (Test an Ethernet/Internet Connection)

The "Ping_ip" function is used to test if the connection of the remote Ethernet/ Internet device is
working properly. (It supports a max. of 50 IP settings.) If not familiar with the way to add this I/0 board,
refer to Chapter4 (P4-1).

1. Mouse double-click the "Ping_ip" to open the “Properties” window, and then to view the setting
description.
Note: Using the slot 8 or above No. because the slot 0 to 7 are reserved for the real I/O module.

i 170 Boards
B

ing_ip -

Key=b el
Ref = 16#04 =|
IP_0=192.168.1.100
Interval 0 =15
Timeout 0=3
IP_1=N7A
Interval 1=15
9 Ping_i ITI;im;m;};_Al =3
HBFing ip 00 09 &=

B Ping ip 10,19 Interval 2 =13

e Timeout_2 =23
— 2 Ping_ip.20.29 ™ ||IP 3=N7

3 Ping_ip_30 39 Irlgtervalt_g = 135
T imeout_3 =

i 4 Ping_ip_40 49 iP 4 - N7

1 Interval 4 =15

12 | Ping_ip - Test Ethemet / Intemet connection

QO == | O O [ (L0 (P — D

%

Setting Description

(>

Mote:
1. If wish ta test the connection between PAC and
Internet, please set proper "Gateway" settings.
2. If test only local Ethernet connection, then
"Gateway' may not be necessary.
3. One PAC can use only one "Ping_IP" . G

o P

Note:
1. If wish to test the connection between PAC and Internet, please set proper "Gateway" settings.
If test only local Ethernet connection, then "Gateway" may not be necessary.
One PAC can use only one "Ping_IP". (Don't use two or more)
When Ping success, return Boolean channel as TRUE.

ik wnw

When Ping fails, it will try one more time. If still fail, then return Boolean channel as FALSE.

Parameters:

IP_01 to IP_49: (Data type: "STRING")

The IP address of targets. Set as 'N/A' if wish to disable it.
For example, 192.168.1.100 or 52.19.125.242 or N/A.

Interval_01 to Interval_49: (Data type: "DINT")

The unit is second. The interval to send one "ping" command. Value can be 6 to 86,400 seconds.
Setting smaller than 6 will use as 6. Setting greater than 86400 (24 hours) will use as 86400.
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Timeout_01 to Timeout_49: (Data type: "DINT")
The unit is second. The timeout settings of the "ping" command. Value can be 2 to 30 seconds.
Setting smaller than 2 will use as 2. Setting greater than 30 will use as 30.

Note: The "Interval_xx" value should be at least triple of the "Timeout_x" value. Or the PAC will
use the "Interval_x" value as a triple of the "Timeout_x" value.
For example, if "Timeout_00" is set as 10 however "Interval_00" is set as 20, then PAC will
use "Interval_00" as 30.

2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.

Key=6 ~

Ref = 16#64 -
IP_0=192.168.1.100
Interval 0=15
Timeout 0=23

Interval_1=10
Timeout_1=2
IP_2 =N/
Interval 2 =15

Timeout_2 =3

IP_3=N/A

Interval_3=15

Timeout 3=3

IP_4 =N/

Interval 4 =15 Vi

192.168.78.88

3. After linking the "Ping_ip" in the “I/O Boards” window, it will auto add 50 “BOOL” input variables in
the “Variables” window. When the Win-GRAF connects the PAC, it will display the online status.
True:  The connection is ok.
FALSE: Connection failed or cable problem.

Variables B X
T Name | Type | Dim. | Attrib. | Syb. | Initvalue | User... | Tag | Description
= @ %I[X3.0 - Ping_ip_00_09 A
0,
;::gg? < ZSSIL ::EEI You can change th‘e v‘aria‘ble
%% [X9.0.2 BOOL T ¢ name by douple clicking it.
%I1¥9.0.3 BOOL Input (See the Section 4.1)
%I[x9.0.4 BOOL Input ]
%I%9.0.5 BOOL Input O
%I%9.0.6 BOOL Input O
%IX9.0.7 BOOL Input O]
%IX9.0.8 BOOL Input OJ
%I%9.0.9 BOOL Input OJ q
= @ %I¥9.1 - Ping_ip_10_19
% B8 %IX9.2 - Ping_ip_20 29
= @ %0493 - Ping_ip_30_39
= B8 %IX9.4 - Ping ip 40 4 e
< | 2
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4.11 1-8088W (8-channel PWM Output Module)

The I-8088W is an 8-channel PWM (Pulse Width Modulation) output module. The duty range (Duty =
High / (High + Low) ) of the PWM output signal can be from 0.1% to 99.9%. Its output frequency in the
Win-GRAF PAC is from 1 Hz to 500 KHz. The [-8088W support two PWM output modes, one is the
“Continuous” mode. It outputs always. The other one is the “Burst” mode. It outputs the required pulse
count and then stop. Please visit the product page http://www.icpdas.com/en/product/I-8088W-G for
other specifications.

Hardware Connection Diagram:

This example uses the 1-8084W (Slot 2) to measure the frequency of the 1-8088W (Slot 1) PWM output
signal (the I-8084W is not necessary in the actual application). Then, connect the I-8088W’s PWM
output channel 0 (PWO) to the I-8084W'’s frequency input channel 0 (COA+).

Power Supply (DP-665) Monitor
PC/Win-GRAF GND ———

=

—
St me——C >
——

o g

PWR use
1-8088W . l 1-8084W

The demo project (demo_8088w.zip) that we will describe below is located in the shipment CD
(\Napdos\Win-GRAF\demo-project) , refer to Chapter 12 to restore/open this project and set up the
current PAC’s IP address.

RS-408

{ Win-GRAF - demo_8088w

File Edit View Insert Project Tools Window Help

A0 [ FI N I ER Ik 0 s it CoE & e AR G & A
Worispace pon _—__—__ —_— — ~— —  _EAX
[ j) demo_8088: AT Name | Type | Dim.
¢ Exceplion o Right-cli =\ &8 ) e
B Bl Frogianis nght Cth (Set the IP) E.Puh_BOBEVY Q —] = {a} Global variables
738 Main {6088 Staten iB088_FreqD DINT
=2 Watch (for de} 1 fsiat State T i8088_Duty0 REAL
..M SoftSeo Communication Parameters. . i8085_Cnt0 DINT
Lo 4 Initial values j’l Om Line \ olehan o i8088_Run0 BOOL
o %d NewSpyl - i8088 Statel BOOL b
%j3 Binding Configtraton 1T -0 TITETS TTE TR &5 .. [ & | >
39 Global defines =g 18088 _Freq0-fFreq == -~
@} Variables 0,001 ~ 0,999 (0... @ 3 (Used)
Lo BB Types 2 | i8085_Duty0 {Duty 4 [Project] b
=2 init as -1:Continu... & l_] Advanced
- i8088_Crt0 Crit [F [ Arithmetic
) F d Arays
= i8085_Run0 - :
— L Run 4 AS-interface
=g || E 3 BACnet v
[ "5 j _ > |[£ %] Blocks  sovlist | Define | ENUM S
[ > _Mainarsbles | NewsSp1
| Build X
(=) Build Cross teferences Runtimeﬂzr Call stack '_ Breskpoints '_ Digital pling trace [ Frompt , Hil
Ready OffLine 192.168.71,19:502 é 0,0 132 x 18 0,0 118% &%
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1/0O Boards:
In this case, add the "i_8088" and the "i_8084 freq" to the corresponding I/O slot No. in the "I/O

Boards" window (refer to Chapter 4). Then, mouse double-click the Slot No. to open the "Properties"
window and you can view the setting description to set this I/0 board.

iiif 1/0 Boards

[ ' 3089 =
1_oloo = |
2 i_8084_freq . _m
T ”\\
4 o || [ Delet |
5 Double-click it to set [ =
g— and to see the details. |
8
3 Key=6
10 Ref = 16#5038
11 Hard_Trigger = 16#00
1 Reseived( = \
Reservedl =0
13 Reserved2 =0
}g Reserved3 =0 Double-click it to set up this item.
16 “00“ means the associate PWM output channel
is triggered by the "i_8088W" function block.

|-8088w - . S
. Setting Description

8-Ch PWwh outputs and 8-ch Digital Inputs /

Note:

To control Pw/M outputs of the -8088W/, first connect the

"_8088" in I/0 board windows, then use the "Pwh_8088w"

function block to control each P\w/ channel. v

After linking the "i_8088" and the "i_8084 freq" I/O boards, it will auto add related variables in the
"Variables" window (or Variables Area). And, you can also declare all the variables that will be used in
the program here (refer to Section 2.3.1).

Workspace
) demo_8088w
-1 Exception programs

Variables

Dim. | Attib. User.. | Tag | Description

ERA] Global variables

[ Programs iB088_FreqD DINT O 100 unit is Hz, init as 100
L) Main i8088_DutyD REAL 0O o5 0.001 ~0999 (0.1% ~99.9%),
o [ Watch [for debugging) i8088_Cnt0 DINT Bl init as -1:Continuous mode, 1 -~
L% Soft Scope i8088_Run0 BOOL O Set TRUE to start, Set FALSE
o 2] Initial values i8088_Statel BOOL | Current State
LB NewSpyl 4 PETAIN variahle
-~ Binding C‘?::f”'a“"" oL = o | To declare all the variables that
(3} Variables %Ix1.1=i8086_DI_1 BOOL Input 0 | will be used in the program.
= %IX1.2=i8088_DI_2 BOOL Input O
%I%1.3=i8088_DI_3 BOOL Input O
%I%1.4=i8088_DI_4 BOOL Input 1
%IX1.5=i8088_DI_5 oL L .
%IX1 B=iG088_DI_B BO Double-click it to change its name.
AN ?=iRnRR_nI_? BOOL (See Section 41)
© B %ID2 - i 8084 _freq _—
lD2. _freq DINT T o mequency chO of i-8084WY
%ID2.1 DINT Input O
%ID2.2 DINT Input O
%ID2.3 DINT Input O
%ID2.4 DINT Input O
%ID2.5 DINT Input O
%ID2.6 DINT Input O
%ID2.7 DINT Input O

<
[4 3| Main| Variables ~ Newspyl
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"PWM_8088W" Function Block:
Then, using the function block “PWM_8088W” to control the PWM output for each channel, such as the
LD program below.

BOOL, always returns “Ture”

Slot and Chan must

Current State
use constant value. — iS085_State0
14 Zlot State ']
04 Chan Fum

Freq: PWM frequency Init = 100 (Hz)
(Data type: D|NT) i5055_Freq0 {Freg
Duty: PWM duty Il = 0.5 (50%)
(Data type: REAL) iB0&E_DutyD JDuty

State: BOOL, the current working status.
(True: working ; False: stopped)
Num: DINT, it reserved for future usage.

Init = -1 (Continuous mode)
i8035 _Crt0 ot

TRUE: Start , FALSE: Stop

iB088_Run0
[ Run

Cnt: DINT - "-1" (Continuous mode), used to output PWM pulse continuously.

"1~ 65535" (Burst mode), used to output the required pulse count and then stop.
Run: BOOL, used to start (True) or stop (False) the PWM output.

Parameters:
Slot: The used I/0 slot No., and it must be a constant value, not a changeable value.
In this case, the value is "1". (Data type: DINT)
Chan: The used I/0O channel No., and it must be a constant value, not a changeable value.

In this case, the value is "0". (Data type: DINT)
Freq: The PWM output frequency. (Data type: DINT ; Unit: Hz)
The value can be from 1 to 500,000 (i.e., 1 Hz to 500 KHz) .
In this case, the initial value is "100" Hz.
Duty: The PWM output. (Data type: REAL)
The value can be from 0.001 to 0.999 (i.e., 0.1 % to 99.9 %).
In this case, the initial value is 0.5 (i.e., 50 %).
Cnt: The output mode (Data type: DINT)
Continuous mode: set it as “-1” (in this case) to output PWM pulse continuously.
Burst mode: it can be from "1" to "65535", to output the required pulse count and then stop.
Run: Using a BOOL variable to trigger the PWM output. (True: Start ; False: Stop)
State: The current working status. (Data type: BOOL). (True: working ; False: stopped)
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Test the program:
Before testing, make sure you have set the PAC's IP address and then compile and download this
program to the PAC. (If not familiar with the operation, refer to Section 2.3.4 and Section 2.3.5.)

When connecting with the PAC, the SPY List (refer to Section 11.3) will show that the I-8088W’s PWM
initial frequency ("i8088_Freq0") is 100 Hz, the initial duty cycle ("i8088_Duty0") is 50%, using the
Continuous mode ("i8088_Cnt0" = -1) and the currently measured frequency of the [-8084W is 0 Hz.

L=yl 4L = i o & W€ OB g (9 @RI Bgie n e @
Workspace 0000 HewSpyt.spl
= [\ demo_8088w [RUN] [ Mame | Value | Description W Name | Yalue | Type
(1~ Exception programs g i8088_Freqd 100 Init =100 [Hz) = {2} Global variables »~
-4 Programs 8085 Dutyd 05 Init = 0.5 (50%) i8088_FreqD 100 DINT
: 3] Main g+ is0ssCnt0 A1 Init = -1 (Continuous mode] i8088_DutyD 0.5 REAL
—1-- 4 Watch (for debugaing) i3088_Run0 | TRUE: Start, FALSE: Stop i8088_CntD -1 DINT
i m SoRScope i8088_Statel : Current State i8088_Run0 BOOL

i8084_freqD 0 frequency chi of i-8084w iB0B8_Statel BOOL
=l RETAIN variables
= Bl %IX1 - i 8088
= B %ID2 - i 8084 freqg

’Sal NewSpy‘l

= 3g Global defines

: fa} Varables %ID2.0=i80... O DINT
B Types %ID2.1 0 DINT
%ID2.2 0 DINT
%ID2.3 0 DINT ¥
< . | b < i >

[€ %] Main| ‘arisbles | MewsSpyl "

Now, set the "i8088 RunQ" as "TRUE" to start the PWM output. At this time, the "i8088 State" will
change from "FALSE" to "TRUE" and output a PWM signal to the I-8084W module, and then the value of
the "i8084 Freq0" will change from 0 Hz to 100 Hz.

AN = W W _g_ax«,\o 9 o e I & % B (3 B §g 05 /@I RUN EE e D
Workspace |l OO00 HewSpyt.spl BEX
[* demo_8088w [RUN] @ Name | Value | Description ¥ Name | Yalue | Type
[+ Exception programs m i8088_Freqgd 100 Init = 100 (Hz) £ {a} Global variables o
=1+~ Programs i8083 Dutyd 0.5 Init = 0.5 (50%) i8088_Freqd 100 DINT
“l€] Main B¢  i8088 Cntd ] Init = -1 [Continuous made) i8088_Dutyd 05 REAL
-4 Watch (for debugging) [ i8088_Rund  TRUE TRUE: Start, FALSE: Stop ‘ iB085_Cnt0 -1 DINT
& Soft Scope 18088 _StateD  THLE Curent State i8088_Run0  TRUE BOOL
fo 24 Initial values i8084_freqD 100 frequency chO of i-8084w i8088_Stated TRUE BOOL
&3 NewSpyl ‘ . s RETAIM variables L
%3 Binding Configuration & B %IX1 - i 8088
39 Global defines [ TRUE W i) £l B8 %ID2 - i_8084_frey
LY Variables N\ %ID2.0=i80... 100 DINT
B Types ( FalsE i) | %021 0 DINT
%ID2.2 0 DINT
%ID2.3 0 DINT ¥
|4 %] Main| ‘arisbles | NewSpyl. Unlack
Build ' X

If set the "i8088_Cnt0" as 500 (Burst mode), the "i8084_Freq0" value will become 0 after the 1-8088W
outputs 500 PWM pulses. You can try to change the "i8088 Cnt0" value and then set the "i8088_ Run0"
as "TRUE" to view the changes of output.
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Chapter 5 Modbus Master: connecting to Modbus Slave Devices

This chapter lists the way to enable the Win-GRAF PAC as a Modbus Master to connect Modbus
RTU/ASCII Slave or Modbus TCP/UDP Slave devices. If you want to use one XV board in the WP-5xx8-CE7,
refer to Section 5.1.6 to Section 5.1.11.

5.1 Enabling the Win-GRAF PAC as a Modbus RTU/ASCII Master
(1/0 & XV-board)

Application Diagram:

Win-GRAF PAC
(Modbus RTU/ASCII Master)

(Recommend to connect

(Max. 32 Ports)

4]

i-8142iW/
i-8144iW

XPAC XP-8xx8-CE6

WinPAC WP-9xx8-CE7
WP-8xx8
WP-5xx8-CE7

ViewPAC VP-x2x8-CE7

Modbus RTU/ASCII
Slave Device

Modbus RTU/ASCII
Slave Device

RS-422/485 Modules
i-8142iW (2-ports)

Ki-8144iW (4-ports) /

(Check P1-1 to view all PAC models)

Follow these steps:
1. Mouse click the “Open Fieldbus Configuration” tool button to open “lO Drivers” window.

[}l Win-GRAF - Test 01 =13
File Edit ¥iew Insert Project Tool: Window Help

AN = NE RN RN IRECNE - Pl -Eﬁ;:ﬂﬂméﬁﬁslég 5 & Al
Workspace 10 Orivers | HL o
- Test 0l = T Mame | Type
----- (1 Exception progiams || o {2} Global variables  #
£ [ Programs g [ RETAIN variables
o ) Main L] Main
El-- I:] Wwatch [for debugai.. | ? 2 pOnBadindex
48 Soft Scope g P8 pOnDivZero v
------- EH Initial values ¥ £ k4
------- !!& Binding Configuration Mame | Yalue
------- «2g Global defines &5
------- oy Wariables ! | >
....... B Types Build X
4 ¥ | Build Cross references Runtime Call stack Breakpoints Ligital sampling trace Frompt
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2. Click the “Insert Configuration” button on the left of the “lO Drivers” window, then click the
“MODBUS Master” and “OK” to enable the Modbus Master setting.

? Mame | Type
{2} Glabal variahlas  ~
|l RETAIM variables

Marne | Walue

Add Confignration

= |l
Chooze a configuratian _
E Ok
A
H —e - MODBUS

25 MODELUS Master
i MODBUS Slave

3. Click the “Insert Master/Port” button on the left side to open the setting window. Then, select the
“Serial MODBUS-RTU”, set COM Port (e.g., “COM2:9600,N,8,1”) and Delay time (recommended value:
10 ms, it can be 0 to 10000), and then click “OK”.

1O Drivers *

Ly FAODEUS b aster Mame | Yalue I Mame | Type
{2} Glaobal variahles
MODBUS Master Port =l RETAIM variahles
[] Main
oK
(O MODBLS on Ethernet -‘ %a pOnBadindex
A Address: ‘ [ cancel B P2 pOnDivZera v
g | Port: & | :/
K. Ma Protocol: ‘ arne | Walue
g2
i Fy L 5

If wish to set it as a Modbus ASCII
Master, change the setting to
“ASCII:COM2:9600,N,8,1”

Cor. port: iCOMZ:%DO,N,S,l 1 |

After receiving the respond, waiting for

.
Delay between requests
1 10 ms to send the next command
Delay (ms): |10 }

Try to reconnect after communication error . .
Select “Disabled” if you do not want

to use this COM Port setting.

V| Manage diagnostic info for slaves

[ pisabled (da not open and manage this port)

4. Click the “Insert Slave/Data Block” button on the left side to create a data block.

E B MODEBUS b azter MName | Walue

2 - N Mode RTL

= Address COMZ9E00,M.8.1

% Part a02

3 Reconnect after emar

B Slaves diagnostics
Delay between requestz [mz] 10

g Dizabled ]
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This table lists five data blocks, and each data block stands for one Modbus Master Request.

Item | Function Code Modbus Request Description
1 2 Read Input-bits Read DI data
2 5 Write single coil-bit Write DO data
3 4 Read Input Registers Read Al data
4 6 Write single holding register | Write one AO data (16-bit)
5 16 Write Holding Registers Write multiple AO data (16/32 bits)

Note: If you want to disable the Modbus RTU/ASCII Master port while the program is running, refer to
Section 5.1.13 to use the “MBRTU_M_disable” function.

5.1.1 Read DI data
1. Completing all the following settings in the “MODBUS Master Request” window, and then click “OK".

MODBUS Master Request 24 . siave/Unit:
Request = : o Enter the Net-ID of the Slave device.
Description: | U U —— (In this case, the Net-ID is “1”).

Slavejunit: |1 @ b. MODBUS Request:

Select “<2> Read Input Bits” option.

MODEBUS Request
SR S c. Base address:
| 1> Read Coil Bits ~ e
2> Read Input Bits o Start from “1” by default.
B e bk s L] Nb items:
@ Sata block 7 The number of DI signals to read.
Bise sddbaser i1 ‘ (In this case, the number is “16").
v - Note:
b items: |16 B
@ I = If you want to change the “Base address”,
Activation . ) _ right-click the “MODBUS Master” and
(%) Periodic: { ‘ ‘ ‘
jgemdl:c' {2000 | then select the “MODBUS Master
{2 Oncall far cevia »” .
Oyon change € i ) Addresses” to modify the value.
) On change This option can not apply _
Misc. to the "Read" request. 10 Drivers
@ z = B ' MODELS Master
Timeout; |250 ms -
Mb trials: .1 MODEUS Master addresses _
= irst valid dd
First valid MODELUS addresses
d. Activation: The way to send the Modbus request. Input bits: 1
Periodic: Sending the request periodically. ol bits: 1
(In this case, to send once every two seconds.) Input registers: |1
“on error” means the next sending time when Holding recietere:
Holding registers: |1
an exception occurred (e.g., 15 seconds).
On call: The request is activated when a program call
tosend it

On change: In case of a write request, means that the request is activated each time any variable
changed.
e. Timeout: Set a timeout value. (When time-out occurred, it will show the defined error code.)
(The recommended value for the Modbus RTU/ASCII device is 200 to 1000 ms. E.g., 250 ms)
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2. Next, open the “Variables” window and then declare variables that are available for the program.

Gorivers

=l Test_01 |8 Mg MODBUS Master Name | Yalue
1 Exception programs a2 ;%; RTU: COM2:9600,M,8.1 Request <2» Read Input Bits
=} Programs s [_ “B <2> Read Input Bits (1) [1..16] || Slave/Unit 1
f ) Main B w Address 1
-3 Watch (for debuggi.. | o _. Nb Item 16
. .18¥ SoftScope B Tips: _ . Activation Periodic
B Iniial values Press “F1” key to view the details |pgioqims) 2000
%3 Binding Configuration 4l on the MODBUS Master settings. |Periodonenor 15000
-39 Global defines &9 Timeout [ms) 250
o Y MIF Number of trials 1
BB Types B Description
Double click it to open the window. | Qperation i Offset I tMask |

>

Declaring 16 variables to read data (Name: “Boo_01 to Boo_16"; Type: BOOL) and one array variable to
record the state of data access (Name: “Status"; Dim.: 5; Type: DINT). Refer to Sectin 2.3.1 for the way
to declare variables, and the figure below shows defined variables.

Voribles —— ____  EEX
“F | Mame | Type | Dirn. [} Attrib. | Syb. | Initvalue | User.. | Tag | Description
E {2} Global variables ~
Bool_01 BOOL O
Bool_02 BOOL O
Bool_03 BOOL O
Bool_04 BOOL O
Bool 05 BOOL O
Bool_0B BOOL
Bool 07 BOOL E Bool 16 BOOL L]
Boal 08 BOOL O [ Status DINT ] L]
Bool 09 BOOL O 5 A ‘
Bool_10 BOOL O =
Boal_11 BOOL O
Bool_12 BOOL O J L
Bool_13 BOOL O
Bool 4 JBOOL E Bool_15 BOOL H
Bool 16 |BOOL O Status DINT [0..4] L]
T |
4 }_ 10 Driwers Yariablas

3. Inthe "IO Drivers" window like the figure below, drag all required variables in the Variables Area (i.e.,
“Bool_01" to “Bool_16" and “Status”) and drop them to the “Symbol” area in the first data block.
Note: The “Status” is an array variable, so, the Status[0] to Status[4] will show on the “Symbol” area.

Click the “Del” key to delete the Status[1] to Status[4].

4. Next, select “Offset” field from “Boo_01" to “Boo_16" and then click the “Iterate Property” button on
the left side to set the “Offset” value (From: “0” ; By: “1”, refer to Section 3.1 — Step8).
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5. Inthe “Operation” field, set the “Status[0]” as “Error report” which means the return value is an
“Error Code” if a read error occurred and the value will be reset to “0” if read successfully.

IO Drivers *

B E-Mg MODBUS Master Name | Yalue SY Name | Type

2 O RTU: COM2:9600.M,8.1 Request <2> Read Input Bits A Bool 01 BOOL £

3 -8 <2» Read Input Bits [1)[1..16] }Iavea’Unil 1 = Bool 02 BOOL

= . Addie 1 ¥ |Bool 03 BOOL

“F+ Symbol /| Dperation | Dffset | Mask | Storage | Bange [L¢ Bool 04 BOOL

E |Bool_01 Data exchange 0 FFFF  Default Bool 05 BOOL

g Bool_02 Data exchange 1 FFFF Default Bool_ﬂ@ 7 BOOL

Bool 03 Data exchange 2 FFFF  Default Boel T7 BOOL

&5 |Bool 04 Data exchange 3 FFFF  Default === I Bool 08 BOOL
Bool_05 Data exchange _ _ [ FEFE — Befautt =~ ~ ~ Bool 03 BooL |

lBooLos € ~Pazerchange [ FFFF  Defaul Boal_10 BOOL

Bool 07 Data exchange 53 FFFF Default Bool_11 BOOL

& Data exchange 7 FFFF  Default Bool 12 BOOL

Data exchange 8 FFFF  Default Bool_13 BOOL

Data exchange FFFF  Default Bool_14 BOOL

g
Bool 11 10 FFFF Default Bool_15 BOOL
Bool 12 11 FFFF Default Bool_16 BOOL
Bool_13 Data exchange 12 FFFF Default Status DINT e
Bool_14 Data exchange 13 FFFF Default - ST i
Bool_15 Data exchange 14 [ —— =
Bool 16 Data exchange O FFFF ——Disfal
Status[0] Data exchange 0
% M amme kA |

a 10 Privers| The “Offset” must be “0” when Fram: By: 1 v

selecting the“Error report”.

Rezults
BoolViE —
Statuz[0] n | Data exchange

ETrorTepoT ST

£ On-gaing request
4 » | 10 Drivers - ‘ariat| 2UCCEss counter
. Fail counter
Build

Rety counter
Command [one shat]
Command [enable]
Reset counters

[ OF. l [ Cancel

You can also press “F1” in this “10 Drivers” window to view details on Modbus Master Configuration.

Error Code Description Error Code Description
0 The communication is OK. 8 Data Parity Error.
1 MODBUS function not supported. 10 Invalid gateway path.
2 Invalid MODBUS address. 11 Gateway target failed.
3 Invalid MODBUS value. 128 Communication timeout.
4 MODBUS Server failure. 129 Bad CRC16.
6 Server is busy. 130 RS-232 communication error.
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5.1.2 Werite DO Data

1. Using the same way in the Section 5.1 - Step 4 to create the second data block and completing all the
following settings in the “MODBUS Master Request” window, and then click “OK".

MODBUS Master Request @ In this example

Request z = a. Slave/Unit:
Lescripton: {;_ : ] Enter the Net-ID of the Slave device.
SlaveUnit: 2 I@ (e.g., the Net-ID is “2”).
ey b. MODBUS Request:
|23 Road Hokling Regioters = @ Select “<5> Write single coil bit”.
| <4 Read Input Registers =

c. Base address:

<5 Wite single coil bit

L6 % Whvibn cimole boldine vomickoy = Start from “1” by default.

Data block - A (See Section 5.1.1 to change it.)
@ Base address: |1 ' d. On call:
Kb s [ 1 The request is activated when a
= program call to send it
Agv:t'ond ‘ . (See Section 5.1.1 for details)
eriodic: (0 ms -
2 1_7,’ \_ ._l e. Timeout: Set a timeout value.

@ oncal {on error) . N

© 0On change When time-out occurred, it will show
o the defined error code. (The

@ e 1250 | ms recommended value for the Modbus
: = RTU/ASCII device is 200 to 1000 ms.
J A i1
b trials: - In this case the value is 250 ms.)

2. Next, open the “Variables” window and then declare variables that are available for the program.

Workspace 10 Drivers *

& _ﬁ Test_01 E E-Ma MODBUS Master Name | Yalue
{1 Exception programs 2 -7 RTU: COM2:9600,M.8.1 Request <5> Write single coil bit
-~ Programs ] [#-*B <2> Read Input Bits (11[1..16] Slave/Unit 2
: T Main B [TS <5y Wiite single coil bit [2] [1..1] Address 1
& Watch (for debuggi.. || L Nb Item 1
- [ Soft Scope | i ) Activation On Call
o A Initial values @ Tips: Period [ms) 0
%} Binding Configuration ‘ Press “F1” key to view the details | peiodoneror 0

-3 Global defines éb on the MODBUS Master settings. | Timeout (ms) 250

Y Wariables : MNumber of trials 1
S Types \ B Description

Double click it to open the window.

Add two boolean variables in the "Variables" window (refer to Section 2.3.1 for declaring variables).

Variable name Data type | Description

DO O BOOL Used to Write digital output data.

III

In this case, choose the “On cal
using a variable to call it.

Act O BOOL way to write data that means
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After completing the settings, the defined variables show as below:

W Name | Type | D.T | Attib. | Syb. | Initvalue | User.. | Tag | Description
DO 0 BOOL ] A
Act_D BOOL ] v
< ‘ \ ¥

< ;i 10 Drivers | VVariaIV)Iers,-v"'

3. Inthe “IO Drivers” window, drag variables - “DO_0", “Act_0” and “Status” (that created in the Section
5.1.1) from the Variables Area to the Symbol Area in the second data block.
Note: The “Status” is an array variable. When you drag “Status” into the Symbol Area, it will show
“Status[0]” to “Status[4]", simply press “Del” key to delete “Status[0]” and “Status[2] to [4]".
B E-Mp MODBUS Master Name | Yalue P Name | Type | Dim. | At
=4 C- 4% RTU: COM2:9600,M,8,1 Request <5> Wiite single coil bit | Bool_11  BOOL b
N -8 <2> Read Input Bits (1] [1..16 Slave/Unit 2 Bool_12 BOOL
B el = B <5 Write single coil bit (21 [1..1] | BAGGIESS 1 Bool 13 BOOL
o Nb Item 1 Bool_14 BOOL
B Activation On Call _ Bool_15 BOOL
o Period (ms) 0 Bool 16 BOOL
Period oneror 0 Status DINT  [0.4] |
s Timeout (ms] 250 DO 0 I. BOOL
Number of trials 1 Act 0,  BOOL v
BY Description | s @
= | Sl 28
27 Symbol | Dperation | Difset | Mask | Storage _ _ — = FAany Name | Walue
Status[1] Error report 0_ _ EFEF- —Defanl— ~
poo € DFswdhange 0 FFFF Defaul
[ Act D Command [one shot) |0 FFFF  Default
¢ D ata exchange Y 5

Error report

Error report [Set anly]
On-going request
Success counter

Fail counter

A ety counter
Command [ane shat]

( >;l“ Ib Dlivets;‘:'m

Command [enable]

Reset counters

Slave: last errar

Slave: last error date stamp
Slave: last emor time stamp

Claua l=eb rasal Asba sb=ram il

4. Setthe “Operation” field of the “Status[1]” as “Error report” (that means this variable will be set to an
error code when a read error occurs, or reset it to “0” when a read request is successful).
Press the “F1” key to view the description of the Modbus Master Configuration and move to the title
“Status and command variables” to know related commands and error codes.

5. Set the “Operation” field of “Act_0" as “Command (one shot)” (that means the request will be sent
only once when “Act_0" is set to “TRUE”. Then, this “Act_0” will auto reset to “FALSE”).
The "Command (Enable)” means the request is sent continuously as long as the “Act_0" is “TRUE”. So,
users can set the “Act_0" to “FALSE” to stop sending command.
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5.1.3 Read Al Data
1. Using the same way in the Section 5.1 - Step 4 to create the third data block and completing all the

following settings in the “MODBUS Master Request” window, and then click “OK".

MODBUS Master Request In this example

Request , a. Slave/Unit:
Description: | l : Enter the Net-ID of the Slave device.
SlavejUnit: :3— ‘I @ (e.g., the Net-ID is “3”).
MODBUS Request b. MODBUS Request:
| <2 Read Input Bits Al Select “<4> Read Input Registers”.
| €3> Read Holding Registers 50 @ «
BT R d. Base address:
| #C o Wiibn cimale ~ail bik = e el
Start from “1” by default.
e T : See Section 5.1.1 to change it
<€> A s 11 - (See Section 5.1.1 to change it.)
: e Nb items:
Mb items: |10 . .
i x | The number of Al signals to write.
Activation _ _ _ (In this case, the number is “10”).
(d ©eperiodic: 1000 | ms 15000 | | period (See Section 5.1.1)
. - —- . Periodic: (See Section 5.1.
O oncal {on error) . .
O on change —————— - i Sending the request periodically.
This option can not apply .
Misc | \ (In this case, to send once per second.)
' . : to the "Read" request. .
e \ Timeout: 1250 ms “on error” means the next sending
- time when an exception occurred
Mb trials: |1
I- (e.g., 15 seconds).

e. Timeout: Set a timeout value.
When time-out occurred, it will show the defined error code. (The recommended value for the
Modbus RTU/ASCII device is 200 to 1000 ms. In this case the value is 250 ms.)

2. Next, open the “Variables” window and then declare variables that are available for the program.

Double-click it to open this window.

Workspace O Drivers

- Test_01 ‘ B =M MODBUS Master Name | Value
” 1 Exception programs a2 g RTU: COM2:9600,M,8.1 Request <4> Read Input Registers
[ Programs 3 -8 <2> Read Input Bits (1] [1..16] Slave/Unit 3
‘ T Main E “B <5> Write single coil bit (2] [1..1] Address 1
-3 Watch (for debuggi.. | = =1 <4 Read Input Registe Nb Item 10
: : B8 Soft Scope a K Activation Periodic

- = Initial values T i Period [ms) 1000

%4 Binding Configuration = =" Tips: Period onerror 15000
. 3g Global defines &5 Press “F1” key to view the details | Tineout (ms) 25()
3} Variables on the MODBUS Master settings. | Number of tials 1
- Types \ B | Description

Follow the table below to add six Word (16-bit), one Double integer (32-bit) and one Real (32-bit)
variables. (Refer to Section 2.3.1 for declaring variables).
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Variable name Data type | Description
Word_1 to Word_6 WORD Used to Read Al data (16-bit).
Long_1 DINT Used to Read Al data (32-bit).
Real_1 REAL Used to Read Al data (32-bit).

Refer to Appendix A for details on data type and ranges. After completing the settings, the defined
variables show as below:

¥ MName | Type | D.5 | Attrib, | Syb. | Initvalue | User.. | Tag | Description
Long_1 DINT O ~
Word_1 WORD O
Word_2 WORD O
Waord_3 WORD O
Word_4 WORD O
Word 5 WORD O 1=
Word B WORD O
Real_1 REAL O =
< o 5
[« | 100ivers | Variables < N

3. Inthe “l1O Drivers” window, drag variables - “Word_1 to Word_6", “Long_1", “Real_1" and “Status”
(that created in the Section 5.1.1) from the Variables Area to the Symbol Area in the third data block.
Note: The “Status” is an array variable. When you drag “Status” into the Symbol Area, it will show
“Status[0]” to “Status[4]", simply press “Del” key to delete “Status[0] to [1]” and “Status[3] to [4]".

IO Drivers *

B = Mg MODBUS Master Name | Yalue ¥ Name 4| Tupe | Dirn.
2 - g RTU: COM2:9600.M,8.1 Request <4> Read Input Reqgis... DO 0 BOOL A
y -8 <2» Read Input Bits (1) [1..16]]| Slave/Unit 3 Long_1 DINT
8 B <5> Write single coil bit (2] [1..]| Address 1 Real 1 REAL
) =1 <45 Fead Input Registers (2] [T, 10 ‘ Status DIMNT [C
ik Activation Periodic | Word_1 WORD
e Period [ms) 1000 Word 2 YWORD
~ Period on err... 15000 Word 3 WORD
é5 Timeout [ms] 250 ‘ Word 4 o WORD =
= Murmber of tri... 1 Word 5/ WORD
E* Description e Word B WORD 3
1 Symbol | Operation | Offset | Mask | Storage - LI~ - 1‘1 ﬁELAIN Jaganies =
Word_4 Data exchange 0 FFFF Default - - ¢ 1 1N
Word_5 < Datf ti:_-cc_flarEe_ _b_ _ FEFR-- Brefault Na ;e - IVValue i
Word 6 Data exchange 0 FFFF Default i
Long_1 Data exchange 1] FFFF DWORD [Low - High)
Real 1 Data exchange 0 FFFF DWORD [Low - High]

[ Status[2] Error report ]J FFFF Default ° :r i
< o el

(€ %] 10 Drivers” Variables

4. Set the “Operation” field of the “Status[2]” as “Error report” which means this variable will be set to
an error code when a read error occurs, or reset it to “0” when a read request is successful.
Press the “F1” key to view the description of the Modbus Master Configuration and move to the title
“Status and command variables” to know related commands and error codes.

5. Both the “Long_1" and the “Real_1" are 32-bit variables and require two Modbus addresses. So, set
their “Storage” column as “DWORD (Low — High)”.
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6. As the figure below, select the "Word_1" to “Word_6" and then click “Iterate property” to set their
Offset value (From: 0 ; By: 1).

| Dperation | Offset | Mask | Storage |
Data exchange FF d
Data exchange F
Data exchange F  Mame X |
Data exchange F ) ) =
Wob | Dowomhne LML w08
< \ Results

<>] 10 Drivers “ariables

[ Ok K]\[ Cancel ]

7. Next, double click the Offset field of “Long_1" and “Real_1” items and set their values as “6” and “8”,
then press “Enter” key to complete the settings.
Note: One 32-bit data requires two Modbus addresses. For instance, the Offset value of “Long_1" is
“6” and the next Offset value must be set to “8” (i.e., “Real_1").

Syrbol | Operation | Difset | Mask | Storage

Word_4 Data exchange 3 FFFF Default A

Word_ 5 Data exchange 4 FFFF Default

Word_B Data exchange 5 FFFF Default

Long_1 Data exchange 5 4-EFEF_IEWDHD [Lows - High)

Real_1 Data exchange g & W - ‘ WORD [Low - High)

Status[2] Error report 0 EL Dictouls v
£ 3 press “Enter” ¥

42| 10 Drivers " Varisbles

Win-GRAF User Manual, V2.0, Aug. 2020 by ICP DAS 5-10



5.1.4 Write AO Data (16-bit)
1. Using the same way in the Section 5.1 - Step 4 to create the 4th data block and completing all the

following settings in the “MODBUS Master Request” window, and then click “OK".

MODBUS Master Request @ In this example

Request

Description: l

SlaveUnit: |3

MODEBUS Request

I;% S_P;e_ad Inpit REEisters
| 5= Write single coil bit
| <6 Wite single holding reqister

| #1E % Wivikn ~ail Dike

Data block -

@Base address: i 1

tb items: (
Activation

O periodic: |0

Concal
(») On change

Misc.

@]‘_imeout: 1250

Mb trials: '

a. Slave/Unit:

(e.g., the Net-ID is “3”).
b. MODBUS Request: Select

ms

“<6> Write single holding register”.

-
Enter the Net-ID of the Slave device.
K6

c. Base address:

) Start from “1” by default.
(See Section 5.1.1 to change it.)

d. On change: In case of a write request,
means that the request is activated
each time any variable changed.

> (See Section 5.1.1 for derails.)
P ’ e. Timeout: Set a timeout value.
{on error)

When time-out occurred, it will show
the defined error code. (The
recommended value for the Modbus
RTU/ASCII device is 200 to 1000 ms. In
this case the value is 250 ms.)

2. Next, open the “Variables” window and then declare variables that are available for the program.

Workspace
B4 _J] Test_01

G ~ Programs
T Main

3 watch [for debuggi...

-8 Soft Scope
= = Initial values

%4 Binding Configuration

e 3 g Global defines
-} Variables
LB Types

(- Exception programs 2

10 Drivers *
B =M@ MODBUS Master Name | Value
-8y RTU: COM2:9600.M.8.1 Request <B> Wite single holding ..
,,E G- “B <2> Read Input Bits (1) [1..16] Slave/Unit 3
“B <5> Write single coil bit [2) [1..1] Address 1
= "B <4> Read Input Registers (3] [1..10 Nb Item 1
a ; <63 Wwiite single holding register [3) [1..1] || E0ELG] 0On Change
Period [ms) 0
i . Period onerror 0
¢s | Tips: Timeout (ms] 250
Press “F1” key to view the details Nurbar. of e [1
B | onthe MODBUS Master settings. Description

Double-click it to open this window.

Declaring a "WORD" variable.
(Refer to Appendix A for details on data type and ranges ; refer to Section 2.3.1 for operations).

Variable name

Data type

Description

Word_Write_1

WORD

Used to write AO data (16-bit).
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After completing the settings, the defined variables show as below:
¥ MName | Type | D.5 | Attrib. | Syb. | Initvalue | User.. | Tag | Description
Word_Write_1 WORD O

|# |®

< : >

3. Inthe “10 Drivers” window, drag variables - “Word_Write_1" and “Status” (that created in the Section
5.1.1) from the Variables Area to the Symbol Area in the 4th data block.
Note: The “Status” is an array variable. When you drag “Status” into the Symbol Area, it will show
“Status[0]” to “Status[4]", simply press “Del” key to delete “Status[0] to [2]” and “Status[4]".

4. Set the “Operation” field of the “Status[3]” as “Error report” (that means this variable will be set to an

error code when a read error occurs, or reset it to “0” when a read request is successful).
Press the “F1” key to view the description of the Modbus Master Configuration and move to the title
“Status and command variables” to know related commands and error codes.

IO Drivers *
i - Mg MODBUS Master Name | Yalue ¥ MName 7| Type
2 B~ ;'%-; RTU: COM2:9600,M,81 Request <B> Write single holdi... C1 £2Y Global variables A
o [#-*B <2> Read Input Bits (1) [1..16] Slave/Unit 3 : Word Write 1 WORD
B.‘ "B <5 Write single coil bit (2) [1..1] Address 1 ‘ vvord_b VYURD &
= | [ °B <4> Read Input Registers (3][1..10]__|| Nb ltem 1 | Word 5 WORD
i &g gle hold q Activation On Change Word_4 WORD
¥El Period[ms] O : Word_3 WORD
| Period oner... 0 ‘ Word_2 WORD
&5 Timeout [ms) 250 Word 1 WORD
= - Mumber of tri... 1 j ,+ Status DINT
B Description P ( Ll it Bl -
) - = ?,,,,.S_:.-;-,‘, &l
' Symbal #Upefation | Offset | Mask | Storage. = — = ~ " | Range(Lc| Name | Walue ‘
Word_Wiite_1  Dataexchange. — T — FFFF~  Defaul
Status[3] Error report IU FFFF Default
£ ‘ | >

|4 %] 10 Drivers  Mariables
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5.1.5

Werite AO Data (32-bit)

1. Using the same way in the Section 5.1 - Step 4 to create the 5th data block and completing all the
following settings in the “MODBUS Master Request” window, and then click “OK".

MODBUS Master Request m In this example

Request =
Description: 1 ]
Slave Unit: '4 I @

MODBUS Request
Y I e\ B "~ AT e o 1
| €6 Write single holding reqister ~

| 215> Write Coil Bits

1 <16 Write Holding Reaisters %

@ Data block

Base address:

b items: [2
Activation

O periodic: { §

oncal
(%) On change

Misc.

Timeout; 1250

Mb trials: b

{on error)

ms

e. Timeout: Set a timeout value.

a.

Slave/Unit:
Enter the Net-ID of the Slave device.

(e.g., the Net-ID is “4”).

MODBUS Request:
Select “<16> Write Holding Registers”.

Base address:

Start from “1” by default.

(Refer to Section 5.1.1 to change it.)
Nb items:

The number of AO signals to write.
(In this case, the number is “2”
because the REAL type requires two
Modbus address).

d. On change: In case of a write request,

means that the request is activated
each time any variable changed.
(Refer to Section 5.1.1 for details)

When time-out occurred, it will show the defined error code. (The recommended value for the
Modbus RTU/ASCII device is 200 to 1000 ms. In this case the value is 250 ms.)

2. Next, open the “Variables” window and then declare variables that are available for the program.

Workspace

E- ) Test_D1
[ Exception programs
E1--E3 Programs
‘ T Main
5[ Watch [for debugai...
: 38 SoftScope
o ] Iritial values
{ B3 Binding Configuration
" 3g Global defines

T Vaiable
B Types \

10 Drivers *
| B Mg MODBUS Master
g - RTU: COM29600N 81

S B <2> Read Input Bits (1) [1..16]
E “B <5> Wiite single coil bit [2) [1..1]
1“8 <4> Read Input Registers (3] [1..10]
-8B <B> Write single holding register (3) [1..1]

i
v -:, o "E A it

Name | Yalue

Request <16> Wiite Holding R...
Slave/Unit 4

Address 1

Nb Item 2

Activation On Change

Period [ms) 0

3 w

Period onemrar

s ] Timeout [ms) 250
Tips: Number of trials 1
N Press “F1” key to view the details | pescription

Double-click it to
open this window.

on the MODBUS Master settings.
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Declaring a "Real" variable.
(Refer to Appendix A for details on data type and ranges ; refer to Section 2.3.1 for operations).

Variable name Data type | Description
Real_Write_1 REAL Used to write AO data (32-bit).

After completing the setting, the defined variable shows as below:

T Name | Type | D.5 | Attrib, | Syb. | Initvalue | User.. | Tag | Description
Real Write_1 REAL O] —
< | 5
|i85 %) —ciO Brivers) Variables,/

3. Inthe “IO Drivers” window, drag variables - “Real_Worite_1” and “Status” (that created in the Section
5.1.1) from the Variables Area to the Symbol Area in the 5th data block.
Note: The “Status” is an array variable. When you drag “Status” into the Symbol Area, it will show
“Status[0]” to “Status[4]", simply press “Del” key to delete “Status[0] to [3]”.

4. Setthe “Operation” field of the “Status[4]” as “Error report” (that means this variable will be set to
an error code when a read error occurs, or reset it to “0” when a read request is successful).
Press the “F1” key to view the description of the Modbus Master Configuration and move to the title
“Status and command variables” to know related commands and error codes.

5. The “Real_Write_1" is a 32-bit data and required two Modbus addresses. So, set its “Storage” field
as “DWORD (Low — High)”.

IO Drivers *

B2 = Mg MODBUS Master Name | Value 7 Name 4| Type
2 )3 RTU: COM2:9600,M,8,1 Request <16> Wiite Holding R... | Bool_15 BooL A
3 (-8 <2> Read Input Bits (1) [1..16] Slave/Unit 4 ‘ Bool_16 BOOL
B -*B <5 Wite single coil bit (2)[1..1] Address 1 DO.0O BOOL
3 “ *B <4> Read Input Registers (3] [1..10] Nb Item 2 Lang_1 DINT
B- ; <B> Wiite single holding register (3) [1..1]| Activation 0On Change Real 1 REAL
o 58 BE oiding Flagta Period(ms) 0 | ; Real Wiite 1 REAL |
Periodon er... 0 Status DINT
éb Timeout [ms] 250 } 7 Word_1 YWORD
™ Mumber of tri... 1 _ e Word_2 WORD
' Description = - | <"‘"""" i HIRRD 5 :
' Symbol /| Dperation | Offset | Mask— Smrage = | Range (Lc| Mame | WValue [
Real wiite_1 @ DatSemfange 0 FFFF | DWORD [Low - High) |
Status[4] Error report ] 0 FFFF
< | >

]
|

(4 #| 10 Drivers  Variables
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5.1.6 How to use the XV Board?

The XV board belongs to the Modbus Slave /O board. Before using the I/O board, users must plug it into
the WP-5xx8-CE7, and then enable the WP-5xx8-CE7 as a Modbus Master (refer to Section 5.1). Visit the
XV board Selection Guide page to get more details.

All the Win-GRAF demo projects listed in the following table can be found on the CD-ROM. Refer to
Chapter 12, click the Win-GARF menu bar "File" > "Add Existing Project" > "From Zip" to restore the demo
project and to view the details. (CD-ROM:\Napdos\Win-GRAF\demo-project\)

Demo File Name Description
XV107, XV107A | demo_XV107.zip Read 8 DI, Write 8 DO
XV110 demo_XV110.zip Read 16 DI
XV111, XV111A | demo_XV111.zip Read 16 DO, Read 1 DO
XV116 demo_XV116.zip Read 5 DI, Write 6 DO
XV308_1 demo_XV308_1.zip 1. Read 8 Al, Read 8 DI
XV308_2 demo_XV308_2.zip 2. Read 8 Al, Write 8 DO
XV308_3 demo_XV308_3.zip 3. Read 8 Al, Write 4 DO, Read 4 DI
XV310 demo_XV310.zip Read 4 Al, Write 4 DO, Read 4 DI, Write 4 AO

Common setting:
1. Mouse click the “Open Fieldbus Configuration” tool button to open the “IO Drivers” window.

Win-GRAF - demo_XY107

File Edit ¥iew Insrt Project Tools Window Help

= B2 AN NRINEENhS & € OB g 5 Al
Workspace 10 Drivers *
e demo_X¥107 E N}J MODBUS Master 57 Name | Type
(-3 Exception programs 2 SEr- N AT COMO:T15200M 8.1 X107 _DIL0O0 BOOL =~
(= Programs F -8B <2> Read Input Bits (1 [1..8] A107_DIL01 BOOL
3] Main 8 [£-*B <15> Wiite Coil Bits (1) [1..8] N7 NIEN?  ROOI 1
[~ Watch [for debugaing) || ' .Mg MODBUS Slave MODBUS Master Port
&% Soft Scope !
oo 2 Initial values Request | Slave/Unit | & — b
‘ %4 Binding Configuration <2> Read Input Bits 1 1 O MODEUS on Ethernet K |
- 3g Global defines @5 <15 Wiite Cail Bits 1 1 At ’ ‘
i a Variables = L 5
B Types B & Port; "
Build - If using it as the Modbus ¢

Prgtacol ASCIl Master, modify it to
“ASCII:COMO0:115200,N,8,1”

2. Double click on “RTU: COM:115200,N,8,1” to /
open the “MODBUS Master Port” window.
Note:

All the demo projects listed in above table
enable the WP-5xx8-CE7 as a Modbus RTU Delay between requests

Master device and set the "Com. Port" as Delay (ms): u |
"COMO0:115200,N,8,1".

Com. port: | COMO:115200,M,8,1 \
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Configure the Al/AO channel

If you want to use the Al/AO channel of the XV Board (e.g., XV308, XV310) in the WP-5xx8-CE7. First, stop
the Win-GRAF driver on the PAC and then configure each Al/AO channel by using

"DCON_Utility_Pro_CE_200.exe".

Using the WP-5238-CE7 as an example:

1. Click the "Win_GRAF_WP_5238" (or the small icon on the taskbar) to open the Win-GRAF driver

window, and then click the "End Driver" button.

8 #

My Devies Regedt

@ 2

Intemet  taskmanager
Exploter

=

Mixosoft
wordPad

/
Lo
My
Documents
/
7l

PAC Utiity

This product is licensed.
Project name : demo_xXY110 , YMDE size : 303922

Elapsed time : 0. 0: 0:19

Win-GRAF-WP-5238 0K

WR-S232 driver Wersion 1.01 , Jul. 16,2014

st |V virtual .2 |

Stop the Win-GRAF driver

8 [on EET €] [

2. Click "My Device" on the desktop and then get into the path "\System_Disk\Tools\dcon_utility_pro"

to run the "DCON_Utility_Pro_CE_200.exe".

Fle Edit view Go Favorites | || @] ||| x| = -] ||E
-~

I]]ﬂgldrES WSystern_Disk\Toolsvdoon_utility_pro

v auto_config

—log_report
CE7_PlatformBase_arm.dl

latforr.dl

3. Click the COM Port button to set the "COM Port" as "COMOQ", set the "Baud Rate" as "115200" and set

the "Format" as "N,8,1", and then click

DCON Utility Pro 2.0.0.0 for CE7 arm(WP5231)

EIQmE

— crnd_config
— rermote_config rsystem
CrdParser. dl
OM_Utility_Pro_CE_200, exe STt lale B =Nl
. Protocol.di

==

i language

Cornmulo.di
PACKNET .l

Utility. ol

|IOK|I'

Start A S5 0 End Address |1

4]

O D Optio
D |addr.. [BaudRate | Checks... [Format] std COM Part Timeout
|COMO[BackDIane]

Ii 200 ms

[Baud Rate I Protocol IChecksu

@® M3, ONSE,2 OES1 00,81

‘ oK *\ ‘ Cancel |
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4. After clicking the Search button, the XV Board (e.g., XV308) will show in the window. Then, double
click this item to get into the setting window.

DCON Utility Pro 2.0.0.0 for CE7 arm(WP5231)
L .E
A DR EREEE
N\

Start Address D End Address |1

1 ! A ! =3 = ! I"kncr*ripi-inh

X¥308 1[1h] 115200 Disable  N,8,1 [Modbus RTUJIS*AIL + 8 Uni ]

Double-click

| | B
L] ]
COM:0[N,8,1] || Address: 1[01h] || Baud Rate: 115200 || Checksum:Disable

5. Inthe "Configuration" tab, set the "Data Format" as "Engineering Format" (recommended setting), set
the "Fast Mode" as "Fast Mode" and uncheck the "Reverse DI State (INIT*)".

XV308 Firmware[A102]

(| configuration Batsar alarm | Dogalarm | HostwoT | o1 | about]

Protocol@IT*)  [rodous Ry []

Address 1 E 01+

Baud Rate(IMT*) 115200 =
Parity (INIT*) |18, 1-Mone Parity |2
ChecksurmiINIT*) IDisabIe =
Data Format |Engineering FDrI‘TEI
Fast Made [Fast Mode |

Response Delay a

[ Reverse DI State (INIT*}:

Set Module Configurations
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6. Inthe "Al/Al Alarm" tab, to configure the proper ranges and values for each Al channel, and
remenmber to select any Al channel (e.g.,"CH:00") you want to use, then click the "Set Alarm" button.

Xv308 Firmware[A102]

0fslarm | Host woT | D1 | about |
High Alarm Limit  Low alarm Limit  Alarm Mode
CH:op 00003 [-000.003]  [o&]+- 10v []|10 | |10 | |pisable [=]
CH:p1 00004 [00.0040] ool +~-5v [+ | |5 | |pisable [+]
[V CH:z 00052 [-00.0052]  [os]+/- 2.5 v [¥]|25 NEE | |pisable [=]
CH:03 -00011 [-00.0011] [mal+-1v [=]1 e | |pisable [+]
[v] CH:04 -00022 [-000.022] [[0D] +¢- 20 mi[x] 20 | |20 | |pisable [+]
cHips 00005 [-000.005]  ios]+/- 10 v [][10 | |10 | |pisable [+]
CHip 00006 [-000.0061  iog]+/- 10v [][10 | |10 | |pisable [+]
cHip7 00001 [-000.001]  ios]+/- 10 v [=][10 | |10 | |pisable [+]
XV308:
Type Code Range Data Format Minimum Maximum
Engineering -25000 +25000
05 +/-2.5V ,
Hexadecimal 8000h 7FFFh
Engineering -20000 +20000
06 +/-20 mA -
Hexadecimal 8000h 7FFFh
Engineering +4000 +20000
07 +4 mA ~ +20 mA -
Hexadecimal 0000h FFFFh
Engineering -10000 +10000
08 +/-10V -
Hexadecimal 8000h 7FFFh
Engineering -5000 +5000
09 +/-5V -
Hexadecimal 8000h 7FFFh
Engineering -10000 +10000
0A +/-1V ,
Hexadecimal 8000h 7FFFh
Engineering -20000 +20000
0D +/-20 mA -
Hexadecimal 8000h 7FFFh
Engineering 0 +20000
1A 0 mA~ +20 mA -
Hexadecimal 0000h FFFFh
Note:

1. For easy to use, recommended to use the data format - "Engineering”. (E.g., "+/-2.5 V" will show as
"-25000 to +25000" and "+4 mA to +20 mA" will show as "+4000 to +20000)

2. When using these "Type Code” - 06, 07, 0D, 1A, please check if the position of eight hardware
jumpers on the XW board are correct.
http://www.icpdas.com/en/download/show.php?num=2271

Win-GRAF User Manual, V2.0, Aug. 2020 by ICP DAS 5-18


http://www.icpdas.com/en/download/show.php?num=2271

7.

Note: When using the XV308, you need to click the "Set Power On" and "Set Safe Value" button (do
not choose any DO Status) in the "DO/Alarm" tab.

Xv308 Firmware[A102]

|HostwoT o1 | about |

DO Status

[Je  [Jr [J2 [Js [J4 [Js [Js []7
Read DO

Qe Do not choose any DO Status.

(O Read Power ON Yal.e Then, click the "Set Power On"

and "Set Safe Value" button.

Set Safe Yalue

{ ) Read Safe Yalue

Alarm Status

H:0 Hil H:2 H:3 H:d H:S HiE H:7
[cClear | [clear | [Clear | [Clear | [Clear | [clear | [clear | [ clear |
L:d L:1 L:2 L:3 L:4 L5 L:G L:7
[Clear | [clear | [Clear | [cClear | [Clear | [clear | [clear | [ clear |

Finally, back to the "Configuration" tab and click the "Set Module Configuration" button (Step5) to
finish the AI/AO configuration, and then close the "DCON_Utility Pro_CE_200.exe". In addition, click
the "Win_GRAF_WP_5238" on the desktop to run the Win-GRAF driver (like Step 1).

Follow the similar way like the steps above to configure the Al/AO of the XV310.

XV310 - Analog Input:

Type Code Range Data Format Minimum Maximum

Engineering -25000 +25000
05 +/-2.5V -

Hexadecimal 8000h 7FFFh

Engineering -20000 +20000
06 +/-20 mA -

Hexadecimal 8000h 7FFFh

Engineering +4000 +20000
07 +4 mA ~ +20 mA -

Hexadecimal 0000h FFFFh

Engineering -10000 +10000
08 +/-10V -

Hexadecimal 8000h 7FFFh

Engineering -5000 +5000
09 +/-5V -

Hexadecimal 8000h 7FFFh

Engineering -10000 +10000
0A +/-1V -

Hexadecimal 8000h 7FFFh

Engineering -20000 +20000
0D +/-20 mA .

Hexadecimal 8000h 7FFFh

Engineering 0 +20000
1A 0 mA ~ +20 mA -

Hexadecimal 0000h FFFFh
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Note:
1. For easy to use, recommended to use the data format - "Engineering”. (E.g., "+/-2.5 V" will show as

"-25000 to +25000" and "+4 mA to +20 mA" will show as "+4000 to +20000)

2. When using these "Type Code” - 0, 1, 06, 07, 0D, 1A, please check if the position of eight hardware
jumpers on the XW board are correct.
http://www.icpdas.com/en/download/show.php?num=2271

XV310 - Analog Output:

Type Code Range Data Format Minimum Maximum

Engineering 0 +20000
0 0 mA ~ +20 mA

Hexadecimal 0000h FFFFh

Engineering +4000 +20000
1 +4 mA ~+20 mA

Hexadecimal 0000h FFFFh

Engineering 0 +10000
2 ov~+10V

Hexadecimal 0000h FFFFh

Engineering -10000 +10000
3 +/-10V -

Hexadecimal 8000h 7FFFh

Engineering 0 +5000
4 OV~+5V -

Hexadecimal 0000h FFFFh

Engineerin -5000 +5000
5 +/-5V & - £

Hexadecimal 8000h 7FFFh
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5.1.7 Connecting the XV107/ XV107A (8 DI, 8 DO)

The XV107/XV107A is an 8-channel digital input and 8-channel digital output board. This section provides
a Win-GRAF demo project - "demo_XV107.zip". First, go to Section 5.1.6 for the information of the XV
Board before using it.

Demo description:
This demo added two data blocks. One is used to read 8 DI data and the other is used to write 8 DO data.

1. Mouse double click the 1st data block (i.e., <2> Read Input Bits) to open the setting window.

Workspace i 10 Drivers
_11 demo_XV107 E = N]n MODBUS Master A7 Name | Type
([ Exception programs 2 [~ RTU: COMO:115200,N.8.1 AV107_DILO0O BOOL A
(=~ Programs o RN = <2> Read Input Bits (1) [1..8] i X107 _DIL0O1 BOOL
2] Main E ‘ “B <15> Wiite Coil Bits (1) [1..8] v X107_D1 02 BOOL
£ 4 Watch [for debugging) || =8 ; X107 _DIL03  BOOL
I g - Symbol | Operation | Dffset| Mask | Storage =
éﬁj::lfe?pe &l v107_p1_oo Data exchange 0 |FFFF  Defaut glg;—g:—gg 288'[ o
TR " : Q X107_DI_ Data exchange 1 FFFF Default G
Y3 Binding Configuation || =1 70" Data exchange 2 |FFFF Defaut Wl e HO0.
g Global defines és ol X107 DL 07 BOOL
% Vaiiables 5 X107_DI_03 Data exchange 3 FFFF Default V107 status  DINT l
B Types B XV107_DI_04 Data exchange 4 FFFF Default V] 07—0 500 BOOL
3 X107_DI_05 Data exchange 5 FFFF Default 3 s
“%107_DI_0B Data exchange ] FFFF Def. e —
X107 DI 07 Data exchange 7 FFFF_~Detaul biang FT
[ K107 _status Error report 1] F Default
| -~ ) | € | | (¥

!

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value
plus 1 (Base address). Moreover, if you set the “Operation” as "Error report”, the “Offset” value
for the mapping variable (Date Type: DINT) must set to “0”.

MODBUS Master Request %]
Request
Description: l ‘ _OK

Slave/Unit: il & The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).
MODEBUS Request

| <1 > Read Coil Bits ~
1 <2 Read Input Bits

| 53> ReadHolding Registers ™| Read DI data.
Data block

Base address: |1 ‘

AR é_s_ ®_| startfrom addr. 1 and

read eight data.

fckivation
@ periodic: |50 | ms 0 ‘
On call
O ; .\ Read every 50 ms.
() oOn change
Misc,
Timeout: 2100 y M5 . .
—’\ An exception occurs if no
|' -1
Mb trials: 1 j respond for 100 ms.
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2. Mouse double click the 2nd data block (i.e., <15> Write Coil Bits) to open the setting window.

Workspace j 10 Drivers
£ i demo_X¥107 |8 Mg MODBUS Master A |7 Name | Type
3 l] Exception programs 2 g% RTU: COMO:115200M,8.1 = ‘ X107_DIL05 BOOL o
= Programs 3 -8 <2> Read Input Bits (1) [1..8] A107_DIL0OB  BOOL
L e 3] Main | & (R = B < 15> Wite Coil Bits [1)[1..8] 107_DIL0O7  BOOL
& 1 Watch [for debugging) \Q : @ +0:Xv107_D0_00 || K107 _status  DINT
P -8 Soft Scope |3 Symbol | Operation | Offset)| Mask | Storage X107 _DO_00  BOOL
o = Inital values *%107_D0_00 Data exchange 0 FFFF Default *107_DO_01  BOOL
g Binding Configuration || = w107 o 1 Data exchange 1 FFFF Defauit A¥107_DO 02 BOOL
-39 Global defines "@:9 ®¥107_D0_02 Data exchange 2 FFFF Default Xv107_DO_03 BOOL
fay Variables ‘iﬂ; s107_D0_03 Data exchange 3 FFFF Default Av107_DO_04 BOOL
B Types ~ XV107_D0_04 Data exchange 4 FFFF Default *107_DO_05 BOOL
[ XV107_DD_05 Data exchange 5 | FFFF Defaul AV107 DO 0 BOOL
%v107_DO_06 Data exchange 6 |FFFF Defaut T R
X107_D0O_07 Data exchange 7 FFFF Default —— — =y
= : || Name | Value ]

|

MODBUS Master Request m

Request

Description: \

|

R S

[ 1

i .

Slave/Unit:

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

MODEUS Request

T <5 Write single coil bit
| <6 Write single holding register

N

S e o N Write DO data.
Data block ,

Base address: il ¢\

S Fame: f—— Start from addr. 1 and

. B write eight data.
Activation

O periodic: ‘ s lo ]

Ooncal {on error)

() On change @————————

Write only when data changed.

Misc.
[
Timeout: {100 ms
b trials: il ‘

An exception occurs if no
respond for 100 ms.
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5.1.8  Connecting the XV110 (16 DI)

The XV110 is a 16-channel digital input board. This section provides a Win-GRAF demo project -
"demo_XV110.zip". First, go to Section 5.1.6 for the information of the XV Board before using it.

Demo description:
This demo added one data block that used to write 16 DI data.
1. Mouse double click "<2>Read Input Bits" to open the setting window.

Workspace 10 Drivers
- il demo_XV110 B - m, MODBUS Master | 7 Name | Type
[ Exception programs 3 g5 RTU: COMO:115200,4,8,1 X110_DI_00 BOOL =&
[ Programs 8 [ER8= ] <2> Read Input Bits (11 [1..16] AV110_DI_D1 BOOL
f 3] Main " - *110_DI_02 BOOL
5. B Watch ffor debugging) || S Symbaol | Operation | Offset | Mask | Storage w110 DI 03 BOOL
X110_DI_00 Data exchange 0 FFFF Default oo
&% Soft Scope X110 _DI D4 BOOL
‘. o E X110_D1I_M Data exchange 1 FFFF Default balce
- 2 Initial values Xv110_DI_05 BOOL
T . . {4 xv110_DI_02 Data exchange 2 FFFF Default S
%4 Binding Configuration X110 _DI 06 BOOL
N { .. 2110.DI_03 Data exchange 3 FFFF Default e
i 3q Global defines éd Av110_D1 07 BOOL
: 3 T X110_DI_D4 Data exchange 4 FFFF Default oo
ioofaY Wariables X110 _DI 08 BOOL
] = *110_DI_05 Data exchange 5 FFFF Default balce
-B& Types X110 _DI_09 BOOL
— X¥110_DI_06 Data exchange 6 FFFF Default T U_D |" 10 BOOL
50 %v110.DI1_07 Data exchange 7 FFFF Default T D_Dl_ 11 BOOL
X110_DI_08 Data exchange 8 FFFF Default W1 U_Dl— 12 BOOL
*110_DI_09 Data exchange 9 FFFF Default w1 D_DI_ 13 BOOL
X¥110.DI_10 Data exchange 10 FFFF Default W1 U_D |" 14 BOOL
X110.D1_11 Data exchange 1 FFFF Default w11 D_Dl_ 15 BOOL
X110.DI_12 Data exchange 12 FFFF Default 110 atat DINT l
XV110_DI_13 Data exchange 13 |FFFF Defaut =SS b
%¥110_DI_14 Data exchange 14 |FFFF Defa e LT i S
5110 DI 15 Data exchange 15 FFFF Ehault Name | Value |
[ X110 _status Error report 0 Default

>

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value
plus 1 (Base address). Moreover, if you set the “Operation” as "Error report”, the “Offset” value
for the mapping variable (Date Type: DINT) must set to “0”.

MODBUS Master Request m

Description: | ’ '
s — —
E—
Stave/Link: 1—?\ The Net-ID ( fixed to “1” ) of the
MODBLS Request Slave device (i.e., XV board).
r<—(1— = Read Coil Bits ~
| <2> Read Input Bits T
| €3> Read Holding Registers
Bt En,ffli_fr_ Read DI data.
Data block :
Base address: '11
Mb items: 16 Start from addr. 1 and
o— read 16 data.
Activation
@ Periodic: |50 ‘z \u ’
oncal = = —
© On change Read every 50 ms.
Misc.
z :
Timeout: 1100 Q - .
-z = An exception occurs if no
Nb trials: |1 | respond for 100 ms.
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5.1.9 Connecting the XV111, XV111A (16 DO)

The XV111/ XV111A is a 16-channel digital output board. This section provides a Win-GRAF demo project -
"demo_XV111.zip". First, go to Section 5.1.6 for the information of the XV Board before using it.

Demo description:
This demo added two data blocks. One is used to write 16 DO data and the other is used to read the DO
status.

1. Mouse double click the 1st data block (i.e., <15> Write Coil Bits) to open the setting window.

[} Win-GRAF - demo_X¥111 Q@@

File Edit View Insrt Project Tools Window Help
Sl G 4 X o a9 B iAEWEAR e BBA

Workspace 10 Drivers

- demo_X¥111 E (- Mg MODBUS Master A || Name | Type
[ffrﬁf [ Exception programs 2 B ﬁx RTU: COMO:115200,M,8.1 X111_DO_00 BOOL »~
[} Programs - (EBR = § < 15> Wwiite Coil Bits (1) [1..16] *111_DO_MM BOOL
[ Main IS wvvrerwT: | Xvi111.D002 BOOL
=1 [0 Watch (for debugging] = Symbol | Operation \ Offset L Mask | Storage | ¥v111_DO_03 BOOL
| L.[N Soft Scope B g: 1 1_33_3? ga:a exc:ange 10 Default V2R L M ntal st BN =TaTa)
»-- _DOo_ ata exchange “« ” : :
- éﬂ g:::;; s;a(l:u::ﬁgwanon 7 ippe e 3 mﬂTbe Offset”value is starting
§ig Global defines g5 ¥¥111.00_03 Data exchange 3 from “0” and the Modbus address
-} Varbles sonan Sl : of a variable is equal to this value
LB Types B¢ xv111_D0_05 Data exchange 5
~ Xv111_D0_06 Data exchange 5 plus 1 (Base address = 1).
= v111_D0_07 Data exchange 7 S T O T
X1 1_00_08 Data exchange 8 FFFF Default W11 1_00—1 2 BOOL
X1 1_DD_09 Data exchange 9 FFFF Default 11 1_00_1 3 BOOL B
X111 1_DU_1 0 Data exchange 10 FFFF Default 11 1_00_1 4 BOOL
211 1_00_1 1 Data exchange 1 FFFF Default 11 1_00_1 5 BOOL
®111_D0_12 Data exchange 12 FFFF Default W1 1_stat_us DINT 7
XV111_D0_13 Data exchange 13 FFFF Default ¢ N T
®XW111_D0O_14 Data exchange 14 FFFF Default Na;e. i Vaie — | :
XV111_D0_15 Data exchange 15 FFFF Default
< 1 >

MODBUS Master Request m
Description: I ' K

Slave Unit: I_1 ?\ The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

MODEBUS Request

| <5 Write siﬁdle coil bit ~
| <63 Write single holding regi :

<15 Write Coil Bits

Leten ko Uoldinn Oonkbons Write DO data.
Data block .

Base address: I1

. —ﬁ} Start from addr. 1 and

Ll jE | write 16 data.
Activation

() Periodic: iw | \ ms ‘g ’

Con call {on error)¥

(*)Onchange @—eu-— | )

Write only when data changed.

Misc.

Timeout; ElUU ms . .

— An exception occurs if no
Mb trials: I1 } respond for 100 ms.
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2. Mouse double click the 2nd data block (i.e., <1> Read Coil Bits) to open the setting window.

Workspace 10 Drivers

£ demo_X¥111 B Mg MODBUS Master 4| 7 Name | Type
’ [ Exception programs | 2 - gk RTU: COMO:115200M,8.1 *111_DO_10  BOOL o
[} Programs b B -8 <15> Wiite Coil Bits (1) [1..16] *W111_DO_M BOOL
' ] Main Y 1> Read Col Bits [1)[1..1] |l xv111_D0_12 BOOL

&1 Watch (for debugaing) | S o Error report: %4111 _status 3 ®/111_DO_13  BOOL
g ‘ ‘
[ d cliiSnope E Symbol | Operation | Dffset | Mask | Storage AAT1_DO_t4 BOOL
- E Initl values XKV111_status Error report 1} FFFF Default ] Bl
%3 Binding Configuration || = = P [ xv111_status  DINT ]v
3 Global defines és e v
(a} Vaiables E N | Name | Value 7 [
B Types [FER i 1 >

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value
plus 1 (Base address).

MODBUS Master Request

Request

Description: | ‘ . OK

SlavefUnit: n ?\ The Net-ID ( fixed to “1” ) of the
’ Slave device (i.e., XV board).

MODBUS Request

1> Read Coil Bits
| £2> Read Input Bits
<3> Read Holding Registers Read DO data.

| #AS Omnd Trmik Danickaves

— B
<o |

Data block

Base address:

Start from addr. 1 and

hlp o read one data.
Activation
() periodic: ‘0 ‘
{Joncal
O omichange Read every 50 ms.
Misc,
e
i : {100 ms ] ]
Tnspdki !4l\ An exception occurs if no
Nb trials: - | respond for 100 ms.
: L
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5.1.10 Connecting the XV116 (5 DI, 6 Relay)

The XV116 is a 5-channel digital input and 6-channel relay output board. This section provides a
Win-GRAF demo project - "demo_XV116.zip". First, go to Section 5.1.6 for the information of the XV
Board before using it.

Demo description:
This demo added two data blocks. One is used to read 5 DI data and the other is used to write 6 DO data.

1. Mouse double click the 1st data block (i.e., <2> Read Input Bits) to open the setting window.

Workspace 10 Drivers
-l demo_X¥116 [ E =] l“h’j MODBUS Master | Type | D
[ Exception programs & g RTU: COMO:115200,N,8.1 ¥116_DI_00 BOOL A
[}~ Programs ‘B =8 L3 A/116_DI_01  BOOL
C e ] Main : -8 <15> Wite Cail Bits (1) [1..6] | A116_DI_ 02 BOOL
E o || = ]
o ;JJ aichifor detiioda) Symbaol | Operation Offset | Mask | Storage s1h D, JRe0L 3
&8 Soft Scope & X116 DI 04 BOOL
., % X116_D1_00 Data exchange 0 FFFF Default
= Initial values AV116_status  DINT l
%3 Binding Configuration B xv116.DL01 Detaeschanoe 1 i Defa *116_RL 00 BOOL
.86 Blobal defines . A116_DI_02 Data exchange 2 FFFF Defauy M= ¥:
- ag an % %116_DI_03 Data exchange 3 |FrF A | ) . i
: - — ge_Xv116 DI_04 Data exchange 4 FFFE" Default Name | Value |
L : KV116_status Error report 0 F Default
. -’ 2|

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value
plus 1 (Base address). Moreover, if you set the “Operation” as "Error report”, the “Offset” value
for the mapping variable (Date Type: DINT) must set to “0”.

MODBUS Master Request m

Request :
Description: \ 1
— = (S — — |
Slavejuni: 1 & | The Net-ID ( fixed to “1” ) of the
MODBUS Request Slave device (i.e., XV board).

[ £3> Read Holding Registers ™| Read DI data.
Data block - -

Base address: i,l +\

Nb items: s Start from addr. 1 and

- —— read five data.
Activation

() periodic: ; 50 Q [0 7"

Concal 5 '

(O On change Read every 50 ms.
Misc.

Timeout: EAIUU Q

e An exception occurs if no
b trials: B | respond for 100 ms.
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2. Mouse double click the 2nd data block (i.e., <15> Write Coil Bits) to open the setting window.

Workspace
- demo_X¥116
[ Exception programs
1 Programs
2] Main

&8 Soft Scope
Lo 23] Initial values
% Binding Configuration
b ,§g Global defines
fa} Variables
- Types

1+ Watch [for debugging) O

MODBUS Master Request

Request

Description: ‘

Slave/Unit:

MODELIS Request

L N

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

;:1.5.> Write single coil bit

| <63 Write single holding register

AL WMvibm Ul dim s P mis b

Data block

Base address:

Write DO data.

Start from addr. 1 and

Mb items: . .
write six data.
Activation
O periodic: Ih l ms ‘U l
() on cal {on error)

{(*) on change ¢——m+———|

Misc,

Timeout; {100 ms

b trials: i1

Write only when data changed.

An exception occurs if no
J respond for 100 ms.

Win-GRAF User Manual, V2.0, Aug. 2020 by ICP DAS 5-27

10 Drivers
1 B = Mg MODBUS Master ~ :? Name | Type | D
; - E1- g RTU: COMD:115200,N,8.1 E *116_DI_04 BOOL o
8 : E1-B <2> Read Input Bits (1] [1..5] | KW116_status  DINT
: fEali = < 15> Wwirite Coil Bits 1] [1..8] | A116_RL_00 BOOL
~ Symbol | Operation \ Offset | Mask | Storage \ #v116_RL 01 'BOOL
a A116_RL_02 BOOL
XV116_RL_0D Data exchange 0 FFFF Default L
116 _RL 03 BOOL
m XV116_RL_OM Data exchange 1 FFFF Default S
[ A116_RL_04 BOOL
- XV116_RL_02 Data exchange 2 FFFF Default W16 RL 05 BOOL 2
G" XKV116_RL_03 Data exchange 3 FFFF Default < ‘— = 5 =
1 X116_RL_04 Data exchange 4 FFF Default e = ————
B i N | |
— XV116_RL_05 Data exchange 5 FFFF Defaut || 222M€ | Value
] 3 | 5|
|l N ) —__



5.1.11 Connecting the XV308 (8 Al, 8 DIO)

The XV308 is a 8-channel analog input and 8-channel digital input/output board. This section provides
three Win-GRAF demo projects - "demo_XV308_1.zip", "demo_XV308_2.zip" and "demo_XV308_3.zip".
First, go to Section 5.1.6 to view the XV Board instructions and then configure each Al channel by using
"DCON_Utility_Pro_CE_200.exe".

Demo description: (demo_XV308_1)
This demo added two data blocks, one is used to read 8 Al data and the other is used to read 8 DI data.

1. Mouse double click the 1st data block (i.e., <4> Read Input Registers) to open the setting window.

Workspace 10 Drivers
=) demo_XV308_1 |8 Mg MODBUS Master : | Type
[ Exception programs 2 =g RTU: COMO0:115200,M,8.1 s = fa} Global variables A
[~} Programs G = § <4> Fead Input Registers (1) [1..8] A308_AILD INT
2] Main 8 #-*B <2> Read Input Bits (1) [33..40] K & X308 A1 INT
"J E h;h f[fo: debugging) || *=" Symbol | Operation N || offset| Mask | Storage AVI0B AL 2 INT ™
L kS ope B xva08_a0 Data exchange 0 FFFF Defaul RO g [INT
el values B %v308.4A1_1 Data exchange 1 FFFF Defaul SELLSR L
% Binding Configuration | XV308 A2 Data exchange 2 FFFF  Defaul Avd8.ala JINT
(g ol cetmes 2 sov308 A3 Data exchange 3 FFFF  Defaul RV308_ALE INT
-} Variables go XV308_41_4 Data exchange 4 FFFF  Defaul XVI08 ALY INT
= e Xv308_A1_5 Data exchange 5  |FFFF Defaut 0l e OINT b
I X308 _AILE Data exchange 6 FFFF De (mnﬂ I 5 5] Nl
X308 Al 7 Data exchange 7 FFFE efault f Né;e - | Value —
[ X308 _status Error report 0 F Default
~ : >l >

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value
plus 1 (Base address). Moreover, if you set the “Operation” as "Error report”, the “Offset” value
for the mapping variable (Date Type: DINT) must set to “0”.

MODBUS Master Eequest

Ik
Descripkion: | |

1
SlavefUnit: . wan
The Net-ID ( fixed to “1” ) of the
MODBLIS Request Slave device (i.e., XV board).
<2 Read Input Bits ~
=3 Read Holding Reqiskers =

<4z Read Inpuk Reqiskers

~C e Wdwibm il il RiE

N Read DI data.

Drata block
Base address;
Mb items: _ Start from addr. 1 and
read eight data.
Ackivation
(%) Perindic: |5|:| L: ||:| |
{on cal
(") on change Read every 50 ms.
Misc,
Timeouk; 100 ms
An exception occurs if no
b trials: respond for 100 ms.
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2. Mouse double click the 2nd data block (i.e., <2> Read Input Bits) to open the setting window.

Workspace

- demo_X¥308_1

-+ Exception programs
F} - Programs

: 3] Main

: : &8 Soft Scope
=2 =3 Initial values
%3 Binding Configuration
i 3 g Global defines
(o} Variables
- Types

(-3 Watch (for debugging) || =

10 Drivers
B E-Mp MODBUS Master A| 7 Name | Type
& & RTU:COMOT1S200N 8! : XV30B_AI7 INT A
wpll -8 <4> Read Input Registers (1) [1..8] | %308 _status DINT

8 i =8 Z X308 DILO BOOL

) Symbol | Dperation | Dffset | Mask | Storage Xv308 DI1 BOOL
E' KW308_DI_0 Data exchange 0 FFFF Default Av308 DI 2 BOOL -
G xvaoe DIt Data exchange 1 |FFFF Defaut E0.0La  BOOL &
'é,é’ ®KW308_DI_2 Data exchange 2 FFFF Default mgg—g:é gggt
N Xy308_DI_3 Data exchange 3 FFFF Default ==
B¢ #V308_DI_4 Data exchange 4 FFFF Default xgg—g:—g gggt v
~ AV308.DI5 Data exchange 5 FFFF Default e B
0 ®v308_D1_6 Data exchange 6 FFFF  Default | —— == et

X308_DI_7 Data exchange 7 |FFFF Defaut || MNeme | Value
N« i | —/ AES I B

Notw: When using the XV308 to read DI data, the address must start from "33".

MODBUS Master Request

Request
| |

Description:
Slavejunit: |1 .| The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).
MODELIS Request

| <1 Read Coil Bits
Read Input Bits
«3> Read Holding Register:

b

Data block

Base address: 1:33

|
i -
f

Read DI data.

AN DA Tem b Dmmickave

Kpas 1 Start from addr. 33 and
Kb items: 8 )
read eight data.

Activation

() periodic: lr 50 E ‘ 0 ‘

On call :

8 o ch:ange Read every 50 ms.
Misc,

Timeout; glUU ms ] ]

- An exception occurs if no
Mb trials: ! | respond for 100 ms.
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Demo description: (demo_XV308_2)
This demo added two data blocks, one is used to read 8 Al data and the other is used to write 8 DO data.

1. Mouse double click the 1st data block (i.e., <4> Read Input Registers) to open the setting window.

Workspace 10 Drivers
- demo_X¥308_2 ‘ E 2| N]] MODBUS Master
[ Exception programs 2 . [ RTU: COMO:115200M,8.1

| Name | Type
E fay Global variables A

[ Programs 5 [ER=§ <4> Read Input Reaisters (1) [1..8] AV30B_AILD INT
i 3] Main E -8B <15 Write Coil Bits (1) [1..8] v H308_Al 1 INT
I‘J E l;:f[:c;rctie::gglng] ‘Q Symbol | Dperation ~ || Offset | Mask | Storage || %gg—i:—g :E; i
. B xv308 410 Data exchange 0 FFFF Defaut || g
- Iojhe yekes. [ %v308_a1_1 Data exchange 1 FFFF Defaul A8.A4 INT
¥ Binding Configuration ., XV308 A2 Data exchange 2 FFFF  Defaul 0205 N
39 GIanal i N X308_41_3 Data exchange 3 FFFF Default VB 6 INT
- |ge Xva08_AL4 Data exchange 4  |FFFF Defaul i e ML 1
s " xv308.A15 Data exchange 5 |FrFF Defaut AL Y308 status DINT _Jo
X308 416 Data exchange 6 FFFF D $ ;‘ 2
2308 &l 7 Data exchange Fi FFFE efault | Name | Value
[ K308 _status Error report 0 F Default
03 1 3¢ . | B

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value
plus 1 (Base address). Moreover, if you set the “Operation” as "Error report”, the “Offset” value
for the mapping variable (Date Type: DINT) must set to “0”.

MODBOE Master Eeqnest

Request
| | _OK

Descripkion:

Slave Unit: ! ?\ The Net-ID ( fixed to “1” ) of the

Slave device (i.e., XV board).

MODEUS Requeskt

2= Read Input Bits
<3 Read Holding Reqiskers

£ [0

N Read Al data.
Daka black,
Base address;
b items: _ Start from addr. 1 and
read eight data.
Ackivation
(3) Periadic: |5|:| t o
v on cal
O on changs Read every 50 ms.
Misic,
Timeaut: 100 ms ] ]
An exception occurs if no
M Erials: respond for 100 ms.
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2. Mouse double click the 2nd data block (i.e., <15> Write Coil Bits) to open the setting window.

Workspace 10 Drivers
& demo_X¥308_2 B Mg MODBUS Master A7 Name | Type
[ Exception programs 2 - RTU: COMO:115200,N,8.1 = RW308_status DINT A
[ Programs g : -8 <4> Read Input Registers (1] [1..8] 4 X¥308_DO_0 BOOL
3] Main : =8 B 3 X308_DO_1 BOOL
- Watch (for debugaing) Q - | X308_DO_2 BOOL
¥ SoftScope E Symbol | Operation | Offset | Mask | Storage ‘! 308 DO 3 BOOL
ik e XK308_DO_0 Data exchange 0 FFFF Default o 3
o B8 Initial values X308 DO 4 BOOL
%3 Binding Configuration m X308 _DO_1 Data exchange 1 FFFF Default XV'SDB_D 0—5 BOOL
I : . X308_DO_2 Data exchange 2 FFFF Default =g oo
-39 Global defines éd *308_DO_B BOOL
£ Varisbles | X308 _DO_3 Data exchange 3 FFFF Default XV308—D 0_7 BOOL
i [ B¢ K308_DO_4 Data exchange 4 FFFF Default ool s M
B Types | 2] >
— ®v308_DO_S Data exchange 5 FFFF Default e —
T v308_DO_E Data exchange 6 FFFF  Default Name | Walue
X308 _DO_7 Data exchange 7 FFFF Default ‘
B i | — >¢ | B
MODBUS Master Request
Request
OK
Description: | ] ;
| Y |
i 1
SlavefUnit: | ‘\ The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).
MODBUS Request (i.e., )
F_S_Q—Write single coil bit ~
| <6 Write single holding register =
i <15 Write Coil Bits 3

<1 & Wik Unldimm O amickavs
Y Write DO data.
Data block
Ve T
Base address: il
b items: '3 Start from addr. 1 and
— write eight data.
Activation
O periodic: 0 ’ ms lg ‘
80"‘ cal {on error)
On change @——————
. Write only when data changed.
Misc.

Timeout:; (100 | ms
—— An exception occurs if no

Mb trials: ‘l—l respond for 100 ms.
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Demo description: (demo_XV308_3)
This demo added three data blocks, the 1st one is used to read 8 Al data, the 2nd one is used to write 4
DO data and the 3rd one is used to read only 4 DI data.

1. Mouse double click the 1st data block (i.e., <4> Read Input Registers) to open the setting window.

Workspace 10 Drivers
- demo_XV308 3 \ B g5 RTU: COMO:115200,N,8.1 A 7 Name | Type

ﬁ [ Programs g B “8 <155 Wite Coil Bits (1) [1..4] E X308 A2 INT
] Main B <2> Read Input Bits (1) [33..40) F X3I0B_ AL INT

- Enceplion pograms || o BIRE-1 < 4> Ficad Input Fiegisters (1] [1..6] a_ X308 A1 INT A

‘ [ Watch (for debugging) || . 308 A4 INT
TG Symbol | Dperation | Dffset | Mask | Storage i = |
vt ft
;X &% Soft Scope B xvaoe a0 Data exchange 0  [FFFF  Defaut il el
w28 Initial values = X308 Al B INT
Nl . . Q K308 411 Data exchange 1 FFFF Default o
%3 Binding Configuration 308 ALY INT
7 : L XW308 412 Data exchange 2 FFFF Default ]
w3 Global defines é5 A308_status DINT
: ; K308 4A1_3 Data exchange 3 FFFF Default
‘oo fay Variables X308 DO 0O BOOL
= — B X308 414 Data exchange 4 FFFF Default DB—D 0— 1 BOOL
L —| XV308_AI_5 Data exchange 5  [FFFF Defaul ANEE D e
I 50y308 A6 Data exchange [ FFFF Default — |- i) 2.
K308 Al_7 Data exchange 7 FFFF Default v Name | Value
£ I | 2 | € | >

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value
plus 1 (Base address).

MODBUS Master Request a
Request
Description: ‘ }

e ——
|
Slavejunit: |1 b\ The Net-ID ( fixed to “1” ) of the
MICDBUS Requst Slave device (i.e., XV board).
| <2 Read Input Bits -~ "
! <3 > Read Holding Registers 7

t <4 > Read Input Registers

| #En Whvibn cimole mnil bik O\
Read Al data.

Data block

Base address: il ’

e fsi‘r\ Start from addr. 1 and

- — read eight data.
Activation

() periodic: iso | ms [o \

oncal z

) on:change Read every 50 ms.
Misc.

Timeout: E 100 ms . .

= An exception occurs if no
Mb trials: B ’ respond for 100 ms.

2. Asthe figure below, mouse double click the 2nd data block (i.e., <15> Write Coil Bits) to view the
setting window.

3. Asthe figure below, mouse double click the 3rd data block (i.e., <2> Read Input Bits) to view the
setting window.
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Workspace

- demo_XV308_3 (|

[ Exception programs
[ Programs
3] Main
=11 Watch [for debugging)
" 3R Soft Scope
w2 Initial values
& Binding Configuration
“- 39 Global defines
i m Variables
L By Types

Workspace

13 demo_Xv308_3
----- [[J Ewception programs
E ----- [ Programs

- 2] Main

[ *fatch [far debugging)

8 Soft Scope

- B Initial values

B Binding Configuration

- g Global defines

ﬁ Wariables

LB Tppes

10 Drivers

[B G-Mp MODBUS Master A 7 Name | Type

2 . 8 RTU: COMO:115200,N,8.1 ° A308_ALT INT ~
3 -8B <4> Read Input Registers (1] [1..8] X308_status DINT

B SRE=Y <15 Wiite Coil Bits (1] [1..4] | XV308_ DO_0 BOOL
[ Q -8 <2> Read Input Bits (1) [33..40] W x308_DO_1 BOOL =
ml Symbol | Dperation ) | Dffset | Mask | Storage xv3le_DO_2 BOOL
B %v308_Do_o Data exchange 0 [FFFF Defaut ANR0e D03 BaaL

X308 D01 Data exchange 1 FFFF Default mmnEE—E!—ﬁ EEE!’

‘ P X308 _DO_2 Data exchange 2 FFFF Default < | 5
E‘ i(VBUS_DD_B Data ex?:hange 3 FFFF Default _7ﬁamer | Value

| <6 Write sing

le holding register

I8 EMp MODBUS Master A 5F Mame | Type
2 B- ﬁ; RTU: COMDO15200.M,8.1 W305_Do 1 BOOL ~
B F1-*B <4> Read Input Registers [11[1..8] #=308_D0_2 BOOL
B B <15 ‘white Cail Bitz [1][1..4] = AVals_Do 3 BOOL
= B 30 | n Xv308_DI_4  BOOL -
E Symbal | Operation | Offzet | Mask | Storage Xv308 DI 5 1BOOL
=308 D4 Data exchange N 4 FFFF Drefault #v308_DI B BOCL
e N30 _DI_5 D ata exchange b FFFF Drefault Av308_DI7 - BOOL b
& /308 DI6 Data exchangs §  |FFFF Defaul 45 2
B4 Hv308_DI_7 Data sxchange 7 FFFF Defaul Namne | Walue
3 | — P | &
. oo MODBUS Master Request |
2. <15> Write Coil Bits: &
. Request
Write 4 DO data. ki | |
T Cancel
SlaveUnit: F ch—J
MODBUS Request
F%—;_Wlﬁﬁ'-gle coil bit

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

MODBUS Master Request

Request
Description:
: é =
Slave/Unit: i1 l
MODBLS Request

A Nand Tmn b Mmmickavs

IQE ~rie?d?:c.il Bits Al
L<3> Read Ho|d|ng Registers Read DI data.

] <15 Write Coil Bits

|18 m Wik Unldima Fan -

Write DO data.

Start from addr. 1 and
write four data.

o |

N

Data block ———

Base address: il '

b items: 4

—

Activation

O Pperiodic: |0 ’ ms

oncall

(*) On change @————

Misc.

Write only when data
changed.

Timeout:

(100 | ms

Hb trials: % An exception occurs if no

—

|

respond for 100 ms.

3. <2> Read Input Bits, read 4 DI data.

When using the XV308 to read DI data,
the address must start from "33".

Data block =

Base address: ;33 '

. , Start from addr. 33 and read
Mb items: 8 ) .
— only four data in this example.

Activation

®periodic: |50 | ms ‘ 0 |

(O 0on cal 2 k

() 0n change Read every 50 ms.
Misc, Note:

Timeout; 2100 ’ ms —_

Nb trials: 1 ]
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5.1.12 Connecting the XV310 (4 Al, 2 AO, 4 DI, 4 DO)

The XV310 is a 4-ch analog input, 2-ch analog output, 4-ch digital input and 4-ch digital ouput board. This
section provides a Win-GRAF demo projects - "demo_XV310.zip".

First, go to Section 5.1.6 to view the XV Board instructions and then configure each Al channel by using
"DCON_Utility_Pro_CE_200.exe".

Demo Description
This demo added four data blocks. The 1st one is used to read 4 Al data, the 2nd is used to write 4 DO
data, the 3rd is used to read 4 DI data and the 4th is used to write 2 AO data.

1. Mouse double click the 1st data block (i.e., <4> Read Input Registers) to open the setting window.

Workspace 10 Drivers
- demo_X¥310 E =] H:n MODBUS Master A|SF Name | Type
[ Exception programs o . gy RTU: COMO:115200,M.8.1 =] a Global variables A
[~} Programs 3 BB = § <4> Fead Input Reagisters (1] [1..4] AIT0_ALD INT
© e 3] Main E -8 <15> Write Coil Bits (1] [1..4] 0 AW310_Al_1 INT
(- Watch (for debugaing) || -8 <2 Read Input Bits (1) [33..36) - 310 A2 INT
. 4% Soft Scope 2] [-*B <165 Wiite Holding Registers (1) [33..34] = || A0 AL INT
E In_ma,| va!ues. . ¥ lSymboI | Operation | Offset | Mask | Storage AV310_AQ_D INT
‘."" g‘ln'i'”lgdc;?”"gu'a"°” L XV310_A1_0 Data exchange 0 FFFF Defaul AV310 A0 1 INT
30 Honacemes &2 ya10_Al1 Data excharige 1 FFFF Default Xv310_status DINT _J
<1 Variables go KVII0AL2 Data exchange 2 FFFF Def XERiEHU: [SECE
B Tipes X310 A3 Data exchangs 3 FFFF_~Defaul L] 2
[ K310 _status Error report 0 Default Name | Value
“ - 2 |< | ?

|4 5] 10 Drivers Varisbles .~

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value
plus 1 (Base address). Moreover, if you set the “Operation” as "Error report”, the “Offset” value
for the mapping variable (Date Type: DINT) must be set to “0”.

MODBUS Master Request @

Request

Description: 1 ’
T —
= =
Slavefunit: |1 A The Net-ID ( fixed to “1” ) of the
TS e Slave device (i.e., XV board).
| <2 Read Input Bits ~
| «3> Read Holding
l <4 > Read Input Registers
| B Mdvikm mimale mmil bk
Read Al data.
Data block
Base address: ll L\
Mb items: 4 | Start from addr. 1 and
o read four data.
Activation
() Periodic: S0 Q \0 y
{oncal —
© On.change Read every 50 ms.
Misc.
2 s
Timeout: {100 L{
= An exception occurs if no
b bials: ! | respond for 100 ms.
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2. Mouse double click the 2nd data block (i.e., <15> Write Coil Bits) to view the setting window.

Workspace 10 Drivers *
B ._ﬂ demo_XV¥310 “ E E!»l“_m MODBUS Master A7 Name | Type
[ Exception programs | 2 . Flogiy RTU: COMO:115200,M,8.1 K310 AD 1 INT ~
[ Programs 1 -8 <4> Read Input Registers (1] [1..4] A310_status DINT

#] Main RR= <155 Wwiite Coil Bits 1] [1.4] ¥310_DO_0 BOOL
-4 Watch (for debugaing) B <2> Read Input Bits 1) [33..36) = X310 _DO_1 BOOL
38 Soft Scope @-*B <165 Wiite Holding Redisters (1] [33..¥ B *310_DO_2 BOOL

LG

‘;,3 Ir?ma.l values. . m Symbol [ Operation | Offset | Mask | Storage ‘ ¥va10.00.3, |BOOL
& Binding Configuration | *310_DI.0 BOOL
... 3 g Global defines & X310 DO_0 Data exchange 0 FFFF Default %310 DI 1 BOOL
| Eﬁ Variables | XV310_D0_1 Data exchange 1 FFFF Default R R
B Tupes B XK310_DO_2 Data exchange 2 FFFF Default - < _ﬁ‘l_ 2|
" X¥310_D0_3 Data exchange 3 FFFF Defaul | Mame [ake
] — |
LS8 K ‘ 3l | =
MODBUS Master Request
Request
OK
Description: \ ‘ ;
T
SlavefUnit: ! K The Net-ID of the Slave
device (i.e., XV board).
MODBUS Request
| <53 Write single coil bit ~

| <6 Write single holding register
| <15 Write Coil Bits

AL W vikm Ualdimm M mmisk v .
N Write DO data.
Data block
.
Base address: il
Kb icinis: 4 Start from addr. 1 and
e write four data.
Activation
O periodic: 0 ‘ ms IEI J
Con cal {on error)
0On change @——————— .
® 2 Write only when data changed.
Misc,
—
Timeout; {100 ms . .
L | An exception occurs if no
S
Mb trials: 1 | respond for 100 ms.

3. Mouse double click the 3rd data block (i.e., <2> Read Input Bits) to view the setting window.

Workspace 10 Drivers *
- demo_XV¥310 \ I8 Mg MODBUS Master |57 Name | Type
1+ [ Exceplion programs || g g RTU: COMO:115200,N.8.1 Xv310_DO_0 BOOL 4
[ Programs B -8 <4> Read Input Registers (1]1..4] A310_DO_1 BOOL
: 3] Main 8 f B <155 Wiite Coil Bits (1) [1..4] ¥310_D0O_2 BOOL
(£--[1 Watch [for debugaing) Q : c3 B0 <2> Read Input B X310 _DO_3 BOOL -
m Soft Scope F : \T‘ “B <16> Wirite Holding Register: 31 []_DI_U BOOL —
{’:; ;:lfﬁlnvgag‘::ﬁgwa"on B Symbol | Dperation | Offset | Mask | Storage | ﬁlg—g:—; gggt
P §9 Global defines é"s) X310.DI_0 Data exchange ] FFFF Default 3 U_D|_3 BOOL
P4 Vaiiables | A R310_DI1 Data exchange 1 FFFF Default S - . ™
» B Types g X310 _DI_2 Data exchange 2 FFFF Default p=tes =
X310.DI_3 Data exchange 3 FFFF Default | Name | Value
& £ i | — 5l | =

= o —

Win-GRAF User Manual, V2.0, Aug. 2020 by ICP DAS 5-35



MODBUS Master Request X |
Request
| |

Description:

Seveiunks ! \ The Net-ID ( fixed to “1” ) of the
MODBUS Request Slave device (i.e., XV board).

| <1 Read Coil Bits ~
‘M &Y

| <3> Read Holding Registers

!44\. Cmad Trmok EAH:RAvﬂ Read DI data-

Note: When using the XV310 | patablock

to read DI data, the base Base address: |33 '
dd b’ “ ) : lr Start from addr. 33 and
address must be set to “33”. b items: 4
a— read four data.
Activation
(%) Periodic: {50 Q o |
On call
80n charge Read every 50 ms.
Misc.
Timeout; i 100 ms ] .
e An exception occurs if no
ials: i1
Motk (1 respond for 100 ms.

4. Mouse double click the 4th data block (i.e., <16> Write Holding Registers)

Workspace 10 Drivers *
- demo_X¥310 ‘ B Mg MODBUS Master ~| 57 MName | Type
-4 Exception programs 2 . By RTU: COMO:115200,M,8.1 AIT0_ALLT INT ~
[ Programs g ; -8 <4> Read Input Reqgisters (111..4] : RWI0_ALZ INT
3] Main 1B <155 Write Coil Bits (1) [1..4] AIT0_ALS INT
lJ Watch (for debugaing) “:’ “B <2> Read Input Bits (1) [33..36) = W310_AC D INT
4% Soft Scope gl 68 g Registe : vl X310_AO_1 INT
5 'Brf"':,' "a’c“esr . Sonbal [ apeion, T Dffset ||Mask | Storage $A10: etatas DINT:
i ‘,é Gllnbmlgd ?n sl | XV310_A00 Dataexchange 0 FFFF Default I =) 2
T3 gl HOn ColNes &2 wv310.40_1 Data exchange 1 FFFF Default | Name | Value
R} Variables 1 ———/ :
= B ‘ | i< &
= Types = = I T =l e
[€.%] 10 Drivers - \ariables
MODBUS Master Request m
Request
Descripkion: \ l
lavefunit: |1
Sevelinks M‘\ The Net-ID ( fixed to “1” ) of the
MODBUS Request Slave device (i.e., XV board).
[ <6 Write single holding register ~

| 2153 Write Coil Bits =
] <16 Write Holding Reaisters

N Write AO data.

. Data block
Note.. When using the XV310 sesmgiess [0 ,
to write AO data, the base —

tb items: 4
address must be set to “33”. S

Start from addr. 33 and
write two data.

Activation

O Pperiodic: |0 ‘ ms ‘0 ’

80“ call {on error)

*) On change @————— .

Write only when data changed.

Misc,

Timeout; EIUU | ms

HE B [ | An exception occurs if no

respond for 100 ms.
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5.1.13 To Disable/Enable the Modbus RTU/ASCII Master Port

The Modbus RTU/ASCII Master ports which are enabled in the Win-GRAF "Fieldbus Configuration" -
"0 Drivers" setting window, will automatically work after the PAC is powered on. If user wants to disable
one of the Modbus Master ports, use the "MBRTU_M_disable" function (see below).

(* Declare To_disable as BOOL *)
If To_disable then
To_disable := FALSE ;
MBRTU_M_disable (3) ;
End_if;

In the above code, when you set "To_disable" as "TRUE", it will disable the Modbus RTU/ASCII Master
port - COM3. And later, you can enable it again by using the "MBRTU_M_enable" function (see below).

(* Declare To_enable as BOOL
Declare Status_com3 as BOOL *)
If To_enable then
To_enable := FALSE ;
MBRTU_M_enable (3) ;
End_if;
Status_com3 := MBRTU_M_status (3) ;

The "MBRTU_M_status" function listed above is used to get the status of the Modbus RTU/ASCII Master
port, for example, enabled (True) or disabled (False).
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5.2 Enabling the Win-GRAF PAC as a Modbus TCP/UDP Master

(Ethernet 1/0)

Application Diagram:

Win-GRAF PAC
{Modbus TCP/UDP Master)

ET-7000 Series I/O Modules

@pport Max. 32 Slave Devicesy

The Setting Steps:

Lo VP-x208-CE7 108
o ,_
XPAC XP-8xx8-CE6
(Support Max. 100 Slave Devices) (Modbus TCP Slave)
WinPAC WP-9xx8-CE7
WP-8xx8
WP-5xx8-CE7 Other
ViewPAC VP-x2x8-CE7 Modbus TCP Slave
Device

(Check P1-1 to see the PAC model numbers.)

1. Click the tool icon “Open Fieldbus Configuration” to open the “IO Drivers” window.

I Win-GRAF - Test O1

File Edit ¥iew Insert Project Tool: Window Help
SLHB LGS X o s el e d e i 09 %A
Workspace 10 Orivers | HL o
D) Test I T Mame | Type
----- (1 Exception progiams || o {2} Global variables  #
& [ Programs g Il RETAIM variables
........ | Main |1 Main
Bl I:] ‘wWatch [for debuggi... || P2 pOnBadindex
oo R Soft Scope B P8 pOnDivZero v
------- =4 Initial values ¥ =) k4
------- !!& Binding Configuration [ Mame | Y alue
------- :rg Global defines g2
------- ﬁ Yariablesz < | &
....... B Types Build X
4 ¥ | Build Cross references Runtime Call stack Breakpoints Ligital sampling trace Frompt

2. Click “Insert Configuration” icon in the left side of the “lIO Drivers” window, and then click “MODBUS
Master”, then click “OK” to enable a Modbus Master.

Note:

One “Modbus Master” can set up multiple Ports (check the next step), can set as a Modbus

Master RTU/ASCII Port (Refer to Section 5.1) or a Modbus Master TCP/UDP Port or can set up

not to enable the setting.
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10 Drivers

@ Mame | alue I Mame | Type

= {2} Global variables  »

g |al RETAIN variables

X Add Configuration %]
Chooze a configuration

g

- A
B — £ MODEUS
és & MODEUS Master

. MODBUS Slave

3. Click the tool icon “Insert Master/Port” in the left side, open the setting window and select the
“MODBUS on Ethernet”.
Set up the following items, and then click “OK”.
Address: Fill in the IP Address of the Modbus Slave device (e.g., “192.168.1.100").
Port: TCP port Number of the Slave device.
Protocol: If as a Modbus TCP Master, select the “TCP — Open MODBUS”.
If as a Modbus UDP Master, choose the “UDP — Open MODBUS”.
Delay: Fill in the delay time (e.g., 10 ms, can be 0 ~ 10000).

10 Drivers *

----- Mame | Yalue I Mame | Type
= i} Global variables  ~
LEK Al variables
3 dindex
g Ferm v
>
B — Address:  |192.168.1.100 l =
Mode ! | Value
&g Port: 502
4 5 (=} | |*

UDP - MODBUS RTU

Protocol: | e
UDP - Open MODBUS

() Serial MODBUS-RTL

Com. pork; [ I

T After received an answer,
D etwies est .

kil nreqf' S wait for 10 ms, and then
Delay (ms): |10 send the next request.

Try to reconnect after communication error

If not need the TCP/UDP Port
setting, check “Disabled”.

Manage c=liagnostic info for slaves

[I:] Disabled {do not open and manage this port)
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4. Click the icon “Insert Slave/Data Block” in the left side to create a “Data Block”.

10 Drivers *

| Walue

MODEBLS bdaster MName
nf - Open MODEBUS: 192.168.1.100:502 Mode
- Address
Port

=3 ET

Read Al Data

Dizabled

Reconnect after error
Slaves diagnostics
Delay between requests [mz]

Open WMODEUS
132.168.1.100
a0z

10
O

5. Inthe “MODBUS Master Request” setting window, set up the following items, and then click “OK".

MODBUS Master Request

Request
Description: | ’ m
Slave Unit: 1 -: @
MODBUS Request
| <2 Read Input Bits =

| <3 Read Holdini Reiisters =
v

| <4 Read Input Reqisters

| #En Whibm cimale ~ail ik =

@ Data block

Base address:
Mb items:
Activation

(*) Periodic:

oncal
() On change

Misc.

(X

Timeout;

b trials:

d. Activation:
Periodic:

On call:

On change:

e. Timeout:

—

Bl =

10,

In this example

4 |
tooo  |ms 15000 |
i —!
{on errar)
W It‘s not suitable for “Read” commend.
o0 | ms

B

e |

the sending way of Modbus Request.

Send request periodically. In this case, it

sends request every 1 Sec. “on error” mear

that when an error occurs, the next sending

time (in this case, 15 seconds).

It will send the request once when a

program calls it.
It will send the request once when data is changed.

a. Slave/Unit:
Fill in the Net-ID of the Slave device
(Usually is “17).

b. MODBUS Request:
Select “<4> Read Input Registers”.

c. Base address:
Default to start from 1.
Nb items:
The Al numbers to read (here is 4).
Note:
If want to change the “Base address”,
please use mouse to right-click the
“MODBUS Master”, and then select
“MODBUS Master Addresses” to
change the value.

10 Drivers

E EII"'lm MODELS b

%]
o ]

HMODEUS Master addresses

First walid MODBIS addresses

Input bits: 1
Coil bits:
Inpuk registers:
Holding registers:

Set up the max. time to wait for the response. If exceeds it, that means an error.
(For Modbus TCP/UDP, recommended: 1000 ~ 3000 ms; this example is 1000 ms)
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6. Open the “Variables” window, set up the variables want to use.

Workspace 0D

- Test 2 B Mg MODBUS Master Name | Value
T lj"‘ Exception programs ; 2 B ; Open MODBUS: 192.168.1.100:502 Request <4> Read Input Registers
- Programs |3 = Read R = Slave/Unit 1
L ) Main “ | K Address 1
£ Watch [for debuggi... || - Mb Item 4
. [88 Soft Scope ‘E Tips: ) _ Activation Periodic
o B il valies ‘Q.: press “F1” key to see the setting ||| pesiad (ms) 1000
- & Binding Configuration | = method for MODBUS Master. Period oneror 15000
.. 3g Global defines @b Timeout [ms) 1000
- fa} Mariables 1 |- Number of trials 1
B Types \ l g Description

Double click to open.

Please follow the table to set up 4 WORD (16 bit) variables (refer to Section 2.3.1).

Variable Name Data Type Dim. Description
Word_1~ Word_4 WORD --- Used to read the Al data (16 bit)
Status DINT 5 Used to record the read/write status

Refer to Appendix A to check the data types and range of the variables. After setting up, it is as the
picture below.

T Name 4| Type | Dim. | Attrib. | Syb. | Initvalue | User.. | Tag | Description
Status DINT [0..4] O
Word 1 WORD ]
Word_2 WORD O
Word 3 WORD O]
]

Word_4 WORD

(< »| 10Drivers | Variables

7. Inthe “10 Drivers” window, drag the variables (“Word_1 ~ Word_4" and “Status”) from the Variables

III

area to the “Symbol” area of the Data Block. Notice: This example shows “Status” is an Array variable.

When drag it to the “Symbol” area, it will become “Status[0] ~ Status[4]", please press “Delete” key to
delete “Status[1] ~ [4]".

IO Drivers *

B Mg MODEUS Master Name | Walue ¥ Name 2| Type | Dim.
K | g Open MODBUS: 192.168.1.100:502 Request <4> Read Input Regis A | Status DINT [0..4]
‘8 B <4> Read Input Registers (1) [1..4] Slave/Unit 1 = ord_1 WORD

- Address 1 v i Word_2 WORD
P
—— Symbol | Operation | Offset | Mask | Storage ] Hgngeﬁ Word_3 WORD
@Data exchange 0 FFFF Default _-- = | qud—4 WORD
0 word_1 Dataeschange 0 FFFF _ Defawk— ~ (= s
2 “Word_2 < - Data exchange— — € — — FEFF Default e
@'a Word_3 Data exchange 0 FFFF Default Hame & l
B Waord_4 Data exchange 0 FFFF Default
—a & ] ) 3

[ %] 10 Drivers “Variables

Win-GRAF User Manual, V2.0, Aug. 2020 by ICP DAS 5-41



8. Set the “Operation” of the “Status[0]” to “Error report” (If reading data fails, its value is an “Error
Code”; when reading data OK, it will reset to “0”.). Press “F1” key to view the setting descriptions for
the Modbus Master. In the title of “Status and command variables”, you can find the details about this
commend and “Error Code”.

9. Select "Word_1~ Word_4" and click “Iterate property” to set up the “Offset” value (From: O; By: 1).

10 Drivers *

|8 =-Mp MODBUS Master Name | Value
o - Open MODBUS: 192.168.1.100:502 Request <4> Read Input Reqist... |
i ,,E B <4> Read Input Registers [1][1..4] Slave/Unit 1
‘ Address 1
[l Nb Item 4
E Activation Periodic
g Period [ms]) 1000
1 Period on err... 15000
s Timeout [ms] 1000
: Mumber of tri... 1
f B Description
r—
IE’%n;l:ol Operation | Offset | Mask | Storage % | Rangell
Stdtus[0] Error report 0 FFFF Default
° Word_1 Data exchange
Word_2 Data exchange
ool Dtachhang:
Wod4  Dataexchange : |

< i Fram: By 1 e

{4 5| 10 Drivers, < \ariables

Fezultz

[ Ok kl\[ Cancel ]

The setting steps of “Modbus Master Request” for both “Modbus Master RTU/ASCII Port (Section 5.1)”
and “Modbus Master TCP/UDP Port” are the same. Now, we have finished the setting to read Al data.
Please click the item number (link to the Section 5.1.1~5.1.5) in the table below for the setting steps to
read/write other data.

Items | Function Code Modbus Request Description
1 2 Read Input Bits Read DI data
2 5 Write single coil bit Write DO data
3 4 Read Input Registers Read Al data
4 6 Write single holding register | Write one AO data (16-bit)
5 16 Write Holding Registers Write multiple AO data (16/32 bits)
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Note: If you want to disable the Modbus TCP/UDP Master port while the program is running. Refer to
Section 5.2.4 to use the "MBTCP_M_disable" function (and use “MBUDP_M_disable” for UDP).

5.2.1 Connecting ET-7000 Series I/O Module

ICP DAS ET-7000 is a series of /0O module supporting Modbus TCP Slave protocol. The Win-GRAF PAC can
enable the Modbus TCP Master to connect the ET-7000 modules. The maximum recommend the amount
of the connecting ET-7000 modules depends on the PAC model, such as the WP-5238-CE7 and
XP-8xx8-CE6, recommends a maximum of 200; the WP-8x28-CE7, WP-9x28-CE7, and VP-x2x8-CE7 is
recommended that no more than 32.

For more information about the ET-7000 series products, please visit the website:

http://www.icpdas.com/en/product/guide+Remote__ | O Module__and__Unit+Ethernet_ | O_ Modul
es+ET-7000_ET-7200

Use Internet Browser to Set the ET-7000 Modules

Before the first time using the ET-7000, you must set up the ET-7000 by using the Internet Browser. When
the ET-7000 shipping from the factory, the settings are: IP address = 192.168.255.1; Mask = 255.255.0.0.
Please set the IP of your PC in the same network (e.g., set the IP to 192.168.255.100, Mask = 255.255.0.0),
then open the browser (such as IE), and enter the IP of the ET-7000 to connect it.

Notice: The Dip Switch on the rear of the ET-7000 must stay in the “Normal” position.

{ifh$ PET-7010Z RY{EAREE 192.168.255.1 EEERAELE
BN -

L& hiEiREE R TANER SRR BT Z 28
AIEE EFRE 0 TEEHEER) -

Username: Admin
Password: Admin

(Case sensitive) EREEHD): (Q]drmn ﬂ
) [P ==

V] seisHREBR)
| = | [ B ]
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Click “Configuration” > “Module 1/0 Settings” to set up the range of channels as below, and then click
“Submit”.

(‘ ' PET-7000 Web page - Windows Internet Explorer

@ )@ &) hip/192.168.255.1 v [¥2][ x| [
iy BEYREE | @ PET-7000 Web page 0 BB 1 ek v BEE- RREO- ITEO
' —— -
) —
—— -
ICP DAS -
http:/fwww.icpdas.com p— —
—
i MamMents Modbus Settings (Al Basic Setting)
(] Overview
=3 Configuration l Range (40427) EnaP'reW(0059r_§:)
T Network Setings Cho [05] +/-2.5V v off © |oN @
01 Basic Sett cns to4] /-1y | oo N
0] Ch2 [OF] T/C K-type, -270°C ~ 1372°C v ore C lon ©*
- - L L o
B TS - Set as “ON" to
B Wb b Ch3 [OF] T/C K-type, -270°C ~ 1372°C v off © lon @ ble it
: = enable it.
= f 37-3, (& i
“{Z1 Pair Connection o L053:3/-2.5¢ ¥ loFF " [on
{1 More Information chs |[05] +/-2.5v v oFF © lon &
ché [05] +/-2.5¥ v loFF " [on
Ch7 |(05] +/-2.5V v oFF [N
che [05] +/-2.5V v oFF © |on @ |
Chg [05] +/-2.5V v orF C lon &
“" 4 << e
Set “Al Data Format
to “ON” (Engineer)’ Modbus Address [Function Action
jecti { [on ¢ loeegiiaes ol et
means: 00629 50/60 Hz rejection for Al OFF i ON{ |'0=50/1=60 Hz (default=1)
+ 2.5:-25000 ~ +25000 00631 Al Data Format OfVF‘EVON‘_ % | pdHex/1=Engineser (default=0)
~ 00632
+1 :-1000 ~ +1000
(e}
258 :25.8 (°C)

Users can set the ET-7018Z‘s "Al Data Format" to "ON" (Engineering) for more convenient usage.
For example:

Type Code Range Data Format Minimum Maximum
Engineering -10000 +10000
04 -1V +1V
2’s comp HEX 8000h 7FFFh
Engineering -25000 +25000
05 -2.5~+2.5V
2’s comp HEX 8000h 7FFFh
Type M Engineering -20000 +10000
18 Thermocouple 5 h H
200 ~ 100°C s comp HEX 8000 4000

Restore/Open the Demo Project:
The Win-GRAF demo projects in the following sections can be found on the shipping CD, please refer to

Chapter 12. Click the menu bar "File" > "Add Existing Project" > "From Zip" can restore/open/check the
demo projects. (CD-ROM:\Napdos\Win-GRAF\demo-project\)

Demo Project File Name Description
ET-7060 demo_ET7060.zip Read 6 DlIs, write 6 DOs
ET-7018Z demo_ET7018z.zip Read 10 Als
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1. Click the tool icon “Open Fieldbus Configuration” to open the “IO Drivers” window.

Y Mame

i RCEption programs ET7060_DI_00 BOOL
- Programs 5 E - ET7060_DI_01  BOOL
oo 3] Main 8 i -8 <155 Wite Coil Bits (1) [1..6] ET7060_DI_02 BOOL
L -1 Watch [for debugging) _"—_' Mg MODBUS Slave ET7060_DI_03 BOOL
o 8 SoftScope E ! ET7060_DI_ 04  BOOL
=4 Initial values g Request | Slave/Unit | Address | Nbltem | Activation | Peric ET7060_DIO5  BOOL —
~- % Binding Configuration ~ <2> Read Input Bits 1 1 6 Periodic 50 ET7080_status  DINT
-39 Global defines €5 <155 Wiite Coil Bits 1 1 6 OnChange 0 ET7060_RL 00  BOOL
oo fay Wariables E ‘ ET7060_RL 01 BOOL
B Types LE{ LI 4l 2l & | ¥

2. Double click “Open Modbus: IP:502” to open the “MODBUS Master Port” window.

Notice:

All demo projects in this chapter can enable the Win-GRAF PAC as a Modbus TCP Master. Please fill in
the current IP address of your ET-7000, and set "Port" to "502” and "Protocol" to "TCP - Open
Modbus".

) [ ok |

l192.168.1.128 \

Address: ‘
Port: 502 \
(et U TP - Open MODBUS

UDP - MODEBUS RTU
UDP - Open MODEBUS

o

() Serial MODBUS-RTU
Com. pork:

Delay between requests

Enter the current IP address
of your ET-7000.

Delay {ms): {g ]

Try to reconnect after communication error
Manage diagnostic info For slaves

[ pisabled {do not open and manage this port)
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5.2.2 Connecting the ET-7060 (6 DI, 6 Relay)

The ET-7060 is a 6 DI and 6 Relay channels Ethernet I/O module. The Win-GRAF demo project for this
section is "demo_ET7060.zip". Please refer to Section 5.2.1 to set up the module channels using the
Internet Browser, and restore/open the demo project.

Demo Description:

This demo creates two Data Blocks, one is used to read 6 DI data, the other is used to write 6 DO data.

1. Double click the first Data Block (<2> Read Input Bits) to open the setting.

Workspace 10 Drivers *
= demo_ET7060 gl = N]n MODBUS Master A7 Name | Type
‘ -1 Exception programs a2 -5 Open MODBUS: 192.168.1.128:502 ET7060_DI_00 BOOL
[} Programs ‘B { ER=§ <2> Fead Input Bits (1] [1..6] ET7060_DI_01 BOOL
! 3] Main £ =B <155 Write Coil Bits (1) [1..6] Z ET7060_DI_02 BOOL
&1 Watch (for debugging) || =8 : > | ET70B0_DI0O3  BOOL
R ‘ Symbol | Operation | Offset | Mask | Storage S
1/
| focMlAdtSoope B e70s0_01_00 Data exchange 0 [FFFF Defaut » Efdetty, A (Belkls
L 2 Initial values = ET7060 DI D5 BOOL
A 2 . B ET7060_DI_01 Data exchange 1 FFFF Default
%3 Binding Configuration || ET7060_status
v : .. ET70B0_DI_02 Data exchange 2 FFFF Default =
i 2g Global defines é5 ET/060 RL 00 BOOL —
: 3 " ET7060_DI_03 Data exchange 3 FFFF Default SR
i fay Variables ET7060_RL 01 BOOL
i = ET7060_DI_04 Data exchange 4 FFFF
-B Types = ET7060 RL 02 BOOL
- ET7060_DI_05 Data exchange 5 FFFE Default ety
[ ET706 ET7060_RL_03 BOOL
0_status Error report 0 Default  »| TR e Ve 30 S SO
< ] > < |

Notice: The value of the “Offset” starts from “0”, but the Modbus address of the variable is the “Offset”
value plus 1 (Base address). If set the “Operation” to "Error report”, the “Offset” value of the
variable (Data Type: DINT) must set to “0”.

MODBUS Master Request %

Description: | ’ =
s ——
I 1
Slavefunit: |1 _\ The Net-ID of the Slave Unit
H . n n
MODBLS Request (ET-7000) is fixed to "1".
<1 J;i?ad’i:‘o’il’éits A~
1 o
’<3> Read Haoldin Re isters
| e e EM.?.Q,, Read DI data
Data block - §
Base address:
- L »_‘ Start from the address 1
Nb items: 6 r\ to read 6 items.
Activation
[ () periodic: |50 ‘ ms 5000
- ' Read once every 50 ms.
on cal {on error) .
If error occurs, wait 5 s to
() On change
send the next commend.
Misc.
2
Timeout: {500 s
) I =4 If no responds in 500 ms, means error.
b trials: il |
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2. Double click the second Data Block (<15> Write Coil Bits) to open the setting window.

Workspace 10 Drivers *
) demo_ET7060 '8 © Mg MODBUS Master A[/I5F Name | Type
&1 Exception programs 2 g OpenMODBUS: 192.168.1.128:502 . ET7060_DI 02 BOOL 4
[ Programs B -8 <2> Read Input Bits (1) [1..6] L ET7060_DI_03 BOOL
ﬁ ] Main e 15> Wiie Coil Bits (1) [1.5] ET7060 DI 04  BOOL
‘ [j "Wa!ch (for debugging) O Symbol et Offset | Mask | Storage \ ET7060_DI_D5 BOOL
{ =l EcSoops B ET7080_RL_00 Data exchange 0 |FFFF Defaut ET7060_status:  DINT
B '.3 In_maF values. i m ET7060_RL_01 Data exchange 1 FFFF Default ET7060 RL 00 BOOL
U Bixiog Configurnine -, ET70B0_RL_02 Dats exchange 2 |FFFF Defaul EHODD ARG  Hoon
3 Hlohsl defiries S2 ET7080_RL_03 Data exchange 3 FFFF Defaul ET7060 RL.02 BOOL ™
-} Variables | ge ET7080_RL_04 Data exchange 4 |FFFF Defaut Efderfies  (Belkls
e ET7060_RL_05 Data exchangs 5 FFFF Defaul El70e0 RL.O¢  BO0L, o
e ' o {F??ﬂn RI N5 ROOI) v

MODBUS Master Request

Request
Description: | ]
G I
. I :
Slavefunit: !—K The Net-ID of the Slave Unit
MODBUS Request (ET-7000) is fixed to "1".

[r;:?:b-Write single coil bit ~

<6 Write single holding register ==
<15 Write Coil Bits

AL Wvikm Unldima O mmiskae~

N Write DO data.

Data black

Base address: {1

Kb o P Start from.the address 1

R to write 6 items.

Activation

O Periodic: }. ] ms |soon y

80“ call {on error)

On change . . .
¢ Write data, if data is changed.

Misc.

Timeout; i5UU Lm\s

Mb trials: 1 J If no responds in 500 ms, means error.
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5.2.3 Connecting the ET-7018Z (10 Al)

The ET-7018Z is an 10 Al channels Ethernet I/O module. The Win-GRAF demo project for this section is
"demo_ ET7018z.zip". Please refer to Section 5.2.1 to set up the module channels using the Internet
Browser, and restore/open the demo project.

Demo Description:
This demo creates one Data Block to read 10 Al data.

1. Double click the first Data Block (<4> Read Input Registers) to open the setting window.

Workspace 10 Drivers
= demo_ET7018z E =] I"h) MODBUS Master A |“¥ Name | Type
5[4 Exception programs S - OpenMODBUS: 192168.255.1:502 : Minutel DINT A
- Programs ‘8 [EB= § <4> Read Input Registers (1) [1..10] Second1 DINT
: ] Main i . . ET70M8z_ALO0 INT
i o | fset [ g it
1. [ Watch for debugging) || Z-2/mbe L oe st O \onkt ul Oxoe il Er7ride, Aot NT
: ET7018z_4&l_00 Data exchange 0 FFFF Default oo
88 Soft Scope B ET7018z_Al 02 INT
R i ET7018z_alI_01 Data exchange 1 FFFF Default ol
w24 Initial values ET7018z_AlL 03 INT
A 2 . I] ET7018z_al_02 Data exchange 2 FFFF Default =
% Binding Configuration ET7018z_Al 04 INT
7 : .. ET7018z 4103 Data exchange 3 FFFF Default g
i 3g Global defines és ET7018z_Al_05 INT
: : v ET70182_Al_04 Data exchange 4 FFFF Default oo
iofaY Variables ET7018z_Al 06 INT
{ B¢ ET70182_41_05 Data exchange 5 FFFF Default W Ll
B Types ET7018z_Al 07 INT
- ET7018z_aAl_06 Data exchange 6 FFFF Default =
| ET70182_41_07 Data exch 7 FFFF Default EBIzaclls | [N
ET701 BZ—AI_DB D‘a : emhang'a 8 FFFF Defaul S v e
z Al ata exchange efault T ]
ET70182 4 09 Data exchange 3 JFFFF et Siinsninin_ g
[ ET7018z_status Error report 0 Default Sl i
2 ‘ Name | Value }
‘ ‘

Notice: 1. The value of the “Offset” starts from “0”, but the Modbus address of the variable is the
“Offset” value plus 1 (Base address).
2. If set the “Operation” to "Error report”, the “Offset” value of the variable (Data Type: DINT)
must set to “0”.
3. If Alrange is -32768 ~ 32767, please declare the data type as "INT" for the variable.

MODBUS Master Request m
Request
Description: | l

= = : :
Slave Unit: {1 P\ The Net-ID of the Slave Unit
(ET-7000) is fixed to "1".
MODEBUS Request
| <2 Read Input Bits Al
! <3 > Read Holding Reqisters -

| <4 > Read Input Registers
| 2B Wikm mimals ~ail bk Read Dl data
Data block :
L
Base address: 1—L\ Start from the address 1
b items: 110 \ to read 10 items.
Activation
[ @ Pperiodic: |50 |ms 5000 { Read once every 50 ms.
Con call {on errar) If error occurs, wait 5 s to
©on change send the next commend.
Misc.
Timeout: /S00 Q
Mb trials: 9 } If no responds in 500 ms, means error.
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5.2.4 To Disable/Enable the Modbus TCP/UDP Master Port

The Modbus TCP/UDP Master ports which are enabled in the Win-GRAF "Fieldbus Configuration" -

"0 Drivers" setting window, will automatically work after the PAC is powered on. If user wants to disable
one of the Modbus TCP Master ports, use the "MBTCP_M_disable" function (and use the
"MBUDP_M_disable" function for UDP), see below:

(* Declare To_disable as BOOL *)
If To_disable then

To_disable := FALSE ;

MBTCP_M_disable ( '192.168.71.9', 502 ) ;
End_if;

In the above code, when you set "To_disable" as "TRUE", it will disable the Modbus TCP Master port
which connects to the slave device with the IP address "192.168.71.9" (TCP Port_No = 502). And later, you
can enable it again by using the "MBTCP_M_enable" function (using the "MBUDP_M_enable" function
for UDP), see below:

(* Declare To_enable as BOOL
Status_tcp as BOOL *)
If To_enable then
To_enable := FALSE ;
MBTCP_M_enable ( '192.168.71.9', 502 ) ;
End_if;
Status_tcp := MBTCP_M_status ( '192.168.71.9',502 ) ;

The "MBTCP_M_status" function (and "MBUDP_M_status" is for UDP) listed above is used to get the
status of the Modbus TCP Master port, for example, enabled (True) or disabled (False).

For easy maintenance, user can declare a STRING variable (set its length as "20"). For example, declare
one "IP_addr2" variable and set its initial value as "192.168.71.9“. Then you can use it as the

following code.

If To_disable then
To_disable := FALSE ;
MBTCP_M_disable ( IP_addr2 ,502);
End_if;
Status_tcp2 := MBTCP_M_status ( IP_addr2,502);
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5.3 Connecting the Modbus TCP Slave device has two IP addresses

The previous section lists the way to enable the Win-GRAF PAC as a Modbus TCP Master device, and lists
the way to read/write Modbus TCP Slave device. This section will list the way to create the redundant

"Modbus Master Request", when one IP of the Modbus TCP Slave devices is disconnected, the other IP
can still normally to be read/written data.

Application Diagram:
Intelligent Remote Redundant
Ethernet /O Expansion Unit
iDCS-8830 + F-8K Series I/O Modules

Win-GRAF PAC

LAN1

LAN2

Modbus TCP Slave

Modbus TCP Master

Follow The Steps:
1. Click the “Open MODBUS:”, and then click the menu bar “Tools” > “Export”.
2. In the “Export Assistant” window, click “Export some project items (XML)” and “Next”.

File Edit View Insert Projec

_'uaw_-—gc

Tools Window Help

i
{EEEE )

& %e AR 3 5%

Workspace 10 Drivers *

Name
Mode
Address

| Yalue
Open MODBUS

Export...

.- Bfd Binding Configuration
2g Global defines

Export Assistant

€9

@ #0071 DINT 1

“B <4> Read Input Registers (1) [1..5]

192.168.1.100

@ +0: boo_1 Port 502
Conyert Program “-@ +1:boo_2 Reconnect after error
Antomation Seript. -G +2 boo_3 Slaves diagnostics

Disabled [l

i @ Error report: ERROR STATUS1\ Delay between requests [ms) 10

Welcome to the Export Assistant. What do you want to export?

(") Export a complete project (XML)

Each Modbus TCP Master can only set to
connect one Slave IP address, so here we
will show the way to copy and generate
the second Modbus Master to connect
the second Slave IP address.

l

Next%[ Cancel ]
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3. Check the “Configurations” and uncheck all other items, and then click “Next”.

Select items to be exported:

[] Programs and UDFBs
[ Main
‘[ ponBadindex
[ pOnDivZero
[ pShutDown
[ pStartup

Configurations
f MODBUS fMaster

/ \

[ClExpott referenced global variables [ Mext \ ! [ Eancel

4. Browse a suitable path (default in C:\Win-GRAF\Projects) and named for the file (e.g., Master_2.xml),
and then click "Save" button. Finally, click "Finish" to export the settings.

FArPia @

EATER D \DProjecte vl O3 = E
Y () Demol1
) ICPDAS_template
BRI  (DOMICE M
= [yother
{r ) Test
£ Test_01
A Etest_1
A\ (03 Test_2
HEBIF | |Cytest 0528
Export is complete, =
BB
“ G (D)
- 3 a4 Q0 \Master_2 aml /) v' T
WL FeglD IR o) v] )
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5. Using the Notepad software to open the file “.xml” that exported in the step 4, and then copy the
content between the <modbus> and </modbus>.

P Master 2 xml - Sp3A
BERE KEE BA0 R HAM

<types>
</types>
<variables>
<vargroup name="{Global)" kind="GLOBAL">
</vargroup>
<vargroup name="{Retain)" kind="RETAIN">
</vargroup=
</variables>

<modbus>

[

ngeHi="" Rang
1" mask="ffff" RangeHi=""

LN
=fieldbusz
«/fieldbus=

6. Paste the copied content above the </modbus>, and change the address to the second IP address of
the Modbus Slave device (e.g., “192.168.1.101"), then save and close the file.

P Master 2 xml - SR8 A&

ANl REE B0 wRO HEE
g Ctl+N Al
FARER Q... Ctlt0  master" address="192.168.1.100" port="502" sdiags="1" reconnect="1" disabled="0" reqdelay="10" rtu="0">
BEERG 2="" mode="Read Input Bits" address="0" nbitem="3" slave="1" call="Periodic(1000,8000)" timeout="1000" retry="1">
Er=rii pe="Data" offset="0" symbol="boo_1" nbword="1" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
- -lpe="Data" offset="1" symbol="bhoo_2" nbword="1" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
SREFIEMERDD)... pe="Data" offset="2" symbol="boo_3" nbword="1" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
FIENE)... Ctrl+P pe="Status" offset="0" symbol="ERROR_STATUS1" nbword="1" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
wRE 2="" mode="Read Input Registers" address="0" nbitem="5" slave="1" call="Periodic{1000,8000)" timeout="1000" retry="1">
i ~ <modbusitem ope="Data" offset="0" symbol="DINT_1" nbword="32770" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
<modbusitem ope="Data" offset="2" symbol="DINT_2" nbword="32770" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
<modbusitem ope="Data" offset="4" symbol="DINT_3" nbword="32770" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
<modbusitem ope="Data" offset="6" symbol="DINT_4" nbword="32770" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
<modbusitem ope="Data" offset="8" symbol="DINT_5" nbword="32770" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
<modbusitem ope="Status" offset="0" symbol="ERROR_STATUS2" nbword="1" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
</modbusreqg:
/modbusport
<modbusport kind="master" g} port="502" sdiags="1" reconnect="1" disabled="0" reqdelay="10" rtu="0">
<modbusreq name="" mode="Read Input Bits" address="0" nbitem="3" slave="1" call="Periodic({1000,8000)" timeout="1000" retry="1">
<modbusitem ope="Data" offset="0" symbol="boo_1" nbword="1" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
<modbusitem ope="Data" offset="1" symbol="boo_2" nbword="1" mask="ffff" RangeHi="" RangeLo="" SigH SigLo=""/>
<modbusitem ope="Data" offset="2" symbol="boo_3" nbword="1" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
<modbusitem ope="Status" offset="0" symbol="ERROR_STATUS1" nbword="1" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
</modbusreqg:
<modbusreq name="" mode="Read Input Registers" address="0" nbitem="5" slave="1" call="Periodic(1000,8000)" timeout="1000" retry="1">
<modbusitem ope="Data" offset="0" symbol="DINT_1" nbword="32770" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
<modbusitem ope="Data" offset="2" symbol="DINT_2" nbword="32770" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
<modbusitem ope="Data" offset="4" symbol="DINT_3" nbword="32770" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
<modbusitem ope="Data" offset="6" symbol="DINT_4" nbword="32770" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
<modbusitem ope="Data" offset="8" symbol="DINT_5" nbword="32770" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/> =
<modbusitem ope="Status" offset="0" symbol="ERROR_STATUSZ2" nbword="1" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
</modbusreqg
</modbusport>
l </modbus> | ”
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7. Click the Win-GRAF menu bar “Tools” > “Import”.

File Edit ¥iew Insert Project S9N Window Help

S 3 ] 3% optons. EWE AR BRA
Workspace Customize...
5 MTCP_M T T T Name /| Type |
[ [ Exception programs " g ; }8.1.100:502 ERAL Global variables
-3 Programs = ReAA e :M0.3] boo_1 BOOL
- Lo [ Main Edit Variables as Text... \ boo_2 BOOL
-0l ;,\;tch lfor debuggin..| | Geperats Himl Document... boo_3 BOOL
. Soft Scope ; o i DINT _1 DINT
o 53 Initial values S A0S RO ROR_STATUST DINT 2 DINT
5 %4 Binding Configuiation | @  Histooy.. gisters (1) [1..5] DINT_3 DINT =
- 3g Global defines | %3 Globsl Binding Editor ‘ DINT 4 DINT
fa} Variables £ Compare Project DINT_5 DINT
‘BB Types &7| Gensuate HIML Graphic ERROR_STATUST DINT
. _ ERROR_STATUS2 DINT v
OPC Client 2 \ B
| ea IEC61850 Client e =
Lo ¥ FDR—SM’TU% || Name | Value J
Goose Client ;
= —— Slave/Unit | Address | |
Communication Parameters. . w 1 2
Runtime Parameters 4 ‘ 1 5
 Import.. \ .
Export... } >

8. In the “Import Assistant” window, click “Import project items (XML)” and “Next”.
9. Select the file you want to import (e.g., “Master_2.xml”) and click “Open” button.

Import Assistant @

Welcome to the Import Assistant. What do you want to import?

(&) Import project items (XML °

(O Tmport ST file \
O Import project items fromerevious versions

() Import common definitions

EHO: | O Projects (O Import OEM libraries
= () Import Embedded HMI hardware definition
() Demo01

() ICPDAS_template

BEARIF  ((OMTCE M
[yother

@ el [ hext | cancel
(= (34 I ance
= Do 01 Q
Etest 1 =
A\ C Test 2
[0 Test_3

AP |yt 0528

s o
S

«
AR (genn Master_2 saml v B
WRBRD: ML files (*oam]) v) [ ®=#% N\
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10. Click “Finish” to finish the import action.

Import Assistant

Import is complete,

N\

11. In the “lO Drivers” window, there has added a new “Open MODBUS” setting item that includes two
“Modbus Master Request” for using to read the DI and Al. One “Error report” is used to check the IP
connecting status, so please add two “DINT” variables in the Variable area (e.g., “ERROR_STATUS11”,
“ERROR_STATUS21”) and double click the “Error report” to assign variables.

B [ Mg MODBUS Master T Name /| Type |
all C1- % Open MODBUS: 192.168.1.100:502 boo_3 BOOL ~
- B L *B <2> Read Input Bits (1] [1..3] DINT_1 DINT
B 5+B (4 Readinput Registers (1.5 DINT 2 DINT
B E Open MODBUS: 192.168.1.101:502 DINT 3 DINT
H 5B <2> Read Input Bits (1) [1..3] DINT 4 DINT
g @ dbwl DINT 5 DINT
i . @ +1:boo_2 ERROR_STATUS1T  DINT =
ep -@ +2 boo 3
o g ~@ Error report: EHRDR STATUST1 ] ERROR_STATUS11
% E <4> Read Input Reglsters (11[1..5] ERROR_STATUS21 v
& ~-@ +0.1: DINT_1 || ] S

; @ +2.3:DINT_2 | Name | Value |

@ +4.5 DINT_3

@ +6.7:DINT_4

[_g +8 9 DINT 5 MODBUS Yariable

Q

----- Error report: ERROR_STATUS21 Symbol
Mg MODBUS Slave 4 _OK
i ERROR_STATUS21 !
: | Cancel |

Eﬁ ROR_STATUS21 ] v X
(%) status { Control @ DINT_4 ]
i Error report @& DINT_5
@& ERROR_STATUST
@& ERROR_STATUS2
() Data exchange & ERROR_STATUS11 B
a8 m v
Offset: |V :
L Variables: (all N ¥
Mask: ~ [[] Local variables only
sl e [] Hide FB instances
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5.4 Connecting the tGW-700 to Expand Modbus RTU Master Ports

If using the Modbus RTU (RS-232/485/422) device to transmit data in a long-distance application area, the
user will normally choose a lower baud rate for better signal quality. But, using this way will cause low
transmission efficiencies. In order to improve this problem, ICP DAS releases the tGW-700 series products
(tiny Modbus TCP to RTU/ASCII gateway) for converting Ethernet/RS-485 signals so that the user can
reduce the RS-485 cable lengths and solve the issue with inefficient communications.

This section will provide a demo program (demo_tgw725.zip) to describe how the Win-GRAF PAC
communicates with LC-103 modules via the tGW-700 gateway (as the figure below).

Win-GRAF PAC

(Modbus TCP Master) . ——

Ethernet * ' Rs-232/485/422 WM. -
WinPAC . (OneIP) | .= = =
M ol ',' S &
\

~ Portl - ~
,_ Rs.4gs D=1 ID=3
XPAC y Port2 """"’ :

tGW-700 Series
Modbus TCP to RTU/ASCII
Gateway

QewPAC

5.4.1 Using the tGW-700 Series (Modbus TCP to Modbus RTU/ASCII Gateway)
The tGW-700 module is a Modbus TCP to RTU/ASCII gateway that enables a Modbus TCP host (e.g.,
WP-8xx8) to communicate with serial Modbus RTU/ASCII devices through an Ethernet network, and

eliminates the cable length limitation of legacy serial communication devices. Visit the tGW-700 series
webpage for more information on
http://www.icpdas.com/en/product/guide+Serial__Communication+Gateway+tGW__Modbus__Gateway

tGW-700 series User Manual
http://www.icpdas.com/en/download/show.php?num=2375&nation=US&kind1=&model=&kw=tGW-700
(Refer to Chapter 3 & Chapter 4 to know the way of network setting, testing and web function
configuration for the tGW-700 module.)

Before using the tGW-700, the user must configure its network and COM Port setting:

o
Connect the Power Supply and the Host PC ”W
1. Check that the Init/Run switch is in the “Run” position.
o
o "
¥
.::?‘- 5
v M f'
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2. Connect both the tGW-700 and the Host computer to the same sub-network or the same Ethernet
Switch, and then power on the tGW-700.

Ethemet Cable

+12 to +48 Vpcjack Power Supply (Non-PoE) PoE Power Supply

@ Install the “eSearch Utility”, and then Search and Configure the Network Setting for the tGW-700
http://www.icpdas.com/en/product/guide+Software+Utility_Driver+eSearch__ Utility

. eSearch Utility [ ¥1.1.7, Mar_30, 2015 ] M=
File Server Tools
MName Alias IP Address Sub-net Mask Gateway MA
r tGW-725 I} Tin 10.10.10.100 255.255.255.0 0.0.0.0
D302 ETherO T9Z.T66.T1.9 200200, 10 T9Z.ThE.T.1 [I]I}
DL-302 EtherlQ 192.168.17.25 255.255.0.0 192.168.1.1 oo:
Weh LED NfA 192.168.11.10 255.255.0.0 192.168.1.1 oo:
Weh LED NfA 192.168.17.42 255.255.0.0 192.168.1.1 00
A0 testl 192.168.11.8 255.255.0.0 192.168.1.1 00:
7T186E3 I-7540D 192.168.17.40 255.255.0.0 192.168.17.40 00
ET-F067fPET-706F NA 192.168.17.44 255.255.0.0 192.168.0.1 0o:
svzz201 Compact 2.168.82.100 255.255.0.0 192.168.1.1 8.
< | >
. . f .
M Searct&Sewers CunilguratlunJUDP] | Ie Weh‘J Exit
Statns

Search your tGW-700. Set the tGW-700’s IP / Mask Open the tGW-700 Web Server.

/ Gateway. (Contact your (Note: Both the tGW-700’s and
Network Administrator to PC’s IP addresses must on the
get correct configuration) same sub-network. Refer to

Chapter 4 of the tGW-700 user

Please contact your Network Administrator to get the correct IP, Mask and Gateway addresses. After
completing these settings, click the “OK” button and they will take effect within 2 seconds.

Configure Server (TDF) E|

Server Name : tGW-725

DHCP: |u: OFF j Sub-net Mask : |255.255.255.n Alias: |Tiny
IP Address : 10.10.10.100 Gateway : 0.0.0.0 MAC: |
VWarning!!

Contact your Network Administrator to get correct configuration before any changing! Cancel
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® Web Configuration
You can refer to the tGW-700 user manual (chapter 4) to view the configuration way for all features. The

following will describe the COM Port setting.

1. Enter the tGW-700’s IP address on the web browser. (Note: It must on the same sub-network with
your PC’s IP).

2. Enter the password (the factory default password is “admin”).

' e Tiny Gatewsay b4

[ 10.10.10.100 [y 1)

0?‘% Tiny Modbus Gateway (tGW-72x)

N Home | Porti | Port2 | Network | Fifter | Monitor | Password | Logout

| »

The system is logged out.
To enter the web configuration, please type password in the following field.

Login password |l Nl A ) Submit

Note: This web configuration requires JavaScript enabled in your browser (Firefox, IE...).
If the web configuration does not work, please check the JavaScript settings first.

When using IE, please disable its cache as follows.
Menu items: Tools / Internet Options... / General / Temporary Internet Files / Settings... /
Every visit to the page

-

Copyright © 2010 ICP DAS Co., Lid. All rights reserved.

3. After logging in, the main page (Home) will display the current port setting. The user can also click
“Portl” or “Port2” tab to modify the settings.

Tiny Modbus Gateway (tGW-72x)

Home | Port1 | Pori2 | Network | Filter | Monitor | Password | Logout

System Timeout

OFF (Network Watchdog, Seconds) 300
Current port settings:
PortSettings | Potl | Port 2
Baud Rate (bps) 9600 9600
Data Size (bits) 8 8
None None
Stop Bits (bits) 1 1
Modbus Profocol RTU RTU
Slave Timeout (ms) 300
Char Timeout (bytes) 4
Silent Time {ms) 0
Read Cache (ms) 980
Local TCP Port
TCP Timeout (Seconds) 180
L T I N
Server
Remote Server IP -
Remote TCP Port -
RTU Virtual ID -
TCP Slave ID -
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5.4.2 Connecting the tGW-700 Series and the LC-103 module (1 DI, 3 Relay)

In this section, we provide a demo project (demo_tgw725.zip) to describe how the Win-GRAF PAC
communicates with LC-103 modules via the tGW-725 (the Modbus TCP to Modbus RTU/ASCII gateway
with two RS-285 ports). You can run the Win-GRAF Workbench and click "File = Add Existing Project >
From Zip..." to open this project in the Win-GRAF PAC CD (CD-ROM: \Napdos\Win-GRAF\demo-project).

The LC-103 is an easy-to-use lighting control module that supports the Modbus RTU protocol and

provides 1 channel for digital input and 3 channels for relay output. Before using this module, set its ID No.
depends on your application needs, for example, if the required ID is "1", simply adjust the rotary switch
to “1" at the bottom of the module. Visit the LC-103 webpage for more detailed information:
http://www.icpdas.com/en/product/LC-103H

1™y jenf
= of The LC series module user manual:
iéi— . http://www.icpdas.com/en/downl
S oad/show.php?num=596&model=
LC-103H/

Demo Project Description: (Refer to Section 5.2 to know how to create this project.)

1. Click the “Open Fieldbus Configuration” tool button to open the “lO Drivers” window.

S H 4 Qg X o9 = HzIedE i & %A
Work=space 10 Drivers *

2l demo_tgw725 E Mg MODEBUS Master A 5F MName | Type
i YT S DT (B 7Y 0 p=n MODELIS: 10.10.10.100:502 {3} Global variables  ~
[ Programs 1 *B <15 Write Coil Bits [11]1..3] Slave1_DOO BOOL

“HE] Main 8 @ +0: Slavel_DOO Slavel DO1 BOOL
[ watch [for debugging) || — = +1: Slavel DO Slavel DO BOOL
&R Soft Scope ﬁ & +2 Slavel_D0O2 Slavel_DOO BOOL
= Initial walues @ Success counter tmp_counter Slave? DO BOOL
%4 Binding Canfiguration E O Fail counter: Fail_counter Slavel DO2 BOOL
g Global defines 25 “B <15 Write Cail Bits [3)1[1..3] trmp_counter DINT
il Wariables @+ Slaved DOD fail_counter DINT
B Types B+ 2 +1: Slaved_DO1 trmp_counterl  DINT
[ (&l Projects) = +2 Slaved DO2 fail_counter] DINT
O Success counter tmp_counter3 Slaved_DoOO BOOL
& _Fail counter: fail_counterd Slave3_DON BOOL
u; Open MODBUS: 10.10.10.100:503 ] Slaved_DoO2 BOOL
“B <15 ‘Write Cail Bits [21[1..3] trmp_counter3  DINT
: bl Clawad BOO - fail_counter3 DIMNT s
Request | Slave/Unit | Addiess | Mbltem | Activation | Pe ¢ 3
<183 Wwrite Cail Bits 1 1 3 OnChange —
M ame | Yalue
< »
4 » kdain “Wariables 10 Drivers

On the screen, the "Open MODBUS: 10.10.10.100:502 / Open MODBUS: 10.10.10.100:503" means that
the tGW-725’s IP address is "10.10.10.100" and using two COM ports (RS-485) No. - "502“ and "503". And,
there are two LC-103 modules (Slave ID = "1" and "3") connected to its COM1 and one LC-103 connected
to the COM2 (Slave ID = 2). The following will describe the configuration way of each Modbus Master
Request one-by-one.
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2. Mouse double-click the first data block under the COM1 (Port = 502) to view this Modbus Master
request. In this example, the Win-GRAF PAC (Modbus TCP Master) send three DO commands to the
LC-103 (Slave ID = 1) via the tGW-725's COML1 (Port = 502). As the figure below, the "Operation" is
set to "Success counter" (or "Fail counter") that means this variable value will add 1 if the command

was successfully sent (or failed). Moreover, the “Offset” value of these variables must set as “0”.

10 Drivers * | HEL A
E Mg MODBUS Master A F Mame | Type
o 2 Open MODBUS: 10.10.10.100:502 ﬁ Global variables -~
s Slave1_DOO BOOL
g &+ Slawe1_DO0 Slave1_DOT BOOL
3 @ +1: Slavel_DO1 Slavel_DOZ2  BOOL
= & +2: Slavel_DO2 Slavel? _DOO BOOL
g O Success counter: trp_counter Slavel DO BOOL
& Fail counter: fail_courter Slavel DO2 BOOL
25 B <15 “Write Coil Bits [3][1..3] tmp_counter DIMT
& +0: Slave3_DO0 fail_counter DIMT
B = +1: Slave3_DON tmp_counter?  DIMT
= +2 Slave3_DOZ fail_counterl DIMT
I L Surcess counber tmn counberd b S|a\r53_DOI:| BOOL
Syrbal | Dperation | Drfset) Mask | Storage | Rang Slave3_DO1 BOCL
Slawel1_D0O0 Data exchange 1] FFFF  Default ~ Slaved DOZ BOOL
Slawel_DO1 Data exchange 1 FFFF  Default tmp_counterd DINT
Slawvel_DOZ2 Data exchange 2 ) FFFF Defalt fail_counter3 DINT
brnp_counter Success counter 1] FFFF  Defalt F3 3
fail_counter Fail counter 1] FFFF  Default N
~ . e | Walue
4k bezin “Wariables 10 Drivers

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value
plus 1 (Base address).

MODEBDS Master Eequest _

Request _
Description: || | =
——
SlaveUnit: The Net-ID (e.g., “1” ) of the

Slave device (i.e., LC-103).

MODEUS Fequest

<5 Write single coil bik ”
<6 Write single holding reqister

A E e Weiks Ueldim s Fmmicbmie—

Write DO data.

Drata block,
Base address:
Hb erms: Start from addr. 1 and
Mb items: .
write three data.
Ackivation
) Periodic: | ms ||:| |
O on call (on_errar)
on ch  —— .
IR Write only when data changed.
Misc,
Tirneout: -3':":":' ms
An exception occurs if no
Mb brials: respond for 3000 ms.
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3. Mouse double-click the 2nd data block under the COM1 (Port = 502) to view this Modbus Master
request. In this example, the Win-GRAF PAC (Modbus TCP Master) send three DO commands to the
LC-103 (Slave ID = 3) via the tGW-725's COML1 (Port = 502). As the figure below, the "Operation" is
set to "Success counter" (or "Fail counter") that means this variable value will add 1 if the command

was successfully sent (or failed). Moreover, the “Offset” value of these variables must set as “0”.

E *B <15 wiite Coil Bitz (1) [1..3] A 5F Mame | Tupe
= @ +0 Slavel_DODO ot Global variables ~
1 3 +1: Slavel_DOT Slave1_DOO BOOL
8 @ +2 Slavel_DOZ Slavel DO BOOL
= O Success counter: tmp_counter Slawvel DO2 BOOL
B = Fail counter: Fail_counter Slave2_DOO BOOL
F 8=1 15 Wwiite Coil Bits (3] [1..3] Slave?_D07 BOOL
2+ Slaved_DO0O Slavel DO2 BOOL
&5 B2 +1: Slaved D01 tmp_counter  DINT
= +2 Slave3_DO2 fail_counter DIMT
B+ O Success counter: tmp_counter3 tmp_counterl  DINT
1 Fail counter: fail_counter3 fail_counterl DIMT
. 2. (nen MODALS- 1010 1010050 s Slaves DO BOOL
Symbal | Operation TEIff&eq M azk | Storage | Rang Slave3 DO BOOL
Slave3_D0O0 Data exchange 0 FFFF  Default » Slave3d_DO2 BOoOL
Slave3_DOT Data exchange 1 FFFF  Default trmp_counterd  DINT
Slave3_DO2 Data exchange 2 FFFF  Default fail_counter3 DIMT
trip_counterd Success counter 1] FFFF  Default ¢ 5
fail_counter3 Fail counter 1] FFFF  Default N
. $ arne | Walue
4 ¥ | bain,  Marables | 10 Drivers

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value
plus 1 (Base address).

HMODEUE Master Request

Requesk _
Description: | | =
Slave/Unit: 3 *\ The Net-ID (e.g., “3” ) of the

Slave device (i.e., LC-103).

MODELS Request

<5 Write single coil bit
<hz= Wite single holding register

E

1 Mhiks Qoldine Rocickees N \Write DO data.

[raka block.

Base address: -

o Ty Start from addr. 1 and

B write three data.
Ackivation

() Perindic: | ms ||:| |

O on cal {on errar)

(®) On change @ Write only when data changed.

Misc.
Timeout: 3000 ms ] ]
An exception occurs if no
Mb trials: |:| respond for 3000 ms.
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4. Mouse double-click the data block under the COM2 (Port = 503) to view this Modbus Master request.
In this example, the Win-GRAF PAC (Modbus TCP Master) send three DO commands to the LC-103
(Slave ID = 2) via the tGW-725‘s COM2 (Port = 503). As the figure below, the "Operation" is set to
"Success counter" (or "Fail counter") that means this variable value will add 1 if the command

was successfully sent (or failed). Moreover, the “Offset” value of these variables must set as “0”.

10 Drivers *
E 2 +1: Slavel_DON
a2 o +2Z Slavel_DO2Z
L, O Success counter tmp_counter
E O Fail counter: fail_counter
= “B <15 Wiite Coil Bitz [3][1..3]
E o +0: Slavez DOO
& +1: Slaved DO
g O +2 Slaved D02
25 O Success caounter bmp_counterd
& Fail counter: fail_counterd
a & Open MODBUS: 10.10.10.100:503
] te 3[2]1..9]

bl

Suymbol | Operation

| Offset | Mask | Storage | Rang
Slave2 _DO0D [Data exchange 0 FFFF  Default
Slave2_D0O1 [ata exchange 1 FFFF  Drefault
Slave2 DOZ2 [ata exchange 2 JFFFF  Default
tmp_counter Success counker 1] FFFF  Default
fail_counterl Fail counter 1] FFFF  Default
£

4 bAzin “Wariables 10 Drivers

M ame

| LI
“F Mame | Type
it Global variables ~
Slave1_DOO BOOL
Slavel DO BOOL
Slave1_DO2 BOOL
SlaveZ_DOO BOOL
SlaveZ DO BOOL
SlaveZ_DO2 BOOL
tmp_counter DIMT
fail_counter DIMT
tmp_counter?  DINT
fail_counter DINT
Slave3_DOO BOOL
Slave3_ DO BOOL
Slaved_DCr2 BOOL
tmp_counterd  DINT
fail_counter3 DINT s
£ >
| Walue

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value

plus 1 (Base address).

MODEDSE Master Eequest

Requesk

Description: |

Slave/Unit:

MODELS Request

The Net-ID (e.g., “2” ) of the
Slave device (i.e., LC-103).

<5 Write single coil bit
«<h= Write single halding reqister

)

Write DO data.

[raka block,

Base address:

L
b items:

Start from addr. 1 and
write three data.

Ackivation
() Perindic: | | ms |EI
() on call (o0 Error

{(#) on change @

Write only when data changed.

Misc,

Tirmeouk: 3000 ms

o ¢
b Erials: I:I

An exception occurs if no
respond for 3000 ms.
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5.4.3 Test the Demo Project (demo_tgw725.zip)

Before testing this demo project, download it to your Win-GRAF PAC. (If you're not familiar with it, refer
to Section 2.3.4 and Section 2.3.5.)

The Hardware Wiring:

WP-8xx8 RS-408 tGW-700 Series
(192.168.80.21:502)  EthernetSwitch Modbus TCP to RTU/ASCII Gateway
Ethernet ™22 Y. Portl
(10.10.10.100) - - (502)
s RS5-485

o ) Port2
!‘_ ) (503)

(9600,8,n,1)

After connecting with the Win-GRAF PAC, double-click on any DO variable and set it as "TRUE" in the “IO
Drivers” window. If the write operation is successful, then the "tmp_counter" value will add "1".

S v 4 Qe X s 9 o g % AR Gy (AR EE LR N
Workspace Qooo [ Drivers]
g [ demo_tgw725 [StaAp.___ E = Mg MODBUS Master -~
----- (3 Exceplion programs o - Dpen MODBUS: 10.10.10.100:502
- Programs E-*B <15 Wwite Coil Bits (17 [1..3]
j (- “HE] Main B o @+ Slavel_DO0O=TRUE
EI 3 ‘whatch [for debugging) || |-= +1: Slavel_D0O1 =TRUE
o &% Soft Scope |-= +2 Slavel_D0O2 =TRUE
= Initial values g ¢\ Success counter: tmp_counter = 4
%3 Binding Configuration ------ 3 Fail counter: fail_counter =0
g Global defines 25 =B <15 ‘Wiite Coil Bits (3] [1..3] e ———— "
o} Warisbles {-= +0: Slaved_DOO = TRUE | Slaves DOO &
e [y T‘I'JFIES EJ' ...... = | TEIE ‘ | 1)
------- [ [All Projects) - | N
[—I:I Success counter tmp_counterd = 2 ] [ FALSE ] (0]
------ 2 Fail counter: fail_counterd =0
Elﬁx Open MODBUS, 101010100503 ] [ ButLack ]
B <15 Write Coil Bitz [2][1..3]
""" =] [ ButUnlock ] W
...... D
...... D “w
Sumbol | Operation | Offset | Mask | Storage | Range (Low) | Riange [High) | Signal [Low]
Slawes_DO0=TRUE  Data exchange i] FFFF  Diefault
< | >

4 » heain “Wariables 10 Drivers

Note: When the Win-GRAF PAC boots up, it will send the Modbus request to the Modbus Slave device.
So, you can see the "tmp_counter" value starts at "1" means that write data is successfully.
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Chapter 6 Retain Variable and Data Storage

Retain variables are used to protect important data. The system can retain the latest variable data
during an unexpected power failure. Win-GRAF Driver v1.09 has supported to add RETAIN variables in
the Variables window. In addition, the chapter describes a demo program to save RETAIN variables data
to afile and then load the settings manually.

Note:
® To avoid internal data conflict, do not use both RETAIN variables and functions in the same project.

Otherwise, functions that describe in Section 6.1 and 6.2 will invalid.
® Using great amount of RETAIN variables will cause the lower performance of the system due to
access data to a disk frequently.

Add RETAIN variables

In the Variables window, right-click on RETAIN variables and click Add Variable to add a RETAIN variable.
Next, set the name and type for the variable and press Enter.

W& Vin-GRAF - Retain_variable
File Edit View Insert Project Too Nindow Help

@3l o (D)oo A faheAE 5, BRA
Workspace Variables
2l Retain_variable “F Mame | Type | Diirn, | Attrib. | Sub. | It v alue
[ Exception programs 24 Global varighles
[ Programs ™ 1 RETAIN variables > |
= Main Retam_Bour Boor N7 9 Unde
[ “wWatch [for debugging) Retain_DINT DINT
¥ Soft Scope Retain_REAL REAL
== Iitial values Retain_INT INT
%4 Einding Configuration Retain LEEAL LREAL
: 0-Global defines [ Newvar BooL ||
=~ 78 pOnBadindex -
3 (& Projects) P8 pOnDivZero -
_1 pShutDown Cancel Sorting
_] pStartup
+M Enable Changes Space
i AddVariable Ins
Add Multi Val'i&es...
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Test RETAIN variables

Download the project to Win-GRAF PAC and change variable data online. If the setting is correct, the last

data before rebooting the PAC will be restored.

FAN= B AR x

Workspace
[* Retain_variable [RUN]

1 Exception programs

1 Pragrams
] Main

[ ‘watch [for debugging]
&R Soft Scope

= Initial walues

!!& Binding Configuration

jg Global defines

'ﬁj‘ W ariahbles

=y 2 S NS A B gl (9 e A RUN imhewndd

Ogo0 [Variables]

I Mame | Value | Type | Dim. | Attrib. | Syb.
fa} Global variables
|=l RETAIN variables

Retain_BOOL TRUE BOOL O

Retain_DINT 2147483647 DINT O

Retain_REAL 6563.249023 REAL |

Retain_IMT 32767 INT |

Retain LREAL 3R597 246876 LREAL O

Retain_STRING ‘abcd12345 STRING(255) ]
_1 Main K

Read/Write the RETAIN variable from/to a file

Copy the "Retain_Test.zip" project from the shipping CD (\Napdos\Win-GRAF\demo-project) to a PC,
and restore the project to Win-GRAF. The chapter describes F_SAVERETAIN and F_LOADRETAIN
functions to read/write RETAIN variables.

F_SAVERETAIN (PATH)

Save RETAIN variable data to a file at the specified path manually.

F_LOADERETAIN (PATH)

Read RETAIN variable data from a file at the specified path.

Note:

® F_SAVERETAIN and F_LOADRETAIN will not automatically create a folder if it does not exist. It is
recommended to manually create the folder in the \System_Disk or the new folder may be

automatically removed after rebooting.

® The project that added RETAIN variables and completed, users can modify the variable name but do

not change the data type or numbers. Otherwise, Win-GRAF unable to load the file due to data

mismatch with original data.

Variables:

In the example program, Load_Path and Save_Path variables are used to specify the file name and the

location to load or save the file. First, add a folder named "Retain folder" in the System_Disk folder of

the PAC.

Workspace
2l Retain_Test
|1 Esception programs
1 Programsz
& Main
“ET| Retain_“ariable
[ "W atch [for debuaging)
¥ Soft Scope
= Initial values
!!& Binding Configuration

Variables
I Mame | Type | Do | & | Syb. | Init value
o} Global variables
Save ol W]
Load_Path STRING{255) [l "System_Disk\Retain folder\Test Retain’
Save Path STRING{255) [] "System Disk\Retain folder\Test Retain’
Load BO0L ]
IsSaved BOOL ]
IsLoaded BOOL ]
[=l RETAIN variables
Retain_BOOL BOOL O
Retain_DINT  DINT O

_1 Main
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ST Program:
Double click "Retain_Variable" to display the window.

Workspace
=3 Retain_Test « IF Save = true Then g
..... [ Exception programs ' IsSaved i F_SAVEREIRIN( Save FPath }:
£--[d Programs F Save T falsss
[ [ Y ey (Er_TES
= IF Load = trus Then
= [j W Ao = "‘; IsLoaded := F_LORDRETAIN( Load Path );
i T Soft Scope — Load := false;
------- =4 Initial values tMl|  END IF:
------- %4 Binding Configuration B
------- g Global defines %
------- ‘[ﬁ Wariables is
....... B Types -
------- [ [Nl Projects)
ST Program

IF Save =true Then
IsSaved := F_SAVERETAIN( Save_Path );
Save := false;

END_IF;

IF Load = true Then
IsLoaded := F_LOADRETAIN( Load_Path );
Load := false;

END_IF;

Description

When Load is set to true,

1) Win-GRAF will read data from the specified path and file, e.g., "\System_Disk\Retain folder\Test
Retain', and updates RETAIN variables data.

2) If the load process is successful, the "IsLoaded" will be set to true.
(Otherwise, it will be set to false)

3) Next, set "Load" to false to avoid Win-GRAF frequently read the disk causes the lower
performance of the PAC.

When Save is set to true,

1) Win-GRAF will save RETAIN variable data to the specified path and file.

2) If the save process is successful, the "IsSaved” will be set to true.
(Otherwise, it will be set to false)

3) Next, set "Save " to false to avoid Win-GRAF frequently read the disk causes the lower
performance of the PAC.
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6.1 Using the RETAIN_xxx Function

Win-GRAF Driver v1.09 has supported to add RETAIN variables in the Variables window, refer to the
previous section for more information.

This chapter lists the way to use the "RETAIN_ARY", "RETAIN_FLAG_CLR”, "RETAIN_FLAG_GET",
"RETAIN_FLAG_SET"and "RETAIN_VAR" Functions. The Win-GRAF PACs are built-in the Retain memory
for users to store the retain variable data that will not lose due to the PAC shutdown and can retain the
last value at the next time reboot.

Refer to Section 1.2.3 Library Manager for more information about functions.

We Library Manager - ICP DAS - XP-WP-VP - O >
File ‘Wizard Help

Function and FBs  [/0s  Profiles AS Typesz

FRetain_Ary (* Eetain an acray variable *) -
ERetain_Flag Clr (* Clear the retain flag *)
FRetain_Flag Get (* Get the state of the retadn flag *)
ERetain_Flag Set (* Zet the retain flag . *)

WVRE_INFUT
Hams : RNY;
43-\4-\4]_ ] LLINL,
END VAR
WVRE_OUTFUT
¢ = BOOL;
END VAR

In the shipping CD (\Napdos\Win-GRAF\demo-project), you can find the demo project for this chapter
(demo_retain.zip), please refer to Chapter 12 to restore this project (Execute File> Add Existing Project >
From Zip) and set the current IP address of your PAC.

Note: Function "Retain_Var()" or Retain_Ary() can only be used in the first PAC Cycle or in the Cycle
that performs the On-line Change. If use them in other Cycle, it will return "FALSE". If the Retain
Variable has not assigned any initial value and the PAC calls the Function, the return value is not
meaningful; users need to assign appropriate initial values to all Retain Variables at least once.

ST Program:
This demo uses Function Retain_Var() and Retain_Ary().

(* "on_line_change_cycle" is declared as DINT
(nonezero means it is in the cycle just after doing on line change).
"retain_done" is declared as BOOL and inited as FALSE.
"tmp_bool" is declared as BOOL.

*)
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on_line_change_cycle := GetSysinfo (_SYSINFO_CHANGE_CYCLE) ;

if (retain_done = FALSE) or (on_line_change_cycle <> 0) then
retain_done := TRUE ; (* just do it one time *)
tmp_bool := Retain_Var ( DINT_1, 1) ; (* retain a DINT variable *)
tmp_bool := Retain_Var ( DINT_2, 2);
tmp_bool := Retain_Var ( REAL_1, 3); (* retain a REAL variable *)
tmp_bool := Retain_Var (BOOL 1, 4); (* retain a BOOL variable *)
tmp_bool := Retain_Var (BOOL_2, 5);

(* retain 10 elements of an INT array variable at retain addr starting at 6. *)

tmp_bool := Retain_Ary ( INT_ARY, 6, 10);

(* retain 20 elements of a REAL array variable at retain addr starting at 16. *)

tmp_bool := Retain_Ary ( REAL_ARY, 16, 20);

tmp_bool := Retain_Var ( DINT_3, 36) ;

(* 64-bit variable can use only addr from 10,001 to 12,000 *)

tmp_bool := Retain_Var ( LINT_1 , 10001) ; (* retain a LINT variable (64-bit) *)

tmp_bool := Retain_Var ( LREAL_1, 10002) ; (* retain a LREAL variable (64-bit) *)
end_if ;

You can check or set variables in the "Variables" window. If you are not familiar with the way of the
variable declaration, please refer to Section 2.2.2 and Section 2.3.1.

Variables WX
¥ Mame /| Type | Dim. | Attib. | Syb. | Initvalue | User.. | Tag | De
=1 fa Global variables »
BOOL_1 BOOL CJ
BOOL 2 BOOL ]
DINT _1 DINT ]
DINT 2 DINT ]
DINT_3 DINT ]
INT_ARY INT [0..9] OJ
LINT 1 LINT ]
LREAL 1 LREAL O £
on_line_change_cycle  DINT ]
REAL 1 REAL ]
REAL_ARY REAL ]
retain_done BOOL ]
tmp_bool BOOL ] |
< J >
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6.1.1 RETAIN_VAR (Retain a Variable)

RETAIN_VAR
[(Name QO Tips:
[1Addr Press “F1” key to see more details.

Name:

A variable name (DO NOT use Array variable or String).

Variable type can be BOOL, SINT, USINT, BYTE, INT, UINT, WORD, DINT, UDINT, DWORD, REAL, TIME,
LINT or LREAL.

Addr:
Data Type: DINT. The address number for retaining the variable, can be 1 to 12,000.

Q:
Data Type: BOOL. TRUE: Ok; FALSE: Error.

Note:

1.

One Addr can accept only one variable (or one element of the array).
DO NOT assign the same Addr to two variables (or more), or the Retain Value will be wrong.

64-bit data type (LINT or LREAL) can use only the Addr No. from 10,001 to 12,000.

Other data type (BOOL, SINT, USINT, BYTE, INT, UINT, WORD, DINT, UDINT, DWORD, REAL or TIME)
can use the Addr No. from 1 to 12,000.
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6.1.2 RETAIN_ARY (Retain an Array Variable)

RETAIN_ARY
[Name][] Q[
[{Addr Press “F1” key to see more details.
[{Num
Name[]:

An ARRAY variable name (DO NOT use String).
Variable type can be BOOL, SINT, USINT, BYTE, INT, UINT, WORD, DINT, UDINT, DWORD, REAL, TIME,
LINT or LREAL.

Addr:
Data Type: DINT. The starting address number for retaining the array variable; can be 1 to 12,000.

Num:

Data Type: DINT. The amount of elements in the Array variable to be retained.

For example:

If there are 100 elements in an Array variable, set "Num" to "1 to 100" is correct, but if set it more
than 100 that is not correct.

If there are 5 elements in an Array variable, set "Num" to "1 to 5" is correct, but if set it more than 5
that is not correct.

Q:
Data Type: BOOL. TRUE: Ok; FALSE: Error.

Note:
1. One Addr can accept only one variable (or one element of array).
DO NOT assign the same Addr to two variables (or more), or the Retain Value will be wrong.

2. 64-bit data type (LINT or LREAL) can use only the Addr No. from 10,001 to 12,000.

3. Other data type (BOOL, SINT, USINT, BYTE, INT, UINT, WORD, DINT, UDINT, DWORD, REAL or TIME)
can use the Addr No. from 1 to 12,000.
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6.1.3 RETAIN_FLAG_SET/GET/CLR (Set/Get/Clear the Retain Flag)

How to Use:

The "Retain Flag" is a flag (TRUE/FALSE) stored by users in the retain memory. Users can set this retain
flag to indicate "All retain data has been assigned a proper value before". When a PAC starts without
setting a proper value to retain variable before, the data of the retain variable read from the retain
memory is not correct (it is normally a strange value). So users have to assign proper value to all retain
variable at least once to let the application work well. Then after user can call the "Retain_Flag_Set()" to
set the retain flag. It means "All retain data has been assigned a proper value".

To get the state of the Retain Flag, please call "Retain_Flag_Get()".

To clear the state of the Retain Flag, please call "Retain_Flag_Clr()".

ST Program:

(* "on_line_change_cycle" is declared as DINT
(nonezero means it is in the cycle just after doing on line change) .
"retain_done" is declared as BOOL and inited as FALSE .
"tmp_bool", "retain_flag" and "to_set_flag" are declared as BOOL.

*)
on_line_change cycle := GetSysinfo (_SYSINFO_CHANGE_CYCLE) ;

if (retain_done = FALSE) or (on_line_change_cycle <> 0) then
retain_done := TRUE ; (* just do it one time *)
tmp_bool := Retain_Var( DINT_1, 1) ; (* retain a DINT variable *)
tmp_bool := Retain_Var( DINT_2, 2);
tmp_bool := Retain_Var( REAL_1, 3); (* retain a REAL variable *)
tmp_bool := Retain_Var( BOOL 1, 4); (* retain a BOOL variable *)

(* ... After doing all the Retain Functions ... *)

retain_flag := Retain_Flag_Get();

if (retain_flag = FALSE) then
(*If Retain variable does not set up any proper value, you can do some proper operation here. *)
(*...%)

end_if;
end_if;

(* When all Retain variables are assigned proper values,
remember to set the "to_set_flag" to "TRUE" for calling "Retain_Flag_Set() once,
so that, when next time you use the "Retain_Flag_Get()", it can return "TRUE".
*)
if (to_set_flag = TRUE) then
to_set flag := FALSE ;
tmp_bool := Retain_Flag_Set() ;
end_if ;
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LD Program:
(Press “F1” key to view the description of setting.)

RETAIN_FLAG_SET: Set the retain flag.

to_=et_flag
| R [ERETAN FLAG SETG] |
to_zet_flag
| R2 R I ST Program:
if to_set flag then
to_set_flag := FALSE ;
Q: Data Type: BOOL. Always return TRUE. TMP_BOOL := Retain_Flag_Set() :
end_if ;

RETAIN_FLAG_GET: Get the state of the retain flag.

s

retain_flag
r1 |[E RETAIN FLae GET o] |

ST Program:
Q. Data Type BOOL retain_flag = Retain_FIag_Get() ;
“TRUE": flag is set;

“FALSE”: flag is not set.

RETAIN_FLAG_CLR: Clear the retain flag.

to_clr_flag
| R [ERETAIN FLAG CLR ] |
to_clr_flag
R2 R |
B ST Program:
if to_clr_flag then
to_clr_flag := FALSE ;
Q: Data Type: BOOL. Always return TRUE. TMP_BOOL := Retain_Flag_Clr() ;
end_if;
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6.2 Save RETAIN Variables and Data to a File

Refer to Chapter 6 to save RETAIN variables data with the new way or using the following demo project
(demo_wp5_retain.zip) to save RETAIN variables and data to the file in the \System_disk\Win-GRAF\.

In the shipping CD (\Napdos\Win-GRAF\demo-project), you can find the demo project for this section
(demo_wp5_retain.zip), please refer to Chapter 12 to restore this project (Execute File> Add Existing
Project > From Zip) and set the current IP address of your PAC.

This project includes an ST main program (Main) and three ST sub-programs (load_retain, save_retain
and Go_retain).

[ Win-GRAF. - demo_wp5_retsin (=53]
File Edit ¥iew Insrt Project Tools Window Help
1 =] % 3 . 0
AN B = T o s e AR 5 A
Workspace |
- 1J) demo_wp5_retain o The "dewo wpS retain” project has the following AT Name | Type | Dim. ]A_!Er@
= = 3 default value . Please set your own proper initial value. _]A
(3 Progams & T o P o e (o} Global variables
&5 23 Ma p.¢ : 1} o 2 ) t ¢ =
”ﬂ] s THEN U s { a>. amoun’ or re a?x-x vari e ]v MAX_\/AQ_REAL DINT R
%a bad retain (‘Get retei . MAX VAR OTHER : 100 (Max. amount for retain integer+Bool+Ti: MAX VAR OTHER DINT R
D" 3 7 = Dim of REAL VAR now and REAL VAR old : 100 ( [0..99] ) = o
a % e B At halh 2 e L
Cs saveLfotain(:5avere:., | o Dim of OTHER VAR now and OTHER VAR old : 100 { [0..99] ) REAL_VAR now  REAL [0.99]
8 Go_retain (implemert . REAL_VAR_old REAL [0..93]
1 Watch (for debugging) { b2 The bigger value of the NAX VAR REAL and MAX VAR OTHER, OTHER_VAR_now DINT  [0..89] v
&8 soft Scope che bigger PAC cycle time will he . < >
= Initid values So it is bhetter to decalre just fine value for the = =
>, MAX VAR REAL and MAX VAR OTHER . 1 3 A
%d NewSpyl — = 2 £ @ B (Proiec)
%4 Bindng Configuration 2 — Ad q
S Global defines This project decalres the following wvarisbles for demo C = | vance
54 - purpose only. Please re-declare your own variables. 7 [ Anthmetic
r:ﬁ Variables =
= 5[ Arays
Types My REAL 00 ~ My REAL 07 (type : REAL) @[3 AS-nteface
My DINT 00 ~ My DINT 0S (type : DINT) 3 BAChe!
My BOOL_00 ~ My BOOL 02 (type : BOOGL) ==
s e I SN Ao v @ [d Booleans v
L < ) ) > 4 »| Blocks Sovlist | Define | ENUM
|4 3| Main NewSpyl | Mariables | Go retain
Build X
[« 5| Build Cross references | Runtime | Call stack [ Breakpoints | Digital sampling trace ] Frompt | HMI
Ready OffLine 192.168.71.19:502 A 0,0 132x18 0,0 100% @4

Limitation :

This project is not good at handling Retain variables which value changes frequently. For example, value
changed about every second or every minute. That is because these retain values of this project are
saved within files in the \System_Disk. The file operations in it consume more CPU time, which will slow
down the PAC performance if retain value changed frequently.

The "demo_wp5_retain" project has the following default values. Please set your own proper initial
values.

MAX_VAR_REAL:
MAX_VAR_OTHER: 100 (Max. amount for retaining integer+Bool+Timer variables)

Dim of REAL_VAR_now and REAL_VAR_old: 100 ([0..99], the same as the value "MAX_VAR_REAL")
Dim of OTHER_VAR_now and OTHER_VAR_old: 100 ([0..99], the same as the value "MAX_VAR_OTHER")

100 (Max. amount for retaining REAL variables)

Note: The bigger the value of the MAX_VAR_REAL and MAX_VAR_OTHER, the larger the PAC cycle time
will be. So it is better to declare just fine value for the MAX_VAR_REAL and MAX_VAR_OTHER.
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This project declares the following variables for demo purpose only. Please re-declare your own
variables.

My_REAL_00 ~ My _REAL_07 (Data Type: REAL)
My _DINT_00 ~ My _DINT_05 (Data Type: DINT)
My_BOOL_00 ~ My_BOOL_02 (Data Type: BOOL)
My_Timer_00 ~ My_Timer_05 (Data Type: TIME)

You can see more variables in the "Variables" window.

Variables WX
W Name | Type | Dim. | Attrib. | Spb. | Init value || | Description
A Globa able A
MAX_VAR_REAL DINT Read Only 100 P Max. amount of REAL variables
MAK VAR OTHER  DINT Read O 100 The “Dim.” must Max. amount of (Integer + Bool + Timer) vai
REAL WAR_now REAL [0.99] be the same. Dim must = MAX_VAR_REAL
REAL VAR old REAL [0..99] O Dirm must = MAX_VAR_REAL
OTHER_VAR_now  DINT [EREE] O Dim must = MAX_VAR_OTHER
OTHER_WAR_old DINT [0..99] O Dim must = MAX_VAR_OTHER
File_Pathi STRING(54) [ | 'System_DiskWvin-GRAF\retain_real txt’
File_Path2 STRING(B4) [ | 'System_Disk\W\in-GRAFiretain_other txt'
My _REAL 00 REAL O -
My REAL 01 REAL O
My REAL 02 REAL | The directory and files for all Retain variables.
My REAL 03 REAL O
My REAL 04 REAL O v
< >

"Go_retain" sub-program is used to do the retain operation. Remember to modify this sub-program.
There are 4 sections should to be modified in it. Please search "Add your REAL variables for retain here"
and "Add your integer, BOOL, Timer variables for retain here", and depend on your re-declared variables
to modify your "Go_retain" sub-program.

(* Add your REAL variables for retain here *)
(* *)
My_REAL_00 := REAL_VAR_now[0] ;
My_REAL_01 := REAL_VAR_now[1] ;
My_REAL_02 := REAL_VAR_now[2] ;
My_REAL_03 := REAL_VAR_now[3] ;

My _REAL_04 := REAL_VAR_now[4] ;
My_REAL_05 := REAL_VAR_now[5] ;
My_REAL_06 := REAL_VAR_now[6] ;
My_REAL_07 := REAL_VAR_now[7] ;

(* *)

(* Add your integer, BOOL, Timer variables for retain here *)
(F e *)
My DINT_00 := OTHER_VAR_now|0] ;
My DINT_01 := OTHER_VAR_now[1];
My DINT_02 := OTHER_VAR_now|[2] ;
My DINT_03 := OTHER_VAR_now[3];
My DINT_04 := OTHER_VAR_now[4];
My DINT_05 := OTHER_VAR_now([5] ;

Win-GRAF User Manual, V2.0, Aug. 2020 by ICP DAS 6-11



My BOOL_00 := Any_to_BOOL( OTHER_VAR_now[6] ) ;
My_BOOL_01 := Any_to_BOOL( OTHER_VAR_now[7] ) ;
My_BOOL_02 := Any_to_BOOL( OTHER_VAR_now[8] ) ;

My_Timer_00 := Any_to_TIME( OTHER_VAR_now[9] ) ;
My_Timer_01 := Any_to_TIME( OTHER_VAR_now[10] );
My_Timer_02 := Any_to_TIME( OTHER_VAR_now[11] );
My_Timer_03 := Any_to_TIME( OTHER_VAR_now[12] ) ;
My _Timer_04 := Any_to_TIME( OTHER_VAR_now[13] ) ;
My _Timer_05 := Any_to_TIME( OTHER_VAR_now[14] ) ;
(¥ ceeeereeerrrrnnrereerereesesese s nnnnnnreeees *)

(* Add your REAL variables for retain here *)
(* *)
REAL_VAR_now[0] := My REAL 00;
REAL_VAR_now[1] := My_REAL_01;
REAL_VAR_now[2] := My_REAL 02 ;
REAL_VAR_now[3] := My REAL 03;
REAL_VAR_now[4] := My REAL 04 ;
REAL_VAR_now[5] := My _REAL 05 ;
REAL_VAR_now[6] := My REAL 06 ;
REAL_VAR_now[7] := My_REAL 07 ;

(* *)

(* Add your integer, BOOL, Timer variables for retain here *)
(¥ cererrrrrrrrrrrrrrrerereere e e ee e e e e e e e e e e e e eeens *)

OTHER_VAR_now|[0] := My DINT_00;

OTHER_VAR_now[1] := My DINT_01;

OTHER_VAR_now[2] := My DINT_02;

OTHER_VAR_now[3] := My_DINT_03;

OTHER_VAR_now[4] := My_DINT 04 ;

OTHER_VAR_now[5] := My DINT_05;

OTHER_VAR_now([6] := Any_to_DINT( My _BOOL 00);
OTHER_VAR_now[7] := Any_to DINT(My BOOL_01);
OTHER_VAR_now[8] :=Any_to DINT( My BOOL_02);

OTHER_VAR_now[9] := Any_to DINT(My_Timer_00);
OTHER_VAR_now[10] := Any_to_DINT( My_Timer_01);
OTHER_VAR _now[11] := Any_to_DINT( My_Timer_02 ) ;
OTHER_VAR _now[12] := Any_to_DINT( My_Timer_03 ) ;
OTHER_VAR_now[13] := Any_to_DINT( My_Timer_04 ) ;
OTHER_VAR_now[14] := Any_to_DINT( My_Timer_05 ) ;
(¥ cereerrrerrerrreerereeeeeee e e ee e e e e e e e e e eeeeenens *)
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Test Project:

Make sure that you have already set the communication IP and download the project to the PAC. When
connecting with the PAC, all values in the Spy list (refer to Section 11.3) will be "0" (or "FALSE") at the
begging, please enter some values at will. When the value has changed, it will create a text file on the
PAC (\System_disk\Win-GRAF\retain_real.txt and retain_other.txt) and write data to the files.

Note: The "Save_file_counter" will show the number of times the file is written, if this value is changing
rapidly (e.g., to write several times every second/minute.), it is not suitable for this application
(Because to write into files frequently in the "\System_disk" will reduce the PAC effectiveness.).

2 I G U e AR 3g (5 %A RUN Pan e n e @
OO00 HewSpyt.spl — Circle tiie Gms):
3 MName | Walue | Description | Last=23
Save_file_counter 0 A
el M. =13
B My_REAL_0D 00 Qo
B¢ My REAL OV 0.0 ———
My REAL 02 0.0 Vid - 01;’0?.'2014 15:59:40
My REAL_03 0.0 CRC= IS#Sf?Gealc
Target applicatio:
My REAL 04 0.0 Vcl lgC [lllég?jg%141 15:59:40
=, ealc
My_REAL_05 &9 RAM = 507864 bytes
My REAL 06 0.0 Elapsed: 1m3s
My RE&AL 07 0.0
My_DINT_00 ] . ,
MONT Ol 0 “ I & % 0 QB g (5 % @I RN o
My_DINT_02 0 Q000 HewSpyt.spl | Cycle time (ms):
My_DINT_03 0 Nal | Description Lazt=4
My _DINT_04 0 1 C Save_file_counter 7 =
| e i =
My_DINT_05 o = My READ (593938 Qrtsoran 22
My _BOOL_OD 5 g My _REA 1 . . X
My_BOOL 01 g It will increase 1, if it writes once. | ..
My BOOL 02 = W14 - 01072014 - 15:59:40
My_T_ s v My_REAL_03 0.0 CRC=16#5{T6ealc
y_Timer_ s My REAL 04 0.0 Target application:
My_Timer_01 s My REAL 05 235 W14 - 01072014 - 15:59:40
My Timer 02 s - — CRC=16#5{70ealc
vl Imel_ My REAL_0E 0.0 RAM = 507864 tortes
My_Timer_03 tH0s My _REAL 07 00 Elapsed: 8ms
M}'_Timer_04 tHOs My_DINT_UD 18325 L a— e
My_Timer_05 tH#0s My_DINT_m 0
My DINT_02 0
My_DINT_03 2014
My_DINT_04 0 ( Force |
My DINT_0S 0
My_BOOL_00 TRUE
My_BOOL_01
My_BOOL_02 Unioct
My Timer_00 tH0s 15 a7 0
My_Timer_01 tH1h33m50s DFFFEFREE REOOOREDR
My_Timer_02 tH0s
My_Timer_03 Hi0s 2423
: DDDDDDDD DDDDDDDD
My_Timer_04 tH0s
v Timer_05 tH#0s
Win-GRAF PAC:
| BEE) W®WE) ®RY) BEG |
HE 2 X4 E-
D )ﬂ \System_Diskiin-GRAF
I~ sofgrafy ] License. bin Qicker.dl QuickerMet, di
g retain_ather, txt B retain_real.txtd’r] CJooft-GRAF-WEF exe! ] t5.cod
[=] t3.codl [2] UserShareMet, B Win_GRAF_WP_B8000.exe Win_GRAF_WF‘_EIDDD.Ink
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6.3 Save Data to an EEPROM

The Win-GRAF PAC has a built-in EEPROM memory for users to read and write data, which will not lose

data when the PAC shut down. Compared to the read and write of the SRAM, EEPROM has the following

disadvantages:

Note: Some PAC have no EEPROM memory (like the WP-5238-CE7). They don't support EEP_Read() and
EEP_Write().

Advantages: Provides another way to save the important data, besides the Retain Variable. (Section 6.1).
Disadvantages: 1. The operation to read/write EEPROM will use much more CPU time (about 5 ~ 50 ms),
but changing to the way of "Retain variable", CPU time is much less than 1 ms.
Therefore, do not use the "EEP_Read" and "EEP_Write" Functions too frequently, or
it will increase the PAC Cycle time.
2. EEPROM has a “write” limitation (depending on the PAC), it is not suitable to write
the same data many times. So, DO NOT call "EEP_Write" Function within each PAC
Cycle to do the “write” operation.

ST Program: (Following will show the safe and dangerous coding ways.)

(* Declare "FIRST_CYCLE" as a “BOOL” variable and has an initial value “TRUE".

Declare "tmp_bool" as a “BOOL” variable °

Declare "New_Val" and "OIld_Val" as “DINT” variables. *)
(* Read the EEPROM once in the first Cycle. *)
if FIRST_CYCLE then

FIRST_CYCLE := FALSE; (* means it is not the first Cycle any more *)
tmp_bool := EEP_Read (1, New_Val);
end_if;
(* Safe Coding Way: write to the EEPROM only when the value is changed. *)
if New_Val <> 0ld_Val then
Old_Val := New_Val;
tmp_bool := EEP_Write (1, New_Val ) ;
end_if;

(* Dangerous Coding Way: EEPROM may be destroyed very soon. *)

(* Declare "FIRST_CYCLE" as “BOOL” variable and has an initial value “TRUE”.
Declare "tmp_bool" as “BOOL” variable.
Declare "New_Val" and "OIld_Val" as “DINT” variables. *)

(* Read the EEPROM once in the first Cycle. *)

if FIRST_CYCLE then
FIRST_CYCLE := FALSE; (* means itis not the first Cycle any more *)
tmp_bool := EEP_Read (1, New_Val);

end_if;

(*Dangerous Coding Way: Write the "New_Val" value to the EEPROM one time in every Cycle. *)
tmp_bool := EEP_Write (1, New_Val);
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6.3.1 EEP_READ (Read a Value from the EEPROM)

EEP_READ
(Addr QP Press “F1” key to see the detailed
[(J@Name setting descriptions.

Addr: (Data Type: “DINT”)

Address, can be 1 to 1200. If the variable type of the "@Name" parameter is a 64-bit data (e.g., LINT
or LREAL), the "Addr" can be 1001 to 1200 only.

@Name:
A variable name to store the value from the EEPROM.

(DO NOT use string variable. Variable type can be BOOL, SINT, USINT, BYTE, INT, UINT, WORD, DINT,
UDINT, DWORD, REAL, TIME, LINT or LREAL.)

Q:

Data Type: BOOL. TRUE: Ok; FALSE: Error.

If the type of the "@Name" parameter is REAL or LREAL, will return "Q" as FALSE if the value is NaN
(Not a Number) or other error happens. In the case of NaN, the REAL/LREAL variable will get the
value "0.0".

6.3.2 EEP_WRITE (Write a Value to the EEPROM)

EEP_WRITE
Addr Qi
Value

—

Addr: (Data Type: “DINT”)
Address, can be 1 to 1200. If the variable type of the "Value" parameter is a 64-bit data (e.g., LINT or
LREAL), the "Addr" can be 1001 to 1200 only.

Value:
The value to write to the EEPROM.

(DO NOT use string variable. The value type can be BOOL, SINT, USINT, BYTE, INT, UINT, WORD,
DINT, UDINT, DWORD, REAL, TIME, LINT or LREAL.)

Q:
Data Type: BOOL. TRUE: Ok; FALSE: Error.
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Chapter 7 Exchange Data between PACs (Data Binding)

"Binding" function is used to exchange data between ICP DAS Win-GRAF PACs, the data transmission is
event triggered. It is much more efficient than polling way. Win-GRAF offers two ways to set up Binding:

® PUBLIC: Publish one PAC’s own data, or for use of VB .net, C#, or C in the same PAC.
® EXTERN: To get data from other PAC.

Application Diagram:

PUBLIC
WP-5xx8-CE7 ——
The max. number of
’ “Binding” (EXTRN) can be
PUBLIC used by one Win-GRAF
EXTERN PUBLIC/ EXTERN PAC:
EXTERN )

XPAC: Max. 32
WinPAC: Max. 16
ViewPAC: Max. 16
(See P1-1 for details.)

VP-2x08-CE7 | VP-4x08-CE7

EXTERN PUBLIC
|
XP-8xx8-CE6 (IP1/1P2) XP-8xx8-CE6
Redundant Binding

"PUBLIC" Setting Steps:

When the PAC sets up the "PUBLIC" area, means to publish its own data.
1. Mouse right-click on the toolbar "Open Binding Configuration" icon to open the "Binding" window.

2. Click "PUBLIC (: 9000)" to configure the data to be published as PUBLIC; "Address" field needs not
tofill in; "Port" field is fixed to "9000", do not change it.

T8 Win-GRAF - Test 3
File Edit View Insert Project Tools Window Help

Open Binding Configuration

2 iR oz el &R e B %A
Workspace Binding
B4 __[1 Test_3 g T Cig Network Nafe | Value W MName | Type |
“ [ Exception programs o (-9 LIELIC [:9000) Name PUBLIC {2} Global variables ~
([ Programs Address = RETAIN vatiables
€] Main g Port 9000 ] Main
E1--[ Watch (for debugaging) || ?a pOnBadindex =
A/ ¥ e s
: jﬂ |S°ft|3°°pe . "PUBLIC" area || & Vit
o I nitial values = . ([ ariaple
d oA Name | Identifier ster..| | N
tfg Binding Configuration needs not to fill ‘L‘L area
- 3g Global defines in the Address.
13 Variables
LB Types
< ‘ il

[4 5] Binding Varisbles
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3. Before setting the data to become public, first you must create the variables want to become

public in the Variable area. Right-click on "Global variables" and press "Ins" key to add the new
variables. In the following table, the variables are used for this example. You can set up your own.
After finished, the screen is as below.

b

Name | Type | D

m Global variables K A
Public_BOOL  BOOL
Public_INT INT
Public_DINT DINT
FPublic WORD WORD
Duhli~-DEAl DEAl
Public_REAL w i|

] Main AN

Press "Enter" key

Variables Name Data Type
Public_BOOL BOOL
Public_INT INT
Public_DINT DINT
Public_ WORD WORD
Public_REAL REAL

<4 Sl

4. Right-click on the "PUBLIC (: 9000)", and then select the variables that you want to publish, and
drag them to the "Name" area. "ldentifier" field will automatically generate numbers (if other PAC
wants to access the data, need to set the same ID number).

Note: "PUBLIC" can use up to 8192 variables; "lIdentifier" number can only be "1 ~ 8192".

Binding *
2 B8 Name | Value W MName | Type |
i Name  PUBLIC = fay Global variables A
: Address Public_BOOL BOOL
g+ Port 9000 Public_INT 0 INT &
= Public_DINT ,° DINT
Public_WORD WORD
Public,REAL  REAL v
2
( o o : & =il >
Name | Identifier | Positive hysteresis . = —
L --~—7" || Name | Value |
Public_INT 2
Piblic_ DINT 3 If the user want to assign continuous “Identifier”
Public_W0ORD 4 . s u e g
Sy : number, first click “Identifier” field and select
i those variables wish to be assigned, and then
______ & click “Iterate property” to set up numbers.
|4 »| Binding " Variables .

I e S —_ ]
. O PUBLIC(3000)

| @ 101:Public_BOOL g % ) |
Bt @ 102Public_INT , = =

n’*—\a 103 Public_DINT EEE )
£ J@ 104:Public_WORD Resuts

° Iterate propertsr °

Name | Identifier

Pubic BOOL
Public_INT
Public_DINT
Public_0ORD
Public_REAL

L ‘ l UK‘{[ Cancel |

@ 105:Public_REAL
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"EXTERN" Setting Steps:
When the PAC sets up the "EXTERN" area, means will get the data from other external PAC.
5. Click the "Insert Master/Port" icon in the left side, it will show the "Group" window. Follow the
description below to set up this window, and then click "OK” button.

Binding

. = EHE Metwark,

ez ' E || C [:9000]

M arne | Walue
Marne PLEBLIC
Address

Port

3000

Mame
-DK |
EXTERN:1 |
g
P PAC1 PAC2
Address ﬁ 92.168.1.100/200.168.1. 10 rnn rn n
Port {9[]60—]
Name: Can be modified to the desired name.

Address: Enter the IP address of the PAC which data will be obtained (e.g., "192.168.1.100").
User can enter two IP Addresses (e.g., "192.168.1.100/200.168.1.100"; that PAC must
use two Ethernet Ports), so that when one IP address occurs any problem, it will try to
link the second IP address.

Port: Fixed to use "9000", do not change it.

6. Inthe variable area, set up the data type you want Variables Name 2ELE] VTR
to get. (Refer to Step 3 - Right click on "Global PAC1_BOOL BOOL
variables" and press "Ins" key to add the variables). PACL_DINT DINT
The variables that listed in the table are used for
this example. You can set up your own. After PAC1_REAL REAL
finished, the screen is as below. Error_Status DINT

7. Please drag the variables you need into the "Name" area of the "EXTERN:1".
Note: "Identifier" field will automatically generate numbers, please change them to the same as

the opened IDs of the PAC that you want to get data from.

Binding *

& B #& PUBLIC (:9000) || Name | Value T Name | Type |
. @ 1:Public_BOOL Name EXTERN:1 || Public REAL  REAL A
© @ 2Public_INT Addr.. 192.168.1.... PACT BOOL BOOL

g @ 3Public_DINT Pot 9000 ¢ PACI_DINT  DINT
@ 4Public_WORD ] /| PACT_REAL  REAL
‘ Publie—REit L7 | Emor Status __ DINT v
_ 7| Sl I8 Variable area
Name | Identifier | Destination R P B plome | reue l
PACT_BOOL 1 Exchange data. — — = -
PACI DINT 2 m— ===~ Exchange data
PACT_REAL 3 Exchange data
Eror_Status 4 Exchange data

(4 ¥ | Binding.” Varisbles
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8. As the picture below, "Error_Status" variable is used to determine the communication status of the
PAC, please set this ID to "0" and then double-click "Destination" field and set it to "Connection
error status".

1 = a5 PUBLIC (:3000) A || Name | Value W Name 7| Type I
P - @ 1:Public_BOOL Name EXTERN:1 Public_DINT DINT 2
@ 2:Public_INT Addr.. 192.168.1.... Public_BOOL BOOL
g @ 3:Public_DINT Port 3000 PACT _REAL REAL
@ 4:Public_WORD PACT_DINT DINT
@ 5:Public_REAL PAC1_BOOL BOOL
755 EXTERN:1(192.168.1.100/200.168.1.100:3000) Error_Status DINT v
Narme | Identifier | Destination , 5
PACT_BOOL 1 Exchange data MName | Yalue ]
PACT_DINT 2 Exchange data
PACT REAL 3 Evchionoaidatar:
| Exchange data
; Enbi Stabs 8 }Variable error status
{4 ¥ | Binding, ~ ‘“fariables / | Yariable date stamp
- : Wariable time stamp
B . S| - chnection enor status ‘ X
) > Build.~ Crozs references | Runtime | \ ital zampling trace ;_ Frompt ‘v_ Hbdl .~
Note:

a. If "EXTERN" set up two IP addresses (step 5), then the "Error_Status" will return two communication

status. As the following table, use 8 bits to indicate the connection status. The bit 0 ~ 3 represents

the first IP connection status (If all bits are 1, the value is 15); the bit 4 ~ 7 represents the second IP
connection status (If all bits are 1, the value is 240). As long as the value is not equal to “0”, it means
that there are connection errors.

IP2 Connection Status IP1 Connection Status . L.
27 ‘ 26 | 25 | 24 23 ‘ 22 ‘ 21 ‘ 20 Status Description
0 0 Connection OK
0 #0 (1~ 15) IP1 Connection error
# 0 (16 ~ 240) 0 IP2 Connection error
#0 Z0 IP1 and IP2 Connection error

b. The return value of the "Error_Status" is an integer value. The following division operation provides
a way to determine this value. Dividing this value by 16, the quotient represents the IP2 connection
status, and the remainder represents the IP1 connection status. If the values are not equal to “0”, it
means that there is any connection error. For example: If "Error_Status" = 16, divided by 16, the
quotient =1 (# 0, IP2 Connection error) and the remainder = 0 (IP1 Connection OK); If "Error_Status"
= 3, divided by 16, the quotient = 0 (IP2 Connection OK) and the remainder = 3 (# 0, IP1 Connection

ignore it.

error);
PR TTTTTTTTTToTT T oo g
|
Notice: : AN EFEEE |
Please ignore the description of the "Connection status" and : i O !
"Variable status" in the "Networked applications - Dual : . DK'""’. |
binding on redundant ETHERNET" of the "HTML Help" that : P _ '
npan L I 1 .= Conrection 1 fails !
opened when press "F1" key. That explanation is wrong and | B - . i |
does not comply with the ICP DAS Win-GRAF PAC. Please Coe omnection=@is
. B Both connections fail., |
L o
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Chapter 8 Connecting DCON 1/0 Modules

The Win-GRAF PAC can connect the ICP DAS "I-7000" and "I-87KW" remote DCON I/O modules via the
COM Port (RS-485). Each PAC can enable up to 16 DCON Ports, and each Port can connect up to 50
remote DCON I/O modules (not recommended over 32). If select the "I-87KW" series I/O modules, it
must be used with the RS-485 I/O Expansion Unit (e.g., 1-87K4/5/8/9 or RU-87P4/8). You can view the
detailed product information on the ICP DAS website:

http://www.icpdas.com/en/product/guide+Remote__ | O_ Module__and__Unit+RS-485__| O__ Modul
es+l0O__Expansion__Unit

Win-GRAF PAC

1-8142iW/I-8144iW
(2/4, RS-422/RS-485 Ports)

Before connecting "I-7000" or "I-87KW" remote DCON I/O modules, you must use "DCON Utility"
software to configure each module for the Protocol (choose DCON mode), Address (1 ~ 255), Baudrate
(the setting must the same with the Win-GRAF PAC, recommended set to 9600), Checksum (the setting
must the same with the Win-GRAF PAC, recommended set to "enabled" for communications security),
Data format and other Input/Output settings (set according to demand).

Note:
A. When using the Al module of 1-7000 and |-87KW, set the Data format to "2's Complement".

E.g. 1-7005, 1-7013, I-7014D, 1-7015, 1-7016, I-7017R, |-7018Z, I-7019R, 1-7033; [-87005W, 1-87013W,
[-87015W, 1-87015PW, |-87016W, 1-87017W, 1-87017RCW, 1-87017ZW, I-87017DW, 1-87018W,
[-87018RW, [-87018ZW, I1-87019RW, 1-87019ZW, and other Analog Input modules.

B. When using the AO module of 1-7000 and |-87KW, set the Data format to "Engineering"

E.g. 1-7021, I-7022, 1-7024, 1-7024R; 1-87024W, 1-87024UW, I-87024CW, 1-87028UW, 1-87028CW,

[-87028VW, 1-87028VW-20V, and other Analog Output modules.

"DCON Utility" is an easy-to-use software toolkit that help user search the network, configure the I/O
modules and test the 1/0 status. Please visit the website to get the software program and user manual:
http://www.icpdas.com/en/product/guide+Software+Utility_Driver+DCON__Utility__Pro

The following will introduce the setting method in the Win-GRAF Workbench.
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8.1 Setting "DCON" 1/O Boards

"DCON" can be used to enable an RS-485 Port to connect remote DCON I/O modules (e.g., I-7000 series
modules, RU-87P8 I/0 Expansion Unit + I-87KW 1/O modules, or I1-87K8 1/0 Expansion Unit + I-87KW 1/0
modules). If want to enable more than one DCON Port, please set up multiple "DCON" 1/O Boards. (One
PAC can enable up to 16 "DCON".)

1. Click "Open I/0s" of the Win-GRAF tool bar to open the “I/O Boards” setting window.

File Edit View Insit FProject Tools Window Help

Sl ok X s 0 m@mmfé&ssg % %% A

2. Double click "Slot8" to add "DCON" I/0O Boards (Refer to Chapter 4), and then double click "DCON" to
open the “Properties” window.
Note: The Slot 0 to Slot 7 are reserved for real I/O modules that plugged into the PAC, and the slot 8
or above are for other usage.

££EE 170 Boards

0
1 ____
2 8 DCO!I Propemes
3 - —
4
5
g Baud_rate = 9600
Host_watchdog Enabled =0
r Watchdog_timeout = 5000
ERoCoN Checksum_enabled =0
Delay _ms_between_polls=0
2 Reserved0 =0
10 Reservedl =0
11 M Reserved2 =0
12 Reserved3 =0
13
14
15 Setting Descriptions —
16 DCON & | ~
17 Enable one serial port [RS-485) to connect remote DCON 1205 (17000 series modules , RU-87PE ‘
Mote:
1. This "DCON" supports only the communication properties ""N,8,1"" .
That is "No-parity , "8 character size'' and "1 stop bit" .
So please must configure all DCON /0 modules to "N.8.1" . Gl
< ‘ > ‘

Parameters:
Note: This "DCON" supports only the communication properties "N,8,1". That is "No-parity" , "8
character size" and "1 stop bit" . So please must configure all DCON I/0O modules to "N,8,1".

Port: COM port number (1 ~ 37, depends on the PAC.)

Baud_rate: Communication baudrate in bps, can be 1200, 2400, 4800, 9600, 19200,
38400, 57600, 115200 (bps). Set a wrong value will use the default value
9600.

Host_watchdog_Enabled: 1: enable host-watchdog, O: disable it.
Set a nonzero value will use the value 1.
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Watchdog_timeout: Unit: ms, can be 3000 ~ 25500.
Set larger than 25500 will use 25500 ms (25.5 sec).
Set smaller than 3000 will use 3000 ms (3 sec).
Ignore this setting when "Host_watchdog_Enabled" is 0.

Checksum_enabled: 0: disabled, 1: enabled.
Set a nonzero value will use the value 1. (Recommended set to
"enabled" for communications security.)

Delay_ms_between_polls: Unit: ms, default is 0 ms. Valid range is 0 ~ 1000.
Set smaller than O will use 0 ms.
Set larger than 1000 will use 1000 ms.
If there is no wireless module connected, set a smaller value.
For instance, set as 0 ~ 10.
If there are wireless modules (e.g., ICP DAS ZigBee Products: ZigBee

Converters or ZigBee 1/0 modules.) connected, set a bigger value.

For instance, set a value between 30 ~ 100 or other values.
Set larger value will get slower polling efficiency.

Double click the item to be set, and then fill in the value.

Key=6
Ref = 1685
Port=2
Baud_rate = 9600
Host_watchdog Enabled =1
Watchdog_timeowut = 3000

Checksum_enabled =0

Reserved0 =10
Reservedl =0
Reserved2 =0
Reserved3 =0

3. After setting up the "DCON" in the "I/O Boards" window, it will automatically add a "BOOL" input
variable in the "Variables" window. When the Win-GRAF links to the PAC, it will show the COM Port
communication status (TRUE: OK; FALSE: error.).

Variables B VX
T MName 4| Type | Dim. | Attrib. | Syb. | Initvalue | User.. | Tag | Description
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8.2 Using 1/0 Function Blocks

The Win-GRAF supports many ICP DAS DCON remote I/O modules, you can open the "Library Manager"
(Refer to Section 1.2.3) or press "F1" key in the "Function and FBs" to view these I/O Function Block
descriptions. This section will introduce "D_7065", "D_7018Z", "D_7083", "D_87084_freq",
"D_87084_cnt4","D_87084 cnt8", and "DL_100T485" I/O Function Blocks.

m Library Manager - ICP DAS - XP-WP-¥P

File Wizard Help

Function and FBs 1)/0s | Profiles i ASi | Types|

s D_7005 i* remote i-7005 ¥ D |

@D_7011 (*remote 1-7011, 7011D, 7011F, 7011FPD *)

@D_7012 (*remote i-7012, 7012D, 7012F, 7012FD *)

—T%_TINAN OO SN i) d oL AT Seoies oo mde 2 O0S0 _D0103_O04OT D01 AT W V
| Parameter€’ Descri@
*#% Function Block -
*#*% Input parameters =
EN : BOOL : TRUE : enable it , FALSE : disable it .
Port : DINT : COM port number , can be 1 to 37 (depends on PAC) .
(*** Must use a constant value, not a changed wvalue *%#)

Addr : DINT : Net-ID address of the module , can be 1 to 255 . N

In the LD Program - Functional Block area, expand the "ICP DAS - XP-WP-VP" folder of the "Blocks" panel.
There are many Functions and Function Blocks. You can select the desired one, and drag it into the
editing area of the program.

1. 7%3

b Inst_D_7005 e N ;’J‘ja.'g e | Type | Dimn.
3k E -
_*‘ ENB JposoK — # {2} Global variables
L | | N | e RETAIN variables
3 = B8 %IXB - DCON
o | Jaddr W1} % %lIX5.0 BOOL
o {tmpF v 2} AN [T L
0 AN |1 [ ICP DAS - XPWPAP ~
gl = ——poa w3 AN TF COUNTER_GET [*Gett...
= N T} COUNTER_RESET [Re...
» | e —Jpoa v} N 1} COUNTER_START [Sta..
o RN T} COUNTER_STATE [‘Get...
IR R S RN 1} COUNTER_STOP [Stop...
HIOH ~ < &
= e e “~1 EF D_701U{temote 7011, ..
= | —ke et T = = FFDTI012 (remote (7012, ..
& g = D_7012_V2 [*Get only 1-...
T D_7013 (remote i-7013")
i Tips: = D_7014 (remate i 7014, ..
¢ | Press “F1” to see the setting description. = —

0] Mainaiabies 7
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8.2.1

“D_7065" Function Block

“D_7065”: Connect a remote I-7065, I-7065D (Power Relay Output Module) or I-7065A, I-7065AD,
[-7065B, I1-7065BD (Solid State Relay Output Module).

Note:
All connected DCON 1/0 modules should be configured once by the DCON Utility (refer to P8-1).
Please use "DCON"(Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,

1.
2.

etc.)onit.

"OK" returns "TRUE".).
Refer to Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the

demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\DEMO_D_7065.zip) in the shipping CD and
view the program and descriptions.

. All values of DI channels are meaningful only when the returned communication state is TRUE (If

Supposition: Use PAC‘s COM2 to connect the I-7065 (Addr. = 2) with 4 DI and 5 Relay output channels.

Mo KEX

ks

> |

—ot
—oi
2

I &

R1

<

4 ¥ | Main/ Variables

Input Parameters:

EN:
Port:

Addr:

RL_1~ RL_5:

EN D_7055 OK|
2-4part Ih_1
2 steir In_2}
DO_1
' RL_1 IN_3
DO_2
' RL_2 IN_4
DO_3
[ RL_3
DO_4
[ {RL_4
DO_5
' RL 5
Data type:
Data type:

Inst_D_7065

DI
DI_2
DI_3

DI_4

COM

-~ N

A Name

.| f"OK" returns "TRUE".

o\

Declare 9 BOOL variables
(DI & DO of the I-7065).

v

BOOL. TRUE: enable it; FALSE: disable it.
DINT. COM port number (can be 1 to 37, depends on PAC).

| Type | Dim. | &

{2} Global variables ~
DI_1 BOOL
D2 BOOL
|3 BOOL
DI 4 BOOL
0.1 BOOL
DO 2 BOOL
DO 3 BOOL
DO_4 BOOL
DO 5 BOOL

COM BOOL v

>

D_7063 [*remote i-7063, ... 4
D_7065 [Fremote i-70B5; ...

D_7066 [*remote i-7066, ...

T N INET (frarmate L7NET.
> {4 ¥| Blocks Sovlist |

(*** Must use a constant value, cannot be a changed value. ***)
Data type: DINT. The Net-ID address of the module, can be 1 to 255.
(*** Must use a constant value, not a changed value ***)
Data type: BOOL. 5-Ch DO values.

Output Parameters:

OK:
IN_1~IN_4:

Data type: BOOL. TRUE: Communication is Ok. FALSE: Communication failed.
Data type: BOOL. 4-Ch DI values.
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8.2.2 “D_7018Z" Function Block

“D_7018Z": Connect a remote I-7018Z module that is a 10-channel Thermocouple analog input module
for measuring voltage, current or temperature with features of individual channel
configuration, open-wire detection and over Voltage protection.

Note:

1. All connected DCON I/O modules should be configured once (e.g., Address, Baudrate, etc.) by the
DCON Utility (refer to P8-1). Please must configure the data format of Al modules to "2’s
complement" by DCON utility, or the Win-GRAF PAC can not read them well.

2. Please use "DCON" (Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,

etc.) on it.

3. All values of Al channels are meaningful only when the returned communication state is TRUE (If

"OK" returns "TRUE".).

4. Refer to Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\DEMO_D_7018z.zip) in the shipping CD and
view the program and descriptions.

Supposition: Use PAC‘s COM2 to connect the I-7018Z (Addr. = 3) to measure the Celsius temperature.

57 Name | Dim. |

¥ inst_D_7018Z COM | Type
o o EN D T015z o] g B {2} Global variables A
2 \ A1 REAL
| 24Port w_nf-Al1 Al_2 REAL
= If "OK" returns "TRUE". | A3 REAL
o 3 addr v 1)al2 Al4 REAL
- AlLS REAL
o | 14Tmp_F y 21813 Al B REAL
o A7 REAL
= W _3AIL4 Al_8 REAL
w ALY REAL
> | YoRALS . Al_10 REAL
F Declare 10 REAL variables COM BOOL <
| v_sfaL6| (Al of the I-7018Z). " R
e S B 4
= v glal7 D_707Z_20 (remotei.. A
§ & D_7018 [remote i-701...
3._ v 7fals D_7018Z [remate i-70...
D_7019R (*remote i-70...
| | v gl a9 D_7021 [Fremote i-702...
D_7022 (*remote i-702...
| v glal 10 v D_7024 [remote i-702...
< ¥ |[®®)] Blocks < Goviist| Define.| ENDM.
{4 » | Main/ Varisbles ' B
Input Parameters:
EN: Data type: BOOL. TRUE: enable it; FALSE: disable it.
Port: Data type: DINT. COM port number (can be 1 to 37, depends on PAC).
(*** Must use a constant value, cannot be a changed value. ***)
Addr: Data type: DINT. The Net-ID address of the module , can be 1 to 255.

(*** Must use a constant value, not a changed value ***)
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Tmp_F:

Data type: DINT. Temperature Format, can be 1 or 2:

1 : temperature unit in Degree Celsius.

2 : temperature unit in Degree Fahrenheit.

Other value: use it as "1:temperature unit in Degree Celsius".

Output Parameters:

OK:
Vo~V_o:

Data type: BOOL. TRUE: Communication is Ok. FALSE: Communication failed.
Data type: REAL. 10-Ch Al value.
If the channel range type is configured as mV or Volt by DCON utility, the unit of the
returned channel value is Volt.
For example, 0.85421 means 0.85421 V or 854.21 mV.
If the channel range type is configured as mA by DCON utility, the unit of the
returned channel value is mA.
For example, 1.5567 means 1.5567 mA .
If the channel range type is configured as temperature, the value unit is degree.
For example, 25.75 means 25.75 degrees.

Open-wire Detection:

If the returned temperature is greater than "9000.0", it means that

1. The temperature sensor may be broken-line.

2. The temperature sensor may be broken.
3. The DCON module is not configured well to fit the connected temperature sensors.
4. The ohm measured by the connected sensor is not correct.
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8.2.3 “D_7083"” Function Block
“D_7083”: Connect a remote |-7083, 1-7083D, 1-7083B or I-7083BD module that is a 3-axis, 32 bits

encoder counter.

Note:

1.

To get the Encoder value of the |-7083, |1-7083D, I-7083B and I-7083BD module, first using "D_7083"
Function Block. Then, using the “Counter_Start”, “Counter_Stop”, “Counter_Get”, “
and “Counter_Reset” Functions (Refer to Section 4.9) to operate encoder channels in an I-7083,
[-7083D, 1-7083B and |1-7083BD module.

All connected DCON 1/0O modules should be configured once (e.g., Address, Baudrate, etc.) by the
DCON Utility (refer to P8-1). Please must configure the data format of Al modules to "2’s
complement" by DCON utility, or the Win-GRAF PAC can not read them well.

Please use "DCON"(Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,

Counter_State”

etc.)on it.

All values of Al channels are meaningful only when the returned communication state is TRUE (If
"OK" returns "TRUE".).

Refer to Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\DEMO_D_7083.zip) in the shipping CD and
view the program and descriptions.

Supposition: Use PAC‘’s COM2 to connect the I-7083 (Addr. = 4) with 3 DI channels.

3 A || Name | Type | Dim. | &
3E R1 EN D 7083 OK Cof\‘? I = ﬁ Global variables ~
g (J* 2 - \ Dl_1 BOOL :
24part zn (s DI_2 BOOL
=5 ol 2 If "OK" returns "TRUE". | DI_3 BOOL
A | 4 L addr I b g U COM BOOL v
) | D3 < 7 >
e To read/write/operate Z2 _— D_7080_CNT [remote ..  »
& | ' Encoder, see Section 4.9. \ D_7080_FREQ [‘remote i..
ol - ' v D_7083 [remote 17083, ... [
Sl ) Declare 3 BOOL variables |4 %] Blocks  Soviist | Define | ENUM
Bl Mt ENrisbios (Z-index DI of 1-7083).
Input Parameters:
EN: Data type: BOOL. TRUE: enable it; FALSE: disable it.
Port: Data type: DINT. COM port number (can be 1 to 37, depends on PAC).

(*** Must use a constant value, cannot be a changed value. ***)

Addr: Data type: DINT. The Net-ID address of the module, can be 1 to 255.

(*** Must use a constant value, not a changed value **%*)

Output Parameters:

OK: Data type: BOOL. TRUE: Communication is Ok. FALSE: Communication failed.
Z0~Z_2: Data type: BOOL. 3-ch Z-index DI value.
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8.2.4 “D_87084_FREQ” Function Block
"D_87084_freq": Connect a remote I-87084W in an |I/O Expansion Unit (e.g., I-87K4/5/8/9 or RU-87P4 or
RU-87P8.) to measure 8-ch frequency.

Note:

1. Please MUST configure the I-87084W's frequency data format as "Hex format" by DCON utility (refer
to P8-1) when using the 1-87084W to measure frequency. Or it will not work.

2. Please use "DCON"(Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,
etc.)on it.

3. All values of Al channels are meaningful only when the returned communication state is TRUE (If
"OK" returns "TRUE".).

4. Refer to Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\DEMO_D_87084_FR.zip) in the shipping CD
and view the program and descriptions.

Supposition: Use PAC‘s COM2 to connect the I-87084W (Addr. = 5) to measure 8-ch frequency.

main S T g X

3 A\ Name | Type | Dim. | &
R (,:Omi 1 || B &} Global variables -~
i \ Al1 DINT
| 24Port Freg_of-Al_1 Al_2 DINT
= If "OK" returns "TRUE". | A2 DINT
A | 5| Addr Freg 1}-A1_2 Al_4 DINT
, A5 DINT
& Freg_2}-21_3 Al B DINT
_ A7 DINT
e i Freq 3} &l_4 Al B DINT
COM BOOL v
» Freq_4f- 415 \ < | >
g Freq 5|4l 6 | iabl D_87084_CNT4 [remate.. &
F 3 req_5f-46 | Declare 8 DINT variables D_87084_CNTS (remots .
- sl sz | (frequency inputs of the
iy | | 1-87084W) DL_1007T485 (*remote DL..
= Freg 7}-21.8 T} EEP_READ [*Read a val..
i | T} EEP WRITE (Wite ava.
(_ ) < ¥ | Blocks Sovlist | Define | ENUM :
[« 3| Main,/ Variables S o : :
Input Parameters:
EN: Data type: BOOL. TRUE: enable it; FALSE: disable it.
Port: Data type: DINT. COM port number (can be 1 to 37, depends on PAC).
(*** Must use a constant value, cannot be a changed value. ***)
Addr: Data type: DINT. The Net-ID address of the module, can be 1 to 255.

(*** Must use a constant value, not a changed value ***)

Output Parameters:
OK: Data type: BOOL. TRUE: Communication is Ok. FALSE: Communication failed.
Freq_0 ~ Freq_7: Data type: DINT. 8-Ch frequency value, unit is Hz.
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8.2.5

“D_87084_CNT4” Function Block

"D_87084_CNT4": Connect a remote |1-87084W in an 1/O Expansion Unit (e.g., I-87K4/5/8/9 or RU-87P4
or RU-87P8.) to measure 4-ch counters.

Note:
Please MUST configure the 1-87084W's counter data format as "Hex format" by DCON utility (refer

1.

to P8-1) when using the I-87084W to measure counters. Or it will not work.

etc.)on it.
To get the 4-ch counter value from the remote 1-87084W, first using "D_87084_cnt4" Function Block.
Then, using the "Counter_Start", "Counter_Stop", "Counter_Get", "Counter_State" and

"Counter_Reset" Functions (refer to Section 4.9) to operate counter channels.

Please use "DCON"(Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,

All values of Al channels are meaningful only when the returned communication state is TRUE (If

"OK" returns "TRUE".).
Refer to Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the

demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\DEMO_D_87084_C4.zip) in the shipping CD
and view the program and descriptions.

Supposition: Use PAC‘s COM2 to connect the I-87084W (Addr. = 6) to measure 4-ch counters.

Inst_D_87084_CNT4

3k

)

R1

To read/write/operate

counter, see Section 4.9.

» S
4> | Main ‘arizbles

Input Parameters:

EN:
Port:

Addr:

AW Name

| Tvpe

| Dim. | &

COM
JE.D_67084_CNT4 ... L) | i:_g
24Part \ AI:?
If "OK" returns "TRUE". ALB
6| 2ddr COM
& ,

bs

Data type: BOOL. TRUE: enable it; FALSE: disable it.

Data type: DINT. COM port number (can be 1 to 37, depends on PAC).
(*** Must use a constant value, cannot be a changed value. ***)
Data type: DINT. The Net-ID address of the module , can be 1 to 255.

v

DINT
DINT
DINT
DINT
BOOL

~

v

>

D_87082_FREQ [remote... &

D 87084 CNT4 [Fremote ..

D_87084_CNTS [remote ..

97k N 27024 FREN (*remate
Sowlist |

|4 ¥ | Blocks

(*** Must use a constant value, not a changed value ***)

Output Parameters:

OK:
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8.2.6

Note:
Please MUST configure the 1-87084W's counter data format as "Hex format" by DCON utility (refer
to P8-1) when using the I-87084W to measure counters. Or it will not work.

1.

“D_87084_CNT8” Function Block
"D_87084_CNT8": Connect a remote |1-87084W in an 1/O Expansion Unit (e.g., I-87K4/5/8/9 or RU-87P4
or RU-87P8) to measure 8-ch counters.

Please use "DCON"(Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,

et

c.)onit.

To get the 8-ch counter value from the remote |1-87084W, first using "D_87084_cnt8" Function Block.
Then, using the "Counter_Start", "Counter_Stop", "Counter_Get", "Counter_State" and
"Counter_Reset" Functions (refer to Section 4.9) to operate counter channels.

All values of Al channels are meaningful only when the returned communication state is TRUE (If
"OK" returns "TRUE".) .
Refer to Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the

demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\DEMO_D_87084_C8.zip) in the shipping CD
and view the program and descriptions.

Supposition: Use PAC‘s COM2 to connect the I-87084W (Addr. = 7) to measure 8-ch counters.

3k

)

>

<

R1

To read/write/operate

counter, see Section 4.9.

|¢ »| Main, \ariables

Input Parameters:

EN:
Port:

Addr:

Inst_D_87084_CNTS
JE.D_87084_CNTS ...

24Port

7| Addr

AW Name

If "OK" returns "TRUE".

bs

Data type: BOOL. TRUE: enable it; FALSE: disable it.

Data type: DINT. COM port number (can be 1 to 37, depends on PAC).
(*** Must use a constant value, cannot be a changed value. ***)
Data type: DINT. The Net-ID address of the module , can be 1 to 255.

v

| Tvpe

| Dim. | &

Al S
AlB
AT
AlB
COM

DINT
DINT
DINT
DINT
BOOL

~

v

X

D_87084_CNT4 [remote.. &

b 87084 CNT8 [remote ..

D_87084_FREQ [remote... —

FZE Nl 10NT 48R Fremats NI
Sovlist |

|4 ¥ | Blocks

(*** Must use a constant value, not a changed value ***)

Output Parameters:

OK:
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8.2.7 “DL_100T485” Function Block
"DL_100T485": Connect a remote DL-100T485 module to get humidity and temperature value.

Product website: http://www.icpdas.com/en/product/DL-100T485

Note:

1. Please use "DL-100T485 Utility" software in the shipping CD to configure the appropriate parameters
of the module (e.g., Module ID). The TDL-100T485’s default Address (ID) is "1", Baudrate is "9600",
and the Checksum is "Disable".

2. Please use "DCON"(Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,
etc.) on it.

3. All values of Al channels are meaningful only when the returned communication state is TRUE (If
"OK" returns "TRUE".) .

4. Refer to Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\ DEMO_DL_100T485.zip) in the shipping CD
and view the program and descriptions.

Supposition: Use PAC‘s COM2 to connect the DL_100T485 (Addr. = 1) to get humidity and temperature
value.

; : A7 Name | Dim.

5 inst_DL_100T485 COM |ifipe
=5 b - 7 L = fa} Global variables »
B & \ COM BOOL
| 24Port RH|-RH1 RH1 REAL
= If "OK" returns "TRUE". | Tempt REAL v
&, 8 1 &ddr Temp_C|-Temp_1 < >
5 ' D_G7084_CNTS [rem..
B D_67084_FREQ (re...
- f Declare 2 REAL variables v E EEE—?E;:EJEE:"?&
e L : (humidity and temperature € %] Blooks  Sovist | Define [ ENUM
< » | Main - “arizbles
— — values of the DL-100T485.)
Input Parameters:
EN: Data type: BOOL. TRUE: enable it; FALSE: disable it.
Port: Data type: DINT. COM port number (can be 1 to 37, depends on PAC).
(*** Must use a constant value, cannot be a changed value. ***)
Addr: Data type: DINT. The Net-ID address of the module, can be 1 to 255.
(*** Must use a constant value, not a changed value ***)
Output Parameters:
OK: Data type: BOOL. TRUE: Communication is Ok. FALSE: Communication failed.
RH: Data type: REAL. The value is "Relative humidity"; unit is 1%.
For example, a value "45.7" means 45.7%.
Temp_C: Data type: REAL. The temperature value is in "Degree Celsius".

For example, a value "25.7" means 25.7 Degree C.
Temp_F: Data type: REAL. The temperature value is in "Degree Fahrenheit".
For example, a value "78.26" means 78.26 Degree F.
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8.2.8 “D_GPS721” Function Block

Using the “D_GPS721” function to link one “GPS-721"” remote GPS receiver module (includes one DO
and one PPS outputs) which is used to receive GPS signals, get the precise date, time, longitude and
latitude, and for satellite positioning and time correction. Moreover, “GPS-721" is equipped with a
RS-232 interface, the remote host can request the GPS-721’s GPS information and remotely control the
built-in DO channel by using DCON commands over RS-485. And, the PPS (Pulse Per Second) function
can be used for a simple time synchronization.

Product website: http://www.icpdas.com/en/product/GPS-721

Note:

1. One PAC can use only one GPS-721 module.

2. All connected modules should be configured once. First of all, set up parameters of the GPS-721
module (e.g., Address, Baudrate, etc.) by the DCON Utility (refer to P8-1). (By defaults, the Address
(ID) is "1", Baudrate is "9600", and Checksum is "Disable".)

3. Please add "DCON" (Section 8.1) in the "I/O boards" window and fill in the proper settings (Port,
baud_rate, etc.).

4. Refer to Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\dmeo_gps721.zip) in the shipping CD and
view the program and descriptions.)

DS T2 ——————————————————— ————————————————————————————_——— el e e

3 — AT Mame | Type
Inzt_D_GPS7T2 t_ok ﬁ
I i EM  D_GPS721  Tok |
fime. ok Inst_D_GPS721 D_GPS72
i 2 |part Time_ok S . Inst_D_7005 D_7005
- Inst_D_7012_%2 D_7012_W
B 1 & ear | year Inst_D 7012 D 7012
sync yearl DINT
a8 | . Syno tarth |-maorth manth1 DiMT
dayl DINT
i gmt_hr JGMT_Hr Dy |clayt hourt DiMT
min DINT
>4 | armt_min - GhT_hin Har |-k sac] oiMT
Eat dd_0 long1 REAL
i . D0 Wtin|-min1 lati1 REAL
. sat_num DINT
= | Seclsect d0.0 BOOL
—o SYnc BOOL b’
= L Sat_Mum|-sat_num ¢ 3y
. ok Enumerated Data Twpes
| Location_ak ]
| Long|-longi
i Lati| Iati1 v

Ea3

» 4 ¥ | EBlocks Sow list Define | ENUM
4 ¥ | aps721 . ‘dariables

Input Parameters:

EN: Data type: BOOL. TRUE: enable it; FALSE: disable it.
Port: Data type: DINT. COM port number (can be 1 to 37, depends on PAC).
(*** Must use a constant value, cannot be a changed value. ***)
Addr: Data type: DINT. The Net-ID address of the module, can be 1 to 255.
(*** Must use a constant value, not a changed value ***)
Sync: Data type: BOOL. Set it as "TRUE" to enable auto time synchronization (note: It will

work only when the "Time_ok" is also set to "TRUE"). If the time gap between the
GPS-721 and the PAC is 5 seconds (or more), it will automatically correct the PAC time.
Set it as "FALSE" to disable this function.
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GMT_Hr & GMT_Min:
Data type: DINT. The time difference between local time and GMT (Greenwich
Mean Time). For example, Beijing and Taipei are +8 hours (GMT_Hr=8, GMT_Min=0),
United States is -6 hours (GMT_ Hr= -6, GMT_MIin=0), and India is +5.5 hours
(GMT_Hr=5, GMT_Min=30).

DOO: Data type: BOOL. The Digital output channel of the GPS-721 module.

Output Parameters:

Tok: Data type: BOOL. _
2.Port Time_aok ']
TRUE: The communication of GPS-721
. T4 Addr Year |-year! = 2015
is normal.
K S e =41 Mot | mantht =&
FALSE: The communication of GPS-721 o= ewn Day | eyt =15
is failed. And all the following T P el pourt < 18
output values are invalid.
] [alei] tdinfmint = 558
Seclsec! =45

Time_ok: Data type: BOOL.
TRUE: Now, the values of Year, Month,
Day, Hour, Min and Sec are valid. el @ '

Sat_Mum|-sat_num =&

Long|lonai = 25.0116

FALSE: Now, the values of Year, Month,
Day, Hour, Min and Sec are invalid.

Lati|-lati1 = 121.4738

(i.e., an error or non-real-time value.)

Note: Each day from 23:59:00 to 00:00:59 (2 minutes), the "Time_ok" will be set as "FALSE"
automatically and the time synchronization will not be processed.

Year: Data type: DINT. Year ( 2009 ~ ...).
Month: Data type: DINT. Month (1 ~ 12).
Day: Data type: DINT. Day (1 ~ 31).
Hour: Data type: DINT. Hour (0 ~ 23).
Min: Data type: DINT. Minute (0 ~ 59).
Sec: Data type: DINT. Second (0 ~ 59).

Sat_Num: Data type: DINT. The number of used satellites.
(0: no satellites can be found. Or, using 1 ~ 9 satellites)

Location_ok: Data type: BOOL.
FALSE: Now, the values of "Long" and "Lati" are invalid (i.e., an error or non-real-time
value.)
TRUE: The GPS-721 has got the current longitude and latitude location.
(Only when "Location_ok" is set to "TRUE", the values of "Long" and "Lati" are valid. )

Long: Data type: REAL. Longitude (positive value: East ; negative value: West).
(For example, "25.0121" means 25.0121 degrees.)
Lati: Data type: REAL. Latitude (positive value: North ; negative value: South).

(For example, "121.4576" means 121.4576 degrees.)
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Chapter 9 On Line Change

"On Line Change" function allows Win-GRAF PAC change its project to a modified one during the PAC
running time. The modified project must be the same name as the original one that currently running on
the PAC.

"On Line Change" is primarily used for emergency, sometimes it can not disable or stop the project
running on PAC or unavailable to update new project, especially, the system needs 24 hours operation
and can not suspended. Except these cases, it is not recommended to use this function! You had better
to stop the running project, and then download the modified one to the PAC (refer to Section 2.3.5),
which is the safe way.

Application 1
(A little modified)

'oo,-

Win-GRAF

Application 1
(Original)

(u

9.1 Limitations of "On Line Change"

A Please notice the important limitations before enabling the "On Line Change"!

When On Line change is enabled, you can perform on the fly the following kinds of changes:

® Change the code of a program.
® Change the condition of a SFC transition or the actions of a SFC step.

4 )

Step Action

Transitions =—f— Transition 1 =t Transition 2 \

Sequential Function
Chart (SFC)

Step Step

- J

® Create, rename or delete global and local variables.

® Create, rename or delete global and local function block instances.
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Workspace
54 Test | 36
[+ Exception programs * Inst_BLINK ouT1
[ Programs
!

= il RUN BLINK Q-
-4 Watch [for debuagin... ‘ e T#2s JCYCLE

“B] Main
p
B8 Soft Scope o

=4 Initial values

MName | Type | Dim. | Attib.
=] Main

Inst_BLINK1  blink

£ {2} Global variables

_del_SW1 BOOL Deleted
ouT1 BOOL

SWW2 BOOL Added

The following kinds of changes are not allowed:

® Create, delete or rename a program. (It will appear a warning message if delete a program.)

2 Test
& POU cannot be deleted with On Line Change active. Do-you want to disable it? Bl Exception programs
e . [ Programs
b B ] =
L= - ) [ i ] ¥ hain

Change SFC charts.

Change the local parameters and variables of a UDFB.

Change the type or dimension (or string length) of a variable or function block instance.
Change the set of 1/0 boards.

Change the definition of RETAIN variables.

In addition, the following programming features that are not safe during a change should not be used:

® Pulse (P or N) contacts and coils (edge detection).

25 Instead, you must use declared instances of R_TRIG and F_TRIG function blocks.

Rising Pulse Detection

Before Enable After Enable

o S Inst_R_TRIG
P CLKR_TRIG) G
(False > True)
ouT Inst_R_TRIG QUT1
P I CLKR_TRIG o |

Decreased Pulse Detection

ET S Inst_F_TRIG
N [CLKF TRIG) )
(True > False)
oum nst_F_TRIG OUTH
W I CLK F_TRIG @ |

® Loops in FBD with no declared variable linked.

25 You need to explicitly insert a variable in the loop.
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9.2 Using "On Line Change"

Enable The "On Line Change" Function:

1. Mouse click "Project > Settings..." from the menu bar, then double click "On Line Change" item to set

it "Enabled".

™ Win GRAF - Test

File Edit ¥Yiew [Insert B&mEE® Tool: Wmdow Help

& =% & . [ Enild All Projects F7
Workspace Clean Al Projects
- Test = Download All Projects. .

I ----- 1 Exception pre o

-3 Proorams

0jé sething

C:\Win-GRAF\ProjectsiTest

§1 Name | Yalue I
Egpnt;;r:l.'; s Communication parameters 192.168.71.18:502
[ & :
{ Debuaging ¥ Cycle time 0
Advanced @ Code Generation Helease
(Al P P N P TR D
on v 4uwum5m3—
Libraries Edit..
Use external objects Edit.

Double click to disable or enable and configure On Line Change
capabilities,

Cancel

2. Click "Project > Build All Projects" from the menu bar. Must compile the program first, then can set

up the following steps.

{7 Win-GRAF - Test

S o A NRe AR 5 R |
\ VX
oject [ : ’ ng Narme | Type | Dim
— ; - ouT1 || {a} Global variables »
Enild ATl Projects F? e @ - 1 SW1 BOOL a
Clean Al Projects OUT1 EOOL G
*= Download ATl Projects.. T2 Jovee | i) ¥
settings. . e - ~
\ / [ [Used)
- - 7 [d (Project)
29 Global defines i | I 5B Advaniced ~
ta} Variables (SRl > 14 % | Blocks . Soulist | Define | Er{UEA
B Types |[S¥ ] varisbles | Main,
Build X||
I'f
Building application data... A
< 9BOOL/SINT; OINT; 1 DINT/REAL; O LINT/LREAL; 3 TIME; 1 STRING; - CRC = 1102ac76 >
[ On Line Change not possible: too many variables
hielocating code... This message can be ignored when just
< Code CRC=a8ccd42ek - File CRC=feal1925 - Size=1832 > .
enable On Line Change.
[€ %] Buitd /" Crossreferences | Runtime | Callstack | Breskpoints | Diaitalsamplinatiaoe | Prompt | il
JReady Offline 192,168, ?1 18 502 A 0,90 692 x 18 0,0
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Setup the Number of Variables:
When the "On Line Change" is enabled, you have to set up the number of variables reserved for the

declaration of the new variables and Function Blocks for future on-line change usage.

3. The same as the step 1, mouse click "Project > Settings..." from the menu bar, then double click on
the "On Line Change" to show the setting window.
Please set the needed new number in the “Value" or “Margin" fields.
Note: If both “Value" and “Margin" have set values, it will use the larger value. In this example,
"Value" is set as "30" and “Margin" is set as "10", then the displayed value x 10% is smaller
than 30, so it will use the larger value "30".

4. Click the needed Variable Type, then click the "Set” button.
(E.g., Click "BOOL/SINT variables" and "Set" button, then the number become 9 + 30 = 39.)
Note: "STRING buffers (characters)", "FB instance data (bytes — approx.)" and "Complex variables
segment (bytes) " need to set a larger number (This example uses "5000").

5. After setting (as the picture below), click the "X" in the upper right corner to exit the setting.

On Line Change On Line Change

Current Status Current Status

ENABLED ENABLED

Number of variables allocated Number of variables allocated

4
(e ]

BDDLI“HNT wariables g ] BOOL/SINT variables | 9739
tMFrarattes = INT variables These 3 Types | 1431
DINT/REAL variables 240 DINT/REAL variables need la rger \ 2432
LINT/LREAL variables 140 LINT/LREAL variables I | 1431
TIME variables 210 TIME variables values. | o2
| Active timers 0/0 |Active timers 0730
|STRING variables 240 |STRING variables 2432
STRING buffers [characters) 1740 |_ STRING buffers [characters) 17 260171 |
FB instances 340 FB instances 3433
FB instance data (bytes - approx.) 3240 | |FB instance data (bytes - approx.] 3275032/ |
Published variables 0/0 Published variables 0730
‘ Complex variales segment [bytes) 0/0 Il Complex vanales seament [bytes] U 45000 J
iF‘DUs 540 iF‘DUs 5735

Numbers displayed: Used / Allocated
Displayed "used' numbers are according to the last build

Allocate: O Value r3|j Allocate: O Value 5000
G%atgin () |10 ] %axgin () |10
\ S

Numbers displayed: Used / Allocated
Displayed "used" numbers are according to the last build

N

6. Click "Project > Build All Projects" from the menu bar, compile the program again. Then click “On

Line” or click the tool icon Al to link to the

Tools Window Help

PAC. (Refer to Section 2.3.5.)

T Build Al Projects &% % € @R e (5 E
' Clean All Projects
1
%5 Download All Projects... /t
. OuT1

Settings. .. | I
P Cans
m2 Simulate F5

Win-GRAF User Manual,

V2.0, Aug.2020 by ICP DAS 9-4



7. After successfully link to the PAC, click the tool icon "Download changes" to download the program
to the PAC.

Note: "On Line Change" is only suitable for the program that just has a little change (Do not need
to stop the application). If the program name is different from the running one on the PAC,
the user has to stop and download the program again (refer to Appendix B).

\/
L

, s % A E sy o A WE@gE o

(L i [Download changes-ﬁ—mx
E: A ? MName REE T Type
|| o Inst_BLINK OUT1 = TRUE || @ ] Main A
i R1 RUN BLINK G O | | B £} Global vanables
3 SV / BC
=1 T#2s JCYCLE OUT1 TR é._IE BC
,- gy 3
A ElE ) -
5 [ ([Used) =
" ol @ |J Projgett ™
’IS | _ >_ ]< >, _Blocks Sov Ilst A ng_ir_\ﬁg__:,;: ENUR -
<y

Vanables . Main~

8. Click on the tool icon "Do On Line change" to execute the program.

Note: After executing the "On Line Change", there are some using restrictions for protecting the
system normal operation (refer to Section 9.1). So, make sure the program is correct, then
perform this function.

File Edit View Insert Project Tools Window Help

e e e I %6 A R g (5 %/ @ RUN P4 r{q ) % @
Workspace '1-II-[Main] Tit % X
P Test [RUN] . . .

= 12 A7 Name Type
[+ Exception programs o o TRUE = 5 & ] Main o
£ Programs E R1 RUN BLINK. @ = fa} Global variables
-] Main SW1 BC
[ Watch [for debuggin... ||+ | T#2s {CYCLE ouT1 TRUE BCw
.48 Soft Scope L < i ¥
: -:3 Initial values 3 ‘—t_:l [Ali] o e
: ?_!9 Binding Configuration B C3 (Used) 5
: g Global defines s Fa (Proiect] - =
B} Variables | g 8 i > | Blocks ~ Sovlist | Define | ENUM
C BB Types {4 %] varisbles | main.” |
Build %

| Build in progress... Please Wait...
Noeror detected
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Chapter 10 Data/Type Conversion and Using the PAC Time

10.1 Al Data Conversion

If you are using Al modules in the PAC's Slot 0 to 7 (for example: I-8017HW), and want to convert the Al
input signal (for example: "4 to 20 mA" or "0 to 10 V") to the user engineering value (for example: 0 to
10000), refer to Section 4.3. However, if you are using the remote Al modules (e.g., through PAC's
RS-485 Port to connect to the 1-87017ZW or I-7017R module), you can refer to the following settings:

Win-GRAF PAC
. I-87K4 1/0 Expansion Unit
COMx: RS-485
S— I-7017R +1-87017ZW
Data - — Data - — Data - —

1. First, connect "i_scale" in the "I/O Boards" window, and double click on "i_scale_x" to open the
Properties window (refer to Section 4.2 for detail steps)
Note: "I/O Boards" supports ONLY ONE "i_scale" (DO NOT connect 2 or more "i_scale").

2. Set up the number and value of the Conversion Function that need to be enabled.
(E.g., Use Function 1 to convert "4 to 20 mA" into "0 to 10000").

Ch01_X0_Min_Physical_Val: “4.0”
Ch01_X1_Max_Physical_Val: “20.0”
Ch01_YO_Engineering_Val_For_X0: “0.0”
Ch01_Y1 Engineering_Val_For_X1: “10000.0”

§EEE 170 Boards E - i scale - Proper 1——~——__q"
[Key=6
{Ref = 16#24 -
{ChO0_X0_reserved =0.0
ChD[I " X1 reserved = 00
Chl][l Y1 _reserved = 00
‘ChOl X0 _Min_Physical Yal=40
|ChD1_X1 Hax _Physical_¥al =200
\Ch01_ Y0 Er gineering ¥al For X0=00
rineering Yal For X1=00

‘Chﬂz _X0_Min Phymal Yal=00 ChO1_¥1 Engineering ¥al For X1
|{Ch02_X1_Max_Physical_Yal=00 ;
‘Ch02 {1 Engmeen.ng_?al For_X0=00
|Ch02 Y1 E Yal For X1=00
IChU3_AU_Min | ym:al Yal=UU
Ch03 Xl Hax Physu:al Yal 0o

scale

Bl scale 0

— 1 iscale 1 i scale o

N
2 | _scale 2

Setup the scaling function No. 01 to 29 for scaling /0 variables .

— ) | | — | —t
=lwinl—=io ]’_“_’T“(DGJ‘HJO)U'DAWI\J—‘D

Notice:

1. If setting both value of Ch_X0 and Ch_X1 to 0.0, it means the relative scaling function No. is d

2. [ Ch_X0 is greater than or equal to Ch_X1, the setting is wrong. ¥
1‘ ( | ) o
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3. Edit an ST Program to convert a physical value (e.g., Phy_V[0] to [7]) to an engineering value
(e.g., Eng_V[0] to [7]). (Refer to Section 2.3.3 for detail setting steps.)

45 (* ii is declared as DINT A | Name 4| Type | Dim. | At
1 Phy V is declared as REAL array with Dim 8 ;1 = ] 8T1 {*Data Conversion™) A
1 Eng V is declared as REAL array with Dim 8 ii DINT
IF + -
na Phy REAL 0.7]
= o5 01 5% 6 88 9 &8 7Eng_\/ .REAL [0..7]
o 5 {ay Global variables
_A (* Using conversion function 1 to convert a ouT1 BOOL v
5 physical valuean to an engineering value ¥) £ [ >
Eng V[ii] := Convert to Eng (1, Phy V[ii]]): "‘,:{: ca AN ~
end_for: | (*iiis declared as DINT variable :
&l Phy_V is declared as REAL array with Dim. =8 —

{4 5| waiabies | masd Eng_Vis declared as REAL array with Dim.=8  *)
forii:=0to 7 do

(* Using conversion function 1 to convert a physical value to an engineering value *)
Eng_VI[ii] := Convert_to_Eng (1, Phy_VI[ii]);

end_for;

10.2 AO Data Conversion

If you are using AO modules in the PAC's Slot 0 to 7 (for example: 1-8024W), and want to convert the
engineering value to the AO output signal (e.g., convert "0 to 20000" to "0 to 10 V"), refer to Section 4.4.
However, if you are using the DCON remote AO modules (e.g., through PAC's RS-485 Port to connect to
the I-7024 module), you can view following settings:

1. Connect "i_scale" in the "I/O Boards" window, and double click "i_scale_x" to open the Properties

window (refer to Section 10.1 for detail steps)
Note: "I/O Boards" supports ONLY ONE "i_scale" (DO NOT connect 2 or more "i_scale").

iE8E 170 Boards

0
1
2 1 yelect
3
4 Delate
5
6
7
g l Properties l
9 i scale
1 i scale 1
2 iscae 2 Mave Lip
10
11 Move Down
12
13 | Help l
14
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2. Set up the number and value of the Conversion Function (e.g., use Function 2 to convert "0 to 20000"
to"Oto 10 V").

9.0: i_scale - Properties X

Key=6

Eif] = 16%2& Ch02_XO0_Min_Physical_Val is set as “0.0”.

T e Ch02_X1_Max_Physical_Val is set as “10.0”.

ChO0_Y0 _reserved =0.00 ; i ; “0 0”
ChOO Y1 reserved =00 ChOZ_YO_Eng!neer!ng_VaI_For_XO !s set as “0.0”.
Ch01_X0_Min_Physical ¥al| Ch02_Y1 Engineering_Val_For_X1 is set as “20000.0".
Ch01_X1_ Max_ Physical Yal

Chl]l_YO Engmeenng_al or_X0=00

Chl]2 Xl _Max_ Physical Yal-= 10.0
Ch02_Y0_Engineering_¥al For X0=00
~Chl]2 "Y1 Engineering_Yal For X1 =20000.0
=uu

Ch03_X1_Max_Physical_¥Yal=00

(£

3. Edit an ST Program to convert an engineering value to a physical value (e.g., Eng_V[0] to [7]).
(Refer to Section 2.3.3 for detail setting steps.)

5T1* B VX

4o (% ii is declared as DINT A7 Name 4| Type | Dim. | &ty

a Phy ¥V is declared as REAL array with Dim & .’_i‘ = [ 8T {*Data Conversion®) s
1 Eng V is declared as REAL array with Dim 8 i DINT

IF * -

nen Phy V REAL [0.7]

=  for ii := 0 to 7 do Eng_V REAL 0.7

o B {ay Global variables

__ (* Using conversion function 2 to convert an ouT1 BOOL v

"m’ engineering value to a physical wvalues *) < il S

o] Phy V[ii] := Convert_to_ Phy (2, Eng V[ii]): : u (A1) ":\

end_tor:l («jjjis declared as DINT variable. "

&5 i) Phy_V is declared as REAL array with Dim. =8 B

'Ql‘ wariables | M{  Eng_V is declared as REAL array with Dim. = 8 *)

forii:=0to 7 do
(* Using conversion function 2 to convert an engineering value to a physical value *)
Phy_VI[ii] := Convert_to_Phy (2, Eng_VIii]);

end_for;
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10.3 Data Type Conversion

When different types of data want to do "+, -, *, /" calculation or ">, <, =, <=, > =, <> (not equal)"

operation, or when the variable types of the parameters in the function are different, you must first use

the type conversion function (in the following table) to convert them into the same data type, then can

use the data normally.

Data Conversion . L. Data Conversion .
. Descriptions . Descriptions
Functions Functions
ANY_TO_BOOL | Convert to Boolean ANY_TO_REAL Convert to Real
ANY_TO_SINT Convert to Short Integer (8-bit) [ ANY_TO_LREAL Convert to Double
ANY_TO_INT Convert to Integer (16-bit) ANY_TO_STRING [Convert to String
Convert to Lone Integer Convert Number to String.
ANY_TO_DINT . g \nteg NUM_TO_STRING |Can set the decimal digital
(32-bit — Default) .
number after converting
ANY_TO_LINT | Convert to Long Integer (64-bit) | ATOH Convert Hexadecimal
String to Integer
. Convert Integer to
ANY_TO_TIME Convert to Timer HTOA . .
Hexadecimal String

For example, the following ST program will convert the DINT variable to a Real first, and then do the
calculation.

REAL_Val_1 := ANY_TO_REAL (DINT Val_1) *3.5+4.8;

You can open the "HTML Help" from the menu bar, and enter the key word to search the needed
information.

>

-5 By 5

&% Topics RERE =ik -§F . BEHEd¥ ER

Q| Search  mso [ #20 || smREo |

Tuborials > S RESITE D
% About type conversion - v :J
Lapguage... FIHEREL) B0
SERTERE (D) B3l Tl

#E e VB |
Type conversion functions - 1 3
ANY_TO_BOOL IECE1131-3 2
ANY_TO_DINT AANY_TO_U..\IEC £1131-3 3
ANY_TO_INT £ ANY_TO_UINT IECE1131-3 4
ANY_TO_LINT IECE1131-3 5
ANY_TO_LREAL IECE1131-3 B
ANY_TO_REAL IECE1131-3 7
ANY_TO_TIME IECE1131-3 8
ANY_TO_SINT IECE1131-3 9
Programming lanquages - Refe... IEC 61131-3 10
ANY_TO_STRING IECE1131-3 11
NUM_TD_STRING IECE1131-3 12
BCD_TO_BIN IECE1131-3 13
BIN_TO_BCD IECE1131-3 14
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10.4 BCD Conversion

BCD 4-bit code is used to represent decimal numbers from 0 to 9. Suppose there is a decimal value
"132", if converted to BCD code is "000100110010" and if converted to binary is 10000100 (e.g., 27 + 2?=
128 + 4 =132).

Decimal ¥ zzBCD21 >0 Description
0 0 0 0 0|0
1 0 0 0 1 |2°=1 NOTE:
2 0 0 1 0 [2'=2 BCD code can only represent
3 0| 0| 1| 1 |2t+2°=3 numbers from 0 to 9.
4 0 1 0 0 | 22=4 It can not be used for these six
5 0 1 0 1 | 22420=5 values (1010, 1011, 1100, 1101,
6 0 1 1 0 |22+2'=6 1110, 1111), and will return "0".
7 0 1 1 1 [22+21+20=7
8 1 0 0 0 [23=38
9 1 0 0 1 |23+2°=9

The function table below can be used for BCD (Binary Coded Decimal) value conversion.

Type Con\.lersmn Description
Function

BIN _TO_BCD Convert Binary to BCD value
BCD_TO_BIN Convert BCD value to Binary

BIN _TO_BCD: SW2 = TRUE OUT1 = TRUE
19(10)= 0001 1001 scp) | | EBIN_TO_BCD .. |

=24+2%3+2°=16+8+1=25

M1 = 191 @l =25

BCD_TO_BIN: S = TRUE QLTY = TRUE
33(10)= 0010 0001 2) = 21(scp) | 1 EBCD_TO_BIN . |

15(10)= 0000 3331, = O(ecp)

IMNZ =33 I o) G2 =21

e et b o oo

menu bar, and enter the key word to search

the related information. pgg _ﬁg : E;g 58

nao( #2 |

S50 AN SRR

@ Topics
|
Q,  Search - LJ
_ FHEBL) BTD)
Tutorialz » 5 ;
: BEEED: k3. 3 i
B About.. | @5 s IEFF |
BCD_TO_BIN IECE1131-3 1
Lapguage. .. Type conversion functions IECE1131-3 2
BIN_TO_BCD IEC 61131-3 3
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10.5 Pack/Unpack Integer or Boolean

Unpack Integer to Boolean:

If want to unpack one BYTE (or USINT, range: 0 to 255) to 8 Booleans, you can use "UNPACK8" Function
Block.

Inst_UMNPACKS Bool_0 Inst_URPACKS
___________________________________________ ENUNPACKS... | EnUNRACKS . |
Bioal_1
_____________________ DSINT_1 Hin il ' LISINT_1 = 1281 1 '
Bool_2
GZ 1 (:!2 X
Bool_3
Bool_4
o 1 a4 .
Boal_5
5 ] a5 .
Bool_&
(8 ] Q6 .
Bool_7
[T ] arF .

If want to unpack one SINT to 8 Booleans, you must first use the ST program "ANY_TO_BYTE ()" to
convert the SINT to be a BYTE type, as follows:

Iri=t_UMPACHS Bool_0
En URIPACKE @i |
Bioal_1
AR TO BYTE(SINT Wal 1) D o '
Bioal_2
Q2 '
Boal_3
ok '
Raanany Bool_4
ot .
Boal_5
Q15 '
Boal_&
QI '
Boal_7
17 | ]

Pack Boolean Into Integer:

If want to pack 8 Booleans into one BYTE (or USINT, range: 0 to 255), you can use "PACK8" Function.

ST Program:

USINT_1 := PACKS8 (Bool_0, I Bool_1, Bool_2, Bool_3, Bool_4, Bool_5, Bool_6, Bool_7);
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LD Program:

Baal_0 ouT
IND PACHS Eno |
Baaol_1
- [N a|-ushT 1
Bool_2
= N2 Bool_0 = TRUE OUTH = TRUE
11
Boal_3 I1 N0 PACKS Eno
Y I3 Biool_1 = TRUE
Boal_4 ] i @] USINT_1 =15
Y thid Boal_2 = TRUE
Bool_5 O [
e e @ Bool_3 = TRUE
Baal_B ] ]z
— MG
Baal_7 L [
[ M7
v s
g
(e

If want to pack 8 Booleans into one SINT, you must assign a "BYTE" variable to the output(Q) to save the
value temporary, and use a "ANY_TO_SINT" Function to convert BYTE into SINT type, as follows:

Biool_0
0] PACHS Eno N En AMNY_TO_SIMT Eno

Bionl_1 "]
[ e L] G| Temp_BYTE Temp_BYTE I G SIMT WAL 1
Biool_2
[ T —— L
Bool_3
[ T —— L
Bool_4 oo
[ L
Bool_5
[ T — L]
Bool_&
B e INE
Bool _7
B | INT

Note: If the compiling fails, please click "Project" > "Settings" from the menu bar to check if the setting
of "Complex variables in a separate segment" in the "Runtime" is "Yes".

1
Oje P 1L

CWin-GRAFProjectsi Test
General Mame | Walue
L EE Runtime spstem Little endian

Compiler -
Debugging W Cycle time 1]
Advanced &F Code Generation Release
(Al % Exchange 10z while stepping ez

2 Sunnort eariables locking I

[ [il« Comples variables in a separate segment Y'es ]
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10.6 Pack/Unpack BYTE, WORD, DWORD

Pack Two 8-bit Data into One 16-bit Data

If want to pack 2 BYTE (or USINT) into one WORD (or UINT), you can use a "MAKEWORD" Function.

ST Program:

WORD_VAL_1 := MAKEWORD (Hi_byte, Lo_byte);

LD/FBD Program:

En MARENORD Eno En WMAKEAORD Eno
Hi_byte JHi alworRD val 1 |:> Hi_byte = 0|1 G WIORD WAL 1 =128
Lo_byte L Lo_byte =128 R

| MAKEWORD
Hi byte=128 I: ! @ WORD VAL 1= 32768
Lo ByieE=10 =

If want to pack 2 SINT into one INT, you must first use an ST program "ANY_TO_BYTE ()" to convert SINT
into BYTE, and then use an "ANY_TO_INT" Function to convert the packed WORD into INT type.

/\
En MAKBWORD Eno n ARy _TO_MT  E

O+

HI — @ Temp_woRD Temp_woRD {in T Al 1

BN _TO_BY TECSINT _Hi)

M _TO_BYTECSIMT_Lo)-{L

Unpack One 16-bit Data to Two 8-bit Data

If want to unpack one WORD (or UINT) to 2 Byte (or USINT), you can use "HIBYTE", "LOBYTE" Functions.

ST Program:

Hi_byte := HIBYTE (WORD_VAL_1);
Lo_byte := LOBYTE (WORD_VAL_1);
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LD/FBD Program:

En HEVIE  Emo En  HBYIE  Eno

WORD_WaL_1 i o af Hi_byte CWORD_vaL 1 = 32767 JrD e @
En LOBVTE  Emo En LOBYIE  Eno

WORD_VAL 1 i m afLo_pyte WORD_VAL_1 = 32767 JrD o @

HIBYTE
WORD WAL 1 i iy Hi byte

LOBYTE
WORD WAL 1 pid iy Lo byte

If want to unpack one INT to 2 SINT, you must first use an ST program "ANY_TO_WORD()" to convert INT
into WORD, and then use an "ANY_TO_SINT" Function to convert the unpacked BYTE into SINT type.

En HIE TE Eno En BNY_TO_SIMT  Eno
[annnnnsf O+
ANY_TOWORDIMT VAL 17 N ol Temp_BYTE Temp_BvTE al s _Hi
En LOBYTE Eno En BNY_TO_SIMT  Eno
oM O
ANY_TOWORDANT _vaL 131 ol Temp_EvTE Temp_BYTE N o] ST Lo

Pack Two 16-bit Data into One 32-bit Data

If want to pack 2 WORD (or UINT) into a DWORD (or UDINT), you can use a "MAKEDWORD" Functions.

ST Program:

DWORD_VAL_1 := MAKEDWORD (Hi_word, Lo_word);

LD/FBD Program:

En MAKECWMORD Eno

Hi_word JHI o} DWioRD_waL 1

Lo_weord JL

| W&k ECWIOR D
Hi word I: ! o DWORD Wal 1
Lo word =
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If want to pack 2 INT into 1 DINT, you must first use an ST program "ANY_TO_WORD()" to convert INT to
WORD, and then use an "ANY_TO_DINT" Function to convert the unpacked DWORD into DINT type.

En  MAKEDWORD Eno ER_ &MY _TO_DINT _Pno
O—i
ANY_TO_WORDHI_nt1 A - o Temp_mwoRD Temp_DwORD i @ DINT _waL 1

ARl _TOWORDLo_int)

L

Unpack One 32-bit Data to Two 16-bit Data

If want to unpack one DWORD (or UDINT) to 2 WORD (or UINT), you can use "HIWORD", "LOWORD"
Function Blocks.

ST Program:

Hi_word := HIWORD (DWORD_VAL_1);
Lo_word := LOWORD (DWORD_VAL_1);

LD/FBD Program:

En  HMYORD Eno

(AENRRNE|
DWORD_WaL 1 i @ Hi_word

En LOWORD Eno

[nRnnREn|
DDRD Wl 4w Gf-Lo_weord
HIWORD
CWORD WAL 1 i iy Hi word
LOWORD
DWORD WAL 1 vl Gy Lo word

If want to unpack one DINT to 2 INT, you must first use an ST program "ANY_TO_DWORD()" to convert
DINT to DWORD, and then use an "ANY_TO_INT" FB to convert the unpacked WORD into INT type.

En HWCRD Eno Er\___ ANT_TO_NT _Ano
oM O
AR _TO_DWORD(DINT _AL_1) h | Temp_woRD Temp_WoRD {in | Hi_int
En LOWWORD Eno En BEF_TO_INT Eno
annnnni} O—wis
AR _TO_DWWORDDIMT _aLl_13 @ Temp_WoRD Temp_WoRD Jin & Lo_int
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10.7 Unpack Variable to Byte Array or Pack Byte Array into Variable

"SerializeOut" Function can unpack a Win-GRAF Variable value to a Byte Array (or USINT Array);
"Serializeln" Function can pack a Byte Array (or USINT Array) into a Win-GRAF Variable value.

Note: 1. The Dim. of Array must be set as at least "8".
2. This "Serialize" Function can not use the STRING variable.

You can open the "HTML Help" from the menu bar, and enter the key word to search the related
information.

E? HTML Help
& Topis.. g ¢ , A
Q Searh. mEEE 9% - 0 EFEA ER
Tuprisls b | mso [ 220 | smeso | _
% About.. SR AKIES TS (I '
Language... sefializeout - : : v 3
Pl EEL)
EEERE(D): I = 2 ——
| B oy (=
Senalizeliut IEC B1131-3 1 K
Advanced operations IECE1131-3 2
Serializeln IECE1131-3 3

If the SerializeOut() and Serializeln() return "0", it means the saving location is wrong or the Array’s
space is not enough.

Note:
(* Declare TMP_DINT as a DINT, Data Type Byte
buf as a BYTE Array, Dim. = 10, BOOL, SINT, USINT, BYTE 1
DINT_Val as a DINT, INT, UINT, WORD 2
Word_Val as a WORE' DINT, UDINT, DWORD, REAL 4
REAL_Val as a REAL *) LINT, LREAL 3

Example 1

(* To unpack one DINT_Val to 4 Bytes, and save them separately to the buf[2], buf[3], buf[4] and buf[5]
from the location 2 of the BYTE Array in the "Little Endian" sequence. *)

TMP_DINT := SerializeOut (buf, DINT_Val, 2, FALSE) ;

Note: The last parameter is "FALSE", that means to use the "Little Endian" sequence (To save the Low
Byte to the starting address).
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Example 2

(* To unpack one Word_Val to 2 Bytes, and save them separately to the buf[0] and buf[1] from the
location 0 of the BYTE Array in the "Big Endian" sequence. *)

TMP_DINT := SerializeOut (buf, Word_Val, 0, TRUE) ;

Note: The last parameter is "TRUE", that means to use the "Big Endian" sequence (To save the High
Byte to the starting address).
Example 3

(* To pack the buf[0], buf[1] , buf[2] and buf[3] in the BYTE Array into one REAL_Val in the "Little
Endian" sequence. *)

TMP_DINT := Serializeln (buf, REAL_Val, O, FALSE) ;

Note: The last parameter is "FALSE", that means to use the "Little Endian" sequence (To save the Low
Byte to the starting address).

Example 4
(* To map one DINT_Val to one REAL_Val in the "Little Endian" sequence. *)

TMP_DINT :
TMP_DINT :

SerializeOut (buf, DINT _Val, O, FALSE) ;
Serializeln (buf, REAL_Val, O, FALSE) ;
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10.8 Get/Set the PAC Time

If you want to get the current time of a Win-GRAF PAC, you can use a "TIME_GET" Function Block.
(Refer to Section 2.2.1)

:w: |

Currert time of the...
Year |-PAC _Year
Morith |- PAC_Maorth
PAC_Year, PAC_Month,
Dy |-PAC_Day
< PAC_Day, PAC_WeekDay,
Dy | PAC_WisskDay PAC_Hour, PAC_Minute,
PAC_Second are declared as
Hawr |-PAC _Haour DINT
Minute |-PAC_Minute
Second|-FPAC_Second

If want to adjust the Win-GRAF PAC time, you can use "TIME_SET" Function Block. (Refer to Section

2.3.6) First, fill the new time to the variables of "new_Year", "new_Month", "new_Day",

n.n

"new_WeekDay",
"TRUE" one time.

new_Hour", "new_Minute" and "new_Second", then set the "Set_new_time" to

Zet TRUE to zet new time

Set_new_time Inst_TIME_SET
Set  TIME_SET e |
niewy time for the Pac
new_Year | Year
Set_new_time is declared as BOOL
niesy _hornith | darth
new_Year, new_Month, new_Day, - .
new_WeekDay, new_Hour,
. nesee_Day JDay
new_Minute, new_Second are
declared as DINT new Hour JHour
neyy _inute hinute
new _Second 4 Secaond

Set TRUE to =et newy time
Set_new_time
R |
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Chapter 11 Commonly Used Tools and Useful Tips

11.1 Upgrade Win-GRAF Libraries

Users can download the latest version of Win-GRAF libraries (Win-GRAF Lib, e.g., "win-graf-lib-x.xx.zip")
from https://www.icpdas.com/en/download/show.php?num=695

The Win-GRAF Libraries (Including Function, Function Block and |I/O Board definitions) are saved in the
folder of “ICP DAS - XP-WP-VP” under the directory of “C:\Win-GRAF\DATA\HWDEF”. In some situations,
you need to upgrade the Win-GRAF Libraries to the new version for supporting more Functions or new
I/O Board. Please follow the steps below:

1. First, close all Win-GRAF Workbench windows. BRE REE WRO BHEEw > 4
- » >
Ot~ Q ¥ R
2. You can compress the original “ICP DAS - XP-WP-VP” e - =
folder and back it up to the other directory (e.g., HELD O C*WW}'C*R“‘D“*T&E“DEF I/ v|
D:\temp\xxx.zip), and then delete the folder. DNP3 Ermbedded Ethemet Files 2
HMI Powerlink
3. Copy the new “ICP DAS - XP-WP-VP” folder into the /' /’
directory “C:\Win-GRAF\DATA\HWDEF”, and
Maths Miscellaneous

execute the Win-GRAF Workbench again.

Note: / — .J

Delete the folder after back up. QEF

If you want to know the version number of the

Win-GRAF library. As the figure below, open the = 3 :
"Library Manager" and click "A_Version" in the "I/Os" /l /I /l /’
tab, and then click "Description" to check the version Regstors:  ‘Rogigs  Selectorss  Stondend: |8

number (e.g., "1.01").

M Win-GRAF | G Libravies
fj Google Chrome > l_t_@ Handbook
@) ICPDAS vl 2] History
(4) Outlook Express () Manual
@ Mozilla Firefox ] ResdMe
iy B B O opern1s Wi Win-GRAF

»I m OEM

mEEA® b

I.rihm.Ur Manage
IS Tool:  Wizard

Save Library !

|ICP DAS - XP-WP-VP Lo K
Counters -~

[T Library Manager - ICP DAS —EF-WP-¥F

NOT connectit . #)

r°1 1T AT

f the Libray "ICP DAS - XP-UP-¥P" is| 1.01 .

DMF3 B
Embedded HiI

Ethermet Powerlink,

Files

ICF DAS - sFP-wWE-WF

IE| .
=DIP_: swm:h (* 8-Ch DVl from the D11:| switch of PAC *)

I AT O AT A T 3 21 A8 T A4 ITIT T Ao 2T

The wersion numbe

|

HiRNN

This "A Wersion™ is only for identification . Rezat Changes
The PAC 's Win-GRAF driwer can not recognize it.
DO HOT connect this "4 Version™ in the Win-GRAF project.

v

Jul. 25,2014 -
ICPF DAS , Taiwan

| £
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11.2 Upgrade Win-GRAF Driver

For updating add-on functions, I/O boards or other purposes, ICP DAS will release a new version of
Win-GRAF drivers in the future. Users can get the latest driver on the website
https://www.icpdas.com/en/download/show.php?num=695 and follow the steps below to upgrade the
new driver into the PAC.

Note: The Win-GRAF Driver of the XPAC (XP-8xx8-CE6), WinPAC (WP-8xx8, WP-8x28-CE7, WP-9x28-CE7,
and WP-5xx8-CE7) and ViewPAC (VP-x2x8-CE7) will be placed in the directory \System_Disk\Win-GRAF\"
inside the PAC.

1. On the desktop of a PAC (use WP-8xx8 in this example), double click on the "Win-GRAF_WP_8000"
icon and then click "End Driver" to stop the currently running driver.

S

@ Win-GRAF-WP-8000 [oK]
Internet

Explorer

WP-Bxx2 driver Version 1.01 , Jun.06,2014

This product is icensed.

wordPad

#|V virtual cE (B troso 2 2

2. On the PC, copy the new driver into the PAC's directory “\Temp\” by using FTP method.
3. Onthe PAC, copy the new driver from “\Temp\” into “\the System_Disk\Win-GRAF\” directory to
replace the old one, and then reboot the PAC.

#BUE(D] 'Sy stem_Diskywin-graf

License.bin %] Quicker.dl t5.cod |=]t5. Lpd:

M8 in_GRAF_WP_8000.exe  MEwin_GR&F_WP_SOOOURk 77
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11.3 Spy List

When a program is running, the Spy List lets users quickly know the variable’s value or status.
Sometimes, a program may declare hundreds or thousands of variables, users do not need to look for
them, just simply switch to the pre-created Spy List window to view the wanted information.

Steps:

1. Right-click on the project name (e.g., "Demo01") and select "Insert New Item".
2. Select "Spy List" of the "Watch", then click "Next" to the next step.

3. Then, key in a list name (e.g., "NewSpy1") and press "OK".

Communication Parameters...

7 A OnLine

e Simulate
SRR R i
; o 5 Montor {4 Insert New Item
- 1Fe| )
» .ﬁ] |" = et Hew Folex Categories: Available Ttems:
T l‘ (3 Insert New Program... () e
P %3 E » Insert HMI Device... PrDgane S RETE—
R Shorteuts Resources @ Graphics

“Ggly | Embedded HMI &8 soft Scope

£y v Insext New Ihem...\ Shortcuts

| (— Others
a .

I‘ Next! !I Cancel |

( ENewSpyl 2 ° ’
| i
L J

I OK%[ Cancel ]

Name

Description
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4. Double click "NewSpy1" on the left side to open the setting window and drag the variables you want

to put into the window.

Workspace | ewspytspte . EEX
= Demo01 | Name | Value | Description W _Hame | Type | Dim. | &
[ Exception programs g _‘f PAC_Year Current time of the PAC & {a} Global variables A
[ Programs . PAC_Month PAC Year DINT
o6 PAC_Time (*Get/SetP.. || H¥  PAC Day PAC_Maonth DINT
.5 LD1 [*Blinking®) PAC_WeekDay WK PAC_Day DINT =
(-2 Watch (for debuaging) P&C_Hour S ~ PAC WeekDay  DINT
j o 48 Soft Scope P&C_Minute Se PAGSHour DINT
- 8] NewStucture PAC_Second SS o _PAC Minute DINT
o B3 Initial values = INT_Val S ~=——=-="] PAC Second  DINT
S ; [ REAL_Val INT_Wal INT [0.2]
% NewSpyl w REAL al REAL [0.3] |
B4 Binding Configuration N\ i€ | || B
" 3 Global defines [€ %] b1] Pac Time | ‘ariables | MewSpyl”
5. When the Win-GRAF and the PAC are connected, the "NewSpy1" window will show the variables
information clearly.
File Edit ¥View Insert Project Tools Window Help
0 IR AN TR TURIEE il T S e ST SN I, <N £ /P V2008 O 1 U B Pgrae w e @
— %X
= [ Demo01 [RUN] | il Name | Value Description | { ¥ Name | Value | Type | Dim. | Attrib.
e | Exception programs B PAC_Year 2014 Current time of the PAC = (&} Global variables o
=1 Programs | PAC_Month 6 PAC Year 2014  DINT
© L) PAC Time [Get/SetP.. || B4  PAC Day 13 PAC_Month 6 DINT
“ LD1 [Blinking") PAC_WeskDay 5 PAC_Day 13 DINT
[ Watch [for debugging) PAC_Hour 5 PAC WeekDay & DINT
. L3R SoftScope PAC_Minute 13 PAC_Hour 5 DINT
78] NewStructure PAC_Second 0 PAC_Minute 13 DINT
Co 2] Initial values ] INT_Val PAC_Second 0 DINT L
“o 28 NewRecipel ‘ INT_val[0] 55 INT_Wal INT 0.2]
o Eewspt | INT_vall] 36 REAL_Val REAL  [0.3]
; %3 Binding Configuration [ INT_Val[2] 100 new_Year 0 DINT
g Global defines = REAL Val new_honth 0 DINT
Y Variables REAL_Val0] 58 new _Day 0 DINT
BB Types REAL Val[l] 96 new_Hour 0 DINT
REAL_Val[2] 32 new_Minute 0 DINT =
REAL_Val[3] 25 <‘T"" o"“"““"‘: & JRIKET, 5
[€ %] D1 PAC Tme | Varisbles | NewSpvl
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11.4 Backup/Restore a Win-GRAF Project

Back up A Win-GRAF Project:
1. Mouse right-click on the project name (e.g., "Demo01") and select "Save Project" and then "To Disk".

Workspace
= DemoD1
WCef

up Project

l“] Progre Communication Parame| Insert New Item. . ‘
jg E 53! OnLine - ;Sgye Pm;ect ' Q To Disk... \
G- B3 Wate| "B Stmulate 75 Duplicate Project.. @& ToZin.
= Monitor & Print Project... &5 ToZipand Mail.
‘-] NewS 3 InsertNew Folder () Project Description... To Target...

)5_,1 Remove Project

2. Click on the "Browser" button to assign a directory you want to save the project (e.g.,
D:\Win-GRAF_demo_backup), fill in the project name (e.g., "Demo01_0613"), and then click "OK" to
back up the project.

% Save as

Current Project
C:A\Win-GRAFProjects\Demoll

Save as: [Proiect s

Destination: D:AWIn-GRAF_demo_backup

Project Name: Demol1_0613 » °

Restore A Win-GRAF Project:
1. Copy the previously backed up the project folder (e.g., "Demo01_0613") into
"C:\Win-GRAF\Projects".

| 4841023 DAWin-GRAF_demo_backup v
(=
Demnolll 0613
> I_‘ (£ CWin-GRAFProjects v
N

'/] Demo01 —
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2. Click the menu bar "File" > "Close Project List" to close all opened project windows.

I Win-GRAF - DemoO1
‘Eﬂn:-. dit View Insert Project Tool: Windowe Help
7 Hew Project List...

Cpen Project List k
Zave Project List k
‘57 Closs ProjestList W
N

3. Click the menu bar "File" > "Add Existing Project" > "From Disk", select the project you want (e.g.,
"Demo01_0613") in the "C:\Win-GRAF\" directory, and then click "OK" to restore the project.

[ Win-GRAF
Eile ’mv«; _loo]s Window Ee}p

ﬂ New Project List... | z-, {1l 2 % —
Open Project List >
Select project
5 Add New Project...
‘—f‘é’d Fxisting Eroject I:H@é‘ﬁrﬂqu . = () Projects Al
Print Setup... ‘ e F:omZip...I \ @ (&) Demol
- { F T SR} Demol] 0613
1 CAWin-GRAFProjectsiDemn01 w51 ‘ rom larget.. ) Default
2 CAWin-GRAFProjectsiTest w51 From XML Exp # () ICPDAS_template
- | ee—— @ () MTCP_M Ll
& 0 other
) Test
" E Tand N1 X
&G )] 8
(Erarrew )| [ W[ mE
AN i

[} Win-GRAF - Demo01_0613
File Edit View Insert Project Tools Window Help

A

b T |

L W& WO ARG B

7 P N B
Ho selection! | i /1.4

e

>PaT!

| Demo01_0613
[ ®Ceplion programs
E—] 4 Programs

- ) LD1 (Blinking?)

- oo [3) PAC_Time (Get..| B

) (23 Watch (for debuagi...

. /8¥ softScope

2o [rE) NewStucture

o 24 Initial values

< &d NewSpyl

.. Bd Binding Configuration

- 3g Global defines

G} Variables

o BB Types IPT] Build ~ Crossreferences | Runtime | Callsiaclg__,j Breakpoints | Diaitalsa
fready OffLine 192.168.71.19:502

Ai_
£
=
x»
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11.5 Software Reboot a PAC

Based on some cases, users may want to reboot the PAC in a software way. The Win-GRAF provides a
Function "PAC_Reboot" for users to restart the PAC.

Note: Please DO NOT call this Function in every PAC Cycle, or the PAC will reboot all the time.

Safety Coding:

(* "reset_PAC" is declared as BOOL and has initial "FALSE"
"TMP_BOOL" is declared as BOOL *)
(* ONLY when "reset_PAC" is set to "TRUE", the PAC will reboot *)

if reset_ PAC then
reset PAC o]

reset_PAC := FALSE ; PAC REBOCT I
TMP_BOOL := PAC_Reboot(); reset_PAC
end_if; R |

Dangerous Coding:

(* "TMP_BOOL" is declared as BOOL *)
(* Dangerous ! This coding method will let the PAC reboot always and cannot stop. *)
TMP_BOOL := PAC_Reboot();

If a mistake to reboot the PAC always, turns the rotary switch of the Win-GRAF PAC to "1" and reset it.
Then it will boot up in safe mode. Then you may rename the Win-GRAF application code on the PAC to
an invalid name. Then when the rotary switch is turned back to "0" and reboot, it will boot up normally
(No application). The Win-GRAF application code in the XP-8xx8-CE6, WP-9x28-CE7, WP-8x28-CE7,
WP-5xx8-CE7, and VP-x2x8-CE7 is "\System_Disk\Win-GRAF\t5.cod".
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11.6 Using ST Syntax in LD and FBD

The Win-GRAF Workbench allows users using simple ST syntax in Ladder (LD) and Function Block
Diagram (FBD) to facilitate programming. Before use, go to the menu bar "Project"> "Settings" >
"Runtime", and set the "Complex variables in a separate segment" to "Yes" to enable this function.

™ Win GRAF - Test

File Edit ¥iew [nsert B&mEa® Tool: Wmdow Help

S H== S : Euild 41l Projects F?
Workspace Clean A1 Projects
J Test += Download Al Projects ..

[ Exception prg :
" Proorams = \
et sething

CWin-GRAFProjects) Test
General M ame | Walue
L EE Runtime system Little endian
Cormpiler :
Debugging W Cycle time I
Advanced @ Code Generation Release
(Al % Exchange |0z while stepping ez
2 Support varables locking Mo
[ [il. Complex variables in a separate segment Y'es ]

Example:
LD Program:
Using division (REAL_VAL/25.5).
Boal_1
En = [o] I
( REAL_V.&.L.ES.S_@
759 Mz

FBD Program:
Call a function "ANY_TO_BYTE()" to convert the type from "SINT" to "BYTE".

mMAKEWORD
ANY_TO_EIY‘FE{SINLHi} +4-RHI Cr— WORD WAL 1
Lo bwyte L
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11.7 Apply a Recipe on the PAC

Some applications use the pre-defined Recipe and Value for processing different products, and this
Recipe can be mapped to a combination of variables within a Win-GRAF PAC. When one day want to
change the PAC process to produce a different product, you can use the Win-GRAF Workbench to
connect with the PAC and select a new Recipe you want to replace, and then apply it to the PAC.

Steps:
1. Mouse right-click on the project name (e.g., "Test") and select "Insert New Item"; then click on

"Watch" > "Recipe" and "Next" button, fill in the Recipe name (e.g., "NewRecipel") and then click

"OK".
Workspace
oient K'a Insert New Item
b 7 X
& | Communication Paramell  cateqories: Available Ttems:
7SI OnLine (al) Al Spuli
: | : Programs = i
B S mﬁ* s °
: s Resources
50w Monstox Embedded HMI &8 sSoft Scope
C o Shorteuts
F a 3 Insert New Folder Others
Q-E :; () Insert New Program...
- ggG »  Insert HMI Device...
v Shortcuts
e By T Insert New Iten... ®-

o
Properties @
( sNewRecipel 2 ° 1

T

MName

I

Description \l

[ Next%[ Cancel J

|  okwk ][ Cancel ]
N\

2. Double click "NewRecipel" on the left side to open the setting window and drag the variables you
want to put into the window.

| HewRecipe1.rep * X
B _J; Test ‘ij Name | Value ¥ Name | Type | Dim. | At
(i1 Exception programs E>_(5 W ater - {2} Global variables A
[} Programs = Soft_Flour YWater DINT
: < FBD1 =4 Suong.Flow Soft_Flour  DINT 8.
] Main CE saadol W Strang_Flour  DINT
v s1] ST1 (*Data Conversi.. B Cream S o Salad_oil DINT
- Watch [for debugging) g Egg ’Cream DINT
: &8 Soft Scope Cook_time 7 | Eog DINT
2 Initial values 1@ Plain_Flour Rl Cook_time TIME
& | w I=: Lemon_Juice Plain_Flour  DINT
o & NewSpyl | == Suger Lemon_Juice DINT
%3 Binding Configuratio | B¢ Suger DINT v
- 3 Global defines . 7.3 | 5
: '& Varables Z_(_’_] ariables | NewRecipel -
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3. Click on the "Insert Column" icon to add the new Recipe, and then fill in the suitable Values.

HewRecipel.rep *

g3 Mame | Value @el Pudding | Lemon Pw D 7 Mame | Type
’ Water 125 r2% = fat Global variables ~
| Soft_Flour 50 50 Water DINT
E' Strong_Flour 50 50 Soft_Flour DINT i
B Salad_oil 35 0 Strong_Flour  DINT
{ 8 Cream 40 40 Salad_oil DINT
: ¥E Eag 180 180 Cream DINT
| == Cook_time TH30mM TH25M Egy DINT
‘B4 Plain_Flour 0 0 Cook_time  TIME
=) Lemon_Juice 0 5 Plain_Flour — DINT
- Suger 100 25 Lemon_Juice DINT
B sal 2 1 Suger DINT
Salt DINT v
; < il ¥

l-; ;l ‘“ariables ;_ NewRecipel,

4. Click on the "On Line" button to connect the PAC. At first the Values are all "0", please select the
product column and then click the icon "Send Recipe" to apply this Recipe into the PAC.

Sl % G X

Workspace
& [ Test [RUN]

| Value

= MName

” - Exception programs 2% Water 1] 125 1 fat Global variables *~
& - Programs | = Soft_Flour 0 50 Water 0

- ] FED1 ‘ Strong_Flour 0 Soft_Flour 0

i (3] Main Salad_oil i Strong_Flour 0
_ s1] 5T1 [*Data Conversi... Creamn a Salad_oil 0
& [ Watch [for debugging) Ega 0 Cream 0

8 Soft Scope Cook_time Hi0s Egg 0
54 Initial values Plain_Flour 0 Cook_time t#0s
3 NewRecipel Lemon_Juice 0 Plain_Flour 0
i b NewSpyl Ovger | 0 U 2s Lemon_Juice O &
8§ Binding Configuration B sak I e il 2 B
[ 30 Blokl celries [ 2] varibies | NewRecipe1 B i

OO00 HewRecipel.recp

g3 Mame | Walue | Caramel Pudding | Lemon Pudding Fie

g A ater 125 125 125

E= Soft_Flour a0 a0 a0 Note:

o,  -tong Flourf 50 50 50 If users want to save the Values on

& Salad ol £ iE L the PAC, i.e., to retain the Recipe
o Eream :gn 1;] jgn values even if the PAC is powered
£ “ off or restarting. See Section 6.1.
Coaok_tirme H30m TH30k TH25M
Iﬂ Plain_Flaur 0 1] I}
=] Lemon_Juicel 0 1] A
® Suger 100 100 25
B sal 2 2 1
\_ J

|{ }l \-"ariahIEE,l Hew Recipel
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11.8 Get the Functions and Function Blocks that Supported by the PAC

In the Win-GRAF Workbench window, expand the "All" directory in the "Blocks" panel to check quite a

lot of Functions and Function Blocks, however, some are not supported in the Win-GRAF PAC. The

following will show how to quickly get the Functions or Function Blocks that supported by the PAC.

{{ Win-GRAF - Demo01

File Edit ¥iew Insert Project Tools Window Help
4 X - #HOH&EWEe AR F %A
. )
PrOjeCt £ Le—=trTBoolean AND*)
Name R1: Get current time lHEn  TIME_GET  Eno|- 1% = (Multiply)
98] PAC| | t{ + (*Addition*
- PAC_ | ] Expand ( )
“.%58 LD1 (Blinking®) E Current time of the PAC "o %{ - (*Subtraction=)
- % -PAC_Year A” +7 =Divide*
1 Watch (for debugging) 5l Iz 7 (*Divide™)
i @8 Soft Scope ! i %{ 1 (*copy (1 gain)*
& P D|rectory (*copy (1 gain)*)
rg) NewStructure T | PAC_Month t{ < (*Less than?)
=4 Initial values e | o 1% <= [(*Less or equal*)
=4 NewRecipel T 2% <> [*Is not equal*)
& NewSpyl —i | PAC_Day 1% =(*Is equal?)
: %3 Binding Configuration o 1% > (*Greater than)
g Global defines - PAC_\WeekDay 1% >=(*Greater or equal*)
) Variables = - 2% >> [1LJ.K] (*Put array item ...
B Types = 2% >> [1J] (*Put amrray item (2 ...
= | -PAC_Hour %4 >> [I] (*Put array item (1 d...
+7 x =
= IlBlOCkS” % [LJK]>> [(*Get arra:v item ...
paC Miite 2% [1LJ1>> (*Get array item (2...
5 = Panel £ [1]>> (*Get array item (1 d...
1} ABS (*Absolute value™)
| | PAC_Second “v" [} ABSL [*Absolute value [LREAL)Y)
T ——— ™ xa i
|08 | > ovlist | Define | ENUR
[4.7] tb1]_PAC Time
Build X
lig }K Build Cross references A -Runtime { Callstack | Breakpoints | Digital samplinatrace | Frompt | HiI
JReady Offline 192.168.71.19:502 Z 0,0 233 x 18 0,0 165% @ &&

Setting Steps:

1. Make sure the PAC is powered on and connected with a PC via an Ethernet cable.

2.

In the Win-GRAF Workbench, right-click on the project name (e.g., "Demo01") and then select

"Configuration", and click on the "Upload" button in the "Select" tab to open the setting window.

Workspace

'PAC_Time
3 e <. 005

Right-click

Progr.

prameters. ..

] F @ OnLine

Bl e Simulate
Watc| 7
R s

K_lj Eemove Project

wilj Lock Project

@5 Euild Froject
Clean Project
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Select | Pescription | Data types | Standard | OEM
Configurations
{<Defsult-— | ([ Dmport ]

‘ Eemo

Click "Upload"
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3. Configure/Select the IP address of the PAC and click on "OK" button, the PAC will upload the
configuration file. Next, key in the file name (e.g., "test.cfg") and click "Save" to save the

configuration file.

Communication Settings

Upload the configuration

[_T 5 Runtime

|
192.168.255.1:502
192.168.71.18:502 | Help I

Setup the IP addr. of the PAC ‘

Configurations

i192.158.71.19;502 | E]

IUploading runtime configuration...

Please wait.

P ?X

B AFFIS @ | (9 CONFIG " v| &2 @
N\
§ Save file under C:\Win-GRAF\DATA\CONFIG
FRARI
FU
£ ¥
FASTIF
= Give the file name & save it.
FAVERS
Mo | I
w;% 848 M) Gstcfg ) vl [ ﬁaﬁ@)w
it — ) : N
RILOSH | AN Conlgumtion fes (*ofe) v A}

4. Back to the "Configurations" window, the configuration file (test) will show in the list, and then click

"OK" to leave this window.

Select | Description | Data types | Standard | OEM |

Configurations

Remove

S - T
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5. Inthe "Blocks" panel, the red Functions and Function Blocks are not supp

{74 Win-GRAF - Demo01

orted by this PAC.

EEX

File Edit ¥iew Insert Project Tools Window Help
N 0 TR N R S i SN M G A< T 315 O 2 BT M= 8
Workspace PAC Time X
= Demo01 ‘ ) Lad T+ DTHOUR [Get hours from time stamp®] A
Bl [ Exception programs " _\ T} DTMIN [*Get minutes from time stamp®)
(1~ Programs i R1: Get current time HEn TIME_GET  Eno 1} DTMONTH [*Get month from date sta...
L) PAC_Time *Get / Set. || 1} DTMS [Get miliseconds from time sta...
%38 LD1 [*Blinking®] = Currert time of the PAC 1} DTSEC [*Get seconds from time stamp...
=1+ Watch (for debugging) o Year|-PAC_Year T} DTYEAR [*Get year from date stamp®]
&8 Soft Scope E: 1} EEP_READ [*Read a value from the ...
7€) NewStructure ¥ Morith|-PAC_Month T} EEP_WRITE (*write a value to the E...
=4 Initial values =1 |
=4 NewRecipel - EPLNMT [*Send NMT command®) T
4 NewSpyl =l | Day|-PAC_Dal EPLREADARRAY (*Read an anay pa...
%3 Binding Configuration > Red means PAC EPLREADOBJECT [*Read a simple pa...
g Global defines - | whay| PAC_We does not Support_ EPLREADULINT [*Read a simple 64 b...
£} Variables 7 EPLWRITEARRBAY [“Write an array pa..
B Types e EPLWRITEDBJECT (*wite a simple ...
= Hour|-PAC_Hour N\ EPLWRITEULINT [“wiite a simple 64.,
ﬁ- 1} EXP (*Natural exponent®)
& MindtePAC. Minute T} EXPL [*Natural exponent (LREALJ)
B ” - T} EXPT (*Exponent¥)
Blocks” Panel £} F_AOPEN ("Dpen file in sppend mode”)
) | econd}-PAC_Sec F_CLOSE [*Close file*) .
RS - , 2l ] i
|47 to1] pAC Time -
‘Build X
[ 4 ¥ Build ' Crossreferences | Runtime | Callstack | Breskpoints | Diaitalsamplinatrace | Prompt | HMI~
JReady test OffLine 192.168.71.19:502 Z 0, -4302 263 x 18 0,0 165% 4%
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11.9 Upload the Win-GRAF Source Code

For some applications, users need to get the source code of the Win-GRAF project from the PAC to the
PC, this is called "Upload". This function can prevent the project source code from missing or incomplete
handover from the previous worker, you can still get the project source code inside the PAC.

Enable/Download The Project Source Code:
1. Click on the menu bar "Project" > "Settings" to open the setting window.

2. Double click on the "Download procedure" of the "Debugging" and select "Send source code for
later project upload", and then click "OK ".

T Win-GRAF - Test

File Edit View Insit BEEiies Tools Window Help

A" B=AR= R Emild 411 Projects 7
Workspace Clean A1 Frojects
S Test ¥ Download All Projects...

----- [ Exception pro -

i Bettings. .

[ Proarams

CUWin-GRAF ProjectsiTest

ngeneraI | Name | Value I
| Ruritime ) Communication parameters 132.168.71.13:502

. Advanced

(alh =] Always start simulator in 'cold start’ mode
A .

i Cycle time in microseconds during debug

| (=] Prompt beforel  [tems to be downloaded:

| 5] Propose to std s .
<Epplication code> | 0K

‘ ﬁj Log user actio

o .
| £ Show log file..
|

" Dpoublecicktocond | Note: When the "Upload" is enabled, Add...
dopnload; it means to store the source code on
the PAC. If someone gets this PAC, he
may have the opportunity to get your Miwe L
source code.

l [V]iSend source code for later project upload ]

3. Click on the menu bar "Project" > "Build All Projects" to compile the program, and then click on the

tool icon 2| to connect the PAC, and next, download the current project to the PAC. (Refer to
Section 2.3.5 for the detail steps). After downloading, the source code will be stored in the file of the
directory "\Systen_Disk\Win-GRAF\t5.upl" of the PAC. This file will be larger when the project
increases. If the project becomes very large and complex, the file size may reach several hundreds K
Bytes or even more than 1 MB.
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Upload the Porject Source Code:
Please close all opened Win-GRAF windows (Click on the menu bar "File" > "Close Project List").

4. Click on the menu bar "File" > "Add Existing Project" > "From Target", then select the PAC's IP
address and set up the upload file name (e.g., "UPL_project1"), and then click "OK" to upload the
file.

View Tools Window Help
i New Project List.. = | im0 4y
QOpen Project List »

5 Add New Project..

Add Existing Project | | @ FromDisk.
Print Setup... i&__}j From Zip...
1 CAWin-GRAFProjects\ Test w51 | Foom Target..

|

2 CAWin-§=
= D ;:?E Open project from target

i Select PAC IP
Settings

| T5 Runtime v |[132.168.71.13:502 4@
Pathnames -

Destination folder : | C:\Wwin-GRAF\Projects v || Browse.. |
Hame: lUPL_pr0|ect1 Set up the upload file name ‘
5. After uploading, click on "OK" button, and then the Win-GRAF will open the project automatically.

Open project from target

From: 192.168.71.19:502/5.upl
To: C:ADOCUME ~1%anice’\LOCALS 15T emphZIP103.tmp

[‘Clﬂ.ﬂlﬂ'ﬂlﬂlHlﬂﬂﬂl!lﬂ.!lﬂ.ﬂ.ﬂlﬂlﬂ'ﬂl!lﬂ-ﬂ.ﬂj

100%

[ Win-GRAF - UPL_projectl
File Edit View Insert Project Tools Window Help
B N TN N MO0 T e N R TR 0 16 3. W A VT <. iy ]}

Worksnas= ‘Ho selection! B%X

Qe I UPL_project]
g ephietroTograms

E! [ Programs

. 7 FBDT
lﬂ Main
" s7] ST1 [*Data Conversi...

- [ Watch [for debugging)

w2 Initial values

2 =4 NewRecipel

%} Binding Configuration e X
- ég Global defines
o} Variables
| B Types ([ € ¥] Build < Crossreferences | Runtime | Callstack | Ereskpoints |  Digitalsa
IReady, myl OffLine 192.168,71.19;502
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11.10 Set Up the PAC Password

In order to avoid the important program running on the PAC is changed or stopped by an unfriendly
connecting PC, you can set up a password for the PAC to prevent unauthorized operation.

1. Click on the menu bar "Project" > "Settings" to open the setting window.
2. Double click on the "Runtime password" of the "Compiler", set a password, and then click "OK".

Y Win-GRAF - Test

File Edit ¥iew Insrt BEEES Tools Window Help

S H=H &S L Euild ALl Projects F?
Workspace Clean 11 Frojects

S0 Test *=  Download Al Projects...

Sethngs...

-3 Programs

C:\Win-GRAF\ProjectsiTest

%General Name | Walue |
< 5 | &4 Check array bounds at runtime Yes ~

1 i ) B Allocate status flags for variables with embedded p... No
iAdvanced 2 Embed symbols of all variables No
(Al ' Keep case of embedded symbols No

[ Check multiple calls to FB instances No

3 Check duplicated profiles No

2 Enable forcing of initial values during debug No

G Update extern POUs before build Mo

3 Use global definition of extern POUs
bq Runtime password
"C" C post compiling

Password

Cancel

l [ Cancel

s password:
Set a password ‘

3. Click on the menu bar "Project" > "Build All Projects" to compile the program again, and then

download the current project to the PAC (Refer to Section 2.3.5 for detail steps.). When the next
time to click the "On Line" icon for connection, it will require the password.

%W e AR S (5 A

Password:

If click "On Line", it need the password.
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Note: After enabling the password, please remember your password, or you will not connect the PAC.

The Only Solution:

1. Connect the PAC with a USB mouse and screen.
2. Onthe PAC, execute the Win-GRAF Driver and then click on "End Driver" button.
(Refer to Section 11.2).

Win-GRAF-WP-8000

WP-BxxB8 driver Wersion 1,01, Jun.06,2014

This product is icensed.

3. Rename the file "t5.cod" in the directory "\System_Disk\win-graf" (e.g., "t5.cod1") or delete it. Then
reboot the PAC.

#FBUE(D \Systern_Disk win-graf
License.bin %] Quicker.dl t5.cod
e in_GRAF WP _B000, exe Wiﬂ_GR.&F_WF‘_BDDD."‘Ik

Then, it will become "No application" on the PAC. Now, you can connect and download the
application from the Win-GRAF Workbench again.

% € & E 5 (5 K osriaion D)
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11.11 Using Function Block in the ST Program

It is easy to use the Function in the ST program, just call the Function and assign the corresponding
parameters. The example below will open COM3 at the beginning, and then send a String "Hello* from

COM3 every 5 seconds.

(* Declare “INIT1” as BOOL and has initial value TRUE,
Declare “TMP_BOQ” as BOOL, “TMR1” as TIME *)

IF INIT1 THEN

INIT1 := FALSE;
TMR1 := THOs;
TSTART (TMR1);

END_IF;

IF COM_Status(3) = FALSE THEN
TMP_BOO := COM_open (3, 19200,N,8,1’) ;

END_IF;

IF TMR1 >= TH#5s THEN
TMR1 := THOs ;
COM_send_str (3, "Hello:’) ;

END_IF;

To use a Function Block in the ST, you must first declare an Instance Variable of the Function Block in the
variable region, after that, the using steps are similar to the steps of using the Function, as follows:

The following code can unpack one Byte to become 8 BOOLs:
1. Declare "MyUnpack" variable as "UNPACK8" (FB Instance) and "IN" variable as "BYTE".

Variables | /1.
W MNeme  [Type | Dim |Atb. | Syb |Initvale |U.. " |Tag | Desciipton
BRA] Global variables %
IN BYTE O ]
MyUnpack UNPACKS
< ‘ 1 >

2. Edit an ST program.

MyUnpack(IN) ;

Q0 := MyUnpack.QO ;
Ql := MyUnpack.Q1;
Q2 := MyUnpack.Q2 ;
Q3 := MyUnpack.Q3;
Q4 := MyUnpack.Q4 ;
Q5 := MyUnpack.Q5 ;
Q6 := MyUnpack.Q6 ;
Q7 := MyUnpack.Q7;
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11.12 How to Protect Your Win-GRAF Program to Avoid Unauthorized
Copied?

When you finish a Win-GRAF application development and prepare for delivery to the customer, please
think about the possibility that your Win-GRAF application on the PAC may will be copied into another
same model PAC?! Be careful! Someone else may steal your hard outcome! The following provides a
simple and easy way to protect your application.

Note: If you give the Win-GRAF application Source Code to the customer, then sorry, the following
method will not protect your program from stolen. Because having the Source Code, anyone can
modify the code and apply into another PAC.

Each ICP DAS Win-GRAF PAC has a Serial Number that has 8 Bytes (also known as 64-Bit), and each PAC
has the different and unique Serial Number. Therefore, you can use this serial number combine with
your own algorithm to generate a password, and pre-store this password on the PAC's file. Then, verify
this password in your application. If not passed, the application will not be allowed to execute.

The steps are as follows:

This example uses two Win-GRAF projects, one is "demo_passwd" used to generate a PAC password and
save it into the PAC's file; the other is "demo_my_ap" application that has been developed and ready to
ship to the customer. Before shipping a PAC to the customer, user needs to download the project
"demo_passwd" into the PAC and runs it once to generate a unique password for that PAC. Then,
downloads the project "demo_my_ap" into the same PAC, and then can ship the PAC to the customer.
After that, if someone copies the Win-GRAF application in this PAC to another same type of PAC and the
operation will fail because of the password validation failure.

There are two example projects (demo_passwd.zip and demo_my_ap.zip) in the shipment CD
(\Napdos\Win-GRAF\demo-project), please refer to Chapter 12 to restore the projects (Execute File >
Add Existing Project > From Zip) and set up the IP address of the current PAC.

[ Win-GRAF - demo_passwd =13
File Edit View Inert Project Tools Window Help
[ TS = T RN - W o HOils&ENWEe AR g & %A
Workspace Main % X
7 J) demo_passwd o INIT is declareds as BOOL and has initial walue TRUE. * A T‘YM
=3 i (f D?;;?tlozs in the first PAC cycle %) = G}Global variables
| THEN i then i INIT BOOL
- Watch (for dedNgging] || "= INIT := FALSE ; (* No more first cycle ) NO BINT
&8 Soft Scope o) NO_1 DINT
=4 Initial values = (* get the hardware serial nuder *) NO_2 DINT j
o "Bd NewSpyl PAC_SN{ No 0, No_1, No_2, No_3, No_4, No_5, No_6, No_7) Mo LT
S Q}é Binding Configuration .
.);g Global defines 3 (* Please use your own algorithm to generate a password B Varlables Area
¢ & Variables This example generate only one password. You may chas|| @
B Types : < | o ) > {4 %] Blocks / Sowlist | Define | E
[ £ > | Main " Newspy1 | Warisbles
‘Build X
i< »| Build ¢ " Cross references : RUIWW Digital sampling trace | Frompt | HMI
Ready %e 192.168.71.19@(? £ Llni,Chi 0x1 Lni, Chi 10(
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"demo_passwd" Project:

This program first uses "PAC_SN" Function to read out the Serial Number, and then uses a user-defined
algorithm to generate a password. Finally, save the password to an address within the PAC's file (user
can decide where you want to store).

Variable Declaration:

RS
- demo_passwd T Name | Type | Dim. | Attib. | Syb. | Initvalue | User.. | Tag | Description
-3 Exception programs ERAlGobal variables..............._ &
£+ Programs INIT BOOL [0 TRUE init as TRUE
P “B1] Main NO_O0 DINT J 8-byte hardware serial number
£ [ Watch (for debugging) NO_1 DINT O
-8 Soft Scope NO_2 DINT O
w28 Intial values NO_3 DINT O
% NewSpyl NO_4 DINT O 4
: NO_5 DINT |
NO B DINT O
NO 7 DINT ]
password DINT [l v
< >
[ 4 5] Main| Newspyi | Variables

ST Program:

(* This "demo_passwd" example will generate a password by the 8-Byte Serial Number of the PAC
and save it into the EEPROM of the PAC *)

(* Declare "No_0" ~ "No_7" and "password" variables as DINT.
Declare "INIT" variable as BOOL and has Initial value TRUE. *)

(* Operations in the first PAC Cycle *)
if INIT then
INIT := FALSE ; (* No more first cycle *)

(* Get the hardware serial number *)
PAC_SN(No_0,No_1,No_2,No_3,No_4,No_5, No_6,No_7);

(* Please use your own algorithm to generate a password. This example generate only one
password. You may change it to generate some passwords. *)
password := (No_0 * No_1) + (No_2 *12345) + No_3 + (No_4 * No_5)+No_6+No_7;

(* save the password in a file "my_product.pwd" in the \System_Disk\Win-GRAF *)
file_name := "\System_Disk\Win-GRAF\my_product.pwd';
file_id := f_wopen( file_name ) ;
if file_id =0 then
(* failed , do nothing *)
else
(* open file ok, save the password into it *)
fm_write( file_id , Any_to_String(password) ) ;
f _close( file_id ); (* close file *)
end_if;
end_if ;
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"demo_my_ap" Project:

This project first uses "PAC_SN" Function to read out the Serial Number, then calculates the password,
and then compares the password that read from the PAC's file to check if the password correct.

Workspace Miin X
-3 demo_my_ap :’Q A7 Name | Type | L
> i ‘ (* operations in the first PAC cycle *) | E i A
1 Exception programs ‘2. =) Global variables »
=P ‘ if INIT then -
grams [ INIT BOOL
-~ THEN =1 B
I ";jg LD2 i__ INIT := FALSE :; (* No more first cycle *) u mg—? g::‘TI'
E 1 Watch [for debuggi... 1 {_l_ {* get the hardware serial number *) NO_2 DINT =
&8 Soft Scope ‘I PAC SN( No 0, No 1, No 2, No 3, No 4, No 5, No 6, No <N0? NINT S
“o 2 Initial values b1/ = = = = = = = & =[] Al
L) NewSpyl "_ i {* Please use your own algorithm for the PAC password e ~
i fa Bindi 1 i PAC password:= (No O * No 1) + (No 2 * 12345) + No 3 = [ (Project .
: & Binding Configurati... s 5 s S A I
-39 Global defines (No_4 * No_5) + No_6 + No_7 : || @ [ Advanced
i

(a} Variables 2\l

B Types |4 3] Main /102 Newsoyt -

(Note: Refer to Section 2.1.2 to arrange the programs in the execution order.)

Variable Declaration:

Workspace Variables B WX
=¥ demo_my_ap T Name | Type | Dim. | Aftib. | Syb. | Initvalue | User.. | Tag | Descriplion
c:] | Exception progiams 1
=1+ Programs INIT BOOL [ TRUE init as TRUE
“1] Main NO_O DINT O 8-byte hardwara serial number
%A LD2 NO_1 DINT O
1=~ [ Walch (for debuggi... NO_2 DINT 0
! &8 Soft Scope NO_3 DINT 0
“o B4 Initial values NO_4 DINT (|
L Bd NewSpyl NO_5 DINT |
%3 Binding Configurati... NO_B DINT 0
=5 Global dem NO_7 DINT O 7
Ll Variable: password DINT |
B Types PAC_password DINT O
password_ok BOOL O TRUE: OK |, FALSE: fail
LED1 BOOL O for demo purpose only if password ok, blink per second
LED2 BOOL || g
< >

[ €3] v 2] Newsors | Variables.

ST Program - Main:

(* This "demo_my_ap" example can read the password from the EEPROM of the PAC, and check if
match with the result that calculated from the user’s own algorithm. *)

(* Declare "No_0" ~"No_7", "password" and "PAC_password" variables as DINT.
Declare "INIT" variable as BOOL and has initial value TRUE.
Declare "password_ok" variable as BOOL *)

(* Operations in the first PAC cycle *)
if INIT then
INIT := FALSE ; (* No more first cycle *)

(* get the hardware serial number *)
PAC_SN(No_0,No_1,No_2,No_3,No_4, No_5, No_6, No_7);
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(* Please use your own algorithm for the "PAC_password" value *)
PAC_password:= (No_0 * No_1) + (No_2 *12345)+ No_3+(No_4* No_5)+No 6+ No_7;

(* Read the password value from a file "my_product.pwd" in \System_Disk\Win-GRAF *)
file_name := "\System_disk\Win-GRAF\my_product.pwd';
file_id :=f_ropen( file_name ) ;
if file_id=0 then
(* can not open file, set password to 0 *)
password :=0;
else
(* open file ok, read the password *)
if f_eof(file_id) then
(* reach the end of file *)
else
(* hasn't reached the end of file , read a string form it *)
Tmp_string := fm_read( file_id ) ;
(* Convert a string to a DINT value *)
password := Any_to_DINT(Tmp_string) ;
end_if;
f close(file_id); (* close file *)
end_if;

(* check if the password is correct? *)
password_ok := FALSE ; (* setit as "FALSE" in the beginning *)
if password = PAC_password then

password_ok :=TRUE; (* the password is correct *)
end_if;

end_if;

LD Program — LD2

If the "password_ok" is “FALSE“, it means the password is incorrect, then will exit the program. Only

when the password is correct can the program execute continuously, and then your application can be
protected from the unauthorized access.

IEUE: i Fal SF fai
passward_ok
!

This example uses only one
"LD2" program, if your

RETLRM

for demo purposs onl... application as well as other
LEDT rograms, please add the
RUN  BLINK I programs, p _
"password_ok" checking code
nn LED2 for each program.

T#l=JCYICLE
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Chapter 12  Description of Win-GRAF Demo Projects

There are some demo projects in the Win-GRAF shipping CD (CD-ROM: \Napdos\Win-GRAF\
demo-project) which some of them will be introduced in the following sections.
Before using the demo projects, follow the steps below:

1. Click on the menu bar "File" > "Add Existing Project" > "From Zip" to open a project (e.g.,
"demo_tmrl.zip").

@iew Tools Window Help i

] New ProjectList... W LT (T A
Open Project List 4

_}1 Add New Project...

Add Existing Project | | @) FomDisk..
Print Setup... ' &_rg From Zip...
D)
Note! St sty [
Please close the current "project List" it %:emo_com_poﬁz@ CD-ROM:
. . . emo_com_portd zip . .

before restoring the demo projects in the “Ddermo,_tie1 zip \Napdos\Win-GRAF\demo-project
CD-ROM. (Click on the menu bar: "File" > “Ddemo_file2.zip

;gdemn_xetamzip

"Close Project List") m\
Qdem_ﬁnﬂ zip
F D) dermn_tmr3 zip

Win-GEAF - Demof1

Edit ¥iew Insrt Project Tools Window Help

Eml Wew Project List. F -
Open Froject List 8 B4 Q: \demo_tmr] zip v [@
Save Project List | [ BRELO [ () [ L) N
l"jj Clnss Project List l SHEAH)
- Destinaton folder: | C:\win GRAF\Projects v| [(Bromse..
Name: (demo_tmrl |

2. Double click "Main" to open the ST program, and can view/add variables in the variable area.
3. Mouse right-click on the project name (“demo_tmr1“), and select "Communication Parameters" to
set up the IP Address of your PAC. (Refer to Section 2.3.5)

[ Win-GRAF - demo_tmrl Q@
File Edit View Insert Project Tools Window Help
S B AT S N O e M ST = S £/ 0 2 (T & %
Iﬂor o Communication Settings
- = e S =
[ Exception programs Y et ~
: | ; = —— —UK =
£ 3 Progan B 1fSTi;$RT SERETTERR R,
Cotsyu o o BO0L
£ WK Tor debugging) | T o ia .| [F2187118502 == - STOP_tmr  BOOL
: &8 Soft Scope © = e [ Bowe ] RESET tmr BOOL
=4 Initial values x— {* set ST 1‘192:153:71_{3;502 ‘ LED1 BOOL
oo 6d NewSpyl [bEL if  STOP_| 1132.168.71.13:502 I ED2 BOOL v
%3 Binding Configuration = STOP_tr | | >
g Global defines " tStop (T u [AII} —
(o} Variables EHEL W8 ¢ 5 3 (Proiect) =2
v
- T T S T |
i a _ e < »| Blocks  Sovlist | Define | ENUL
| Build D
{4 %] Buitd " Crossreferences | Funtime | Callstaok | Breskpoints | Diaitalsamplinatizce | Promot | HMI
§Ready OffLine 192,168.71.18:502 Z Lni,Chi Ox1 Lni,Cht 100%
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12.1 The List of Demo Programs

The Win-GRAF product package includes a CD-ROM named Win-GRAF-PAC-CD, the user can find out
more information on Win-GRAF demo programs in the path - \Napdos\Win-GRAF\demo-project. Look

over the table below and to restore these projects to the Win-GRAF Workbench.

The following table shows the list of the demo programs:

File Name Description
Use the "tStart" and the "tStop" functions to operate the Timer
demo_tmrl .
- (refer to Section 12.2.1).
demo_tmr2 To do periodic operations for the Timer (refer to Section 12.2.2).
demo._tmr3 To do periodic operations more accurately for the Timer

(refer to Section 12.2.2).

demo_com_portl

Send a string by the COM Port (refer to Section 12.3.1).

demo_com_port2

Request/Anser the device by the COM Port (refer to Section 12.3.2).

demo_com_port3

Wait for data coming from the remote device to the COM Port
(refer to Section 12.3.3).

demo_com_port4

Report data periodically to the remote device by the COM Port
(refer to Section 12.3.4).

demo_filel

Write data to a file on the PAC (refer to Section 12.4.1).

demo_file2

Read data from a file on the PAC (refer to Section 12.4.2).

demo_retain

Use retain variables to save lately values before the PAC power failure
(refer to Section 6.1).

demo_wp5_retain

Use file to retain variable values (refer to Section 6.2).

demo_extra_port

Enable a serial port for connecting the Win-GRAF Workbench
(refer to appendix E).

demo_my_ap

demo_passwd

Protect your Win-GRAF program and avoid being embezzled
(refer to Section 11.12).

demo_XV310

demo_XV308 1

demo_XV308 2

demo_XVv308 3

demo_XV116

demo_XV111

demo_XV110

demo_XV107

Use an XV-Board in the WP-5xx8-CE7 (refer to Section 5.1.6 to 5.1.12).

demo_vb01

demo_vb02

demo_vb03

demo_vb04

Use VB.net 2008 programs to read/write Win-GRAF variables
(refer to Chapter 13).

demo_PID_simple

The PID and regulator applications.

demo_user_C

Develop your own Functions and Function Blocks (refer to Chapter 18).
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File Name

Description

demo_rdn_1

demo_rdn_2

demo_rdn_3

Redundant System (refer to Chapter 16).

demo_ET7060

Connect the remote ET-7060 Ethernet I/O module (refer to Section 5.2.2).

demo_ET7018z

Connect the remote ET-7018Z Ethernet I/O module (refer to Section 5.2.3).

DEMO_DL_100T485

Connect the remote DL-100T485 module to measure temperature and
humidity (refer to Section 8.2.7).

demo_schedule

Schedule control (refer to Chapter 17).

demo_d_7065 Connect the remote I-7065 1/O module (refer to Section 8.2.1).
demo_d_7018:z Connect the remote I-7018Z I/O module (refer to Section 8.2.2).
DEMO_D_7083 Connect the remote I-7083 I/0 module (refer to Section 8.2.3).
demo_8088w PWM Output (refer to Section 4.11).

DEMO_D_87084_FR

Connect the remote |1-87084W module to measure frequency
(refer to Section 8.2.4).

DEMO_D_87084_C4

DEMO_D_87084 _C8

Connect the remote I-87084W module to measure Counter
(refer to Section 8.2.5, 8.2.6 and 4.9).

demo_SMS

Use the 2G/3G GSM Modem to send/receive the text message
(refer to Chapter 21).

demo_send_file

Send a file via Ethernet or 3G wireless network from a PAC to a remote PC
(refer to Chapter 20).

demo_3G

3G wireless communication.
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12.2 Timer Operations

12.2.1 Start, Stop and Reset the Timer

Refer to P12-1 to open the project ("demo_tmrl.zip"), and can view/add variables in the variable area.

ST Program:

(* Declare “START_tmr”, “STOP_tmr”, “RESET_tmr”, “LED1”, “LED2” as BOOL
Declare “TMR1” as TIME *)
(* Set START_tmr as TRUE to start ticking Timer TMR1 *)

IF  START tmr THEN
START tmr := FALSE;
TSTART (TMR1);

END_IF;

(* Set STOP_tmr as TRUE to stop ticking Timer TMIR1 *)
IF STOP_tmr THEN
STOP_tmr := FALSE;
TSTOP (TMR1);
END_IF;

(* Set RESET_tmr as TRUE to reset TMR1 to a value T#0s *)
IF RESET_tmr THEN
RESET_tmr := FALSE;
TMR1 :=THOs ;
END_IF;

(* Let LED1, LED2 ON during TMR1 =3 ~ 10 second *)
LED1 := FALSE;
LED2 := FALSE;
IF (TMR1 >= T#3s)and (TMR1 <= T#10s) THEN

LED1 := TRUE;
LED2 := TRUE;
END_IF;

(* Reset TMR1 as 0 when reachs 15 second *)
IF TMR1 >= T#15s THEN
TMR1 := TH#Os;
END_IF;
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12.2.2 Periodic Operations
Refer to P12-1 to open the project ("demo_tmr2.zip"), and can view/add variables in the variable area.

Function "BLINK" plus Function Block "F_TRIG" can produce a Pulse TRUE at regular intervals, so it can
be applied in the periodic operations.

LD Program:
pulze
RUM  BLINK aHolk  F TRIG =] |
nn X
T#2S oy ieLE Type: BOOL
ST Program:

IF pulsel THEN
(* do periodic operations here *)

END_IF;

The "BLINK" and "F_TRIG" above will produce a Pulse TRUE every two seconds, but this method has a
drawback:

Pulsel

v

A

»
P«

2 Sec 2 Sec

If the interval time of the period is shorter (e.g., 100 ms per period or less; or the PAC Cycle Time is
larger, such as 20 ~ 50 ms, generally 3 ~ 15 ms), then the period operations will be inaccurate. For
example, to do a periodic operation every 50 ms, as compared to 250 ms or 2 seconds, the interval time
of 50 ms is very close to the PAC Cycle Time, if using Function Blocks "BLink" plus "F_TRIG", it is easy to
accumulate the output delay time, therefore the final operation time will become inaccurate.

O : Cycle time Delay: 5ms 10 ms ......
(3~ 15 ms) : :

Pulse

50ms 50ms Tolerance will increase.
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To improve the situation above, the following coding method will be more accurate:
(Tolerance will not increase.)

Refer to P12-1 to open the project ("demo_tmr3.zip"), and can view/add variables in the variable area.

ST Program:

(* Declare “INIT” as BOOL and has initial value TRUE
Declare “TMR1”, “TMR1_next” as TIME *)

IF INIT THEN
INIT := FALSE;
TMR1 := TH#Os;
TMR1_next := TMR1 + T#50 ms;
TSTART (TMR1);
END_IF;

When the timer reach T#23h59m59s999ms,
the value will overflow.
1 Therefore, please reset it automatically to

IF TMR1 >= TMR1_next THEN
IF TMR1 > T#10h THEN

TMR1 := THOs ; "0" after 10 or 18 hours.
TMR1_next := T#Os ;
END_IF;

TMR1_next := TMR1_next + T#50 ms;
(* Do periodic operations here *)

END_IF;
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12.2.3 Detect the Steady ON or Steady OFF Signal
"TON" Function Block can detect the steady "ON" signal. (Keeps "ON" for a minimum period of time.)

oUT_1

IM_1

PT: Programmed Time
ET: Elapsed Time

As the picture above, this function can detect the steady "ON" signal that keep at least 2 seconds.

ON ON

2 sec H H 2 sec
IN_1 < » < B

<

I ON 1 | ON 1

ouT_1

"TOF" Function Block can detect the steady "OFF" signal. (Keeps "OFF" for a minimum period of time.)
that can keep "OFF" for a period of time.

ouT_1

IN_1

Inzt_TOF ’
Il TOF 5]

T#3=PT

PT: Programmed Time
ET: Elapsed Time

As the picture above, this function can detect the steady "OFF" signal that keep at least 3 seconds.

ON ON
2 sec H H 2 sec
IN_1 < > < >
X 1 ON 1 ON 1
:
1
1
OouT_1 .
OFF u OFF ‘ ‘ \ OFF
IN_1 T ' T
I—————p! I—————p!
[ 1 [ 1
1 3sec 1 3sec |
OuT_1
OFF OFF OFF
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12.2.4 Keep Outputting ON for Some Time after Triggering

"TP" Function Block can keep outputting "ON" for some time after triggering (e.g., from OFF to ON).

IM_1 ouT_1

PT: Programmed Time
ET: Elapsed Time

As the picture above, after triggering, it can keep outputting "ON" signal for 10 seconds.

A
A\ 4

A
A\ 4

A
\ 4

10 sec 10 sec

10 sec

ON ON

ouT_1 U
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12.3 Operations of Serial Port Communication

Users can directly operate the serial port (e.g., RS-232, RS-485 or RS-422 Port) to achieve some specific
communication protocol. The following Functions can be used to directly operate the serial port.

Functions Description
COM_open Open a serial COM port.
COM_close Close a serial COM port.
COM_clear Clear the input buffer of a serial COM port.
COM _test Test if any data received in the input buffer of a serial COMM port.
COM_send Command a serial COM port to send 1~500 bytes.
COM_send_str Command a serial COM port to send a String.
COM._ recv Et‘eec;i\;ﬁ :f;:ef;(;g;_he input buffer of a serial COM port and save
COM_status Get the current status of a serial COM port.

Please refer to Section 1.2.3 to open the Library Manager and find the detail Function description.

Library Manager - ICP DAS - XP-WP-VP " [oX|

File Wizard Help

Function and FBs | '.-“.U;s I Profiles AS: I iyfpes:

(3COM_clear (* Clear the taput buffer of a serial COM port *) A
#COM _close (* Close a serial COM port )
#ICOM _open (* Open a serial COM port. Forex,, TMP_BOO = COM_open( 2, 9600,N,8,1') ; %)
#ICOM _recy (*Receive bytes form the tnput buffer of a serial COM port and save them in a byte acray *)
FICOM_send (* Command a serial COM port to send 1 ~ 500 bytes *)

HCOM_send _str (* Command a serial COM port to send & string *)

FICOM _test (* Test if any data received in the input buffer of & serial COMM. port #)

ol Avesnvd

At imvt a Dharrdand dnvmasd ialain dm an T cimamsmio o imlava #04

D escription l

| Parameter
COM_clear : Clear the input buffer of a serial COM port .

*#*% Function

*#*% Input parameters
Port : DINT : serial COMM. port number to open .
can be 1 to 37 (depends on PAC, means COM1 to COM37) .

#%% fJutput parameters
0 : BOOL :
TRUE : clear successfully.
FALSE : something wrong (for example, port number is incorrect).

Jun. 18,2014
ICP DAS , Taiwan
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12.3.1 Send a String by the COM Port

Refer to P12-1 to open the project ("demo_com_portl.zip"), and view/add variables in the variable

area.

ST Program: This program can send a String every 2 seconds by the PAC COM1 (parameters:
'9600,N,8,1°) (e.g., <CNT1=1>o0r<CNT1=25>).

(* Operations in the first PAC cycle *)

if INIT then Declare “INIT” as BOOL and has initial value TRUE;
INIT := FALSE ; (* No more first cycle *) “Port_OK” as BOOL ;
“CNT1” as DINT ;
CNT1:=0; “TMR1”, “TMR1_next” as TIME
TMR1 :=THOs ; “Port_number” as DINT and has initial value “1”
TMR1_next :=TMR1 + T#2s;

(* start ticking TMR1 *)
tStart(TMR1) ;
end_if ;

(* if the status of COM port becomes FALSE(not open), open it *)
if COM_Status(Port_number) = FALSE then

(* open a serial COM port *)

Port_OK := COM_open(Port_number, '9600,N,8,1' ) ;
end_if;

(* when time reached, ... *)
if TMR1 >=TMR1_next then

(* to prevent TMR1 overflow (means reach T#23h59m59s999ms) *)
if TMR1 > T#10h then

TMR1 := THOs ;
TMR1_next := T#Os ;
end_if;

(* Set new TMR1_next *)
TMR1_next := TMR1_next + T#2s;

(* Send a string from COM port *)
COM_send_str( Port_number, '<CNT1="'+ Any_to_STRING(CNT1) +'>');

(* reset CNT1 when reach 100 *)
CNT1:=CNT1+1;
if CNT1>=100 then
CNT1:=0;
end_if ;
end_if;
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12.3.2 Request/Answer the Device by the COM Port
If an application needs to use RS-232/485/422 Port to get the data from other devices, the steps are as

the following request and answer:

Win-GRAF PAC @ Device
1. Send a command to request the Device. 2. Check if receive a complete query?
» (If yes, reply an answer to the

3. Check if receive the complete reply? Win-GRAF PAC.)

(If yes, do the proper operations and e

wait for a while, and then return to 4., Wait for the next command,
the step 1 to send the next command.) @ and if receive a command

then go to the step 2.

Refer to P12-1 to open the project ("demo_com_port2.zip"), and view/add variables in the variable
area.

Note: Double click “Action” will first open a “Notes” window, then click “Action” icon to view the code.

ﬁwam»GRu - demo _com portZ

Fil: Edi? View Irsert Proect Tools Emdow Help — ) — —
W g Gy A X Zlo - % & WBE AR e & A
Workspace | I
-y demo_com_poit2 | Step:1 - Action
+ [ Excepticn programs ’ = | Aertion(P) : ol 1 bdain L
£ 3 Programs | k | - . [ ] = & Global variables
%) Main \: ( if port is not open, open 1(? ] Patt 0K BOOL
1--[8 Wach (for debugging) e e if COM status(Port_number) = FALJE Act.on NUMT DINT
T IR = P 2 2 DOUbIe C“Ck Port_OK := COM open(Port_nwmber, ' |
¥ SoftScope ﬁﬂ sna-4Eo ByteAry BYTE =
=3 Initial vales R % - Port_number DINT v
%4 Binding Configuraton E = i | End_iction : < | >
P daline: i) ) e —
a-rimrehdaine: B I Al o
- i} Varables + ‘ 7 o [Proiect =
T2 |—|| === gg3.T = Tgz50ms , H C [Proec
B e “j [ 4 Advenced
E. il T 3 # Zd Arithmetic
| % - \;;1 ’ @ 23 Anaps 1
o il ) [# _d AS-rterface
il ‘ [i1 1 BACnet
i ?— GS5.T »= IgZs ; [+ Booleans
E“’; | [ =@ CANbus
mj l il CéANopen
[E : &= 23 Clock
= ==l ¥\ [ 3 Comparisons __ o
= <] e[ | | |[€ %] Blocks  Soviist [ Define [ ENUL
!{ )‘. Main \ariables - B
] { »| Build  Crossreferences | Runtime |  Call stack Breakpants Digitalsamplinqtiace | Prompe | HMI
Ready CffLine 192.168.71,18:502 Al o,0 1x1 0,0 100% 44

You can click the “Variables” tag to open the Variables window.

Variables
T Name

| Type | Dim. | Attrib. | Syb. | Initvalue | User.. | Tag | Description

SRA] Global variables A
Pot OK  BOOL O
NUN1 DINT O 1
Bytelry BYTE [0..199] ] Byte Array, DINM=200
Port_number DINT £l 13 init as 3 v

@ j 3

[« ;_[ hain | Wariables %
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In this example, the Win-GRAF PAC sends a string 'QUESTION?' by COM3 to the device, and then wait for
the reply and does operations. After the operations, waits 2 seconds, and then sends the same
command 'QUESTION?', and repeated.

SFC Program:
( Declare "Port_OK" as BOOL; "NUM1" as DINT ; "ByteAry" asBYTE and Dim.="200";

“Port_number” as DINT and has initial value "3")

Action(P) :
l (* if port is not open, open it *)
1 if COM_status(Port_number) = FALSE then
Port_OK := COM_open(Port_number, '9600,N,8,1' ) ;
end_if; Ay N .
. (Open COM3 as "9600,N,8,1°)
End_Action;

——  Port_ OK ; (If succeeds, do the next.)

2
Action(P) :
(* Clear input buffer *) (In this example, clear input buffer of
3 COM_clear(Port_number) ; COMS3 first, and then send a
— (* Send 'QUESTION?' by COM3 *) command 'QUESTION?".)
COM_send_str(Port_number, 'QUESTION?' ) ;
End_Action;
(After sending query, wait for 250 ms to allow the device’ reply Bytes
R GS3.T >=TH#250ms ; . . :
4 are safely delivered to the Win-GRAF PAC. Do not set the time too
short, or cannot receive a full reply.)
Action(P) :
(* receive reply from COM3,max. 200 bytes in this example*)
5 NUM1 := COM_recv(Port_number, ByteAry, 0, 200) ;
L | (* do operations if protocols is correct *)
if NUM1 =10 then
(*...%)
end_if;
End_action;
. GS5.T >= TH? - K (Put the received Byte into ByteAry[]
6 K ’ and check if the number is correct?
\% (When done, wait 2 seconds and then It ye:,, d(') the opder:tlons the
1 return to the step 1 to send the next application needed.)

query command.)
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12.3.3 Wait for Data Coming from the Remote Device to the COM Port

This way is common in the general store or supermarket, such as using the barcode readers. After
reading the barcode of the product, it will send the barcode data to the Win-GRAF PAC's COM Port
(RS-232/485/422), and need not to reply any messages.

Win-GRAF PAC @ Device

2. If receives the complete data from device, < 1. After triggering, send data to
do operations. the Win-GRAF PAC
3. When done, wait for the next data coming.

Refer to P12-1 to open the project ("demo_com_port3.zip"), and view/add variables in the variable
area.

ST Program:
(* operations in first PAC cycle *) Declare "INIT" as BOOL and has initial value TRUE;
if INIT then "Port_OK" as BOOL ;
INIT := FALSE ; STEP1", "NUM1" as DINT ;
"T1" as TIME ;
T1:=THOs ; "ByteAry" as BYTE and Dim. = "200" ;
STEP1:=0; “Port_number” as DINT and has initial value "3".
end_if;

(* if port is not open, open it *)
if COM_status(Port_number) = FALSE then

Port_OK := COM_open( Port_number, '9600,N,8,1') ;
end_if;

(* If open port fail, exit this ST program *)
if Port_OK = FALSE then

return;
end_if;

CASE STEP1 OF

(* if there is at least 1 byte coming *)

0:
if COM_test(Port_number) then
STEP1:=1;
T1:= T#Os ; STEP1 = 0, means waiting, and will test if COM3 has data?
Tstart(T1) ; If returns TRUE, means COM3 has data.
end if ; Then set STEP1 to "1", T1 to "0" and start timing.
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(* wait 250 ms, then receive all bytes form COM port *)

L £ T1>= T#250ms then STEP = 1 means the data is sendi‘ng in, and will wait 250 ms
to receive all data and put them into an array. The waiting
Tstop(T1); time concerns the device specifications and the Baud Rate.
T1 :=THOs ; If set the time too short, may receive data incompleted.
STEP1:=0; Remember to set STEP1 to "0" to wait for the data coming
next time.
(* receive max. 200 bytes *)
NUM1 := COM_recv(Port_number , ByteAry, 0, 200);
(* do proper operations if protocol is correct,
here assume correct protocols has 25 bytes in this example*)
if NUM1 =25 then
(*...%)
end_if; When receive data, check if data is correct?
If yes, do the operations the application needed.
end_if ;
END_CASE ;
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12.3.4 Report Data Periodically to the Remote Device by the COM Port
If wants to periodically report data to other devices by RS-232/485/422 Port, do as follows.

Win-GRAF PAC Devi
B evice

—> Check if receive the complete
and correct data?
oo And then do proper operations.

Every period time (e.g., 5 sec), put the
data to be sent into array (Type: BYTE)
and send data by Function COM_send.

Refer to P12-1 to open the project ("demo_com_port4.zip"), and view/add variables in the variable
area.

SFC Program: (Refer to Section 12.3.2 to open the "Action" window.)

(Declare “Port_OK“as BOOL ; "TMP_DINT" as DINT ; "ByteAry" as BYTE and Dim. = 100 ;
“Port_number” as DINT and has an initial value "2".)

Action(P) :
' (* if port is not open, open it *)
1 | | if COM_status(Port_number) = FALSE then
Port_OK := COM_open( Port_number, '19200,E,8,2" ) ; (Open COM2 as “19200,E,8,2')
end_if;
End_Action;
R Port OK : (If succeeds, do the next.)
2 — 7
Action(P) : (The sent data concers with
(* prepare ByeAry[] to be sent *) your application, please
3 (*...*) use COM_send to send
(* Send it, here send 20 bytes *) data after the data is
TMP_DINT := COM_send(Port_number, ByteAry, 0, 20) ; ready. Max. 500 Bytes )
End_Action;
V\\
. GS3.T >= THSs ; (If wants to send String, can use the Function
4 COM_send_str(). Max. 255 Bytes, and can not
(After 5 seconds, has "0" in the Byte of the String, because "0"
return to the step 1 to means the end of the String, but it can be the
1 send the next data.) Character "0“.)
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12.4 Read/Write Data from/to a File on the PAC

The Win-GRAF Workbench provides the following Functions to enable sequential read/write operations
in disk files of the Win-GRAF PAC.

Functions Descriptions

Please click the menu bar "Help" > "Topics" and type the

searching key word “File” to view more information in the &g Iopiss. \
topic of the “File Management functions”. Q| Search...
Tutorials »
@ | About..
Langmage...
F_ROPEN Open/Create a file for reading.
Open/Create a file for writing.
F_WOPEN If the file doesn’t exist, it will be created automatically.
If the file exists, all its content will be removed.
F_AOPEN Create or open a file in append mode.
F_CLOSE Close an open file.
F_EOF Test if the end of file is reached in a file open for read.
FA_READ Read a DINT integer from a binary file.
FA_WRITE Write a DINT integer to a binary file.
FM_READ Read a STRING value from a text file
FM_WRITE Write a STRING value to a text file.
FB_READ Read binary data from a file.
FB_WRITE Write binary data to a file.
F_EXIST Test if a file exists.
F_GETSIZE Get the size of a file.
F_COPY Copy a file.
F_DELETE Remove a file.
F_RENAME Rename a file.
Refer to Section 1.2.3 to find the detailed descriptions for the following Functions.
F_dir Create a directory.
F cp._dir Copy all files i_n a dirsectory tq another directory.
(Include subdirectories and files). (Notel)
E del dir Delete a directory and all files inside it.
- - (Include subdirectories and files). (Notel)

Note: The Win-GRAF PAC of ICP DAS does not support Functions “F_SAVERETAIN” and

“F_LOADERETAIN".

Notel: Since the following PAC drivers support the "F_cp_dir" and the "F_del_dir" functions for
operating in sub-directories.

WP-8xx8 : v1.04, VP-x2x8-CE7 : v1.01, XP-8xx8-CE6 :v1.02, WP-5xx8-CE7: Released day.
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12.4.1 Write Data to a File on the PAC

Refer to P12-1 to open the project ("demo_filel.zip"), and can view/add variables in the variable area.

ST Program: This program can be used to write 10 "REAL" values to a file on the PAC.

(* This "demo_filel" project will save 10 REAL value to a file
in the \System_Disk\Real_datal.txt.

File Format :
Each row contains one REAL value and ends with <CR><LF> characters. Like:

1.08

2.786

38.45

41.5

59.875

60.76

71.23

80.5

99.8

100.7 *)

Because the size of \System_Disk\ is small,
(* Variables declaration: recommend you may change the directory to
Write_File : BOOL below (Depends on your application):

T tri : String, len=255 . ; i
mp_string ring, len WinPAC, ViewPAC Series:

File_ID : DINT \Micro_SD\ or
REAL_val[0..9] : REAL

ii : DINT XPAC Series:
File_Status :String, len=128 *) \System_Disk2\

(* Set Write_File as TRUE to write data to the file *)
if Write_File then

Write_File := FALSE ;
File_ID := F_Wopen( "\System_Disk\Real_datal.txt');

if File_ID=0 then
(* Can not open file in write mode *)
File_Status := 'Can not open file in write mode !';
else
(* open file in write mode ok, save REAL[0] ~ [9] to file,
each row contains 1 REAL value and end with <CR><LF> *)
File_Status := 'Open file ok.";

forii:=0to9 by1 do
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Tmp_string := Any_to_string( REAL_vallii] ) ;
FM_write( File_ID, Tmp_string ) ;
end_for;

If want to save data to Integer, use the code:
Tmp_string := Any_to_string( DINT_val[ii] ) ;
and declare Variable “DINT_val” as DINT and
Dim. at least "10" for this example.

(* close the file *)
F_close( File_ID ) ;

end_if;
end_if;

Test Program:
In this example, when the "Write_File" is set to "TRUE", the values will be written into the file

\System_Disk\Real _datal.txt on the PAC.

1. Please set up IP configurations (Refer to P12-1), compile and download the program to the PAC.
(Click on "Project" > "Build All Projects" / "On Line", if not familiar with the operation, refer to
Section 2.3.4, Section 2.3.5)

2. Click "NewSpy1" to open a Spy List and fill in the values to be written, and then set the "Write_File"
become "TRUE" to Write data. (If OK, "File_Status" will show "Open file ok".)

File Edit ¥iew Inse @ @w Help

e N E Y R L V)
Workspace il OO0 HewSpyt.spl
- I demo_file1 [RUN] | Bl Name | Description
:;;_ »[_J Exception programs ﬁ =1 REAL_val ———
{ %) Main B REAL_valll] | 39 . ‘
&1 3 Watch (for debugging) REAL_val2] | 27 4 TRUE W (1)

L. m Soft Scope REAL_vall3] | 55 AN

z : REAL val4] | 285 | FALSE Jtoy)
REAL_valls] | 3.42
REAL_val] | 20
- REAL_vall7] | 7.83
; T Variables REAL_wall8] | 3.69

Lo BB Types REAL_valla) \267_J i i
Wwiite_File F&LSE set TRUE to write data to the file

File_Status ‘Open file ok.'

(4 ¥ tain| MewsSpy1 ” Variables

3. Onthe PAC, open the file "Real_datal.txt" to check values you filled in the step 2.

| BRE) WEE) HRAW) BEQ |
@ v P XU O Taxe #e8E wRy) B30 TAD| & H

. @W 1.23

(=7 Drivers 3.9
(-9 External_device_driver 27
[~ ISAGRAF 5 5
lf_j tools 9 8 5
I Win-GRAF 3 432

£] Backup_Real_1.txt 3
[Tl GetPacName.exe
[&penmount ush_touch_v2010052¢ 783

3.89
%] testfl.txt k 2.67
£] woarking_Int.txt
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12.4.2 Read Data from a File on the PAC

Refer to P12-1 to open the project ("demo_file2.zip"), and can view/add variables in the variable area.

ST Program: This program can be used to read 10 "REAL" values from a file on the PAC.

(* this "demo_file2" project will read 10 REAL value from a file
in the \System_Disk\Real_data2.txt .
File format :
Each row contains one REAL value and ends with <CR><LF> characters. Like:
1.08
2.786
38.45
41.5
59.875
60.76
71.23
80.5
99.8
100.7

¥)
(*

Variables Declaration:

Write_File : BOOL
Tmp_string  : String, len=255
File_ID : DINT
REAL_val[0..9] : REAL
ii : DINT
File_path : String, len = 128, initial val = '\System_Disk\Real_data2.txt'
File_Status  :String, len=128
*
) \ Because the size of \System_Disk\

is small, recommend you amy
change the directory to below
(Depends on your application):

(* Set Read_File as TRUE to read data from the file *)
if Read_File then

Read_File := FALSE ; WinPAC, ViewPAC Series:
(* Check if file exists *) \Micro_SD\ or
if F_exist( File_path ) = FALSE then
(* file doesn't exist *) XPAC Series:
File_Status :='File "' + File_path +"" does not exist !'; \System_Disk2\
else

(* file does exist , open it in read mode *)
File_ID := F_Ropen( File_path );

if File_ID=0 then

(* open file in read mode fail *)

File_status := 'Can not open File "' + File_path +'" I';
else
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(* open file in read mode ok, read REAL[0] ~ [9] from file,

each row contains 1 REAL value and end with <CR><LF> *)
File_status := 'Open File "' + File_path +'" Ok .";
forii:=0to9 by1 do

(* test if the end of file is reached in a file open for read *)
if F_EOF(File_ID) then

(* reach the end of file, exit "for loop" *)

exit ;
end_if;

(* read one row in the file as a string *)
Tmp_string := FM_READ( File_ID ) ;

(* convert the string to become REAL value *)
REAL_vallii] := Any_to_REAL( Tmp_string ) ;

N

end_for;
If want to read Integer, use the code below:

(* close the file *) DINT_vall[ii] := Any_to_DINT( Tmp_string ) ;

F_close( File_ID); and declare Variable “DINT_val” as DINT and
Dim. at least "10" for this example..

end_if ;
end_if;
end_if;

Note: In this example, when the "Read_File" is set to "TRUE", it will read the file on the PAC
"\System_Disk\Real data2.txt", please make sure the file already exists on the PAC.

| BRE) ®BE BRY) BEQ |
¢ %2 XQ B
HaHED) I \Systerm_Disk

[ Drivers = . =

i External_device_driver HE%':E:I wEE) Bl 8L0) IE’EIH =
7 1SAGRAF 1.0&

3 tools 4. 756

9 Win-GRAF 38.45

[ penmount_usb_touch_v20100526, 415
] [EC61131 User and Reference Mani 29875

£] Backup_Real_2.txt al.’ 74
7L.23
£] Update_History 28120418, txt a0.5
Z] Working_Real.txt 995
1007
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Test Program:

1. Please set up IP configurations (Refer to P12-1), compile and download the program to the PAC.
(Click on "Project" > "Build All Projects" / "On Line", if not familiar with the operation, refer to
Section 2.3.4, Section 2.3.5)

2. Click "NewSpy1" to open a Spy List and set the "Read_File" to "TRUE" to read the data. (If OK,
"File_Status" will show "Open File "\System_Disk\Real_data2.txt" Ok.")

File Edit Yiew Inse@v Help - @
SR = A T s o W S S R T 00 P A IR A

Workspace il D000 HewSpyt.spl
£ [ demo_file2 [RUN] ‘ B Name | Yalue | Description
D [ Exception programs Eﬂ =1 REAL_wal @ .
&3--E3 Programs . REAL_val0] | 1.08
L) Main B¢ REALvall] |2788
(=3 Watch [for debuagi.. REAL_vall2] | 38.450001 I; TRUE j (1)
- - 3® Soft Scope RE&L_wal[3] | 41.5 ‘\

5 | REAL valld] | 59.875 ( FALSE ]
| REAL_valls] | 60.759398
REAL_vall§] | 71.230003 Lock
REAL_val7] | 805

REAL vallg] | 99.800003

100.693937

- 3g Glo
T3} Variables
LB Types

set TRUE to read data from the file

‘Open File "System_Disk\Real_data2.txt" Ok '

(1 M8 I | >
|[[$%] Main| wariables | NewSpyl -

Note: There is one another file operation example listed in the Section 6.2. It handles many data in the
file, you may refer to it.
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12.4.3 Data Logging

Refer to P12-1 to open this project ("demo_Datalog.zip") that provides a simple function for data
logging. This program creates a spy list that contains a String variable (write_date), an Integer variable
(int_data) and a Real variable (float_data). These variable values will be recorded to a file per minute
and be stored on the PAC‘s \System_Disk2\. This log file will be named according to the current date
(e.g., May 06, 2015, the file name will be "2015-5-6.csv"). Moreover, this log file will be replaced per day
and the existing file will be moved to "\System_Disk2\Current month\" (e.g., May 06, 2015, the file will
be moved to "\System_Disk2\2015-5\").

Note: This example project is used for the XP-8xx8-CE6 PAC. If you want to use the others PAC,
simply change the file path as \Micro_SD\ or other storage location.

The sample of the CSV file format:

Time, int_val, float_val
20:18:30, 1236, 14.56
20:18:40, 3456, 34.56
20:18:50, 8932, 89.32

Description of variables: The user can view/set variables in the Win-GRAF "Variables" window.

Name Data Type | Description
Yearl DINT
Month1 DINT
Dayl DINT
WeekDay1 DINT Used to get the PAC system time in the “PAC_Time” program.
Hourl DINT
Minutel DINT
Secondl DINT
old_day DINT Used to know if the time is changed and then rename the log file
old_hour DINT in the “PAC_Time” program.
log_tmrl TIME )
log_tmr2 TIME Timer.
CSV_Path STRING The storage path of CSV file.
CSV_Dir STRING The storage folder of CSV file.
write_date STRING Used to record the time when writing data to a CSV file.
init BOOL Set it as TRUE to initialize. (Init value = TRUE)
int_data DINT Used to record the data.
float_data REAL Used to record the data.
writecsv BOOL Set it as TRUE to write data.
File_ID DINT Used for the "F_WOPEN" function.
tmp_bval BOOL
The temporary variable.
tmp_msg STRING
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Spy List — “My_List”:
There is a Spy list called “My_list” in this example project. (Refer to Section 11.3 for more details)

¥ M arne | Walue | Description

FE! write_date

int_data

B

LD Program — “PAC_Time”:
To get/set the PAC system time.

R1 ME.TIME_GET ...

....................... Yearf eart
Meonth}-Month1
Day|-Day1
wDay|-WeekDay1

Hourj-Hour1

Minute}- Minute1

Sec,. }Secondi

ST Program — “Main”:
To generate random values as the data of the log file (.csv) and to change the file storage path.

(* Declare “init” as "BOOL" ; Declare "log_tmrl" and "log_tmr2" as "TIME" *)
(* Set “init” as TRUE to start ticking "TMR1" *)
IF init THEN
init := FALSE;
(* Enable the timer of the data logger *)
TSTART (log_tmr1) ;
(* Set the separator and decimal within the csv file *)
SetCsvOpt(’,’, ".");
END_IF;

IF old_day<> dayl THEN

tmp_msg:="\System_Disk2\'+CSV_Dir+'\'+ANY_TO_STRING(yearl)+'-'+
ANY_TO_STRING(month1)+'-'+ANY_TO_STRING(old_day)+'.csv';
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(* Copy the file to \System_Disk2\ *)
tmp_bval:=F_COPY (CSV_Path,tmp_msg);

(* Delete the original file stored at \temp\ *)
tmp_bval:=F_DELETE(CSV_Path);

(* Create the CSV file and its filed name *)
tmp_msg:="\Temp\'+any_to_string(yearl)+'-'+any_to_string(month1)+'-'+
any_to_string(dayl1)+'.csv';
CSV_Path:=tmp_msg;
File_ID:= F_WOPEN(tmp_msg);

IF File_1D<>0 THEN
tmp_msg:='Time,Int_val,Float_val’;
tmp_bval:=FM_WRITE(File_ID,tmp_msg);
tmp_bval:=F_CLOSE(File_ID);

END_IF;
old_day:=dayl;
END_IF;

(* Create the folder every month, or when the PAC boot up. *)

if old_month<>month1 then
CSV_Dir:=ANY_TO_STRING(year1)+ANY_TO_STRING(month1);
tmp_msg:="\System_Disk2\'+CSV_Dir;

F_DIR(tmp_msg); \
Because the size of \System_Disk\ is small,

old_month:=month1;
we recommend that you save the log file at

\Micro_SD\ (for WinPAC, ViewPAC series) or
\System_Disk2\ (for XPAC series).

end_if;

(* The function for writing data to a CSV file *)
IF log_tmrl>=log_tmr2 THEN
log_tmrl:=t#Os;

(* Generate random values for the "Int_val" and the “Float_val" field *)
int_data:=rand(1000);
float_data:=ANY_TO_REAL(int_data)/100;
(* The time for each data logging *)
write_date:=ANY_TO_STRING(hourl)+":'"+ ANY_TO_STRING (Minutel)+":'"+
ANY_TO_STRING (Second1l);
(* Delete the previous file *)
tmp_msg:="\System_Disk2\'+CSV_Dir+'\'+ANY_TO_STRING(Yearl) +'-'+
ANY_TO_STRING(month1)+'-'+ANY_TO_STRING(Day1)+'.csv';
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(* Delete the file stored at \System_Disk2\ *)
tmp_bval:=F_DELETE(tmp_msg);
(* Trigging it to write data to a file *)
writecsv:=true;
END_IF;

LD Program — “WriteFile”
Set the "writecsv" as "TRUE" to write one data to the CSV file.

The user can click the following function or function block, and then press “F1” to view the descriptions.

VLID: Get the identifier of an embedded list of variables (i.e., Spy List - My_list.spl).
LogFileCSV: Generate a log file in CSV format for a list of variables.
F_COPY: Copy a file.

writecsy In=t_LOGFILE...

R1 P En WVLID Eng LOGFILECSW I
Falze
"My_list.spl' List D)-File_ID ] RST ERR}-ERR

File_ID{ List

writecsy N wWritecsy

R2 P SF_corv bR

cev_Pathsre

Using “F_COPY” to copy a file from the path “\Temp\”
fmp_msg-| Dt (RAM Disk, which can read/write data quickly) to

“System_Disk2”. (Refer to ST program — “Main”)
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Chapter 13 Using VB.net 2008 Program to Access Win-GRAF

Variables

This chapter lists the procedure for creating the first demo program by Visual Studio .NET 2008

development tool. There are some sample programs in the Win-GRAF PAC CD.

VB .NET example:

CD-ROM : \napdos\Win-GRAF\demo-project\vb.net_2008_demo\
demo_vb01: Digital /O demo with one I-87055W in slot 0 of the PAC.
demo_vb02 : Analog /O demo with one I-87024W in slot 1, one I-8017HW in slot 2.
demo_vb03: Read/Write Win-GRAF internal integers, timers & real variables. (No 1/0)
demo_vb04 : Read/Write Win-GRAF internal String variables. (No I/0)

Win-GRAF example:

CD-ROM : \napdos\Win-GRAF\demo-project\
"demo_vb01.zip", "demo_vb02.zip", "demo_vb03.zip", "demo_vb04.zip"

13.1 Add an Existing Win-GRAF Project from a ZIP

Please follow these steps to restore the Win-GRAF project.
First Click “File” -> “Add Existing Project” -> “FromZip...”. Then choose the Win-GRAF project zip file

which you would like to restore. After restoring the project, you have to build the project, and then

download it to the PAC.

View Ioals Window Help
| HWewr Project List. .
Cipen Project List
= Add Hew Project...

A4 Exdsting Froject

Print Zetup... \

1 SV -G R AP rojectswep_wbO1 w5l
2 TN m-GR AR rojectshep_wbl3 w5l

3 CAWin-GRAFRPmojectshwep_wh0Z w5l
4 CAWin-GEARProjectsICPDAS  ternplate w5l

fl¢ Exit

*| [ & %

tﬂ_ﬂ From Digk....

[ﬂ] From Zip....
Frevrn Tarset \

= Ealige |j Demo-Program | ¥ M-
N [y C8harp net_2008_demn
[ £ E:,jvb.mt_ZElElS_demo
o el p s M- derno_vbU1 zip
F“‘&
=
RIS
-
48
FHHIERE
"—J fa & I E::lemn_vbﬂl.zip nel] B ()
WS LHDSHE ImEAND: | Zip e (*aip) v A
SHEEH)
Destination falder : E't:\Win-GHAF\F'roiects v
Mame; E.l;;.lemn_vbm - 1
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13.2 Publishing the Win-GRAF Variable for .NET

If users wish to use .NET program to Read/Write the Win-GRAF variables. Except for String variable all of
the variables need to use the "Open Binding Configuration" function to set an address. The following

demonstrates how to publish Win-GRAF variable:

1. Click “Open Binding Configuration” on the toolbar to open the “Binding” setup window.
2. Click "PUBLIC (:9000)". Keep the "Address" value is blank and "Port" value is fixed to 9000.

™ Win-GRAF - Test 3
File Edit ¥iew Insert Project Tools Window Help

Open Binding Configuration

' B2 AN I SEEEE i JE G B g (5 e A
Workspace Binding
e Test 3 : Network Nahe | Value 7 Name
- Exception programs 5 (-4 FLIELIC [:9000) Name PUBLIC {2t Global variables A
-C3 Programs Address = RETAIN variables
g 3] Main g¢ Port 3000 ] Main
-4 Watch (for debugging) E [ ?-a nOnBadindex 5
ik okt Scops , Keep "Address" value blank. ¢ | ,
: ﬂ Ir‘rma‘l values‘ ) Name | Identifier s iy | NEYaue e ,‘gme Variable Area
g Binding Configuration T [
i 39 Global defines
: T3 Variables
B Types
< | e
|4 5| Binding/ Varisbles ' i

3. Before publishing these variables, make sure you have declared them in the Variables Area. Click
“Global variables” and press the “Ins” key to insert a new variable. The following table demonstrates
variables using in the “Test_3” project and you can declare them according to the needs of your
application.

Variable name Type ¥ Name | Type | D

Public_BOOL BOOL | {at Global variables K A
— Public_BEOOL  BOOL

Public_INT INT Public INT  INT
Public_DINT DINT Public_DINT  DINT
— Public WORD WORD
PUbIIC_WORD WORD E..-L\J.,._D;:M DEAl :
Public_REAL REAL e i |
- ] Main  — -
& il Enter key i

4. As the figure below, click on "PUBLIC(:9000)" and drag all the needed variables to the "Name" area.
The "ldentifier" will generate an address number automatically. If any other VB or .NET program
wants to use these public variables, it must set to the same address number (ID).

NOTE:
The "PUBLIC" allows to use up to 8192 variables, and the "ldentifier" number JUST can be 1 to 8192.
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Binding *

o ‘318 Network Name | Value T Name | Type |
R Y e (3000 Name PUBLIC = {3} Global variables A
Address Public_ BOOL BOOL
Bt Pot 9000 Public INT o INT
3 Public_DINT / DINT
FPublic_ ¥WORD WORD
Public /REAL REAL  |v
Name | Identifier | |Positive hysteresis | - 5—, o7 k2 .
“Public_BOOL 1 _ | Nme | Value |
Public_INT 2 _-- ---"
Public_DINT -
Public_0ORD 4
Public_REAL 5
¢ ’ 2

(< | Binding,” varizbles

The following procedure will show you how to use the “pub_string” function to publish the Win-GRAF
String variable in the ST program.

Syntax:

Pub_string(Address, String_val) ;

Address:  The public address number, and its range can be 1 to 1024
String_val: The name of String variable.

Variables description:

Name Type Description
Init BOOL Set the initial value as TRUE.
TRUE: Binding succeeds.
Tmp_val BOOL FALSE: Binding fails.
msgl STRING, Length is 100
. String variable for demo purpose.

2 STRING, Length is 32
mse L LENEin 15 NOTE: The String length could be 1 to 255.
msg3 STRING, Length is 60

ST program:
If init then
Init := false;

(*add address 1 for share string val *)
Tmp_val := pub_string(1,msgl);

(*add address 2 for share string val *)
Tmp_val := pub_string(2,msg2);

(*add address 3 for share string val *)
Tmp_val := pub_string(3,msg3);

End_if;
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13.3 Create a new VB.NET project

1. First, run Microsoft Visual Studio .NET 2008 software, and then choose “File” > “New Project”.

Edit Wiew Tools Test Windew Help

Shift+Alt+I

]| Mew File..,

Microsoft*

Lj Crpen Project... Crl+0 .“ Vlsual StUdIO 2008

% Open Web Site... Shift+Alt+0

2. Click “Smart Device” on the left, and then select “.NET Framework 3.5” and “Smart Device Project”.

Entering a proper project name and click “OK”.

Project types: Templates: NET Framnework 3.5 =
= Visual Bazic Yisual Studio installed templates
Wind owes
ieh
Srmart Device E]VH
Office = .
Database Smart Device
Reporting Project
Test
WCF
Woarkflow _ My Templates
Other Languages
Other Project Tyvpes
Test Projects -
Hearch Cinline
Templates. .. 3
s

& project for Smart Device applications. Choose target platform, Framework version, and template in the next dialog box. |

M | projectl] |

[ oK &[ Cancel |

3. Select the "Device Application" and "Windows CE" and “.NET Compact Framework Version 3.5”, then
click “OK”.

Target platform: Windows CE b

HNET Compact Framework version: | §ET Campact Framework Version 3.5 w
NET -:.mam Framework ‘.fersu:un 2 EI

Templates:

Control — Empty Project & project for creating a NET
Library Compact Framework 3.5 forms
application for Windows CE
Platform

Dovenload. additons] emlator dmeages and smart device SDEs. .

UK % Cancel |

Win-GRAF User Manual, V2.0, Aug. 2020 by ICP DAS 13-4



13.3.1 Add Project Reference

The “UserShareNet.dll” library contains all functions of data exchange with Win-GRAF variables. Before
you use the “UserShareNet” keyword in the program, you must add the “UserShareNet.dll” into the
reference list of your project.

1. Copy the “UserShareNet.DLL” from Win-PAC’s shipment CD (\napdos\Win-GRAF\WP-8xx8\
vb.net_2008_ demo\wp_vb01\vb01\) to your project folder (e.g., “C:\project1\”)

2. Right click on the project name (e.g., “projectl”) in the _ =] x|
“Solution Explorer” window, and then select “Add Referenc¢

”

Solution Explorer - pr.., » I X

8| Build Right click
Rebuild

Deploy

Clean
Add »

Add Eeference...

Add Web Eeference...

3. Click the “Browse” tab and select the “UserShareNet.dll” from your project location.

NET Projects | Browse | Recent

{Rs{UE D | ) projec w D ¥ . -

S X

[y Mo Project ] ] ] ]

=) 0bj The current project is located in "C:\project1".
%) UserShareNet dll

RS\ | 3
TR | Component Files (% Al;* tlh* olb * ocx* exe) w

[ OK‘{[ Cancel |

Note: You may copy the “UserShareNet.dll” from the CD-ROM to your current project path first.
Then add it to the project reference.
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4. When “UserShareNet.dll” is added, please double click on “My Project” to check if the
“UserShareNet.dll” is well added.

Solution Exploter - 1 X

2|5 G

-_:,]E projectl

""" Double click
Lpplication
Compile
Debug Referenes Unuged References. . I [ Eeference Paths...
Reference Name Twpe  Ver.. CopwLocal Path
References Satem NET 9000 Fale i o eram Fllestierosodt B TSOE cmpactFramenorkhy 0V
wten. Data NET 2000 bale o gram Filesibicrosoft NE TWDEV ompactFrameworkiva IV
Besommes Swtern. Draveing NET 2000 False WPy gram Filesibicrosoft NE TWDEV ompactFrameworkiva I
Swstern, Windows For.. NET 2000 Fale CProgram Filesticrosoft NE TSDEVCompactFrameorkhy@ I
N . Sarstern il NET 2000 Fals AP o B i
Signing I MaerSharelet NET 1010 Tme C:Documents sd Setingsmserd EwingradfdocWapdod Win-GR I
Devices \
{ >

5. Right-click on the “Form1.vb” and select “View Code” from the pop-up. Move cursor to top and
insert the “Option Explicit On” and “Imports UserShareNet” in the first two statements.

solution Explover Forml vhb
= | & 2] [H E d'%:, “t% Forml
-_4]E projectl Option Explicit On
=d| My Froject
= Imports Tzeriharehet
j' Qipen
Right Open With... sPublic Class Forml|

|—End Clazs

Click [=] ¥iew Code \

Then you can design all required objects and actions inside your VB Forms.
(Refer to Chapter 13.5 for more information about using functions in the “UserShareNet.dIl”.)
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13.4 Compiling the Application

When you have finished writing a program, you can build (compile) an application by the following
steps.

1. Remember to save at any time for safety.

ke Pointer
tﬂj Rinf]!‘n‘o‘q{“ln‘n

] - fis1
Edit ¥iew Progect
|

=I"All Device Controls v2
k Pointer
21 BindingSource

P N

File
R N AR R

Eebuild projectl
Deploy  ohyerg i
Clean profid 0 Errors‘

1 i

_;5 0 Warnings| i) 0 Messages

|| Diocepinti
o %

IBuﬂd succeeded I

3. You can find the execution file in

<Your VB.net Project folder> \bin\Release\ <project_name>.exe

Please copy this execution file to the WP-8xx8’s \System_Disk\Win-GRAF\ path to run it.

Note:
The user may copy the VB.net execution file to another path to run it, but there should contain at
least two DLL files with it or it cannot run correctly.

For ex, the projectl.exe can run in the \Micro_SD\ folder if there are three files in it. The

“projectl.exe” , “UserShareNet.dll” and “Quicker.dll” . (The “UserShareNet.dll” and “Quicker.dll”
can be copied from the Win-GRAF PAC’s “\System_disk\Win-GRAF\” path)
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13.5 UserShareNet.dll

This section we will focus on the description of the application example of UserShareNet.dll
functions. There are some functions that can be used to read/write data from/to the Win-GRAF
soft-logic. The functions of UserShareNet.dll can be divided into as listed below:

1. R/W Boolean

2. R/W 8-bit Integer
3. R/W 16-bit Integer
4. R/W 32-bit Integer
5. R/W 64-bit Integer
6. R/W 32-bit Float

7. R/W 64-bit Float

8. R/W String

X Refer to “Appendix A” to get familiar with the definition of Win-GRAF variables.

13.5.1 R/W Boolean Functions

l Set_BOOL

Description:
This function is to set a value to a Win-GRAF Boolean variable.

Syntax:

UserShare.Set_BOOL ( iUserAddress As System.UInt16, ByVal iStatus As byte) as Byte

Parameter:

iUserAddress : Address of the Variable (1 to 8192)

iStatus : Set the status. For instance, iStatus = 1 for True, iStatus = O for False
Example:

‘Set the Win-GRAF BOOL variable with address 1 to True.
UserShare.Set_BOOL(Convert.ToUInt16(1), 1)

Demo program:
CD-ROM: \napdos\Win-GRAF\demo-project\vb.net_2008 demo\demo_vb01
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B Get_BOOL

Description:
This function is to get the value from a Win-GRAF BOOL variable.

Syntax:

UserShare.Get_BOOL ( iUserAddress As System.UInt16 , ByRef iStatus As byte)

Parameter:

iUserAddress : Address of the Variable (1 to 8192)

iStatus : Get the variable value, iStatus = 1 for True, iStatus = O for False
Example:

‘Get the value of Win-GRAF BOOL variable with address 1.
Dim iStatus As Byte
UserShare.Get_BOOL(Convert.ToUInt16(1), iStatus)

Demo Program:
CD-ROM: \napdos\Win-GRAF\demo-project\vb.net_2008 demo\demo_vb01
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13.5.2 Integer R/W Functions

B Set SINT [l Set INT [ Set DINT [l Set LINT

Description:
These functions are to set 8-bit Integer, 16-bit Integer, 32-bit integer & 64-bit Integer value to Win-GRAF
integer variables.

Syntax:

UserShare.Set_SINT (ByVal iUserAddress As System.UInt16 , ByVal iStatus As SByte) As Byte

UserShare.Set_INT (ByVal iUserAddress As System.UInt16 , ByVal iStatus As Short) As Byte

UserShare.Set_DINT (ByVal iUserAddress As System.UInt16 , ByVal iStatus As Integer) As Byte

UserShare.Set_LINT (ByVal iUserAddress As System.UInt16 , ByVal iStatus As long) As Byte

Parameter:

iUserAddress : Address of Variable. (1 to 8192)

iStatus : the value of 8-bit Integer, 16-bit Integer, 32-bit Integer or 64-bit Integer.
Example:

‘Set a 32-bit integer value “1234567” to the Win-GRAF DINT variable with address “1”.
UserShare.Set_DINT(Convert.ToUInt16(1), Convert.Tolnt32(1234567) )

‘Set a 16-bit integer value “-1234” to the Win-GRAF INT variable with address “2”.
UserShare.Set_INT(Convert.ToUInt16(3), Convert.Tolnt16(-1234) )

‘Set a 64-bit Integer value “123456789012345” to the Win-GRAF LINT variable with address “3”.
UserShare.Set_LINT(Convert.ToUInt16(3), Convert.Tolnt64(123456789012345) )

‘Set a 8-bit Integer value “125” to the Win-GRAF SINT variable with address “4”.
UserShare.Set_SINT(Convert.ToUInt16(3), Convert.ToSByte(125) )

Demo Program:

CD-ROM:

1. \napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb02 for R/W analog I/O

2. \napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb03 for R/W internal long integer,
Timer and Real (floating-point) values.
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B Get SINT H Get_INT I Get_DINT [ Get_LINT

Description:
These functions are to get 8-bit integer, 16-bit integer, 32-bit integer & 64-bit integer value from
Win-GRAF integer variables.

Syntax:

UserShare. Get_SINT (ByVal iUserAddress As System.UInt16 , ByRef iStatus As SByte) As Byte

UserShare. Get_INT (ByVal iUserAddress As System.UInt16 , ByRef iStatus As Short) As Byte

UserShare.Get_DINT (ByVal iUserAddress As System.UInt16 , ByRef iStatus As Integer) As Byte

UserShare. Get_LINT (ByVal iUserAddress As System.UInt16 , ByRef iStatus As long) As Byte

Parameter:

iUserAddress : Address of Variable (1 to 8192)

iStatus : Get the 8-bit integer, 16-bit integer, 32bit-integer or 64-bit integer value.
Example:

Dim Dlong_val As Int64
Dim short_val As Int16
Dim long_val As Int32
Dim Sbyte_val as byte

‘Get 64-bit integer value from the Win-GRAF LINT variable with address “7”.
UserShare.Get_LINT(Convert.ToUInt16(7), Dlong_val)

‘Get 32-bit integer value from the Win-GRAF DINT variable with address “8”.
UserShare.Get_DINT(Convert.ToUInt16(8), long_val)

‘Get 16-bit integer value from the Win-GRAF INT variable with address “9”.
UserShare.Get_INT(Convert.ToUInt16(9), short_val)

‘Get 8-bit integer value from the Win-GRAF SINT variable with address “10”.
UserShare.Get_SINT(Convert.ToUInt16(9), sbyte_val)

Demo program:

CD-ROM:

1. R/Wanalogl/O:
\napdos\Win-GRAF\demo-project\vb.net_2008 demo \demo_vb02

2. R/W internal long integer, Timer and Real (floating-point) values :
\napdos\Win-GRAF\demo-project\vb.net 2008 demo\demo_vb03
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13.5.3 R/W Real Variable Functions

B Get REAL [ Get LREAL

Description:
These functions are to get 32-bit REAL and 64-bit double from the Win-GRAF REAL/LREAL variable.

Syntax:

UserShare. Get_REAL (ByVal iUserAddress As System.UInt16 , ByRef iStatus As Single) As Byte

UserShare. Get_LREAL(ByVal iUserAddress As System.UInt16 , ByRef iStatus As Double) As Byte

Parameter:

iUserAddress : Address of Variable (1 to 8192)

iStatus : Get the 32-bit REAL or 64-bit double value.
Example:

Dim float_val As Single
Dim double_val As Double

‘Get 64-bit double value from the Win-GRAF LREAL variable with address “7”.
UserShare.Get_LREAL(Convert.ToUInt16(7), double_val)

‘Get 32-bit REAL value from the Win-GRAF REAL variable with address “8”.
UserShare.Get_REAL(Convert.ToUInt16(8), float_val)

Demo program:
CD-ROM:
1. R/W analogl/O:
\napdos\Win-GRAF\demo-project\vb.net_2008 demo\demo_vb02
2. R/W internal long integer, Timer and Real (floating-point) values :
\napdos\Win-GRAF\demo-project\vb.net_2008 demo\demo_vb03
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B set_REAL [ Set LREAL

Description:
These functions are to set 32-bit REAL and 64-bit double value to the Win-GRAF REAL/LREAL variable.

Syntax:

UserShare. Set_REAL (ByVal iUserAddress As System.UInt16, ByVal iStatus As Single) As Byte

UserShare. Set_LREAL(ByVal iUserAddress As System.UInt16, ByVal iStatus As Double) As Byte

Parameter:

iUserAddress : Address of Variable. (1 to 8192)
iStatus : Set the 32-bit REAL or 64-bit double.
Example:

‘Set a 64-bit double value “11234.234567” to the Win-GRAF LREAL variable with address “1”.
UserShare.Set_LREAL(Convert.ToUInt16(7),Convert.ToDouble(11234.234567))

‘Set a 32-bit REAL value “123.12"” to the Win-GRAF REAL variable with address “8”.
UserShare.Set_REAL(Convert.ToUInt16(8), Convert.ToSingle (123.12))

Demo program:

CD-ROM:

1. R/W analog1/O : \napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb02

2. R/W internal long integer, Timer and Real (floating-point) values :
\napdos\Win-GRAF\demo-project\vb.net 2008 demo\demo_vb03
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13.5.4 R/W String Variable Functions

B Get_STRING

Description:
This function is to get a Win-GRAF String variable.

Syntax:

UserShare. Get_STRING (ByVal iUserAddress As System.UInt16, ByVal msg() As Byte) As

h

Parameter:

iUserAddress : Address of Variable (1 to 1024)
msg() : Get the string value.

Example:

Dim str_val As String
Dim msg() As Byte

‘Get String value of the Win-GRAF String variable with address “7”.
UserShare.Get_STRING(Convert.ToUInt16(7),msg )
str_val= byte_array_to_unicode(msg)

Private Function byte_array_to_unicode(ByVal buf() As Byte) As String
Dim tmpmsg As String
If buf.Length > 255 Then
Return Nothing
End If
tmpmsg = System.Text.Encoding.GetEncoding("UTF-8").GetString(buf, 0, buf.Length)

Return tmpmsg
End Function

Demo program:

CD-ROM:

1. R/W String variable:
\napdos\Win-GRAF\demo-project\vb.net 2008 demo\demo_vb04
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Il Set_STRING

Description:
This function is to set a String value to the Win-GRAF String variable.

Syntax:

UserShare. Set_STRING (ByVal iUserAddress As System.UInt16, ByVal msg() As Byte) As

]

Byte

Parameter:

iUserAddress : Address of Variable. (1 to 1024)
msg() : the string value.

Example:

Dim str_val As String="Hello World”
Dim msg() As Byte

msg= unicode_to_byte_array(str_val)

‘Set a string value “Hello World” to the Win-GRAF String variable with address “7”.
UserShare.Set_STRING(Convert.ToUInt16(7),msg )

‘Convert String to byte array.
Private Function unicode_to_byte_array(ByVal msg As String) As Byte()
Dim tmpbuf() As Byte
If msg.Length > 255 Then
Return Nothing
End If
tmpbuf = System.Text.Encoding.GetEncoding("UTF-8").GetBytes(msg)
Return tmpbuf
End_Function

Demo program:

CD-ROM:

1. R/W String variable:
\napdos\Win-GRAF\demo-project\vb.net 2008 demo\demo_vb04
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13.5.5 How to use VB.NET R/W to Win-GRAF String Variable

Before .NET program write to Win-GRAF String variable. The String-type has to convert to byte array. If
you need to read Win-GRAF String variable. Then you have to convert byte array to String. There is a

VB.NET example to show how to convert each other.

(Encode :UTF-8)

Convert String to byte array
Private Function unicode_to_byte_array(ByVal msg As String) As Byte()
Dim tmpbuf() As Byte
If msg.Length > 255 Then
Return Nothing
End If

tmpbuf = System.Text.Encoding.GetEncoding("UTF-8").GetBytes(msg)

Return tmpbuf
End Function

Convert byte array to string
Private Function byte_array_to_unicode(ByVal buf() As Byte) As String
Dim tmpmsg As String
If buf.Length > 255 Then
Return Nothing

End If
tmpmsg = System.Text.Encoding.GetEncoding("UTF-8").GetString(buf, 0, buf.Length)

Return tmpmsg
End Function
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Chapter 14  Using C# .net 2008 Program to Access Win-GRAF
Variables

This chapter lists the procedure for creating the first demo program by Visual Studio .NET 2008
development tool. There are some sample programs in the Win-GRAF PAC CD.

C# demo:
CD-ROM : \napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\
demo_CSharp01 : Digital I/O demo with one I1-87055W in slot 0 of the PAC.
demo_CSharp02 : Analog |/O demo with one I-87024W in slot 1 and one |-8017HW in slot 2.
demo_CSharp03 : Read / Write Win-GRAF internal integers, timers and real variables. (No 1/0)
demo_CSharp04 : Read/Write Win-GRAF internal String variables. (No 1/0)

Win-GRAF demo:
CD-ROM : \napdos\Win-GRAF\demo-project\
"demo_vb01.zip", "demo_vb02.zip", "demo_vb03.zip", "demo_vb04.zip"

14.1 Add an Existing Win-GRAF Project from a ZIP

Please refer to Chapter 13.1

14.2 Publishing the Win-GRAF Variable for .NET

Please refer to Chapter 13.2

14.3 Create a New C# Project

1. First, users need to open Microsoft Visual Studio .NET 2008 software. And then in the menu of “File”,
please run the “New Project” .

I'.[l Wis
Edit Miew Tools Test Mindow Help

2

HNew Meb 3
Mew File...
Cpen Project... Ctel+C
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2. Check the “Smart Device” on the left, then selecting the “.NET framework 3.5” and “Smart Device
Project”. Then entering a proper project name and the last click on “OK”.

Fraiect types: Templates: HET Framework 3.5 =
Database # || ¥isual Studio installed templates &
Fepaorting T
Test
WCF E]cﬂ
Workflow

o). Other Languages Smart Device
=) Visnal C# o
_Hy Templates
Zearch Online
Templates...
v “

L I

A project for Bmart Device applications. Choose target platform, Framework version, and template in the next dialog hos

Wame: project]|

[ ok &[ Cangel |

3. Select the "Device Application" and "Windows CE" and “.NET Compact Framework Version 3.5”,
then click on “OK”.

Target platform: Windaws CE v
NET Compart Framework version: | yET Cumpact&wnrk Version 3.5 v
Templates: PRSI LA g g LT EsOn 2
=2Ve =M ?} ErB ] Ve
:ﬁ iﬁ Vg T E] Description:
Dievice Clags Library  Console Control - Empty Project 4 project for creating a NET
Application A pplication Library c.:pmp]am FMWE?EE.S fionms
application for Windows CE
Platform

Diowendoad additonsl exaulator images and smart device SDE:.

[0)4 Cancel
I ,% [
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14.3.1 Add C# Project Reference
The “UserShareNet” library contains all modules’ functions. Before you use the “UserShare” keyword in
the program, you must add the “UserShareNet.dll” into the reference list of your application.

1. Copy the “UserShareNet.DLL” from the Win-GRAF PAC CD:
\napdos\Win-GRAF\WP-8xx8\CSharp.net_2008_demo\demo_CSharp01\ to your project folder(ex:

C:\project1\)
=B

2. Right click on the Project name on the right of
the window , then select “Add Reference ...”.

Solution Explerer - pr... » 1 X

| Build J Right Click
Eebuild

Deploy
Clean
Add »

Add Eeference,

Add Web Reference...

3. Click the “Browse” button. Select the “UserShareNet.dll” from your project location.

NET Projects BmW“\Recent

PEERED: | [0 project] ¢ 5

| bin \

[hoby .

0 Propertiss Change foId'er to your current project Path.
%) UserShareNet 411 (Ex: "C:\project1")

T FE S | 3
TEEELEANT): | Component Files (*d11* tlh:* olb* oo exe) w

( OK!{[ Cancel |

Note: You may copy the “UserShareNet.dll” from the CD-ROM to your current project path first.
Then add it to the project reference.
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4. When “UserShareNet.dll” are added, you can see them in the Solution Explorer panel as below.

solution Explorer

2 |5 (7]
-_;E projectl
=d| Properties

A0 Borztemn

A0 FBorstem.Core

A Sorstermn. Data

A2 Bwetemn. Data. DataSetExdensions
A Farztermn Divaeing

A3 Forztermn. Wind ows Formms

A2 Bvstern Hml

A0 Tserbhareet

5. Right-click on the “Form1l.cs” and select “View Code” from the pop-up. Move cursor to top and

insert the “using UserShareNet;” in the first statements.

=d| Properties using System.Drawing;
g References using System.Text;
& B ,
. c#j - nzing Tzerfharelet ;
ﬁ (7  Open
. mnamespace wp_Caharpll
Open With. . I

public partial class Forml - Form

[Z] WView Code \ % I

Then you can design all required objects and actions inside your C# Forms.
(Refer to Section 14.5 for more information about using functions in the “UserShareNet.dll”.)
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14.4 Compiling the Application Program

When you have finished writing a program, you can build (compile) an application by the following
steps.

1. Remember to save at any time for safety.

e Pointer
T RBindineSenrea

Eebuild projectl

=I"All Device Controls v2
k Pointer
27 BindingSource

P B T

Deploy g Rn]
Clean pro 'q) 1] Errors‘

1 i

_;5 0 Warnings| i) 0 Messages

| | ———
— ¥

IBuﬂd succeeded I

3. You can find the execution file in

<Your C# .net Project folder> \bin\Release\ <project_name>.exe

Please copy this execution file to the WP-8xx8’s \System_Disk\Win-GRAF\ path to run it.

Note:

The user may copy the C#.net execution file to another path to run it, but there should contain at least
two DLL files with it or it cannot run correctly. For ex, the projectl.exe can run in the \Micro_SD\ path if
there are three files in it. The “projectl.exe”, “UserShareNet.dll” and, “Quicker.dll” .

(The “UserShareNet.dll” and “Quicker.dll” can be copied from the Win-GRAF PAC’s
“\System_disk\Win-GRAF\” path)
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14.5 UserShareNet.DLL

This section we will focus on the description of the application example of UserShareNet.DLL
functions. There are some functions that can be used to read/write data from/to the Win-GRAF
variable. The functions of UserShareNet.DLL can be divided into as listed below

R/W Boolean

R/W 8-bit Integer
R/W 16-bit Integer
R/W 32-bit Integer
R/W 64-bit Integer
R/W 32-bit Float
R/W 64-bit Float
R/W 32-bit String

©® No Uk wnN PR

X Refer to “Appendix A” to get familiar with the definition of Win-GRAF variables.

14.5.1 R/W Boolean Functions

B Set_BOOL

Description:
This function is to set a value to a Win-GRAF Boolean variable.

Syntax:

UserShare.Set_BOOL(ushort iUserAddress, byte iStatus)

Parameter:

iUserAddress : Address of Variable (1 to 8192)

iStatus : Set the status. For instance, iStatus = 1 for True, iStatus = O for False
Example:

// Set the Win-GRAF BOOL variable with address 1 to True.
UserShare.Set_BOOL(Convert.ToUInt16(1), 1);

Demo program:
CD-ROM : \napdos\Win-GRAF\demo-project\CSharp.net_2008 demo\demo_CSharp01
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B Get_BOOL

Description:
This function is to get the value from a Win-GRAF BOOL variable.

Syntax:

UserShare.Get_BOOL(ushort iUserAddress, out byte iStatus)

Parameter:

iUserAddress : Address of Variable. (1 to 8191)

iStatus : Get the variable status, iStatus = 1 for True, iStatus = O for False.
Example:

Byte iStatus=0;
// Get the value of Win-GRAF BOOL variable with address 1.
UserShare.Get_BOOL(Convert.ToUInt16(1),out iStatus);

Demo program:
CD-ROM: \napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp01
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14.5.2 R/W Integer Functions

B Set SINT [ Set INT [ Set DINT [l Set LINT

Description:
These functions are to set 8-bit Integer, 16-bit Integer, 32-bit integer & 64-bit Integer value to Win-GRAF
integer variables.

Syntax:

UserShare.Set_SINT(ushort iUserAddress , sbyte iStatus)
UserShare.Set_INT(ushort iUserAddress , short iStatus)
UserShare.Set_DINT(ushort iUserAddress, int iStatus)

UserShare.Set_LINT(ushort iUserAddress, long iStatus)

Parameter:

iUserAddress : Address of Variable. (1 to 8192)

iStatus : Set the 8-bit Integer, 16-bit Integer, 32-bit Integer or 64-bit Integer.
Example:

// Set a 32-bit integer value “1234567” to the Win-GRAF DINT variable with address “1”.
inttemp1=1234567;
UserShare.Set_DINT(Convert.ToUInt16(1), temp );

// Set a 16-bit integer value “-1234” to the Win-GRAF INT variable with address “2”.
short temp2=-1234;
UserShare.Set_INT(Convert.ToUInt16(2), temp2 );

// Set a 64-bit Integer value “123456789012345” to the Win-GRAF LINT variable with address “3”.
long temp3=123456789012345;
UserShare.Set_LINT(Convert.ToUInt16(3), temp3 );

// Set a 8-bit Integer value “125” to the Win-GRAF SINT variable with address “4”.
Sbyte temp4=125;
UserShare.Set_SINT(Convert.ToUInt16(4), temp4 );

Demo program:

CD-ROM:

1. R/W analogl/O:
\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp02

2. R/W internal Boolean ,long integer, Timer and Real (floating-point) values :
\napdos\Win-GRAF\demo-project\CSharp.net_2008 demo\demo_CSharp03
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B Get SINT H Get_INT I Get_DINT [ Get_LINT

Description:
These functions are to get 8-bit integer, 16-bit integer, 32-bit integer & 64-bit integer value from
Win-GRAF integer variables.

Syntax:

UserShare.Get_SINT(ushort iUserAddress, out sbyte iStatus)
UserShare.Get_INT(ushort iUserAddress, out short iStatus)
UserShare.Get_DINT(ushort iUserAddress, out int iStatus)

UserShare.Get_LINT(ushort iUserAddress, out long iStatus)

Parameter:

iUserAddress : Address of Variable (1 to 8192)

iStatus : Get the value of Win-GRAF integer variables.
Example:

Int64 Dlong_val;
Int16 short_val;
Int32 long_val ;

sbyte sbyte val;

// Get 64-bit integer value from the Win-GRAF LINT variable with address “7”.
UserShare.Get_LINT(Convert.ToUInt16(7),out Dlong_val);

// Get 32-bit integer value from the Win-GRAF DINT variable with address “8”.
UserShare.Get_DINT(Convert.ToUInt16(8),out long_val);

// Get 16-bit integer value from the Win-GRAF INT variable with address “9”.
UserShare.Get_INT(Convert.ToUInt16(9),out short_val);

// Get 8-bit integer value from the Win-GRAF SINT variable with address “10”.
UserShare.Get_SINT(Convert.ToUInt16(9),out sbyte val)

Demo program:
CD-ROM:
1. R/W analogl/O:
\napdos\Win-GRAF\demo-project\CSharp.net_2008 demo\demo_CSharp02
2. R/W internal Boolean, long integer, Timer and Real (floating-point) values:
\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp03
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14.5.3 R/W Real variable Functions

B Get REAL [ Get LREAL

Description:
These functions are to get 32-bit REAL and 64-bit double from the Win-GRAF.

Syntax:

UserShare. Get_REAL (System.UInt16 iUserAddress, out float iStatus)

UserShare. Get_LREAL(ByVal iUserAddress As System.UInt16 , out Double iStatus)

Parameter:

iUserAddress : Address of Variable (1 to 8192)

iStatus : Get the 32-bit REAL or 64-bit double value.
Example:

float float_val;
double double_val;

// Get 64-bit double value from the Win-GRAF LREAL variable with address “7”.
UserShare.Get_LREAL(Convert.ToUInt16(7),out double_val);

// Get 32-bit REAL value from the Win-GRAF REAL variable with address “8”.
UserShare.Get_REAL(Convert.ToUInt16(8),out float_val);

Demo program:

CD-ROM:

1. R/W analogl/O:
\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp02

2. R/W internal long integer, Timer and Real (floating-point) values :
\napdos\Win-GRAF\demo-project\CSharp.net_2008 demo\demo_ demo_CSharp03
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B set_REAL [ Set LREAL

Description:
These functions are to set 32-bit REAL and 64-bit double value to the Win-GRAF REAL/LREAL variable.

Syntax:

UserShare. Set_REAL ( ushort iUserAddress , float iStatus )

UserShare. Set_LREAL( ushort iUserAddress , Double iStatus)

Parameter:

iUserAddress : Address of Variable. (1 to 8192)
iStatus : Set the 32-bit REAL or 64-bit double.
Example:

// Set a 64-bit double value “11234.234567” to the Win-GRAF LREAL variable with address “7”
UserShare.Set_LREAL(Convert.ToUInt16(7),Convert.ToDouble(11234.234567));

// Set a 32-bit REAL value “123.12” to the Win-GRAF REAL variable with address “2”.
UserShare.Set_REAL(Convert.ToUInt16(8), Convert.ToSingle (123.12));

Demo program :
CD-ROM:
1. R/W analogl/O:
\napdos\Win-GRAF\demo-project\CSharp.net_2008 demo\demo_CSharp02
2. R/W internal long integer, Timer and Real (floating-point) values :
\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp03
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14.5.4 R/W String variable Functions

B Set STRING

Description:
This function is to get a Win-GRAF String variable.

Syntax:

UserShare.Set_STRING (ushort addr, Byte [] msg)

Parameter:
addr: Address of Variable (1 to 1024)
msg[] : Get the string value.

Example:
String str_val;
Byte[] msg;

// Get the String value of the Win-GRAF String variable with address “7”.

msg= unicode_to_byte_array(str_val);
UserShare.Set_STRING(Convert.ToUInt16(7),msg );

//Convert String to byte array.
private byte[] unicode_to_byte_array(string msg)
{
byte[] tmpbuf;
if (msg.Length > 255)
return null;

tmpbuf = Encoding.GetEncoding("UTF-8").GetBytes(msg);
return tmpbuf;

Demo program:
CD-ROM:
1. R/W String variable :

\napdos\Win-GRAF\demo-project\CSharp.net_2008 demo\demo_CSharp04
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I Get_STRING

Description:
This function is to set a String value to the Win-GRAF String variable.

Syntax:

UserShare.Set_STRING (ushort addr, Byte [] msg)

Parameter:
addr : Address of Variable. (1 to 1024)
msg|[] : Set the string value.

Example:
String str_val= “Hello World”;
Byte[] msg;

// Set a string value “Hello World” to the Win-GRAF String variable with address “7”.
UserShare.Get_STRING(Convert.ToUInt16(7),msg );
str_val= byte_array_to_unicode(msg);

//Convert byte array to String
private string byte_array_to_unicode(byte[] buf)
{
string tmpmsg;
if (buf.Length > 255)
return null;

tmpmsg = Encoding.GetEncoding("UTF-8").GetString(buf, 0, buf.Length);

return tmpmsg;

Demo program:
CD-ROM:
1. R/W String variable : \napdos\Win-GRAF\demo-project\CSharp.net_2008 demo\demo_CSharp04
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14.5.5 How to Use C# to Convert Win-GRAF String Variable

Before .NET program write to Win-GRAF String variable. The String-type has to convert to byte array.
(According your .NET program Encode. Ex: UTF-8) If you need to read Win-GRAF String variable. Then
you have to convert byte array to String. There is an C# example to show how to convert each other.

Example (Encode is UTF-8):

//Convert String to byte array
private byte[] unicode_to_byte_array(string msg)
{
byte[] tmpbuf;
if (msg.Length > 255)
return null;

tmpbuf = Encoding.GetEncoding("UTF-8").GetBytes(msg);
return tmpbuf;

}

//byte array to string
private string byte_array_to_unicode(byte[] buf)
{

string tmpmsg;
if (buf.Length > 255)
return null;

tmpmsg = Encoding.GetEncoding("UTF-8").GetString(buf, 0, buf.Length);
return tmpmsg;
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Chapter 15 Using eLogger HMI in the Win-GRAF PAC

elLogger is a free and easy HMI development platform designed by ICPDAS. eLogger can not only be used
to design local and Web Server HMI, but can also achieve remote PAC control via Web browser on PC or
smart phone. With Win-GRAF, it is easy to create a professional monitoring application without any
advanced programming background.

o -

e ) Win-GRAF PAC

Win-GRAF (" elogger _
w@w‘j M1 Development Too y
| o Simulate without PAC n | » Free HMI Toolkit n

® Debug/Control/Monitor Online ® Support Local & Web HMI
® Support Five IEC 61131-3 PLC Languages ® Easy & Useful

eLogger Features:

eLogger HMI Page
® Support Modbus RTU/ASCII and Modbus TCP Protocols &3ﬁ fT N ®

® Support Real-time Data Trend

The maximum of five lines in one plot.

® Support Local HMI:

Support variety of HMI elements and the maximum of 32 pages.

® Support Web Server HMI:

Support administrator login.

® Support Account Management (for Local HMI):

3-level operating management: Admin, Power User, User.

® Support Remote Maintenance:
elogger is not only support to upload a program or web pages

and execute (or stop) the program through Internet.

® Support Data Logging
Local database: Support CSV files.
Remote database: Support Microsoft SQL Server 2005 or later.
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Users can download the following Win-GRAF and eLogger demo projects from Win-GRAF FAQ website.

Demo projects for Win-GRAF and elogger:

Win-GRAF Project | elLogger Project | Description Page

Designing the Local HMI and Web HMI Pages

® Introduction of the Win-GRAF  (P3 ~ 4)
eL01.zip el_01.wez ® |Install eLogger Software (P18 ~ 20) P3 ~ P50
® Design and Test the Local HMI (P21 ~ 38)
® Advanced elLogger Functions (P39~ 42)
® Design and Test the Web HMI (P43 ~ 50)
. Configuring a Control Button that can be N
el02.zip el_02.wez Instantly ON and then OFF PS1™55
€103 zip el_03.wez Reading or Modifying the PAC’s Date and Time P56 ~ 64

and Doing Some Control

For more information about these demo projects, visit:
https://www.icpdas.com/en/faq/index.php?kind=273#840 > FAQ-018 (demo_faq018_all.zip)

15.1 Get Win-GRAF Projects

Users can get these Win-GRAF and elLogger demo projects from Win-GRAF FAQ website.

1. Download the file - demo_faq018_all.zip at https://www.icpdas.com/en/fag/index.php?kind=273
(FAQ-018). Or, copy it from the Win-GRAF PAC CD: \napdos\Win-GRAF\demo-project\.

2. Unzip this file and restore the Win-GRAF demo project (e.g., eL01.zip) to the project folder at
C:\Win-GRAF\Projects.

15.2 Get eLogger Projects

After downloading and unzipping the demo_faq018_all.zip file, copy all eLogger demo projects (.wez) to
the project folder at C:\ICPDAS\eLogger\eLogger Developer\Project.

elLogger web page:
http://www.icpdas.com/en/product/guide+Software+elLogger+elLogger

elogger software:
http://www.icpdas.com/en/product/guide+Software+elLogger+elLogger#1089

elogger manuals:
http://www.icpdas.com/en/download/show.php?num=1666&nation=US&kind1=&model=&kw=elogger+
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Chapter 16 Redundancy

ICP DAS Win-GRAF PAC - XP-8xx8-CE6 series support the redundant system:

One redundant system is composed by two Win-GRAF PACs. When the PAC that running programs is
crashed or need to release its control authority by user-defined event, the PAC control authority will
automatically switch to the normal one.

Win-GRAF provides two ways for redundant system: Near-Field Redundancy and Far-Field Redundancy.

Name Definition Near-Field Redundancy Far-Field Redundancy
Main-PAC Rotary switch is set to 7 Rotary switch is set to 6
Backup-PAC Rotary switch is set to 9 Rotary switch is set to 8

The PAC that is running the program and automatically switches
Active-PAC . . .

control authority depending on the condition.

The PAC used to synchronize data and automatically switches
Passive PAC . . .

control authority depending on the condition.

Notice:

1. Do not use two Main-PACs or two Backup-PACs Rotary switch

to form a redundant system.
COM4 (RS-232/485)

2. Win-GRAF redundant PACs support RS-485/RS-422 COM2 (RS-232)

expansion boards (e.g., 1-8142i/ 1-8144i) plugged into

COM3 (RS-485) <
their local slot. Please don‘t use other kinds of 1/0
COMS5

(RS-232)

modules.

LAN2

3. Two PACs are communicating by using these communication ports.

Near-Field Redundancy Far-Field Redundancy
(Rotary Switch: 7 & 9) (Rotary Switch: 6 & 8)

LAN1, used to communicate with Win-GRAF, SCADA, or HMI. It can also

Comunication Port

A. Public IP Port
be used to control Modbus TCP 10 or Ethernet equipment.

LAN2, data sync port.

It cannot connect to a domain, Users need to assign the IP address.

B. Replication Port

must synchronize data in a It allows connecting to a local domain

closed-loop system by using an | for synchronizing data in an open-loop

Ethernet crossover cable. system.

Used to detect if two PACs are running properly.

C. Alive Port

COMS (RS-232) COM4 (RS-232/485)
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Features of the Win-GRAF redundancy

1. Higher safety:
The redundant system conducts communication through LAN1, LAN2, and Alive-port. Active-PAC can
run Win-GRAF project even if only one cable works. If three cables are failed to communicate with the
PAC, the other PAC will automatically become an Active-PAC by a switching mechanism.

2. Unique Public IP:
Win-GRAF redundant system provides a unique J:E1d T X (5051 R
public IP address for SCADA/HMI to access it ‘
without needing to determine which one is the

SCADA/HMI

Active IP address.

Main (1r1)

3. Easy maintenance:
If the redundant system is malfunctioning, the operator can power off and remove the broken one and
replace a spare one without re-installing all files. The normal PAC will automatically send Win-GRAF
project and data to the new PAC.

Notice:

® Do not shut down or dismounting the normal PAC, keep it running.

® Before powering on the PAC, adjust the rotary switch to the proper position and connect all
required communication cables or I/0 modules.

Exception:
Except the Win-GRAF project if there are other projects such as C, VB.net, C# and eLogger HMI,

running in the redundant system, these files need to pre-installed to the spare XPAC (or a repaired PAC)
before re-installing this PAC to the redundant system.

4. Simplifying the programming process:
Users do not need to specify what files or data should be sent to spare PAC because the Win-GRAF
redundant system will automatically handle these tasks.

5. Custom security mechanism:
Users can design a security mechanism in the program, for example, if Active-PAC is failed to connect
to SCADA because LAN1 or RS-485 is disconnected or damaged, it will automatically reboot which
means release its control authority to the other PAC.

6. 1/0 Redundancy:
Besides PAC Redundancy, users can choose iDCS-8000 system to achieve I/O redundancy.
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16.1 What Kinds of Data will Automatically Send to the Passive-PAC?

Win-GRAF redundant system will automatically send a part of data from Active-PAC to Passive-PAC.

What Kinds of Data can Backup Automatically:

The user’s Win-GRAF applications.

The value of variables.

The private data of function block instance.
The PAC’s RTC (Real Time Clock) time.

Retain memory.

o vk W E

The configuration file for Schedule-control (refer to Chapter 17).

The most common data that cannot BackUp to the Passive-PAC Automatically?

1. The status of Timer variable (Ticking or Sleeping).

2. Except for user’s Win-GRAF applications and config files of schedule-control, some files in the
Active-PAC are unable to send to the Passive-PAC. For example, files that stored in the "\system_disk"
or "\Micro_SD" or non-Win-GRAF applications such as C, VB.net, C#, and eLogger applications. These
files should be pre-installed in the spare (or repaired) PAC before mounting it to the redundant
system.

3. If using the COM_OPEN() function to open the serial port, which will not automatically be opened on
the Passive-PAC.

4. The PAC's data that stored in EEPROM memory cannot be backed up automatically.

For some data that unable to send to the Passive-PAC automatically, users can deal with them by
programming as follows. Refer to the "Retain_and_timer" program in the "demo_RDN_2" project.

if is_first_cycle just_after_switch then

(* Just in the cycle after switching. *)
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16.2 Near-Field Redundant System (Rotary Switch: 7 & 9)

Near-Field redundant system is suitable for synchronizing data between two PACs at high speed through
LAN2 port.

Hardware
Two XPAC Rotary Switch One is set to "7" (called Main-PAC)
One is set to "9" (called Backup-PAC)
LAN1 2 x Ethernet cable
LAN2 1 x Ethernet crossover cable
COMS5 (RS-232) 1 x RS-232 crossover cable

16.2.1 The Architecture of Win-GRAF Near-Field Redundant System

1. Redundant system without plugged-in I/O modules:

HMI/SCADA Ethernet Switch

Win-GRAF PAC

Alive Port
H (RS-232) :

Backup (9)

The following architecture of 1/O connection (2 to 5) can also be mixed with two or more.

2. Redundant system with the use of DCON I/0 modules:

Win-GRAF PAC
LAN1

t; ;“ /7
'E : M | élnduSoft
I-87K8/9+  1-70001/0 Alive Port c_
1-87KW 1/0 (RS-232) = L

COM4 i

(RS-485)

Ethernet HMI/SCADA
Switch
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3. Redundant system with the use of Modbus TCP I/0 modules:

HMI/SCADA Ethernet Switch

Win-GRAF PAC

Alive Port
L (RS-232) =

. Backup (9)

Other Modbus
TCP Devices  ET-70001/0

4. Redundant system with the use of iDCS-8830 I/O modules:
This architecture allows to accomplish both PAC and I/O redundancy.

HMI/SCADA Ethernet Switch Win-GRAF PAC

; o
_ & e
REESIRTS

Alive Port
(RS-232)

Backup (9)

LAN2

iDCS-8830 series 1/O

LAN1LAN2

Note: Each pair of plugged-in redundant I/O modules with iDCS-8830 must be the same model
numbers.

5. Two PACs are equipped with Modbus RTU/ASCII I/0 modules:

Win-GRAF PAC

@ InduSoft

tM series 1/O .
LAN2 LAN1 Alive Port 4 u
; . (RS-232)
COmM4
(RS-485) Ethernet HMI/SCADA

Switch
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16.2.2 Set up the Near-Field Redundant System

Win-GRAF Ethernet Switch

Win-GRAF PAC .
Alive Port Rotary Switch

(RS-232)

Step 1: Turn on two PAC with normal mode (i.e., Rotary Switch = 0 & 0) and set IP addresses for
LAN1 and LAN2.

Step 2: Wiring three communication cables for each PAC and power on with redundant mode (i.e.,
Rotary Switch =7 & 9).

Step 3: Modify both communication IP and Active IP in the Win-GRAF project, and download it to
Main PAC (7). After that, the project will automatically send to Backup PAC (9) via LAN2.

Set IP addresses for LAN1 and LAN2:

X The factory default setting of LAN1 and LAN2 is DHCP that must be set as static IP by using
XPAC_Utility.
A. Set the rotary switch to “0” for redundant system.

B. Excute XPAC Utility and select the Manual Save To Flash option under HIVE Registery on the General
page.

XPAC Utility [1.2.7.7]

File Help

| Eeneral2 I Ciisplary IIF' Config INEth:urk IDevice Information I Ao Execution I Rotary E}{d 1 l 4

Welcome to use XPAC Utility
This ool will help vou easy o
Lse XPAC CE series,

Task Bar setting:
[ &t Hide
[ always On Top

) HIVE Registry:
t?:;’ XPAC WINCE Series { ) Auto Save To Flash (Default)

Maunal Save To Flash

Backplane Battery [ Enable Autorun in plugging USE Disk

RTC Battery OK

Configure the synchronization with a time server | Caonfigure ]
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C. Click on IP Config tab and configure LAN1 IP for redundant system. Note that,
1) Set LAN1 IP and Active_IP to be different to avoid IP address conflicts after rebooting PACs.
2) For Win-GRAF and the PAC can communicate properly, both the IP addresses of them must
on the same network segment.

XPAC Utility [1.2.7.7] [

E[/ File Help

[General IGeneraIE I Displa | IP Config || hetwark I Device Information I Auto Execution IRDtaryr E}{el 1 I 4

LAMN 1: LAN 2:
MaC Address: 00-0D-E0-70-00-FF MAC Address: O0-00-E0-GE-OC-44,
() Use DHCP to get IP address 1 {7 Use DHCP to get IP address 2

@ssign IF address wgsign IP address

IP A}dress: |192,1E.8.1.2E|

P ddress: 1199.193.195.17

Note that LAN1 IP

| |

and Active IPmust | M3 ssessoo | Maski pssassams0 |
be different. Gateway: | | Gateway: | |
DMS Server: | | DS Server: ‘ ‘

__Apply By __Apply R

D. Check "Assign IP address” under the LAN2 setting for redundant system.
E. Click both two "Apply" buttons to save the settings.

Set up communication cables and redundant mode (Rotary switch: 7 & 9)

A. Conncet each LAN1 port of PACs to an Ethernet switch.

B. In between two LAN2 ports of PACs must connect to an Ethernet crossover cable.

C. In between two COMS5 ports of PACs must connect to a RS-232 crossover cable.

D. Set the rotary switch of PAC to "6“ (called Main-PAC) and the other one to "8" (called Backup-PAC).
E. Rebooting two PACs.

After rebooting, the LAN2 IP address and Mask address will automatically be set as follows:
Main-PAC (7) : 199.193.195.17 / 255.255.255.0 ;
Backup-PAC (9) : 199.193.195.9 / 255.255.255.0
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Download the Redundant Project

1. Set the Win-GRAF communication IP address
For the first time to download the redundant project, e.g., demo_rdn_2, enter the LAN1 IP address of
the Main-PAC (7). Refer to Section 2.3.5 - “Communication Parameters".

==

e
) Coew
)

The communication IP.

Communication Settings

T5 Runtime

192.168.1.26:502

Help

2. Set the Active_IP address
Set the Active_|IP and Mask address for the " i_redundancy" function depends on the network
environment.

10: i_redundancy - Properties

=

Active TP =1921658.73.37
Passive IF =anto

Mask =255 25500
Gateway _IP = disabled

Reservedl =0

Reservedl =0 - . .
Reserved? =[] If users are not familiar with the setting,
ﬁ:xﬁzﬁ ZE refer to "I/O Board" Settings.

3. Download the Win-GRAF project

Click the “On Line” button ( Al ) to connect, and download the redundant project to the Main-PAC.
After it’s downloaded, LAN1 IP address of the Main-PAC(7) will automatically set to the Active_IP
address and LAN1 IP address of the Backup-PAC(9) will set to Active IP + 1.

PCIWVETCESB1

IP Information IIPVG Information |

Internet Protocol (TCPFIP)
Static

oK} X

PCIVETCESB1

IP Information IIPVG Information |

Internet Protocol (TCPFIP)
Static

oK} X

Address Type: Address Type:

LAN1 IP address and Mask
of the Main-PAC (Active).

IP Address: 192.168.79.37 IP &ddress: 192.168.79.38
Subnet Mask: 255.255.0.0 Subnet Mask: 255.255.0.0
Default Gateway: A DEfault Gateway:

T
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4. Change the Win-GRAF communication IP address to the Active_IP address
Right now, Win-GRAF will show "Communication error" because the current IP address of the

Active-PAC is automatically set to the Active_IP address. Click the “On Line” button again to stop the
connection between the Win-GARF and the PAC.

5 " Q&_

Stop the connection.

Next, change the Win-GRAF communication IP to the Active_IP address so that this project will always
download to the Active-PAC whenever the user wants to debug or change it.

Communication Settings

[TE Runtirne v]

=
il
m

190168 1 26500 N The communication IP.

132.168.73.37:502

Note: Since Win-GRAF Driver v1.10, users can know which one is Active-PAC by checking the
L1 LED indicator on PAC.

L1 LED indicator

Link/Act {9

LANI

ON This PAC is Active PAC

& B

Blinking | This PAC is Passive PAC

Moreover, open the Win-GRAF Driver window on XPAC to check which one is Active-PAC.

Win-GRAF-XP-8xx8-CE6 0K

....... Wm— ¥P-8xxB-CEA driver Wersion 1,028, Jan.03,2018 build 01
Win_GRAF

P_8xx8_CE6 This product is licensed,

Project: demo_rdn_2, Wer=27, CRC=f040046e, Extra_port: None

r—

Elapsed time : 0. 1: &: 5 (Passive-Ready)

w

It means that the PAC is Active-PAC and
Passive-PAC is working normally.
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16.2.3 Test the Redundant Project (demo_rdn_2)

Refer to Section 16.4 for the description of demo projects.

1. View the status of redundant PACs
After Win-GRAF connects to the PAC, click "NewSpy1" to open the spy list window and check the

current status of the redundant system.

File Edit View Insert Project Tools Window Help
el =¥ Gy H X =5 9 i & % € 4 B g (5 "E{ ARUN N
Workspace 0000 HewSmrl.spl
[* demo_rdn_2 [RUN] M ame | W alue | Dezcription
[ Exception programs Hourl 12
3 Programs i MirteT 35 . . .
J“j_q PAC_Time E‘L ’ﬁgrnnrﬁ el The Maln-PAC IS ACtlve-PAC now.
“f3] RDM_coantrol
“Er] Retain_and_timer iz_Backup_Active
[ whatch [for debugging) iz Main_ready TRUE _» <> Main-PAC and Backu p-PAC are
&8 Soft Scope is_Backup_ready THLE ready and LAN1 IP addresses are
= Initial values iz_first_cycle_just_after_switch .
"5 NewGpy1 ) is_Main_LAN1_ok TRUE function normally.
.d Binding Eo@ation iz_Backup LAMT_ok TRUE <> Alive Port (RS_232) are function
g Global defines is_Alive_part_ok TRUE
']:'E[ Wanables iz_Pazsive_ready TRUE _’ norma”y'
B Types is_Active_LANT_ok TRLE <> Passive-PAC is ready.
;I—:f?'”e—mmjk ;HUE | < Both LAN1 IP addresses of
DINT_2 0 Active-PAC and Passive-PAC are
AEAL_T 0.0 function normally.
REAL_2 0o
TMRA_1 0z
THR_1_last_state TRUE: ticking . FALSE: zleep
To_tick_TMR_1 Set TRLUE to start ticking timer1
To_stop_TMR_1 Set TRUE to stop the ticking of timerd
TMRA_2 0z
THR_Z2 last_state TRUE: ticking . FALSE: zleep
To tick_TMA_2 Set TRUE to start ticking timer2
To stop_TMR_Z Set TRUE to stop the ticking of timer?
Note:

1. Before switching the control authority, make sure the Passive-PAC is ready (i.e., "is_Passive_ready"

= TRUE).

2. Users can also click the "Redundancy" button ( & ) to manually switch the control authority.

Al RUN

Eedondancy

() Redundancy iz not enabled in the wntime

{(*) Bunning as active runtime

1N

A T
Pdtn e n

Refresh

Cloze

Pazzive runtime iz alive

The PAC is Active-PAC right now.

() Bunning as passive wntime
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2. Set the value of variables
1) Assign a value to DINT_1, DINT_2, REAL_1 and REAL _2 variables.

2) Set the To_tick_ TMR_1 and To_tick_ TMR_2 to "TRUE" (this status will automatically reset to FALSE)

to start the "TMR_1" and "TMR_2" ticking.

D000 Hew Spyi.spl
| Mame | *alue | Description
PE! iz_Active_LAMNT ok TRUE -
i iz Pazzive LAMT ok TRUE
g+ DIMT 1 Setup az Retain varable in the program "Retain_and_timer"
DIMT_2 1234 Setup az Retain variable in the program "R etain_and_timer"
REAL_1 22.2933933 N ble in the program "R etain_and_timer"
Entera value t _ - C
REAL_2 335 Yy, ble in the program 'R etain_and_timer
(" THF_1 Tl D526ms ) e
THMR_1_last_state TRUE TRUE: ticking ., FALSE: zleep
To_tick_THRA_1 A 4 Set TRUE to start ticking timerl
\ To_stop_THMA_1 . y, Set TRUE ta ztop the ticking of timer =
(TMR_2 Settimer [ ot )
TMR_2_last_state | 10 TRUE” |rqic TRUE: ticking , FALSE: slesp

To tick_TMA_2

\ To_stop_THR_Z

Set TRUE to start ticking timer
Set TRUE ta ztop the ticking of timers

3. Test the redundant system (refer to the “RDN_control” program)
1) Make sure the Passive-PAC is ready (i.e., is_Passive_Ready is TRUE).
2) Remove the LAN1 cable of the Active-PAC (or power the PAC off and on). The Active-PAC will
automatically reboot after a specific time and give control authority to the other PAC. Now, the
Active-PAC is Backup PAC, all values still exist and timers are still ticking.

The Backup-PAC is Active-PAC now.

OO00 NewSpy1.spl

A Mame | Walue

FE [ iz_Mair_Active J/

i iz_Backup_Active TRLE

g+ is_bair_ready TRLUE
iz_Backup_ready TRLUE

iz_first_cocle_just_after_switch

[ is_Main_LAN1_ok

is_Backup_LAM1_ok
ig_Alive_port_ak
iz_Pazsive_ready
iz_Actve LAMNT ok

TRUE
TRUE
TRUE
TRUE

[ is_Pazsive_LAMT_ok

Note:

Doo00 HewSpyl.spl
| Mame | Yalue |
FE! DIMT_1 3
- DINT_2 1234
g+ REAL_1 22299339
REAL_2 315
THR_1 2938251 0ms
THMRE_1_last_ztate TRUE
To tick_THR_1
To_stop_THMRE_1
THMR_2 H29m5:480ms
THMRE_Z2_ last_state TRUE

To tick_TMA_2

To_stop_THMRA_Z

Plug in the LAN1 cable on the Main-PAC (Passive), the statuses of "is_Main_LAN1_ok" and
"is_Passive_LAN1_ok" will become "TRUE".
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16.3 Far-Field Redundant System (Rotary Switch: 6 & 8)

Far-Field redundant system is suitable for multiple sets of redundant PACs whose LAN2 cable is connected
to an Ethernet switch/Hub. Users must set their LAN2 IP address for sending data.

Hardware
Two XPAC Rotary Switch One is set to "6" (called Main-PAC)
One is set to "8" (called Backup-PAC)
LAN1 2 x Ethernet cable
LAN2 2 x Ethernet cable
COMS5 (RS-232) 1 x RS-232 crossover cable

16.3.1 The Architecture of Win-GRAF Far-Field Redundant System

1. Redundant system without plugged-in I/O modules:

HMI/SCADA Ethernet Switch

_ A Win-GRAF PAC
;"'-"",‘:‘ l- "

gl
(_&/ InduSoft

Baékup (8)

The following architecture of 1/O connection (2 to 5) can also be mixed with two or more.

2. Redundant system with the use of DCON I/O modules.
3. Redundant system with the use of Modbus TCP 1/0 modules.

4. Redundant system with the use of iDCS-8830 1/0 modules.
This architecture allows to accomplish both PAC and /O redundancy. Each pair of plugged-in
redundant I/O modules with iDCS-8830 must be the same model numbers.

5. Two PACs are equipped with Modbus RTU/ASCII I/O modules.
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16.3.2 Set up the Far-Field Redundant System

Win-GRAF Ethernet Switch
. Win-GRAF PAC

Rotary Switch

Step 1: Turn on two PAC with normal mode (i.e., Rotary Switch = 0 & 0) and set IP addresses for
LAN1 and LAN2.

Step 2: Wiring three communication cables for each PAC and power on with redundant mode (i.e.,
Rotary Switch = 6 & 8).

Step 3: Modify both communication IP and Active IP in the Win-GRAF project, and download it to
Main PAC (6). After that, the project will automatically send to Backup PAC (8) via LAN2.

Set IP addresses for LAN1 and LAN2:

X The factory default setting of LAN1 and LAN2 is DHCP that must be set as static IP by using
XPAC_Utility.

A. Set the rotary switch to “0” for redundant system.
B. Excute XPAC Utility and select the Manual Save To Flash option under HIVE Registery on the General
page.

XPAC Utility [1.2.7.7]

File Help

‘General | Beneral2 I Diisplay IIF' Zanfig INetw!:lrk IDeuice Information I AUt Bxecution I Rotary Exe_ ! 4

YWelcome 1o use XPAC Uility
This tool will help vou easy to
Lise ¥PAC CE series,

Task Bar setting;
[ &wto Hide:

[ slways On Top

_ HIVE Registry:
t‘?:; XPAC WINCE Sﬁﬁ.ﬁﬁ () auto Save To Flash (Default)

Maunal Save To Flash

Backplane Battery [T Enable autorun in plugging USE Disk

RTC Battery OK

Configure the synchronization with a time server | Configure
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Note:

Click on IP Config tab and configure LAN1 IP for redundant system.

1) Set LAN1 IP and Active_IP to be different to avoid IP address conflicts after rebooting PACs.
2) For Win-GRAF and the PAC can communicate properly, both the IP addresses of them must
on the same network segment.

A

XPAC Utility [1.2.7.7] _|

File Help

IGeneraI I General? I Displa | IP Config |

etwork IDevice Information I AutD Execution IRDtary E}{é 1 I 4

LAN 1:

MaC Address: 00-0D-EQ-70-00-FF
{1 Use DHCP o get IP address

Note that LAN1 IP
and Active IP must
be different.

LAMN 2:

MAC Address: 00-0D-EO-5E-0C-4A
{ ) Use DHCP to get IP address

%ﬂsign IP address
IP Address:  [192.168.1.26

@ﬁjign IP address
IP Ackress:  [192.168.79.21

| |
Mask |255.255.0.0 | Mask: |25 255.255.0 |
Gateway: | | Gateway: | |
DMS Server: | | DHS Server: | |

D. Configure the LAN2 settings for two PACs.

Note:

When using far-field redundant system, user needs to configure LAN2 IP for each PAC.

1) If the LAN2 IP of Main-PAC is x.x.x.n, the LAN2 IP of Backup-PAC must be x.x.x.n+1.

2) The first three octet of LAN2 IP for two PACs must be the same, and the Mask address for
LAN2 and LAN1 must be different.

Rotary Switch

LAN2

Description

Main PAC (6)

IP (E.g.,192.168.79.21)
Mask (E.g., 255.255.255.0)

Download Win-GRAF project to this PAC.
It is Active PAC by default (L1 LED is ON).

Backup PAC (8)

IP+1 (E.g., 192.168.79.22)
Mask (E.g., 255.255.255.0)

It is Passive PAC by default (L1 LED is OFF)

E. Click both two "Apply" buttons to save the settings.
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Set up communication cables and redundant mode (Rotary switch: 6 & 8)

A. Conncet each LAN1 port of PACs to an Ethernet switch.

B. Conncet each LAN2 port of PACs to an Ethernet switch.

C. In between two COM4 (RS-232/485) ports of PACs must connect to a RS-232 crossover cable.

D. Set the rotary switch of PAC to "6“ (called Main-PAC) and the other one to "8" (called Backup-PAC).
E. Rebooting two PACs.

Download the Redundant Project

1. Set the Win-GRAF communication IP address

For the first time to download the redundant project, e.g., demo_rdn_2, enter the LAN1 IP address of
the Main-PAC (6). Refer to Section 2.3.5 - “Communication Parameters".

Communication Settings

T5 Runtime

Cancel
192.168.1.26:502 (] -\

The communication IP.

4
! H
e

2. Set the Active_IP address

Set the Active_|IP and Mask address for the " i_redundancy" function depends on the network
environment.

10: i_redundancy - Properties =]
Rey=p )

Active TP =192168.79 37
Passive IP =auio

Magk =12552550.0
Galeway IF = di=Dled

Rezervedl =0

E:xﬁzﬂ ZS If users are not familiar with the setting,
Reserved3 =0 " " .

Reservedd = [ refer to "I/O Board" Settings.

3. Download the Win-GRAF project

Click the “On Line” button ( Al ) to connect, and download the redundant project to the Main-PAC
(refer to Section 2.3.4 and 2.3.5). After it’s downloaded, LAN1 IP address of the Main-PAC (6) will
automatically set to the Active_IP address, e.g., 192.168.79.37, and LAN1 IP address of the Backup-PAC
(9) will set to Active IP +1, e.g., 192.168.79.38.
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4. Change the Win-GRAF communication IP address to the Active_IP address
Right now, Win-GRAF will show "Communication error" because the current IP address of the

Active-PAC is automatically set to the Active_IP address. Click the “On Line” button again to stop the
connection between the Win-GARF and the PAC.

5 " Q&_

Stop the connection.

Next, change the Win-GRAF communication IP to the Active_IP address so that this project will always
download to the Active-PAC whenever the user wants to debug or change it.

Communication Settings

[TE Runtirne v]

=
il
m

190168 1 26500 N The communication IP.

132.168.73.37:502

Note: Since Win-GRAF Driver v1.10, users can know which one is Active-PAC by checking the
L1 LED indicator on PAC.

L1 LED indicator

Link/Act {9

LANI

ON This PAC is Active PAC

& B

Blinking | This PAC is Passive PAC

Moreover, open the Win-GRAF Driver window on XPAC to check which one is Active-PAC.

Win-GRAF-XP-8xx8-CE6 0K

....... Wm— ¥P-8xxB-CEA driver Wersion 1,028, Jan.03,2018 build 01
Win_GRAF

P_8xx8_CE6 This product is licensed,

Project: demo_rdn_2, Wer=27, CRC=f040046e, Extra_port: None

r—

Elapsed time : 0. 1: &: 5 (Passive-Ready)

w

It means that the PAC is Active-PAC and
Passive-PAC is working normally.
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16.3.3 Test the Redundant Project (demo_rdn_2)

Refer to Section 16.4 for the description of demo projects. Check the status of redundant system in
Win-GRAF “Variable” window and refer to Section 16.4.1 - "I/O Board" Settings for the description of
“i_redundancy”.

Test Steps:
1. Change variable values and start ticking (To_tick_TMR_x = TRUE).

QOO0 [Variables]
“F Mame | Walue
IMIT_1 TRUE

DINT_1 1234
DINT_2 21806
REAL_1 123.456001
REAL 2 456.759001

t#4m1s806ms
t#3m59s407Vms

TMR_2

retain_done TRUE
on_line_change_cycle 0
tmp_bool TRUE
TMRE_1_last_state TRUE
TRUE

To_tick_TMR_1
To_tick_TMR_2
To_stop TWIR_1
To_stop TMR_2

2. In this example (refer to the “RDN_control” program), make sure the Passive-PAC is ready (i.e.,
"is_Passive_ready" = TRUE).

Remove the LAN1 cable of the Active-PAC (or power the PAC off and on), it will automatically reboot
after a specific time and give control authority to the other PAC.

B %I0X10 - i_redundancy
%al¥10.0=is_Main Active

(%1X10.1=is_Backup_Active TRUE |
%al¥10.2=1s_Main_ready TRUE
%l1X10_3=is_Backup_ready TRUE
%IX10.4=is_first_cycle_just_after_switch
YalX10.5=is_Main_LAN1_ok TRUE
%l¥10.6=is_Backup_LAN1_ok TRUE
%al¥10.7=is_Alive port ok TRUE
 %1X10.8=is_Passive_ready TRUE |
%lX10.9=is_Active_LAN1_ok TRUE
%l¥10.10=is_Passive_LAN1 ok TRUE
YalX10.11

3. Then, the Active-PAC is Backup PAC, all values still exist and timers are still ticking.
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16.4 Description of Win-GRAF Demo Projects

The Win-GRAF PAC CD provides four demo projects for the redundant system, i.e., "demo_RDN_1.zip",
"demo_RDN_2.zip", "demo_RDN_3.zip" and "demo_RDN_4.zip". Refer to Chapter 12 to restore these

files to the Win-GRAF Workbench.

Project Name

Description

demo_RDN_1 Using both the COM3 of PACs to connect three DCON I/O modules. |Test

demo_RDN_2 Using two PACs without connecting any I/0 module.

Test, Program

demo_RDN_3 | ' dule) through

Using both the LAN1 of PACs to connect a ET-7050 (Modbus TCP I/O

one Ethernet switch.

Test

demo_RDN_4

Using both the LAN1 of PACs to connect an iDCS-8830 through one
Ethernet switch. iDCS-8830 supports redundant I/O modules.

Test, Program

Note: XP-8xx8-CE6 series support the redundant system.

16.4.1 [Important] "I/O Board" Settings (i_redundancy and i_redundancy_rs485)

<> Used for demo_RDN_1, demo_RDN_2, demo_RDN_3, and demo_RDN_4:
To enable Redundancy function on PAC, users must add the "i_redundancy" function into the "I/O

Boards" window.

EEEE 170 Boards

: S
1
:
3
4 Delete
]
? 1 d undan o7
8 B
3 Active IP =192.168.71.37
B r=dundancy Fassive IF = auio
I )
ateway IF = di= .
12 N\, Eemneg? =g Note:
% Note: peservedl =t DO NOT set the last digit value of the
— . E d3=0 -
15| Using the Slot 9 or later. Recorwodd =10 "Active_IP" as 0 or 254 or 255.
% (Refer to Chapter 4) It should be in the range of 1 to 253.
I_redundancy -
Enable Redundancy in the PAC.
The following PAC zuppart redundancy. Definition of Settmg
#P-Bux3-CER
#P-3ux3-CER
WwP-5248 3z
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Description of "i_redundancy" 1/0 board:
The function is used to display the current status of Win-GRAF redundant system.

Active_IP: This IP address is public for the redundant system to communicate with HMI or SCADA.

DO NOT set the last digit value of the "Active_IP" IP address as 0 or 254 or 255.
It should be from 1 to 253.

Passive_IP: "Auto", the LAN1 IP address of the Passive-PAC will automatically be set as

Mask:

Active_IP +1. E.g., if the "Active_IP" is set as "192.168.71.37",
the "Passive_IP" will be automatically set as "192.168.71.38".

The common settings are either 255.255.255.0 or 255.255.0.0 depending on the
network environment.

Note: After adding the “i_redundancy” in the “I/O Boards” window, it will auto add 12 "BOOL” input

channels in the “Variables” window that can be used to display the current status of the
redundant system.

I Mame | Type | Dim. | Atrib. | Spb. | Initvalue | User.. | Tag | Description
B %010 - i_redundancy -
%lx10.0=is_Main_Active BOOL Input O
0LAM 1—ir Paclam Aetiva BOOL |nput I:l
: V\[ BOCL hput [
%l1¥10.3=i5_Backup_ready AN B Lot =

%l10.4=is_first_cycle_just_aftd Double-click it to add a variable

%I10.5=is_Main_LANT ok ; hch |
%I%10.6=is_Backup_LAN1 ok | NA@Me 10 €ach channel.

%lx10.7=is_Alive_port_ok BOUC Thput 1
%lx10.8=is_Passive_ready BOOL Input O
%lX¥10.9=i5_Active LANT ok BOOL Input O
%l¥10.10=is_Passive_LAMT ok BOOL Input O
01011 BOOL lnput [ v
>
4 ¥ 10 Drivers My Spr 1 RDH control Yariables Retain and timer
Channel | Variable Name Description
Ch.0 is_Main_Active Is the Main-PAC active now?
TRUE: Active PAC.
FALSE: Passive PAC.
Ch.1 is_Backup_Active Is the Backup-PAC active now?
TRUE: Active PAC.
FALSE: Passive PAC.
Ch.2 is_Main_ready Is the Main-PAC ready?
If Ch.2 returns FALSE. The possible reason could be the
following.
(1) The Ethernet cable (LAN2) between Main-PAC and
Backup-PAC is broken.
(2) The Main-PAC is dead or crashed.
(3) The rotary switch of the Main-PAC is not set at 7 (or 6).
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Channel

Variable Name

Description

Ch.3

is_Backup_ready

Is the Backup-PAC ready?

If Ch.3 returns FALSE. The possible reason could be the

following.

(1) The Ethernet cable (LAN2) between Main and
Backup-PAC is broken.

(2) The Main-PAC is dead or crashed.

(3) The rotary switch of the Main-PAC is not set at 9
(or 8).

Ch.4

is_first_cycle_just_after_switch

For Active-PAC only.
True: Now is in the first cycle just after switching.
False: Now is not in the first cycle after switching.

Ch.5

is_Main_LAN1_ok

Is the LAN1 port of the Main-PAC ok?
TRUE: OK.
FALSE: Fail or Ethernet cable is disconnected.

Ch.6

is_Backup_LAN1_ok

Is the LAN1 port of the Backup-PAC ok?
TRUE: OK.
FALSE: Fail or Ethernet cable is disconnected.

Ch.7

is_Alive_port_ok

Is the communication status of Alive Port ok?
TRUE: OK.
FALSE: Fail or the Passive-PAC is dead or crashed.

Ch.8

is_Passive_ready

Is the Passive-PAC ready now?

If Ch.8 returns FALSE. The possible reason could be the

following.

(1) The Ethernet cable (LAN2) between Main and
Backup-PAC is broken.

(2) The Passive-PAC is dead or crashed.

(3) The rotary switch setting of the Passive-PAC
is incorrect.

Ch.9

is_Active_LAN1_ok

Is the LAN1 port of the Active-PAC ok?
TRUE: OK.
FALSE: Fail or Ethernet cable is disconnected.

Ch.10

is_Passive_LAN1_ok

Is the LAN1 port of the Passive-PAC ok?
TRUE: OK.
FALSE: Fail or Ethernet cable is disconnected.
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<> Used for demo_RDN_1:

In this case, using the COM3 (RS-485) of PAC to connect DCON I/O modules. Besides "i_redundancy",

also "DCON" must be added in the I/O Boards window. Moreover, the "i_redundancy_rs485" function

is used to check if the RS-485 port of Passive-PAC can receive data normally.

EEEE 1A0 Boards

9: DCON - Properhes

I

Pof - 15#5

Port=3

Baud_rate = 9600

Watchdog timeowut = 5000

Checksom_enabled =00

Delay_ms between_polls
A I

Host_watchdog_ Enabled =0

Using the COM3 of PAC and
the Baud rate is set to 9600.

=0

Reszervedl =00

s W ) SR

Reszervedd =0

Reserved3 =0

—
C 8 DCON w_ D

Definition of setting |

DCOM

Maote:

1. Thiz "DCOMN" supportz only the communication properties "M,8.1"

That iz "Mo-parity'" . "8 character zize'’ and "1 stop bit'"

Important Notice:

So please must configure all DCOM 140 modules to "M ,8,1"" .

Enable one zerial port [R5-485] to connect remaote DCON /0= [I-7000 series modules . RU-87PE

<

| £

| W

1. The"i_redundancy_rs485" must use with the "i_redundancy" or it doesn't work.
2. The "i_redundancy_rs485" only enable RS-485 ports of Passive-PAC to receive data but not to send

data.

& 1/0 Boards %

1]

1

2 edundan .+ )

3 ey =

4 ot ——trih
ChO0_Port_No=3

g ChO0_Timeout =30 |Wa
LhidDert Me ol

7 ChO0l_Timeowut =20
Ch02_Fort_No=0

8 Ch02_Timeout = 20

9 DCOM Chi2_Port_No =0

i red ChD3_Timeout =30

w_‘ Chﬂ4_Purt_Hu =0

i_redundancy _rzd35 Chi4_Timeout =30

Cho5_Fort_ Ho =0
Ch05_Timeout =20

13 Ch06_Port_No =0
14 Chi6_Timeont = 20
:: g I_redundancy _rz485
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™

Chxx_Port_No:

Using COM3 of Passive-PAC (0: Disable)
Chxx_Timeout:

Set timeout as 30 seconds.

Note:

If no data is received until the expiration
of the time-out, the status of channel
(0-15) will be displayed as " FALSE" in the
"Variables" window.

T

#P-8umB-CEE
#P-92=8-CEE
WP-5248

Detect the R5-485 port state of the pazsive PAC of a redundant zystem. -

The fallowing PAC support redundancy.

Definition of setting

[£
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16.4.2 Declaring Variables (demo_RDN_2)

Users can view or add variables in the "Variable" window (refer to Section 2.3).

Name Data Type Description

Used in the “PAC_Time” program

Yearl
Monthl
Dayl
WeekDay1l DINT
Hourl
Minutel
Second1l

Used in the “PAC_Time” program:
They are used to get the PAC’s system time.

Set_new_time BOOL Set it as "TRUE" to set up new system time.

Year_to_set
Month_to_set

Day_to_set DINT Used in the “PAC_Time” program:
Hour_to_set They are used to set the PAC’s system time.

Minute_to_set

Second_to_set

Used in the “Retain_and_timer” program

DINT_1
DINT
DINT_2 Used in the "Retain_and_timer" program:
REAL 1 Set them as retain variables.
= REAL
REAL_2
TMR_1
TIME Timer
TMR_2
. TRUE: Retain variables are well set up;
BOOL
retain_done 00 FALSE: Not set up yet.
on_line_change_cycle DINT Non-zero, means this is the first cycle just after On-Line
change.
tmp_bool It used to return the Retain status.
TMR_1_last_state TRUE: Ticking ; FALSE: Sleeping.
TMR_2_last_state TRUE: Ticking ; FALSE: Sleeping.
To_tick TMR_1 BOOL Set it as TRUE to start TIMER1.
To_tick TMR_2 Set it as TRUE to start TIMER2.
To_stop_TMR_1 Set it as TRUE to stop TIMER1.
To_stop_TMR_2 Set it as TRUE to stop TIMER2.
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16.4.3 Introduction of the "demo_RDN_2" Project

This project includes one LD program and one ST program.

LD Program — “PAC_Time”
It used to get/set the system time of PAC.

= [* Get currert Time of the PAC #) = (* zet "Set_new_time" to TRLUE to set new time to PAC %)
- Set_newy_time In=t_TIME_SET
Inst_TIME_GET ey _TIME_:
g e I R2 5 TME_SET Q l
. !
| ———]
Year_to_set|Year
Year |- Year]
Month_to_set {Month
honth |-Morith
Day_to_zetDay
Dy |-Dayl

Hour_to_set {Haour
wDay |WeekDay
Minute_to_zet JMinute

Howr |-Hour
Second_to_set{Sec

hinute |-Minute1 = (*Reset "Set_ne_time"to FALSE®) =—

Set_newy_time
R3 R |

Sec.. |-Secondl

LD Program — “RDN_control”
When an error occurs on the LAN1 of the Active-PAC, also the Passive-PAC is ready and its LAN1 is

function normally, the Active-PAC will reboot after 10 seconds, and change the control authority to the
Passive-PAC.

— (* Switch to Passive PAC if Passive iz ready and itz LAN1 is ok howewer Active LANM1 communication has problem *)

iz_Active _LANI _ak Inzt_Tok iz_Pazsive_ready iz_Passive_LANT_ok

! TOM e En PAC REBOOT @

=1
T#10s =t ET

ST Program — "Retain_and_timer"

(* "on_line_change_cycle" is declared as DINT (nonezero means it is in the cycle jsut
after doing on line change) .
"retain_done" is declared as BOOL and inited as FALSE .
"tmp_bool" is declared as BOOL. *)

on_line_change_cycle := GetSysIinfo (_SYSINFO_CHANGE_CYCLE) ;
if (retain_done = FALSE) or
(is_first_cycle_just_after_switch = TRUE) or
(on_line_change_cycle <> 0) then
retain_done := TRUE ; (*just do it one time *)
tmp_bool := Retain_Var( DINT_1, 1) ; (* retain a DINT variable *)
tmp_bool := Retain_Var( DINT_2, 2);
tmp_bool := Retain_Var( REAL_1, 3) ; (* retain a REAL variable *)
tmp_bool := Retain_Var( REAL_2, 4);
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(* if Retain variables havn't been inited yet, use default value *)
if (DINT_1 <-1000000) or (DINT_1 > 1000000) or
(DINT_2 < -2000000) or (DINT_2 > 2000000) or
(REAL_1 < -9.9E10) or (REAL_1 > 9.9E10) or
(REAL_2 < -9.9E10) or (REAL_2 > 9.9E10) then

DINT_1:=0;
DINT_2:=0;
REAL_1:=0.0;
REAL_2:=0.0;
end_if ;
end_if ;

(* is_first_cycle_just_after_switch :
TRUE :just in the cycle after switching.
FALSE : other cycle *)

if is_first_cycle just_after_switch then

(* The Timer ticking state is not auto-redundant. So we have to process them here.
Ticking timer in the cycle just after switching if its last state is "ticking" *)

if TMR_1_last_state then
tStart(TMR_1) ;
end_if;
if TMR_2_last_state then
tStart(TMR_2) ;
end_if;
end_if;

(* Timer operation *)

if To_tick TMR_1 then
To_tick TMR_1 := FALSE ;
tStart(TMR_1) ;
TMR_1_last_state := TRUE ;

end_if;

if To_tick TMR_2 then
To_tick_TMR_2 := FALSE ;
tStart(TMR_2) ;
TMR_2_last_state := TRUE ;

end_if;

if To_stop_TMR_1 then
To_stop_TMR_1 := FALSE ;
tStop(TMR_1) ;
TMR_1_last_state := FALSE ;

end_if;

if To_stop_ TMR_2 then
To_stop_TMR_2 := FALSE ;
tStop(TMR_2) ;
TMR_2_last_state := FALSE ;

end_if;
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16.5 The Description for Other Redundant Projects

16.5.1 Test the Redundant Project (demo_rdn_3, demo_rdn_1)

Description:
Using both the LAN1 of two XP-8xx8-CE6 to connect a ET-7050 (Modbus TCP 1/O module) through one

Ethernet switch.

1. Configure the ET-7000 module
Refer to the ET-7000 manual to set the IP address and 1/0O settings (refer to Section 5.2.1).
Manual: http://www.icpdas.com/en/download/show.php?num=2217&model=ET-7050
Users can also use VxComm Utility to search and modify the IP, mask, and gateway addresses of the
ET-7000.

2. Download the Win-GRAF project ("demo_rdn_3")
If users have ever downloaded the redundant project before, only modify the Active_IP, Mask, and
Win-GRAF communication IP addresses, and then download the project to the Active-PAC.

3. View settings of the Win-GRAF project
In the "1/0 Drivers" window, enabled the PAC as Modbus TCP Master to connect an ET-7050 module
(Modbus TCP Slave, Addr. = 1) and create some data blocks to read/write the DI and DO data (refer to
Section 5.2). Next, double-click on the program name which is shown in the Workspace window to

view program codes.

File Edit View Inert Project Tool: Window Help

s ayee AR BmA

10 Drivers

) demo_rdn_3 T MODEUS Master To enable a Modbus TCP Master to
| Exception programs B Open MODEUS: 192168 71 128:502
[ Programs B <2» Read Input Bits (1]{1..12] connect an ET-7050 mOdUIe and
] PAC Time *B <15> Wite Coil Bits (1][1..6] create some data blocks to read/write

“FE] RDN_control

Mg MODBLS Slave the DI/DO data, refer to Section 5.2.

& Server - Slave number = 1
“B Input Registers [1..2000]

i

"H

—+ B <15 Read Coil Bits (1] [1..6]
g

B

[ *watch [for debugging)
&® Soft Scope

=4 Initial values doi

% NewSpy] " Request | SlawveUrit | Address | Mbltem | Activation | Period (ms] | Period onemar | Timeout fms] | Number of tial:

%3 Binding Carfiguration B4 <2» Read Input Bits 1 1 12 Periodic: 50 5000 1oaa 1

o;g Global defines <153 YWiite Coill Bits 1 1 B OnChange 0 0 1000 1

24 Vaniables <1» Read Cail Bits 1 1 B Periodic 50 5000 1000 1

B Types < ¥
4 » HewaSpig 1 10 Drivers PAC Time RDHN control Retain and timer “wiariables

4. View the status of redundant PACs
Click "NewSpy1" to open the spy list, now the Main-PAC is the Active-PAC.
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- EIEI Y- & W R DR g (5 /AR ZEEER X

Workspace

OO0 0 HewSpayl.spl

M amne | Walue | Description

L
----- [ Exception programs = is_Main_active TRUE . . . ~
&3 Programs I T Bashun o ]\A The Main-PAC is Active-PAC now. 7
PR PAC Time B+ ix_Main_ready TRLE
5| ROM_control iz_Backup_ready TRUE
-------- “&7] Fetain_and_timer iz_first_cycle just_after_switch
=) Watch [for debuagging) iw_Main_LAMT_ok TRUE
(- ¥ Soft Scope iz_Backup_LaM1_ok TRUE . )
_______ o i s Alive port_ ok TRUE The Passive-PAC is ready. So, users
(& [ is_Passive_ready TRUE ]’v can test for changing the control
------- T gnflgu an f$_f-‘-.ctw_e_LAN1_nk TRUE authority of PACs.
------- ;g Global defines iz_Pazsive_LaM1_ok TRUE
------- o} Variables DIMT_1 1 Setup as Retain variable in the program "Retain_and_timer"
------- B Tupes DIMT_2 000 Setup as Retain variable in the program "Retain_and_timer"
REAL 1 na Setup as Retain wariable in the program "Retain_and_timer"'
REAL 2 na Setup az Retain wariable in the program "Retain_and_timer"'
THR_1 0z
To tick_TMR_1 Set TRUE to start ticking timerl
To ztop TMA_1 Set TRUE to stop the ticking of timer
ET7050_CO_err 1} 0: Mo errar [comm. ok) . Comnunication enar of the ET-7060
ET7050_D0_0_ReadBack Felay_ 0~ 5 of the ET-7060
ET7050_D0_1_ReadBack Felay_0~ 5 of the ET-7060
ET7050_D0_2_ReadBack Felay_0~ 5 of the ET-7060
ET7050_D0O_3_ReadBack Felay_0~ 5 of the ET-7080 —
ET7050_DO_4_ReadBack Relay_0~ 5 of the ET-70E0
ET7050_DO_5_ReadBack Relay_0 5 of the ET-7060
ET7050_D0O_0 Relay_0 5 of the ET-7060
ET7050_D0_1 Felay_0~ 5 of the ET-7060
ET7050_D0O_2 Felay_0~ 5 of the ET-7060
ET7050_D0O_3 Felay_0~ 5 of the ET-7060
ET7050_D0O_4 Felay_0~ 5 of the ET-7080
ET7050_DO_GS Relay_0~ 5 of the ET-70E0 v
< | =
4 r| HewSpvel 10 Crivers FALC Time ROM control Retain and timer “ariables

5. Set the value of variables
1) Assign a value to DINT_1, DINT_2, REAL_1 and REAL _2 variables.
2) Set the To_tick TMR_1 to "TRUE" to start the "TMR_1" ticking.
3) Set the ET-7050_Do_x to "TRUE" and the ET-7050_DO_x_ReadBack will return "TRUE".
If the Ethernet cable of ET-7050 is removed, the "ET-7050_COM _err" will return a non-zero value
to indicate the communication error.

6. Test the redundant system
1) Make sure the Passive-PAC is ready (i.e., is_Passive_Ready is TRUE).
2) Remove the LAN1 cable of the Active-PAC (or power the PAC off and on). In this example, the
Active-PAC will automatically reboot after a specific time and pass control authority to another
PAC (refer to the “RDN_control” program).

o000 HewSpyl.spl

| Description

i5_Main_dctive

>

iz_Backup_Active

The Backup-PAC is Active-PAC now.

iz_hain_ready

iz_Backup_ready
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iz first cocle just after switch

[ s Main LAMT ok

=

iz_Backup_LaMNT ok
iz_Alive_port_ak,
iz_Pazsive_ready
iz_Mctive_LAMT ok
iz_Paszive_LANT ok

Plug in the LAN1 cable of Main-PAC (Passive)
to become the TRUE status.

N

DIMT_1 3
DIMT_2 3700
REAL_1 319
REAL_2 5.4
TMR_1

HAmAs5h26ms

To_tick_THMRA_1
To_stop_TMA_1

ET7050_COM_en
ET7050_DO_0_ReadBack
ET7050_DO_1_FeadBack
ET7050_D0_2 ReadBack
ET7050_DO_3 ReadBack
ET7050_DO_4 ReadBack
ET7050_DO_5 FeadBack
ET7050_DO_0
ET7050_DO_1
ET7050_DO_2
ET7050_DO_3
ET7050_DO_4
ET7050_DO_5

130

£

4 ¥ | HewSpvl 10 Drivers FPAC Time

Test the redundant project (demo _rdn 1)

Description:

RLM contral

Retain and timer

When the Backup-PAC switch to the
Active-PAC, all variable values still exist
and timer is still ticking.

Set TRUE to ztart ticking timer
Set TRUE to stop the ticking of timer1
2 Mo eror [comm. ok] , Communication error of the ET-7060

v/ ET-7050_COM _err:
A non-zero value indicates an error.

v If the ET-7050_DO_x is set to TRUE, the
ET-7050_DO_x_ReadBack will return
TRUE to indicate communication is OK .

Felay 0~ 5 of the ET-F0B0
Felay 0~ 5 of the ET-7060
Relap 0~ 5 of the ET-7060
Relay_0~ 5 of the ET-70B0
Felay 0~ 5 of the ET-F0B0

‘Jfariables

Using both the COM3 of two XP-8xx8-CE6 to connect three DCON 1/O modules.

1. Before two PACs connect to remote DCON I/O modules, refer to Chapter 8 to configure each module

by using DCON Utility.Visit "DCON Utility" web page to download the software and user manual
http://www.icpdas.com/en/product/guide+Software+Utility Driver+DCON__ Utility__ Pro

2. Users can review Win-GRAF programs and the "i_redundancy” setting (refer to Section 16.4.1 1/0

Boards Settings).

3. After downloading the Win-GRAF project ("demo_rdn_1"), refer to the test methods of
“demo_RDN_3" noted before (step5 and step6).
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16.5.2 Introduction of the "demo_RDN_4" Project

In the "demo_rdn_4" project, you can click on the program name to view its content, click "Variables" to
see all used variables, or refer to Section 16.4.1 to view the I/O Board settings ("i_redundancy").

This section will introduce you the "Modbus Master" function (refer to Chapter 5 for more details about
operations and the way to set up continuous Offset value for multiple variables).

In this example, we use one redundant |I/O expansion unit (iDCS-8830), two redundant DI module (F-8040)
plugged in its I/O Solt0, 1, and two redundant DO module (F-8041) plugged in its I/O Solt2, 3. Refer to
Section 16.5.3 to configure the iDCS-8830 to function properly. Click the “Open Fieldbus Configuration”

button to open the “IO Drivers” setting window.

I Win- GRAF - demo_rdn 4

File Edit View Insert Project Tools Window Help
S W g Q 5 X = Ea%i&ﬁﬁségﬁ%"%sﬂ'
Workspace 10 Drivers
) demo_rdn_4 “F Mame
|1 Exception prograrms L3 fai Global variables A~
[ Programs | B <2 HeadlnputBlts [1][1..32] Read DA Yearl
“] DO_dema B “B <15 Write Coil Bits (1) [65..96] - Control D0 tdonthi
“#E] PAC_Time - *B <4» Read Input Registers (11 [513.521] - iDCS-8830 status Dayl
“BE] RDN_conkral E B <4 Read Input Registers (1) [577..664] - 120 status WyeekDay b
“&1] ReadMe [*Only comme... |2 Open MODBUS: 192,168, 71.201:502 | A »
“&1] Retain_and_timer d M@ MODEUS Slave Mame | Value
[ Watch [for debugging) an &ix Server - Slave number = 1
ﬂ. Soft Scape 4’. Made | Address | Part | Reconnect &
B It values OpenMODBUS  192.168.71.200 502
S NewSpyT - OpenMODBUS  132.168.71.201 502
!F& Binding Configuration
g Global defines < < *
LE anables I 4 10 Drivers “wWariables 0O demo Mew Spi FAC Time RLM control Feadhde Fetain and timer
Tioe Build »
[ [AN Projects] 4 * | Build Cross references Runtime Call stack Ereakpoints Digital sampling trace Frompt | Hbdl Code Check
Ready OffLine 192.168.71.37:502 é 0,0 399 = 138 0,0

Next, enable the Modbus Master function to connect two Modbus TCP Slave devices. Each iDCS-8830
redundant I/O unit has two IP addresses, e.g., "192.168.71.200" and "192.168.71.201" (Port: 502) that
can be used to read/write the 1/O data and status.

Read Digital Inputs (Using two redundant DI module - F-8040 in the slot0, 1)
10 Drivers

E Mz MEIDELIS b azter
s
E “B <15 write Coil Bits [1][85 EIEi] Contral D0
= “B <d> Read Input Reagizters (1] [513..521] - iDCS-8330 status
ﬁ “B <d» Read Input Reagisters [1] [577..664] - 1/0 status
Q & Open MODBUS: 192.168.71.201:502
Mg MODBUS Slave
Es & Server - Slave number = 1
*B Input Registers [1..2000]
Symbal | Dperation | Ortset | Mask | Storage | Range [Low] |
DCSE820_zlot01_F2040_DI[o] [Data exchange | O FFFF  Default L
iDCSA830_zot01_Fa040_DI1] D ata exchange | 1 FFFF  Default
DCS5E830_zlot0]_Fa040_DI] [rata exchange | 2 FFFF __ Defaul
DC58030_slotdl_Fao4n D3] Data exchange | 3 FFFF  IDCS8830_slotl_F3040_D1[23]  Data exchange| 29 FFFF  Default
DCS2520_slotd]_F2040_DI[4] Data exchange | 4 FFFF DCS8B30_slotD1_FB040_DI[30]  Data exchange| 30 FFFF  Default
IDES8830_$|Dtu1_FBD4D_D|[5] Data e:-:c:hange [ ! I FFFF IDCSBBED_SlDtD-I_FBD-qD_Dl[31] Data e:-:change Kl FFFF Default

£
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Note: We use an iDCS-8830 redundant I/O unit in this example, refer to iDCS-8000 user manual
(CH4 Modbus Addresses Mapping) to know how to input a proper "Base address".
http://www.icpdas.com/en/download/show.php?num=1677&model=FCM-MTCP

MODBUS Master Request | # |

Ok
Description: |
| Cancel
SlaweUnit:

MODBEUS Fequesk

<1 Read Coil Bits
<2 Read Input Bits

::3:5 Read Halding Reaqiskers

A P Tk Fmmickmaes

Drata block

Base address;

A

Read 32 DI status from the address 1.

Aictivvation "Periodic: 0 ms" means sending
— e .
(%) erindic 0 3000 the request continuously.
82” E:U {on error) (If an exception occurred, waiting
N change
2 3 seconds to send next request).
Misc,
i : 1000 ms
Timeaut: ¥ Ifno response over 1 second means
o il communication timeout.

Write to Digital Outputs (Using two redundant DO module - F-8041 in the slot2, 3)

In this example, to write 32 DO status from the address "65" (other settings like the figure above).

lonmers e BODBUS aster Requsst

Mg MODBUS Master

E Requesk
2 &r Open MODBLUS: 192.168.71.200:502 s = ontrol DI |
1 <> Aead [nput Bits [11]1..32] - Read D/
8 =1 <15 Wirite Coil Bits (1] [65..96] - Contral DO SlaveUnit:
= - U status
e *B <4 Read Input Begisters [1] [5?? 884] 1/0 statuz MODELS Request
TE &r Open MODBLUS: 192.168.71.201:502 <5 Write single coil bit A
= Mg MODEUS Slave < Wite single holding register -
éb s Server - Slave number = 1 BT RRr
*“B Input Regizters [1..2000]
gt = Draka block
.S_I,Imbu:ul | Operation | Offzet | Mask | Storage | Base address:
DCSE830 slotzd FA041_DO[]  Data exchange| 0 FFFF  Default
DCSEA20_slat23 FAO041_DO[1]  Data exchange | 1 FFFF  Defaul b items:
DCSB220 slotz2 FB041_DO[2]  Data eschange| 2 FFFF  Default
iDCS8530_slot?3 FE041_DO[3]  Data exchange| 3 FFFF  Defaul Activation
DCS8830_slot23_FE041_DO[4]  Data exchange | 4 FFFF  Defaul @ periodic; | | ms |
DCSE30 slotzd FA041_DO[GE]  Data eschange | 5 FFFF  Default o call
i () On change
DCSAA30_slot23_FA041_DO[28] Data exchange| 28 FFFF  Default Misc.
DCS8830_slot23_Fa041_DO[29] Data exchange| 29 FFFF  Default ) i TS
DCSE830_slot23_F3041_DO[30] Data exchange] 30 FFFF  Default L
DCSBA30_slot23_FEO41_DO[H] Data eschange| 31 | FFFF Default Nb brials:

£
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Read the status of the iDCS-8830

® The “Operation” field of the "iDCS8830 LAN1_error_status" variable is set as “Error report” in order to
show an error code when reading failed. The error code will be reset to “0” when reading success.
Moreover, its “Offset” field must set as “0”.

® Due to the data type of "iDCS8830_System_minor_fault_status" and "iDCS8830_System_major_fault
_status" is "DWORD" (32 bit), the "Offset" must use two Modbus address and the "Storage" must set
as "DWORD (Low-High)".

10 Drivers *

E Mg MODBUS b azter
a2 gy Open MODBLUS: 192.168.71.200:502
I *B <Z» Read Input Bitz [1][1..32] - Read D/
B <155 “Wirite Coil Bits [1][65..96] - Control DD
= :
EE
&z Open MODBUS: 192.168.71.201:502
i Mg MODBUS Slave
5 B Server - Slave number = 1
. Svmbal | Dperation | Offset | Mask | Storage | Ran
| DCS3830 LAMT error_status Error report 0 FFFF Drefault ~
IDC538E0_FCMT_mode [rata exchange 1] FFFF Drefault
iDCS8830_FChMZ_statuz [Data exchange 1 FFFF Drefault
DCS3820_syztemn_buz_statuz [ata exchange 2 FFFF Drefault
iDCS3830_FPR_statuz [rata exchange 3 FFFF Drefault
iDCSE830_Sestern_minor_fault_status  Data exchange 4 FFFF D/ ORD [Low - High)
iDCS3820 Seztern_major_fault_statuz  Data exchange B FFFF DwORD [Low - High] 0
iDCS3R30_LAMT_ID [ata exchange 2 FFFF Drefault o
L >

Note: Refer to iDCS-8000 user manual (CH4 Modbus Addresses Mapping) to enter the "Base address".
http://www.icpdas.com/en/download/show.php?num=1677&model=FCM-MTCP

MODBUE Master Eequest _

)4
Descripkion: |
Cancel |
Slave/Unit:

MODEUS Requesk

<Z = Read Input Bits ~
<3 Read Holding Reqisters —
<4 > Read Inpuk Registers w
~C = Lllvikm mimmle il Rk =
N
[raka block,
Base address:  |513 W
= Read 9 Al values from the address 513.
N (o "Periodic: 0 ms" means sending
©Beriodic: 0 M= [3000 W/ the request continuously.
80” '::'-' {on error} (If an exception occurred, waiting
on change
4 3 seconds to send next request).
Misc.
Timeout: 1000 ™| If no response over 1 second means

Hb brisls: communication timeout.
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Read the 1/0 status of the iDCS-8830

10 Orivers *

E Mg MODBUS Master L
a2 & Open MODBUS: 192.168.71.200:502
I *B «<Z» Read Input Bitz [1][1..32] - Read D/
B B <15 wiite Coil Bits (1] [65..96] - Control D/0
= *B <4> Read Input Registers (1] [513.521] - DCS5-8820 status
E M=] <4> Read Input Registerz [1] [ 3
& Open MODBUS: 192.168.71.201:502 v
Symbol | Dperation | Dffset | Mask | Storage | Ra
€2 IDCS8830_io_sot_status(0] Dataeschange | 16 | FFFF  Defaul
N iDC52230_io_slot_status[1] [rata exchange 17 FFFF Drefault
DCSEE30_Io_slot_status[2] [rata exchange 18 FFFF Drefault
iDC52230_io_slot_status[3] [ata exchange 19 FFFF Drefault
DC58330_Io_slot_status[4] [ata exchange 20 FFFF Drefault
DCS3830 _io_slot_status[] [Drata exchange 21 FFFF Drefault
iDC52230_io_slot_status[B] [rata exchange 22 FFFF Drefault
DCSEE30_Io_slot_status[7] [rata exchange 23 FFFF Drefault
iDC52230_io_emergency_status[0] [ata exchange 32 FFFF Drefault
iDC58330_io_emergency_statuz[1] [ata exchange 33 FFFF Drefault
DCS8830 io_emergency_status[d] [Drata exchange 34 FFFF Drefault
iDC52230_io_emergency_status[3] [rata exchange 35 FFFF Drefault
DC58830_io_emergency_status[4]  Dataeschange | 36 | FFFF Defaut | "DWORD" is a 32-bit data type,
iDC58830_io_smergency_statuz[5] Data exchange | 37 FFFF Default | and needs 2 Modbus addresses.
iDC58330_io_emergency_statuz[R) [ata exchange 38 FFFF Drefault
iDC52230_io_emergency_status[7] [ata exchange 29 FFFF Drefault
iDC58830_io_channel_break_status[0] Data exchange i FFFF WwWORD [Lows - High)
DCS8830_io_channel_break_status[1]  Data exchange 74 FFFF WwWORD [Lowe - High)
iDC52230_io_channel_break_status[2] Data exchange 7B FFFF DwORD [Low - High)
DCS8330_io_channel_break_status[3] Data exchange 78 FFFF [ ORD [Laww - High)
iDC52230_io_channel_break_status[4] Data exchange 20 FFFF WORD [Low - High)
iDC58330_io_channel_break_status[5]  Data exchange a2 FFFF DwWORD [Lows - High)
DCS8830_io_channel_break_status[B] Data exchange o4 FFFF WwWORD [Lowe - High)
iDCS8830_io_channel_break_statuz[7] Data exchange ol FEFE DwORD [Low - Highl
< >
Request
Note: Diescripkion: /0 skakus
Refer to iDCS-8000 user manual (CH4 Modbus
Addresses Mapping) to enter the "Base address". ZeElrE :
http://www.icpdas.com/en/download/show.php?nu MODELS Request
m=1677&model=FCM-MTCP <2 Read Input Bits 4
3= Read Holding Registers
In this example, to read 88 Al values from the address 577. <4 Read Input Registers
. Daka block,
Refer to Chapter 5 for more details on Modbus Master Base address: 577
settings and refer to Chapter 3 for Modbus Slave settings.
hb ikems: as
Ackivation
(%) Perindic: 0 ms 3000
O on call (on errar)
() 0n change
Misc,
Tirmeouk: 1000 ms
b trials: 1
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16.5.3 Test the Redundant Project (demo_rdn_4)

Description:
Use both LAN1 of two XP-8048-CE6 and one iDCS-8830 to connect with an Ethernet switch. iDCS-8830
supports redundant I/0 modules.

Refer to Section 16.2 Near-Field Redundant System and Section 16.3 Far-Field Redundant System to
connect communication ports for the redundant system. Following table lists all used devices in this

project:
Products Quantity | Products Quantity
XP-8048-CE6 2 DN-DI-32DW 1
RS-408 1 DN-DO-16DR-A 1
iDCS-8830 1 DN-DO-16DR-B 1
F-8040 2 CA-3710AM (1M Cable) or 4
F-8041 2 CA-3720AM/30AM/50AM/100AM

The following describes modules plugged in iDCS-8830 from left to right. Visit the web page to download
the software and user manual.

<> MiniOS7 Utility: http://www.icpdas.com/en/product/guide+Software+Development__Tools+MiniOS7

<> iDCS-8000 Website: http://www.icpdas.com/en/product/iDCS-8830

<> iDCS-8000 Utility / User Manual (Software Installation: Ch2.2):
http://www.icpdas.com/en/download/index.php?model=FCM-MTCP

FPM-D2440 * 2: Power modulel, Power module2 (for power input, 24V).

FCM-MTCP * 2: MCU1 (set the SW2 to "C", the SW1 to "8", and the IP address to 192.168.71.200).
MCU2 (set the SW2 to “C”, the SW1 to “9”, and the IP address to 192.168.71.201).
SW2/SW1 means the fourth octect of IP address of the MCU. (C816 = 200; C916 = 201)

Configure IP addresses by using MiniOS7 Utility: (Refer to Section 2.3 of iDCS-8000 user manual)

Open “MiniOS7 Utility” and click “Search” to search current IP addresses of iDCS-8830 (i.e., MCU1/2), and
click “Stop” to stop searching. In this example, set both IP addresses as “192.168.71.200” and
“192.168.71.201” and set Mask as “255.255.0.0”. Next, click the “Set” button and close MiniOS7 Utility.

G ICPDLAS M MindOS7 Utility Ver 226 » | @8 MindO37 Ttility Ver 3.26
@ WinZip » | [/ iDCE-e000 bl Mind0S7 Utility Ver 2.26 Manks

llfl Win-GEALF W I DOON_THdi e - ;
s MimOS7 Ttility ¥Yersion 3.2 6
ll‘:] DA J

- G File [p Comnectio Command [57] Configuration ™

) Modbus Pall b CFE ) Comestiok[- o Co onfiguration ]
- New comnection F2

Lookin:| 1 ot Comection Al o®

Marme Size | Type L

Do | HEE<V File Folder
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(74 MiniOS7 Scan

@%éﬂ&

Stu:up Optiohz Connect  Clear [P se@K Help E xit
\\ | IP/Part | V \ N |.f1".|ia8 | Mask | G Recommend 5 ettings :|
_szdcast 192 168.11.9 4 Etherl O FERZEE00 19
| |TEFEoadCast 1921681110 Wb 255.256.0.0 19‘ IP: 192.166.71.200
TCPBroadCast  192.168.11.8 10 test] 25526600 19
B[ 7CP BrosdCast 216871, : DC5-8830 | 25625500 19| Maske  |2R20500
TCP BroadCast  192.168.71.2001 "\ FCM-MTCP DCS-8830 25525600 19 Gatewsy: 19216801
TCP BroadCast FEEZER00 19
| | TCP BroadCast Select it and click “IP setting”. 255258500 19 Alias: DICS-8630
| |TCP BroadCast e aes e e 25525500 19 SR
TCPBroadCast 192168117 wSE-5800 WISE-S800 25525500 19 _
= f+ Dizable " Enable

F-8040 * 2 :

32-channel DI modules, plug them into the I/0 slot0 and slot1.
F-8041 * 2:

32-channel DO modules, plug them into the 1/0 slot2 and slot3.

Cancel

Configure 1/0 modules by using iDCS-8000
Refer to Section 2.3 of iDCS-8000 user manual for more details.

1) Open iDCS-8000 Utility and enter the IP address of the iDCS-8830 to connect.

iDCS-8000 Utility ver 3.2.2

MBus File Ouline Setting Help

o
iDCE-8000 -
TTili Connect

Controller

IP [192.168.71.200 \

Note:

Your PC and the iDCS-8830 must in
the same network segment (e.g.,
192.168.x.x) to connect successfully.

2) Click "Upload" to upload the current I/O settings that used in the iDCS-8830.

iDCS-8000 Utility ver 3.2.2

File Online Setting Help

Status

x E - |‘F¢F 03:50:34 Successfully connectwith iDCS-5000.
Diseonnect Momitor Tread Load Save E}-ut
Controller
Successfully connect.
IP (19216871, Modbus ID | 1 o—5c! Don’t change it.

Win-GRAF User Manual, V2.0, Aug. 2020 by ICP DAS 16-35



3) Click the 1st FCM-MTCP (MCU1) and set "IOM_0 ~ 3" (F-8040/F-8041) as "Duplex" Mode.

Load J Save

iDCS-8830 Common IOM Configuration Successfully Set
upload.

Status
|Up|uad d%fmm iDCS-8000 finished.

X

Dizmonnect

Upload

Duplex bdode  Break Line

IP |192.168.71.200 odbus ID Set OM_0  |Duplex ~| |OFF =]
D DDD IOM_1  |Duplex ~| |OFF  ~|
I 1 00O
IOM_2  |Duplex ~| [OFF =]
IOM 3 |Duplex

FCM-MTCP

4) If F-8040/F-8041 has not yet connected to termination boards, set the "Break Line" as "OFF".
If F-8040/F-8041 has connected to the following termination boards, set the “Break Line” as "ON".

DN-DI-32DW *1:  32-channel DI termination board. Connect to F-8040 DI modules on slot 0 to 1.

DN-DO-16DR-A * 1: 16-channel DO termination board that used for channel 0 to 15.

DN-DO-16DR-B * 1: 16-channel DO termination board that used for channel 16 to 31.
Connect DN-DO-16DR-A (CN1, CN2) to F-8041 DO modules (slot2, slot3), and then
connect DN-DO-16DR-A (CN3) to DN-DO-16DR-B (CN1).

CA-3710AM * 4 : 1m 37-pin Male-Female D-sub cable, which used to connect to I/O modules and the
termination boards.

5) Click “Set” and click “Download” to download settings to iDCS-8830, and then close iDCS-8830 utility.

Start testing:

First, users must refer to Refer to Section 16.2 Near-Field Redundant System and Section 16.3 Far-Field
Redundant System to know how to set Win-GRAF communication IP address and Active_IP address, and
download Win-GRAF project ("demo_RDN_4").

The following is the description of testing iDCS-8830. Before testing, make sure that all devices are
connected properly and then establish the connection between Win-GRAF and the PAC.

Note: Make sure that both of IP addresses of the PC and PAC are on the same network segment. For

example, if the IP address of PACis "192.168.71.37“ and the Mask address is "255.255.0.0%, set
the IP address of PCas "192.168.x.x".
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After connecting to the PAC, click "New Spy1" to open the spy list.

Win-GRAF - demp_rdn_4

File Edit ¥iew Imert Project Took Window Help
- EIEN-YEY YT CaweaE, s aw ) tEmEwio

Wi & 0000 HewSpyl.spl
Bl MName | Walue | Description
5 Hourl n ~
\__l F’mgrams Minutel 4
“&] DO_demo DS Second! 1
“[E) PAC_Time is_Main_dctive TRUE
“[E] RDM_contral iz_Backup_Active
“E1] ReadMe [Only c... is_Main_ready TRUE
“1] Retain_and_timer is_Backup_ready TRUE
[ “Watch [for debugging) is_first_cycle_just_after_switch
¥ sSoft Seope is_Main_L&N1_ok TRUE
b & iz_Backup_LAM1_ok TRUE
iz_Alive_part_ak TRUE
iireBimdingecertCtion is_Passive_ready TRUE
s‘g Global defines is_fctive_LAM1_ok TRUE
- :_LAN1_ak TRUE
. M1_enor_status I Value : 0 ok . non < enor. LAN erar status of the 1st FCM-MTCP.
Click "New Spyl" o BOLANZ enor_status 0 Value 0 ok , nor-zera: enor. LAN error status of the 2nd FCM-MTCR
B0 FCM1_mode 32 Value : 1680020 : Master, 1680021: Slave. Modbus start-addr = 513. Redundant mode of the 1st FCM-MTCP.
iDCSE830_FCM2_mode 33 Value : 1680020 : Master , 16H0021: Slave. Modbus stat-add = 513, Redundant made of the 2nd FCM-MTCP.
DCSBE30_FCM1_status 16 Walue : 16#0000: Empty . 16#0007: Timeowt , 1680002 Undefined . 1680010: Momal. Modbus-addr = 514, FCM1 status.
DCSBE30_FCM2_status 18 Walue : 1680000: Empty . TEH#0007: Timeout , 1680002 Undefined , 1680010: Mormal Modbus-addr = 514, FCM2 status.
IDCSBE30_FPM_status 3 Walue: 040000: Mo FPM plugged . 0:00070: FPM1 Good / FPR2 OFf | 040002: FPM1 OFf / FPMZ Good | 0x0003: Two FPM are Good. Modbus-addr = 516,
iDCS8830_System_minor_fault_status 1} Walue: 0 nomnal , non-zero: something wrong [refer the iDCS-8830 software manual). Modbus-addr = 517 /518, System minar fault status.
iDCS8830_System_major_fault_status o Value: 00 marmal | non-zera: something wrong [refer the iDCS-8830 software manual]. Madbus-addr = 519 /520 . System major fault status.
iDCSE830_io_slat_status Value: 1680001: Erpty , 1680002 Halt, 16#0004: Boctup, 16#0008: Bootloader, 16#0010: Pre-operation, 168#0020; Operation, 1680040; Stop. Modbus ...
iDCS8830_ia_slat_status0] 32 Value: 1680001: Erpty , 1680002 Halt, 16#0004: Boctup, 16#0008: Bootloader, 16#0010: Pre-operation, 168#0020; Operation, 1680040; Stop. Modbus ...
IDCSEE30_io_slot_status[1] 32 Walue: 1680001 Empty . TE#000Z: Halt, 16#0004: Bootup, 16#0008: Bootloader, 1680010: Pre-operation, 16#0020: Operation. 1T6#0040; Stop. Modbus ...
IDCSEE30_io_slot_status]2] 32 Walue: 1680001 Empty . TE#000Z: Halt, 16#0004: Bootup, 16#0008: Bootloader, 1680010: Pre-operation, 16#0020: Operation. 1T6#0040; Stop. Modbus ...
iDCSBA30_io_slot_status{3] 32 Walue: 16H0001: Erpty . 1680002 Halt, 1680004: Boohup, TE#0008: Bootioader, 16#0010: Pre-operation, 16H0020: Operation, TEH0040: Stop. Modbus
iDCSBA30_io_slot_status{4] 1 Walue: 16H0001: Erpty . 1680002 Halt, 1680004: Boohup, TE#0008: Bootioader, 16#0010: Pre-operation, 16H0020: Operation, TEH0040: Stop. Modbus
iDCSE830_ia_slat_status(S) 1 Yalue: 1640001: Erpty , 16H0002: Halt, 16H#0004: Boctup, 16#0008: Bootloader, 1640010: Pre-operation, 16#0020; Operation, 1680040; Stop. Modbus ...
iDCS8830_ia_slat_status[B) 1 Value: 1680001: Erpty , 1680002 Halt, 16#0004: Boctup, 16#0008: Bootloader, 16#0010: Pre-operation, 168#0020; Operation, 1680040; Stop. Modbus ...
iDCSHE30_io_slot_status[7] 1 Value: 1680001 Empty . 1680002 Halt, 16#0004: Bootup, 16#0008: Bootloader, 1680010: Pre-operation, 16#0020: Operation. 16#0040; Stop. Modbus ...
DCS 8830 Io_smergency_status Walue: 0 OK. . Yalue: TERD00: cable break-off , 16#0020; CIC eror. Modbus start-addr = 609, 10 Emergency status of the iDCS-8830 % slot 0~ 7
IDCSEE30_io_emergency_status(0] 1} Walue: 0 OK. . Yalue: TERD00: cable break-off , 16#0020; CIC eror. Modbus start-addr = 609, 10 Emergency status of the iDCS-8830 % slot 0~ 7
iDCSBA30 in emergency status(1] - 0 Walue: 0 0K, Walue: 16#0100: cable break-off . 1640020 CIC enor. Modbus start-addr = B09. 10 Emeraency status of the iDCS-85330 s shat 0~ 7 b
4> 10 Drivvers “ariables DO deme | NewSppl " PAC Tme RODN control Readhe Retzin and timer
Runtime b4
4 ¥ | Build Cross references Runtime - Call stack Ereakpoints Digital sampling trac: Code Checker
Read C RUM(192.166.7L.37:5020 ) Al 0,252 1079 % 18 287,72 100% gk

iDCS-8830’s Communication Status:

Name iDCS8830_LAN1 error_status iDCS8830_LAN2_error_status

1. Unplug (or plug in) the LAN cable of the 1st FCM-MTCP. Value: Non-0 (or 0).

Test Steps .
2. Unplug (or plug in) the LAN cable of the 2nd FCM-MTCP. Value: Non-0 (or 0).

Return Value | 0: Communication OK; Non-0 : Communication Error

af the 15t FCM-MTCP.

|DESEESEI LAMZ eror_ status 0 YWalue I:I ak. ., non-zera : emar. LAM error status of the 2nd FCM-MTCP.

iDCS-8830’s Power Status:

Name iDCS8830_FPM_status

1. Unplug (or plug in) the power cable of the 1st FCM-MTCP. Value: 2 (or 3).

Test Steps
P 2. Unplug (or plug in) the power cable of the 2nd FCM-MTCP. Value: 1 (or 3).

0: No FPM is plugged. 1: FPM1 Off ; FPM2 Good.

Return Value
2 : FPM1 Good ; FPM2 Off. 3 : Both of these FPM are plugged.

DCS8330_LAMNT_ermor_statuz 0 Walue: 0: ok . non-zero: emor. LN eror stabus of the 1st FCM-MTCP.
DCSE830 LAMZ emror_statuz 0 Walue : 0: ok, non-zero: emor. LAM ermor statuz of the 2nd FCM-MTCP.
DC58830_FCMI1_mode 32 Walue - TEH0020 : Master . 1T680027: Slave. Modbus start-addr = 513, Redundant mode of the 1zt FCM-
DCS2830_FCM2Z_mode x] Walue : TEHO020: Mazter , TEH0027: Slave. Modbus start-addr = 513, Redundant mode of the 2nd FCM
DCSEE30_FCMI_status 16 “Walue : TERO000; Ernpty . 16R0007: Tirmeout , 16H0002: Undefined , 1680010: Mormal. Modbus-addr =
DCS8830_FCM2_status 16 YWalue : TEH0000: Emphy | 181¢EIEIEI1 Timeout , 1680002: Undefined | 'IE#EIEHEI Hormal Modbus-addr = !
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FCM-MTCP’s Redundant Mode and Status:

Name iDCS8830_FCM1_mode iDCS8830_FCM2_mode
iDCS8830_FCM1_status iDCS8830_FCM2_status
Unplug the 1st FCM-MTCP module (FCM1).
iDCS8830_LANT_emor_status 130 Walue : 0 ok, non-zero: emor. LA eror statug of the 1zt FCM-MTCP.
Test Ste iDCS8E30_LANZ eror_status 1] Walue : 0 ok, non-zero: error. LAM error status of the 2nd FCM-MTCP.
P iDCSE330_FCM1_mode a2 Walue : TEHO0Z0 : Master , 16H0027: Slave. Modbug start-addr = 513, Re
iDCS8330_FCMZ_mode a2 Walue : TEHO0Z0 : Master , 16H0027: Slave. Modbug start-addr = 513, Re
iDCSE330_FCMT_status 1 Walue : TEH0000: Empty . 16H0007: Timeout , 1680002 Undefined |, 16:
iDCS8830_FCMZ2_status 16 Walue : TEH0000; Emply ., 1680007 Timeout , 1680002 Undefined | 162

Description

iDCS8830 _LAN1 error_status =130

It means the FCM1 communication error.

iDCS8830_FCM1_mode =32

The redundant mode still displayed as "32" (Master) because the FCM1 is unplug.
iDCS8830_FCM2_mode =32

It means the FCM2 is taking over now and its redundant mode is "Master" (32).
iDCS8830_FCM1_status = 1 means that the FCM1 is timeout.

Return
Value

iDCS8830_FCM1_mode / iDCS8830_FCM2_mode
32 : Master 33:Slave

iDCS8830_FCM1_status / iDCS8830_FCM2_status
0: Empty 1:Timeout 2:Undefined 16: Normal

Plug in the FCM1, it will change to "Slave" mode (33), and becomes a normal status (16).

iDCS8830_LAMT_emor_status 1] YWalue : 0; ok . non-zero : emor. LAM error status of the 1t FCM-MTCP.

iDC58530 LAMNZ error_status 1] Walue : 0: ok . non-zero : emor. LAM eror status of the 2nd FCM-MTCP.
iDC58330_FCk1_mode 33 YWalue : TERO0Z0 : Magter . 16H0021: Slave. Modbus start-addr = 513 B
DCS3830 FCM2 mode 32 Walue : TERO020 : Master , 1680021: Slave. Modbus start-addr =513, R
iDCS8830_FCMI _status 16 YWalue : TER0000; Empty . 16R0007: Timeout , 16R0002: Undefined , 16
iDCS8830_FCM2_statuz 16 Walue : TERO000: Empty . T6R0007: Timeout , TER000Z: Undefined . 16

You can try to unplug the FCM2, and then the FCM1 will become the Master (32) and take over.

iDES8830 LAMT eror_status 1] Walue : 0: ok . non-zero : emor. LAN error status of the 1t FC-MTCP.
iDCS8E30_LAMZ error_status 130 YWalue : 00 ak . non-zero : emror. LAMN errar gtatus of the 2nd FCM-MTCP.
iDCS3830_FCMI_mode 32 Walue : TERO020 : Master , 16H0021: Slave. Modbus start-addr = 513, R
iDC58330_FCMZ2 mode 33 Walue o TERO020 : Masgter . 1680021: Slave. Modbus start-addr = 513, R
iDC58330 FCM1_statuz 16 Walue : TERO000: Empty . 16H0007: Timeout . TER000Z: Undefined . 16
iIDCS8E30_FCM2_statuz 1 YWalue : TERO000: Erply . 16H0007: Timeout , TER0002: Undefined . 16

Plug in the FCM2 afterward.

iDCSE330 LAMT emor_status 1] Yalue : 0: ok, non-zeno; emror, LAM ermor status of the 1st FCM-MTCP.
iDCS8330_LAMZ emror_status 0 Walue : 0 ok, non-zero : emor. LAMN erar status of the 20d FCM-MTCP.
iDC58330_FCk1_mode 32 Walue : TERO020 : Magter . 1680021: Slave. Modbusg start-addr = 513, R
iDCS3830_FCM2_mode 33 Walue : TERO020 : Master . 1T6R0021: Slave. Modbus start-addr = 513. R
iDCS8330 FOCM1_status 16 Walue : TERO000: Empty . T6H0007: Timeout . TER000Z: Undefined , 16
iDCS8E30_FCM2_statuz 16 Walue : TERO000: Empty . 16H0007: Timeout . TER000Z: Undefined . 16

Win-GRAF User Manual, V2.0, Aug. 2020 by ICP DAS 16-38




The Status of 1/0 Slot and I/O Emergency:

Name iDCS8830 _io_slot_status iDCS8830_io_emergency_status
Unplug the cable between the 1st F-8040 (slot 0) and the terminal board DN-DI-32DW.
0 io_slob_status Walue: T6H0007: Empty , TERO002Z Halt, 16#0004: Bootup, 1680002
I DCS8830_1o_slot_status(0] B4 I Walue: TERO00T: Empty . 16H0002: Halt, 16#0004: Bootup, 1680003
iDC58830_io_slot_status[1] 32 Yalue: TEH0001: Empty . 1640002 Halt, 1640004: Boatup, 1680003
iDCSB830_io_slot_status(2] 32 Yalue: TEH0001: Empty . 1640002 Halt, 1640004: Boatup, 1680003
DCS8330 o slat_status[3] 32 Walue: T6R0007: Emply , TER000Z: Halt, 16#0004: Baotup, 1680002
DCS8330 _io_slat_statuz[4] 1 Walue: 16H0007: Empty , 160002 Halt, 16#0004: Baotup, 1680005
Test step DCSE330 _io_slat_statuz[5] 1 Walue: TERO00T: Empty . 16H0002: Halt, 16#40004: Bootup, 1680008
iDCS8830 jo_slot_status[B] 1 alue TEHO001: Foonty TEHOO0Z- Halt TEHO004- Pochin TEHIAN
DCS8330_in_slat_statuz[7] 1 Note:
iDCS8830_io_emergency_stalus The "iDCS8830_io_emergency_status[x]"
| IDCS8330_1I0_emergency_status(0] 286 |A’ K | h the "IOM X" i tt
IDCS8330_1I0_emergency_status(1] i} XVOF S OI: y when the _X'lssetto
iDCSBA30_io_emergency_status(2] I} DuPIex Mode.
iDESBBBD_iU_EmErgEnC}'_StatuS[g] I} [ L e ) o e | T i e | e L ) e
iDCS8830_io_slot_status[0] = 64, which means this module (slot0) is stop working.
. iDCS8830_io_emergency_status[0] = 256
Description . . . -
It means the cable which plugged into this module (slot0) is disconnected.
Plug in this cable and then you can try to unplug others cable for testing.
iDCS8830_io_slot_status[x]
Return 1: Empty 2: Halt 4: Bootup 8: Bootloader 16: Pre-operation 32: Operation 64: Stop
Value iDCS8830_io_emergency_status[x]

0 :Normal 32:CICError 256: Cable Break-off

Redundant DO module:

Name iDCS8830_slot23 F8041 DO
Plug in the 1st F-8041 DO module (slot2).
iDCS8330_In_zlot_statuz Yalue: TER0007: Emphy . TERO00Z: Halt,
iDCS8330 io_slat_status[0] 32 Yalue: TERO007: Emphy . TERO00Z: Halt,
IDCSE830_I0o_slot_status(1] 32 Walue: TERO007: Empty , TERO00Z: Halt,
I iIDCS8330_io_slat_status[?] 2 I Yalue: TER0007: Emply . TERO002: Halt,
iDCS8330 io_slat_status[3] 32 Yalue: TER0007: Emphy . TER000Z: Halt,
Test step iDCS8830_slot23 FA041_DO F-2041 Digital Output in the slat 2 - 3 [Duplex mode] of iDCS-8830
DCS8030_sIot23_FE041_DO[O] F-8041 Digital Dutput in the slat 2 - 3 [Duplex mode] of iDCS-8830
DCS8330_slot?3 FA041_DO[] F-8041 Digital Dutput in the slot 2 - 3 [Duples mode] of iDC5-3830
iDCSAE30 glot23 FAO4T_DO[2)] F-2041 Digital Output in the slat 2 - 3 [Duples mode] of iDCS-8830
iDCSAB30_slot23 FAO41_DO[3] F-2041 Digital Output in the slat 2 - 3 [Duplex mode] of iDCS-8830
DCS8030_sIot23_FE041_DO[4] F-8041 Digital Dutput in the slat 2 - 3 [Duplex mode] of iDCS-8830
DCS8330_slot?3 FA041_DO[S] F-8041 Digital Dutput in the slot 2 - 3 [Duples mode] of iDC5-3830
iDCSAE30 glot23 FAO41_DO[E] F-2041 Digital Output in the slat 2 - 3 [Duples mode] of iDCS-8830
iDCSEB30_slot23 _FA041_DO[A] F-2041 Digital Output in the slat 2 - 3 [Duplex mode] of iDCS-8830
At first, the LED indicator (called DOO ~ 7) of the 1st F-8041 module (slot2) will light up
L. sequentially. When you unplug this module, the 2nd F-8041 module (slot3) will take over
Description

and do the same thing. Then, you can view the status value of the iDCS8830_io_slot_
status[2] is "2" which means this module (slot2) is halted. (Plug in this module again.)

Win-GRAF User Manual, V2.0, Aug. 2020 by ICP DAS 16-39




Chapter 17 Schedule Control

Win-GRAF PAC

Introduction:

All Win-GRAF WinCE series PAC support the Schedule-Control function. One PAC can control max. 10
Targets (devices) with specified schedule configurations. Each schedule Target (device) contains three
variables to be controlled — one BOOL variable, one DINT variable and one REAL variable. ICP DAS
provides a free software — “Schedule-Control Utility”. User can use this software to edit /modify the
schedule configurations easily in PC or in PAC.

Driver version of Win-GRAF PAC:
The Win-GRAF PAC supports Schedule-Control in the below driver version and the new version.

WinCE PAC Win-GRAF PAC Driver Version
ViewPAC VP-x2x8-CE7 1.02
WP-8000 WP-8148, WP-8448, WP-8848 1.02
WP-8000-CE7 WP-8128-CE7, WP-8428-CE7, WP-8828-CE7 1.01
WP-5000 WP-5238-CE7 1.01
XP-8000-CE6 XP-8048-CE6, XP-8348-CE6, XP-8748-CE6 1.01

You may download newer Win-GRAF driver at
https://www.icpdas.com/en/download/show.php?num=695
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17.1 Install the Schedule-Control Utility and Restore the Win-GRAF Demo
Project

There is one Win-GRAF-PAC-CD in the Win-GRAF PAC package box. The Schedule-Control Utility file
name is “Schedule_in_PC.exe” in the “CD:\napdos\Win-GRAF\Tools_Utility\” path.

Please copy this Schedule-Control Utility (Schedule_in_PC.exe and label_name.txt) to your PC.
Recommend to copy it to the directory of your Win-GRAF project. For instance, copy it to
“D:\Schedule-Control\Station1\Schedule_in_PC.exe “, then run this “Schedule_in_PC.exe” file.

Then we will see the following windows (Click New > Target 1).

MNew ‘ Open frora PC ' ]Gﬂfmm(:omo}]x:: ’ Help-sbout
2a ehedite-Control Uttty TS - _— - =TERE ]
Save B Send o Clontraller el tome s hocidzatiog | Orpem Frcan B2 HG‘ei‘mOmm]hr Help-akaoml | |
Tile, Tk
|
|
Target 1 Target 2 Target 3
2 ScheduleControl Utility o e e - = (==
Back o o PO ‘
H HBeelrzn Intrare Feal
@ Target 1 Diefaal Vel OFF o~ 0 00
Target 4 = i
Target 7
[ Season Always Always
Season Always Seagen ‘ l Seagon 2 F ‘ Season 3 ‘ Season 4
i
1 1
o @ Normal day
SO -
& Nomnel day (Schesnlz 1 %) Aiyt [t 1 | Seherdle
T Sanday O
Holiday 1 S —_—
E 7| Mondzy
3 Echedale 3
_' Holiday 2 vl :
7| Welresday AR
* Special day | Thusdsy Seheduled
| Friday
| Bnburday | Sohedile 5

There is one another Schedule-control utility, however it is set up on the PAC (not on the PC). It is
“Schedule_in_PAC.exe”. You can find it in the “\System_Disk\Win-GRAF\” path of the Win-GRAF PAC.
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Restore Win-GRAF demo project :

The Win-GRAF demo project for the Schedule-Control is “demo_schedule.zip”. It is in the

“\napdos\Win-GRAF\demo-project\” path of the Win-GRAF-PAC-CD. Restore it to the PC/Win-GRAF

workbench by the following way.

[ Win-GRAF

|'Ei1_e Yiew Tools Wmdow Help
iy New ProjectList..
QOpen Project List

@ Add New Progect...

| Add Existing Project | @ FromDisk..

Print Setop... 88 From Zip... K

1 CAWin-GRARProjectsdemo_schedule w1 From Target... N

2 CAWin-GRARProjectsdemo_8083w w5l Frop XML Export file...

1 [ 21 x|
F(Q): | O demo-project 1 o F 2 E.

ﬁ e @demo_vhﬂl.zip. N\ _;gjdem_fnez.zfp |

) demo_user_C zip "idemo_filel zip (

i iz paa e

FEBLS

Y demo_wp5_retain zip

.‘.ﬁ demo_tmr3 zip
@ demo_tmi?2 zip
& Jdemo_tmr] zip

@ demo_retain zip
demo_rdn_3.zip
) demo_xdn_2 zip

sdemo_schedule zip

o\

{}demo_extirs_portzip (
) demo_ET7060 zip
@d_ET?UlSz.zip
{JDEMO_DL_100T485 zip
) DEMO_D_87084 FR zip
{)DEMO_D_87084_C8.zip
) DEMO_D_87084_C4 zip

P ——

Yi-r 2} demo_vb04 zip U demo_rdn_1 zip @) DEMO_D_7083 zip
-« bdem_vWB.zip U demo_passwd zip demo_d_7065 zip
FAVE ) demo_vb02.zip L dema_my_ap zip idemo_d_7018z zip
v [F s
b LA WAQ: |demo_schedule zip = 5L ={(e)]
L‘f{f QOpen From ZIP )_q vl BUH

The archive includes library elements. SHeBH)
Do you want to add them to the library?
Addto ibrary: IU ser ‘
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17.2 Introduction of the “demo_schedule” Project

This “demo_schedule” project shows the way to do schedule-control. Please prepare one Win-GRAF PAC
(like VP-x238-CE7 or WP-8x48). One PAC can control schedules of max. 10 Targets (Target 1 to Target 10).
Each Target contains one BOOL, one DINT and one REAL variable.

Settings in the “1/0 boards” window :

To enable schedule-control in the Win-GRAF PAC, first click the “Open I/Os” to add one “Schedule” (add
it in the slot number 8 or bigger number). There is a “Password” parameter in its “Properties” window.
The “Password” is for the “Schedule-Control Utility” running in PC to identify the authorization when
connecting the Win-GRAF PAC. It is set as 0 in this demo project. After adding the “Schedule” in the “I/0
boards”, we can find 10 BOOL input channels in the “variables” window. These 10 channels return the
state of the schedule-control of the Target 1 to 10. TRUE means the Target has the schedule-control
enabled by the “Schedule-Control utility”. FALSE means not enabled.

Window Help 1.

B
0 al Cloze
i
5 Select
3
Y Delets
5
E Double-click it to add the ee
] 7 Schedule” function board. pmp,,tiﬂk
5 A 3
BT 5 cheduie Wirtual/Feal

11
1: 10: Schedule - Properties |8

1 Bey =0 Variables
1. [Ref = 16810 " Name | Tune Dirn | abrib
N R emrved0 =0 Hourl I/O Board — Schedule has 10 BOOL
:III %‘““‘ﬂ;‘g 4 Minute1 inputs. They indicate if the released
R amrend 3 =1 ' Secondl Target 1 ~ 10 has enable the
W T[;TJTE?‘I?EPHQE schedule-control or not.
B IS demo_schedule o RETAIN varigbles  §
F-{all Exceplion prograins 1 B %IX10 - Schedule
F--{a Programs %I%10.0=Target01 EOOL Input
- il M _ %1X10.1=Target02 BOOL Input
0 ‘—J:L“":Shuf:”ﬁ’?“gg'”g] %[X10.2=Target03 BOOL Input
... e %1%10.3=Target04 BOOL Input
- B Il values %IX10.4=Target05 BOOL Input
s e Mol , %IX10.5=Targel0s BOOL Input
g Binding Configuration %110, 6=Target07 BOOL Input
8 tikbl defes %1X10.7=Target08 BOOL Input
B Varisbles v\ %1X10.8=Targei9 BOOL Input
5. %1X10.9=Target10 BOOL Input
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Variable declaration:
Click the “Variables” to view all variables in this demo project.

Win-GRAF - demo_schedule

Wi

File Edit ¥Yew Insert Project Tools Window Help

_.|H .:’L.'II.I '3' TR PR, }

Sl |2 AW SR 05 R A
Workspace Juaisbies ——_———— — — — |
[ i) demo_schedule T Heme | Type | Dim. | &t
[+~ 3 Excephon programs SR ] Global variables
| [ Programe Target_01_BOOL BOOL
] Main Target_02_BOOL BOOL
El- [ Watch [for debugging) Target_03_BOOL BOOL
8 Soft Scope Target_04_BOOL BOOL
= Initial values Target_05_BOOL BOOL
& NewSpyl Target_06_BOOL BOOL
¥4 Binding Configuration Target_07_BOOL BOOL
39 Global defines Target_08_BOOL BOOL
i} Variables Target_09_BOOL BOOL
B Types: Target_10_BOOL BOOL
Target_01_DINT DT
Target 02_DINT DINT
Target 03 DINT DinT
Target 04 DINT DIMT
Target 05 DINT DINT
Target 06_DINT DiMT
Target 07 DINT DINT
Target 08 DINT DINT
Target 09 _DINT DIMT
Target_10_DINT DiNT
Target_01_REAL REAL
Target_02_REAL REAL
I....._..l [ o T o Tl N | o [l N |

The above variables - "Target_01_BOOL ~ Target_10_BOOL”, “Target_01_DINT ~ Target_10_DINT” and
“Target_01_REAL ~ Target_10_REAL” - will be controlled by the Win-GRAF PAC. They represent these
variables belong to the 10 Targets .
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Data Binding
Refer to Chapter 7 for more details about the Data Binding. If the user wants to open variables of this

Win-GRAF PAC for other PACs to read data, these variables that described as above should be dragged
into the “Public” area of the “Binding” window, and then assign a ID for them. To be controlled correctly
by the Schedule-Control configurations, the “Identifier” number Must be set from 5001 to 5030. After
that, the system will deal with the schedule controls for ten targets according to the settings in the
Schedule-Control Utility.

Window Help 1.
W Yo P Q) B g | (5 " A

Binding

ek Marne | Yalue
e FLELIC [:3000) Mame FUBLIC

Fin
= = Trearl Address
B @ 2Monthl 2. Por 3000
E =2 3Daul b
2 4weekDapl
g 25:{”:1 N 2 ZMonthl
CMIAUE .
. 2 3Da User may select the
2 Y:Secondl O 2'eekDavl
@ 11:Targst0l 4. ESRERT L “Identifier” field of
Q 127 o _ B 5:Haourl
| arget EMinute] Target_01_...
S 13 Targetl3 @ 7Second! | Target_10 ... variables.
2 14:TargetDd s u
_ & 11:Targetll | Then, click “Iterate
2 15:Targetls @ 12T 2
. - T on 5 13'TE"5'E 0 property” to assign
| ;[ arget .
Narne | Identifigr | Po @ 14Taqetng | CONtinuous number.
Target 01_BOOL| 5001 Targe
Target_01_DINT| 5002 2 1oTagels =3 7
Target D1_AEALL 5003 Mame | Idertifier A | Paosit

Target_02_B00Y 2004
Target_02_DINT| 5005
Target_02_REAL| 5006
Target_03_BOOY 5007 Target_02_BOOL
Target_03_DIMT | 5003 Target_02_DINT
frocitt ol S et
? H;:;n ‘ariables Binding ¢ Target_03_BOOL
Build Target_03_DIMNT

Target_03_REAL
—— Tarnat N4 RO

Target_01_BOOL  gaiauy]
Target_01_DINT [
Target_01_REAL

5. 4| ¥ dain| varizbles | Binding
X
Marne A
From: IEEIEH 3: By 1 =
|- Reszults |

Note: If the user want to publish Win-GRAF variables to allow the eLogger HMI to get data. Refer to
Section 3.1 To Enable the Win-GRAF PAC as a Modbus TCP Slave for more details.
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17.3 Edit Schedule Configurations by the Schedule-Control Utility

Here shows a simple example to use the Schedule-Control Utility, refer to Section 17.5 for details.
1. Execute the Schedule-Control Utility (Schedule_in_PC.exe) in the PC.
(Click “New” and click “Target 1” to open the Schedule setting window for the “Target 1”).

|Cnmolerwwhmnmn Cipea fren PO Gt foten, Coontroller

Newk
N\

Target 1 Target 2 Tarpet 3
Target 4 Target 5 Target 6
Target 7 Target & Target 9

2. Enable/Set the Season and Schedule Date.
(1) Check “Target 1 ” box to enable and set Target 10
the Target 1. |
(2) Click “Season Always”. -
(3) Check “Season Always” box to enable it.
(4) Click “Normal Day” item (Normal day is usually used for Monday ~ Friday.)

(5) Check “Normal Day” box to enable it and then set proper settings (e.g. Monday ~ Friday).
(6) Click “Schedule 1” to set the schedule period for the “Schedule 1”.

—— I ——=E i
Target 1 > Season Always > Normal day ! !

(r—————— m—
1 Schedule-Control Utility

Back Saverto PC ‘
Boolean Integer Eeal
W Target 1 Default Value  OFF =1 0 00
Th e “uxn
means that
the item is
ena bled . I;_.r'l SB&SDII _A]“ays Al WaYs
N @
Zeason Always * Zeason 1 Feazon 2 Seazon 3 Zeazon 4

#\ Normal day  Schodule 1
® Nomnal day {Schedule 1 111) : Bope 1| Sctedeh | ¥ Scheduls 2 a

[ Sunday
= Holiday 1 7] Moidey

. . ] Twestsy Schedule 3
(2 Holiday 2 e
(] Wednesday
7) Special day [¥] Thuesday | Schedule 4
[] Fridayr
[ ety Seheduls 5

L
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3. Set the Schedule Period

After selecting "Schedule 1" in the step2 — (6), do the following steps.

(1) Check “01” to enable the setting for the No. 01 Time Period of the Schedule 1.
(A) Set up the time as the figure below, or the time which easily for testing.

(B) Set up the Boolean, Integer, Real variables to the values that you want to control, or follow

the setting in the figure below.

(2) Check “02” to enable the setting for the No. 02 Time Period, such as the step (1).

Each schedule can set up a max. of 15 Time Periods.

After completing the settings, click “Save and exit” to save and exit this window.

Schedule 1
‘ Copar from
Hour Minute To Hour Minute Boolean Titeger Feal

[7] 01 B - 3 - 12 =0 = OF + 10 12.34
7] 02: 13 =0 o 17 -~ 30 - O - 0 2567
[T L 1] u u u (B3 u :U

] 04: b i 0 0 OFF i i

[ 05: 0 i 0 0 OFF 0 0

] 06: 0 0 0 0 OFF i i

[ 07: 0 0 0 0 OFF i 0

[ 08: 0 0 0 0 OFF o i

[ 09: 0 0 0 0 OFF i 0

[ 1o: 0 i 0 0 OFF 0 i

] 11 0 0 0 0 OFF O 0

[ 12: 0 o 0 0 OFF i i
12 0 0 0 0 OFF i 0

[ 14: b o 0 0 OFF 0 i

[ 15: 0 i 0 0 OFF 0 0

Save and exit ! Cancel |

=

4. Then, it will go back to the previous setting window as the figure below. And, the

on the screen means the season or schedule has been configured.
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Target 1 > Season Always > Normal day .

{n;,—'i Schedule-Control Utility

[ Back Bave o PO ‘

» ©

Boolean Integer
@ Target 1 DefaultVelue  OFF =1 o

Real
0o

®

¥l Season Always

Always

Season Alway@ “

‘ Beason | ‘ ‘ Season 2 ‘ ‘

Season 3

‘ ‘ Zeason 4

The “*” means that item is configured.

) Holiday 1
&) Holiday 2

) Special day

@ Normal day (Schedule Apply SCth%@ =

¥l Normal day

[7] Monday
(@] Tuesday
(] Wednealay
[7] Thursday
[¥] Friday

[ Baturday

‘ Schedule 2
Schedule 2
‘ Schedule 4

Schedule 5

5. “Default Value” (in the upper right) is for the default setting. If the current date is not found in any
Schedule setting or the date is found, however, its time period is not found in the related Schedule
1~ 5, the Target device will be controlled follow the “Default Value”. The “Default Value” in this

demo project is “Boolean: OFF, Integer: 0, Real: 0.0” .

Advantage of the Default Value:

Utilizing the "Default Value" can reduce the amount of the Periods setting in the Schedule 1 ~ 5.

Ex: The following example sets 5 Periods in the Schedule 1.

(1) 00:00 ~ 08:00
(2) 08:00 ~ 09:50
(3) 09:50 ~ 10:00
(4) 10:00 ~ 11:50
(5) 11:50 ~ 24:00

OFF 0 0.0
ON 0 0.0
OFF 0 0.0
ON 0 0.0
OFF 0 0.0

If utilize the "Default Value" as "OFF, 0, 0.0", the user just needs to set 2 Periods as below.

(1) 08:00 ~ 09:50
(2) 10:00 ~ 11:50

ON 0 0.0
ON 0 0.0

6. After completing all settings, click “Save to PC” to save a configuration file in PC.
(This demo uses “test1.txt”)
7. Click “Back” to return to set up other Targets. (This demo sets Target 1 only)
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17.4 Testing the “demo_schedule” Project

This section shows the way to implement the Win-GRAF project and schedule configuration in the
Win-GRAF PAC. Then testing the schedule control.

1. Download the “demo_schedule” project to the PAC by the Win-GRAF workbench.
(For more information, refer to Section 2.3.5)

2. Download the schedule configuration to the PAC by the Schedule-Control Utility.

Note:

(1) Click “Send to Controller”.

(2) Assign the PAC’s IP address (remember to fill in your PAC’s IP address)
Set a password (This demo uses “0”)

Check “Remember Password” can remember this password
Click “OK” to send the schedule setting to the PAC.

(3)

If success, it will pop up a “Send file success” window.

Before downloading the project, make sure the Schedule-Control Utility on PAC has been

activated. Moreover, add the \System_Disk\Win-GRAF\Schedule_in_PAC.exe path in the
Auto Execution page of the PAC Utility.

E_=

rn\;‘ Schedule-Control Utility' — - . [E_‘i‘ % |
Save to PC SendtoCon\tco]ler Controller time synchronization Open from PC ’ l Get from Controller ‘ Help-about
Title: Title ( 1 )
Target 1 * Target 2 Target 3
o5l Controller info =8 =
Target 4 IP: 192.168.75.101 [
Pasword : @ @
[] Remember password — |
[ [ || Send fil ; -
= = [ 2 e SUCCess ]
Target 7 Target 8 ' a
Target 10

~
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3. Test the Win-GRAF project:
Click “On Line” to connect the PAC by the Win-GRAF workbench, then open the “NewSpy1” window.
If the connection is fine, we can see variables - Target_01_xxx ~ Target_10_xxx are controlled
properly by the schedule configurations which is set by the “Schedule-Control Utility”.

The user may use the “Schedule-Control” Utility to modify the schedule configurations and then
download to the Win-GRAF PAC to see if those variables are controlled well.

Win Win-GRAF - demo_schedule El@

File Edit WView Insert Praject Tools ‘Window Help

AR AR Y A = I S AR F R R A= TR i

Workspace OO00 NewSpy1.spl *
[* demo_schedule [RUM] [ Mame | Wale “F Mame A Value | Type
[ Exception programs g Yearl 2017 oy Global variables -
[ Programs Manth1 7 Current_Fage 0 DINT
“HE] Main g+ Dayl 5 Day1 5 DINT
[ “Watch [for debugging) WeekDayl 3 Hour 10 DINT
R Soft Scope Hourl 10 Minute1 29 DINT =
= Initial values Mitwite 29 Manth 7 DINT
“Bd MewSpyl \’ Secondi | Second 39 DINT
#ia Einding Configisation Targetdl TRUE Target 01 BOOL  TRLE BOOL
0 Global defines Targetl2 Target_01_DINT 10 DINT
il Wariables Targetl3 Target_01_REAL 12.34 REAL
B Types Target_01_BOOL  TRLE Target 02 _BOOL BOOL
[ (&l Projects) Target_01_DINT 10 Target_02_DINT 0 DINT
Target_01_REAL 1234 Target 02 REAL 0.0 REAL
Target_0Z2_BOOL Target 03 BOOL BOOL
To_Page 0 Target_03_DINT 0 DINT
Target 02 DINT 0 Target 03 REAL 0.0 REAL
Target 02 REAL 0.0 Target 04 BOOL BOOL
Target_03 BOOL Target 04 DINT 0 DINT
Target 03 DINT O Target 04 REAL 0.0 REAL
Target_03_ REAL 0.0 Target_05 BOOL BOOL
Current_Page 0 Target_0&_DINT 0 oIMT
Target 05 REAL 0.0 REAL o
T — b il b
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17.5 Configurations of the Schedule-Control Utility

17.5.1 Address for each Target Variables

The Schedule-Control Utility can configure max. 10 Target ‘s schedule. Each Target contains one BOOL

variable, one DINT variable and one REAL variable.

To enable the schedule-control in the Win-GRAF PAC, first add a “Schedule” in the “1/0 boards”
windows (refer to Section 17.2). The user can declare all required variables in the “Variables” window,

and add these variables in the “Binding" window and then assign correct “Identifier” number 5001 ~
5030 (refer to Section 17.2 - Variable declaration). After downloading the Win-GRAF project to the PAC,
the scheduling will control these variables well.

Address Type Description Address Type Description
5001 BOOL 5016 BOOL
BOOL, DINT and REAL BOOL, DINT and REAL
5002 DINT variable controlled 5017 DINT variable controlled
by Target 1 by Target 6
5003 REAL 5018 REAL
5004 BOOL 5019 BOOL
BOOL, DINT and REAL BOOL, DINT and REAL
5005 DINT variable controlled 5020 DINT variable controlled
by Target 2 by Target 7
5006 REAL 5021 REAL
5007 BOOL 5022 BOOL
BOOL, DINT and REAL BOOL, DINT and REAL
5008 DINT variable controlled 5023 DINT variable controlled
by Target 3 by Target 8
5009 REAL 5024 REAL
5010 BOOL 5025 BOOL
BOOL, DINT and REAL BOOL, DINT and REAL
5011 DINT variable controlled 5026 DINT variable controlled
by Target 4 by Target 9
5012 REAL 5027 REAL
5013 BOOL 5028 BOOL
BOOL, DINT and REAL BOOL, DINT and REAL
5014 DINT variable controlled 5029 DINT variable controlled
by Target 5 by Target 10
5015 REAL 5030 REAL
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17.5.2 Target Configuration

Every Win-GRAF WinCE PAC can control maximum 10 “Target” (Target 1 to Target 10) devices. First,
execute the Schedule-Control Utility and click “New” to create a new configuration file, the Targets will
show as 10 buttons (See the figure below). The default Target names are “Target 1” ~ “Target 10”. One
Target can set up the schedules to fit different Seasons. The Target button will show a “*” to distinguish

it is enabled.

Addition to “New” a configuration file, the user can open an existing file in PC or get from the PAC.
New: Create a new file.
Open from PC: Open an exist configuration file from PC.
Get from Controller: Get an existing configuration file from PAC (required enter the PAC's IP and
password) and then to show on the PC.

fﬁ?sa;edule{ontlol‘uﬁ!i. Y.
New l
i ugl Schedule-Comrql Utility ﬁ_ __ - . - T T W=
l SaetoPC Send toCemtocller Contioller time symehimndzation Open foom P ‘ Getfmcomha]hr‘ Help-ahant
Tife: Titls :
Target 1 * Target 2 Tareet 3
Tareet 4 Tareet 5 Target 6
Target 7 Target 8 Target 9
Target 10
I

Change the Target Name to meet the needs of the field:

User can change the name of the Target, Season or other items to fit for the equipment at the
application field. Please create a text file named “Label_Name.txt” (as the figure below) and save it in
the same folder with the Schedule-Control Utility “Schedule_in_PC.exe” (e.g., D:\Schedule-Control\
Station1\Label_Name.txt).
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Notes for creating the file “Label_Name.txt"”:

. If this file does not exist, the Target shows the default name (e.g., Target 1, Target 2).

. In this file, change the target name (e.g., “ Factory ”, the prefix/suffix of spaces will be erased.) or the
name of other items (e.g., Season, Normal day, Holiday, Schedule, etc.) after the colon (" :").

. The user can create and edit it by using MS Notepad or other editors, but must select the “Unicode”
format when saving it.

. On the PAC, copy this file into the same folder with the Schedule_in_PAC.exe, i.e., \System_Disk\
Win-GRAF\.

T —
( label_name.txt - > EI@
8 == B|RO) B\BEREM

ERRAH)

Targetl : Target 1 ;i%?%ﬁ-ﬁ
Target? : Target 2 U'\_.../' | D4Schedule-ControlStationl 2 | 3 | | EE Stationd D |
Target3 : Target 3

Targetd : Target 4 EEEEN): label_nametxt ”
Target5 : Target & ZEEIM: [I#if*(*.brt) ,]

Targetb : Target &
Target7 : Target 7
Target8 : Target 8 > BEEHE) =EE): IUnicude k v| [ =E(S) ] | HRA |
Target9 : Target 9 ¢

Targetl0 : Target 10

Season Always : Season Always
Season 1 : Season 1
Season 2 : Season 2
Season 3 : Season 3

m

Season 4 : Season 4 ! Schedule-Control Utility =N =R~
Normal da\f’: Normal day I Save to PC ] Send to Controller Controller time synchromzation Open from PC llGetfmComrc]]er]
Holiday 1 : Holiday 1 Tile: Till
Holiday 2 : Holiday 2 Vs ~
Special day : Special day
Schedulel : Schedule 1
Schedule? : Schedule 2 Target 1 Target 2 Target 3
Schedule3 : Schedule 3
Scheduled : Schedule 4
Schedule5 : Schedule 5
1 Target 4 Target 5 Target 6
Target 7 Target 8 Target 9
Target 10
. J
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17.5.3 Season Configuration

Each “Target” (1 ~ 10) includes the “Season Always”, “Season 1”, “Season 2”, “Season 3” and “Season 4”
setting items. It is recommend to check "Season Always" that means to enable the year-round schedule.

The Searching Priority of Seasons:
1. PAC will first search the Season 4 (if it is enabled)
If found the current date in the Season 4, then do the Boolean/Integer/Real control.
2. If not found, then search the Season 3, Season 2..., at last search the Season 1.
3. If not found, then search the Season Always to do its control.
4. If not found the current date in this Target, then do the “Default Value” control.

a2 Schedule-Control Utility Target 1 » Season 4 > Ngogal day EI = @
‘ Back ‘ Sane o PO ‘ 2
Beolean Integer Real
Target 1 Default Value  OFF -« 0 0.0
Season 4 ['] Every year 20130601 9013Dec3l
AY
‘ Season Always ¥ ‘ ‘ Season | ‘ ‘ Season 2 ‘ ‘ Season 3 ‘ Season 4 ¥

Normal day

Schedule 1 *
fpply S v Schedule 2

@ Nomal day (Schedule 1 *)
[ Sonday

@ Holiday 1 Monday

Tuesday

Wednesday

") Special day Thursday Schedule 4
Friday
[ Saturday

Scheduls 3

© Holiday 2

Schedule 5

Season Setting:
Season 1 ~ 4 need to set its “Date Period”. After completing the settings, recommend to check the
“Every Year” option to apply the Date Period every years.

Note 1: The Date Periods of the 4 Seasons must not overlap.

Note 2: If the "Every Year" is checked, the system diagnoses the overlap of Month/Day only, not the
year. If the "Every Year" is not checked, it will diagnose the “From” Year/Month/Day should be
earlier than the “To” Year/Month/Day.
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15" Schedule-Control Utility Target 1 > Season 4 > Normal day IE' = @

‘ Back Save to PC ‘
Boolean Intezer Eeal
7 Target 1 Defoult Veluz  OFF . 0 04
7] Season 4 7| Every year Fom | Octf0l To | Deci
Season Alwaws ¥ ‘ ‘ Zeason | ‘ ‘ Season 2 ‘ ‘ Season 3 Season 4 *k

N\

Note: Unchecked the "Every Year" can modify the date periods, and take notice of the date order.

For example:

1. The Correct Setting:
User can check “Every Year”, so that the setting will be used for every year.

Season 1 01/01 ~03/31
Season 2 04/01 ~07/15
Season 3 07/16 ~09/30
Season 4 10/01~12/31

2. The Wrong Setting:
Because the Season 2 overlaps the date of Season 1 from 03/16 to 03/31.

Season 1 01/01 ~03/31
Season 2 03/16 ~ 07/15
Season 3 07/16 ~ 12/31
Season 4 Disabled

Win-GRAF User Manual, V2.0, Aug. 2020 by ICP DAS 17-16




17.5.4 Normal Day / Holiday / Special Day Configuration

There are Normal day, Holiday 1, Holiday 2 and Special day in each Season. When enabling the setting,
users must choose a Schedule number (1 to 5) to apply the time settings.

Normal day The normal days are Monday to Friday.
Holiday 1 Normally set to Saturday and Sunday.
Holiday 2 In some workplace, there are different holidays, e.g., Wednesday.

Special Day

Set the schedule for local holidays or the adjusted working-day.
E.g., Oct. 10, Jul. 4, Oct. 1, Dec. 25, etc.

A maximum of 50 days can be set per Season.

o’ - . - . = — . - T = ﬁ — wi
ol Schedule-Control Utility Target ! = geasc’m xlways = Mormal day @.11 L
Back | Save o P |
Boolean ) Integer Feal
W] Target 1 Defeult Value  OFF < |0 00

¥l Season Always always
Season Always * ‘ Season 1 ‘ ‘ Season 2 ‘ ‘ Season 3 ‘ ‘ Season 4
- |
\
¥ Normal day
Low
* i T
© Nomnal day (Schedule 1 %) Apply  Schedule 1 | Scheduls 2
] Bonday

) Holiday 1

[¥] Monday
|| Toesday
|¥] Wednesday

) Holiday 2

) Special day || Thursday | Bcheduls 4
[¥] Friday =
[ Saturday | Schedule 5
N =

A. The Searching Priority of Normal Day / Holiday / Special Day:
The PAC will first search “Special day”. If the date is not found in this Special day setting, then
search “Holiday 2”, then “Holiday 1”7, and then “Normal day”.

B. Default Value for Boolean / Integer / Real:
Each Target must set the default value for the Boolean, Integer and Real variables. These default
values will be applied when the PAC cannot find any available “Date Period” or “Time Period” in the
enabled “Season” setting. Then the PAC follows the setting of the Default Value. Usually, the
Default Value of Boolean is set to be “OFF”, the Integer and Float value are set to be “0”. User can
set the different Default Value by the case.
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C. Date Setting for Normal day / Holiday 1 / Holiday 2:
Note that NO OVERLAP. For example,

The Correct Setting:

Normal day Monday, Tuesday, Wednesday, Thursday, Friday
Holiday 1 Sunday, Saturday
Holiday 2 Disabled

The Wrong Setting: (Because “Friday” overlaps in the setting of “Normal day” and “Holiday 2”.)

Normal day Monday, Tuesday, Wednesday, Thursday, Friday
Holiday 1 Saturday
Holiday 2 Sunday, Friday

D. Date Setting for Special Day:
The “Special day” is for special schedule, such as the special holidays or make-up workdays. Each
Season can set maximum 50 Special days. The searching priority of the “Special day” is higher than
the priority of Holiday 2 and Holiday 1 and Normal day. Each enabled “Special day” date must select
a Schedule number (1 ~ 5) to be applied.

Special day
o
- Mormmal day (Schedule 1 *) a
Holiday 1 Setting
Target 1 > Season Always > Spedial day

") Holiday 2 Alvrays

M A

o
© Soeider® | Colndr ETTa——

@ 4
2007E782 3
- T BT & Delete

£f = 1
3 4 5 8
9 10 11 12 13 14 3
6 17 18 19 20 21
23 24 25 26 27 28 2

30 31 1 2 3 4 3
S 20177777

‘ Confiom k ‘ ‘ Canel ‘
X Lpply

1 iz T 30177 Schedule 1 -
—0

A4dd & new date
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17.5.5 Schedule Configuration

Each Season can set up maximum 5 Schedules (Schedule 1~ 5), and each Schedule can set up maximum
15 Time Periods. The time unit is “minute”, in the range of “00:00 ~ 24:00”.

Season Alwaws # ‘ ‘ Zoasan | ‘ ‘ Seagon 2 Seagom 3 Hogeon 4 #
I - I =
M Normal day
© Nommal dey Apply  [Eshedule 1 el
Funday
© Holiday 1 B
. ) i Srhedule 2
= Holiday 2
TWedneaday
() Special day Thnzzd e ‘ dchedule 4 ‘
Ry =
EoE l Scheduls 5 ‘
k= —— ——f
( Schedule 1 |
Copyr foom
; ] )
Hour anmts To Hour blinute Boolean Integer Real
[¥] 01: a - 30 12 ~ 0 - L) 10 1224
@] 02 120 =] [0 1 i = ON - @ 2567
103 0 i i a COFF i 10
] o4 o 0 0 0 OFF D 0
[l 05: i 0 0 I} CFF 0 0
] 06: o 0 0 0 OFF B 0
[ 07 0 ] 1] a OFF a 0
] oe: o 0 0 0 OFF 0 0
[ 09: i 0 0 I} CFF 0 0
I 10: o 0 0 0 OFF B g
11 i 0 0 i} CFE 0 0
] 12 0 0 0 0 OFF ] i
13 a 0 0 1} CFF 1} 0
I 14: o 0 0 0 OFF B 0
[ 15: i 0 0 i} CFE 0 0
5 J
Save and exit | Cancel ‘

EX: The following setting is correct.

No. Time Period Boolean Integer Real
01 00:00 ~ 08:00 OFF 100 30
02 08:00 ~ 12:00 ON 150 255
03 12:00 ~ 13:00 OFF 120 27
04 13:00 ~ 17:00 ON 150 25.5
05 17:00 ~ 24:00 OFF 100 30
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The Searching Priority of Time Period:
The searching priority of the Time Period in the schedule is in the order from the largest number to the
smallest number.

For example, the following table shows five Time Periods settings .

No. Time Period Boolean Integer Real
01 00:00 ~ 08:00 OFF 100 30
02 08:00 ~ 12:00 ON 150 25.5
03 12:00 ~ 13:00 OFF 120 27
04 13:00~ 17:00 ON 150 25.5
05 17:00 ~ 24:00 OFF 100 30

1. The searching will in the order from No. 5 to No. 1 (05, 04, 03, 02, 01). If the Time Period
overlaps, the PAC will follow the larger number setting to control the schedule.
2. If the PAC cannot find the current time in any Time Period in the “15” ~ “01”, it follows the

setting of "Default Value".

( Schedule 1 |
‘ Copy from ‘
Hour Minute Ta Hour Minute Boolean [nteger Feal
/] 01 A 1] - 0 - a - 0 - OFF = oo 30
[¥] 02: -~ 0 - 12 - 0 - [0 150 255
J] 03 12 » 0 - 13 - 0 - OFF = 120 27
[¥] 04: 13 + 0 - 17 - 0 - o - 150 255
7] 05 17 +~ 0 - 24 - 0 - OFF = oo 30
| 0B: ] ] ] o OFF 0 ]
| ot ] 1] ] o OFF 1] o
| 08 ] ] ] o OFF ] ]
|09 1] 1] ] o OFF 1] 1]
10: ] ] ] o QFF ] a
| 11: ] 0 ] o OFF 1] 1]
| 12: ] il ] o OFF il ]
| 13: 1] 1] ] 1] OFF 1] 1]
[ 14: ] ] ] o QFF 0 a
i e |0 1] ] 0 OFF ] o
Save and exit Cancel
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17.5.6 Save and Send the File to the PAC

After completing the configurations, please save and then send it to the PAC:

[’ a! Schedule-Control Utility

[‘ Save o P l Send to Comtroller ‘ J Controller time synchronization Open from FC ‘ ‘ Gt from Controller ‘

N

1. Click “Save to PC” to save the configuration file (“ *.txt ”).

ol SEHE

¢ e 7 = i PP |

kot | D:\Schedule-Control\Stationl - | 3 | EE Stationl o
HAEZE Yy  HEEHE H- @
| label_name.txt || schedulel tat

fﬁﬂmm@ -

ZEEIM: ||og files (* txt) "

- EEENE [ ?’.E(S)k] [ Hig l
N\

2. Click “Send to Controller” to send the configuration file to the linked PAC. Please assign the PAC IP
address and set up the password (default: 0). Check the “Remember password” can save the
password for speeding the next sending process.

s ™

ol Controller infa = | B &

IP: 192.16375101 e——P» PAC IP address

Paszswrond ;@

[¥] Eemember pagsword

BTy
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17.5.7 Time Synchronization

If the PAC has not synchronized the system time after working a long period (e.g. one year), the time
may be differ over 10 seconds to a few minutes. For the time synchronization of the controller, the
Schedule-Control Utility provides a function to set the PAC time from the PC.

‘ Controller time synchoonization

X
Steps:

1. Your PC must connect to an Ethernet Switch and then to the Win-GRAF PAC by using
Ethernet cables.
2. Click “Controller Time Synchronization” button, and enter the current IP address of the PAC and

ot Schedule-Control Utility

£

Sae to PO

Crpen from PC ‘ ‘Gﬁtfromcont[o]ler ‘

= [

the password (defaults: 0).
3. Set a new date, hour, minute and second.
4. Click “Set new Controller time” button to set the new time to the PAC.

o B
okl Controller info ==l &

IF: 19216875101

Paszword : @

[#] Remember password

Cow]  [em]

o' Controller time setting @
Hour Minute Second
Controller time : 017 7TH TH 11 45 20
Set new Controller ime - | 20175 7H 7H [El- 11 - % 0 -

| Set new Controller e |

X
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17.5.8 Schedule-Control Utility in PAC Site

The configuration process on the PAC side is similar as the process in the PC side, just a little bit different
on the screen. Please refer to Section 17.5.2 to 17.5.6.

1. Target Configuration:

Help-ahout Exit
: |T|t|e |
Target 1 * Target 2 Target 3
Target 4 Target 5 Target 6
Target 7 Target 8 Target 9
Target 10
2. Season Configuration:
edule-Contro arqge ea50n A 7 0 al da
Save and implement Help-about Exit
Target 1[v|enable oFF 8o 0.0
Season Always(v] Enable Aharays
Segzon A * Season 1 | Segson 2 | Segson 3 | Seazon 4 |

1 ]
Mormal day(v/| Enable
Marmal day (Schedule 1 *) [ | sunday
() Holiday 1 My
() Holiday 2 Tuesday
Wednesday
() Special day Thursday
[ |saturday
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3. Special Day Configuration:

Always

Add a new date |

Clear all

| Save Setting

4. Schedule Configuration:

Period Mo, Hour  Minute ~ Hour Mlirite: Boolean Integer Real

or ¥ o Mo v Jiz v o M Jon M| [izaa ]
Start End { Boolean , Integer , Real )
01: 0 (OM, 10, )
Voz: 13:00 ~ 17:30 (0N, 20, 25.67

[ os: 00:00 ~ 00:00 (OFF,0,0)

[Jo4: 00:00 - 00:00 (OFF,0,0)

[ os: 00:00 - 00:00 (OFF, 0,0

[Jos: 00:00 ~ 00:00 (OFF,0,0)

o 00:00 - 00:00 (OFF, 0,0

[os: 00:00 ~ 00:00 (OFF,0,0)

oo 00:00 - 00:00 (OFF,0,0)

[]1o: 00:00 ~ 00:00 (OFF, 0,0

[]11: 00:00 ~ 00:00 (OFF,0,0)

[]1z: 00:00 - 00:00 (OFF, 0,0

[]1s: 00:00 ~ 00:00 (OFF,0,0)

14 00:00 ~ 00:00 (OFF,0,0)

[1s 00:00 ~ 00:00 (OFF,0,0)

| Save and exit |
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17.5.9 Using Schedule-Control in the eLogger HMI

elLogger is a free charge and an easy-to-use HMI software platform developed by ICP DAS. It can be used
to design the Local HMI and the Web Server HMI for remotely controlling the PAC through a web
browser on your PC or cell phone. All Win-GRAF PAC support eLogger HMI.

For instructions on eLogger HMI, visit the following web page for the Win-GRAF FAQ-018 and FAQ-019:

https://www.icpdas.com/en/fag/index.php?kind=273#840 > FAQ-018, FAQ-019

Win-GRAF Soft-Logic PAC

- FlPT -

No. Title Demo Project
019 How to Create an eLogger HMI and 2 Schedule-Control Application for a Win-GRAF PAC? H

018 How to Use Win-GRAF SoftLogic and eLogger HMI in the Win-GRAF PAC? frsl

You can download the sample program ("Demo_faq018_all. zip" or demo_faq019_all. zip) directly on
the Win-GRAF FAQ page, or in Win-GRAF-PAC-CD (\napdos\win-graf\demo_ project\), and then operate
and test the project according to the contents of the document.
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http://www.icpdas.com/web/product/download/software/development_tool/win-graf/document/faq/faq-019.pdf

Chapter 18 Develop Your Own Function and Function Block

This section described how to use the Visual Studio 2008 development tool to produce a DLL file of your
own Function or Function Block. All the related demo files are included in the PAC’s CD-ROM, such as
the XP-8xx8-CE6, WP-8xx8, WP-8xx8-CE7, WP-5xx8-CE7, and VP-x2x8-CE7 PAC.

Related demo files:
CD-ROM : \napdos\Win-GRAF\demo-project\user_c_lib\
\demo_user_c: The VS 2008 project folder, can be used to build the “user_c.dll” file for your own
Function and Function Block. (Refer to Section 18.4)

.\user_c.dll : The pre-compiled DLL file - “user_c.dll” used for the Function (“bytes_to_long”)
and the Function Block (“long_to_bytes”) in this demo.
\wp_vp\user_c.dll : for WP-8xx8, WP-8xx8-CE7, VP-x2x8-CE7, and WP-5xx8-CE7.
\xpc\user_c.dll : for XP-8xx8-CE6.

\user :  The Win-GRAF Lib folder, including library files of the Function (“bytes_to_long”)
and the Function Block (“long_to_bytes”) in this demo. (Refer to Section 18.3)

Win-GRAF demo file:
CD-ROM : \napdos\Win-GRAF\demo-project\demo_user_c.zip

The standard shipments of ICP DAS Win-GRAF PAC do not include the “user_c.dll” file. If you want to add
your own Function and Function Block for working with the Win-GRAF logic, you must build a DLL file
and copy it to the same folder as the Win-GRAF driver on the PAC (i.e., \System_disk\Win-GRAF\).

After rebooting the PAC, the Win-GRAF driver will load that DLL file to support your Function and
Function Block.
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18.1 The Development Process of Your Own Function or Function Block

Create the development
environment

Create the
Function or Function Block

h 4

Programing the
Function or Function Block
logic

Test your own
Function or Function Block

Use VS 2008 and install
the correct SDK.
(Refer to Section 18.2)

Use Win-GRAF Library Manager
to generate the source code.
(Refer to Section 18.3)

Import the source code generated in
the previous step to the VS 2008
project to edit the logic.

(Refer to Section 18.4)

Create a Win-GRAF project that includes
your own Function or Function Block,
and download it to the Win-GRAF PAC.
(Refer to Section 18.5)
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18.2 Creating the Compiler Development Environment

Download the SDK (Software Development Kit):

The user can download the related SDK on the website:

1. For WinCE 7.0 PACs / ViewPACs
http://www.icpdas.com/en/download/show.php?num=2348

2. For WinCE 6.0 PACs
http://www.icpdas.com/en/download/show.php?num=2473

3. For WiInCE 5.0 PACs / ViewPACs
http://www.icpdas.com/en/download/show.php?num=2593

18.2.1 Install the SDK of the ViewPAC or the WinPAC
Note: Make sure your PC has been installed the Microsoft VS2008 before doing the following steps.

1. Double click the downloaded SDK file (e.g., pac270_sdk_20121015.msi) to install it to the VS2008.

ﬂ%\

pac270_sdk_2012
1015 msi

2. Click the “Next” button.

[ Pac270 setup o]

Welcome to the PAC270 Setup
Wizard

The Setup Wizard will install PAC270 on your computer. Click
Next to continue or Cancel to exit the Setup Wizard.
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3. Choose the “Accept” radi

o button and then click the “Next” button.

This software will not set up on your computer unless you accept the terms of the agreement.
For your future reference, you may print the text of the agreement now using the PRINT
button or obtain the text from the 'MSFT_SDK_EULA_1033.rtf file after installation. You may
also receive a copy of this agreement by contacting the Microsoft subsidiary serving your
country, or write: Microsoft Sales Information Center, One Microsoft Way, Redmond WA
98052-6399.

) PAC270 License Agreement

End-User License Agreement

Be sure to carefully read and understand the following end-user license agreement,
and then indicate whether you accept or do not accept the terms of the agreement.

END-USER LICENSE AGREEMENT FOR

MICROSOFT SOFTWARE

MICROSOFT CUSTOM SOFTWARE DEVELOPMENT KIT FOR WINDOWS CE 5.0
(Referred to as the "Microsoft Custom SDK")

L

Press the PAGE DOWN key to see more text.
: (©) Dedine

[ <Bak |l N_ext>* [ cancel |

N\
A

4. Click the “Next” button.

——

o g R Put oy

) PAC270 Setup

Customer Information

Please enter your customer information

User Name:
[Brady]

Organization:

[

5. Click the “Complete” but

ton.

) PAC270 Setup

Choose Setup Type
Choose the setup type that best suits your needs

Custom

Allows users to choose which program features will be installed
and where they will be installed. Recommended for advanced
users.

OR

&|E

Complete
All program features pill be installed. (Requires most disk
space)

Cancel
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6. Click the “Next” button.

; " b

1 paczro - Destination Folders o — e
Destination Folders

Click Next to install to this folder, or dlick Change to install to a different folder.

S Install PAC270 to:
"_J C:\Program Files\Windows CE Tools\wce500\PAC270\

< Back H Next = K} [ Cancel

7. Click the “Install” button to install the SDK.

#] PAC270 Setup m&]

Ready to Install —
The Setup Wizard is ready to begin the Custom installation @

Click Install to begin the installation. If you want to review or change any of your
installation settings, dick Back. Click Cancel to exit the wizard.

[ <tk [ .l"?‘é“.ﬁ [ Cancel ]
AN

8. After completing the installation, click the “Finish” to quit the procedure.

[ Pac270 setup =5

Completing the PAC270 Setup
Wizard

Click the Finish button to exit the Setup Wizard.
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18.2.2 Install the SDK of the XPAC (XP-8xx7-CE6, XP-8xx7-Atom-CE6)
Note: Make sure your PC has been installed the Microsoft VS2008 before doing the following steps.

1. Double click the downloaded SDK file (e.g., pacsdk_ce_1.4.3_vs2008.msi) to install it to the VS2008.

@
ﬁ'\

pacsdk ce 1.4.3 v
s2008.msi

2. Other steps, refer to Section 18.2.1 — Step (2) to (8).
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18.3 Define Function or Function Block

18.3.1 Define Function Lib

This section presents a simple example of creating a library function - “bytes_to_long” that is used to
convert four bytes (0 ~ 255) to one long integer (32-bit Signed Integer).

To begin, follow these steps:

1. Click All Programs - Win-GRAF - Libraries - OEM from the Start menu as the figure below.
Note: If the Win-GRAF Workbench is opened, the user cannot add or edit Win-GRAF Library.

@ Win-GRAF | G Libraries
(™) Google Chrome 3
() ICPDAS »
(%) Outlook Express
@ Mozilla Firefox
> € ) Opera 18

»| 8 oEM

Distiller 2

HEEA® b

Wa Win-GRAF

2. Create a library group named "User" in order to easy maintenance and management.

L s |
W Library Manager- Userl Open Library &J
[File| Tools Wizard Help
. Ize
Open Library... s | 254 | Types| i \ ]

Save Library Advanced e

_ 1 Arithrmetic b 3
Use in SAMA Arrays
= AS-interface
BACHet
Booleans
CaMbus
CAMopen
Clack,
Comparizohs
Conversionz
Counters
DHP3
Ermbedded HiI X

Select a library in the lizt or enter a
name for creating a new librany.

m

3. Select the "Function and FBs" tab and click the “New” button.

i’ !
Wi Library Manager - User =

File- Tools Wizard Help

Function and FBs | [0z | Prafiles I A5 | Types |

Rename...

el : =
Farameters | Description -

* Skore
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4. Enter the name and comment, and select the type as a Function and then click the “OK” button.

-

i

Mew item

Mame: butesz_to_long

Comment:  Corvert 4 bytes to 1 long

oo 1)

140 Digwize
@ Function
7 Function Bla
Fraofila
Type

5. Declare the prototype of this Function.
The user can declare parameters like this way - “variable name : data type;”, and refer to Appendix
A for the data type. The content between the "VAR_INPUT" and "END_VAR" are passed-in
parameters; the content between the "VAR_OUTPUT " and "END_VAR" is returned parameter.
After completing it, click “Store” to save. Then, click “Description” tab to add the technical notes for
this Function and then click “Store” to save.

Delete

Parameters Descriptinn|“

VAR_INEUT @ - Stors
Bytel @ USINI; =
Byted_ : USINI; 2
Bytced_ : USINT;
Byted @ USINT;
END_VER
VAR OUTEUT]
( @ : DINT: )
END_VER

s

6. Click “Wizard” - “Function/Block Source Code” to generate the source code of this Function.

Wi, Library Manager - User

File T{mI( [ Wizard | )he-lp

\_/
Function and F Function / Block Source Code. t

ahytes to_long (* Convertd budes o 1 long *)
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7. Select “Windows DLL” and click “Copy” button to copy the source code.

Wizard - L-:‘I_i-J

£ bytes to_long - Source code [requires fﬁvm.h include] */ -
#* Function */ .

£ Argumnent lizt 4

fdefine P BYTE1_ [T PTEYTENTSGET _DEDATAZPE aze]l+pargs[0]))
fdefine _P_BYTEZ  [M[TS_FTBYTE)NTSGET_DBDATAS(pE azell+pirg:z[1]]]
fdefine P BYTES. (TS PTBYTENTSGET _DEDATASRE aze]l+pargs[2])]
fdefine P BYTE4_ [T PTEYTENTSGET_DEDATAZRE aze]l+pargs[3])
fdefine P O [T _PTLONG)ITSGET_DBEDATAIZ(pE asell+pirgs[4]

£ handler =¢

m

T5 'WWORD _ declzpecidiexport) BYTES_TO_LOMG [
Ta WORD wCommand,
TSPTR_DE pBasze,
T5 PTR pClazs,
T5 PTR plnat,
| { TE PTWORD prgs]

awitch [wCommand]

caze TAFBCMD_ACTIMATE :
# enter your code here... */
return 0L

caze TAFBCMD_ACCERPTCT :
/* dant change that =/
return 1L;

default :
return OL;

Implementation

) Staticaliylinked | Copy Wr!

@ windowes DLL
[l
V\ L Cose | 2 )
A

e -

©)

8. Paste the source code into the text editor (e.g., Notepad) and save it as “bytes_to_long.c”.

(res to Iong& L=2 |,'='|_E||$J1
=== ) BEIO) \EN REH)
| * bytes_to_long - Bource code (requires tSvm.h include) */ *

¥ Function */
#incluode "stdafx. k"
#incluode "thvm. h"
{¥ hroument lizt */

#define _P_BYTEl  (*((T5_PTLONG)(TSGET_DBDATA32(pBase))+pArgs[0]))

#define P BYTEZ  (*((T5_PTLONG)(TSGET_DBDATAZZ(pBase) )+phres[1]))

#define P BYTE3  (*((T5_PTLONG )(TLGET_DBDATAZZ(pBaze) )+phres[2]))
[31)3
)

m

#define P BYTE4  (*((T5_PTLONG)(TLGET DBDATA3Z(pBaze))+phres
#define P O (*((TS5_PTLONG)(T5GET_DEDATA32(pBame))+phres[4])
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18.3.2 Define Function Block Lib
This section uses the similar way as previously described to define the Win-GRAF library of the Function
Block (e.g., "long_to_bytes”) and then create a file of source code (e.g., "long_to_bytes.c").

1. Refer to the Previous Section to open "Library Manager" (All programs - Win-GRAF - Libraries -
OEM) and open the library group - "User", and then click “New” button to add a Function Block.

—

@}fhﬂanager- User = |-E] |

File Tools Wizard Help

Function and FBs | 1/0s | Profiles | 454 | Types|
fibyies_to_TongN¥ Cogert 4 bodes io 71 Tong #)

@)
| Parameﬁi_[)escriptiun _ Delete

- Store

Fename...

2. Enter the name and comment, and select the "Function Block” type and then click the “OK” button.

- : .
New jtem [
| Okwe |
Marme: lotg_to_ bytes
& ; i | Cancel
Comment:  Conwvert 1 long to 4 bytes 3
|0 Device
() Function
Profile
Type

3. Declare the prototype of this Function Block.
The user can declare parameters like this way - “variable name : data type;”, and refer to Appendix
A for the data type. The content between the "VAR_INPUT" and "END_VAR" is passed-in parameter;
the content between the "VAR_OUTPUT " and "END_VAR" are returned parameters.
After completing it, click “Store” to save. Then, click “Description” tab to add the technical notes for

this Function Block and then click “Store” to save.

Parameters DescriptiDn|k

VAR INPUT @ -
EIL Long Val_ : I.‘IINI;]

O_VEF]
VAR CUIEUT

Bytel_ : USINI:

Byted_ : USINI:

Byte3_ : USINI;

Byted @ USINI;
END VAR
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4. Click “Wizard” = “Function/Block Source Code” to generate the source code of this Function Block.

W Library hh)ﬁga\mer ESRIER
File Toolg [Wizard | Help
Function and FI Function / Block Source Code. . \ [

Fbytes_to_long (* Convert 4 bytes to 1 long *j N 0
& long to_bytes (¥ Convert] long to 4 bydes

Fename...
Parameters | Description| Delete

5. Select “Windows DLL” and click “Copy” button to copy the source code.

[ Wizard . [ﬁ

£ long_to_bytes - Source code [requires tym.h include] =/ -
#* Function block =/ 3

£ Brgurment lizt =/

Hdefine P LONG_ VAL [(T5_PTLONGITSGET_DEDATAI2(pEas=)l+piugsl0]l
Hdefine P BYTET_ [T _PTEYTE)TEGET_DEOATASRE ase]l+ptrgs[1])
tdefine _F_BYTEZ [((T5_PTEYTEITEGE T_DEDATAS(RE asell+ptras(2])]
Hdsfine P BYTES [4(TE_PTBYTEITEGE T_DBDATASRE ase]l+ptrgs[3)
Hdefine _F_BYTE4 (TS5 _PTEYTENTEGET_DEDATASRE ssell+paras[4])]

_ ]]-] _

/% private block, data =/

t{ypedef struct

T8 DWwWORD dwData; & TODO: replace dwD ata by the iters pou need */
} st FB_LOMG_TO_BYTES:

/% handler */

T8 DwWORD _ declspec(dilesport] LOMG_TO_EYTES |
T5 WORD wCaormmand,
TSFTR_DE pBase.
T5 PTR pClazs,
T5_FTR plnst,
T5 PTWORD pargs]

_str FB_LOMG_TO_BYTES "pData;

pData=[_str FE_LOMG_TO_BYTES *jplnst;
ayitch [wCommand)

caze TEFBCMD_ACTIMATE : -

|mplementation

(1 Statically linked Copy
@ ‘Windows DLL | Y
2 Cloze
o~ —te= ()
(1 y 4 \

L

6. Paste the source code into the text editor (e.g., Notepad) and save it as “bytes_to_long.c”.

g ] Iong to by‘tesc |E|E|&J
o) |/EREN) FREH

,h*lnc nde "stdafx. h"

#include "tSvm.R"

¥ long to bytes - Source code (requires tovm.h include) */
{* Function block */f

[om]

H Aroument list */

#define P LONGVAL  (*((T5 PTLONG)(TSGET DBDATAZZ(pEasze) 4pire={0]))
#define P BYTEl  (*((T5_PTLONG)(TGET_DEDATAZ2(pBaze) +phres[1]))
#define P BYTEZ  (*((T> PTLONG)(TSGET_DEDATA3Z(pBasze) +phrea[2]]))
#define _P_BYTES  (*((T5_PTLONG(T5GET_DEDATA3Z(pBase) i+phres[3]))
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18.4 Edit the Logic of the Function and Function Block

Note: Please make sure your PC has installed the Visual Studio 2008 and WinPAC/XPAC SDK before
operating the following steps.

1. As the figure below, copy these source code files of the Function and the Function Block (described
in Section 18.3) to the VS 2008 project folder on your PC. (Or, get the VS 2008 sample project
folder from the CD-ROM: \napdos\Win-GRAF\demo-project\user_c_lib\demo_user_c)

= EEH =2 el

|, PACZ70 (ARMVAT)
L XPacSDK_CE (x86) '
c] bytes_to_long.c ] Copy these source code files of the

] long_to_bytes.c Function and the Function Block to \
T reativett the VS 2008 project folder.
|n] resource.h

¢ stdafcpp

|n] stdafh

| | TSBLOCKS.APS
¢ TSBLOCKS cpp
&8 TSBLOCKS.rc

(SH T5BLOCKS veproj
[g?,T5BLGL‘.KS.vcproj.GRADY-NBLGrad}r.u&er
| [0] tsvm.h

—=

ElT 2 EEE EUHE 2014/10/21 B 05116 ETHE: 2014/8/18 FF 02:40

C. 7l 3.05 KB

2. Then, make sure your VS 2008 project settings are correct for your PAC.
(Note: the settings are different between different controllers.)
For WP-8xx8, WP-8xx8-CE7, VP-x2x8-CE7, and WP-5xx8-CE7, it must set to “PXA270 (ARMV4I)”.

o TSBLOCKS - Microsoft Visual Studio {Administrator)
i i e A 3

o .

File Edit WView Project Build Debug Data Tools Whware Test Analyze Window Help

- o % EaE 9 - S -5L | b Release E__ﬂ} m_license

| PACS0-ARMVA: ARMVAL Releas ~ | g B | 42 Sk
E sElEaanl  Fl=Saaagl
B pEBER| D o MW M PP uoa o] E0E e e 3

o= fm 20| B o | S ] ¢ alb | Table Views | % | 2
Solution Explorer - TSETL_D-CKS - ﬂ- x_ . o Eytes—to—longchEBLOCKS:CP_Fi/SQdan_hrLOI'H_EO_I, 25 Cl
B2 & | E 4 '
._: Solution 'TSBLOCKS' (1 project)
- 24 TSBLOCKS

=1~ [ Header Files

(Glokal Scope) -

| _E||,f* tlytes_‘t_c_lcmg - Source cude_{requizr'es t5vm.h include) #*/
/¥ Function */
#include "stdafy k"

Fs
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For XP-8xx8-CE6, it must set to "XPacSDK (x86)".

o TSBLOCKS - Mmroso_ft‘u"_r:_tial_studlo Admmtstrator] : - ——

File Edit Wiew Project Build Debug Data Tools Vhware Test
@ S E @ % @[9I -E| b Release
| XPacSDK_CE %86 Device v |8 B4 Sk

B 48 | oo |G 0 ab | Tableview- | % 3B 8B [1Bagadl] Sl=@aaml

(B BEHE| D e M= & iy poaas =-|Hex.|i3- i

Solution Explorer - TSBLOCKS -~ I x /'bytes to_long.c} TSELOCKS ¢ : n %PI‘E-E-CI

e | 3| ) -Eal-c-::.ba_lugcope) <l

m Solution TSBLOCKS' (1 project) -

E 54 TSBLOCKS 4
|_—_| l_'? Header Files W

i |n] resourceh

& m_license

— |,.’* bytes_to long - Source code (requires tSvm.h include) */
/* Function *J

#include "stdafx.h™

#include "tSvm.h"

3. Here, we will add C source files of the Function and Function Block to the VS 2008 project. Mouse
right-click on the "Source Files" folder and click “Add” - “Existing Item...”, select the previously
copied C source files and click the “Add” button.

‘Solution Ex -~ resource.h | oytes tc
2 | E';'j (Global Scope)
E.‘f Resource Files - (77
AFEH-EEKETe #1fde-F APSTUDIO WMV
> o s i e
el I::-}rtes Add » __]‘ NewIterﬂ..- o rc
C_j long_t — 9 e
T Cut 2] Existing tem... 1 o
G sfdafy & '_] e el K -9
By =& | T Fe | Bleaas Cildae
cgsolut.. B3 Class || | @ Add Existing Item - TSBLOCKS 1 L% |
Output > H:j [l » TSBLOCKS » TSBLOCKS » == £
Show output from: —a—l = = = — == == = = :
 Thwexe Tirtual Debu > 3
=% EHHH =T il >
|| PAC270 (ARMVAL 2014/10/3 T 0341 BEZEHE
| ¥PacSDK_CE (x86) 2014/8/18 FF03:10 BEBEERRE
| | TSBLOCKS.APS 2014/9/9 T 03:02 APSBE= 29 KB
\c] bytes to_long.c 2014/10/21 FF05.. CSource 2KB
] long_to_bytes.c 2014/10/21 T 05.. € Source 2KB | (=
|n] resource.h /819 P 11:33  C/C++ Header 1KB
A478/18 T 02:25 C/C++ Header 2 KB
o . : - 2014/9/4 TS 12:28  C/C++ Header G KB
| & | = | Y 2014/8/18 F5 02:25 C++ Source 1KB
Eu [ Header Files - 2014710/ TS 0527 C++ Source 3kg L8
- |h] resource.h 2014/9/9 T2 03:02  Resource Script 3KB
- 0] stdafich o] 2014/10/16 EF 1. VC++ Project KB |
|n] tsvm.h
=8 E' Resource Files MEEEA): "long_to_bytesc” "bytes_to_longc" [A]l Files (*.%) -|
' Caw) [ A ]
] bytes_to_long.c 3 ) :
2 long_to_bytes.c @

. .. & TSBLOCKS.cpp
‘o || ReadMetxt

cSolut.. |@CI355... |Eprop... |Reso... |
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18.4.1 Edit the “T5BLOCKS.cpp”

Fill out your “libinfo” and “libVer” information in the “T5BLOCKS.cpp” file. The information will show on
the Win-GRAF driver dialog on the PAC (as the figure below).

Solution Explorer - Solution 'T3B... -

2| E &

[ Solution 'TSBLOCKS' (1 project)
& (34 TSBLOCKS

E| |7 Header Files

.. |n] resource.h

] stdafh

] t5vrm.h

= & Resource Files

‘.. 2 TSBLOCKS.rc
- & Source Files

: bytes_to_long.c
long_to_bytes.c
¢ stdafwcpp

&3 TSBLOCKS.cpp

I x resource.h | bytes_to_long.c( TSBLOCKS.cpp )stdafich

—~
(Global Scope)

=5 TSBLOCKS.cpp

.'l. .'l.

Defines the entry point g

#include "stdafx.h"

#define DLL_API _ declspec(dllexport)

ff Please ¥ill out your own informations.

.'I..'I.
LPCTSTR libinfo
LPCTSTR libver

.'I .'I

_T{"Add Your DLL informati
_T{"Add DLL version here."

"
Lal

| ReadMetudt

g solut.. [ Class... [ F,Prop.

Win-GRAF-XP-8xx8-ATOM-CE6 0K

KP-Si¢8-ATOM-CES driver Version 1.01 , Aug.07,2014 buid 7
‘This product is licensed.
Praject: demo_rdn_1, Extra_port: None

Elapsed time : 0. 0: 1:14
Add DLL version here.
add Your DLL information here.

If you have some operations to process when a new Win-GRAF project starts or stops. Please edit the
“Project_Begin” and “Project_End” functions in the “T5BLOCKS.cpp” file.

Solution Explorer - Solution T5E... ~ 1 X resource.h ]"bytes_to_longé T5B|-0‘CK5-CPPE Ytdafih | “long_to_bytes.c |

2 E K
(5 Solution TSBLOCKS' (1 project)
5 (57 TSBLOCKS
5 [E Header Files
. [n] resource.h
] stdafxh

L

1

et

—————

(Global Scope)

o DLL_API BOOL TS5Blocks_IsValid (woid)

return TRUE;

i |h] tSWMLH
= (¥ Resource Files '
i (2 TSBLOCKS.rc

~

1
= Lj Source Files
. & bytes_to_long.c
¢ long_to_bytes.c b

- & stdafx.cpp
. 6] TSBLOCKS.cpp

f/f This is an example of an exported function.
o DLL_API woid Project_Begin(wvoid)

@ DLL_API woid Project_End(woid)

FfPut you code in the below

f#This function will be called cne time when a project starts.

FfPut you code in the below
f#This function will be called cne time when a project stcpi;//

i
|| ReadMe.tut
H
g Solut... B Class_ [T Prop [@Reso_ ||| _pyy
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18.4.2 Edit the Logic of the Function (In this example is “bytes_to_long. c”)

First, add your logical expression for this Function in the switch case statement —"T5FBCMD_ACTIVE".

22| E K

Solution Explorer - Solution 'T5B.. » I X

T~
 resource { bytes_to lona.c )rseLOCKS cpp| stdafich | long.i

CoeS—

(Global Scope)

[ Solution TSBLOCKS' (1 project)
= 24 T3BLOCKS
o [ Header Files
.. [n] resource.h
.. [n] stdafih
... [n] tsvm.h
= [ Resource Files
.. [ TSBLOCKS.rc
= & Source Files
... ¢4 bytes_to_long.c
. & long_to_bytes.c
... & stdafcpp
... & TSBLOCKS.cpp
..... | ReadMet«

L;* handler */

T5_WORD wCommand,
TSPTR_DE pBase,
T5_PTR pClass,
T5_PTR pInst,
5| T5_PTWORD pArgs)
i
switch (wCommand)
{

TS_DWORD _ declspec{dllexport) [ais=mypelisllld (

/~ case TSFBCMD_ACTIVATE :

/* enter your code here...
_P_Q=8;

_P Q |= _P_BYTE4_ << 24;
_P_Q |= _P_BYTE3_ << 18;
_P_Q |= _P_BYTEZ_ << 8;
_P_Q |= _P_BYTELl_ << @&;

\ return 8L;

*f

g Solut.. |@CI555... |Eprnp... |Resc+... ‘

case TSFBCMD_ACCEPTCT
f* _dont chanee that *=7

Then, add this Function name (e.g., “BYTES_TO_LONG”) into the switch case statement of the

"T5Blocks_GetBlockName" functions in the “T5BLOCKS.cpp” file.

Note: The number of the case label (e.g., case 1) must start from "1" and continue with contiguous

numbers.

Solution Explorer - Solution ‘'T3E... » 0 X

2| 2| E S

S ——
resource.h ]/bﬁes_to_long_(ﬁﬂlﬂﬂ(s-mtdafx_h |"long_to_bytes.c |

[od Solution 'TSBLOCKS' (1 project)
= (54 T3BLOCKS

= [ Header Files
.. [n] resourceh
.. [n] stdafih
... [n] tsvm.h
= [ Resource Files
... Za TSBLOCKS.rc
= |5 Source Files
. &4 bytes_to_long.c
... &1 long_to_bytes.c
... € stdafx.cpp
.. & TSBLOCKS.cpp

NS —

(Global Scope)

L
B DLL_API void Project_End{wvoid)

i
J—] JfPut you code in the below

b

- J/This function will be called one time when a project 2

switch (dwIndex)
1l

case 1 : return L"BYTES_TO_LONG™;

1

return NULL;

(ﬂ)LL_ﬁF‘I LPCTSTR TSBlocks_GetBlockName (DWORD dendex]\
i

/* should continue with cw.guuus numbers... */

J
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18.4.3 Edit the Logic of the Function Block (In this example is “long_to_bytes.c” )

typedef struct
i

TS5_DWORD dwData; /*
¥ _str_FB_LONG_TO_BYTES;

TODO:

replace dwData by the items wou need */

TS_DWORD _ declspec{dllexport) LONG_TO_BYTES ﬂ

X

T5_WORD wCommand,
TSPTR_DE pEBase,
T5_PTR pClass,
T5_PTR pInst,

TS5_PTWORD pargs)

Each used Function Block in the Win-GRAF
project has distributed a “private
structure”memory for users to use.

_str_FB_LONG_TO_BYTES *pData;

phata = (_str_FB_LONG_TO_BYTES *)pInst;

switch (wCommand)

{

case TSFBCMD_ACTIVATE
/* activates the function block */
J* enter vour code here... ¥/
_P_BYTEL = P LONG_VAL & BxFF:
_P_BYTEZ_ = (_P_LOMG VAL > 8) & @xFF;
_P_BYTE3_ = (_P_LONG_VAL 3> 16) & @xFF;
_P_BYTE4 = (_P_LONG_ VAL >> 24) & @xFF;
return eL;

case TSFBCMD_INITINSTANCE
J* initialize private data */
J/* enter vour code here... ¥/
return aL;

case TSFBCMD_EXITINSTANCE
/* release private data */
/* enter your code here... */
return 8L;

case TSFECMD_HOTRESTART
/* actuate private data for hot restart */
f* enter your code here... ¥/
return éL;

case TSFBCMD_SIZECQFINSTAMNCE
/* dont change that */

e

e

D

Doing expressions in each Cycle.

It used to initialize the “private
structure” when the project starts.

It used to close the “private
structure” when the project stops.

Update data in the “private structure”
memory when the project hot re-tarts
or on-line change.

return (TS_DWORD)sizeof{_str_FB_LONG_TO_BYTES);

case TSFECMD_ACCEPTCT
f* dont change that */
return 1L;

default
return 8L;
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Finally, remember to add the Function Block name (e.g., “LONG_TO_ BYTES”) into the switch case
statement of the "T5Blocks_GetBlockName" functions in the “T5BLOCKS.cpp” file.

resource.h | bytes_to_long.c | TSBLOC K&cpp]’stdaﬁm

(Global Scope)

Solution Explorer - Solution 'T5B... » 0 X

= & E S
m Solution 'TSBLOCKS' (1 project)
= (54 TSBLOCKS
- (i Header Files
[n] resource.h
[n] stdafich
i |h] tSvm.h
- [ Resource Files
... [ TSBLOCKS.rc
- [ Source Files
... & bytes to_long.c
& long_to_bytes.c
... & stdafcpp
.. ©f TSBLOCKS.cpp
ReadMe.txt

TeSe—

Note: The number of the case label (e.g., case 1) must start from "1" and continue with cd

numbers.

Solution Explorer - Solution 'TSB.. » O X

=3 Ea

m Solution 'TSBLOCKS' (1 project)

=- (53 TSBLOCKS

- £ Header Files

.. [n] resource.h

|n] stdafih

i |h] tSWMLR

B [ Resource Files

.. & TSBLOCKS.rc

B [ Source Files

... &4 bytes_to_long.c
¢ long_to_bytes.c
¢ stdaf.cpp

- & TSBLOCKS cpp
ReadiMe bt
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TS5_DWORD dwData; /* TODO: replace dwData by the items you need */

l {
} _str_FB_LONG_TO _BYTES;

B

handler */

T5_DWORD __ declspec({dllexport LONG_TO_BYTES)(
T5_WORD wCommand,

TSPTR_DE pBase,
T5_PTR pClass,
T5_PTR pInst,
T5_PTWORD pArgs)

_str_FB_LONG_TO_BYTES *pData;

pData = (_str_FB_LONG_TO_BYTES *)pInst;
switch (wCommand)
{
case TSFBECMD_ACTIVATE
/* activates the function block *f
/* enter your code here... */

P
resource.h rbytes_to_longﬂg T5BLOCKS.cpp| Jtdafich | long_tofbytes.c |

(Global Scope)

e

/

é S/Put you code in the below
= S/This function will be called one time whef a project stops.
}
EDLL_API LPCTSTR T5Blocks_GetBlockMame (DWORD/ dwIndex)
i
switch (dwIndex)
i
case 1 : return LB
case 2 : return
J* should contints )
T
return NULL;
H

= LPCTSTR DLL_API GetLibInfo(LPCTSTR *info)
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18.4.4 Trying to Compile the Project
1. Click "Build" > "Build Solution" to generate a DLL file.

@9 T5BLOCKS - Microsoft Visual Studio (Administrator)

File Edit View Project |Build | Debug Data Tools VMware Test Analyze Window
-l | $ . Build Solution \Ct F7 se ~ XPacSDK_CE (x86)
an

- wParSDK CE %26 Device Rebuild Soluti rl+Alt+F7

: | = Deploy Solution R .
e .0 - A . =1 v|| =3
= B | Clean Solution e . !
P [ B L ' il | 5 %= [ = == | Hex 3] |
ion EworeSoiar 7 L | BulETSBLOCKS e SBLOCKScpp el
| e i 2 ] std f){_h
P Rebuild TSBLOCKS B PP sigahsl
2|3 E A -

m - Deploy TSBLOCKS

| (e Solution 'TSBLOCKS' (1 pn e =

LT o Clean TSBLOCKS in the below

2. After a successful compilation, copy the “USER_C.dIl” file to the path "\System_disk\Win-GRAF\" in
your PAC, and then reboot it.

@7@4 | C:\Users\Grady\Desktop\TSBLOCKS\TSBLOCKS\XPacSDK_CE (x86)\Release NENE

B HE b fic]
] TSBLOCKS.obj 2014/10/22 TS 05.. ObjectFile
(1] TSBLOCKS. pch 2014/9/9 T 06:38  Precompile
B TSBLOCKS. pdb 2014/10/22 T 05.. PDBEE
(3| TSBIOCKS res 2014/10/9 F504:25 Compiled |
@ USER_C.dll 2014/10/22 T 05 ERESE
W] USER_C.pch 2014/10/9 T 04:24 Precompile
fpvcanidb 2014/10/22 T 05.. [DBHE=E
& veE0.pdb 2014/10/22 F05.. PDBEE

~ B Openwith KUSO EXIFViewer E =H

USER Cdll St HE: 2014/10/22 FF 0521 EITHE: 2014/10/9 FF 0528
EHELER Fiz 5.50 KB
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18.5 Test your own Function and Function Block

1. Copy the "user_c.dll" file to the same folder as the Win-GRAF driver (i.e., \System_disk\Win-GRAF\)
on the PAC by using FTP. And, reboot the PAC.

If a proper DLL file is detected by the Win-GRAF Driver, its dialog will show as below.

Win-GRAF-XP-8xx8-ATOM-CE6 [ok]

XP-S3x8-ATOM-CES driver Version 1.01 , Aug.07,2014 build 7

‘This product is licensed.
Project: demo_rdn_1, Extra_port: None

Elapsed time : 0, 0: 1:14
Add DLL version here,
Add Your DLL information here.

2. Open the Win-GRAF project that includes your own Function and Function Block, and then compiles
and download this project to the Win-GRAF PAC.

In addition, there are some available files in the Win-GRAF PAC’s CD-ROM for users to test.

(1) WP-8xx8, WP-9x28-CE7, WP-8xx8-CE7, VP-x2x8-CE7 and WP-5xx8-CE7:
\napdos\Win-GRAF\demo-project\user_c_lib\wp_vp\user_c.dll

(2) XP-8xx8-CE®6:
\napdos\Win-GRAF\demo-project\user_c_lib\xpc\user_c.dll

(3) Copy the Win-GRAF Library folder -"User" to the following path on your PC.
C:\Win-GRAF\DATA\HWDEF\

(4) Open the Win-GRAF sample project —"demo_user_c.zip”, and then compiles and download this

project to the Win-GRAF PAC. (Refer to Section 13.1 to open the Win-GRAF project from a zip).

Win-GRAF User Manual, V2.0, Aug. 2020 by ICP DAS 18-19



Chapter 19 Using 3G Modules - I-8212W-3GWA

Note:

1. Due to the product certification issue, the 1-8212W-3GWA module can sales in certain areas. Please
contact our agents for more information.

2. There is one another 3G Solution, that is, the user can buy a 3G Router come with a SIM card. By this
way, the Win-GRAF PAC can also connect to the Internet via the 3G network.

Sending back the collected data to the control center is necessary in some application. However, there
may be no cable can reach the field or the cost of the network wiring is too expensive. ICP DAS released
the “Win-GRAF PAC + 1-8212W-3GWA” solution for such applications. Designers can collect I/O data or
other application data by program a PLC application (Ladder, ST, Function block, etc.) with Win-GRAF
software. Using the device — “I-8212W-3GWA” (insert the SIM card inside that has registered the 3G/2G
service from the Telecom Company) to connect Internet by dial-up 3G/2G, then the PLC can send TCP
data to the center.

3G/2G Wireless Application

1-8212W-3GWA (3G/2G) + SIM card

Control Center
(WG-Communication Server)

The following Win-GRAF driver version supports the dial-up 3G/2G access with the 1-8212W-3GWA.
XP-8xx8-CE6 : 1.03 or later WP-8xx8 : 1.05 or later ~ VP-x2x8-CE7 : 1.01 or later

If the Win-GRAF driver version of your PAC is older than the above listed version, please visit the
https://www.icpdas.com/en/download/show.php?num=695 to download the newer driver.

1-8212W-3GWA: http://www.icpdas.com/en/product/I-8212W-3GWA
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19.1 Hardware Installation

The 1-8212W-3GWA supports 3G/2G wireless communication. Insert the 3G SIM card (that registered
the 3G/2G function from the Telecom Company) into the “SIM card” socket of this 3G/2G module and
make sure the antenna has installed well.

If your PAC is XP-8xx8-CE6, plug the 1-8212W-3GWA in its slot 1.
(I.e., the leftmost 1/0 slot of the XPAC).
If your PAC is WP-8xx8 or VP-x238-CE7, please plug the I-8212W-3GWA in its slot 0.
(I.e., the leftmost 1/0 slot of the WinPAC. The slot number of ViewPAC is shown on the back).

Then power on the PAC and run PAC Utility (for example, run “XPAC_Utility” for the XPAC) to set up the
“COM®6” port of the I-8212W-3GWA. Remember to run “File > Save and Reboot” once to save the
settings.

The user can find out the PAC Utility on the desktop or the PAC folder (e.g., \System_Disk\Tools\
XPAC_Utility), or download the Utility on FTP:

For WinCE 6.0 XPACs:
http://www.icpdas.com/en/download/show.php?num=2488
For WinCE 7.0 PACs / ViewPACs:
http://www.icpdas.com/en/download/show.php?num=2083

XPAC_Utility:

@/ XPAC Utility [1.2.0.0] _|
- File Help

i \ """" [Nemn:urk IDevice Infor mation IAut:n Executian IRDtary Execution | Multi-I0 Modulas |E-ackplane Cal 4 | r |

y8# Y IO Moules for

(3F Multi-Serial Port Serics The 3G module must be
Multi-I0 Modules - | plugged into the leftmost
This tab can show each MUlt-ID Modules' Ports on this slot of the PAC. And, the
device. COM port number is start

There are several kinds of multi-IO module such as o
8114, A144, 8142, and 8112, from “6”.
If you have to use these multi-I0 ports, please use the

port name which show |eft, .\

Select COM Part Type: () USE MSa/B/C/Dx | @ USE COMy, Start COM Port number D

Select order type: () Sequence order | @ Slot order (Original)

Set
fnote: The minimum value should more than &) K
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WinPAC_Utility:

WinPAC Utility [2.1.0.6]
File Help Configuration

IEﬂﬁemet Seftings l Metwaork Settings l Systern Inforration l Autn Execution [: Multi-serial port wizard g 4 | 4

ity

Slot 0:

Slot 1:

Slot 23

Slot 3:

Slot 4:

Slot 5:

Slot 5:

Slot 7:

=B Sloto
8212-3G * COME
Bk com7

@ Driver enabled
e Driver disabled

UL

() Sequence orde

Slot scan (Refresh) Stepz:

Step3: Go to "File" —>"Save and Reboot" to enable driver

Install driver iapply to I-5112/51 1451 42/5144 series modules )

Stepl: Port number assigned according to

r {®) Slot order (Fixed order)

[ USE Msamskx
USE COMx

Start Port nurmber IZ'

Tabja[wle[r[t]¥Juli]o]p

Input Panel I— e

m N FEE=CR RN E

ES((1]2]3]4]5]6]7(8]0]0]-|=]|@] '~ = €
| []]

| C
culai] " [\] L4t

caPlas[d]f]a[n]i[k[I]:;]"
shift] z v[b[nm[,[.[/]+
I

{—I—}

Finally, run “File > Save and Reboot” in the PAC Utility.

XPAC Utility [1.2.0.0]
S0 Help

Save and Reboot
Reboot

Restore Lty D
Exit

efault Settings
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19.2 Software Installation

Please check the Win-GRAF driver version for your PAC is the correct version that listed in the Section 19
(P19-1). If not, update it.

19.2.1 Install the I-8212W-3GWA (or 1-8213-3GWA) Driver
Note: Plugthe I-8212W-3GWA into the 1/0 slot0 of the WinPAC or ViewPAC.
In addition, plug it into the 1/0 slotl of the XP-8xx8-CE6.

Double-click the “icpdas_i-821xw_com6_vx.xx.cab” file in the path of Win-GRAF PAC -
\System_Disk\Win-GRAF\ to install the I-8212W-3GWA driver if the PAC is the XP-8xx8-CE6, WP-8xx8 or
VP-x238-CE7.

Address |\System_Disk\win-GRAF

| Marme Size | Type

' sofgrafy File Falder
dial_up_rnet_win_graf.di 4B Application Extension
Cdial_up_utility _win_graf.exe 27.5KBE  Application

11.5KB  Application Extension
1.15KE CAE File

[B¥icpdas_i-82 1w _come_v1,00,cab :

After completing the installation, remember to open the XPAC Utility (or WinPAC Utility, ViewPAC
Utility) and run “File > Save and Reboot” to save the settings, then the PAC will restart automatically
once.

(In the below figure, we use XP-8xx8-CE6 as a sample, select “Manual Save To Flash” and then run “File >
Save and Reboot”).

¥PAC Utility [1.2.0.0]

¥=0 Help

|
Dnfig INetwcurk IDevice Infor mation IAub:u Execution I Rotary Exsl 1 I 4

Save and Reboot
Reboot

Restore Utility Mefault Settings Welcome 1o use XPAC Utility

, This tool will help you easy to
it use ¥PAC CE series.

Task Bar setting:
[T &wuto Hide
[ always On Tap

HIVE Registry:

L??—j ‘X-P A-C “;INCE SﬁI‘lﬁ'i () suto Save To Flash Default)
. @ Maunal Save To Flash
Backplane Battery [ EnahleMyitorun in plugging USE Disk
Batteryl : OK Batteryz : Ok
Configure the synchronization with a time server | Configure |
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19.2.2 Configure the 3G/2G Dial-up Parameters

At first, get into the “Network and Dial-up Connections” and then run “Make New Connection” on the
PAC.

.Ij Priograrns r

Favorites r .
veFe # P
i Docurments # b L
g Settings [F Contral Panel Make Mew PCI- PCI-

we\glg=mawigk FETCESE1 FETCESEZ
@ Help a Metwark and Dial-up Connections \
o, Taskbar and Start Menu.,..

| |'¢_-,Netwurk Connections

Select “Dial-Up Connection” and type an English name (e.g., “3G”, it allows to contain the numbers 0 to
9) and then click the “Next” button. Then, Select the modem - “ICPDAS I-821xW COM®6:” and click the
“Configure ...” button.

Make New Connection Modem
Type a name for the connection: 3
) E}l 3G
[L "l (e
Select a modem:
Select the connection type: | EIAE TR s C oG vy
@) Dial-Up Connection

N
{ ) Direct Cannectian Eﬂﬂﬁgurﬂ‘-- |

(O virtual private Network (PPTP) | ICP/IP Settings... | Security Settings... |’
() Virtual Private Metwork (L2TP)

() PPP aver Ethernet [PPPOE]

| <Back || uext@ . <Back | Next> |

N\

In the “Port Settings” tab, select “Baud Rate” as “115200”, “Data Bits” as “8”, “Parity” as “None”,

4

“Stop Bits” as “1” and “Flow Control” as “None”.

Device Properties
 Part settings Dral options
c~————— .
_ _ _ -Connection Preferences i
n E?irrll_égljmal {user supplies dial Baud Rate |1152EIEI E
N
Data Bits a N
Terminals - I EI
u Use terminal window Barity IN':'”E EI
before dialing Stop Bits Il EI
] s termninal window after
dialing Flow Control
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Then, click “Call Options” tab to set up the “Extra Settings” (the settings depend on each of the Telecom
Company). For example, the settings provided by a Telecom Company in Taiwan is
+CGDCONT=1,"”IP”,”INTERNET”

and a Telecom Company in China is
+CGDCONT=1,”IP”,”CMNET”

This configuration includes the 3G/2G APN (Access Point Name), please contact your SIM card provider

(Telecom Company), to get the settings, or you can also visit the web to search the word “3G/2G APN”
to find the settings.

Device Properties Eﬂ
CaII Options |

Call Setup
Cancel the call if not connected within 120 seconds
Wait for dial tone before dialing

Wait for credit card tone |0 seconds

Must fit the setting provided by the
Telecom Company. Or you may Google

Extra Settings (special modem commands may be s §earch for A’PN Settings”. (This example
I+CGDCONT= LI TNTERMET" is for Taiwan’s some Telecom Company.)

This part is APN. [-LE] 11:25 am ,L,-.;}|_»_->i

Then get into the “TCP/IP Settings ...” dialog box and follow the same settings as below.

-
_I_.-‘?l 3G

S G—— TCP{IP Settings 0K

Ganeral Drame Servers

Config -‘,:T

TCPfIP Settings.ﬁﬁe_curity Sett se server-assigned IP address
C 1 1 1 1

TCPfIP Settings
| | Use Slip

——
C : General (Mame Servers |)
[w))lUse software compression -

; IUse [P header compression ‘i‘] 7 3G

HCPDAS [-52

33

| = Back || i [

se server-assigned addresses
DMS:
At DS
wine: [ |
sewms: | |
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Then get into the “Security Settings” dialog box and follow the same settings as below. Afterward, type
the phone number for 3G/2G dial-up, and it must fit for the number provided by Telecom Company, and
then click “Finish”.

Modem

H_PDAS I-

Configure...

TCP/IP Settings... | Security Settings... |

aN

Security Settings Em
Advanced Security Settings ]

L

[ ] Use Data encryption

Logon security:

[ Use Extensible Authentication Protocol (EAP Modem
MOS-Challenge
| g 3 L.Ji1 3G
|_H

[v|Unencrypted password (PAP) Selzict @ rime s

[v/IChallenge Handshake Authentication Pratocol (CHAP |ICF'D’E‘5 [-821:00 COMB: ﬂ
[ Microsaft CHAP (MS-CHAR)
[ |Microsoft CHAP Wersion 2 (MS-CHAP w2

Configure...

TCPfIP Settings... | Security Settings...:

Phone Number = Back | Next }kl

-
i‘i 3G

Countryfregion code: lli

Area code: 423 . .
o This phone number should fit the

Efame rumiass: ul\ Telecom Company'’s setting.

[ ||Force long distance (This example is for some

[ IForce local Telecom Company Taiwan.)

Don’t check them. —
FInIShk

Back
| = e L |- 11:26 am L,-J|f1
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Next, double-click on the new connection (e.g., “3G”) that you have created and get into the “Dial

Properties” dialog box, and then get into the “Dialing Patterns” to change the content of those three
fields as “G” and click “OK”.

W] X
I_'— I—' I_—-Il-l

Make Mew PiI- PClI-
Connection FETCESE1  FETCESEZ2

Dial-Up Connection

-’

Al

Lser Mame: | Phore: HOQQkAE]

Dial from:

Password: | Haome

DIomain: | Dial Pruperties...‘l

a AN

[ Save password Connect Cancel |

Dialing Properties m

when diding from: | JECa | new... | Remove |
-Local settings are:
The local area code is: |425

The local countryfregion code is; |1
Dial using: @ Tone { ) Pulse

[ | Disable call waiting by dialing:

Dialing Patterns. k|

Dialing Patterns

Edit the dialing pattern for each type of call to change hiok
the phone is dialed,

Ecr | ocal calls dial:

For JLong Distance calls dial:

Fot [International calls dial:

E,e = Country/Region Code; F,f = Area Code; 5,0 =
urnter )

| 11:26 am L=J| “:?1
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Now, you need to make a dial-up connection to check if the 3G/2G network is OK. Please type the “User
Name” and “Password” that provided by the Telecom Company or online search the word “3G/2G APN”.
As figure below, we use a Taiwan SIM card for Telecom Company as an example (keep two fields blank)
and then click “Connect” to make the 1-8212W-3GWA (plus SIM card) to start dial-up.

Dial-Up Connection
)
Al
Lser Mame: | Phone: *QoEE] ¢
Dial frarm:
Paszword: | Hame
Daomain: | | Dial Properties... I
[] Save passward | g:unnect‘l | Cancel |
N

If the connection is successful, it will show up “Connected”.
(Note: Refer to Section 19.2.3 after running the “Ping” command)

3G Status

2

Hide this message:

Disconnect

After successfully connecting, open “Command Prompt” and give a ping command to check if the
connection is fine. If the ping command fails, refer to Section 19.2.3. After a successful ping, it must run
“Disconnect”, then continue the next important steps.

) Communication * File Edit Help

@EEI’E"SD Pocket CMD < &_00

".}Iping T goole. com I

Pinging Host www. goole_com [213.165.70.32]

Beply from 213.1&65.70.39: Echo size=3Z time=38&m=s TTL=47
Beply from 213.165.70.39: Echo =size=3Z time=37Zm= TTL=4E5
Beply from 213.165.70.39: Echo =size=3Z time=377m=s TTL=47
Beply from 213.165.70.39: Echo sime=3Z time=38Zm=s TTL=47
b o=

& Command Prompt
@@ Programs @ DCOMN_CE_XP
'z Favorites 2 isghw3S
U Docurnents ., RegEdit
[¥ Settings P[5 TaskManager

LEN 106 A ([ 3
.':;.’ Winidows Explorer | a AI%
MR comn L xPac Utility 3G Status

Jj}l Connected

-

Hide this ressage:

Disconnect
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19.2.3 Important Configuration (DO NOT ignore it)!!!

Users must do the following two important settings!

1.

If the PAC is going to send/receive the TCP data by using 3G/2G Internet connections, it must clear

the gateway settings of LAN1 and LAN2 or else it may not work properly. Then, remember to run the

PAC's Utility “File > Save and reboot” once to save the settings.

(Using the XPAC)

& ¥

2
Make Mew

33
Connection

(Using the WinPAC)

Px %

. —_

PCI- Make Mew
FETCESEZ Connection

2l

3G

LAN1

'PCIFETCESBE1" Settings

IP Address | Mame Servers |

oK) X

An [P address can be
autornatically assigned to this
computer, If your netwiork
does not autoratically assign
IP addresses, ask wour netwaork
administrator for an address,
and then type it in the space
provided,

() Obtain an IP address via DHCP

Specify an IP address:
IP address: |192.1E|8. 71,18

Subnet Mask: [255.255. 0 . O

Leave “Gateway” blank.

Default Gateway: |

1/

If your PAC can connect to the Internet by using LAN1 or LAN2, recommend not to use the 3G/2G

(in such a case, it requires to set the gateway of LAN1 or LAN2). The reason is LAN1 / LAN2 speed is

faster than the 3G/2G.

In the previous page, the connection has been established. For now, the following configuration is

very important and can’t be ignored or else it will cause some problem when you connect to the
3G/2G network using the Win-GRAF program.

If the status of 3G/2G connection is still “Connected”, please click the “Disconnect” button first.

3G Status

Hide this ressage:

-‘i];l Connected

Disconnect
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After that, run the new connection (here is “3G”) and then click “Cancel” (At this time, Do Not click
“Connect”, you must click “Cancel” ). Finally, run “File > Save and Reboot” in each PAC Utility (e.g.,
“XPAC Utility”) to save all the settings (including this and those in the previous section) and then the PAC
will restart automatically once.

B & % #

Make Mew PCI- PCI-
Connection FETCESB1 FETCESBZ

Dial-Up Connection
)
Al
Lser Marme: | Phiore: QO]
Dial frorm:

Passward: | Hame
Diomain: | Dial Properties... |

D iz 2 Connect Cancel

AN
This “Cancel” operation must be set
once. Then, run PAC’s Utility to save
this “Cancel” setting.

XPAC Utility [1.2.0.0]

1IN Help

Save and Reboot
Reboot
Restore Uity
Exit

Befault Settings
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19.2.4 Enable “Dial_up_utility_win_graf” " Dial-up Software
“Dial_up_utility_win_graf” is a software tool developed by ICP DAS for the 3G/2G dial-up automatically.

It allows a Win-GRAF program (or VB.net, C#.net and C program) to connect or disconnect 3G/2G by

sending commands and it can also read the connection status or command status. Please follow the

steps below to enable this dial-up software. Then, click “Connect” to check if the connection is good and

click “Disconnect” to check if the connection is broken. Finally, you need to run “...PAC Utility” and add

the “dial_ up_utility_win_graf.exe” to the list of “Auto-Execution” and then run “File > Save and Reboot

to save the settings.

||eddress [5ystem _piskwyin-Grar

—
E Marme

I Size | Type

sofgra
My Device — sofgrafy

f—

dial_up_net_win_graf.dll

Wait about 25 sec. | 1)

blank is ok.

(Entry: The name of the
new connection.)

B @

Connection

“User” and “Password” must fit the setting
of the Telecom company. For some case,

Makie New 3G

2. 4KB

File Folder

Application Extension
Application
Arplication Extension

when starting up the PAC, check this
“Connect when starting up” box.

If wish to connect “3G” automatically

XPAC Utility [1.2.0.0]
=[-8 Help

Save
Save and Reboot

Reboot 12

Exit

Restore Utility Default Settings

At most 10 programs
can be specified 1o
execUle automatically
at system startup.
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Program 3:
Program 4:
Program 5:
Frogram &:
Program 7:
Program 8:
Program 9:

Programii:

Curren Crnd Connect
Cormm, status Disconnected
| Connectxl ’ Disconnect | | Address |
N
Entry |3G | Diarnain |
User Passwd |
—@Cumnect when starting up: Wer.1.01
6.
Lock Set parameter About
\. 4 w
=

bnfig INetwu:urk IDevice Information | AL Execution |R|:|tar\,r E}{% ; I ;
9.

[\System_Diskiw/in-GRAFYAlin_GRAF_XP_fwx | | Browse |

|\System_Diskwin-GRAFdial_up_utility_win ||£

| Browse |

|| Browse |

|| Browvse |

| _Browss |

|| Browse |

|| Brovwse |

|| Brovwse |

19-12

N

| Browse ]10.




19.3 Function Descriptions for Controlling 3G/2G Connection

This Win-GRAF demo program shows how (* Set “To_connect_3G” as TRUE to connect 3G to

to use _3G_connect() to connect 3G/2G. access to the Internet *)

Set up “To_connect_3G” as TRUE, it will if To_connect_3G then
instruct “Dial_up_utility_win_graf” to To_connect_3G := FALSE ;
connect 3G/2G.

_3G_connect() ;

end_if;

And, this Win-GRAF demo program shows (* Set “To_disconnect_3G” as TRUE to disconnect 3G *)

if To_disconnect_3G then
To_disconnect_3G := FALSE ;

_3G_disconnect() ;

the way to use _3G_disconnect() to stop
the 3G/2G. Set up “To_disconnect_3G” as
TRUE, it will command

“Dial_up_utility_win_graf” to disconnect.
end_if;

The program below shows the way to use _3G_state() to read the current status of the 3G/2G
connection and use _3G_read_cmd() to read the current status of the 3G/2G command.

(* Get 3G connecting state *) 0 : No-action
State_3G := _3G_state() ; (1~ 6): Connecting ...
1: Open COM Port 2 : Port opened
3 : Connect device 4 : Device connected
(* Read current 3G command 5 : Authenticate 6 : Authenticated
0 No action 7 : Password expired 8 : Connected
1: Connect 9 : Disconnected 10 : Others

2 : Disconnect *)
current_3G_cmd := _3G_read_cmd() ;

When the 3G/2G dial-up state is “Connected”. The driver will try to ping DNS Server and “8.8.8.8” every
15 minutes to test if the 3G/2G communication is ok. If there is no response for 15 seconds, the
Win-GRAF PAC will automatically reset the 3G/2G module and then re-dial-up to recover the 3G/2G
communication . If the user doesn't want to ping this “8.8.8.8”, can modify it to ping one another IP
address (for example, 202.43.192.106). Like as below code.

(* Set IP address (other than 8.8.8.8) to ping every 15 minutes *)
if To_ping_a_new_ip then

To_ping_a_new_ip := FALSE;

TMP_BOOL := _3G_option(1,'202.43.192.106' ) ;
end_if;;
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Chapter 20 Sending a PAC File to a Remote PC via Ethernet or
3G/2G Wireless Networks

For some applications that need to record some useful data on the PAC like temperature, humidity,
speed, voltage, current, etc., these data can be saved as a file by the user-designed Win-GRAF
program. Then, the user can use the following ways to send this PAC file to a remote PC/Server.

In the shipping CD (CD-ROM: \Napdos\Win-GRAF\demo-project\), the user can find out the Win-GRAF
demo project (demo_send_file.zip) which will be used in this chapter (refer to Chapter 12 to restore it).
In addition, in the CD-ROM: \Napdos\Win-GRAF\Tools_Utility\, there is a Win-GRAF Communications
Server software (called WG-Communication-Server) which run on a PC/Server to allow the file sending

from the PAC.
Win-GRAF PAC +
- 3G Router + SIM card

Win-GRAF PAC i , <

Win-GRAF PAC +
1-8212W-3GWA (3G/2G)
+SIM card

PC/ Server
(WG-Communication Server)

Note: There are two ways to setup a Win-GRAF PAC with 3G/2G network.
(1) Using a 3G Router plus a SIM card.
(2) Using the 1-8212W-3GWA module plus a SIM card (refer to Chapter 19).
In addition, the PC/Server must run the "WG-Communication Server" software which must
configure a public IP for the user sends the PAC file by using 3G/2G network or Ethernet (WAN).

The following Win-GRAF driver versions (or later version) support functions described in this chapter.
WP-8xx8 : 1.05
VP-x2x8-CE7 : 1.01
XP-8xx8-CE®6 : 1.03
WP-5xx8-CE7 : 1.02
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20.1 Description of the "WG-Communication-Server" Software

Note: Copy the "WG-Communication-Server” folder (includes WG-Communication-Server.exe and
DLL) into the D:\ on your PC/Server, and then running this software to allow the file sending
from a remote PAC. The user can use the "WG-Communication-Server" to create the
username/ password (max. 100) for a remote PAC can log in and send a file to this PC/Server.

Add a User Account:
1. After running the "WG-Communication-Server", it will zoom out to the bottom-right corner of your

desktop screen (running in the background). Double-click the small icon if you want to configure it.

G- Commundcabion-server exs
| TG-Commundeation-Server
ICEDAR

(. @200 tFum

2. Click "Manage Account" to open Account Manager and then check "TCP port for file transmission".

WGE-Commonmication-Server

: The default is "4567".

: ication-&
opyright Mar. 2015, Hisory Log File for File Transmition -
All Right Reserved. %Emte one fils per day () generate one file per month

service @icpdas.com

TTaer List Aeeomnt Setting
Mame
Passwrord
Rt Dir fior File Transmition
Add ] [ Femove

"TCP port for file transmission": To enable the specific TCP port (Default: 4567; Range: 1000 ~ 9999)
for communicating with the PAC while file sending. (Note: Whether check or uncheck this item, or
even modify the TCP Port number, the user must restart this software to apply the setting.)

"History Log File":
To generate one historical log file per day/month (choose "per day" in this case).

Note: Go to the next step to set up an account. In addition, the user can open the "D:\WG-
Communication-Server\account.txt" to check the account that you set up before.

O BEx B B B & A

Historyr acconnttd  account babk confiz tmphis bt WG-CDmmuniE WinGraf Se...
cati;:un—Senfer.eg
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3. Click the "Add" button to enter a username (e.g., "Spider-Man") and then click "OK".

TCP port for file transmition. | 4567

Historyr Log File for File Transmition :
(%) generate one file per day () generate one file per month

Taer Lzt Becoumnt Sething

—

Rt Dir for File: Transadtion

[ Add‘] [ Eemove
N\

4. Click on the username (e.g., "Spider-Man") to set its password (e.g., "AB-567"). Click "Root Dir" can

set the PAC file storage path, we recommend to use the defaults - D:\WG-Communication-Server
\User Name (e.g., Spider-Man), and then click "Apply" to take effect. Finally, click "OK".
Note: The user can view the "Generate User Key" usage in Section 22.1.

Account Manager

TCP port for file transmition (4567

Hiztory Log File for File Transmition :
(*) generate one file per day () generate one file per month

Ty Lzt Aecount Fething
W Marne
1. 2.

pasw

%]

Enter “AB-567" in this example.
Note: Click "Apply" for these
settins to take effect.

Reot Dirfor File Transmiton [ yk| 3

Add l l Remove l l Crenerate TTser Key l

Delete a User Account

Click on the username you want to delete (e.g., "Spider-Man"),
click the "Remove" button, and click "OK" to delete this account
(username/password).

D:'\WG-CDmmunicaﬁnn—Sewer'ﬂpide\r-M

Add ] [ Remnve‘]
N
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20.2 "Send_File_To", "Send_File_State" and "Send_File_Abort" Functions

There are 3 functions which can handle the file sending from the PAC to the PC.

The "Send_File_To" function:
To send one PAC file to a remote PC/Server which is running the "WG-Communication-Server”.

En  SEMD_FILE_TO 7] |

IP

Part

\ Note:
d=er

Click on this function and press "F1" key
Password to view the details on settings.

PAC_ID

Desz_File_Path

Src File Path

Input parameters:

Note: Valid characters for the "User", "Password", "Des_File_Path" and "Src_File_Path":
A~Z, a~z(case-sensitive), 0~9, "' (dot), '@' (At), '-' (minus) and '_' (underscore).

IP: (Data type: String) IP address of the remote PC (e.g., '192.168.71.29’).
Port: (Data type: DINT) The TCP port number (range: 1000 ~ 9999).

User: (Data type: String) User name (max. 32 characters).

Password: (Data type: String) Password (max. 32 characters).

PAC_ID: (Data type: DINT) A number to identify the file is sent by which PAC.

Value range: -2,147,483,648 ~ 0~ 2,147,483,647.

Des_File_Path: (Data type: String) Destination file path in PC (max. 128 characters).
And the first character should be '\', however the last character cannot be '\'.
(E.g. '"\2014\12\data001.txt' or "\Record\recp-2014-11-08.txt')

Src_File_Path: (Data type: String) Source file path in PAC (max. 128 characters).
And the first character should be '\', however the last character cannot be '\'.
(E.g. "\Micro_SD\PAC\data001.txt' or '\System_Disk\DATA\recp-2014-11-08.txt')

Output parameters:
Q: (Data type: BOOL)
TRUE: Communication OK.
FALSE: Wrong input parameters or "Src_File_path" doesn't exist or file size is 0.
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The "Send_File_State" Function:
To get the sending state of the PAC file. (MUST use with the "Send_File_to" function.)

En SEMD _FILE_STATE Enc |
Y Q
S
Note:

Click on this function and press "F1" key
to view the details on settings.

Input parameters:

None.

Output parameters:

Q: (Data type: DINT)
0: Sleep, no "Send_File_To( )" function is called.
1~99: Busy, afile is sending now. ("1 ~ 99" means the percentage of completion)
100:  Succeed, the file sending is finished and the file is sent successfully.
-1: Send failed or timeout.
-2: The file sending is interrupted by the "Send_File_Abort" command.
-3 Username/Password error.
-4 Unable to create a sub-folder or file in the PC, or

The file is over 10,000,000 Bytes, or

There is no "WG-Communication-Server” running on the PC.
-5: The file for sending does not exist or the file size is "0".
-6: Unable to open the file located at “\Email_ETH” of the PAC.

The "Send_File_Abort" Function:
To abort the file sending.

[En_ SEMD FILE aBoRT @l |

Input parameters:
None.

Output parameters:
Q: (Datatype: DINT), always return "TRUE".
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20.3 Description of the Win-GRAF Demo Project (demo_send_file.zip)

This Win-GRAF demo project (demo_send_file.zip) can be found in the shipping CD (CD-ROM:
\Napdos\Win-GRAF\demo-project\), refer to Chapter 12 to restore it.

After opening this "demo_send_file" project, mouse double-click on "Main" to open this LD program.

Then, you can see all defined variables listed on the right of the window (i.e., Variable Area).

Win-GRAF - demo, send_file

File Edit View Insit Project Tools Window Help

AN NETRIE N I M E %ME QR g [ %A
i
2 demo_send_file I — ! ! S——— ~ ﬂme | Type
. end_ mp_k 5
|_.3 Exception programs " ESED FLETO G _] Main . -~
[ Programs 3 | fal Global variables
il des_path STRING(128)
[ *wiatch [for del — | src_path STRING(128)
&8 Soft Scope | port | part ip STRINGZ4)
&d initial port DIMT
= Initial values il uzer | zer user STRING(E2)
%4 Binding Configuration o password STRINGI(EZ)
g Global defines ol pazsword |Passw... PAC_ID DINT
tal wariables Send_it BOOL
B Types » PAC_IDAPAC_ID Send_state  DINT
< Trp BOOL  BOOL b
| des_path {Des_Fil.. < 3
" " _ £3 Al -
=1 - SC_P Src Fil. £ [Used)
:ﬂ_?' Se';d—'t I 3 [Praject]
B 1 Advanced
| SEND_FILE_STATE L Anthmetic
[ Arrays
| el send_state [ AS-interface
Inst_BLIMK Send it CF BALnet
| RUM BLINK G P | [J Booleans
1 CaAMbus
| | T#3M ' CLE 1 CaMopen
s A Clack ¥
< > 4 ¥| Blocks, Soulist | Define | ENUM
4 ¥ | Main “ariables
4 Build Crozs refarances Runtirme Call stack Brezkpaints Digital zmpling trace Prompt HhAl x
Ready Offline 192.168.71.19:502 £ 0,54 186 x 15 0,0

First of all, we need to know what variables are used in this project and their purposes. You can also

click "Variables" on the left of the window (i.e., Workspace) to view/set all variables.

Workspace
2 demo_send file I Mame | Type w | Dimn. | Attrib, | Sub. | Init value | Uze

fab

Global variables

[ Ewception programs

[d Programs des_path STRING(128) L1 1001w&larmdt txt'
“#] Main src_path STRING(128) L1 “System_Disk\&larmD1 txt’
3 “watch [far debugging) user STRING(32) ] 'Spider-tan’
8 Soft Scope password STRING(ZZ) [l AB-5&7
&d initial ip STRING(24) ] 192.168.78.161"
= Initial values port DINT O 4857
%3 Binding Configuration PAC_ID DINT ] 1001
: Send_state  DINT O
Send_it BOOL O
Trmp BOOL  BOOL O v
>
4 bdain | Wariables
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Variable Description:
The following table describes the variable name, data type, their usages, and initial value that used in

the Win-GRAF project (demo_send_file.zip).

Name Data Type Description
Destination file path in PC (max. 128 characters).
h TRING(12
des_pat > G(128) (Init value: '"\1001\AlarmO01.txt')
Source file path in PAC (max. 128 characters).
src_path STRING(128) (Init value: "\System_Disk\Alarm01.txt')
PC login username (Max. 32 characters).
user STRING(32) (Init value: 'Spider-Man')
PC login password (Max. 32 characters).
password STRING(32) (Init \;galure)' 'AB-567")
. IP address of the remote PC. (Max. 24 characters.)
'P STRING(24) | (| it value: '192.168.78.161")
ort DINT The TCP port number of the WG-Communication-Server to
P receive files. (Init value: 1000 ; Range: 1000 ~ 9999).
A number to identify the file is sent by which PAC.
PAC_ID DINT (Init value: 1001)
Send_state DINT Get the sending state of the PAC file. (Refer to Section 20.2)
Send_it BOOL Set it as "True" to send a PAC file.
TRUE: Communication OK.
Tmp_BOOL BOOL FALSE: Wrong input parameters or "Src_File_path" doesn't
exist or file size is 0.

LD Program (Main)
The "Send_File_To" function (refer to Section 20.2) is used to send a PAC file to a remote PC/Server.

Send_it Tmp_BOoL
| En  SEND FLETO @ |
Set it as "True" to send a PAC file. I P "True": OK.

"False": Wrong input parameters
or file/file path doesn't exist.

port JPort

Enter the PC’s IP address, TCP port /user Uzer
number, and login username/
password (Max. 32 characters).  |Password |Passward

Enter a user-defined identification
RAC_IDPAC_ID <4 number, destination (PC) and
source (PAC) file path.

des_pathDes_File_Path

stc_path|Sre File Path
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Send_it

| €4—| Reset “Send_it” as “False”.

The "Send_File_State" function is used to get the sending state of the PAC file.

En SEMD_FILE_STATE Enj |

f=end_state

®

0:

Return the state of file sending.

Sleep, no "Send_File_To( )" function is called.

1~99: Busy, afile is sending now. ("1 ~ 99" means the percentage of completion)
100 :

Succeed, the file sending is finished and the file is sent successfully.

Send failed or timeout.

The file sending is interrupted by the "Send_File_Abort" command.
(see Section 20.2)

Username/Password error.

Unable to create a sub-folder or file in the PC, or

The file is over 10,000,000 Bytes, or

There is no "WG-Communication-Server” running on the PC.

The file for sending does not exist or the file size is "0".

Unable to open the file located at “\Email_ETH” of the PAC.

The "BLINK" function block in this example is used to send a file every 3 minutes.

RLI BILIMK =] P |

T#aM PTVICLE

Set to send a file every 3 minutes.
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20.4 Test for File Sending

Before testing this project, check the following settings in the "Variables" window:

"src_path": Does the file exist on the PAC (i.e., \System_Disk\Alarm01.txt)? If not, download it by
using FTP or assign other file. (Note: the file size cannot be 0 bytes.)

"ip": Enter the IP address of your PC. (If using 3G/2G network or an Ethernet (WAN) to connect
to a Server, the user must enter a public IP.)

"port" (4567),"user" and "password":

These settings must be the same as the "WG-Communication-Server" settings (Refer to Section 20.1).

workspace
2 demo_send_file T Mame | Type | Dirn. | Atk | Swb. | Init value | Us
[ Exception programs ot Global variables A
[ Programs des_path STRIMG(128) C1 %1001%Wlarm0 et
“&1] initial src_path STRING(128) L] System_DiskialarmO1. txt’
e Main ip STRING(24) N 152 165875 .99
[ Wwatch (for debuaging) port DINT O 4567
¥ Soft Scope user STRINGEZ) L] 'Spider-Man’
= Initial values password STRIMG(3Z) [1 ‘AB-SGET
% Binding Configuration PAC 1D DIWT L] 1001
+g Global defines Send it BOOL L]
2 Variables Send_state  DINT ]
B Topes Trp_BOOL  BOOL L] v
4 | >

L initizl tizin | “Wariables

Moreover, set the current IP address of the PAC in the Communication Settings, and then recompile
and download this project to the Win-GRAF PAC.

Communication Sethngs '
Work=pace Variables —
B0 demo_szend_file ¥ hlama I
[ Exception prog | TS Runtime hd | )

3 Programs Communication Parsmeters... ‘192 168,71 29502 ‘Ik |
1] initial : \ 168.71.29: ]
j"| i Line N\ m]

2] Main
Current PAC’s IP. E]

3 watch [for det BB Simulate
m Soft Scop I

Note: If the user wants to set the timeout value (default: 3 seconds), refer to Section 2.3.5.
(E.g. Set the IP to “192.168.71.29:502(10)” which means the timeout is 10 seconds.)

= O Y e AR g (5
After downloading the 0000 [Main] -

project, double-click

En SEMD_FILE_TC @

"Send_it" in the LD program | ]
(i.e., Main) to set it as k152158 7.9 |
"TRUE" to start sending the ! TALE \ WA | port - ase7 Jport

f||e. [ FALSE ] (0] = 'Spicer-Man' {User

ord = "&8-567" {Pazsward

PAC_ID=1001 JPAC D

dez_path = "1001\Alarm0... |Des_File_. .

src_path = "System_Disk.. | Sre File P

[~
|
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When the progress of "Send_state" reaches "100", it means that the file is sent successfully.

SEND_FILE_STATE )

() send_state = 100

Return the state of file sending.

0: Sleep, no "Send_File_To( )" function is called.
1~99: Busy, a file is sending now. ("1 ~ 99" means the percentage of completion)
100: Succeed, the file sending is finished and the file is sent successfully.

-1: Send failed or timeout.

-2: The file sending is interrupted by the "Send_File_Abort" command.
(refer to Section 20.2)

-3 Username/Password error.

-4 Unable to create a sub-folder or file in the PC, or

The file is over 10,000,000 Bytes, or

There is no "WG-Communication-Server” running on the PC.
-5: The file for sending does not exist or the file size is "0".
-6: Unable to open the file located at “\Email_ETH” of the PAC.

Now, the file is sent to the PC - "D:\WG-Communication-Server\Spider-Man\1001\AlarmO1.txt".
(Refer to Section 20.1 — Step4 and Section 20.3 — the "des_path" variable)

ﬁiﬂ:(ﬂ I DAWG-Communication-Server'S pider-Mani1 001 b |
Fu $8R fEti 5 EA
lEE sTFaiif 201545 EF 1156

In addition, this Win-GRAF example project (demo_send_file.zip) is designed to send a file every 3
minutes, the user can open "WG-Communication-Server" to view file receving records.

WGE-Commonnication-Server

WG -Communication-Server YVer, 1.0 A
Copyright bar. 2015, by ICP DAS CO., LTD.

All Bight Eeserved.

service @icpdas.com

Spider-kan has login.

Spider-tan has logout.

Spider-Man recive file ok.

Spidel-Ian has [ogin. - ]
Spider-Man has logout. All login records will
Spider-Man recive file ok,

Spider-Man has login. be shown here.
Spider-ban has logout.
Spider-Man recive file ok.
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Chapter 21  Win-GRAF SMS Function

This chapter shows the way to send/receive a text message by using the Win-GRAF PAC comes with the
3G/2G wireless module. This Win-GRAF demo project (Demo_SMS.zip) can be found in the shipping CD
(CD-ROM: \Napdos\Win-GRAF\demo-project\), refer to Section 21.2 for details).

Software/Hardware Requirements:

1. Win-GRAF PACs
The following Win-GRAF driver versions (or later) support the SMS function (refer to Chapter 19).
WP-8xx8 : 1.05 ; VP-x2x8-CE7:1.01 ; XP-8xx8-CE6:1.03 ; WP-5xx8-CE7 : 1.02

2. 3G/2G Wireless Modules: Visit the website for more details.
http://www.icpdas.com/en/product/guide+Wireless__Communication+3G_4G__Products+Modem
All supported GSM Modems: GTM-201-RS232, GTM-203M-3GWA, 1-8212W, |-8212W-3GWA (refer to
Chapter 19), I-8213W-3GWA.
Note: Due to the product certification issue, these modules can sale in certain areas.

Please contact our agents for more information.

21.1 "GSM_Open", "Send_SMS" and "Read_SMS" Functions

There are 3 functions which can handle the SMS messaging by the Win-GRAF PAC.

The "GSM_OPEN" function:
To open/close the GSM module.

In=t _I:l PER _'3 =ha
Note:
Click on this function and
G gCOhPort o=ignalCuality |- Sianal press "E1" key to view the

details on settings.
'0000" {yPinCode gErrorCode|-Error_Code

Input parameters:

gEnable: Data type: BOOL
TRUE: Open the specified PAC’'s COM port to connect the GSM module and initialize it.
FALSE: Disconnect the GSM module and close the specified PAC’'s COM port.

gCOMPort: Data type: DINT
The PAC’s COM port number which connects with the GSM module.

gPinCode: Data type: STRING
Using this PIN code to unlock the SIM card, if it is necessary.

Output parameters:

glsinitialized:  Data type: BOOL
TRUE: Open the specific PAC’s COM port and initialize the GSM module successfully.
FALSE: Failed to open the specific PAC's COM port or the GSM module is not initialized.
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gSignalQuality: Data type: SINT

gErrorCode:

0~ 31: The higher value means that the signal strength is stronger.
99: Unknow or not detectable.

Data type: INT

0: No error.

-1: Broken line.

-2 : SIM card not inserted.

-3 :SIM PIN code wrong.

-4 : SIM configuration error.

-5: Cannot open the specified PAC’'s COM port.

The "GSM_SEND_SMS" Function:
To send the SMS message via the GSM module.

In=t SERID Shis

Phone_Mb | gPhonerlb gErrorCode |- Send_SMS_Error_code

sms_text |gSMSText \ Note:
Click on this function and press "F1" key

codePage |gCodePage . . -
=1 . to view the details on settings.

Notice: Before using this "GSM_SEND_SMS" function, first the user must use the "GSM_OPEN" to open
the PAC’s COM Port which the GSM module connects with, or else this function will not work.

Input parameters:

gExecute:

gPhoneNb:

gSMSText:

gCodePage:

Notice:

Data type: BOOL
Pulse TRUE: trigger it to send SMS message.

Data type: STRING
Destination-Address (i.e., the phone number).

Data type: STRING
The text message.

Data type: UDINT

The code page of the text.

English: 0 Traditional Chinese: 950 Simplified Chinese: 936
Japanese: 932 Russian: 866

If the “gCodePage” is set as "0", the max length of text is 160 characters.

If the “gCodePage” is not set as "0", the max length of text is 70 characters.

If the user type more than the maximum text length, the Win-GRAF driver will just send the
maximum characters from the beginning of the text.
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Output parameters:

gErrorCode: Data type: INT
4 : Send SMS succeeds -1 : Cannot find valid GSM module.
3 : Sending SMS -2 : SIM card not inserted.
2 : Send SMS is pending -4 : SIM card configuration failed.
1: Prepare to send SMS -5 : Cannot open the PAC’'s COM port.
0 : No operation. -6 : NO recipient number.

-7 : Send SMS message failed.

The "GSM_READ_SMS" Function:
To read the SMS message via the GSM module.

Notice: Before using this "GSM_READ_SMS" function, first the user must use the "GSM_OPEN" to open
the PAC’s COM Port which the GSM module connects with, or else this function will not work.

Input parameters:

gExecute: Dataty

TRUE : Enable to read the SMS message from the GSM module.

Inzt_RFAN_SHS

gExC GSM_READ_SMS is... Note:

gReceivesh, . FReceivesSmMSText settlngs.

Click on this function and press
codePage! JuCodePage gSenderPha... |- Sender_phonetlh "EqM key to view the details on

pe: BOOL

FALSE : Disable to read the SMS message from the GSM module.

gCodePage: Dataty

pe: UDINT
The code page of the text. Please refer to the following example:
:0 Traditional Chinese: 950 Simplified Chinese: 936

English

Japanese: 932 Russian: 866

Output parameters:
glsNewSMS:

gSenderPhoneNb:

gReceiveSMSText:

Data type: BOOL
Pulse TRUE: the new message is coming.

Data type: STRING
Originating-Address (i.e., the phone number).

Data type: STRING
The text message.
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21.2 Description of the Win-GRAF Demo Project (Demo_SMS.zip)

This Win-GRAF demo project (Demo_SMS.zip) can be found in the shipping CD (CD-ROM: \Napdos\
Win-GRAF\demo-project\), refer to Chapter 12 to open project from a zip file. There are one LD program
(SMS_pro) and two ST programs (SendMessage and ReadMessage) in this "Demo_SMS" project.

s pro ¥ X
2 Demo_SMS L L L L L A |[F Name | Type
3 Exception programs —— To openiclose GEM module _] SMS_pro -

I; 2 pOnBadlindex B
I; 2 pOnDiiZera R
57 pShutDown
s1] Dotartun

[ Programs

“&7| ReadMessage

“&1] SendMessage

= To zend M=

&¥ Soit Scope > | R2
=4 Initial values -
“&d Spylist B
,_l& Binding Configuration
jg Global defines
'ﬁ'] “ariables
B Types B
3[4l Projects]

Sl B

= Toread SMS

R3

<

4 ¥ | SMS pro Sendhessage

GSM_Module_en

L Inst_OPEM_GSM  GSM_OPEN
lzinitialized - - -

Inst_SEMD_SMS  GSM_Send_S
Inst_READ_SMS  GSM_Read_t
6oco.. osign...| Signal Inst_TIME_GET Time_Get
fat Global variables
‘0000 feRinC.. gErro. | Error_Code Signal SINT
Error_Code INT
Sms_text STRING(255)
Izintialized  Trigger_To_Send Trigger_To_Send  BOOL
55M_SEND_S.., | Sender_phonehlb  STRING(255)
ReceiveSMSText  STRING{255)
Phone_Mb{oPho... gErro.. |-Send_SMS_Err.. FPhone_Mb STRING(255)
codePage UDINT
Sims._text{oEM... GSM_Module_en  BOOL v
< ¥
codePage JoCod
3 [am »
3 [Used)
leintislized  Read_SMS_en I5_Plew_Messa... 3 [Project)
4 Advanced
[ Arithmetic
codePagel JoCod... gSen..|Sender_phone... [ Amraps
[ AS-interface
| oRec..|ReceiveSMSText 2 3 BAChet v
b3 4} él:cnkr:ﬂ“gnulist Define | ENUIhd

Readhessage

“ariables

SpyList

Variable Description: ( * : Refer to Section 21.1 for more details)

Name Data Type Description
GSM_Module_en B00L | e the GoM module snd intilie
Signal SINT The signal quality of the GSM module. (*)
Error_Code INT The error code of the GSM module. (*)
IsInitialized BOOL To check if the GSM module has been initialized.
Trigger_To_Send BOOL Set it as “TRUE” to send a text message.

The phone number of recipient.

2

Phone_Nb STRING(255) | it value: '0932860424')
The content of texting.

2
Sms_text STRING(255) (Init value: 'This message is sent from Win-GRAF PAC')
codePage UDINT The code page of the sending text. (*)
Send_SMS_Error_code INT The error code during the SMS sending. (*)
Read_SMS_en BOOL Set it as “TRUE” to read a text message.

— "

codePagel UDINT The code page of the receiving text. (*)

(Init value: UDINT#950)

Sender_phoneNb

STRING(255)

The phone number of sender.

ReceiveSMSText

STRING(255)

The received text message.

Is_New_Message

BOOL

To check if there is any new text message.

Got_New_Message

STRING(255)

To receive text message. (ST — ReadMessage)

Got_Message_from_who

STRING(255)

To receive the phone number of sender.
(ST — ReadMessage)
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The LD Program (SMS_pro)

Refer to Section 21.1 to view how to configure these three functions.

= To openicloze GEM module

GEM_Module_en

Set it as “TRUE” to open the specified
PAC’s COM port to connect the GSM
module and initialize it.

Inst_OPEN_G:Sh

Izinttiglized

= To =zend SWS message

lzInitialized Trigoer_To_Send

w w

When these two variables are set as
“TRUE”, it will send the SMS message.

codePage

Phone_Mb

Sms_text

gE ... GSh_OPEM glsl... |
EgcomPort gSignaia... | Signal Return the result of
initializing the GSM
'0000° {ePiniCode  gErroriCa.. J-Error_Code module.
Inst_SEMD_ShS
of. GSh_SEND_SMS: . |

gPhonerlb gErrorCo.. |-Send_SME_Frror_code

OIS Text

gCodePa..

= Toread SM= message

lzInitialized Read_SM=_en

w w

When these two variables are set as
“TRUE”, it will read the SMS message.
Set the “Read_SMS_en" as “FALSE” to
stop reading the text.

The ST Program (SendMessage)

if Trigger_To_Send then

if IsInitialized then
if Send_SMS_Error_code < 0 then
(* Send SMS failed *)
Trigger_To_Send := false;

codePage!

(* TODO: Add failed processing here *)

elsif Send_SMS_Error_code = 4 then

(* Send SMS successed *)
Trigger_To_Send := false;

(* TODO: Add success processing here *)

end_if;
else
(* GSM modaule is not initialized *)

(* TODO: Add failed processing here *)

end_if;
end_if;

Inzt_READ_SMS
g. GEh_READ SMZ .

gCodePa... g3ender.. | -Sender_phonetlh | Check to see if

gReceiv.. |-ReceiveSMSText
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The ST Program (ReadMessage)

(* Get new message *)
if Is_New_Message then

(* If the user need more time to deal with the new message, *)

(* the user could set "Read_SMS_en" as “FALSE” to disable the Read_SMS function *)

(* and then set it as “TRUE” after dealing *)

(* Notice : If the user set "Read_SMS_en" as “FALSE”, it will stop reading the SMS message. *)
(* Read_SMS_en := false; *)

Got_New_Message := ReceiveSMSText;
Got_Message_from_who := Sender_phoneNb;

(* do more operating *)

end_if;

21.3 Test for SMS Messaging

In this example, we use one Win-GRAF XPAC and plug one 3G/2G module (I-8212W-3GWA + SIM card) in
its slot1. Before testing this project, set the current IP address of the PAC in the Communication Settings,
and then recompile and download this project to the Win-GRAF PAC. (Refer to Section 2.3.5 in case of

any doubt.)

After connecting to the PAC, the "SMS_pro" program is shown as below:

AN IE AR IR W < i % 0 A E 5y o A ) ELLR X
Workspace O00C [SMS_pro]
S [ Demo_SMS [RUN] A
[ Exception programs == Toopeniclose G5 module =
s 2 pOnBadindex B = — o
Ba 0nDiZ EEM_Mocdule_en = TRUE Inst_OPEN_GSM lzInitislized = TRUE
a PLnLIwEn i ] | oE... GSM_OPEN gl . O |
51 pShutDown
e 5T pStartup | 6-ocomPont gSignaa.. |- Signal = 13
=4 Programs
“Er] ReadMessage B ‘0000 |gPinCode  oErrorCo. |-Error_Code =0
TEr
H J Sendiessage —— To zend SMS message
e 8E] SMS_pro B
£1-- [ Watch (for debugaing) Isinitislized = TRUE Inst_SEND_SMS
g8 Soft Scape B | | o). GEM_SEND_SMS:,., |
e i Initial values
-5 Spylist B Phone_Mb = '0932860... {oPhonehlb  gBrrorCo. . |-Send_SMS_Error_cod...
Wiy Binding Configuration _
39 Global defines B Sms_text = 'Thiz mes.. JgsmMSText
Y Wariables
By Types B codePage = 0gCodePa..
....... [ (&) Projects) —— Toread Shis
lsinttislized = TRUE  Read_SMS_en = TRUE In=t_READ_SMS
| | | 11 o). GEM_READ_SMS ... |
B codePage! = 350 4gCodePa... gSender...|-Sender_phonehl ="
L Receiv.. |- ReceiveshSText =" a3
£ | >

4 »| SME pro ZendMessage Readhiessage “Wariables Spylist
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1. Fill in the COM Port No. which the GSM module used and the PIN code of your SIM card (if it is
necessary to use). In this example, the GSM module uses the COM6 (refer to Section 19.1) and the
SIM card PIN Code is '0000'.

= To openicloze GSM module

EEM_Module_en = TRLE Inat_COPER_GSh lzintialized = TRIJE
| | oE... GSM_OPEN glsl... )
/ GAaCOMPort gSignald.. |-Sianal = 16
n n n n
Set the "GSM_Module_en" as "TRUE A:":":":" gPinCode  oFrrorCo. |-Error_Code = D\

to open the specified PAC’'s COM port
(In this example, COM Port =6 and
PinCode ='0000') to connect the GSM
module and initialize it.

The signal quality of the GSM module
is "16" and the "Error_Code" is "0" (no
error, see Section 21.1)

2. Fill in the phone number, the text message and the code page.
In this example, the PAC will send an English (CodePage = 0) text message ('This message is sent
from Win-GRAF PAC') to the cell phone number '0932860424' (or '886932860424').

3. Mouse double click the "Trigger_To_Send" to set it as "TRUE" to send a text message. If the
"Send_SMS_Error_Code" changes to "4" that means the texting is successful (refer to Section 21.1).

= To zend SM= meszage

Isinitislized = TRUE Inst_SERD_SMS
. . oEx... GSM_SERD_SMZ  Eno |

* Phione_Mi = '0932860424' JgPhonetlb gErrorCode |-Send_ShS_Error_cade = 4

Double click to Sms_tend = This message is ..

set it as "TRUE". / codePage =0

In this example, If the "Send_SMS_Error_Code"
Cell phone number: '0932860424' (or '886932860424') is "0" that means no error.
Text: 'This message is sent from Win-GRAF PAC' (See Section 21.1)

Code page: 0 (English ; Traditional Chinese: 950 3 : Sending SMS

Simplified Chinese: 936 ; Japanese: 932 ; Russian : 866) 4 : Send SMS succeeds

4. For testing an SMS message reading via the PAC, using a cell phone to send a text message to this
SIM card. In this example, using the cell phone number ('886932860424') to reply a Chinese

(CodePagel = 950) text ('ICP DAS A& RIS BB AR AT]") to this SIM card.

= To read SM= message

Isinitialized = TRUE Read_SMS_en = TRUE Inst_READ_SMS
11 oE ... GSM_READ_SMSgls... B — |
T codePagel = 950 )gCodePage  oSenderPh, ‘ “Sercler_phonshl = 83693,

gReceives  NTeceiveSMSText = ICP DA,

"TRUE": to read an SMS message.
"FALSE": stop reading an SMS message.
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Moreover, the user can double click the "SpyList" to open the Spy list, and then change the variable
value to test the SMS messaging.

= | =y 0 6 Ba@AX = o Ol & YNE AR e &
Workspace OOo0 spylist.spl
= I Demo_SMS [RUN] 5 Name | Value
£--E3 Exception programs e G5M_Module_en TRUE
------- P8 pOnBadindex i Signal 13
------- P8 pOnDivZera B+  Emor_Code 0
------- 51| pShutDown [zl nitialized TRUE
------- 7] pStartup Trigger_To_Send
= Programs Phone_Mb 0332860424
....... “B1] ReadMessage Srs_text ‘Thiz meszage iz sent from WinGRAF PAC
------- “B1] SendMessage codePage 0
....... *—”ﬁ_:-"l S5 _pro codePage] 350
[ " atch [for debugging] Send_SM5_Emor_code 4
[ Soft Scope Read_SMS_en
....... Gitialecales Sender_phoneMb
(-Ed Spylist ReceraSMSText
------- ‘UgErmrm Configlration Got_Meszage_fraom_who '‘BEES32860424'
....... g Global defines Gaot_Mew Meszage CP DaAS EAE R R BER SR
------- ‘[ﬁ Wariables
....... B Types
------- 3 (80 Projects) £, l :

4k SkA5 pro Sendhessage Readhdessage Wariables Spylist

Note: If the 3G/2G wireless module is connected to the RS-232 Port of the Win-GRAF PAC, the user
must refer to Appendix F to view the pin assignment of the COM Port. (Using the XP-8xx8-CE6 as
an example, the pin assignment of the COM4 or COMS5 is different.)

XP-8x38-CE6 L GTM-203M-3GWA

CA-0910 LP-5238
(com2)
TxD
RxD GND RxD TxD
GND ><
GND RxD TxD
TxD
RxD
GTM-203M-3GWA
GND
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Chapter 22  The Intelligent Win-GRAF 3G Solution

The following Win-GRAF driver versions support intelligent 3G solution described in this chapter.

WP-8xx8 : 1.05 ; VP-x2x8-CE7:1.01 ; XP-8xx8-CE6:1.03 ; WP-5238-CE7 :1.02

PC (WG-Communication-Client)

_—_ /-)

Sl

— InduSoft

& === Win-GRAF (SCADA/HMI)
)}) Win-GRAF PAC
Public IP Ethernet .

(support Domam Name)

Win-GRAF \

INll;RNLI
—_—— i _/
= B j:‘ (((O

VUL | —

PC / Server
(WG-Communication- Server) 0
Wb»(_ommmamx. Sercerexs .}
W e C s Win-GRAF PAC +

3G Router + SIM card

The main features of the intelligent 3G solution is to connect the Win-GRAF PAC to the Server

(WG-Communication-Server) with a public IP (support Domain Name) via 3G wireless or via the Internet.

Then the PC/laptop (WG-Communication-Client) can communicate with the remote PAC via the Server.

The user can achieve the following functions:

1. The user’s PC/laptop can run the Win-GRAF Workbench to remotely debug/update the Win-GRAF
application on the PAC.

2. The user’s PC/laptop can run the SCADA/HMI software (e.g., InduSoft) to remotely monitor the PAC.

3. The user’s PC/laptop can remotely update the Win-GRAF driver on the PAC if it is necessary.

4. The remote PAC can actively send a log file to the WG-Communication-Server.

Note:
4. The WG-Communication-Server must have a public IP address. Other remote PAC and user’s

PC/laptop no need a public IP address.
If Internet connection for the PAC is available, the user no need to buy a 3G Router.

6. If Internet connection for the PAC is unavailable, the user can buy a 3G Router and then insert a
local SIM card to enable the PAC to access the Internet. We recommend you to choose an
unlimited 3G data plan to reduce the Internet connection charges.

7. If there are several PACs in the same worksite to connect to the WG-Communication-Server, set
up an Ethernet switch first. Then connect this switch to the 3G Router so that these PACs can
access the Internet through this switch.
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22.1 Set Up the PC/WG-Communication-Server

The user can use the "WG-Communication-Server" to create the user account (max. 100) for the remote
PC/laptop or PAC to log in to the Server (Note: Both the PC/laptop and the PAC must log in with the
same username/password, and the PC/laptop need to install the "WG-Communication-Client".) In the
Win-GRAF PAC CD (CD-ROM: \Napdos\Win-GRAF\Tools_Utility), copy the "WG-Communication-Server"
folder to your Server PC’s "D:" (i.e., D:\WG-Communication-Server).

Notice: The "WG-Communication-Server.exe" must be stored in this folder to work properly.

Add a User Account:
1. After running the "WG-Communication-Server", it will zoom out to the bottom-right corner of your

desktop screen (running in the background). Double-click the small icon if you want to configure it.

G- Comumnnde abion-Sery er exe

]r';rl.:rl oG Ao - Se Y eT - \vs P '_I_' E::Jj" : -
ICPDAS ‘ﬂ - o AL R IL

2. Click the "Manage Account" icon to open the setting window.

WG -Commonnication-Server E E ﬂ

'Comfnght Max 2015, - History Log File fu_:r File Tramsmnition : |
&ll Right Reserved. () generate one file per day () generate one file per month

service @icrpdas.com

Tlzer List A coont Bething
Marme
Pasaword
Eoot Dir for File Transmaition
Add ] [ Remove

"TCP port for file transmission": To enable the specific TCP port (Default: 4567; Range: 1000 ~ 9999) for
communicating with the PAC while file sending. (Note: Whether check or uncheck this item, or even
modify the TCP Port number, the user must restart this software to apply the setting.)

"History Log File": To generate one historical log file per day/month (defaults: "per day").

Note: Just go to the next step to set up an account. In addition, the user can open the "D:\WG-
Communication-Server\account.txt" to check the account that you set up before.

5B 2 8 WU o
account account tthk config tmphista  [WE-Comumum Winlef_Je...
cation-Serverel
& :
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3. Click the "Add" button to enter a username (e.g., "Spider-Man") and then click "OK".

[] TCP port for file transmition |:|

Hiztory Log File for File Transmition
{(*) generate one file perday () generate one file per month

ey List Aecount Betting

[ 4Add ‘] [ Femove
N\

4. Click on the username (e.g., "Spider-Man") to set its password (e.g., "AB-567"). Click "Root Dir" can
set the storage path of the PAC file or user key, we recommend you to use the defaults - D:\
WG-Communication-Server\User Name (e.g., Spider-Man), and then click "Apply" to take effect (and
unlock the "Generate User Key" button.

[] TCP port for file transmition |:|

Hiztory Log File for File Transmition :
(%) generate one file perday () generate one file per month

Tlzer List B eoonnt Setting

,@ Name Enter “AB-567" in this example.
1.

Note: Click "Apply" for these

2. settins to take effect.
e
Bt Dir for File Transmoition || - 3

D:\WG-CDmmunicaﬁun—Sewef'Spide\r-Mm

Ldd ] [ Remove ] [ Generate Tser Kew ]
5.

5. For security concerns, the remote PC/laptop must have a user key provided by the Server for
successfully logging in to it. Click "Generate User Key" to create a user key.
Notice: Each time you click "Generate User Key" and confirm it, a new user key will be created.
Be careful to make sure you want to do it because the PC/laptop which includes an old user key
cannot login to the Server any more
(unless installing the generated new
use r—key in it) . '\ To generate a new User-Kewr will make the old User-Eey no work aoymore.

Wamning message

Mg wom sure to proceed ¥

If it must to create a new user key, click “Yes", and then
the old user key on remote PC will become invaild.
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Send the user key to the remote user (client), and copy it to the D:\WG-Communication-Client on
user’s PC. Then, the user will have the access authority to use this username/password to login to the
Server.

e 3 DAW-Conuumication-Server' pider-Man b |
#n | #ERl

2 3

1@] Spider-an-key bin

Copy this user key to the user’s PC
(D:\ WG-Communication-Client).

| .8

Delete a User Account

. TCP port for file transmition
Click on the username you want to LJTcPe |:|

delete (e.g., "Spider-Man"), click the History Log File for Fil Transmition -
(%) penerate one fils per day () generate one file per month

"Remove" button, and click "OK" to
delete this username/password. User List Aecount Setting

e —
pasv

Reot Dir for File Transmition | . |
DAAG-Commumnication-Serverss pid er-ban

b [roro]
N

View the connection status
This feature is used to view what PC/laptop or Win-GRAF PAC is connected to this Server.

WG-Commonnication-Server

E'Cu:q:n}.rnght Mar, 2015, by ICF DP;S.CD., LTD.
all BEight Reserved.
service @icpdas.com

Connection state |

A PAC, its Port ID is 20009 (Refer to
Section 22.2), is connected to this Server.

The user use the account - “Spider-Man”

3
"= 4~ to login to the Server (122.147.137.140).
» Spider-kan 122147127140 |Connected
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22.2 Set Up a Remote PAC to Connect to the WG-Communication-Server

If the Win-GRAF PAC connects to the Internet via a 3G Router (plus a SIM card), view its product
instructions to configure it. Note: Many 3G routers on the market has the build-in Wi-Fi feature.

For security issues on PAC communication data, we recommend you to disable the Wi-Fi function of
the 3G Router.

The network setting on the PAC

Please configure the network settings according to the field demands. If the user uses the 3G Router as
a gateway and set its IP address as “192.168.0.254”, and then assign IP addresses which range from
“192.168.0.100” to “192.168.0.200” for PACs, then you can set the PAC’s network setting as below.

® Double click the PAC Utility (e.g., XPAC_Utility) on the PAC’s desktop, and then click the IP setting tab
(e.g., IP Config) to fill in the proper IP, Mask, and Gateway address, and click “Apply”. Finally, execute
“File = Save and Reboot” to save and reboot the PAC.

pA 0.0 1%
File |Help
E[/‘ eneral | General2 | Displa(| [P Config I)Ietwurk IDevice Information IAuh: Execution I Rotary Exd_{ I 4
HPAC_Ltility 2.
1.
LAN 1: LAN 2:
MaAC Address: 00-10-F3-18-21-AC MAC Address: 00-10-F3-18-21-AC
P A 0.0 () Use DHCP to get IP address @ Use DHCP to get IP address
Help 3. @ Assign IP address () Assign IP address
Save . .
IPAddress: 1921680105 |l Assign an IP address for this PAC.
Restore Utility Default Settings Gateway:  [1921630254  |lg— Enter the IP address of the
Exit DMS Server: 3G Router.
Applvﬂ 4 Apply |

N

Using the “WG-Communication-PAC” on the PAC to connect to the Server
On the PAC, you can find out “WG-Communication-PAC.exe” at the path “\System_Disk\Win-GRAF\”,
and then use it to connect to the WG-Communication-Server.

1. Double click the “WG-Communication-PAC.exe” to open the setting window.

File Edit View Go Favorites ||]] al» %

||ddrest]system_Diskwin-crar

= sofgrafy License. bin schiedule_in_pac. txt
Cdial_up_utility_win_graf.exe dlial_up_win_graf.dl [@in:pdas_i-EIEl}{w_cDmEu_ul.IIIEI.n:ah
Quicker.dl QuickerMet.dl [ 5chedule_in_PAC.exe
C1Soft-GRAF-WIGF, exe UserShareMet, dl [ E&G-Cummunicatiun-mc.exeé

BaR i _GRAF_XP_Swx3_CEA.Ink t5.cod '

Win-GRAF User Manual, V2.0, Aug. 2020 by ICP DAS 22-5



2. Fillin the username/password (e.g., Spider-Man/ AB-567, refer to Section 22.1) that created by the
WG-Communication-Server, and enter the IP address of the Server, and then assigns a Port ID (e.g.,
20009; Range: 20000 ~ 22000) for this PAC. (Note: The "PAC-Port-ID" is used for a remote Server or
a user’s PC to identify which PAC is connected with them. Different PACs connect to the same
Server should use different PAC-PORT-ID.)

3. Finally, click the "Set parameter" button to take effect.

WG-Communication-PAC o= E
Select it to log in to the
Server after starting up. —{v| Connect WE-Communication-Server when starting up
User : |5pider-Man | Passwd |****** |
Note: In the "Server IP" field,
P : - Server 1P ¢ [122.147.137.140 | PAC-PORT-ID: [20009
fill in the domain name (e.g.,
Www.my-server.com.tw) is Server status | Disconnected
allowable. ..........................................
/Y ......... Lock . Set parameter\| About | ver.1.01
Click “Lock/Unlock” to [v]

forbidden or allow editing.

User : | | Passwd: | |

Server IP ;| | PacPoRT-D:  [oooe ]
Server status

A

Unlack | . Setparameter | Ahout | wer, 1,01

Moreover, run the PAC Utility (e.g., XPAC_Utility) and then follow the steps (shown as below) to add
“WG-Communication-PAC.exe” into the startup program list, and then execute “File = Save and
Reboot” to save and reboot the PAC.

E=z3

eneral ] Geheralz I Display I IP Conifig ] Metwork I Device Information Aunﬁcutian IRDtar\,r Exe 4
2.

e

XPAC_Utility
1.

Program 1: |\5ystem_Disk\Win—GRAF\Win_GRAF_}(F'_Elxx| Browse

Program 2 [\System_DiskWin-GRAFWVG-Comrmunicatio | | Bro i&
I [

'S
Open =N i ij

2] \System_Disk\Win-GRAF 5.
At m;st 7 sofgrafy A3-LOMMUMICATIo J
;izcu?:e [ldial_up_utiity_win_graf.exe  BRWin_GRAF_WP_B000.exe W_4- B

at syste] [|5chedule_in_PAC.exe TR win_(GRAF_WP_8000 Ink

Reboot . 7. _ I5lschedule_in_PAC.Ink iR VWin_GRAF_XP_Sxx2 CE6.exe J
Restore Utility Default Settings [C)Soft-GRAF-WGEF.axe EWin_GRﬂF_)(P_Bx}{EI_CEEu.Ink J
Exit J
[arme: |WG—CcurnmunicatiDn Type: |E}{E files (*.exe) ﬂ J

Clean Apply i 6.
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22.3 Set Up the WG-Communication-Client on a User PC or the SCADA PC

The user’s PC can connect to the Server and then debug/download the Win-GRAF project or update the
Win-GRAF driver to the remote PAC by using the "WG-Communication-Client" software. In the

Win-GRAF PAC CD (CD-

ROM: \Napdos\Win-GRAF\Tools_Utility), copy the "WG-Communication-Client"

folder to your PC’s "D:" (i.e., D:\WG-Communication-Client).
Notice: The "WG-Communication-Client.exe" must be stored in this folder to work properly.

/” Win-GRAF PAC

Switch

Win. GRAF

“E PC/NB

(WG-Communication-Client)

3G Router

22.3.1 Logging to the Server and detect the PAC connection status

Before logging to the Server, make sure the "WG-Communication-Client" folder contains the user key

provided by the Server.
1. Mouse double click the "WG-Communication-Client" to open the setting window, and fill in the user

name, password, an

d Server IP, and then click the "Connect" button.

| | Spider-Man-key.
% WiG-AgentClient.

WGE-Communication-Client

@le L DAWG-Communication-Client  » | \Fay|
a3

NEs 28 »

Notice: If the Server is disconnect, the
Client will log out and then try to
connect to the Server every 30 seconds.

bin € yser Key
4 WG-Communication Client EI =] @

Fill in the username, password, and the
Server IP that are provided by the Server.
Note: The user can also fill in the domain
name (e.g., www.my-server.com.tw) in the
"Server IP" field.

User Mamne :  Spider-ban

+ Faswod: G000 08

Server IP. 122147137140

ﬁ Remember Account Setting

Check the box to save
the account setting.

[ Comnnect k l
N\
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2. After connecting to the Server, you can see the "Server Status" shows "Server Connected" and the
following table will list the status of the PAC connection that connect with the Server (refer to
Section 22.2). The user can click "Add PAC-Port-ID to detect" to add a PAC-PORT-ID (e.g., 20001) to

the PAC connection-detection lists. Or, click "Remove PAC-Port-ID to detect" to remove it from the
lists.

© - WiGE-Communication Client = B ||
Connections i Add new PAC-PORT-ID to detect. i

Please inpnt PAC-PORT-ID to detect. (20000~22000)
20001

| Add PAC-PortID o detect WR|
N

[ Femove PAC-POR T-ID 1o detect ]

[ ok || Comel |
SErVEr st wErver Commected
PAC Name PAC-FORT-ID Statns Diescription
3 MewPAC 20009 Connected Add wour descriphon here. ..

HewPAC 20010 Commected Ldd wour description here. .

3. Mouse double click on any PAC name to open that setting tab. The user can click “Rename” to change

the displayed PAC name, and also can click “Modify” to add comments, and then click “Apply” to
take effect.

ErYEr Statns SErver Commeched
PAC Wame PAC-PORT-ID Status Diescription
> m 30009 Connected Add your description hers...
WewP&C 20010 Comnected Add wour description here.
WewP&C 20001 Disconmnected Add wour description here.
“ 1 WGE-Communication Client El = @
Connections ﬂ|
FAC Mame :  MewFAC Rename the PAC name to : @
PAC-Port-ID - 20000 KEAC-OL [ﬂg
FAC Type P-Bux8-CES

Win-CEAF driver version 103

Description : | Description :

Add wour description here. ..

The EFALC at Banguiao, New Taip?i Citr

Tpdate Win-GEAF Diriver
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Remotely update the Win-GRAF PAC Driver from the PC

In the normal case, the user doesn’t need to update the Win-GRAF PAC driver unless you want newer
driver version that contains new released functions or bug fixing. The user can visit the website to
download the latest version of the Win-GRAF PAC driver.
https://www.icpdas.com/en/download/show.php?num=695

Before updating the Win-GRAF driver, make sure you have copied all related files into the proper folder.
Using the “XP-8xx8-CE6” as an example, first unzip the driver file (.zip) and then copy all files from the
\xp-8xx8-ce6-driver-1.xx\1.xx (e.g., 1.03) to the D:\WG-Communication-Client\XP-8xx8-CE6.

@Qﬂ | DwG-Communication-Client\ XP-8:x8-CE6 NN
EEEE - MAZERE ~ HZESHZE - B mEEE =~ O ':@'
@ Win_GRAF_XP_8xx8_CE6 E‘v"."in_GRAF_XP_SHKB_CEE CWG-Communication-PAC
%) UserShareMet.dll ] Soft-GRAF-WGF (7] Schedule_in_PAC
7 Schedule_in_PAC |2 QuickerMet.dll |%] Quicker.dll
= Label_Name [ icpdas_i-821aw_com6_v1.00 |%) dial_up_win_graf.dll
Cldial_up_utility_win_grat |%| dial_up_net_win_graf.dl| . sofgrafy

1. Run the D:\WG-Communication-Client\WG-Communication-Client.exe and log in to the Server.
(If you are not familiar with the way, refer to Section 22.3.1.)

2. Double click on the PAC name that you want to update and has been connected to the Server, and
then click the “Update Win-GRAF Driver” button.

Note: Don’t restart this PAC, stop this Client, or close this tab while updating the driver. And,
update only one PAC at each time.

‘10 WG-Communication Client EI =] @

Connections |

[ AddPACFortIDiodetect |

[ Femove PAC-PORT-ID 1o detect ]

“r1 WG-Communication Client E' = @

Server Statos - Beever Connectsd Connections HPAC-01 ﬁ|
PAC Name PACPORT-ID Status D

S ;01 20009 Connectsd Th PACHMame: XPACOL
NewPAC ~ 1. 20010 Comnected Ad)
NewPAC 20001 Disconnectsd pa PACFortD: 200089

PAC Type -Gk B-CES
Win-GEAF driver version  1.03

Description :

The ¥PAC at Banguian, New Taiped Citr

Updats Win-GRAF DﬁverKZ
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3. When the “Updating Driver” shows “100%"” means that the update is complete. Waiting for about 60

to 90 seconds. If the “PAC Type” shows “Disconnected” which means the PAC is rebooting now. After
that, confirm the PAC type and Win-GRAF driver version again.

4. Close the “XPAC-01” tab. Then, you can change the other PAC’s settings or click “Logout” to log out
the Server.

(=] = |
. WG-Communication Client 5 WG-Communication Client El =] @

Comnectons i Conmnectomns - %

bdd PAC-Port-ID 1o detect —Lngout
| ] * PACName:  XPAC-OL
[ Eemove PAC-PORT-ID to detect ] 4,

BAC-Port-T0 20003
SEVED Status SErEr Commerted
PAC Name PAC-FORT-ID Status Description| | FAT Type Dizcommecied
> m 30000 Connected The XFAC , , ,
Win-CRAF driver version 000
WewPaC 20010 Comected A4 your de:
WewFaC 20001 Discomnectsd 144

The PAC is rebooting now. Confirm the PAC
type and Win-GRAF driver version again later.

"100%" means
Updating Driver  100% the update is

complete.

22.3.2 Remotely update the Win-GRAF project from the PC/Win-GRAF Workbench
This section will describe how to use the WG-Communication-Client on the PC/Win-GRAF Workbench to
connect to the Server and then remotely download/update the Win-GRAF project to the PAC.

/

H Win.GRapfd
]

— PC/NB
"_&Eﬁ =

(WG-Communication-Client) //

~

Public IP

1 N
Server @3 ;

\ (WG-Communication-Server)/ - I

1. Runthe D:\WG-Communication-Client\WG-Communication-Client.exe and log in to the Server.
(If you are not familiar with the way, refer to Section 22.3.1.)

©

';\le | DAWG-Communication-Client = | J-?.|

B & =52 ==
EETE v | ] Big = »

|| Spider-Man-key.bin € User Key
%, WG-AgentClient.dll

"u"."G-Ct:ummunicatin:-n-Client\
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1. Run the Win-GRAF Workbench and then click "File = Add Existing Project 2 From Zip..." to open the
Win-GRAF project (demo_3GModbus.zip) which is stored in the Win-GRAF PAC CD and its file path is
CD-ROM: \Napdos\Win-GRAF\demo-project\. This example project includes an LD program (Main),
using the “Time_Get” function block to read the system time.

A Win-GRAF - demo_3GModbus
Edit Visw Insert Project Tools Window Help

5o BE AN RN TREENE=N =i i Ol WE AR e %A
s — Lt
£} &) demo_3GModbus I AT Mame | Type | Dir
(- [ Exception programs R1 %} | Jﬁ
- [ Progess B = faf Global variables
ear | vear! Muonth DINT
- [ 'watehThr debuggin... || = B Hourl DINMT
L SoftSoope Morth  Marth Dayl DINT
-#ig Binding Configuration | Min1 DINMT —
i g Global defines o Day |- Day1 Year! DINT
£ variables I Sec DINT v
LB Types | | wlay | < | >
------- [ (Al Projects) o A ~
» | Hour |-Haur 1 £ (Used) 3
N ] . [ [Project]
aa o) [ Advanced
_ second| Sect [ Arithmetic
0l b [ Amaps b
—oil L4 ¥ 4 ¥| Blocks, Sovlist | Define | ENUK
Build >
4 ¥ | Build Crogs references Runtirme Call stack Erezkpaints Digitzl zampling trace Frompt | Hbdl Code Checker
Ready OffLine 127.0.0.1:20009(15) A 0,0 100%18 0,0

And, this project enables a Modbus TCP Slave to allow the SCADA/HMI software (e.g., “InduSoft”) or
the Modbus Master to access Win-GRAF variables (refer to Section 3.1 for more details).

H X = | .o | ¥ e &HM € QR B Al

g MODBLIS Master Name T | Type C
PRGH = &t Global variables +
1 Bl erver - Slave number =1 earl DIMT
B £-*B Input Registers [1..2000] Sect DIMT
ik ------ = +0.1: Yearl baonth DIMT 1
B ------ @ +2.3 Monthi fint DinT
Q ------ = +4 5 Dayl Hourl DiMT
------ @ +6..7: Hourl \Dgy DIMT ):
g2 o 8.5 Min > : <
B & +10.11: Secl Mame | Value |
Slave nurnber | Server 1D |
1

2. Mouse right click on the project name (demo_3GModbus), and then click “Communication
Parameters..” to enter the IP address and the port number.

AN - D= AN= RO WREC Nt

Workspace 10 Drivers
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The configure way is “127.0.0.1:PAC-PORT-ID(Timeout)”, and it's set to “127.0.0.1:20009(15)” in this

example.

Note: “PAC-PORT-ID” is a uniquely identified ID, and make sure this PAC is connected to the Server
(refer to Section 22.2). By default, the Timeout is 3 seconds, recommend you to set it between
15 and 30 seconds if the PAC access to the Internet via the 3G router (plus a SIM card).

Due to the 3G is a wireless network and transmit signals through a base station, it can cause
communication delays or exceptions sometimes. Recommend you to set a bigger timeout
value to range from 15 to 30 seconds to reduce the communication timeout or read/write

Communication Sethngs |

ak.

error.

T5 Runtime

-
Cancel
127.0.0.1: 2000901 5] D

m
I 3
=
“h
= Y

127.0.0.1:20010(15) Help
192 168 71.10:502
192.168.71.17:502

3. Click the “On Line” button to make a connection and download the project to the PAC.
Note: If you have edited this program, it must be compiled before downloading (refer to Section
2.3.4); If there is another project name is running, just click “Stop” to stop that project and
then click “Download” to download the current project (refer to Section 2.3.5 - Steps 4 ~ 6).

File Edit ¥iew Inmrt Pooject Toole Window Help

Fane = O ? = | 9 I A MW R g (558 A RUN PAEE|IE v ¥ @
Workspace O Drive
[ demo_3GModbus [RUN] E Mg MODBUS Master On Line ame Stop/DownIoad
[ Exception programs 2 Mg oy Gllrerermrerrrere »~
[ Programs F, &5 Server - Slave number =1 Yearl 2015 DIMT
“5e] b ain B *B Input Registers [1..2000] Sect 18 DIMT
[ watch [for debugaing) — @ +0.1: Yearl = 2015 Manth1 4 DINT
&® Soft Scope i @ +2.3 Monthl =4 ki 2 DINT
%3 Binding Configuration g @2 +4.5 Dayl =13 Hourl 17 DIMT
g Global defines @ +6.7 Howl =17 Dayl 13 DINT b
fa} Wariables 25 @ +8.9 Minl=2 < >
B Types @ +10.11: Secl =18 Mame | Walue |
- [AllFrojscts] | Slave number | ServerID
1
4 ¥ kdzin | 1O Driwers

22.3.3 To read/write the PAC data remotely from the PC/SCADA

For the different kinds of HMI/SCADA software intend to communicate with a remote PAC via Modbus
TCP protocol through the WG-Communication-Server, the user must run the WG-Communication-Client
on an HMI/SCADA PC first. Then use it to log in to the Server, and then enter the PAC’s IP address (fixed
127.0.0.1) and PAC-PORT-ID (20000 ~ 22000) that you want to connect to on the SCADA software.

In this section, we will introduce you how to use the Modbus Poll to act as an HMI/ SCADA/Modbus
Master on the PC to read the PAC data remotely. You can visit the website to download and install the
Modbus Poll: http://www.modbustools.com/modbus poll.html
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1. First, run the “D:\WG-Communication-Client\WG-Communication-Client.exe", and then log in to the
Server. (If you are not familiar with the setting, refer to Section 22.3.1)

2. Double click the “Modbus Poll” icon to open it, and then click “Connection = Connect” to set the
connection parameters. Select the “TCP/IP” way to connect, set the "Response Timeout” ranges
from 15 to 30 seconds, set the "IP Address" as “127.0.0.1” (fixed), and set the "Port" as the PAC’s ID
(PAC-PORT-ID, e.g., 20009, refer to Section 22.2).

7t Modbus Poll - Mbpolll

o I
Connection

Anto Comnect Mode
-l p -
40001 = o
40002 = o Response Timeout Cancel
40003 = o 15000 [ms
40004 = o :
40005 = o = If a PAC/PC use the 3G wireless,
40008 = o = - recommend you to set its
40007 = o . N
a0005 = o I—_| — Timeout to 15 ~ 30 seconds.
40009 = o
40010 = 0 Femote Server
IP Address Port
|12'?.EI.EI.1 |2EIEIEIEI
Cornmnect

3. Click “Setup = Poll Definition” to set the data type you want to read. Then, select “04 INPUT
REGISTER” in the "Function" field (refer to Section 22.3.2 — Step2) and click “OK” to view the read
data shown on the Modbus Poll.

7't Modbuz Foll - Mhpolll

File Conmnection @EWMN Fonction:  Display  View  Window Help

Poll Definition
T
o=l 4 [NFIT EEGISTER

Cancel
Address: 1
Lengti |10 _ dmy |
Hean Rate:  |1000 s
[v Aufo Eead Enable

B! Mbpolll |:| |E| [5__<|

Tx = 146: Err = 0: ID = 1: F = 04: FE = 1000mz

30001 = 0 30008 = 13
3000z = 2015 30007 = 0
30003 = 0 30005 = 17
30004 = 4 J00os = 0
30005 = 0 30010 = =
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Chapter 23 HART Master

The following Win-GRAF driver versions support the [-87H17W HART Master module.

WP-8xx8 : 1.07 ; XP-8xx8-CE6:1.05 ;

Win-GRAF PAC

fossll
WinPAC . 1-87H17W
v
Fi CA-3710A £t
NO | i

This chapter will describe three demo projects for communicating between the Win-GRAF PAC and the
HART device via the I-87H17W HART module.

23.1 Introduction of the I-87H17W HART Module

[-87H17W : http://www.icpdas.com/en/product/I-87H17W-G

The XP-8xx8-CE6 PAC supports I-87H17W in its slot 1 to 7 (the first I/0 slot No. is 1). And, the WP-8xx8
PAC supports I-87H17W in its slot 0 to 7. The Win-GRAF PAC doesn't support the I-87H17W which is
plugged into the RS-485 remote expansion unit (like the 1-87K8, RU-87P8), so only use it in the
Win-GRAF PAC’s I/0 Slot.

Each I-87H17W has 8 analog input channels that used to measure 4 ~ 20 mA current and/or used as
HART communication channels. Recommend to link only one HART device in each channel. Owing to
these eight HART channels share with one communication chip inside this module, only single channel
can be used at a time. In other words, 1-87H17W unable to send/receive the HART frame via two or
more channels at the same time. But, the user can use the Win-GRAF program (e.g.,
“Demo_HART_3.zip”) to process these 8 HART channels to communicate with HART devices by turns.

Hardware Wiring:

For more details on [-87H17W hardware, refer to the user manual.
http://www.icpdas.com/en/download/show.php?num=1697&model=I-87H17W-G
The following only lists its internal I/O structure, pin assignment and wire connection.
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The internal I/O structure of I-87H17W:

™
RX
GND

+5V

GND

LED HART  [——1ESD Protect [
Module Modem | |  Block || MUX
s
Embedded [
Controller :
;Z ESD Protect
EEPROM ADC i MUX
+\/
< 3
i
‘3
Y RY

EX PwrR_| Soft- Stant

& Current
Lirmilor

H- BK1

s L EXT GND
Signal 1T vinGe

Separator (== INT_PWR
T VIND+

Signal [T E,.‘TJ.I—_GND

|l Separator (- INT PWR
T VINT+

Signal |[T Sz

| Separator |- INT PWR
T VINZ+

Signal [T gD

separator |1 INT_PWR
T VING+

Sianal | SXT-GND

Separator |- INT PWR
T ViNd+

. L EXT_GND
Signal [T GiNg.

Separator [+ INT_PWR
T VING+

St ] EXT.OND

Separator |- INT_PWR
T VING+

S | EXTGND

Separator |+ INT_PWR
T VINT+

L EXT_PWR

- EXT_GND

- BK2
L_INT_PWR

The pin assignment of I-87H17W:

8

CH HART Input

19

EXT_PWR 18
VIN7- 17
VINT+ 16
VING- 15
VING+ 14
VINS- 13
VINS+ 12
VINS- 11
VING+ 10
VINS- 09
VING+ 08
VIN2- 07
VIN2+ 06
VIN1- 05
VINT+ 04
VINO- 03
VINO+ 02

BK1 01

) O

©| 37
O} .36
O 35
O 34
O 33
O} 32
O 31
O 30
| 29
| 28
i 27
< 26
Of 28
O 24
O 23
it 22
O) 21
O) 20

OO0 C
00 L

")
9

-~
(@I O2

000

0.0

{

OO0 00
- ~r ~7 ~

YO
A -

\o

BK2
EXT_GND
INT_PWR7
EXT_GND
INT_PWRE
EXT_GND
INT_PWRS
EXT_GND
INT_PWR4
EXT_GND
INT_PWR3
EXT_GND
INT_PWR2
EXT_GND
INT_PWR1
EXT_GND
INT_PWRO
EXT_GND

37-pin maie D-Sub Connector
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The wire connection of [-87H17W:

Wiring for Current input

0e
|

1
e

(J«; 0e

IS =

/=]

EXT_PWR
EXT_GND

VINX-
INT_PWR
VINX+

23.2 The Format of the HART Protocol

Wiring for HART input

[ 108 | [EXT_PWR
MVE =]
2-wire : {0&) | [EXT_GND
]
02| [[ViINx-
HAREYS lo&| [INT_PWR
HART- 0S| |VINx+
|o EXT_PWR
4-wire |o EXT_GND
HART-,_ ™
[0 | [INT_PWR
HART-~ 10| [VINx+

Before describing the Win-GRAF projects, we need to understand the format of the HART protocol. The

HART protocol is based on a Master-Slave communication scheme, using a "request-respond" way to

communicate to each other for data exchanging.

Notice:

A. Refer to the user manual of each HART device for knowing their supported HART format.

B. The user can ignore the “Check Byte” in the Win-GRAF program because the I-87H17W module will

automatically add/remove it when sending/receiving a HART frame.

C. The HART physical layer is using 1200bps, 1 start-bit, Odd parity, 8 character-size and 1 stop-bit.

The I-87H17W send a HART command to a device:

The “Byte Count” indicates the number of data bytes in the range 0 to 255.

Preamble | Delimiter Address Command | Byte Count Data Check byte
5-20 1 bytes (short)
1 byt 1 byt 1 byt 0 - 255 byt 1 byt
bytes yie 5 bytes (long) yie yie ytes yte

The device responds data to the I-87H17W:

The “Byte Count” indicates the number of response code and data bytes in the range 0 to 255.

Preamble | Delimiter Address Command | Byte Count | Response code | Data | Check byte
5-20 1 bytes (short) 0-253
1 byt 1 byt 1 byt 2 byt 1 byt
bytes byte 5 bytes (long) byte byte bytes bytes byte

Preamble: 5 - 20 bytes

The value of each byte is “255” (i.e., 16#FF).
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Delimiter: 1 byte

01: Short frame, Burst Frame.
02: Short frame, Master to Slave.
06: Short frame, Slave to Master.

129 (16#81): Long frame, Burst Frame.
130 (16#82): Long frame, Master to Slave.
134 (16#86): Long frame, Slave to Master.

Address: 1 byte (Short frame) or 5 bytes (Long frame)

Short frame (1 byte):

1= Primary Master , 0 = Secaondary Master

1 = Slave in Burst Mode

— Address: 4-bit | value is 0~ 15

hit 7 olo bit 0

Long frame (5 bytes):

1= Primary Master , 0 = Secondary Master

1 = Slave in Burst Mode

Manufacturer (D

hit 7 hit O
\ / li Device D
Device
Byte 0 type Byte 4
Command: 1 byte (refer to the manual of the HART device for its definition).
Byte Count: 1 byte.

Send (I-87H17W): “Byte Count” is the byte amount of the “Data”. The value is 0 to 255.
Response (device): “Byte Count” is the byte amount of “Data” + “Response code”. The value is 0 to 255.

Response code: 2 byte (refer to the manual of the HART device for its definition).

Data: Refer to the manual of the HART device for its definition.

Check Byte: 1 byte. The user can ignore the “Check Byte” in the Win-GRAF program because the
[-87H17W module will automatically add (or remove) it when sending (or receiving)
the HART frame.
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23.3 Introduction of the Win-GRAF Demo Project

This section lists three Win-GRAF projects to show you the way to do HART communication between the
Win-GRAF PAC and HART devices. The user can run the Win-GRAF Workbench and then click "File >
Add Existing Project = From Zip..." to open the Win-GRAF project, which is stored in a shipping CD
(CD-ROM: \Napdos\Win-GRAF\demo-project)).

File Name Description

Sending the HART frame manually from Ch-0 of the I-87H17W in the slot 2, and

Demo_HART_1.zip then receive the HART frame from the device.

Sending and receiving the HART frame every 5 seconds automatically and

Demo_HART_2.zip |\ eatedly from Ch-0, Ch-1 and Ch-2 of the I-87H17W in the slot 2.

(It’s similar as Demo_HART_2) Using two |I-87H17W in the slot 2 and slot 3 to
Demo_HART_3.zip | send and receive the HART frame every 5 seconds automatically and repeatedly
from Ch-0 to Ch-7 at the same time.

Note: Because all 8 channels of the I-87H17W are shared with one HART chip. Each I-87H17W can
conduct only one channel for sending/receiving HART frame at a time, and then conduct the next
channel.

23.3.1 1/0 Board Setting and the HART Functions
1/0 Board Setting

Both the “Demo_HART_1” and the “Demo_HART_2” projects require to use one |I-87H17W on the PAC’s
Slot 2. Therefore, we need to enable this I/O function in the Win-GRAF “1/0 Boards” window. Simply
click the "Open I/0s" button and then add “i_87H17W” in the slot no. 2, click “Properties” can view
more details about it (or refer to Chapter 4 — Linking 1/0O boards).

4 Win-GRAF - Demo HAERET 1 (Operate 1-87H17W to communicate with HART device)
File Edit WView Insmpit Project Tool: Window Help

San B= G b =W,
Workspace Ho selection!

) Demo_HART_1 [*Operate i-87H17w..
[ Exception programs

%y € O B oy (5 A

Click "Open 1/0s".

1 Programsz
1] b ain
: RSy
= Ref=16#37F17
5 ChO_7_twpe=16#07
G Chl_scale=16#0
7 Chl_scale=16#0
5 Ch_scale=16#0
= Ch3_smale=16#0
3 Chd_scale=16#0
10 ChS_scale=16#0
1 ChfA_scale=16#0
EF Ch7_scale=16#0
—=  [|Resrved=]
13 Feserved={]
14 Feserved={]
15 Reserved={]
16
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“I-87H17W” is an eight channels HART current input module (data type: REAL; input range: 4 - 20mA).

Parameters:
ChO0_scale ~ Ch7_scale : 16#SS

SS: Scaling function is defined by the "i_scale" I/O board (refer to Section 4.2).
00 means "No scaling".
01to 29 means "Appling a scaling function No. (01 to 29)"
Setting SS as other value will use the default value 00.

For example, 16#17 means the physical input signal is converted with the scaling function 17.
Note: If the Current value is greater than "9000.0", which means the HART device may be disconnected.

In the “Demo_HART_3"” project, it need to enable two “i_87H17W” in the slot no. 2 and no.3.

EEEE 105 X

” :
1
A LEHIAY e
% Rei=16#87F17 Delete
5 Chi_7_type=16407
B |Ch)sale=l6#0
2 |Chl_sale=16#D [_Rename |
A |Ch2 scale=1640 _
8B |Ch3 scale=16#0 Froperties
g Chd_scale=16#0
90 |ChS_male=l16#0 :
41 |Chesale=it#0 [ Vil |
12— Ch?_s:a]ﬂ=1 fa#( rT'I
T I— Egigggj% 2: i 87H17W - Properties x|
14 Remrved=] [Key=0 :
G5 |Resrved=D | Ref = {6#ETFY
- ChD_7_type = 16407
16 | Ch0_scale = 1640

Chl_scale = 16#0
Ch2_scale = 16#0
Ch3_scale = 16#0
Chd_scale = 16#0
Ch5_scale = 16#0
Chb_scale = 16#0
Ch7_scale = 16#0
Reserved =0
Reserved =0
Reserved =0
Reserved =0

Parameters : ”
Chi_zcale - Ch¥_scale : 16455

55 Scaling function iz defined by the wirtual board "'i_scalg' -----
00 means "Mo zcaling'
M to 29 means “Appling a scaling function Mo, [07 to 29"
zeting 55 az other value will uze the default value 00 .

For example,

16817 means phpzical input gignal iz converted with a scaling function 17
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The HART Functions
The user can use the "HART_Read", "HART_Send" and "HART_Status" functions in the ST or LD program.

In addition, you can press "F1" or open "Library Manager" (refer to Section 1.2.3) to view the
descriptions of these functions.

Librarx Manager - ICEF DAS - XF-WE-YF

File Wizard Help

Function and FBs | 1/0s | Profiles | AS- Types

Fead Hart Fes pluj_:-:l

LFJ]E[a.l't Send l[* Fend Hart Fegquest #)
AHart_State (* Check Hart bz state *J

[ F Uy W, . UV (U UPTRR th P temmmme e de dl. o La ST ATITTLIT wn

Parameters DESC"DUDH

LFJ

Hart Fead : to Get the response from HART bus ~
Moticed:

Thiz C-function must work with the HART module, I-S7HLYW, in the backplane.

%% Input parameters

Hart_Read: To get the response from HART Bus.
Note: This function must work with the HART module (i.e., -87H17W), which is plugged
in the Win-GRAF PAC.
Input Parameters:
gSlot: (Data type: DINT)
The specified 1/0 slot which the I-87H17W is plugged in. It used to read the response
frame from the HART bus. (The value range is0 ~ 7)

@gPreamble: (Data type: USINT) (Refer to Section 23.2 — The format of HART frame.)
To get the Preamble number of HART response.

@gDelimiter: (Data type: USINT) To get the Delimiter of the HART response.
gAddress|[]: (Data type: USINT) To get the Address of the HART response.
@gCommand: (Data type: USINT) To get the Command of the HART response.
gDatal]: (Data type: USINT) To get the Data of the HART response.
@gDatalen:  (Data type: USINT) To get the data length of the HART response.

Output Parameters:
Q: (Data type: DINT)

0 : Nothing happened.

1 : Read success.

-1: Cannot find the HART module, I-87H17W, in the specified slot.
-2 : Invalid HART response.

-3 : Waiting HART response.

-4 : No HART request.

-5 : HART module I-87H17 is off line.
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hart_Send: To send the request to HART bus.
Note: This function must work with the HART module (i.e., I-87H17W), which is plugged

in the Win-GRAF PAC.

Input Parameters:

gSlot:

gChannel:

gPreamble:

gDelimiter:

gAddress|[]:

gCommand:

gData[]:

gDatalen:

(Data type: DINT)
The specified 1/0 slot which the I-87H17W is plugged in. It used to send the HART
request. (The value range is0-7.)

(Data type: DINT)
The specified channel of I-87H17W to send HART request to HART device.
(The value range is0-7.)

(Data type: USINT) (Refer to Section 23.2 — The format of HART frame.)
The Preamble amount of HART request (The value range is 5 - 20.)

(Data type: USINT)

The Delimiter of the HART request.

(Data type: USINT)

The Address of the HART request.

(Data type: USINT)

The Command of the HART request.

(Data type: USINT)

The Data of the HART request.

(Data type: USINT)

The Data length (byte) of the HART request.

Output Parameters:

Q:

(Data type: DINT)

0 : Nothing happened.

1: Read success.

-1: Cannot find the HART module, i-87H17W, in the specified slot.

-2 : The specified channel of I-87H17W is wrong.

-3 : The specified Preamble amount is wrong.

-4 : The sending error of the HART request, please check Delimiter and Address is
correct.

-5 : HART bus is busy.

-6 : HART module |I-87H17 is off line.
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Hart_State: To Get HART bus state.
Note: This function must work with the HART module (i.e., -87H17W), which is plugged
in the Win-GRAF PAC.
Input Parameters:
gSlot: (Data type: DINT)

The specified 1/0 slot which the I-87H17W is plugged in. It used to get the status of the
HART bus.

Output Parameters:
Q: (Data type: DINT)

0: No any query.
1: HART request is waiting to send to HART device.

2 : HART request is sent to HART device.

3 : Waiting the HART response.

4 : HART response is received.

-1: Timeout.

-2 : The length of the HART response frame is too short.

(Refer to Section 23.2 — The format of HART frame.)

-3 : The Delimiter of the HART response is wrong.

-4 : The Address (Master) of the HART response is wrong.

-5 : The Address (Burst) of the HART response is wrong.

-6 : The Command of the HART response is wrong.

-7 : The Checksum of the HART response is wrong.

-8 : HART response error.

-98 : There is some mismatch between the parameter of the HART response and
the HART request.
-99 : Impossible error.

-100 : The error happened during sending the HART request to the HART device.
-101 : Cannot find HART module I-87H17W in the specified slot.
-102 : HART module I-87H17 is off line.
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23.3.2 The Demo Project - “Demo_HART_1"

(You can check the feature description in the ST program below.)

[ Win-GRAF - Demo HART 1 {Operate i-87H17W to communicate with HART device)

File Edit ¥iew Insert Pmoject Tools Window Help

B H= g Q4 333X — P &Y e AR e %A
i X
2 Demo_ HART_1 [*Ope...| (o "I # 5F MWame | Type | Dim.
[ Exception programs ‘a _] Main ~
Plnoam X fat Global variables
THEH (¥ Check HART lhus state ¥)
Hart BU3 state := hart state(slot); Preamble  USINT
[ watch [for debugging) = - - ’ - ’ Delimiter  LUSIMT
& ot Scope 2 % Error occurred *) Address USINT [0..4]
= Initial values if Hart Bus state < O then Command  USINT w

“Bd MewSpy Cil < >
%& Binding Configuration Hart error counter := Hart error counter + o3 1Al 2
» g _Glohal defines Hart_error code := Hart_Bus_state;

. : : W7 3 [Project] b
fa} Wariables =€ ¥ |[4 %] Blocks sovlist | Define | ENU
<

B Types “ariables HewSpw | Main

Description of Variables:

Variables Name Data Type Dim. Description
slot DINT -
channel DINT -
Preamble USINT i Used to send the HART request.
Delimiter USINT - * The initial vaI.ue of “slot” is set to “2”.
ddress USINT 0.4] * Refer to M - The format of HAI.RT frame

and Section 23.3.1 - "HART_Send" function.
Command USINT -
Data USINT [0..254]
Datalen USINT -
ret DINT - Send/receive the status value of the HART frame.
Preamble_r USINT -
Delimiter_r USINT -
Address. r USINT [0.4] >lkJsed to receivg the HART response.

Refer to Section 23.2 - The format of HART frame
Command_r USINT _ and Section 23.3.1 - "HART_Send" function.
Data_r USINT [0..254]
Datalen_r USINT -
Hart_BUS_state DINT - To get the status of the HART bus.
Hart_error_counter DINT - To calculate error times of the HART bus.
Hart_error_code DINT - The error code of the HART bus.
hart_bus_err_Msg STRING(255) - The error message of the HART bus.
hart_send_err_msg | STRING(255) - The error message when sending the HART frame.
hart_read_err_msg STRING(255) - The error message when reading the HART frame.
send_HART_ request BOOL - Set it as “TRUE” to send the HART frame.
read_HART _request BOOL - Set it as “TRUE” to read the HART frame.
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ST Program (Main)

(* This demo project is to show how to use one I-87H17W(HART Master) to communicate
manually with one HART device.

Hardware Environment:

1. Plug i-87H17W in the slot 2 of Win-GRAF PAC.
2. Connect HART device to the channel 0 of i-87H17W *)

(* Check HART bus state *)
Hart_BUS_state := hart_state(slot);

(* Error message and error times of the HART Bus *)
if Hart_Bus_state < 0 then

Hart_error_counter := Hart_error_counter + 1;
Hart_error_code := Hart_Bus_state;

case Hart_error_code of
-1: hart_bus_err_Msg := 'Error: Timeout';

'Error: Read_data_too_short error';

-2 :hart_bus_err_ Msg:

-3 : hart_bus_err_Msg :='Error: Response Delimiter error';

-4 : hart_bus_err_Msg :='Error: Response addr_master error';

-5 : hart_bus_err_Msg :='Error: Response addr_burst error';

-6 : hart_bus_err_Msg :='Error: Response recv_command error';

-7 : hart_bus_err_Msg :='Error: Response checksum error';
-8 : hart_bus_err_Msg :='Error: response error';
-98 : hart_bus_err_Msg :='Error: para_mismatch error';
-99 : hart_bus_err_Msg :='Error: impossible error';
-100: hart_bus_err_Msg := 'Error: Sending HART request error';
-101: hart_bus_err_Msg :='Error: cannot find the HART moudule, i-87H17W" ;
-102: hart_bus_err_Msg := 'Error: i-87H17W is off-line’;
end_case;

end_if;

if Hart_BUS_state = 0 and Send_HART _request then
(* HART bus is free to send *)

(* Build HART command *)
slot :=2;

channel :=0;

Preamble := 5;

Delimiter := 16#82;
Address[0] := 16#96;
Address[1] := 16#85;
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Address[2] := 16#0B;
Address[3] := 16#0A;
Address[4] := 16#42;
Command := 16#03;
Datalen :=0;

ret := hart_send(slot, channel, Preamble, Delimiter, Address, Command, Data, Datalen);

case ret of
1: Send_HART request :=false;
hart_send_err_msg := 'Send success';
-1: hart_send_err_msg := 'Send Error: cannot find the HART moudule, i-87H17W';
-2: hart_send_err_msg := 'Send Error: specified the wrong channel to send hart cmd’;
-3: hart_send_err_msg := 'Send Error: specified the wrong preamble number’;
-4: hart_send_err_msg :='Send Error: wrong HART cmd, please check delimiter and
address is correct';
-5: hart_send_err_msg :='Send Error: HART bus is busy';
-6: hart_send_err_msg :='Send Error: i-87H17W is off-line';
end_case;

end_if;

(* HART response is coming *)
if Hart_BUS_state =4 then

ret := hart_read(slot, Preamle_r, Delimiter_r, Address_r, Command_r, Data_r, Datalen_r);

case ret of
1: hart_read_err_msg := 'Read success’;
read_HART _request := true;
-1: hart_read_err_msg := 'Read Error: cannot find the HART moudule, i-87H17W";
-2: hart_read_err_msg := 'Read Error: invalid HART response’;
-3: hart_read_err_msg := 'Read Error: waiting response’;
-4: hart_read_err_msg := 'Read Error: No Request’;
-5: hart_read_err_msg := 'Read Error: i-87H17W is off-line’;
end_case;

end_if;

(* HART response processing *)

if read_HART _request then
read_HART request := false;

(* ToDo: put your code here to handle the HART response *)

end_if;
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23.3.3 The Demo Project - “Demo_HART_2"

(You can check the feature description in the ST program below.)

Win-GEAF - Demo HART Z (Operate i-B7H17W to communicate with HART device)

File Edit ¥View Insert Project Toole Window Help

E Wy & Q85X = MO & Y e AR e A
Wi X
2/ Demo_HART_2 (*Oper...| o # | °F Mame | Type
[3 Exeeption programs . (" Check HART hbus state ¥ _1 Main ~
[ Eroers i Hart BUS state := hart state(slot): ﬁ Glohal variahles
THEH g
.o - . . i [* Error occurred *) ﬁi‘?iir?ﬂlf H:v
#e=0ll = if Hart Bus state < 0 then < 3>
[ ‘#atch [for debugging) ') - -
= Initial values = [* count the error number ¥) 03 (Al e
B MewSpy b1l cagse cmd_index of [ [Project)
%id Binding Configuration O: [ Advanced
7g Global defikes emdl_error_counter := ewdl error_counte,, [ Aithmetic 2
=g 3| |[€3)] blocks  Sovist | Define | ENUN
= Types 4 Meva Spp “Wariables Main Trigger Signal Gen

Description of Variables:

Variables Name Data Type Dim. | Description

slot DINT -

channel DINT _ Used to send the HART request.

Preamble USINT i * The initial value of “slot” is set to “2”.

Delimiter USINT - * Refer to Section 23.2 - The format of HART
Address USINT [0..4] frame and Section 23.3.1 - "HART_Send"
Command USINT - function.

Data USINT [0..254]

Datalen USINT -

ret DINT - Send/receive the status value of the HART frame.
Preamble_r USINT -

Delimiter_r USINT 3 Used to receive the HART response.

Address_r USINT [0..4] | * Refer to Section 23.2 - The format of HART
Command_r USINT ; frame and Section 23.3.1 - "HART_Send"
Data_r USINT [0.254] | function.

Datalen_r USINT -

Hart_BUS_state DINT - To get the status of the HART bus.
hart_bus_err_Msg STRING(255) - The error message of the HART bus.
hart_send_err_msg STRING(255) - The error message when sending the HART frame.
hart_read_err_msg STRING(255) - The error message when reading the HART frame.
send_HART_request BOOL - Set it as “TRUE” to send the HART frame.
read_HART_request BOOL - Set it as “TRUE” to read the HART frame.
cmd_index DINT - The index value to process the command.
cmd_max_num DINT - The number of sending commands. (Init. = 3)
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Variables Name Data Type Dim. | Description
cmdl_response_counter DINT -
The number of response times.
2 DINT -
cmd2_response_counter (From Ch-0 / Ch-1/ Ch-2)
cmd3_response_counter DINT -
cmdl_error_counter DINT -
cmd2 error counter DINT i The number of error times on the HART bus.
= = (From Ch-0/ Ch-1/ Ch-2)
cmd3_error_counter DINT -
cmdl_error_code DINT -
The error code of the HART bus.
2 DINT -
cmd2_error_code (From Ch-0 / Ch-1/ Ch-2)
cmd3_error_code DINT -
trigger_Timer TIME - Start ticking.
. . The interval time for sending commands.
trigger_interval TIME - (Init = T#5s)
INIT BOOL - Initialize (Init. = TRUE).
next_index DINT - The index for the response data.
cmdl_Data REAL [0..3]
Used to save the response data.
cmd2_Data REAL [0..3] (From Ch-0 / Ch-1/ Ch-2)
cmd3_Data REAL [0..3]

ST Program (Main)

(* This demo project is to show how to use one I-87H17W(HART Master) to communicate
automatically with HART devices that is connected with different channels of I-87H17W.

Hardware Environment:

1. Plug I-87H17W in the slot 2 of Win-GRAF PAC.
2. Connect three HART devices to the channel 0 ~ 2 of i-87H17W in the slot 2 of Win-GRAF PAC
separeately.

*)

(* Check HART bus state *)
Hart_BUS_state := hart_state(slot);

(* Error occurred *)
if Hart_Bus_state < 0 then

(* Count the error number *)

case cmd_index of

0:
cmdl_error_counter :=cmdl_error_counter + 1;
cmdl_error_code := Hart_Bus_state;

1
cmd2_error_counter := cmd2_error_counter + 1;
cmd2_error_code := Hart_Bus_state;
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2:
cmd3_error_counter := cmd3_error_counter + 1;
cmd3_error_code := Hart_Bus_state;

end_case;

(* Try to send the next HART request *)
cmd_index := cmd_index + 1;

if cmd_index = cmd_max_num then
cmd_index :=0;
end_if;

case Hart_Bus_state of
-1:hart_bus_err_Msg :='Error: Timeout';
-2 : hart_bus_err_Msg :='Error: Read_data_too_short error';
-3 : hart_bus_err_Msg :='Error: Response Delimiter error';
-4 : hart_bus_err_Msg :='Error: Response addr_master error';
-5: hart_bus_err_Msg :='Error: Response addr_burst error';
-6 : hart_bus_err_Msg :='Error: Response recv_command error';
-7 : hart_bus_err_Msg :='Error: Response checksum error';
-8 : hart_bus_err_Msg :='Error: response error';
-98 : hart_bus_err_Msg :='Error: para_mismatch error';
-99 : hart_bus_err_Msg :='Error: impossible error';
-100: hart_bus_err_Msg :='Error: Sending HART request error';
-101: hart_bus_err_Msg :='Error: cannot find the HART moudule, i-87H17W' ;
-102: hart_bus_err_Msg := "Error: i-87H17W is off-line’;
end_case;

end_if;

if Hart_BUS_state = 0 and Send_HART _request then
(* HART bus is free to send *)

(* Build HART command *)

case cmd_index of

0:
slot := 2;
channel :=0;
Preamble :=5;
Delimiter := 16#82;
Address[0] := 16#96;
Address[1] := 16#85;
Address[2] := 16#0B;
Address[3] := 16#0A;
Address[4] := 16#42;
Command := 16#03;
Datalen := 16#00;

Win-GRAF User Manual, V2.0, Aug. 2020 by ICP DAS 23-15



slot := 2;

channel :=1;
Preamble := 5;
Delimiter := 16#82;
Address[0] := 16#96;
Address[1] := 16#85;
Address[2] := 16#0B;
Address[3] := 16#0A;
Address[4] := 16#42;
Command := 16#03;
Datalen := 16#00;

slot := 2;
channel := 2;
Preamble := 5;
Delimiter := 16#82;
Address[0] := 16#96;
Address[1] := 16#85;
Address|[2] := 16#0B;
Address[3] := 16#0A;
Address[4] := 16#42;
Command := 16#03;
Datalen := 16#00;
end_case;

ret := hart_send(slot, channel, Preamble, Delimiter, Address, Command, Data, Datalen);

case ret of
1: Send_HART _request := false;
hart_send_err_msg := 'Send success';
-1: hart_send_err_msg := 'Send Error: cannot find the HART moudule, i-87H17W";
-2: hart_send_err_msg :='Send Error: specified the wrong channel to send hart cmd’;
-3: hart_send_err_msg := 'Send Error: specified the wrong preamble number’;
-4: hart_send_err_msg := 'Send Error: wrong HART cmd, please check delimiter and address is
correct';
-5: hart_send_err_msg :
-6: hart_send_err_msg :
end_case;

'Send Error: HART bus is busy';
'Send Error: i-87H17W is off-line';

end_if;

(* HART response is coming *)
if Hart_BUS_state = 4 then

ret := hart_read(slot, Preamle_r, Delimiter_r, Address_r, Command_r, Data_r, Datalen_r);
case ret of

1: hart_read_err_msg:
read_HART _request :

'Read success';
true;
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'Read Error: cannot find the HART moudule, i-87H17W";
'Read Error: invalid HART response’;

'Read Error: waiting response’;

'Read Error: No Request';

'Read Error: i-87H17W is off-line’;

-1: hart_read_err_msg:
-2: hart_read_err_msg :
-3: hart_read_err_msg:
-4: hart_read_err_msg :
-5: hart_read_err_msg:
end_case;

end_if;

(* HART response processing *)

if read_HART_request then
read_HART_request := false;

(*--- Please use your own <Data> definition for your own application ---
The data of the HART response assume as 00 00 41 AO FF 3E OC 3E C5 37 48 20 41 C8 3F 22 39
42 C9 8E D1
The HART answer is from a device, which <Data> in big endian has the following meaning.
41 AO FF 3E = 41A0FF3E < convert these 4 bytes (IEEE-754) to one REAL>: 20.1246 mA
3E C5 37 48 = 3EC53748 < convert these 4 bytes (IEEE-754) to one REAL> : 0.385187
41 C8 3F 22 = 41C83F22 < convert these 4 bytes (IEEE-754) to one REAL> : 25.0308
42 C9 8E D1 =42C98ED1 < convert these 4 bytes (IEEE-754) to one REAL>: 100.779 *)

case cmd_index of
0:
cmd1l_response_counter := cmd1_response_counter + 1;

next_index := SerializeIn(Data_r, cmd1_Data[0], 2, true);
next_index := next_index + 1;

next_index := Serializeln(Data_r, cmd1_Data[1], next_index, true);
next_index := next_index + 1;

next_index := Serializeln(Data_r, cmd1_Data[2], next_index, true);
next_index := next_index + 1;

next_index := Serializeln(Data_r, cmd1_Data[3], next_index, true);

cmd2_response_counter := cmd2_response_counter + 1;

next_index := Serializeln(Data_r, cmd2_Datal[0], 2, true);
next_index := next_index + 1;

next_index := Serializeln(Data_r, cmd2_Data[1], next_index, true);
next_index := next_index + 1;

next_index := Serializeln(Data_r, cmd2_Data[2], next_index, true);
next_index := next_index + 1;

next_index := Serializeln(Data_r, cmd2_Data[3], next_index, true);

cmd3_response_counter := cmd3_response_counter + 1;

next_index := Serializeln(Data_r, cmd3_Data[0], 2, true);
next_index := next_index + 1;
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next_index := Serializeln(Data_r, cmd3_Data[1], next_index, true);

next_index := next_index + 1;

next_index := Serializeln(Data_r, cmd3_Data[2], next_index, true);

next_index := next_index + 1;

next_index := Serializeln(Data_r, cmd3_Data[3], next_index, true);
end_case;

(* Try to send the next HART request *)
cmd_index := cmd_index + 1;
Send_HART _request := true;

if cmd_index = cmd_max_num then
cmd_index :=0;
end_if;

end_if;

ST Program (TriggerSignal)
(*

To start the timer for generating the trigger signal to send HART request

¥)

if INIT then
INIT := false;
TStart(trigger_timer);
send_HART_request :=true;
end_if;

if trigger_Timer > trigger_interval then

trigger_Timer := THOs;
send_HART request :=true;

end_if;
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23.3.4 The Demo Project - “Demo_HART_3"

(You can check the feature description in the ST program below.)

Win-GEAF - Demo_HART 3 (Operate 1-87H17W to commmunicate with HART device)

File Edit ¥iew Insert Pmoject Tool: Window Help

SN = N NS W eI WNEEE O N o &N Ee ARy A
Workspace Main
5--£3 Programs Al =) # T Mame | Type | Dim.
| 72 Buigcmd (Tobuia| 5 3 S
1 %2 ChangeCmd (To s | £ {a} Global variables
1 %2 Enor handle THEH [* check all HART kbus ¥) 0 Preamble USIMT D
Du . T for slot index := 0 to slot num - 1 do L.
4 178 GetSlot [To get curf = - - Delimiter  USINT
3 U:j bl it e {* Get current =lot nuwher *) Address USINT - [0. 4]
1 5 FeadResponse (o slot := getslot(slot_index): Command  USINT
-} sl TriggerSignal_gen [ b1 Data USINT [0..254]
[}~ ‘Watch [far debuaging] {* Check HART kus state ¥) Datalen LSIMT
m Soft Scope Hart_ BUS_state := hart_state(slot); ret OINT “w
o ] Initial values 5= L | ¥
% MewSpy F (¥ Error occurred ™) = —
%73, Binding Configurati if Hart Bus state < 0 then [ [an -~
-~ inding D.I"I iguration b 3 [Project] v
o pulalebal defines (_ | l 4 ¥ | Blocks Sowlist Define | EMUR
CaY vaniables 4 » | MewSpy | Main ariables

Description of Variables:

This demo project is similar as the “Demo_HART_2" project. The user can view its variable descriptions
or open the “Demo_HART_3” project to view all used variables in the Win-GRAF “Variables” window.

ST Program (Main)
There are several subroutine used in this project, the user can open them to view the program code.

The following description is focused on the "Main" program.
(*
This demo project is to show how to use two I-87H17W (HART Master) to communicate
automatically with HART devices that is connected with different channels of I-87H17W.

Hardware Environment:

1. Plug one I-87H17W in the slot 2 of Win-GRAF PAC

2. Plug the other one in the slot 3 of Win-GRAF PAC.

3. Connect 8 HART devices to the channel 0 ~ 7 of I-87H17W in the slot 2 of Win-GRAF PAC
separeately.

4. Connect 8 HART devices to the channel 0 ~ 7 of I-87H17W in the slot 3 of Win-GRAF PAC
separeately. *)

(* Check all HART bus *)
for slot_index := 0 to slot_num -1 do

(* Get current slot number *)
slot := getslot(slot_index);

(* Check HART bus state *)
Hart_BUS_state := hart_state(slot);

(* Error occurred *)
if Hart_Bus_state < 0 then
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(* Count the error number *)
Error_handle(any_to_byte(slot_index));

(* Try to send the next HART request *)
ChangeCmd(any_to_byte(slot_index));

case Hart_Bus_state of
-1 : hart_bus_err_Msg :='Error: Timeout';
-2 : hart_bus_err_Msg :='Error: Read_data_too_short error';
-3 : hart_bus_err_Msg :='Error: Response Delimiter error';
-4 : hart_bus_err_Msg :='Error: Response addr_master error';
-5 : hart_bus_err_Msg :='Error: Response addr_burst error';
-6 : hart_bus_err_Msg :='Error: Response recv_command error';
-7 : hart_bus_err_Msg :="Error: Response checksum error';
-8 : hart_bus_err_Msg :='Error: response error';
-98 : hart_bus_err_Msg :="Error: para_mismatch error';
-99 : hart_bus_err_Msg :="Error: impossible error';
-100: hart_bus_err_Msg :="Error: Sending HART request error';
-101: hart_bus_err_Msg :="Error: cannot find the HART moudule, i-87H17W';
-102: hart_bus_err_Msg :="Error: i-87H17W is off-line’;
end_case;

end_if;

if Hart_BUS_state = 0 and Send_HART _request[slot_index] then
(* HART bus is free to send *)

(* Build HART command *)
buildCmd(any_to_byte(slot_index));

ret := hart_send(slot, channel, Preamble, Delimiter, Address, Command, Data, Datalen);

case ret of

1: Send_HART request[slot_index] := false;
hart_send_err_msg := 'Send success';

-1: hart_send_err_msg := 'Send Error: cannot find the HART moudule, i-87H17W';

-2: hart_send_err_msg := 'Send Error: specified the wrong channel to send hart cmd’;

-3: hart_send_err_msg := 'Send Error: specified the wrong preamble number’;

-4: hart_send_err_msg := 'Send Error: wrong HART cmd, please check delimiter and address
is correct’;

-5: hart_send_err_msg := 'Send Error: HART bus is busy';

-6: hart_send_err_msg := 'Send Error: i-87H17W is off-line’;

end_case;

end_if;
(* HART response is coming *)

if Hart_BUS_state = 4 then
ret := hart_read(slot, Preamle_r, Delimiter_r, Address_r, Command_r, Data_r, Datalen_r);
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case ret of
1: hart_read_err_msg := 'Read success';
read_HART_request := true;
-1: hart_read_err_msg := 'Read Error: cannot find the HART moudule, i-87H17W/;
-2: hart_read_err_msg := 'Read Error: invalid HART response’;
-3: hart_read_err_msg := 'Read Error: waiting response’;
-4: hart_read_err_msg := 'Read Error: No Request';
-5: hart_read_err_msg := 'Read Error: i-87H17W is off-line’;
end_case;

end_if;

(* HART response processing *)
if read_HART _request then
read_HART _request := false;

ReadResponse(any_to_byte(slot_index));
ChangeCmd(any_to_byte(slot_index));
end_if;
end_for;

23.4 Test the Demo Program

Feature Descriptions:

File Name Description

Sending the HART frame manually from Ch-0 of the I-87H17W in the slot 2, and

Demo_HART_1.zip then receive the HART frame from the device.

Sending and receiving the HART frame every 5 seconds automatically and

D HART_2.zi .
emo_ —~21P repeatedly from Ch-0, Ch-1 and Ch-2 of the I-87H17W in the slot 2.

(It’s similar as Demo_HART_2) Using two I-87H17W in the slot 2 and slot 3 to
Demo_HART_3.zip | send and receive the HART frame every 5 seconds automatically and repeatedly
from Ch-0 to Ch-7 at the same time.

Note: Because all 8 channels of the I-87H17W are shared with one HART chip. Each I-87H17W can
conduct only one channel for sending/receiving HART frame at a time, and then conduct the next
channel.

23.4.1 Testing Environment and the “HC_Tool” Setting

Before testing, make sure the 1-87H17W module is plugged in the slot2 (or slot3) of the Win-GRAF PAC,
and the needed I/O channels (Ch-0 ~ Ch-7) are linked to HART devices (refer to Section 23.1). Then,
power on the Win-GRAF PAC and download the project to it.

The following will describe the test way for these Win-GRAF demo programs one by one. Here, we use
the “HC_Tool” utility to simulate a HART device to conduct the HART response. The user can download
“HC_Tool” and its user manual on the I-7567 webpage (as the list below).
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Refer to the following product page (Pin Assignment or Wire Connection) to know the way of wiring.

Slot2/3: I-87H17W (Al)

XP-8348 | DN-37 I-7567 PC (HC_Tool
1
1
: CA-3710 D Al 4 HURT+
: Al- 7 HURT-
!
1 2 3 37-pin I/O Connect Block  USB to HART
Testing Enviorment:
Device Model Quantity Note
Win-GRAF PAC XP-8348-CE6 1 -
HART Al Module 1-87H17W ) The' Demo_HART_l and “Demo_HART_2
- projects require only one [-87H17W.
USB to HART To download the USB driver and the “HC_Tool”
I-7567 1 -
Converter utility.

www.icpdas.com/en/product/guide+industrial__Communication+Fieldbus__Communication+HART

I/O Connector Block DN-37 1 Includes one CA-3710 cable.

http://www.icpdas.com/en/product/guide+Accessories+Daughter__Boards+DAQ__Daughter__Board

The HC_Tool Setting:

Run “HC_Tool.exe” and then click “Setting” to select the COM Port no. which your PC used (refer to
“Device Manager”). You can keep the settings like the figure below (or refer to 1-7567 manual) and click
“OK”, and then click “Open" to open this COM Port.

HC Tool v1.05 {ICEF DAS)

Com Port 2.
Status = Idle

/ Port Neme :
Ipfommnation &

- I-7570 :

Gﬁb 2B Root Hub O
- SEREIE (COMFOILPT)
CAICIDAS [-7567 USBZHART (COME) HART (For Cnd 0)

| huto Configure : Ensble |  HT Channel:
Frame tvpe : Master type © | Prinwary

Timeont (ms) :

W

Preambles ;

Manufactorer [D Dievice tpe

R

Device ID

bl

oty (et |
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https://www.icpdas.com/en/product/guide+Software+Development__Tools+Win-GRAF#434
http://www.icpdas.com/en/product/I-87H17W-G
http://www.icpdas.com/en/product/I-7567
http://www.icpdas.com/en/product/guide+Industrial__Communication+Fieldbus__Communication+HART
http://www.icpdas.com/root/product/solutions/pc_based_io_board/daughter_boards/dn-37.html
http://www.icpdas.com/en/product/guide+Accessories+Daughter__Boards+DAQ__Daughter__Board
http://www.icpdas.com/en/download/show.php?num=1706&model=I-7567

23.4.2 Test the “Demo_HART_1", “Demo_HART_2" and “Demo_HART_3" Projects

Feature Descriptions: (Program- Demo_HART_1 ; Wiring — Refer to Section 23.4.1)
Sending the HART frame manually from Ch-0 of the I-87H17W in the slot 2, and then receive the HART
frame from the device.

After downloading this project, open the spy list (NewSpy) and set the "send_HART_request" variable as
"TRUE" to send the HART request.

_ lg j‘l 4 Q o I L }'( A+ .+—I ﬂﬂ 'HT !hi ﬁ ﬁ == .S;g |1|_T| “
Workspace 0000 HewSpy.spl
B [ Demo_HART_1 [Stafp... Mame | % alue | Descrl 57 Mame
..... [ Exception programs g zend_HART_request FALSE ﬁ Slobal we
£ Programs read HART _request e T = Preamble
- 57] Main B+ Hart_BUS_state 0 | s (1] | Detimiter
- [ watch [for debugging) Hart_ermor_counter 1] - K = Address
T Soft Seope Hart_emaor_code 0 [ FALSE ] Cormrmand

B MewSpy

4 “Wariables

hart_busg_en_MMzq
glot

1. You can also press "space" to set it as "TRUE".

Hew: Spy

hadlzin

@ Binding Configuration channel e TET
- 3 Global defines Preamble 1] ButUnlock slot
2} Wariables Drelimiter 0 channel
B Types [ Address Preamle_r
------- [ (Al Projects] Address[0] 0 Delimiter_r
Address{1] 0 Address ¢
Address[2] 1] . Caommand_r 2
< > gl >

In the "HC_Tool", click "SRMsg" to open "Send & Receive Msg" window, fill in the response data and
click "Send".

EEX

Refer to 23.4.1 for COM Port setting.

HC _Tool ¥1.05 (ICF DAS)

ettings | DataLog HICfz ModCfz  About

EOX]

Send & Receive Msg

Send Data
|FFFFFFFFFF86 OR 85 0B 04 420315000041 A0FF3EQC 2EC5 37482041 C8 3F22 3942 COBE D1 |

Bend

With Parity Check

2. Fill in the response data and click "Send".

FF FF FF FF FF 86 96 85 0B 0A 42 03 15 00 00 41 AO FF
3EOC3EC537482041C83F223942C98ED1
(Refer to Section 23.2 - The format of HART frame.)

[] Auto Zerall

Recetve Data
T 020704 275<=FFFFFFFFFF a2 96 35 0B 04 420300 D1

Set "send_HART_request" as "TRUE" to send this HART
request by the I-87H17W (refer to Section 23.2).
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Preamble Delimiter Address Command | Byte Count Data
The HART request from the I-87H17W (Hex.)
FF FF FF FF FF FF | FF FF FF FF
FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
FF FF FF FF FF
The HART response from the device (Hex.)
(long) 00 00 41 AO FF 3E OC
FF FF FF FF FF 86 96 85 OBgOA - 03 15(16) 3E C5 37 48 20 41 C8
3F 22 39 42 C9 8E D1
If the process is successful, you will see the screen like below.
0000 HewSpy.spl
& Marne: | Value | Description
m zend_HART_request L
read_HART_request
g¢ Hart_BILIS_state 0
Hart_error_counter il
Hart_error_code il
hart_buz_em_Mszg "
zlat 2
channel 0
Preamble ]
Drelirniter 130
Adjg:ﬁgsm] /50 V\ The HART request from I-87H17W's
Address[1] 133 Ch-0in the Slot2 (refer to Section 23.2).
Address[2] 1
Address[3] 10
Address[4] EE
Cormmand 3
Data
Dratalen ]
hart_zend_em_msg ‘Sen
Preamle_r 5
Drelimiter_r 1EHEE
Address o
Addreszs_r[0] 150
Addreszs_1[1] 133
Addreszs_r[2] 11
i:j:::_ﬁ} 152 V\ The HART response from the device
Command © 5 (refer to Section 23.2 The HART format).
Data_r
Drata_r[0] 0
Drata_r[1] il
Drata_r[2] alal
Drata_r[3] 160 W
4 N “ariables Hew Spy - hdain
Drata [250] il
Data f251] il
Data_[252] il
Data_[253] il
Drata_i[254] 0
Datalen_r 16H#15
hart_read_err_msq 'Read success' W
4k “Wariables Hew Spy - bdain
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Feature Descriptions: (Program- Demo_HART_2 ; Wiring — Refer to Section 23.4.1)
To send/receive the HART frame automatically and repeatedly every 5 seconds from the Ch-0, Ch-1 and
Ch-2 of the I-87H17W module in the slot 2.

After downloading this project, open the spy list (NewSpy) and the I-87H17W will automatically send the
HART request from Ch-0, Ch-1 and Ch-2.

I Win-GRAF - Demo HART 2 (Operate 1-87YH17W to communicate with HART device)

Fle Edit ¥View [mset Project Tools Window Help

TN T I S % © A = g Ak ) By S 0

Workspace 0000 Hewspy.spl
[* Demo_HART_2 [StaAp... E Mame | W alue | Dezcri | Mame || Tupe | C
1 Exception programs FE zend_HART_request * o} Global variables ~
3 Programs i cmd_indes a Preamble LISIMNT
“E&1] Main gt crmd_max_mum K] Delimiter LISINT
“&1] TriggerSignal_Gen .. cmdl_Data Address LISINT L
[ Watch [for debugging) crd1_Dataf0] 0o Cormmand LISIMNT
= e T crdl_Datafl] 0o Data USINT
omd1_Datal2] 00 1 Datalen USINT
e BT TigUration crnd1_Diata3] 0o ret DIMT
g Global defines crndl_response_counter 1] slot DIMT
o} Wariables cmdl_eraor_counter 1 channel DIMT
B Types crdl_enor_code 1 Freamle_r LISIMNT
[ [l Projects] cmd2_Data Delimiter_r USINT
cmd2_Data[0] 0n Address_r LSINT
cmd2_Data[1] 0.0 v Cormand r LSINT b
A » < | >

4 kAzin TriggerSignal Gen MHew Spy

In the "HC_Tool", set up the COM Port and HART format first (refer to 23.4.1), and then click "SRMsg" to
open "Send & Receive Msg" window, fill in the response data and click "Send".

HC_Toolvl.05 (ICP DAS)

| HTCfz  ModCfz  About
See 23.4.1 for COM Port setting.

COME

Send & Receive Msg

Send Data
|FFFF FF FF FF 86 96 85 0B 04 42 03 15 00 00 41 A0 FF 38 0C 38 C5 37 48 20 41 C8 3F 22 30 42 C3 8E DI | )
e k
With Parity Check K -
TF 121202187=-FFFFFFF| 3 Fil| in the response data and click "Send". -+ 8E D121 )
FF FF FF FF FF 86 96 85 0B 0OA 42 03 15 00 00 41 AO
FF3EOC3EC537482041 C83F 223942 C98ED1
(Refer to Section 23.2 - The format of HART frame.)
[] Luto Ecrall Clear
Recetve Data
F4F 12:11:08 031 «—FF FF FF FF FF 82 06 85 0F 04 42 03 00 D1 . }
TG ERERRLS LR LLUR | | The LE7HIZW wil automaticly send
4 131126 503 FF FF FF FFFF 52 96 85 O 0 4% 03 00 D1 the HART request every 5 seconds from
FF 17:12.01 £09-—FF FF FF FF FF 82 05 85 OF 04 42 0200 D1 Ch-0. Ch-1 and Ch-2
F4F 17'12-11 503 <—FF FF FF FF FF 82 05 85 OF 04 43 0200 D1 ) an .

(It shows 15 seconds because we just link the channel 0 in this test.)
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Preamble Delimiter Address Command | Byte Count Data

The HART request from the I-87H17W (Hex.)

(long)

FEFFFFFFFF | 82 | oo oo onon 40

03 00 -

The HART response from the device (Hex.)

00 00 41 AO FF 3E OC
03 15(16) 3E C5 37 48 20 41 C8
3F 22 39 42 C9 8E D1

O0O00 HewSpy.spl
¥ M arme | Walue | Description

(long)

FEFFFFFFFF | 86 | 0o oc 0n op 42

FE! zend_HART _request
—' omd_index @47 The I-87H17W is sending HART request from Ch-2.
g+ crid_rmas_nunn 3

cmdl_Data

The received data from Ch-0. The “Data” will convert

crmd1_Data{0] 2012463 ) g1 to four “REAL” values in the program (P23-17).

sztg:::{;} o datal =20.12463 (41 AO FF 3E)
cmdl_Datal3] 100778938 data2 =0.385187 (3E C5 37 48)
cmd1_response._counter 1 data3 =25.030827 (41 C8 3F 22)
cmdl_emor_counter 15 datad4 = 100.778938 (42 C9 8E D1)
cmdl_emor_code -1
cmdZ_Data
Cm:?gata{?] E'E By now, one response from Ch-0. The I-87H17W will
Ezdz_[):::{zi D:D send the request every 5 seconds from Ch-0 to Ch-2.
u:de:Data[S] 00 If it is timeout, the return value will be "-1". And,
crmd2 response. counter 0 there is no response for 15 times now.
cmds_ermar_counter 16
cmd2_emor_code -1
cmdd_Data
cmd3_Datal] 0.
cmdd_Datal1] n.a
cmd3_Datal?] 0.
cmd3_Datald] 0.
cmdd_response_counter 1]
cmd3d_ermar_counter 15
cmd3_emor_code -1
hart_bus_er_Msg ‘Errar; Timeout’
hart_zend_emn_msg 'Send success’

hart_read_erm_msg 'Fead success'

4 hedain Trigger Signal Gen Hew Spy
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Feature Descriptions: (Program- Demo_HART_3 ; Wiring — Refer to Section 23.4.1)
Using two I-87H17W in the slot 2 and slot 3 to send and receive the HART frame every 5 seconds
automatically and repeatedly from Ch-0 to Ch-7 at the same time.

After downloading this project, open the spy list (NewSpy) and both of I-87H17W modules will send the
HART request from Ch-0 to Ch-7 automatically.

A Win-GRAF - Demo_HART 3 (Operate 1-87H17W to communicate with HART device)

File Edit View Insent Project Tools Window Help

2lblal om0l G A EBE AR SEAsarn ) BT e B
Workspace 0000 HewSpy.spl
[* Demo_HART_3 [StaAplRur ~ E Hame | Yalue | Le “F Mame | Walue

1 Exception programs Send_HART_request L 5
[ Programs i Send_HART _request[d] Send HART re...

78 BuildCrmd [*T o build HA B+ Send HART_request{1] TRUE Freamble 5

T8 ChangeCmd [*To switch cmd_indesx Delimiter 130

?-2 Errar_handle cmd_index{0] 3 Addrass

P8 GetSlot [*To get cumenl crd_index{1] 2 Cammand 3

“E1] Main cmd_max_num Data

P8 ReadResporse [*ta hart crd_max_nurn[0] a Datalen 0

“&1] TriggerSignal_gen [To cmd_mas_num(1] a ret G
|1 watch [far debugging) triqaer_tirmer 24930 slot 3

B® Soit Scope trigger_interval tHhs channel 2
e zlot2_cmd1_Data Prearnle_r 0
“Bad MewSpy slotZ_cmd1_Data[0] 0o Delimiter_r 16800
Per=Bndina-Earliguration zlot2_cmdl_Data[1] 0o Address_r
3.9 Global defines PSS Qg Uy e L1 | nn b e mn A ] %
']ﬁ‘ " aniables $ 2 £ 2
—— 4k Hew Spy -~ hdain “Wariables Build Crmd Change Cmd Trigaer Signal qen

In the "HC_Tool", set up the COM Port and HART format first (refer to Section 23.4.1), and then click
"SRMsg" to open "Send & Receive Msg" window, fill in the response data and click "Send".

HC_ Tool w1 05

COME
Send & Receive Mzgz

(ICF DAZ})

HICfy ModCfe  About

Cloze

Bend Data

|FFFFFFFFFF869685 OB0LA 420215000041 AOFF3EOC 3ECS5 374582041 CE3F22 3942 CA8ED1

With Parity Check

\
T 040011 656—=-FFFFFFFY 2 Fill in the response data and click "Send". E D1 31
FF FF FF FF FF 86 96 85 0B 0A 42 03 15 00 00 41 AO FF
3EOC3EC537482041C83F223942C98ED1
(Refer to Section 23.2 - The format of HART frame.)
[] ufo Scroll Clear

Receive Data

Both of I-87H17W modules will send the HART
request from Ch-0 to Ch-7 automatically.

T4 04:00:11.093«=FF FF FF FFFF 82 96 85 0B 04 42 03 00 D1 F

Preamble Delimiter Address Command | Byte Count Data
The HART request from the I-87H17W (Hex.)
(long)
FF FF FF FF FF 82 96 85 OB OA 42 03 00
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Preamble

Delimiter

Address

Command

Byte Count

Data

The HART response from the device (Hex.)

FF FF FF FF FF

(long)

86 96 85 0B OA 42

03

15(1¢)

00 00 41 AO FF 3E OC
3E C5 37 48 20 41 C8

3F 22 39 42 C9 8E D1

OO00 HewSpy.spl

4 »

Mame

| Yalue

| Description

Send HART _request
Send_HART_request[0]

Send_HART _request[1]

cmd_index
cmd_index[0]
cmd_index[1]

crnd_mas_nunm

TRLE

cmd_rmax_num[0] a

cmd_max_num[1] g

trigger_timer
trigger_interval

tH2:116ms
5z

Send the HART request every 5 seconds.

glot2_cmd1_Data

glat?_cmd1_Drata0]
glot2_cmd1_Dataf1]
glot2_cmd1_Datal2]
glot2_cmd1_Data[3]

2012483
0.385187
2h.030327
100.773335

glotd_crmdZ_Lata
glot2_cmd3_Data
glot2_cmdd Data
glot2_cmd5_Data
zlot2_cmde_Data
glot2_cmd?_Data
zlot2_cmdd_Data

glot2_cmd_responze_counter

glot2_cmd_rezsponse_counter[0]
glot2_cmd_response_counter1]
glot2_cmd_response_counter2]
glot2_cmd_response_counter]3]
glot2_cmd_response_counter4]
glot2_cmd_rezponse_counterd)
glot2_cmd_rezponse_counter[B)
glot2_cmd_response_counter[7]

glot3_cmd1_Data
zlot3_cmdZ_Data
zlot3_cmd3_Data
zlot3_cmd4_Data
zlot3_cmd5_Data
zlat3d_cmdB_[Data
glot3_cmd?_Data
zlot3_cmdd_Data

o o o o o o o =

zlot3_cmd_responze_counter

zlot3_crmd_ermor_counter

zlot3_cmd_ermaor_code

hart_bus_em_Mszg
hart_zend_erm_mzg

hart_read_err_msg

‘Error: Timeout!

The received data from Ch-0 of the I-87H17W
in the Slot2. The “Data” will convert to four

“REAL” values in the program.

datal =20.12463
data2 = 0.385187
data3 = 25.030827
data4 = 100.778938 (42 C9 8E D1)

(41 AO FF 3E)
(3E C5 37 48)
(41 C8 3F 22)

‘Send Errar: -87H1 ™ i aff-line'

Hew Spy - hdain

‘Wariables Euild Cmd Change Cmd

Trigger Signal gen
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Appendix A Data types and Ranges

Users can specify the data type of variables in the Variables Area (refer to Section 2.2.1) or in the
Variables window (refer to Section 2.2.2).

o} Global variables

Below are the available basic data types and ranges:

(*) stands for the commonly used data type.

PAC Year | e

PAC Month 0| BOOL

PAC Day p| EYTE

PAC WeekDay ] _
PAC_Haur D
F'AC_MinLItE D LINT

PAC Second O LRpEAL

< LWwWORD

Data types Size in-bits Range of Values
BOOL (*) Boolean TRUE or FALSE
STRING (*) Character string A max. of 255 characters
SINT Signed small integer -128 to +127
USINT 8-bit
Unsigned small integer 0 to +255
BYTE
INT Signed integer -32768 to +32767
UINT 16-bit
Unsigned integer 0 to +65535
WORD
DINT (*) Signed double integer -2147483648 to +2147483647
UDINT
Unsigned double integer 0 to +4294967295
DWORD 32-bit
REAL (*) Floating point +3.4x1038 to +3.4x1038
TIME (*) Time of day T#Oms to TH23h59m59s999ms
LINT Signed long integer -283 to +(263-1)
LREAL Floating point +1.7x103% to +1.7x103%8
64-bit
ULINT
Unsigned long integer 0 to +(2%4-1)
LWORD
Note: “ULINT” and “LWORD” are not supported for Win-GRAF PAC.
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Appendix B Troubleshooting while On-Line the PAC

If the error message is showing up (as the screenshot below) after connecting to the Win-GRAF PAC,
refer to the following content to solve the problem.

® The “Bad version!” error message:
It means that the compiled version between the PC and the PAC is different. The most common
reason is that users have modified and re-compiled the program.

To solve the problem

1. Click the “Stop application” button to stop the running program.

Win-GRAF - DemoD1 M=1E3
File Edit View Inset Project Tools Window Help
2L -y e, AW e QR e (9 A I O
Workspace R X
I La |7 Mame | Walue
I_J Exception programs £ ] PAC Time (*Get / Set [~
£ Programs | Second) PAC_Second Inst TIME_GET E
“8] PALC_Time [*Get / Set... Set TRUEto setn... Inst_TIME_SET
e |2€] LD [*Blinking?) _ Set_newy_time Inzt_TIME_SET =] ﬁ Global varighles
[+ [ Watch [for debugging) R Set TRUE o . SENUNREEr € PAC Year
o
@® Soft Scope new times far the PAC Manth 3
- B Initial values newy_vear | vear = <'_' n “l - s
!!& Binding Configuration I = ==
3g Global defines C3 (Al -
{2} Wariables | new_arth | Manth 3 [Used) 3
BB Types 3 (Project]
1 Advanced
o new_Day {Day [ Arithrmetic
[ Arays
neswe_Hour JHour v [ ASdntertace hd
L] > 4 »| Blocks,  Sowlist | Define | EMUN
Demol - 192.168.255.1:502 »
# | Time | Event description | Bac! version!
Cycle time (ms):
Last=0
Allowwed = 0
hdaximum =0 \
4> Euild Cross referenses Runtime Call stack Breakpaints Digital sampling trace Frompt | __Hbi|
IReady Bad version! (192.165.255.1:502) {1 0 »
Bad version!
Cycle time (ms;
. . Last=2
2. Click the “Download” button to download the program again. Alloved =10
Maximum =9
. Overflove = 0
48 || Mo application
Local application:
n?mmm 4 - 155811
Crmtime 5 RiZ=1 E#EEMB!IETBEEI
Target application:
ﬂb 070452014 - 12:46:53
=] =
T y{[ W | ﬁc=1 B#48e78eS
RAM = 75176 bytes
Elapsed: 2h11m26s

3. The “RUN” message means that the program is working properly.

Al EuN PSR e
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® The “Communication error” error message:
A communications failure has occurred between the PC and the PAC.

Win-GRAF - Demoll

File Edit View Inset Project Tools Window Help
e s A & BT AR A

Workspace umun [PAC_Time] | HLL B4
I I I&? M arne | Value
|_j Exception programs Inst TIME GET E 8 PAC_Time ("Get / Set F»
- [0 Programs | |R1: Get current .. En TIME_GET Eno | Inst_TIME_GET
538 PAC_Time [Giet / Set.. Inst_TIME_SET 1
" [ LD [Blinking®] Current time of th... El {3} Global variables
[=)- [ Wfabch [for debugging) | ear[PAC_Year PAC Year
R Soft Scope PAC Manth 2
o B Initial values hortk|-PAC_Marth <"‘ " AI - ST
!!& Binding Configuration I = =
3g Global defines C3 (AN 2
Wariables | | Diay |-PAC_Day (] [USE'..CI] =
BB Types 3 [Project]
4 Advanced
B un Dy |-PAC _WeekDay B3 Arithmetic
[ Arays
Hour |-PAC_Hour b [ ASdntertace ~
3] > < »| Blocks Sovlist | Define | ENUM
Demo1 - 192.168.255.1:502 »
T Time Event deseription | Communication errar
4k Build Cross references Runtime Call stack Ereakpaints Digital zampling trace Frompt HRkL
IReady Bad version! {192,168,255,1:502) é 0,0 205 % 18 0,0

To solve the problem
1. Make sure your Win-GRAF PAC is started, and the network communication between the PC and the
PAC is functioning properly.
2. Make sure the IP setting of the Win-GRAF project is the same as the PAC IP (refer to Section 2.3.5,
in this example, the IP address is “192.168.255.1:502").
3. Make sure the network communication of your PC is working.
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Appendix C  Enable the Screen Saver of WinCE PAC

Please set the following two items to enable the screen of WinCE PAC.

1. Choose “Control Panel” > “Power” > “Schemes”, and set the “Power Scheme” as “AC Power”, set the
“User Idle” and the “System Idle” to the same value (or set the “System Idle” value larger than the
“User Idle” value).

2. Then, remember to run “WinPAC Utility” > “File” > “Save and Reboot” to save the settings and auto
reboot the PAC.

Using the WP-8xx8 as an example:

If users do not touch the screen or button until the time out (e.g., 1 minute), the WP-8xx8 will turn off
the backlight for enabling the screen saver. Whenever users touch the screen or button, the WP-8xx8
will turn on the backlight again.

The way to disable the screen saver is to set the “User Idle” and the “System Idle” as “Never”, and then
remember to run “WinPAC Utility” > “File” > “Save and Reboot” to save the settings and auto reboot the
PAC.

Teogams >
% Favorites 4 -h 4 E@
L% :33 J

D Docurnents

Certificates  Date/Time Dialing

Power. Properties E

Battery

B Settings B Control Panel

Power Scheme: ]
|:&C Powwer J

Switch state to User Idle: )
|ﬂfter 1 minute J

Switch state to Suspend:

06

<

|Never

WordPad
= WInPAC Utility [2.1.0.4]
@J Help Configuration |
[y i
Documents Save and Reboot
Reboot without Save W& |
¢ ° "\
\ Restore Default Settings 5
WINPAC

Exit
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Appendix D Using Expansion RS-232/485/422

The Win-GRAF PAC (check P1-1) expand more COM port in its slot No. 0 to 7 by using following modules.

[-8112iW : 2-port Isolated RS-232 module

[-8114iW : 4-port Isolated RS-232 module

I-8114W : 4-port RS-232 module Note: The WP-5xx8 does not support
[-8142iW : 2-port Isolated RS-422/RS-485 module . XW-5xx series XW-board.
-8144iW : 4-port Isolated RS-422/RS-485 module ('S PAC can not expand COM port.)

Using the WP-8xx8 as an example:
Before using these modules, please configure them by using the “WinPAC Utility”. First, plug the module
in the WP-8xx8’s slot 0 to 7 (It is better to be in slot 0 to 3), and then run the “WinPAC Utility”.

® Click the “Multi-serial port wizard” tab.

® Check the “USE COMx” option. (Note: The Win-GRAF doesn’t support “USE MSA/MSBx”)

® Click the “Slot scan” button, and then the current found serial-port expansion module will be listed
on the left. (The earlier COM port setting is listed on the right if you have already set it before.)
Click the “Set” button to refresh the new setting like the figure below.

® Click [File] > [Save and Reboot] to save the new setting and auto reboot the WP-8xx8.

WInPAC Utility [2.1.0.3]

File Help Configuration

[ Ethernet Settings ] Network Settings l System Information ] Auto Execution Multi-serial port wizard 12| «] »
~ i

=3 Slot3:8144
Slot 0: .- £33 comp Driver enabled
I . -3 com?
L Slot 1 8 come e Driver disabled
My Slat 2: 3 coma
Documents

@ Slot 3:
2 Slot 4:
WINPAC ...

Slot 5:

JUUHAOIL

Slot 6: Install driver (apply to 1-8112/8114/8142/8144 series modules )
Slot 7: Stepl: Port number assigned according to
(@) Sequence order (O slot order (Fixed order)
Slot scan, (Refresh) Stepz: [f [Juse msamsex
' : use COMx
Start Port number
WinPAC Utility. [2.1.0.3] E

¢

Help  Configuration

Step3: | \/->"Sr' “hoot" to enable driver

Save

Save and Reboot
Reboot Without Save N\
Restore Default Settinig:
Exit

Select “USE COMXx” option
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After the configuration succeeds, the COM port No. for the expansion is COM6 to COM37 in the
Win-GRAF definition. (In this case, it expands the COM6 to COM9).

INEtWDrk Settings IS\,rst!m Infor mation ] Autn Execution | Multi-serial port wizard [

=l Slota
Slot O: |:| % come
, - Com7
e I:I * COME
Slat 2: |:| B COMY
Pin Assignment:
1-8112iw 1-8114iW 1-8114W
2-port Isolated RS-232 4-port Isolated RS-232 4-port RS-232
Aoy Termesl . No. Ssignment Soniect ""‘""Q““ Aot
ot 05 i bl | 2R3
DIR1 04 D3 L 21 DTR3
TxD1 03 ?::3 :: 22 DSR3
Ri4 06 25 oCD4
DTR4 07
Port DSR4 08 Z ?:;
I o B RxD4
TxD4 10 23 RI2
BCD2 11 0 OTR2
oty | (B
RxD2 14
i o1 e moos e ok
crs2 DTR1 16
D2 03 07 RTS2 DSR! 17 X e
= o = | =
TxD1 19
ol L J R 55 Comectr
1-8142iW 1-8144iW
e Pir Assignment e, Pin Assignment I-8142iW (2-port Isolated RS-422/485)
| o DIHTHO14 | o DI4/T:O1+ RS-485 portl: (D1+, D1-)
Tu|| 02 D1/TxD1- Tul| 02 D1-/TxD1- RS-485 port2: (D2+, D2-)
Taj| o3 RxD1+ Taf| 03 RxD1+
J‘_:J : 2:«?)11- ffil Z :""&‘ RS-422 portl: (TxD1+, TxD1-, RxD1+, RxD1-)
—;: e B —:-: % S RS-422 port2: (TxD2+, TxD2-, RxD2+, RxD2-)
X -J 07 D2-/TxD2- o y 07 D2-fTxD2-
= iooe KD o)) o8 RxD2+ 1-8144iW (4-port Isolated RS-422/485)
el 09 RxD2- el 09 RxD2-
Tal| 10 GND2 | 1 GND2 RS-485 portl: (D1+, D1-)
el 1 N.C. MY D34/TxD3+ RS-485 port2: (D2+, D2-)
) 12 N.C. ‘o 12 D3-/TxD3-
= o = © sk RS-485 port3: (D3+, D3-)
ol 14 NC. o] 14 RxD3- RS-485 port4: (D4+, D4-)
iell s NC. el 15 GND3
L2 - :g _ - g:*rf;*:: RS-422 port1: (TxD1+, TxD1-, RxD1+, RxD1-)
| s NE. o s RxD4+ RS-422 port2: (TxD2+, TxD2-, RxD2+, RxD2-)
3'} 19 :-C- "T} 19 RxD3- RS-422 port3: (TxD3+, TxD3-, RxD3+, RxD3-)
2 - e caiic RS-422 portd: (TxD4+ , TxD4-, RxD4+, RxD4-)

Win-GRAF User Manual, V2.0, Aug. 2020 by ICP DAS AP-6



Appendix E  Enabling a Serial Port for Connecting the
Win-GRAF Workbench

(In this section we use the WP-8xx8 as an example to show the way to enable the serial port for
connecting the Win-GRAF Workbench and this way is also applied to other Win-GRAF PACs.)

The Win-GRAF PAC’s Ethernet Port is typically enabled for the Win-GRAF Workbench to debug or
download or upload the project. If users want to enable a serial port (i.e., RS-232 or RS-485) for doing
these operations, follow the way as below:

Method 1:
When the Win-GRAF PAC is turned on, it will try to read a “Extra_Ports.txt” file in the path
“\System_Disk\Win-GRAF\”, and the contents are shown like below.

It means to enable the COM1 and

COM1:19200,N,8,1 y\
the Baud Rate is 19200 bps

If you want to enable the COM2 and its Baud Rate is 9600 bps, modify the contents as below.

COM2:9600,N,8,1

So, put this text file to the path “\System_Disk\Win-GRAF\” by FTP and then reboot the PAC.

Disable the COM Port:
If you want to cancel this COM Port setting, simply delete the “Extra_Ports.txt” file on the PAC
( \System_Disk\Win-GRAF\Extra_Ports.txt) and then reboot the PAC.

Method 2:

Users can find out a "demo_extra_port" demo project in the shipment CD. First, restore this zip file
(refer to Chapter 12) and then mouse double click "ST1" to modify this program. Finally, compile and
download this program to the PAC (refer to Section 2.3.5).

Worl . space

, i Create_extra port := FALSE ; A\ Name | Type
-] REEpUOn programs iR : i file DINT
£l Programs 3 Iy oen Tilentor "Nriheodata 7 filel_name STRING(128)
8] Main THEN f_llel.:= F_wopen( filel name ) ; Create_extra_port BOOL
= { et — = =
-l - = [ #n wriceq siter , ‘comi:iszon,m,s, it j:) <De|me SkiR pot B0CL
(3l Walch (for deDagging) || F close( filel ) ; [ close file 7) : )
/&8 Soft Scope end if ; Sl B L)
=4 Initial values bIl
%3 NewSpyl — end if ; In this example, it writes the string ‘COM1:19200,N,8,1’
%ig Binding Configuration . . . .
- : i+ ser TRUE to { into the file, which means to enable the COM1 and its
g Global defines
@} Vaiebles X Baud Rate is 19200 bps. Change the COM Port number
B Types § | ST1,7 NewSpyi
and baud rate to whatever you want to use and compile
this program again.
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Test the program:

%2 A RUN

1. After connecting the Win-GRAF PAC, set the variable -"Create_extra_port" as "TRUE" in the Spy list.
In this example, it will add a file -"Extra_Ports.txt" into the path "\System_Disk\Win-GRAF\" and the
content is “COM1:19200,N,8,1”.

2. Setthe "Reset_PAC" variable as "TRUE", and then the PAC will auto reboot and apply the setting.

SLEL bl bl i 0 2 Lo A WE ARG S

Workspace il OO0 HewSpyt.spl —

[> demo_extra_port [RUN] | Name | Walue @l Create_exira_port
[+~ Exception programs g Yearl 2014 l
=14 Programs =7 Month1 7 d

o 56 Main B¢ Dapl 25

57 sT1 Hourl P ( FALSE
E- [ Watch (for debugaing) Minute1 7

../ Soft Scope Secondl ;

=4 Initial values file1 1324688

filel name “System DiskWWwin-GRAF

“&d NewSpyl
o8¢ Binding ConfigMhtion

Reset PAC B

Create_exstra_port
e 3g 6 . Delete_extra_port
Y Double-click Reset_PAC
o B Types P [

[ > | 571 NewSpy1, ‘ariables | Main

in-GRAFAExtra_Ports. tat'
= Ports. tat

In the Win-GRAF Workbench, if you want to connect to the Win-GRAF PAC through the serial port. Refer
to Section 2.3.5 — Step 1 to 2, and select the "Serial link" option for connecting the PAC via COM Port.

Communication Settings

() Ethemet TCPAP 4
P adress: ’[ ‘

Port humber; \ ' ’

Select the available COM Port
number on your PC. In this
example, Baudrate = 19200 bps.

() Serial link
PC port: y : ‘
Baudrate: \1?200_%
Baiity: None |
Stop bits: (1 v

Disable the COM Port:
If you want to cancel this COM Port setting, simply set the

"Delete_extra_port" variable as "TRUE", it will delete the
“Extra_Ports.txt” in the path (PAC: \System_Disk\Win-GRAF\).
Then, set the "Reset_PAC" variable as "TRUE" to auto reboot
the PAC.

Delete_exira_port
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Appendix F  Pin Assignment of PAC’s Serial Ports

WP-8448/8848:
Pin assignment of COM1 to COM4.

COM1: RS-232 COM2: RS-485 COM3: RS-232/485 COM4: RS-232

ll-pWR1

~GND
=PWR2

[=GND DSR- 'ggg
§|~R.COM CTSH RTS- >
=R.NO RTS CTSA xD

~DTR

RI- LGND

Data-+

tleD¢ny
=D N

g

Note: WP-8148 has no COM3, COMA4.

XP-8038-CE6/8138-CE6/8338-CE6/8738-CE6 and XP-8048-CE6/8348-CE6/8748-CE6:
Pin assignment of COM1 to COMS5.

COM1: RS-232

External COM1 for the XP-8038-CE6 and the XP-8048-CE6 only;

@, @ The COM1 of other PACs is for internal communications with 1-87KW
@ 8'"“10 modules in slots only.

@ T TxD

@ & leno

COM3: RS-485 COMa4: RS-232/485 COM5: RS-232

DSRA 'z‘jg
CTSH RTS- [
CTS- X

~DTR

RI- LGND

RTS~
Data--

deolpa

g
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VP-x2x8-CE7 :
Pin assignment of COM1 to COM3.

VP-2208-CE7 VP-4208-CE7
COM1 & COM2 : RS-232/RS-485 | COM1 & COM2 : RS-232/RS-485 COMS3 : R$-485 (D+, D-)
6@~-Data+ @*-Data+
CTS—D %”?"D CTS—H?) QR0 @ il @
+TxD @t TxD
RTS—H® @ RTS—® @ |
Data-—<9) Iso. Data-—9) Iso. h PGND | D-
\C@:PGND \C@:-GND FG PWR D+
VP-1238-CE7
COM2 : R$-485 (D2+, D2-) COM3 : RS-232
DSRA @-+-DCD
RS D R*P
D-— mm — D+ TS @_ - TxD
= RI- @++-DTR
(®H-GND
RS-485
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Appendix G Automatically and Periodically Synchronizing the PAC
Time over a Network

The Win-GRAF PAC support SNTP (Simple Network Time Protocol) Client for network time
synchronization. This chapter will describes how to synchronize the Win-GRAF PAC time with the SNTP
Server over the Internet or a local network.

SNTP WinPAC SNTP Server

Server

Win-GRAF PAC :
(SNTP Cllent) I |nternet

ViewPAC

G.1 Set up an SNTP Client for Network Time Synchronization

Run the WinPAC Utility on the PAC’s (e.g., WP-8xx8) desktop, select the “System Settings” tab and click
the “Configure” button to open the "Internet Time" window.

WinPAC Utility [2.1.0.6] =]
Fle Help Configuration

WordPad

 Systern Settings | Bystem Settings2 I Ethernet Settings ]Netwclrk Settings ]S\,rstem Infor mation ]Aub: i | »
“;k/ Welcome to use WinPAC Utility
2 This tool will help you to set up the WinPAC - 5000,
My . .
Documents Disglay Resclntion - [1024 * 768

] Brp: 16 v
@ WinPAC . T

WINP.&C\ \n “ Industrial Control Products

| £

< Data Acquisition System Set
&\
Bateryl: (K Task Bar Settings: [ ] Auto Hide Always On Top
Batteny2: 0K [ ]Blank Desktop

When the battery voltage below 1.5, the data in the RTC {real time clock) and 512KE SDRAM will be lost,

Configure synchronization with a time server l Configure w l

[ |Enable Autorun when connecting a USE Disk
[ ]Enable Autorun when connecting a Micra SD
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Step 1: Assign a SNTP Server

In the "Internet Time" window, you can select the listed SNTP Server (as the figure below) to conduct
the Internet time synchronization. Or, you can set up a PC as a SNTP Server (Refer to Section G.2) and
then type its IP address (e.g., 192.168.78.99) in the "Server" field, for automatically time synchronization
through the Internet or a local network.

Internet Time 1.0.0.2

<5tep1:59rver: 192,168.75.99 (1\

pool.ntp.org N
SiEp2: AuBUpEE tock. LSt nayy mil
Step3: time. windows.com

|:| Autornatically synchronize with an internet time server

Update Moy

Step 4:Go o0 "File" -->"Save and Reboot" 1o enable
driver

Ao update stopped

Note: If the assigned SNTP Server for the PAC time synchronization is over the Internet in a different
domain, the user must set up the “Default Gateway” for the PAC (Refer to Section G.3)

Step 2 : Assign the Auto-Update Frequency
If setting to update once a day (24 hours), entering "1440". (Uint: minutes. The minimum update
frequency is "5" minutes.)

Step 3 : Enable Auto-Time-Synchronization
Check the box for time synchronization automatically with a SNTP Server, and then click “X” on the
upper-right corner to exit this window. (Uncheck the box to stop this function.)

WinPAC Utility [2.1.0.6]

Internet Time 1.0.0.2

Help  Configuration

Stepl: Server: |puu|.n¢u.urg w

1440 minLte

’\
i@.ltl:umatil:ally synchronize with an internet time ser

N, :
F{;\) Update Mow :
5 .
Step 4:Go to "File" --="Save and Reboot" to enable WinPAC

dr e ‘c-jl"' Industrial Control Products
( Autn update running ﬁh,':' Data Acquisition System
N —

S ——————————

Save and Reboot

Reboot without Save
Restore Default Setfings
Exit

Step2: Autoupdate Frequency: <
Step3:

7\

Step 4 : Save and reboot the PAC
Click “File” > “Save and Reboot” of the WinPAC Utility to save the settings and restart the PAC.

Step 5: Test the SNTP Automatic Time Sync

After rebooting the PAC and able to access the network, it will automatically synchronize the time with
the SNTP Server according to the previous settings. You can also click the “Update Now” button in the
“Internet Time" window to update the PAC time immediately.
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G.2 Set up a Windows XP PC as the SNTP Server to test the SNTP Client

Prepare a Windows XP PC for the WinPAC SNTP Client to synchronize the time. Follow these steps.

Step 1: Enable and Set Up the SNTP Server of Windows XP PC

1. Run “Registry Editor”
On PC, select [Start] > [Run] and enter “regedit”, then click “OK”.

= Type the name of a program, folder, document, or
: Internet resource, and Windows will open it For you,

Open: I Regeditl v

[ OK k{[ Cancel ] [ Browse..,
2. Enable the SNTP Server.

The SNTP Server in a normal Windows XP PC is default enabled.

Left window:
Please change to the following directory.
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\W32Time\TimeProviders\NtpServer\

Right window:
The most right “Data” number of “Enabled” is (1) which means the SNTP Server is enabled. If it is (0)

which means the NTP Server is disabled. Please right click “Enabled”, select “Modify” and change
“Value” to “1”, and then click “OK”.

% Registry Editor

File Edit Wiew Favorites Help

[ vgasave A Mame Type Data
(1 vialde [ab]{Default) REG_SZ ivalue not set)
(3 velsnap 8] AllowhanstandardModeCombina, .. REG_DWORD 0x00000001 (1)
% W55 [ab]DliName REG 52 W INDOW S system32 waztime
= ESZCT:;:g Enahled REG_DW/ORD 0x00000001 (1) |
3 Erum %] InputProvider REG_DWORD 000000000 {0)
I:l Parameters
|:| Security
=23 TimeProviders
[ MepClisnt
=5 [
(2 waswc
|:| Wanarp
£ woIcA

3 wdmaud

[Z3 webClignt

[ windows Workflow Foun
[ wWindows wWorkflow Foun

| I |

|

8

er ComputeriHKEY _LOCAL_MACHIME)SYSTEMICurrentControlSet) Servicest ' 32 Timel TimeProvider s\NtpServer ]
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3. Set the Windows Time service to use the internal hardware clock.

Left window:
Please change to the following directory.
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\W32Time\Config\

Right window:
Right click “AnnounceFlags”, select “Modify” and change “Value” to “5”. Then, click “OK” to exit the

“Registry Editor” window.

% Registry Editor,

File Edit Wiew Fawvorites Help

3 uprs | Mame Type Data ”~
([ usbeegp REG 5 {valus ot set)
(3 usbCennect [ AnnounceFlags REG_DWORD 0x00000005 (5) |
£ usbehei REG_DWORD 0000000z (2]
g :sStl;';bOR FrequencndrrectRate REG_DWORD 00000004 {4)
3 wsbuhd HoldPerind REG_DWORD (000000005 (5)
23 vaasave LargePhaseOFFset REG_DWORD 000135500 1280000)
0] Vialds [RE]LastClockRate REG_D'WORD 000026254 (156250)
(23 velsnap LocalCIockDispersion REG_DWORD 000000004 (107
[ vss MaxF\IIowedPhaseOFFset REG_DWORD 0=00000001 (1)
- WazTime [ MaxClackRate REG_DWORD (00026360 {156640)
£ Config MaxNegPhaseCorrectinn REG_DWORD 0:x0000d2f0 (S4000)
3 Enum MaxPnIIIntervaI REG_DhORD 0 0000000F (15)
[ Parameters MaxF‘nsPhaseCurrection REG_DWyORD 0x0000d2F0 (S4000)
[ security [R¥] MinClockRrate REG_D'WORD 0x000260d4 (155860) T
(13 TimeProviders || [@#MinPalinteral REG_DWORD 00000000 (10)
0 waswc [R8]PhaseCorrecthate REG_DWORD 000000001 (1)
(3 wanarp ¥ || [R¥1PalladiustFactor REG DMWIORD 000000005 (S) 4
< | > £ | >

I My ComputeriHIKEY _LOCAL_MACHIMEVSYSTEMY CurrenkContral3et)Services w32 Timel Config ]

Step 2 : Restart Windows Time Service

4. On Windows XP desktop, click [Start] > [Run].
2. Enter “net stop w32time && net start w32time”, and then click “OK”.

The user can also right click [My Computer], left click [Manage] and [Service], and double-click
[Windows Time] to stop/start the Windows Time service and set its “Startup Type” to “Automatic”.

= Computer Management

g! File  &ction  Wiew Window  Help =] %]

& = -I-II'.IE@ Fom ol o

% Computer Managemenk (L .

| [ame Drescripkion Skatus Startup Typ £
s ﬁ% System Tools %Winduws Installer Adds, modi, . Manual
- @ (g Event Viewer . .
] %Wlnduws Management Inskrurnentation Providesa ... Started Aukornatic

Provides 5., Manual
Maintains d.., Started

& Shared Folders

[E25 Local Users and GrtI = -
; Aukornakic
A

Performance Lu:ugs il

% Dievice Manager Irel AUCDt_orrig | ER<T= A TSt
= & Storage % Wireless Zero Configuration Provides a... Started  Automatic
[+ & Removable Stu:urage- %WMI Performance Adapter Provides p... Manual
: : Disk Diefragmenter %Wurkstatmn Creates an... Starked Aukomatic
i Dlsk Management
|| = and Applicatio | |
arrol E
e E Indexing Service W
L ! L

I\_ Extended }\ Standard ,-'f
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Step 3 : About the Windows Firewall

If using Windows Firewall (enabled), you need to open a port (i.e., UDP123) for allowing communicates
with other device.

1. On Windows XP desktop, click [Start] > [Control Panel] > [Windows Firewall].
2. Click the “Exceptions” tab, and click “Add Port...”.
3. Give a name “SNTP Server”, set up the port number “123” and select “UDP”. Click “OK” to exit.

B Control Panel L

File Edit View Favorites Tools  Help

"= Windows Firewall

\_) e) - ? fJSearch Folders ' e 1@ Advanced

Address |I:} Control Panel | windows Firewall is blocking incoming netwark connections, except for the
__ - L1 programs and zervices selected below. Adding exceptions allows some programs
= User Accounts YMware Tools to work. better but might increasze pour zecuriby rigk.
i [
ﬂ Control Panel £
[} Switch to Category Wiew E_;] % Programs and Services;
a Mame -
Windows Windows
See Also £ CardSpace Firewall Ir?temet Explarer
Livellpdate360
& Wwindows Update ) | MediaCerter
Microzaft Office Duthoak
MSMShel
Metwark Diagnostics for Windows =P
UPAP-Framework,
JUPlayer
Add a Port ] | L!ve M ezsenger 8.1
e Livve Mezzenger 8.1 [Phone] —
~
|Use these settings to open a port through Windows Firewall. To find the port -
number and protocol, consult the documentation for the program or service you | [ #dd Part. [ Edi..
want to use.
otification when Windows Firewall block s a program
Name: | SHTE Server | isks of allowing exceptions?
Port number; | 122 | oK, ] [ Cancel

O 1cP %‘

What are the risks of opening & port?

i Change scope... | [ oK ] [ Cancel

Step 4 : Set up a fixed IP for the SNTP Server

The SNTP Server must set up a static IP address for the time synchronization service no matter over the
Internet or over a local network. And, this IP address must the same with the settings of the WinPAC
Utility (Refer to Section G.1). If using the local network, both IP addresses of the SNTP Server and the
WinPAC must in the same network segment so that it can successfully synchronize the PAC time.

For example, the IP/Mask addresses of the WinPAC are "192.168.80.21 / 255.255.0.0" and the IP/Mask
addresses of the SNTP Server are "192.168.78.99 / 255.255.0.0". They are in the same network segment.
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Step 5: Testing
After setting up the SNTP Server, the user can test the SNTP Client (e.g., the WinPAC). Follow the
instructions in Section G.1 or see the figure below, type the IP address of the SNTP Server, change the

auto-update frequency to “5” minutes, checked the auto-time-synchronization box, and reboot the
Win-GRAF PAC (e.g., WP-8xx8).

WinPAC Utility, [2.1.0.6]

Fle Help Configuration

Welcome to use WinPAC Utility
This tool will help you to set up the WinPAC - 8000,

Fl= Help Configuration Diisplay Resohtion - Im
Save
C oo = Balme . Bpp: IlEu “
Save and Reboot WinPAC
Reboot wWithout Save . Frequency : I?EI w
Fa , dustrial Control Products
Restore Default Settings |, Acquisition System =
Exit
Bateyl: Ok Task Bar Settings: [ | Auto Hide Always On Top
Baters2: oK [ elank Desktop

‘\When the battery voltage below 1.5, the data in the RTC (real time clock) and 512KE SDRAM will be losk.

Configure synchronization with a time server [ CDnﬁgurek ]
S12)

[ ]Enable Autorun when connecting a USE Disk

[ ]Enable Autorun when connecting a Internet Time 1.0:0.2

e —
/v‘Etepl: Server: (|192.168.78.99 b
If using the local network, both Stepz: Autoupdate Froquency <© S
IP addresses of the SNTP Server
and the WinPAC must in the Steps:
same network segment. Qlutclmatin:ally synchranize with an internet time servert
| Update Mow

Step 4:Go to "File" -->"Save and Reboot" to enable
driver

ALto update running

You can double click the taskbar to see if the date/time is synchronized automatically. Then, change the
auto-update frequency to the needed value.

Server PAC

ﬂ fl &).___I 14:10

8 L 14:%@ =
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G.3 Set up the Gateway and DNS Server Addresses for the PAC

If your PAC (i.e., SNTP Client) synchronize the time with the SNTP Server over the Internet (i.e., in two
different networks), the user not only to set up the IP and Mask addresses, but to set up the Gateway

and DNS Server addresses.

How-to:

Run PAC_Utility on desktop, click "Assign IP address" and enter the Gateway and the DNS Server

addresses for LAN1 in the "IP Config" screen. Next, click the "Apply" button and click "Save and Reboot

on the File menu to apply the IP settings.

XPAC Utility [1.2.2.0]

Help

M KB

Save .

rificy | Metwork IDevice Information I Autn Execution IRDtar\,f Exe_{ I »

Save and Reboot
Reboot
Restore Utility Default Settings
Exit

MAC Address: 00-10-F3-31-B5-F5

() Use DHCP to get IP address

IP &Ndress:

DNS Server: |139.175.1.244

|192.168.1.26 |

EE |255.255.D.D |
Gateway:  [192.168.1.1 |
|

LAN 2:

MAC Address: 00-10-F3-31-B3-E8
() Use DHCP to get IP address
@ sssign IP address

IP éddress:  [160.254.165.121 |
Mask: |255.255.D.D |
Gateway | |

|

DMS Server: |1|:|,|:|,D.3

\

Note: 1.The Win-GRAF application must use the fixed IP address, no DHCP accepted.
2. The Google Public DNS IP address is “8.8.8.8” and the HiNet DNS Server IP address

is “168.95.1.1".
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